Microsoft® Office
Project® 2003 Bible

Elaine Marmel

Wiley Publishing, Inc.
Microsoft® Office
Project® 2003 Bible
Microsoft® Office
Project® 2003 Bible

Elaine Marmel

Wiley Publishing, Inc.
About the Author

Elaine Marmel is president of Marmel Enterprises, Inc., an organization that specializes in technical writing and software training. She routinely employs project management software and skills to manage critical business projects, and otherwise spends most of her time writing. Elaine has authored or coauthored more than 30 books about software, including Project, Word for Windows, Word for the Mac, Quicken for Windows, Quicken for DOS, 1-2-3 for Windows, Lotus Notes, and Excel. Elaine is a contributing editor to the monthly magazines *Peachtree Extra* and *QuickBooks Extra*.

Elaine left her native Chicago for the warmer climes of Florida (by way of Cincinnati, Ohio; Jerusalem, Israel; Ithaca, New York; and Washington, D.C.) where she basks in the sun with her PC, her dog, Josh, and her cats, Cato, Watson, and Buddy. Elaine also sings in the Toast of Tampa, an International Champion Sweet Adeline barbershop chorus.
Credits

Acquisitions Editor
Terri Varveris

Project Editor
Pat O’Brien

Technical Editor
Jim Peters

Copy Editor
John Edwards

Editorial Manager
Kevin Kirschner

Vice President and Executive Group Publisher
Richard Swadley

Vice President and Executive Publisher
Bob Ipsen

Executive Editorial Director
Mary Bednarek

Project Coordinator
Kristie Rees

Graphics and Production Specialists
Sean Decker
Lauren Goddard
Joyce Haughey
Jennifer Heleine
Michael Kruzil
Lynsey Osborn
Heather Ryan

Quality Control Technicians
Carl William Pierce
Brian H. Walls

Permissions Editor
Laura Moss

Media Development Specialist
Greg Stafford

Proofreading and Indexing
TECHBOOKS Production Services
To my brother and sister-in-law, Jim and Mariann Marmel, who always believe in me, and to the memories of my mother, Susan Marmel (1914-2003) and my father, Harry Marmel (1914-1985), who always made me feel loved and cherished.
Managing projects can be as exciting as scheduling the next space shuttle or as mundane as planning routine production-line maintenance. A project can be as rewarding as striking oil or as disastrous as the maiden voyage of the Titanic. Projects can have budgets of $5 or $5,000,000. One thing that all projects have in common, however, is their potential for success or failure — the promise that if you do it right, you’ll accomplish your goal.

Why You Need This Book

Microsoft Project is a tool for implementing project management principles and practices that can help you succeed. That’s why this book provides not only the information about which buttons to press and where to type project dates, but also the conceptual framework to make computerized project management work for you.

How it’s designed

This book strives to offer real-world examples of projects from many industries and disciplines. You’ll see yourself and your own projects somewhere in this book. A wealth of tips and advice show you how to address, control, and overcome real-world constraints.

✦ As a tutorial. You can use *Microsoft Project 2003 Bible* as a linear tool to learn Project — from the ground up.

✦ As a reference. You can put it on the shelf and use it as your Project reference book, to be pulled down as needed — for advice, information, and step-by-step procedures.

Either way, this book is designed to enrich your Microsoft Project experience and to make you a better project manager.

Who it’s for

Unlike word processing or spreadsheet software, many of you may have come to project management software never having used anything quite like it before. You may also have used earlier versions of Project or other project management software.
♦ If you’re new to project management. This book is for you. The early chapters explain the basic concepts of computerized project management and what it can do for you, so that you have a context for learning Project.

♦ If you’re experienced with project management. This book is also for you. It explains what’s new in the latest version of Project and shows you techniques for using the software that you may not have considered before.

You will benefit most from this book if you have at least a basic understanding of the Windows environment, have mastered standard Windows software conventions, and are comfortable using a mouse. But beyond that, you need only the desire to succeed as a project manager, which this book will help you do.

The Special Features of This Book

To help you maximize your use of this book, I’ve included many special features in its design and conception. The following sections show you how they work.

Formatting conventions

To streamline your learning experience, I’ve used the following formatting conventions:

♦ Text you’re asked to type. When you’re asked to enter text into a Project schedule, for example, it appears in boldface.

♦ When using the mouse. A click indicates a left mouse-button click and right-click indicates a right mouse-button click. Double-click designates two quick, successive clicks of the left mouse button.

♦ Keystroke combinations. These look like this: Alt+Tab. Hold down the first key and, without letting it go, press the second key.

♦ Menu commands. These are shown with the command arrow — for example, Choose File➪Open.

♦ New terms. When a new term or concept is introduced, it appears in italic.

Margin icons

Throughout the book, I’ve included special icons in the margins to call your attention to added information, shortcuts and advice, warnings about potentially disastrous courses of action, the new features of Project 2003, references to additional wisdom, and how to access the wonderful software on the CD-ROM that accompanies this book. Here’s how they look:
When you have the time for a more comprehensive approach to the subject, however, the concepts that you find in sidebars may prove invaluable — providing the context and depth necessary to a fuller understanding of Project’s functions.

**Note**

The Note icon signals additional information about a point under discussion or background information that may be of interest to you.

**Tip**

A tip is a bit of advice or a hint to save you time and indicate the best way to get things done.

**New Feature**

This icon highlights a new feature in Project 2003.

**Cross-Reference**

These helpful icons clue you in to sources of additional information on a topic under discussion. They point to another chapter or a specific heading elsewhere in the book.

**On the CD-ROM**

The CD-ROM icon flags helpful software and templates that you’ll find on the accompanying CD-ROM.

### How This Book Is Organized

This book is organized in the way that you will use Microsoft Project. It begins with some basic concepts, progresses through the features that you need to build a typical schedule, and then track its progress. The later chapters provide more advanced information for customizing Project, using it in workgroup settings, and taking Project online.

### Part I: Project Management Basics

Part I of the book explains the basic project management concepts and terminology that you’ll need in order to learn Project. In Chapter 1, you take a look at the nature
of projects themselves, how Microsoft Project can help you control them, and the life cycle of a typical project. In Chapter 2, you get your first glimpse of the Project software environment.

**Part II: Getting Your Project Going**

Here’s where you learn about the type of information that Project needs in order to do its job. In Chapter 3, you begin to build your first schedule and add tasks in an outline structure. In Chapter 4, you assign timing and construct timing relationships among those tasks. In Chapter 5, you begin assigning people and other resources to your project; this chapter is also where you learn to determine how these resources add costs to a project and how to handle issues such as overtime and shift work.

**Part III: Refining Your Project**

Before your project is ready for prime time, you need to tweak some things, just as you check spelling in a word-processed document. Chapter 6 explains how to view that information to gain perspective on your project, and Chapter 7 helps you to manipulate and customize views to make them work for you. Chapter 8 shows you how to make your project schedule look more professional by formatting the text and modifying the appearance of chart elements. The next two chapters delve into the tools that Project provides to resolve conflicts in your schedule. Chapter 9 explores resolving conflicts in the timing of your schedule, so you can meet your deadlines. Chapter 10 considers the issue of resolving resource conflicts, such as overworked people and underutilized equipment.

**Part IV: Tracking Your Progress**

Here’s where you get the payoff for all your data entry and patient resolution of problems in your schedule. After you set your basic schedule and the project begins, you can track its progress and check data on your status from various perspectives. Chapter 11 gives you an overview of the tracking process. Chapter 12 shows you how to track progress on your individual tasks and view that progress in various ways. Chapter 13 is where you explore the power of generating reports on your projects for everyone from management to individual project team members. Chapter 14 gives advice and methods for analyzing your progress and making adjustments as needed to stay on schedule and within your budget.

**Part V: Working in Groups**

Most projects worth the effort of tracking in Project aren’t done by a single person; workgroups, teams, and committees often form a day-to-day working project team. Chapter 15 shows you how to set up multiple projects to run concurrently or to consolidate smaller projects into larger schedules, and Chapter 16 describes how to keep members of your workgroup in touch using an e-mail workgroup.
Part VI: Project, Project Web Access, and Project Server

In Chapters 17 through 22, learn how to plan, implement, and manage projects using Project, Project Web Access, and Project Server, Microsoft’s Web-based project-managed solution.

Part VII: Advanced Microsoft Project

Part VII provides advice and information to make your use of Microsoft Project easier. Learn about customizing the Project environment in Chapter 23. Chapter 24 provides information on macros, which are simple programs that enable you to record and automatically play back series of steps that you use frequently, thus saving you time and effort. Chapter 25 shows you how to use VBA and VBScript to customize Project so that it works the way you work. Chapter 26 deals with importing and exporting information into and out of Project. Importing information from other software can save you the time and expense of reentering existing data. And, in Chapter 27, you’ll find some case studies that show you ways in which Project has been used by a variety of companies.

Part VIII: Appendixes

Appendix A covers the contents of and installation for the companion CD-ROM, which contains trial software, time-saving templates, and a Web page with links to sites of interest in the project management world—including sites to partners of Microsoft Project. Appendixes B–D on the CD-ROM provide resources and other additional materials to make your work easier.

The Glossary on the CD-ROM contains many specifically project management terms and concepts that have evolved over time. These terms are defined when they are first used in the book, but you may want to look them up at a later date. Use this handy alphabetical listing to do so.
Acknowledgments

No man (or woman) is an island, and this book is the product of the efforts of several people. Thank you, Terri Varveris, for your support and for making things easier in general, especially at the beginning of this project when my life was difficult at best. Thank you, Pat O’Brien, for keeping me sane and for your excellent guidance in addressing issues I couldn’t figure out how to handle. Thank you, John Edwards, for keeping the manuscript readable. My thanks also go to the CD team at Wiley for producing the Web page on the CD and handling the details of compiling the CD. And, thank you, Jim Peterson, for keeping me technically accurate and for the wonderful insights you added.

Thank you, Bob Woock of the M.I.S. Guy, Inc. in Tampa, Florida, for all the support, expertise and understanding you provided in helping me set up the hardware for this project.

Thank you, Ray Coker and Tom Sherry of Project Server Support, Inc. and John Godley and Alex Ovecka of Project Assistants for the information you provided that expanded my horizons.

My special thanks go to the co-authors of Chapter 25, Ira Brown and Roger Butler of Project Assistants. Ira is the Executive Vice President, CTO, and co-founder of Project Assistants, Inc, a Premier Microsoft Project Partner and Solution Provider specializing in implementation services, integration, training, and custom software development for Microsoft Project. He has extensive project management and application development experience, and is recognized as a leading authority in developing custom solutions for Microsoft Project and Microsoft Project Server. Roger is a Senior Solution Architect with Project Assistants who specializes in custom software development for Microsoft Project and Microsoft Project Web Access and is an integration expert to a variety of third party project management related applications. Ira can be contacted by phone at (800) 642-9259, or email at ibrown@projectassistants.com. Roger can be contacted by phone at (610) 305-4572, or email at roger@projectassistants.com. For more information about Project Assistants, visit their Web site at www.projectassistants.com.

You all helped me make this a better book than I could have produced by myself.
Contents at a Glance

Preface ................................................................. ix
Acknowledgments ................................................... xv

Part I: Project Management Basics .............................. 1
Chapter 1: The Nature of Projects ................................. 3
Chapter 2: Exploring the Microsoft Project Environment .... 21

Part II: Getting Your Project Going ............................ 43
Chapter 3: Creating a New Project ............................... 45
Chapter 4: Building Tasks .......................................... 79
Chapter 5: Creating Resources and Assigning Costs ....... 117

Part III: Refining Your Project ................................. 149
Chapter 6: Understanding the Basics of Views ................ 151
Chapter 7: Using Views to Gain Perspective .................. 203
Chapter 8: Modifying the Appearance of Your Project ...... 245
Chapter 9: Resolving Scheduling Problems ................... 287
Chapter 10: Resolving Resource Problems .................... 309

Part IV: Tracking Your Progress ............................... 333
Chapter 11: Understanding Tracking ............................ 335
Chapter 12: Recording Actuals .................................... 355
Chapter 13: Reporting on Progress ............................. 385
Chapter 14: Analyzing Financial Progress ..................... 411

Part V: Working in Groups ....................................... 439
Chapter 15: Coordinating Multiple Projects Outside Project Server ...... 441
Chapter 16: Using Project in an E-mail Workgroup ......... 469

Part VI: Project, Project Web Access, and Project Server ... 499
Chapter 17: Preparing to Use Project Server .................. 501
Chapter 18: Installing and Configuring Project Server ....... 513
Chapter 19: Organizational Roles and Project Server: The Administrator ...... 561
Chapter 20: Organizational Roles and Project Server:
The Project/Resource Manager ............................. 623
Chapter 21: Organizational Roles and Project Server:
The Day-to-Day User ........................................ 667
Chapter 22: Organizational Roles and Project Server: The Executive .............................. 705

Part VII: Advanced Microsoft Project ......................... 725
Chapter 23: Customizing Microsoft Project .................. 727
Chapter 24: Using Macros to Speed Your Work ................ 757
Chapter 25: Customizing Microsoft Project Using
VBA and Active Scripting ................................... 773
Chapter 26: Importing and Exporting Project Information ........................................... 815
Chapter 27: Project Case Studies ............................. 851

Part VIII: Appendixes ........................................... 873
Appendix A: What’s on the CD-ROM ......................... 875
Appendix B: Project Management Worksheet ................. CD-ROM
Appendix C: Available Fields and Functions for
Custom Field Formulas .................................. CD-ROM
Appendix D: Project Management Resources ............... CD-ROM

Glossary ......................................................... CD-ROM
Index ................................................................ 885
License Agreement ............................................. 925
# Contents

Preface ................................................................. ix
Acknowledgments .................................................... xv

## Part I: Project Management Basics

### Chapter 1: The Nature of Projects .......................... 3

- Understanding Projects ..................................... 3
  - Exploring project management ................................. 4
  - Managing projects with project management software .......... 11
- The Life Cycle of a Project .................................... 14
  - Identifying your goal and the project's scope ................. 14
  - Planning .......................................................... 15
  - Revising ......................................................... 17
  - Tracking .......................................................... 18
  - Learning from your mistakes ................................. 18
- Summary ............................................................ 19

### Chapter 2: Exploring the Microsoft Project Environment .... 21

- Taking a First Look at Project ............................... 21
  - Starting Project .................................................. 23
  - Examining the Gantt Chart view ...................... 28
  - Using Project menus ........................................... 30
  - Examining the toolbars ...................................... 34
  - Entering information ........................................... 35
  - Changing views .................................................. 37
- What’s New in Project 2003 ................................... 38
- Summary ............................................................ 41

## Part II: Getting Your Project Going

### Chapter 3: Creating a New Project ......................... 45

- Gathering Information ......................................... 45
  - Determining detail tasks ....................................... 46
  - Establishing time limits ....................................... 47
  - Lining up your resources ...................................... 47
  - Looking at dependencies ....................................... 48
Chapter 4: Building Tasks

Establishing Timing for Tasks
  Fixed-unit tasks
  Fixed-duration tasks
  Fixed-work tasks
  Effort-driven tasks
Assigning Task Timing
  Using the Task Information dialog box
  Using the Gantt table
  Using your mouse and the task bar
  Setting scheduling options
  Assigning a calendar to a task
  Creating milestones
  Timing for summary tasks
Using Recurring Tasks
Establishing Constraints and Deadline Dates
  Understanding constraints
  Using deadline dates
  Setting constraints and deadline dates
Manipulating the Gantt Chart to View Timing
Entering Task Notes
### Chapter 5: Creating Resources and Assigning Costs  

Understanding Resources  
- How resources work  
- How Project uses resource information to affect the schedule  
- How Project gathers cost information  

Creating a Resource List  

Modifying Resource Information  
- Assigning a communication method  
- Specifying resource availability  
- Specifying a booking type  
- Creating a generic resource and assigning custom fields  
- Adding notes to a resource  
- Calendars and resources  

Using Resources and Tasks  
- Assigning resources to tasks  
- Getting help while selecting resources to assign  
- Some tips about resource assignments  
- Removing or replacing a resource assignment  

Handling Unusual Cost Situations  
- Looking at the project’s cost  
- Assigning fixed costs  
- Accounting for resource rate changes  

Summary  

### Part III: Refining Your Project  

### Chapter 6: Understanding the Basics of Views  

What Is a View?  
- Changing a table  
- Changing a Details section  

Examining Indicators  

Summary
### Contents

- Admiring the Views ................................................. 156
- Calendar .......................................................... 158
- Detail Gantt ....................................................... 159
- Gantt Chart ....................................................... 160
- Leveling Gantt ................................................... 161
- Tracking Gantt .................................................... 162
- Multiple Baselines Gantt ................................. 164
- Network Diagram .............................................. 165
- Descriptive Network Diagram ........................... 169
- Relationship Diagram ..................................... 170
- PERT analysis views ......................................... 171
- Resource Allocation .......................................... 176
- Resource Form .................................................. 177
- Resource Graph ................................................ 178
- Resource Name Form ....................................... 179
- Resource Sheet ................................................ 180
- Resource Usage ............................................... 181
- Rollup views ................................................... 183
- Task Details Form ............................................. 191
- Task Entry ....................................................... 192
- Task Form ....................................................... 193
- Task Name Form .............................................. 194
- Task Sheet ....................................................... 195
- Task Usage ....................................................... 196
- Printing Your Project ........................................... 197
- Summary ......................................................... 202

### Chapter 7: Using Views to Gain Perspective ............................................. 203

- Customizing Views ............................................. 203
- Changing tables ................................................ 203
- Working with views ........................................... 210
- Ordering Tasks in a View ..................................... 216
- Sorting tasks ..................................................... 216
- Creating WBS codes .......................................... 220
- Renumbering WBS codes .................................. 224
- Defining outline numbers .................................. 226
- Filtering Views to Gain Perspective ................... 230
- Applying a filter to a view .................................. 234
- Creating custom filters ..................................... 236
- Using AutoFilters ............................................. 237
- Using grouping .................................................. 238
- Summary .......................................................... 243
Chapter 8: Modifying the Appearance of Your Project .................................. 245
  Changing Project’s Looks ................................................................. 245
  Using the Gantt Chart Wizard .......................................................... 247
  Formatting Elements One by One ...................................................... 251
    Working with text ............................................................................ 251
    Changing taskbars ........................................................................... 254
    Changing network diagrams ............................................................ 263
    Formatting the Calendar view ......................................................... 270
  Inserting Drawings and Objects .......................................................... 273
    Copying pictures .............................................................................. 273
    Using visuals in schedules ............................................................... 278
    Inserting visual objects ................................................................... 279
    Using the Drawing toolbar ............................................................... 281
    Modifying graphics and drawings .................................................... 284
  Summary ............................................................................................ 285

Chapter 9: Resolving Scheduling Problems .............................................. 287
  Resolving Scheduling Conflicts ........................................................... 287
    Adding resources to tasks ................................................................. 288
    Using overtime .................................................................................. 288
    Adding time to tasks ....................................................................... 290
    Adjusting slack ............................................................................... 290
    Changing task constraints ............................................................... 292
    Adjusting dependencies .................................................................. 294
    Splitting a task ............................................................................... 296
  Using the Critical Path to Shorten a Project ........................................ 298
    Identifying the critical path ............................................................... 299
    Shortening the critical path .............................................................. 302
  Using Multiple Critical Paths .............................................................. 305
  Summary ............................................................................................ 308

Chapter 10: Resolving Resource Problems .............................................. 309
  Understanding How Resource Conflicts Occur .................................... 309
  Spotting Resource Conflicts .............................................................. 311
    Using views to spot resource conflicts ............................................. 311
    Using filters to spot resource conflicts ............................................. 313
  Resolving Conflicts .......................................................................... 315
    Changing resource allocations ....................................................... 315
    Scheduling overtime ....................................................................... 318
    Redefining a resource’s calendar ..................................................... 319
    Assigning part-time work ............................................................... 320
## Contents

- Controlling when resources start working on a task ........................................ 322
- Delaying tasks by leveling resource workloads ........................................... 323
- Contouring resources ....................................................................................... 328
- Pooling resources ........................................................................................... 332
- Summary ........................................................................................................... 332

### Part IV: Tracking Your Progress 333

#### Chapter 11: Understanding Tracking .......................................................... 335
- Understanding the Principles of Tracking ....................................................... 335
  - Estimates versus actuals ............................................................................ 336
  - Making adjustments as you go ................................................................. 337
- Using Baselines ............................................................................................... 338
  - What is a baseline? .................................................................................... 338
  - Setting a baseline ...................................................................................... 339
- Changing the Baseline ................................................................................... 341
  - Adding a task to a baseline ...................................................................... 342
  - Using interim plans .................................................................................. 343
  - Clearing a baseline or interim plan ......................................................... 345
- Viewing Progress with the Tracking Gantt View .......................................... 345
  - Interpreting the Tracking Gantt view ....................................................... 346
  - The Task Variance table ......................................................................... 348
  - The Task Cost table ................................................................................. 349
  - The Task Work table .............................................................................. 350
- Understanding Tracking Strategies ................................................................. 351
  - Tackling the work of tracking .................................................................. 351
  - Keeping track of tracking ....................................................................... 352
- Summary ........................................................................................................... 353

#### Chapter 12: Recording Actuals ................................................................. 355
- Organizing the Updating Process .................................................................. 355
- Understanding Calculation Options .............................................................. 356
- Updating Tasks to Reflect Actual Information ............................................ 360
  - Setting actual start and finish dates ......................................................... 360
  - Recording actual durations .................................................................... 361
  - Setting remaining durations .................................................................. 362
  - Setting the Percent Complete value ....................................................... 364
  - Setting work completed .......................................................................... 365
- Using Actuals and Costs ................................................................................ 366
  - Using the Cost table for tasks ................................................................. 367
  - Using the Cost table for resources .......................................................... 368
  - Overriding resource cost valuations ....................................................... 369
Techniques and Tips for Updating

- Tracking work or costs regularly
- Accelerating the updating process
- Letting Project reschedule uncompleted work

Reviewing Progress

- Using the Tracking Gantt view
- Using the Work table for tasks
- Using the Work table for resources
- Viewing progress lines

Summary

Chapter 13: Reporting on Progress

- Reporting Commonalities
- Looking at the Big Picture
  - Project Summary
  - Top Level Tasks
  - Critical Tasks
  - Milestones
  - Working Days
- Generating Reports on Costs
  - Cash Flow
  - Earned Value
  - Budget
  - Overbudget reports
- Producing Reports on Time
  - Unstarted Tasks
  - Tasks Starting Soon
  - Tasks in Progress
  - Completed Tasks
  - Should Have Started Tasks
  - Slipping Tasks
- Making Reports on Work Assignments
  - Who Does What
  - Who Does What When
  - To Do List
  - Overallocated Resources
- Presenting Reports on Workloads
  - Task Usage
  - Resource Usage
- Customizing Reports
  - Custom reports
  - Customizing an existing report

Summary
Chapter 14: Analyzing Financial Progress 411

Understanding Earned Value 411
  Understanding earned value fields 412
  Using earned value tables 417
Evaluating Cost Information 421
  Charting earned value 421
  Analyzing timescaled information 427
  Using PivotTables for analysis 431
Making Adjustments During the Project 436
  Changing the schedule 437
  Modifying resource assignments 437
Summary 438

Part V: Working in Groups 439

Chapter 15: Coordinating Multiple Projects

Outside Project Server 441
Consolidating Projects 441
  Setting up to use consolidation 442
  Inserting a project 444
  Using inserted projects and their source files 450
  Consolidating all open projects: A shortcut 451
  Moving subprojects within a consolidated project 452
Understanding Consolidated Projects and Dependencies 453
  Linking tasks across projects 453
  Changing links across projects 455
  Consolidated projects — to save or not to save 456
Viewing Multiple Projects 458
Viewing the Critical Path across Projects 459
Sharing Resources Among Projects 462
  Creating a resource pool and sharing the resources 463
  Opening a project that uses a resource pool 464
  Updating information in the resource pool 465
  Quit sharing resources 466
Summary 468

Chapter 16: Using Project in an E-mail Workgroup 469

Setting Up an E-mail Workgroup 470
  Editing the registry 470
  Installing the Project Workgroup Message Handler 475
  Setting up the workgroup in Project 475
Building a Resource Workgroup 477
Communicating via E-mail ................................................ 478
  Publishing all information ......................................... 479
  Publishing new and changed assignments .................... 481
  Republishing assignments ....................................... 484
  Requesting a status update .................................... 486
Customizing Your Workgroup ........................................ 487
Establishing Management Procedures .............................. 489
Sending Notes and Routing Files ................................... 489
  Sending Project notes ............................................ 489
  Routing a Project file .......................................... 490
Using the Web Toolbar .................................................. 492
Working with Hyperlinks .............................................. 493
  Inserting a hyperlink ........................................... 494
  Editing hyperlinks ............................................... 495
  Moving or copying hyperlinks ................................... 497
Summary ................................................................. 498

Part VI: Project, Project Web Access, and Project Server 499

Chapter 17: Preparing to Use Project Server ................. 501
  Understanding Project Server and Project Web Access ....... 501
  Planning the Project .............................................. 504
    Assessing requirements ....................................... 504
    Designing the system ......................................... 506
    Developing a strategy for implementation and configuration 509
  Avoiding the Pitfalls ............................................. 510
  Summary ............................................................ 512

Chapter 18: Installing and Configuring Project Server .......... 513
  Reviewing Requirements .......................................... 513
    Meeting software requirements .............................. 514
    Meeting hardware requirements .............................. 515
    Assessing the network environment ......................... 516
    Considering software/hardware scenarios ................... 516
  Installing Peripheral Software .................................. 518
    SQL Server and Analysis Services .......................... 519
    Internet Information Services (IIS) ......................... 521
    Setting up Windows accounts .................................. 524
  Installing and Configuring Windows SharePoint Services .... 528
    Extending the WSS site ....................................... 533
    Completing the integration of Project Server and WSS .... 536
  Installing Project Server ....................................... 539
Connecting to Project Server through Project Web Access ........................................ 549
  Setting up mail server information ................................................................. 552
  Modifying SharePoint portal server information ............................................. 553
  Changing operation modes ................................................................................. 554
  Entering OLAP server information .................................................................. 555
  Entering WSS server information ..................................................................... 556
Troubleshooting Your Installation ........................................................................ 558
Summary .................................................................................................................. 559

Chapter 19: Organizational Roles and Project Server:
The Administrator .................................................................................................. 561
  Double-Checking the Settings .............................................................................. 562
    Specifying Project Server features for your organization ................................ 563
    Managing user authentication options ............................................................. 565
    Managing Windows SharePoint Services ......................................................... 566
    Managing security templates ........................................................................... 568
    Managing groups ............................................................................................... 570
    Working with views .......................................................................................... 571
    Working with categories ................................................................................... 575
  Managing Users .................................................................................................... 578
  Managing Enterprise Project Versions ................................................................. 581
  Working with the Enterprise Global Template .................................................... 583
    Creating custom fields ....................................................................................... 583
    Creating calendars ............................................................................................ 587
  Setting Up and Editing Enterprise Resources ...................................................... 587
    Creating the Enterprise Resource Pool .............................................................. 588
    Editing resources in the Enterprise Resource Pool ........................................... 589
  Importing Projects ............................................................................................... 593
  Setting Up Administrative Projects ..................................................................... 597
  Customizing Project Web Access ......................................................................... 599
    Establishing Project Web Access menus .......................................................... 599
    Establishing tracking settings .......................................................................... 599
    Selecting the Gantt taskbar styles and timescales ............................................ 601
    Selecting grouping formats .............................................................................. 602
    Setting the default home page appearance ...................................................... 603
    Establishing notifications and reminders options .......................................... 604
  Completing Housekeeping Chores ...................................................................... 605
    Managing the OLAP cube .................................................................................. 605
    Updating resource tables ................................................................................... 615
    Checking in enterprise projects and resources ................................................. 616
    Managing information in the Project Server database ..................................... 618
    Managing SharePoint sites and synchronizing administrator accounts ........... 619
Summary .................................................................................................................. 620
Chapter 20: Organizational Roles and Project Server: 
The Project/Resource Manager ............................ 623

Connecting to Project Server .......................... 624
Creating a Project Server logon account ............. 624
Logging on to Project Server ......................... 626
Creating a Web-Based Project ....................... 628
Assigning resources to projects .................... 640
Tracking progress ...................................... 652
Summary ................................................. 665

Chapter 21: Organizational Roles and Project Server: 
The Day-to-Day User ................................. 667

Logging on to Project Web Access .................. 668
Reviewing the Home Page ............................ 669
Changing Your Password ............................ 670
  A word about passwords and security .............. 671
  Setting your password ............................. 672
Working with Your Tasks ............................ 673
  Entering time on tasks ............................ 675
  Adding tasks ....................................... 678
  Project Web Access and Microsoft Outlook ........ 680
  Notifying managers of workday changes .......... 688
  Delegating a task .................................. 690
Working with Documents ............................ 692
  Attach supporting documents to projects ......... 693
  Viewing documents ............................... 694
  Posting a document ............................... 695
  Creating a document library ...................... 697
Viewing Information .................................. 698
Reporting Status ..................................... 702
Logging Off .......................................... 704
Summary ................................................. 704

Chapter 22: Organizational Roles and Project Server: 
The Executive .......................................... 705

Reviewing Your Portfolio ............................ 705
Identifying Trends and Potential Problems ........ 708
Answering the Famous “What If” Question ........ 713
Summary ................................................. 724
## Part VII: Advanced Microsoft Project 725

### Chapter 23: Customizing Microsoft Project 727

Using Custom Fields ........................................ 727  
Customizing data entry ...................................... 728  
Using formulas in custom fields ............................ 732  
Customizing the Interface ................................... 737  
Windows taskbar icons ...................................... 737  
Saving Project files ......................................... 739  
Using the Organizer .......................................... 741  
Making changes to toolbars ................................. 742  
Customizing project menus ................................. 751  
Summary ......................................................... 756

### Chapter 24: Using Macros to Speed Your Work 757

Using Macros .................................................. 757  
Recording Macros ............................................ 758  
Running Macros ............................................... 761  
Using Shortcuts to Run Macros ............................. 762  
Assigning a macro to a toolbar button ..................... 762  
Assigning a macro to a menu command ..................... 766  
Assigning a keyboard shortcut to a macro ................. 770  
Summary ......................................................... 772

### Chapter 25: Customizing Microsoft Project Using VBA and Active Scripting 773

Example One: Creating a Filter to See Critical Tasks and Resource Assignments ...................................... 774  
Recording a macro to create a filter for critical tasks .................................................. 774  
Editing the macro to show only specified resources .................................................. 778  
Testing the code .................................................. 781  
Example Two: Creating a UserForm Object to Adjust Work Designing the UserForm .................................. 784  
Adding code to the UserForm ................................ 793  
Adding a sub procedure to show the UserForm ............ 799  
Example Three: Customizing the Project Guide Content of the Project Guide XML document .................. 802  
Project Guide XML document elements ...................... 803  
Defining the Project Guide for a project ................... 806  
Summary ......................................................... 814
### Chapter 26: Importing and Exporting Project Information . . . . . . 815

- Understanding General Importing and Exporting Concepts . . . . . . 815
- Exporting Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . 816
  - Exporting to Office files . . . . . . . . . . . . . . . . . . . . . . . . . . . 816
  - Exporting Project information to a graphic image . . . . . . . . 826
  - Exporting to other formats . . . . . . . . . . . . . . . . . . . . . . . . . . 828
  - Saving Project files as Web pages . . . . . . . . . . . . . . . . . . . . . 830
  - Creating XML files from Project data . . . . . . . . . . . . . . . . . . . 832
- Importing Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . 835
  - Inserting another project . . . . . . . . . . . . . . . . . . . . . . . . . . . 835
  - Importing Office files . . . . . . . . . . . . . . . . . . . . . . . . . . . . 835
  - Importing other files . . . . . . . . . . . . . . . . . . . . . . . . . . . . 846
- Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 847
  - Project imports incorrect times in data from Microsoft Excel . . . 848
  - Linked or embedded objects don’t import or export . . . . . . . . 848
  - The export file contains more or less information than expected . . . 848
  - Project imports invalid information . . . . . . . . . . . . . . . . . . . . 849
  - The values of imported information change . . . . . . . . . . . . . 849
  - The imported project is empty . . . . . . . . . . . . . . . . . . . . . . . 849
  - Project displays imported information in the wrong fields . . . . . 849
- Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 850

### Chapter 27: Project Case Studies . . . . . . . . . . . . . . . . . . . . . . 851

- Case 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 851
  - Problem statement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 852
  - Problem solution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 852
  - Business Benefits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 854
  - Problem solvers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 855
- Case 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 855
  - Problem statement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 855
  - Problem solution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 856
  - Problem solvers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 856
- Case 3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 856
  - Problem statement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 857
  - Problem solution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 857
  - Problem solvers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 858
- Case 4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 858
  - Problem statement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 858
  - Problem solution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 859
  - Problem solver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 860
## Contents

<table>
<thead>
<tr>
<th>Case 5</th>
<th>Case 6</th>
<th>Case 7</th>
<th>Case 8</th>
<th>Case 9</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem statement</td>
<td>Problem statement</td>
<td>Problem statement</td>
<td>Problem statement</td>
<td>Project statement</td>
<td></td>
</tr>
<tr>
<td>Problem solution</td>
<td>Problem solution</td>
<td>Problem solution</td>
<td>Problem solution</td>
<td>Project solution</td>
<td></td>
</tr>
<tr>
<td>Problem solver</td>
<td>Problem solver</td>
<td>Problem solvers</td>
<td>Problem solvers</td>
<td>Problem solvers</td>
<td></td>
</tr>
</tbody>
</table>

860

864

866

868

869

870

860

864

866

868

869

870

871

### Part VIII: Appendixes

873

**Appendix A: What’s on the CD-ROM**  
875

**Appendix B: Project Management Worksheet**  
CD-ROM

**Appendix C: Available Fields and Functions for Custom Field Formulas**  
CD-ROM

**Appendix D: Project Management Resources**  
CD-ROM

Glossary  
CD-ROM

Index  
885

License Agreement  
925
Project Management Basics

In This Part

Chapter 1
The Nature of Projects

Chapter 2
Exploring the Microsoft Project Environment
The Nature of Projects

Everybody does projects. Building a tree house is a project; so is putting a man on the moon. From the simplest home improvement to the most complex business or scientific venture, projects are a part of most of our lives. But exactly what is a project, and what can you do to manage all its facets?

Some projects are defined by their randomness. Missed deadlines, unpleasant surprises, and unexpected problems seem to be as unavoidable as the weekly staff meeting. Other projects have few problems. Nevertheless, the project that goes smoothly from beginning to end is rare. Good planning and communication can go a long way toward avoiding disaster. And although no amount of planning can prevent all possible problems, good project management enables you to deal with those inevitable twists and turns in the most efficient manner possible.

In this chapter, you begin exploring tools and acquiring skills that can help you become a more efficient and productive project manager. The goal of this chapter is to provide a survey of what a project is, what project management is, and how Microsoft Project 2003 fits into the picture.

Understanding Projects

When you look up the word *project* in the dictionary, you see definitions such as “plan” and “concerted effort.” A project in the truest sense, then, isn’t a simple one-person effort to perform a task. By this definition, getting yourself dressed — difficult though that task may seem on a Monday morning — isn’t a project.
A project is a series of steps that are typically performed by more than one person. In addition, the following items describe a project:

- **A project has a specific and measurable goal.** You know you have finished the project when you have successfully met your project goal.

- **Projects have a specific time frame.** The success of a project is often measured by how successfully the project has been completed within the amount of time allotted to it.

- **Projects use resources.** Resources aren’t just people; resources can include money, machinery, materials, and more. How well these resources are allocated and orchestrated is another key measure of a project’s success or failure.

- **All projects consist of interdependent, yet individual, steps called tasks.** No piece of a project exists in a vacuum. If one task runs late or over budget, it typically affects other tasks, the overall schedule, and the total cost of the project.

Projects can last for months or even years. By their nature, projects are dynamic; they tend to grow, change, and behave in ways that you can’t always predict. Consequently, you, as a project manager, have to remain alert to the progress and vagaries of your projects or you will never reach your goals. Documentation and communication are your two key tools for staying on top of a project throughout its life.

**Exploring project management**

*Project management* is a discipline that examines the nature of projects and offers ways to control their progress. Project management attempts to organize and systematize the tasks in a project to minimize the number of surprises that you may encounter.

Project management and project managers concern themselves with the following key areas:

- Scheduling
- Budgeting
- Managing resources
- Tracking and reporting progress
To manage these aspects of projects, certain tools have evolved over the years. Some of these are conceptual, such as the critical path; others involve specific formats for charting progress, such as a Gantt Chart. The following sections introduce some key project management concepts and tools.

**Critical path and slack**

The critical path marks the series of tasks in a project that must be completed on time for the overall project to stay on schedule. For example, suppose that you are planning a going-away party at your office. You have three days to plan the party. The following table lists some of the tasks that are involved and indicates their time frames.

<table>
<thead>
<tr>
<th>Task</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signing the good-bye card</td>
<td>three days</td>
</tr>
<tr>
<td>Ordering food</td>
<td>one day</td>
</tr>
<tr>
<td>Reserving a room</td>
<td>one hour</td>
</tr>
<tr>
<td>Buying a good-bye gift</td>
<td>one day</td>
</tr>
</tbody>
</table>

The shortest task, reserving a room, takes only one hour. Assuming that plenty of rooms are available for holding the party, you can delay reserving the room until the last hour of the third day. Delaying this task doesn’t cause any delay in holding the party — as long as you accomplish this task by the end of the longest task, which is getting everyone to sign the good-bye card. Therefore, the task of reserving a room isn’t on the critical path. However, you can’t delay the task of signing the good-bye card, which is projected to take three days to accomplish, without delaying the party. Therefore, the card-signing task is on the critical path. (Of course, this example is very simple; typically, a whole series of tasks that can’t afford delay form an entire critical path.)

The following points further define and clarify these concepts:

- ♦ The critical path changes as the project progresses. Remember that a *critical path* is a means of identifying tasks that have no leeway in their timing to ensure that they don’t run late and affect your overall schedule. Knowing where your critical path tasks are at any point during the project is crucial to staying on track. Figures 1-1 and 1-2 show the same schedule — first with all tasks displayed and then filtered to show only the tasks that are on the critical path.
Figure 1-1: Tasks with slack displayed alongside those on the critical path.

Cross-Reference
See Chapter 7 to find out how to filter for only critical tasks and to see more information about changing the view of your project.

✦ Slack, also called float, is the amount of time that you can delay a task before that task moves onto the critical path. In the preceding example, the one-hour-long task — reserving a room — has slack. This task can slip a few hours, even a couple of days, and the party will still happen on time. However, if you wait until the last half-hour of the third day to reserve a room, that task will have used up its slack and it then moves onto the critical path.

Durations and milestones
Most tasks in a project take a specific amount of time to accomplish. Tasks can take anywhere from five minutes to five months. The length of time needed to complete a task is called the task’s duration. You should always try to break the long tasks in a project into smaller tasks of shorter duration so that you can track their progress more accurately. For example, break a five-month-long task into five one-month tasks. Checking off the completion of the smaller tasks each month reduces the odds of a serious surprise five months down the road — and makes you feel like you’re getting something done.
Some tasks, called milestones, have no (0) duration. Milestones are merely points in time that mark the start or completion of some phase of a project. For example, if your project involves designing a new brochure, the approval of the initial design may be considered a milestone. You can assign a duration to the process of routing the design to various people for review, but assigning a length of time to the moment when you have everyone’s final approval is probably impossible. Therefore, this task has a duration of 0 — that is, approval of the design is a milestone that simply marks a key moment in the project.

**Resource-driven schedules and fixed-duration tasks**

Some tasks take the same amount of time — no matter how many people or other resources you devote to them. Flying from San Francisco to New York is likely to take about five hours, regardless of how many pilots or flight attendants you add. You can’t speed up a test on a mixture of two solvents that must sit for six hours to react by adding more solvent or by hiring more scientists to work in the laboratory. These tasks have a fixed duration, meaning that their timing is set by the nature of the task. (These tasks are also called fixed tasks.)
On the other hand, the number of available resources can affect the duration of some tasks. For example, if one person needs two hours to dig a ditch, adding a second person will likely cut the time in half. The project still requires two hours of effort, but two resources can perform the task simultaneously. Tasks whose durations are affected by the addition or subtraction of resources are called resource-driven tasks.

In real-world projects, this calculation is seldom so exact. Because people have different skill levels and perform work at different speeds, two people don’t always cut the time of a task exactly in half. In addition, the more people you add to a task, the more communication, cooperation, and training may be involved. Although Microsoft Project handles additional assignments of resources as strictly a mathematical calculation, you can still use your judgment of the resources that are involved to modify this calculation (see Chapter 10).

**Diagrams that aid project management**

Gantt Charts, network diagrams, and work breakdown structures (WBSs) are tools of project management that have evolved over many years. These tools are simply charts that you can use to track different aspects of your project. Figure 1-3 shows a Microsoft Project Gantt Chart, and Figure 1-4 shows a Microsoft Project network diagram. Figure 1-5 shows a typical WBS, although Microsoft Project does not include a WBS chart as one of its standard views.

![Figure 1-3: The Gantt Chart bars represent timing of the tasks in a project.](image)
Figure 1-4: The network diagram resembles a flow chart for work in a project.

Figure 1-5: The work breakdown structure chart reminds you of a typical company’s organization chart.
You can purchase an add-on product (WBS Chart Pro) to create a WBS chart from a Microsoft Project file. The CD-ROM that is included with this book features a sample of the program.

Before people used computers to manage their projects, managers drew these charts by hand. Any self-respecting project war room had a 10-foot network diagram, WBS, or Gantt Chart tacked to the wall. By the end of the project, this chart was as marked up and out of date as last year’s appointment calendar. Thankfully, project management software makes these charts easier to generate, update, and customize.

A Gantt Chart represents the tasks in a project with bars that reflect the duration of individual tasks. Milestones are shown as diamond-shaped objects.

You can find out more about the various elements of the Gantt Chart in Chapter 2. For this chapter’s purposes, you simply need to know that a Gantt Chart enables you to visualize and track the timing of a project.

Network diagrams, on the other hand, don’t accurately detail the timing of a project. Instead, a network diagram shows the flow of tasks in a project and the relationships of tasks to each other. Each task is contained in a box called a node, and lines that flow among the nodes indicate the flow of tasks.

In Project 98 and prior versions of Project, network diagrams were called PERT charts. PERT stands for Program Evaluation and Review Technique. The Special Projects Office of the U.S. Navy devised this method for tracking the flow of tasks in a project when it was designing the Polaris submarine in the late 1950s.

The U.S. defense establishment uses the WBS as its primary tool for managing projects and describes the WBS in Military Standard (MIL-STD) 881B (25 Mar 93) as follows: “A work breakdown structure is a product-oriented family tree composed of hardware, software, services, data and facilities . . . [It] displays and defines the product(s) to be developed and/or produced and relates the elements of work to be accomplished to each other and to the end product(s).”

MIL-STD 881B was superseded by MIL-HDBK 881, 2 January 1998. The forward of the newer documents states that there were “no substantive changes in work breakdown structure definition.” The full text is available on many DOD sites (e.g., http://dcarc.pae.osd.mil/881handbook/milhdbk881_cover_chap1.pdf).

Project doesn’t contain a PERT chart view. However, on the enclosed CD-ROM, you can find a sample version of PERT Chart EXPERT, a program that converts the information in any Project file to a PERT view.
Dependencies
The final project management concept that you should understand is dependencies. The overall timing of a project isn’t simply the sum of the durations of all tasks, because all tasks in a project don’t usually happen simultaneously. For example, in a construction project, you must pour the foundation of a building before you can build the structure. You also have to enclose the building with walls and windows before you lay carpeting. In other words, project managers anticipate and establish relationships among the tasks in a project. These relationships are called dependencies. Only after you have created tasks, assigned durations to them, and established dependencies can you see the overall timing of your project.

Chapter 4 covers several kinds of dependencies.

Managing projects with project management software
Many people manage projects with stacks of outdated to-do lists and colorful hand-drawn wall charts. They scribble notes on calendars in pencil, knowing — more often than not — that dates and tasks will change over time. They hold numerous meetings to keep everyone in the project informed. People have developed these simple organizational tools because projects typically have so many bits and pieces that no one can possibly remember them all.

To manage a project, you need a set of procedures. Project management software automates many of these procedures. With project management software, you can do the following:

✦ **Plan upfront:** By preplanning the various elements of your project, you can more accurately estimate the time and resources that are required to complete the project.

✦ **View your progress:** By examining your progress on an ongoing basis from various perspectives, you can see whether you are likely to meet your goal.

✦ **Recognize conflicts:** By identifying time and resource conflicts early, you can try out various what-if scenarios to resolve them before the project gets out of hand.

✦ **Make adjustments:** You can make adjustments to task timing and costs, and automatically update all other tasks in the project to reflect the impact of your changes.

✦ **Generate professional-looking reports:** You can create reports on the status of your project to help team members prioritize and to help management make informed decisions.
With improved workgroup, intranet, and e-mail capabilities, Microsoft Project also makes communication and cooperation among workgroup members much easier and more productive.

Project 2003 expands the capabilities of Project Server, which is Project’s tool to manage projects in a Web-based environment. For more details, see Chapters 17 through 23.

What’s required of you

Many people contemplate using project management software with about as much relish as they contemplate their next visit to the dentist. They anticipate hours of data-entry time before they can get anything out of the software. To some extent, that vision is true. You have to provide a certain amount of information about your project for any software to estimate schedules and generate reports, just as you have to enter numbers for a spreadsheet to calculate a budget or a loan payback schedule.

On the other hand, after you enter your basic project information into Microsoft Project, the ongoing maintenance of that data is far easier than generating handwritten to-do lists that become obsolete almost immediately. In addition, the accuracy and professionalism of reports that you generate with Project can make the difference between a poorly managed project and a successful one. As with a quarterly budget that you create with spreadsheet software, after you enter the data, Project performs its calculations automatically. And, using Project makes it easy for you to quickly spot potential problems and to test alternative solutions.

So, exactly what do you have to do to manage your project with Microsoft Project? To create a schedule in Microsoft Project, you must enter the following information about your tasks:

- Individual task names
- Task durations
- Task dependencies

To track the costs of these tasks, you add certain information about resources, including the following:

- The list of human and material resources and their costs for both standard and overtime hours
- The assignment of resources to specific tasks
To track a project over its lifetime, you need to enter the following information:

- Progress on tasks
- Changes in task timing or dependencies
- Changes in resources — that is, resources that are added to or removed from the project
- Changes in resource time commitments and costs

**What Microsoft Project can do to help**

Even though you still must enter a great deal of information into your project schedule, Microsoft Project has various shortcuts that can help you automate this chore. These shortcuts are as follows:

- **Project templates**: If you often do similar types of projects, you can create project templates with typical project tasks already in place; you can then modify the templates for individual projects. Project comes with templates to help you get started.

  You can take advantage of sample project templates, which can be found on this book’s companion CD-ROM. These templates represent a cross section of typical industries and project types.

- **Automating repeated tasks**: If you have tasks that repeat throughout the life of a project, such as weekly meetings or regular reviews, you can create a single repeating task, and Project duplicates it for you.

- **Importing existing task lists**: You can create projects from tasks that you’ve set up in Outlook, or you can use Excel to start your project and then easily import the spreadsheet into Project.

  Using a COM add-in, Project 2003 supports exchanging task information with Outlook.

- **Exchanging task information with Outlook**: You can download project tasks into Outlook from Project Web Access, work on them, record the work in Outlook, and then upload the updated information to Project Web Access.

  See Chapter 3 for more information about starting projects in Outlook and Excel and then moving them into Project 2003. See Chapter 22 for more information on exchanging task information with Outlook.
Workgroup tracking: You can use workgroup features that enable individual team members to enter and track progress on smaller pieces of the project. By tracking with this method, no individual person has to enter an overwhelming amount of data. Also, team members feel more accountable and involved in the project.

See Parts V and VI of this book, “Working in Groups Outside Project Server” and “Project, Project Web Access, and Project Server,” respectively, for detailed information about working in groups.

Macros: You can take advantage of Microsoft Visual Basic to build macros that automate repetitive tasks, such as generating weekly reports.

See Chapter 25 for more information about using macros to speed your work.

The Life Cycle of a Project

Projects typically consist of several phases. Understanding the nature of each phase can help you relate the features of Microsoft Project to your own projects.

Identifying your goal and the project’s scope

Before you can begin to plan a project, you have to identify the goal, which isn’t always as obvious as it sounds. Various participants may define a project’s goal differently. In fact, many projects fail because the team members are unwittingly working toward different goals. For example, is the team’s goal to perform a productivity study or to actually improve productivity? Is the outcome for your project to agree on the final building design, or is it to complete the actual construction of the building? As you analyze your goal and factor in the perspectives of other team members, make sure that your project isn’t just one step in a series of projects to reach a larger, longer-term goal.

To identify your goal, you can use various communication tools, such as meetings, e-mail, and conference calls. Most importantly, you should conduct a dialogue at various levels (from management through front-line personnel) that gets ideas on the table and answers questions. Take the time to write a goal statement and circulate it among the team members to make sure that everyone understands the common focus of the project.

Be careful not to set a long-range goal that is likely to change before the project ends. Smaller projects or projects that have been broken into various phases are more manageable and more flexible.

See Chapter 17 for tips on avoiding pitfalls during project planning.
After you understand your goal, you should also gather the information that you need to define the project’s scope. This endeavor may take some research on your part. The scope of a project is a statement of more specific parameters or constraints for its completion. Project constraints usually fall within the areas of time, quality, and cost, and they often relate directly to project deliverables.

The following are some sample goal and scope statements:

**Project A:**
- **Goal:** To locate a facility for our warehouse.
- **Scope:** By October 15, to find a modern warehouse facility of approximately 5,200 square feet, with a lease cost of no more than $3,000 per month, in a location that is convenient to our main office.

**Project B:**
- **Goal:** To launch a new cleaning product.
- **Scope:** Includes test-marketing the product, designing packaging, and creating and launching an advertising campaign. The launch must be completed before the end of the third quarter of 2003 and can cost no more than $750,000.

Notice that the second scope statement designates major phases of the project (conducting test marketing, designing packaging, and creating an ad campaign). This statement provides a starting point for planning the tasks in the project. In fact, you may eventually decide to break this project into smaller units of conducting test marketing, designing packaging, and launching an advertising campaign. Writing the scope of the project may encourage you to redefine both the goal and the scope to make the project more manageable.

Keep your goal and scope statements brief. If you can’t explain your goal or scope in a sentence or two, your project may be overly ambitious and complex. Consider breaking the project into smaller projects.

Writing a simple goal and scope statement ensures that you’ve gathered key data—such as deliverables, timing, and budget—and that you and your team agree on the focus of everyone’s efforts. These activities are likely to occur before you ever open a Microsoft Project file.

**Planning**

When you understand the goal and scope of a project, you can begin to work backward to determine the steps that you need to take to reach the goal. Look for major phases first, and then break each phase into a logical sequence of steps.
Planning for resources is one aspect of planning the entire project. Resources can include equipment of limited availability, materials, individual workers, and groups of workers. Take into account various schedules and issues, such as overtime, vacations, and resources that are shared among projects. Time, money, and resources are closely related: You may be able to save time with more resources, but resources typically cost money. You need to understand the order of priority among time, quality, and money.

There’s truth to the old joke: Time, budget, or quality—pick two. Devoting resources (which usually become costs) to a schedule can decrease the time but can also cause loss of quality control. Extending the time can improve quality but usually causes resource conflicts and added costs. Microsoft Project helps you see the trade-offs among these three important criteria throughout the life of your project.

Planning is the point at which you begin to enter data in Microsoft Project and see your project take shape. Figure 1-6 shows an initial Microsoft Project schedule.

**Figure 1-6:** The outline format of a Project schedule clearly shows the various phases of your project. Dependencies among tasks have not yet been established; every task starts at the same time, which isn’t always possible.
Revising

Most of the time, you send an initial project schedule to various managers or coworkers for approval or input so that you can refine the schedule based on different factors. You can use the reporting features of Microsoft Project to generate several drafts of your plan.

Chapter 13 explains more about the reports that are available in Project.

Be prepared to revise your plan after everyone has a chance to review it. You may want to create and save multiple Project files to generate what-if scenarios based on the input that you receive. Seeing your plans from various perspectives is a great way to take advantage of Project’s power.

Find out more about what-if analysis in Chapter 6.

Finding resolutions to conflicts in timing and resource allocation is another aspect of planning and revising. Project helps you pinpoint these conflicts, which may include the following:

- A team member or resource that is booked on several projects at once
- A task that begins before another task that must precede it
- An unusually high use of expensive equipment in one phase that is upsetting your budget

This book contains many tips and techniques for resolving conflicts. In particular, Chapters 9 and 10 focus on using Microsoft Project features to resolve scheduling and resource problems.

When your project plan seems solid, you can take a picture of it, called a baseline, against which you can track actual progress.

Chapter 11 explains how to set (and, if necessary, clear) baselines.
Tracking
You should try to solidify your tracking methods before your project begins. Ask yourself the following questions:

✦ Do you want to track your progress once a week or once a month?
✦ Do project participants track their own work or merely report their progress to you?
✦ Do you want to roll those smaller reports into a single, less-detailed report for management?

The answers to these questions can also help you determine if you need to use Project Standard, Project Professional, or Project Server. See Chapter 2 for more information on choosing the Project product that best suits your needs.

Knowing how you are going to track your project’s progress, and who needs to know what and when, helps your team establish efficient tracking mechanisms from the outset; this reduces frustration.

The Microsoft Project schedule shown in Figure 1-7 uses the Tracking Gantt view to show the original baseline (the bottom bar of each task) tracked against actual progress (the top bar of each task).

You can save interim baselines of a schedule at various points during your project. This approach helps you see where major shifts occurred and shows how you accommodated those shifts. See Chapter 11 for more information on baselines.

Learning from your mistakes
Learning project management software isn’t like learning to use a word processor. Project management entails conceptual layers that transcend the tools and features of the software. Having the experience and wisdom to use these features effectively comes from repeated use. You probably won’t be a proficient Microsoft Project user right away. You have to work through one or more projects before you really know the most effective way to enter information about your project. You can expect to develop efficient tracking methods over time. Don’t worry — it took you time to learn all you know about managing projects. If you pay attention to what goes on during your projects when you first implement Microsoft Project schedules, you can learn from your mistakes.

Microsoft Project enables you to review your projects and to clearly see where you estimated incorrectly, made adjustments too slowly, or didn’t break phases into manageable chunks. Project keeps your original schedule’s baseline in a single file, along with interim baselines and your final tracked schedule. When planning future projects, you can use these older baselines to help gauge the duration of tasks and the cost of certain items and to know how many resources are enough resources.
Figure 1-7: The darker portion of each upper task bar and the percentage figure to the right of each upper task bar indicate the percentage of each task that is complete.

In the end, you’ll be a more successful and efficient project manager. You can easily show your boss the specific actions that you’ve taken to avoid problems and provide solutions. In addition, you’ll have the tools that you need to help you and your manager understand the issues that you face and to get the support that you need.

Summary

This chapter presented a survey of the discipline known as project management and explained the role that project management software can play to help you manage projects. The following topics were covered:

- Projects involve a stated goal, a specific time frame, and multiple resources (which can include people, equipment, and materials).
- Project management seeks to control issues of time, quality, and money.
- Critical path, slack, task durations, milestones, fixed tasks, resource-driven tasks, and dependencies are project management elements that help you build and monitor a project.
Project management software can assist you in planning, tracking, and communicating with team members and in reporting on projects with tools such as Gantt Charts and network diagrams.

Although using Project takes some effort on your part, this effort pays off in increased productivity and efficiency.

Projects typically have five activities: Setting the goal and defining the scope, planning, revising, tracking, and reviewing to learn from your mistakes.

Chapter 2 takes a closer look at the Project environment and provides information about some of the tools that you can use to manage a project.
Microsoft Project has come a long way in the past few years. It now sports an interface that makes managing a project almost as easy as maintaining your personal calendar. If you’re a user of other Microsoft 2003 products, such as Word or Excel, the menus and tools that are in Project should, hopefully, look like old friends. And although Project’s many views can be a bit overwhelming at first, they enable you to choose the perspective that you need to monitor the progress of your project at any given time.

This chapter introduces Project’s environment as well as the powerful tools that Project places at your disposal. You practice moving among different views, and you work with some of the tools and on-screen elements that you can use to create schedules.

Taking a First Look at Project

Two versions of Microsoft Project 2003 will be available. You can purchase Project 2003 Standard or Project 2003 Professional. These products differ only in the way that they support Project Server, which is Project’s tool to manage projects on the Web.
The functionality of Project Server has been expanded, and you can no longer use Project Server with Project Standard 2003 like you could with Project Server 2002. Instead, to use Project Server 2003, you must also use Project Professional 2003. In this book, I assume that you’re using Project Professional.

See Part VI for more information on using Project Server.

If you are not connected to Project Server, you’ll see no difference in functionality between Project 2003 Standard and Project 2003 Professional. You see commands in Project 2003 Professional that you don’t see in Project 2003 Standard, but the commands aren’t available for use.

See Part VI for more information about Project Server and Project Web Access.

Although Microsoft Project doesn’t come with Microsoft Office software, Project is a member of the Microsoft Office family. Consequently, Project uses the standard Microsoft Office menu and toolbar structure and contains some of the familiar Microsoft Office tools.

What is Project Server?

Project Server enables you to manage projects on your company’s intranet or on the Internet — and only the manager must install and use Microsoft Project. Everyone else on the project uses Project Web Access, the Web-based product that connects to the Project Server database that contains your project data. You open Project Web Access by typing the URL to the Project Server database into Internet Explorer version 5.5 (or later). Using Project Web Access instead of Microsoft Project, resources can, among other things, do the following:

✦ View a project’s Gantt Chart
✦ Receive, refuse, and delegate work assignments
✦ Update assignments with progress and completion information
✦ Attach supporting documentation, such as budget estimates or feasibility studies, to a project
✦ Receive notices about task status
✦ Send status reports to the project manager

Project managers can do even more than resources. For example, by using Project Server, project managers have access to a company-wide resource pool (called the Enterprise Resource Pool) that tracks resource allocations across projects. If a project manager finds that a specific resource is unavailable, he can define the requirements for the job and let Project Server tools search the Enterprise Research Pool to find another resource with the same skills.
Chapter 2 ✦ Exploring the Microsoft Project Environment

Project contains a View bar that functions similarly to the one in Outlook, Microsoft's organizer, e-mail, and calendar program. It enables you to switch among views and functions in the software. You can choose to hide or display the View bar. Open the View menu; if a check appears next to View Bar, Project displays the View bar. Click View Bar to remove the check and hide the View bar.

The figures throughout this book don’t show the View bar.

Starting Project

When you open Microsoft Project from the Programs folder of the Windows Start menu, Project initially displays the main screen for Project 2003, as shown in Figure 2-1. On the left, you see the new Getting Started pane, which is common to Office 2003 products. The Getting Started pane helps users open files, start a new project, and, if connected to the Internet, get information about Project 2003 from Microsoft Office Online, which supplies new, updated Help information in addition to the Help information that comes with Project.

Figure 2-1: The first screen that you see when you start Project looks familiar, because it shows the Getting Started pane that also appears in all other Office 2003 products.
You also can open Project by double-clicking any Project file. Project files are saved with the extension .mpp.

In Chapter 3, you find out about the Help features that Project provides.

The Getting Started pane, new to Project 2003, is found in Office 2003 products.

Once you start a project, the Project Guide, a goal-based user interface that helps you build projects, replaces the Getting Started pane (see Figure 2-2). The Project Guide is composed of both the Project Guide pane on the left side of the screen and the Project Guide toolbar, which appears just above the Project Guide pane.

Figure 2-2: The Project Guide helps you build your project. The buttons on the Project Guide toolbar control the information that appears in the Project Guide pane.
To display the Project Guide toolbar, right-click any toolbar and choose Display Project Guide.

At this point, you can use the Project Guide toolbar and the Project Guide pane to begin building your project. Click a button on the Project Guide toolbar to start working in the associated area. The options that appear in the Project Guide pane change, based on the Project Guide toolbar button that you click.

When you click a link in the Project Guide, a wizard starts and walks you through the process that’s suggested by the link. For example, if you click the Tasks button on the Project Guide toolbar and then click the Define the project link, a three-step wizard walks you through starting a project. The first step helps you to establish the starting date for your project. After setting the date, click the right arrow at the top of the pane or click Save and go to Step 2 at the bottom of the Project Guide pane to continue (see Figure 2-3). In Step 2 of the Define the Project Wizard, you identify whether you’re going to use Project Server. In Step 3, you return to the Project Guide.

If you click the Define general working times link, the Project Guide helps you establish a calendar for your project (see Figure 2-4).
When you click the Define general working times link, the Project Guide helps you establish a calendar for your project.

Figure 2-4: When you click the Define general working times link, the Project Guide helps you establish a calendar for your project.

New Feature

The Project Guide for Printing Wizard is new to Project 2003.

If you click the Report button on the Project Guide toolbar, you find a link in the Project Guide pane that enables you to print what you see — the Print current view as a report link (see Figure 2-5). The four-step process helps you do the following:

✦ Determine the number of pages for the report
✦ Change the size of the report by modifying elements such as the timescale or the columns
✦ Set up the header, footer, and legend
✦ Set other options to change the margins, print notes, configure manual page breaks, and more

You also can preview the report on-screen before you print.

You can customize the Project Guide so that it offers you options to work the way that your organization works. See Chapter 26 for some examples on customizing the Project Guide.
Figure 2-5: The new Print current view as a report link walks you through a four-step process to print what you see on-screen.

If you decide that you don’t want to use the Project Guide (perhaps it eats up too much screen real estate for your taste), you can hide the pane and the toolbar. To temporarily hide the pane, click the X in the upper-right corner of the pane. To temporarily hide the toolbar, right-click any toolbar and click Project Guide to remove the check mark that appears next to it.

To turn off the Project Guide feature entirely, open the Options dialog box (choose Tools ➪ Options) and click the Interface tab. Then, remove the check mark from the Display Project Guide box.

See Chapter 24 for more information on setting options in Project.

After you’ve hidden the pane, you see the blank Project screen in the Gantt Chart view, as shown in Figure 2-6.
Figure 2-6: A blank project contains no project information. When you enter information in the Gantt Chart view, the split pane displays the data both textually and graphically.

Project always opens a new project in the Gantt Chart view. You see other views throughout this book, but you’re likely to spend a great deal of your time in the Gantt Chart view. This view offers a wealth of information about your project in a single snapshot. In most table views, you find a fill handle, which you can use to populate columns, just as you use a fill handle in Excel.

Cross-Reference
For details about the other views that are available in Project, see Chapter 6.

Examining the Gantt Chart view
The Gantt Chart view has two main sections: the Gantt table and the Gantt Chart. After you enter task information, the Gantt table (in the left pane) holds columns of information about your project, such as the task name, duration, start date, and more. The Gantt Chart (in the right pane) is a graphic representation that helps you see the timing and relationships among tasks, as shown in Figure 2-7.
The timescale along the top of the Gantt Chart acts like a horizontal calendar. Think of it as a ruler against which you draw the tasks in your project. Instead of marking off inches, however, this ruler marks off the hours, days, weeks, and months of your project. Project enables you to display up to three timescales along the top of the Gantt Chart — a top, middle, and bottom timescale. In Figure 2-7, you see two timescales. The top timescale shows months, and the bottom timescale shows weeks. Multiple timescales help you to see the multiple levels of timing at the same time, such as the day and hour or the month, week, and day.

You can customize your timescale to increase or reduce the amount of information that appears on the right side of the Gantt Chart or to show unusual time increments, such as thirds of months. In Figure 2-7, I customized the timescale to show week increments. Double-click the timescale itself to display the Timescale dialog box. You can adjust settings for all three timescales in the Timescale dialog box. Also, note that Project uses default settings for the number of hours in a workday, days in a week, and so on. To adjust these settings to display or hide nonworking days, you can use the settings on the Non-working Time tab in the Timescale dialog box.
In Chapter 3, I explain how to modify the calendars that control a project, and in Chapter 4, I explain how to set the timescale.

You can modify what you see on-screen in the Gantt Chart view, and Project carries those modifications to other views. After you practice moving among these views, you can see information about timing, budget, or resource assignments in detail, or you can just look at the big picture. You can also customize what each view shows you. For example, you can use the divider that runs between the Gantt table and Gantt Chart to adjust the amount of space that each pane occupies. Dragging this divider to the right reveals more columns of project data in the Gantt table. Dragging the divider to the left displays more of the project’s task bars in the Gantt Chart.

In addition to modifying how much of each pane you display on-screen, you can zoom in or out to view larger or smaller time increments for different perspectives of your project’s schedule. You can show smaller time increments in the Gantt Chart by clicking the Zoom In button, or you can show larger increments of time by clicking the Zoom Out button. A daily perspective on a three-year project enables you to manage day-to-day tasks, whereas a quarterly representation of your project may be more useful when you’re discussing larger issues with your management team.

Notice that the two panes of the Gantt Chart view have their own sets of scroll bars at the bottom of the window. To perform actions on information, you must use the appropriate scroll bar and select objects in the appropriate pane.

**Using Project menus**

The menus in Project 2003, which you access via the menu bar at the top of the screen, work like the menus in Office XP and Office 2003: by default, commands are available “on demand.” That is, when you open a menu, you see a small subset of commands that Microsoft believes you’ll use most often. In addition, at the bottom of the menu, you see a pair of downward-pointing arrows, as shown in Figure 2-8. If you highlight the pair of arrows (or pause for a few moments), Project displays the other commands that usually appear on the menu, as shown in Figure 2-9. After you select a command, that command appears on the menu as soon as you open the menu.
Figure 2-8: Initially, only a subset of commands appears on a menu.

You can change this menu behavior so that all commands appear on a menu when you open it. To do this, use the Customize dialog box.

The Customize dialog box is described in detail in Chapter 24.

Several of the menus in Project offer commands that are probably quite familiar to you, such as Save, Print, and Copy. Other menus on the menu bar are specific to the tasks that you perform with Project.

Table 2-1 shows the various types of functions that you can perform from each menu.
Figure 2-9: When you pause or click the down arrows at the bottom of the menu, the rest of the menu commands appear.

Table 2-1
Microsoft Project Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Types of Functions Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Open and close new and existing files; save and print files; adjust page setup and document properties; and route files to e-mail recipients.</td>
</tr>
<tr>
<td>Edit</td>
<td>Cut, copy, and paste text or objects; manipulate data with Fill, Clear, and Delete commands; link and unlink task relationships; and locate information with Find, Replace, and Go To commands.</td>
</tr>
<tr>
<td>View</td>
<td>Select various default views of your project; access standard report formats; choose to display or hide various toolbars; use the Zoom feature; and enter header and footer information.</td>
</tr>
</tbody>
</table>
Menu | Types of Functions Available
---|---
Insert | Insert new tasks, another Project file, or columns in views and insert various objects into your schedule, including drawings, Excel charts, Word documents, media clips, and even hyperlinks to Web sites.
Format | Adjust the appearance of text, task bars, and the Timescale display and change the overall appearance of a view’s layout.
Tools | Run or modify Spelling and AutoCorrect functions to proofread your schedule; access workgroup features; establish links between projects; and modify your working calendar or resources. You can also customize standard views and functions with the Organizer, Options, or Customize commands; record macros; and initiate tracking functions. If you’re using Project 2003 Professional, you can set Enterprise options.
Project | Display task or project information or notes, and use commands to sort or filter tasks to see specific details. You can also control outlining features of your project tasks.
Collaborate | Publish project information to Project Server, request or update progress information, view the Project Center and Resource Center, analyze or model a portfolio, discuss risks and issues, view documents posted by other users, and set Collaboration options. If you’re using Project Standard, you don’t see this menu.

The remaining two menus, Window and Help, contain commands to arrange windows on-screen and to access Help features, respectively.

See Chapter 3 for more information on the Help system in Project.

Microsoft has placed corresponding tool symbols and keyboard shortcuts (such as Delete or Ctrl+F) next to the menu commands, as shown in Figure 2-10. This display helps you to get things done more quickly in Project. Notice also that the main menus sometimes open up submenus (also called side menus or cascading menus). A black arrow to the right of a command indicates the presence of a submenu. Finally, if you choose a menu command followed by an ellipsis (…), such as Find … or Replace …, Project displays a dialog box.
Figure 2-10: Tool symbols appear to the left and keyboard shortcuts appear to the right of commands on Project menus. Submenus offer more choices, and dialog boxes appear if you click a menu command that is followed by an ellipsis.

Examining the toolbars

You're probably already familiar with tools in Windows programs and the way in which they appear by category on toolbars. When you open Project, two default toolbars are visible: the Standard toolbar and the Formatting toolbar. These are shown in Figure 2-11.

Figure 2-11: The Standard toolbar and the Formatting toolbar are the default toolbars in Project.

You may see both toolbars appear on one row when you open Project. In this case, you also don’t see all the tools that are displayed in Figure 2-11. You can change the appearance so that the toolbars appear on two rows, as I’ve done throughout this book. If you choose to keep both toolbars on one row, you can access the buttons that don’t appear by clicking the Toolbar Options down arrow, which appears at the end of each toolbar, and then clicking the button that you want to use.

Tip

If you move your mouse over the Toolbar Options down arrow and pause, a screen tip appears to help you identify it.
To change the appearance of the toolbars in Project, use the Customize dialog box, which is discussed in Chapter 24.

In some software programs, the available tools are context-sensitive, that is, they change according to the function that you’re performing. In Project, the default toolbars are fairly consistent. Some tools become unavailable when you perform different functions or change views. In these cases, the tools appear grayed out, and nothing happens when you click them.

If you insert an object into your project from another Microsoft application, such as Excel or PowerPoint, the other program’s environment replaces the toolbars and menus in Project when you select that object. Therefore, you can use the other program’s tools to modify the object without leaving Project. The toolbars and menus in Project reappear when you click outside the inserted object.

In addition to the Standard and Formatting toolbars, Project contains several other toolbars, some of which appear automatically when you’re performing certain types of activities. However, you can also display any of these toolbars at any time by choosing View ➪ Toolbars and selecting from the toolbar submenu that appears.

These toolbars appear as floating toolbars when you choose to display them. You can move floating toolbars anywhere on your screen by dragging their title bars. Alternatively, you can anchor a floating toolbar at the top of your screen near the default toolbars. To do so, simply drag the toolbar (using its title bar) to the top of the screen. Conversely, you can convert the Standard and Formatting toolbars into floating toolbars. To do so, just click anywhere on a toolbar — except on a tool — and drag the toolbar to any position on your screen.

**Entering information**

Several views or portions of views in Project, such as the Gantt table, use a familiar spreadsheet-style interface. Information appears in columns and rows. The intersection of a column and a row is an individual cell. Each task in your project has an ID number, which is indicated by the numbers that run along the left of the spreadsheet. You can enter information either in dialog boxes or directly into cells. When you select a cell, the Entry bar displays the information in the cell.

For more information on entering information in dialog boxes, see Chapter 4.

When you press Delete, Project deletes just the selected cell. Prior to Project 2002, Project deleted an entire row instead of a single cell.
If you’ve ever used Microsoft Excel or one of the other popular spreadsheet programs, you already know how to enter and edit information in Project. When you begin typing in a cell, the insertion point appears in the cell to the right of any text that you enter. To edit text in a cell, click once to select the cell and then press F2 or click a second time at the location in the cell where you want to begin editing. If you press F2, the insertion point appears at the right edge of the text in the cell. If you click a second time, the insertion point appears in the cell at the location where you clicked the second time.

As you enter information into a cell, the information also appears in the Entry bar, which runs along the top of the screen directly under the Formatting toolbar. The Entry bar in Project serves the same purpose as the Entry bar in Excel. You can type new text or edit existing text by clicking anywhere within the text in the Entry bar. Two buttons on the left of the bar (an X and a check mark) enable you to cancel or accept an entry, as shown in Figure 2-12.

Figure 2-12: You can enter or edit text in individual cells or in the Entry bar.

Chapter 4 covers entering and editing text in greater detail.
Changing views

Project offers multiple views in which you can display project information. A single view can’t possibly show all the information that you need to see regarding timing, relationships among tasks, resource allocations, and project progress. In fact, each type of information requires special kinds of graphical and textual displays for you to interpret it accurately. Think of a project as a small business. As in any business, different people attend to various aspects of the work. The accounting department thinks mainly of the costs of doing business. The plant supervisor focuses on operations and having enough machinery and manpower to get the job done. Your human resources department thinks of people — their salaries, hours, benefits, and so on. As the owner of your project, you are likely to wear all these hats (and more) during the project. With Project, switching to another view to see your work from a different perspective is the equivalent of changing hats as you move from one responsibility to another. Each view helps you to focus on a different aspect of your project. The View bar or the View menu enables you to jump from view to view, as shown in Figure 2-13.

Figure 2-13: The View bar and View menu offer several predefined views of your project.
The View bar contains icons for eight views; click the down arrow near the bottom of the bar to see them all. When you move down the View bar, an up arrow appears near the top of the bar so that you can return to the top of the View bar. You can display any of the views listed here by clicking it in the View bar. Similarly, the View menu contains commands for the same eight views; you can display any of the views that are listed on the View menu by clicking the command.

At the bottom of the View bar and on the View menu, you can see an item called More Views. Click More Views to open the More Views dialog box, as shown in Figure 2-14.

![Figure 2-14: The More Views dialog box lists 24 built-in views — you can add your own as well.](image)

In Chapter 6, you find out more about which view you should use to gain a specific perspective on your project. In Chapter 7, you discover how to create custom views by clicking New in the More Views dialog box.

**What’s New in Project 2003**

Rather than describing all the new features in Project 2003 at this point in the book, the following section describes just a few of them — and then provides a table that shows you where you can find more information in this book on other new features.
You can easily find the new features in the chapters in which I discuss them in detail. Simply look for the New Feature icon that appears next to the discussion of a new feature in Project.

Most of the new features in Project 2003 affect Project Server.

As I mentioned earlier, Project is not part of Office 2003, but Project is part of the Office family. For this reason, you see some of the same interface features in Project 2003 that you find in Office 2003, such as the Getting Started pane that I discussed earlier in this chapter.

As you find out in Chapter 3, Project's Help system works the same way as the Help system in Windows XP and Office 2003 products. Project displays help choices in a pane on the left side of the screen, where you usually see the Getting Started pane and the Project Guide pane. Whenever you search for help, Project automatically searches both the local Help system and, if you're connected to the Internet, searches an online Help system (see Figure 2-15).

**Figure 2-15:** The Help system in Project works the same way as its counterpart in Windows XP and Office 2003 products.
In Chapter 7, you find out about your new ability to use pick lists in the Values field when you create filters.

Project Server has many new features, as you see in Chapters 18 through 24. For example, in Project 2002, you could import task lists from Outlook into Project Server. In Chapter 22, you find out how to download Project Server tasks that are assigned to you into your Outlook Task List. Furthermore, you can use your Outlook Task List to create and work on tasks and then upload the information to Project Server. In Project 2003, you can use a COM add-in to exchange information with Outlook; my crystal ball suggests that you may see full integration of this feature in the next release of Project.

Table 2-2 provides a list of the new features in Project — and includes the chapter in which you can find information about a particular new feature.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Guide for Printing Wizard</td>
<td>2</td>
</tr>
<tr>
<td>Assistance Center</td>
<td>3</td>
</tr>
<tr>
<td>Help Pane</td>
<td>3</td>
</tr>
<tr>
<td>Web-based Training</td>
<td>3</td>
</tr>
<tr>
<td>Spotlights</td>
<td>3</td>
</tr>
<tr>
<td>Resources Booking Type</td>
<td>5</td>
</tr>
<tr>
<td>Value List in Filters</td>
<td>7</td>
</tr>
<tr>
<td>Copy Picture to Microsoft Office</td>
<td>8</td>
</tr>
<tr>
<td>Sample Database</td>
<td>18</td>
</tr>
<tr>
<td>Enterprise Resource Multi-Valued Fields</td>
<td>19</td>
</tr>
<tr>
<td>Protect Actual Work/Adjust Actual Work</td>
<td>19</td>
</tr>
<tr>
<td>Adjusting Locked Down Actual Work</td>
<td>19</td>
</tr>
<tr>
<td>Timesheet Lock Downs</td>
<td>19</td>
</tr>
<tr>
<td>Protect Saved Baselines</td>
<td>19</td>
</tr>
<tr>
<td>Risk Management</td>
<td>19</td>
</tr>
<tr>
<td>Define Timesheet Views</td>
<td>19</td>
</tr>
<tr>
<td>Multiple Timesheet Approvers</td>
<td>20</td>
</tr>
<tr>
<td>Feature</td>
<td>Chapter</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Enterprise File Open Dialog</td>
<td>20</td>
</tr>
<tr>
<td>Delete Resources</td>
<td>20</td>
</tr>
<tr>
<td>Document Check-in/Check-out</td>
<td>21</td>
</tr>
<tr>
<td>Document Versions</td>
<td>21</td>
</tr>
<tr>
<td>Pick Lists and Lookup Tables in Enterprise Custom Fields</td>
<td>21</td>
</tr>
<tr>
<td>Microsoft Outlook Integration</td>
<td>21</td>
</tr>
<tr>
<td>Renamed Custom Fields Appear on Views Page</td>
<td>21</td>
</tr>
</tbody>
</table>

Summary

This chapter introduced the Project 2003 environment and the many ways in which you can display project information. This chapter also described the following techniques:

✦ Understanding the Project screen
✦ Using Project menus and toolbars
✦ Entering information in your project

Chapter 3 covers how to get help in Project and how to save Project files.
Getting Your Project Going

In This Part

Chapter 3
Creating a New Project

Chapter 4
Building Tasks

Chapter 5
Creating Resources and Assigning Costs
Creating a New Project

Now that you have some project management concepts under your belt and you’ve taken a stroll around Project’s environment, you are ready to create your first schedule. Before you type a single date into a Project schedule, however, you must first assemble the relevant information about your project. Then you can open a new Project file and begin to build your project tasks by using a simple outline structure.

In this chapter, you begin to build your first Project schedule and find out how to save your project. At the end of the chapter, you read about how to take advantage of Project’s various Help features.

Gathering Information

As you read in Chapter 1, several elements must be in place before you can begin to build a project schedule. First, you must understand the overall goal and scope of the project so that you can clearly see the steps that lie between you and that goal. You’ll find delineating the major steps of the project a good place to start. Don’t worry about the order of the tasks at this point — just brainstorm all the major areas of activity. For example, consider a project such as organizing an annual meeting for your company. You may take the following steps:

✦ Book the meeting space
✦ Schedule speakers
✦ Arrange for audiovisual equipment
✦ Order food
✦ Send out invitations
✦ Mail out annual reports
The last item on that list raises the question of scope: Is it within the scope of your project to create the annual report, or should you simply obtain copies of a report from the marketing department, for example, and mail them to stockholders before the meeting? In some corporations, the person who is responsible for organizing the annual meeting is also responsible for overseeing the production of the annual report. Be sure to answer questions of scope and responsibility at this stage of your planning.

For this example, you can assume that another department is creating the annual report. You simply need to make sure that someone mails copies of the report to all stockholders before the annual meeting.

**Determining detail tasks**

After you have prepared a list of major tasks, break them into more detailed tasks. Take one of the items on the list — Order food, for example — and consider how you can break down this task. How detailed should you get? The following is one possible breakdown of the Order food task:

- Create a budget.
- Determine a menu.
- Select a caterer.
  - Send out requests for bids.
  - Receive all estimates.
  - Review estimates and award contract.
- Give final headcount to caterer.
- Confirm caterer one week before the meeting.

Could you do without the detailed tasks under Select a caterer? Do you need more details under Create a budget? Those decisions are up to you, based on your knowledge of your project and procedures. However, keep the following points in mind:

- Create tasks that remind you of major action items, but don’t overburden yourself with items of such detail that keeping track of your schedule becomes a full-time job. That’s the purpose of daily to-do lists.

- Include milestones to mark off points in your project. For example, the Review estimates and award contract task under the summary task Select a caterer is a milestone — it marks a point in time by which you want to have made a major decision. If that time comes and goes and you haven’t selected the caterer, will missing this deadline affect other subsequent tasks? If so, including that milestone could be vital to your success.
Include tasks that management should know about, because you’ll use the Project schedule to report progress. If your boss wants to see that you’ve sent out a purchase order to the caterer per your new Accounting department procedures, you may want to include the task (even if you don’t think that this level of detail is important).

**Establishing time limits**

After you have an idea of the tasks that are involved in your project, you need to have some idea of the timing of these tasks. Should you allow two weeks for caterers to reply with bids? Not if you have only three weeks to organize the meeting. You may want to approach determining task timing by building an initial schedule in Project, assigning time to tasks, and seeing how close you can come to your deadline. If you’re way off, you can go back and tweak the timing for individual tasks until your schedule works.

You may be tempted to trim time off your tasks to make them fit a deadline, but this approach tends to produce an unrealistic schedule. What is the solution? Use the initial schedule to convince your boss that you need more time, money, or resources to complete this project on time. If he or she wants to trim time from a specific task to meet the deadline, you may have grounds to ask for more help.

At this early planning stage, get any information that you need to assign timing to tasks. For example, contact vendors or subcontractors to get their timing estimates, which you need to reflect in your schedule. If your project has a drop-dead completion date, you should be aware of it. However, leave it to Project to show you whether your estimates work in an overall schedule.

**Lining up your resources**

Before you can build a Project schedule, you must understand what resources are available to you, as well as their costs. You don’t necessarily have to know these resources by name, but you should know, for example, that your project needs three engineers at a cost of $75 per hour and one piece of earthmoving equipment at a daily rental cost of $450.

You need to identify these resources and assign them to individual tasks early in the project-planning process. Find out anything you can about the availability of these resources: Are some resources available only half-time for your project? Will all the engineers be unavailable during the third week of August because of a professional conference? Research the cost and availability of resources as much as possible as you begin to build a project.

For more information about identifying resources and assigning them to individual tasks, see Chapters 5 and 21.
Looking at dependencies

Finally, before you enter project information into a schedule, be aware of relationships among tasks. Does the CEO have to approve the menu before you book the caterers? Are you required to wait three weeks after applying for a permit before starting construction on a building? If your project faces issues involving the order and relationships of tasks, you will save yourself some headaches down the line and build a more realistic schedule if you can identify these obstacles now.

Opening a Project File

You can start a project file in a couple of different ways. In this section, you first see the “usual” way to start a file. Then, I cover how to use templates with project files.

Opening a project file — the usual way

Okay, you’ve done your homework. You’ve made some notes about your upcoming project’s tasks, timing, resources, and dependencies. You’re ready to start building your first schedule in Project. Choose Start➪Programs➪Microsoft Project. You see the main Project window, where you can begin building a task outline.

When you first open Microsoft Project — depending on how you have your Enterprise options set — you may be prompted to connect to Project Server or to work offline. To work offline, simply click My Computer and then click the Work Offline button.

To learn how to set Project Server options, see Chapter 19.

Other ways to open or start projects

You can base your project on one of the templates that became available in Project 2000. Templates contain “standard” information to help you get started quickly. Instead of entering tasks, you may need only to edit tasks. Choose File➪New. In the New Project task pane that appears, click one of the three links that are available to search for templates. You can search at the Office Online Web site, on your computer, or on your Web sites.

You may need your Project 2003 CD to install the template.

To open a project that you previously saved, you can use the Getting Started task pane shown in Figure 3-1. If you see the project that you want to open listed in the Open section of the Getting Started task pane, click the project name.
Instead of the Getting Started task pane, you might see the Search Results, Help, or New Project task panes at the left side of the screen. If so, click the task pane arrow and then click Getting Started. If you see the Project Guide instead of any of the task panes, and you want to display the Getting Started task pane, right-click any toolbar and choose Task Pane.

Otherwise, click More in the Open section of the Getting Started task pane to display the Open dialog box (see Figure 3-2) and navigate to the folder where you store projects to open the project.

If you’re using Project Server, you see the Open from Microsoft Project Server window, in which you can choose a project that’s available through Project Server. If your project is not stored in the Project Server database, click the Open from File button and then navigate to the folder where you saved your project.

Figure 3-1: The Getting Started task pane appears on the left side of the Project window and enables you to create new projects from templates or to open existing projects.
Figure 3-2: Use the Open dialog box to navigate to the folder where you store projects, and select a project to open.

Establishing Basic Project Information

Use the Project Information dialog box, shown in Figure 3-3, to supply basic information about the new project that you want to set up. If this box doesn’t automatically appear, choose Project ➪ Project Information to display it.

Figure 3-3: The Project Information dialog box tracks basic information about each project.

Tip

You can make the Project Information dialog box appear automatically whenever you start a new project by checking the Prompt for project info for new projects box on the General tab of the Options dialog box. Choose Tools ➪ Options to open the dialog box.
You can enter the following eight pieces of information in the Project Information dialog box:

✦ **Start date:** If you set a start date for the project, all tasks begin on that date until you assign timing or dependencies to them.

✦ **Finish date:** If you know your project’s deadline, you can enter it here and then work backward to schedule your project. You must change the setting in the Schedule from field to make this option available.

✦ **Schedule from:** You can build schedules from completion to start by setting this field to Project Finish Date. Alternatively, you can build your schedule from the start date forward by accepting the default setting, Project Start Date.

✦ **Current date:** Project uses your computer’s current date setting for the default entry in this field. To use a different date, change the date in this field. You can adjust this setting to generate reports that provide information on your project as of a certain date or to go back and track your project’s progress from an earlier date.

✦ **Status date:** This field performs earned-value calculations and identifies the complete-through date in the Update Project dialog box. Status date also enables Project to place progress lines in your project. If you leave the status date set at NA, Project sets the status date as your computer’s current date setting.

✦ **Calendar:** You can select the calendar on which to base your schedule. The Standard calendar is the default — it schedules work eight hours a day, five days a week.

✦ **Priority:** You can establish a priority for each project in addition to setting priorities for tasks — a numerical value between 1 and 1,000. The project level priority plays a role when you use shared resources across multiple projects. Setting a project priority helps you to better control how resource leveling adjusts tasks when you share resources across projects.

✦ **Enterprise Custom Fields:** If your organization uses Project Server, you may need to assign values to project-level custom fields or outline codes that are defined in the Project Server database. You see an asterisk (*) next to any required custom field or outline code. Enter either a start or finish date — only one is available to you, depending on the choice that you’ve made in the Schedule from field. If you schedule from the project start date, Project defaults the constraint type for all new tasks to As Soon As Possible (ASAP). And, as you would expect, if you schedule from the project finish date, Project defaults the constraint type for all new tasks to As Late As Possible (ALAP).

To enter one of these dates, click the down arrow next to the text box. (The arrow is not available if the Schedule from field isn’t set for that choice.) Select a date from the pop-up calendar, as shown in Figure 3-4.
Figure 3-4: Use the arrow keys at the top of this calendar to choose other months.

If you decide to schedule backward from the finish date, Project can’t use tools such as resource leveling to resolve conflicts in your schedule.

You can change the project’s start date during the planning phase, trying out alternative what-if scenarios by modifying this field. As you build your tasks going forward, Project indicates the finish date as dictated by the length of your tasks and their timing relationships. When you’re satisfied with the overall time frame, you can set the start date that works best when you’re ready to begin.

Tip

If you have already begun the project, you can set the start date to a date in the past to accurately reflect the real start date. Tasks on the Gantt Chart appear to have occurred before the current date line.

If you know the date by which something must be completed (as with the annual meeting project, for example, or a Christmas party that must happen on December 25), you can schedule tasks by moving backward from the finish date. When you do this, Project builds the tasks going back in time. You may be surprised when Project generates a schedule telling you that you should have started three weeks earlier to finish on time. In that case, you can either add resources to get the work done faster or reduce the scope of the project.

Cross-Reference

In Chapters 9 and 10, you read about techniques that you can use to help you resolve scheduling and resource problems.

When beginning a new schedule, you typically accept the default settings for Current date and Status date. After your project is under way, changing these default settings affects project tracking and the material that is generated in project reports.

For now, you can keep all the default settings (that is, scheduling from the start of the project, having the current date be today, and starting the project today, as well
as basing your schedule on the standard calendar). Click OK to close the Project Information dialog box.

Looking at Project Calendars

The Project Information dialog box enables you to set the basic parameters of the project’s timing. Those parameters and the information that you’re about to enter for specific tasks are based on the base calendar.

You can create a base calendar for each group of resources in your project. For example, if the plant employees work a 9-hour day from 6:00 a.m. to 3:00 p.m., and the office employees work an 8-hour day from 8:00 a.m. to 5:00 p.m., you can create two base calendars. When you assign one day of an office employee’s time, Project understands it to be an 8-hour day. In the Project Information dialog box, you designate whether you want your project to use a standard, 24-hour, or night-shift calendar for most of your work assignments.

If you’re using Project Standard, the preceding information is absolutely true. If you’re using Project Professional, it’s almost all true. When using Project Professional, you can create your own base calendars (for both projects and tasks) if you’re working offline and storing the project locally (not in the Project Server database). If you store the project in the Project Server database, you can create base calendars only if the administrator has given you the rights to do so.

Project also supports resource calendars and task calendars in which you can set exceptions to base calendars for specific resources or to tasks in your project whose work hours are different from the rest of the resources or tasks.

You find out more about task calendars in Chapter 4 and more about resource calendars in Chapter 5.

Setting calendar options

Project makes default assumptions about certain items that form the basis of the default base calendar (or the project calendar). For example, Project assumes that the default week contains five working days and 40 working hours. Project uses this calendar for resources unless you assign a different calendar to them. You can see the assumptions that Project uses on the Calendar tab of the Options dialog box.

The Calendar tab of the Options dialog box does not affect scheduling. The options that you see in this dialog box show you the defaults that Project uses to convert durations into corresponding time amounts. For example, if you enter 1mo for a task’s duration, Project assumes that you are allotting one month (which is equal to 20 days) for that task.

To view the default calendar options, choose Tools ➪ Options. Click the Calendar tab in the Options dialog box, as shown in Figure 3-5.
Figure 3-5: By reviewing the settings on the Calendar tab in the Options dialog box, you ensure that you and Project are speaking the same language when you enter task-duration information.

Any changes that you make to these options apply to the current schedule only. To save your changes across all schedules, click the Set as Default button on the Calendar tab.

You can select any day of the week as your start day. For example, if you run a restaurant that closes on Sundays and Mondays, you may want to designate a workweek of Tuesday through Saturday. In that case, you would set the Week starts on field to Tuesday.

If your company uses a fiscal year other than the calendar year (January through December), you may want to set the Fiscal year starts in option. This setting is especially useful when you generate reports that show costs per quarter or year.

The final five settings on the Calendar tab of the Options dialog box enable you to designate specific start and end times for each day, the number of hours in a day and in a week, and the number of days in a month. For example, you can set the workday to start at 9:00 a.m. and end at 6:00 p.m., assign 9 hours to your workday (no lunch for you!), and end up with a 45-hour week.

Setting schedule options

You also can modify the way in which Project enters task information. In the Options dialog box (if it isn’t open, choose Tools➪Options), click the Schedule tab.
to change the default settings for entering tasks, as shown in Figure 3-6. On this tab, you determine the default unit of time for entering task durations (the default is days), work time (hours), and whether new tasks start on the project start date or the current date. For example, if you are working on a five-year project in which most tasks run for months — not days — you may want to change the default setting for the Duration is entered in field. If you prefer to have any new tasks begin no earlier than the current date, you can adjust the setting for New tasks. As you gain experience in entering information, you will find ways to customize Project to match your work style.

![Image of the Schedule tab]

**Figure 3-6:** The Schedule tab is where you modify the default settings for entering tasks.

When you are satisfied with the settings on the Schedule tab, click OK to close the Options dialog box.

### Creating a new calendar

The Standard calendar may not work for your project under all circumstances. You may find that all members of a specific group of resources work on the same calendar, but their calendar is different from the Standard calendar. For a group such as this, you can create a special resource calendar.

You use calendars to manage task schedules. You can also modify the calendars of resources to mark time when the resources aren’t available. In Chapter 4, you read more about task calendars. In Chapter 5, you find out more about resource calendars.
For example, suppose that you run a print shop and each project that you complete requires you to use the printing press, but the press requires cleaning and maintenance each week for two hours on Thursday afternoon. To make sure that each printing project considers the maintenance requirement of the printing press, you can create a Press calendar that considers the need to shut the press down for cleaning and maintenance. Then you can assign the Press calendar to the Press Time task that you create for each project.

As previously mentioned, if you're using Project Standard, everything you're about to read works automatically. However, if you're using Project Professional, you can create your own base calendars (for both projects and tasks) if you're working offline and storing the project locally and not in the Project Server database. If you store the project in the Project Server database, you can create base calendars only if the administrator has given you the rights to do so. Also, the privilege to create base calendars doesn’t permit you to change the Standard calendar.

To create a new, project-wide calendar, choose Tools ➤ Change Working Time to display the Change Working Time dialog box, as shown in Figure 3-7.

Figure 3-7: By default, Project displays the settings for Standard (Project Calendar) in the Change Working Time dialog box.

If other calendars exist, you see them listed in the For list box. You can create a custom calendar by clicking the New button. Project then displays the Create New Base Calendar dialog box, as shown in Figure 3-8.
To model your calendar on an existing calendar, select the existing calendar from the Make a copy of drop-down box. Provide a name for the new calendar in the Name box.

By default, Project suggests that you copy the calendar that you were viewing when you chose the New button. In particular, I suggest that you make a copy of the Standard calendar rather than modifying it. That way, you can always use the original Standard calendar if you need it.

Click OK to create the new calendar, and then make changes to it in the Change Working Time dialog box. To change the working hours for a particular day, make sure that you use the For list box to select the calendar that you want to change, and then make your changes. The Legend panel on the left side of the dialog box identifies Working, Nonworking, Edited working hours, and edits to a day of the week or an individual day on the current calendar.

To select contiguous days on the calendar in the Select Dates section, click the first day. Then press Shift as you click the last day that you want to select. To select noncontiguous days, press Ctrl as you click each day that you want to select. Scroll up to see an earlier month; scroll down to see a later month. To select all Sundays, for example, click the letter that corresponds to the day. Project selects all Sundays in all months.

In the Set selected date(s) to section, make the necessary changes in the From and To text boxes, or use the Set selected date(s) to option buttons. Because you set an exception to the regular schedule, the dates (or days) that you selected appear underscored in the calendar. In Figure 3-9, May 26 is not using the default calendar. Even if you don’t select a particular date, you can tell that the day contains non-standard working hours by comparing the shading for the date to the legend.

You don’t need to select the Nondefault working time option button if you’re changing the hours for a particular day. Although the dialog box continues to show that the Use default option is selected, Project automatically selects the Nondefault working time option button.

Reselecting a date and clicking the Use default option button returns the date to its originally scheduled time on that date. Therefore, clicking the Use default option button for Sundays means “don’t schedule work on Sundays:”
Figure 3-9: Project marks exceptions to the typical schedule with an underscore.

Entering Tasks

To begin building a project, enter the major steps to reach your goal in roughly the same order that you expect them to occur. (Don’t worry if you’re not quite accurate about the sequence of events; Project makes it easy to reorganize tasks in your schedule at any time.)

You can use the Project Guide to help you enter tasks. Display the Project Guide toolbar (simply right-click any toolbar and click Project Guide), and click the Tasks button. In the Project Guide pane, click the List the tasks in the project link. You see helpful information on entering tasks.

For the sample project (organizing a corporate annual meeting), follow these steps to create your first task — booking the meeting space:

1. Click the Task Name column in the first row of the Gantt table.
2. Type Book Meeting Space. The text appears in the cell and in the entry bar that is above the Gantt table.
3. Press Enter to accept the text.

You also can accept an entry in a cell by clicking the check mark button that’s located to the left of the entry bar, by pressing a directional arrow key on your keyboard to move to another cell, by clicking another cell with your mouse pointer, or by pressing Tab.

Information begins to appear in your schedule. For example, Project lists the task name in the Task Name column and makes a corresponding entry in the Duration column. The question mark in the Duration column represents an estimated duration. (Remember the default setting in the Schedule tab of the Options dialog box?)
The default length of new tasks is estimated at one day. The question mark that you see in the Duration column represents the estimation that Project makes.) According to the Start column, the task begins today. In addition, a task bar reflects the one-day duration of the task graphically.

Chapter 4 contains more information about estimated durations.

If you use the scroll bar that is located at the bottom of the Gantt table to move to the right, you see the Finish Date entry. Because this is a one-day task, it will be completed by the end of the day.

You also can drag the bar that divides the Gantt table from the Gantt Chart to expand the visible area of the Gantt table.

Using either your mouse pointer or the down-arrow key, move to the second row in the Task Name column and enter Schedule Speakers as the next task. Then enter the following tasks in the next four rows: Arrange for Audio/Visual Equipment, Order Food, Send Invitations, and Mail Annual Reports. Your schedule should now look like that shown in Figure 3-10.

Figure 3-10: Note that each task is the same length by default, and each begins on the project start date.
Adding Subtasks

After you enter the major tasks in your project, you can begin to flesh out the details by adding subordinate tasks, also referred to as subtasks. When you add subtasks, the upper-level task becomes a summary task. Summary tasks and subtasks provide an easy-to-apply outline structure for your schedule.

Project’s outline approach also enables you to display and print your project information with various levels of detail. For example, with only summary tasks showing, you see a higher-level overview of the project that you may want to present to management. On the other hand, you can reveal the details of only one or two phases of a project so that you can discuss those tasks with the people who will be performing them. The outline structure gives you a lot of flexibility in working with your schedule.

You can use the Project Guide to help you organize your project outline. On the Project Guide toolbar (to display the toolbar, right-click any toolbar and then click Project Guide), click Tasks. Then click the Organize tasks into phases link.

When you insert a new task, it appears above the currently selected task. Begin by adding subtasks under the Book meeting space task. Follow these steps to insert a new task:

1. Click the Schedule Speakers task.
2. Choose Insert ➤ New Task. Row 2 becomes a blank row, and all the other tasks move down one row. Your cursor rests in the new task row.
3. Type Request Purchase Order, and click the check mark button to accept the new task.
4. Click the Indent button on the Formatting toolbar (it looks like a right-facing arrow) to indent the subtask, as shown in Figure 3-11.

By default, summary tasks appear in boldface type and subtasks appear in normal type. However, some people like to differentiate these task types even more. In traditional outlining, the capitalization of items may vary, depending on their level. For example, you can capitalize the first letters of all the words in the summary tasks (headline style) and capitalize only the first letter of the first word in the subtasks (sentence style), as in this example. The choice is yours. However, if you decide to use some special effect as you enter text, be consistent so that others looking at your schedule can recognize your system. And, if others are to work on your schedule, make sure that they follow the formats that you have established.

Notice that the summary task (Book Meeting Space) now displays a solid black line on the Gantt Chart, with a down arrow shape marking its beginning and end. When a task becomes a summary task (that is, when it contains subtasks), the timing of the summary task reflects the total amount of time that is required to complete the subtasks. If a task has a duration assigned to it and you make it into a summary task, the timing of the subtasks overrides the assigned duration. If you change the timing of a subtask, the summary task duration changes to reflect the change.
You can add other subtasks by following these steps:

1. Click the Schedule Speakers task.
2. Press Insert (which is a shortcut to choosing Insert ➪ New Task). A new blank row appears.
3. Type Select Room, and press Enter to accept the new task. The new task uses the same level of indentation as the task above it.
5. Type Confirm Space, and press Enter to accept the new task. The new task uses the same level of indentation as the task above it.
6. Press Insert.
7. Type Order Flowers, and press Enter to accept the new task.

Each of these new tasks indents to the subordinate level. However, the third new task is not a subtask of the Book Meeting Space summary task. To move the task higher in the outline hierarchy, simply select the new task and use the Outdent button on the toolbar. You can also use your mouse to move the task as follows:
1. Move your mouse over the first few letters of the Order Flowers task name until the mouse pointer becomes a two-way pointing arrow.

2. Drag the task to the left until a thick gray line indicates that the task is lined up with the upper-level tasks in the outline, as shown in Figure 3-12.

![Figure 3-12: You can use your mouse to drag tasks in or out in the outline hierarchy.](image)

3. Release the mouse button to complete the move.

Your schedule now looks like the schedule shown in Figure 3-13. Adding details is as simple as inserting new tasks wherever you want them and then moving the tasks in or out in the outline structure.
Figure 3-13: The outline structure enables you to see summary tasks and subtasks as manageable chunks of work.

Saving Project Files

Of course, you should always save your work frequently. With the often-mission-critical information that is centralized in a Project file, frequent saving is even more important. When saving Project files, you have the option of setting up protection for them. You can also save your files as templates, that is, files on which you can base other schedules.

Saving files

To save a Project file for the first time, choose File ➤ Save or click the Save tool on the Standard toolbar. In the Save As dialog box, specify the name of the file, where to save the file, and what format you want to use, as shown in Figure 3-14.

The format of Project 2003 files is the same as that of Project 2002 and Project 2000 files, but the format of these versions is different from the format of Project 98 files. You can, however, save Project 2003 files as Project 98 files. You even can set Project 2003’s default save format to that of Project 98 files. See Chapter 20 for more information.

In the File name box, type a name for the file. Click the arrow at the right edge of the Save in list box to display a hierarchy of your computer’s drive and directory organization. Click the Up One Level tool to move up one level in that hierarchy. Or, select one of the Save in choices (for example, History, My Documents, Desktop, Favorites, or Web Folders) to select a folder in which to save the file. To place this project file in a new folder, navigate to the drive or folder in which you want Project to store the new folder and then use the Create New Folder tool.

After you save a project for the first time, you can simply click the Save button to save the file; Project doesn’t display this dialog box. If you want to change a setting or save the file with a new name, choose File ➪ Save As to display this dialog box again.

By default, Project saves files in Project 2003 format with the extension .mpp. To save a file in a different format, such as a Microsoft Access database (.mdb) or a Project 98 file (also .mpp), you can select that format in the Save as type drop-down list. After you enter a name for your file and designate its location and type, click Save to save the file.
Clicking the ODBC button enables you to export the entire project or only selected data to an ODBC database.

**Saving files as templates**

One format in the Save as type drop-down list is template. Template files have an .mpt extension. The template feature is especially useful in project management because your projects are often similar to ones that precede or follow them. A template file saves all the settings that you may have made for a particular project, such as formatting, commonly performed tasks, and calendar choices. Keeping template files on hand can save your coworkers (and you) from having to reinvent the wheel each time that you want to build a similar project.

You may ask, “Can’t I just save my previous project’s file with a new name and use that for my next project?” Yes, you can, but after you track progress on tasks, opening that final project file and stripping it back to its baseline settings is a cumbersome process — a project in and of itself. Saving the initial schedule as a template on which you can build new schedules is a much better approach. To create a new schedule, simply open the template and save the file as a standard Project file with a new name.

**Protecting files**

Some projects are as top secret as an FBI file. In a case such as this, some people within the organization — and certainly people from outside the organization — should not have access to the details. If your projects fit this mold, you need a way to keep your Project files secure from prying eyes. You can set a measure of security for Project 2003 files by clicking the Tools button in the Save As dialog box and choosing General Options to display the Save Options dialog box, as shown in Figure 3-15.

![Save Options dialog box](image)

**Figure 3-15:** Don’t use your phone extension, birthday, or spouse’s name as a password — such passwords are much too easy to break!
Assigning a password in the Protection password box safeguards the file from being opened. Only someone with the assigned password can open a file that is protected in this way. If you assign a Write reservation password, on the other hand, anyone can open the file without a password, but as a read-only file (that is, no one else can make changes to the file). Finally, if you check the Read-only recommended option, Project displays a message recommending that anyone opening the file not make changes to it. However, this choice doesn’t prevent someone from making changes.

What kind of passwords should you use? Consider two factors: You must be able to remember the password, and you must make it something that the average person can’t guess. (No password is perfect; if someone really wants to break into your files, he or she will.) Try using passwords such as an address or phone number that you had as a child — information that you remember but others are not likely to know.

Both the Protection password and Write reservation password are case-sensitive. If you assign a password of JoeS, you can’t open the file if you type in joes.

Closing Project

When you’re finished working in Project, you can save your files as described previously and then use one of the following methods to close the program:

✦ Click the Close button in the upper-right corner of the Project window.
✦ Choose File ➪ Exit.

If you haven’t saved any open files, Project prompts you to do so.

Working with a Project Outline

After you build a project outline, reorganizing the sequence of individual tasks is easy. You can also manipulate the outline to show more or less detail about your project. Outlining features work the same way in many software products. For example, Word for Windows, PowerPoint, and Project — all Microsoft products — have the same outlining tools and features. In Project, you can (as you may expect) move, copy, hide, and display tasks.

Adjusting tasks in an outline

To move tasks in an outline, you can cut and paste (as you see in the following Steps 1 through 4) or you can drag and drop (as you see in the following Steps 5 through 7). You also can change the relative position of tasks in the hierarchy of
the outline by promoting or demoting them (outdenting or indenting). In Step 8, you see an example of demoting a task.

**Tip**

You can select a task by clicking its Gantt bar.

To move tasks, you must first select them. Use any of the following techniques to select tasks:

- To select a single task, click its ID number.
- To select several contiguous tasks, select the first task. Then hold down Shift and click the last task that you want to select.
- To select several noncontiguous tasks, hold down Ctrl as you click the ID numbers of the tasks that you want to select.

Moving tasks and subtasks can be a little tricky. It’s important to remember that, although you can move tasks wherever you like, when you move a summary task, its subtasks move with it. Furthermore, if you move a task at the highest level of the outline to a new location just below a task with subtasks, Project demotes the task that you move. Similarly, if you move a subtask so that it appears below a task at the highest level of the outline, Project promotes the subtask that you move. To get a feel for this behavior, try the following steps:

**Note**

To move a summary task only (without moving any of its subtasks), you must first promote all its subtasks to a higher level.

1. Click the ID number (in the leftmost column) for the Order Flowers task. Project highlights (selects) the entire row.
2. Click the Cut tool on the Standard toolbar.
3. Click the Gantt bar for the Send Invitations task. Project selects the row.
4. Click the Paste tool on the Standard toolbar. The Order Flowers task appears selected in its new location above the Send Invitations task.
5. Click the ID number of the Request Purchase Order task to select the task.
6. Move the mouse pointer over the ID number of the selected task; the pointer changes to a four-way arrow.
7. Press and hold down the left mouse button while you drag the Request Purchase Order task below the Order Food task. A horizontal gray line appears on-screen, indicating the new proposed position as you drag (see Figure 3-16).

**Tip**

You can promote or demote tasks by dragging. Dragging a task to the left promotes the task in the project outline. Similarly, dragging a task to the right demotes the task. You see the same gray vertical line when you promote or demote tasks that you see when you move tasks up or down in the outline.
8. With the Request Purchase Order task selected (either the entire row or just the task name), click the Indent button on the Formatting toolbar to make the task subordinate.

You also can promote or demote by dragging. Move the mouse pointer over the first few letters of the subtask name until the pointer becomes a double arrow. Then drag the subtask to the left or right.

If a task isn’t selected when you place the mouse pointer over the task name, you won’t have much time to view the double arrow, because Project displays a screen tip that contains the task name. If you’re patient, the screen tip will disappear and the double arrow will reappear.

Your schedule now has two tasks with subtasks beneath them, as shown in Figure 3-17.
Copying tasks

Copying tasks also is simple to do and can come in handy while building a project outline. For example, suppose that you were entering tasks in a project to test various versions of a compound to see which works best as a fixative. You may repeat the same series of tasks (Obtain compound sample, Test in various environments, Write up test results, Analyze results, and so on) several times. Instead of typing those tasks 10 or 20 times, you can save time by copying them.

To copy tasks, you must first select them. Use any of the techniques that I described in the previous section. You can copy tasks in the following two ways:

- Use the Edit ➤ Copy and Edit ➤ Paste commands (or their corresponding tools on the Standard toolbar) to copy the selected task(s) to another location.

  Remember, to copy a summary task and its subtasks, you need only select the summary task and copy it. Project automatically copies the summary’s subtasks for you.

- Hold down Ctrl while you drag the task(s) to another location. Release the mouse button to complete the copy.
If you have several repetitive phases of a project, such as the development and production of several models of a single product, you can use the fill handle to copy the tasks. In Figure 3-18, you see three tasks: Design, Development, and Production. To copy the group of tasks, follow these steps:

1. Select their task names.
2. Place the mouse pointer over the fill handle in the lower-right corner of the selection.
   The mouse pointer changes to a plus sign (+).
3. Drag the fill handle down until you have selected the group of rows that you want to contain the repetitive tasks.

![Figure 3-18: Take advantage of the fill handle for contiguous copy tasks.](image)

The fill handle copies tasks into a contiguous range. However, if the range already contains information, using the fill handle to copy overwrites the existing information. To avoid this problem, insert blank rows in the project before using the fill handle. Select the task that you want to appear beneath the new row, and choose Insert > New Task. To insert more than one blank row, select the number of rows that you want to insert before choosing Insert > New Task.
When you release the mouse pointer, Project copies the tasks into the selected range, as shown in Figure 3-19.

**Figure 3-19:** Project fills the range with the selected tasks.

Suppose that you're using WBS codes and you set up the WBS codes to automatically assign codes when you create new tasks. When you copy tasks by using any of the methods described here, Project automatically assigns incremental WBS codes to the new tasks.

### Displaying and hiding tasks

The outline structure enables you to view your project at different levels of detail by expanding or collapsing the summary tasks. You can use the Show button on the Formatting toolbar to quickly hide or display subtasks based on their outline level, as shown in Figure 3-20. By using the Show button, you also can quickly display all the detail tasks in your schedule.
Figure 3-20: Use the Show button on the Formatting toolbar to easily determine the level of detail that you want to view in a project.

Figure 3-21 shows a minus sign (–) appearing to the left of each summary task. This symbol indicates that all subtasks are in view. If you click the minus sign, any subtasks disappear from view and a plus sign replaces the minus sign next to the summary task name. The plus sign indicates that the task is associated with some hidden detail tasks. Click the plus sign to reveal the “hidden” subtasks.

How many levels of detail can an outline have? Just about as many as you need. For example, the schedule that is shown in Figure 3-21 has several levels of detail regarding the annual meeting example. Any task that has subtasks also has the plus and minus sign mechanism for displaying or hiding the subtasks.
Using too many levels of outline indentation (usually more than three or four) makes it difficult to see your entire schedule on-screen. In fact, a very detailed project outline may indicate that you need to rethink the scope of the project and break it into smaller, more manageable projects.

You can use the hide and show features of the outline to focus on just the amount of detail that you want. You can take the same schedule that you saw in Figure 3-21, for example, and show just the highest level of detail for a report to management to summarize project activity, as shown in Figure 3-22.
Getting Help

As you begin to build tasks in a schedule, you’re likely to have questions about using Project 2003 that the Help system can answer. Project’s Help is similar to the Help feature in Windows and Office XP products.

If you chose “Typical” when you installed Project, the Office Assistant feature will not be available to you. If you open the Help menu and choose Office Assistant, you’ll be asked if you want to install the Office Assistant.

If you click the Office Assistant button located on the end of the Standard toolbar, you’ll see an animated Paperclip and a bubble in which you can type an English language-like question.

The Help character annoys many people, however, so Project offers three different ways in which you can avoid it:
Don’t install it. The Typical installation choice does not install the Office Assistant by default.

Bypass it. You can choose Contents and Index from the Help menu.

Turn it off. You can turn off the Office Assistant; in the Office Assistant bubble, click the Options button to display the Office Assistant Options dialog box. Remove the check from the Use the Office Assistant check box on the Options tab.

If you decide later that you again want to use the Office Assistant and you’ve installed it, choose Help ➤ Show Office Assistant.

### Using the Help system

You can click the Help button at the right edge of the Standard toolbar or choose Help ➤ Contents and Index or Help ➤ Microsoft Project Help to display the Assistance pane on the left side of your screen. The Assistance pane helps you find help; it covers a broad spectrum of help possibilities, from searching for help in the Project help files and online to searching online for training, consultants, or user groups.

To see a list of help topics in the Assistance pane, click the Table of Contents link at the top of the Assistance pane.

You can use the links in the Table of Contents to locate information by general topic areas. When you click any of these links, Help displays a list of subtopics. By narrowing down these subtopics, you eventually get to the information that you want.

When you type a keyword in the Search for box and click the arrow next to the box, Help searches both the Project help file and online sources for information.

Depending on the topic you choose, you’ll see a Help pane along the right side of the Project window, or you’ll see a browser window displaying information about the topic, because help is provided both in the Project help file and from online sources. You can distinguish between Project help file topics and online source topics by the icon that appears next to the topic.

Help information often contains steps required to complete a procedure. In addition, a “See Also” hyperlink takes you to related topics when you click it. Finally, the Help text may contain hyperlink text, a button to show you how to accomplish some task, and even demos.
The Table of Contents is a good way to get help if you know the general topic that you want to learn about but perhaps don’t know enough about the terminology to type a specific phrase or term in the Search box. The Table of Contents and the Search box often bring you to the same information screen. For example, you can display the Help topic “Use an outline structure for your task list” by typing Indent in the Search box and then clicking the first topic that the search returns. You also can display this topic by clicking the Table of Contents link, and then clicking the following topics:

✦ Creating a Project Plan
✦ Outlining tasks
✦ Use an outline structure for your task list

Use the buttons across the top of the Assistance pane. You can go back and forward between help topics or click the Home icon to return to the opening Assistance pane.

Finding online help

You can find a world of support, information, and even freeware, shareware, or products-for-a-price that work along with Project on the Internet.

This book’s companion CD-ROM includes several products from third-party vendors that work with Project to enhance it.

The Assistance pane provides direct links to online sources and automatically includes online sources when you search for help. You can control online searching settings by scrolling down in the Assistance pane and clicking Online Content Settings.

You also can open the Help menu and click Office on the Web to follow a link to the Microsoft Office Online Web site. At this site, you can find things such as update information, files to download, and a link to a list of software companies that provide add-on products or specialize in the use of Microsoft Project. If you have a technical question about Project, you can click Assistance to use Online Support or to look up articles on Microsoft Project stored in Microsoft’s Knowledge Base. You also can find links on this page to the Microsoft Project Newsgroups, the Microsoft Project Resource Kit, and the Solution Provider Database.
Summary

In this chapter, you started to build your first project by creating summary tasks and subtasks. You learned about the following aspects of Project:

✦ Gathering the data that you need to begin creating your schedule
✦ Entering Project information and setting up some calendar defaults
✦ Creating summary and subtasks
✦ Saving files and closing Project
✦ Working with the outlining hierarchy to assign WBS codes and move, copy, and display subtasks
✦ Using the Help system to search for information and obtain online help

In Chapter 4, you begin to add details about task types, add timing, and establish relationships among your tasks.
Building Tasks

Hesiod, that classic Greek project manager, once said, “Observe due measure, for right timing is in all things the most important factor.” You could do worse than to use this truism from around 700 B.C. as your personal project management mantra today. When it comes to projects, timing is, indeed, everything.

In Chapter 3, you created several tasks and used the outlining feature of Project to organize them. But every task in your schedule has the default length (one estimated day), and they all occur on the same day. In essence, you have listed the steps to get to your goal, but with no related timing, your schedule may as well be a shopping list.

You have to add durations to your tasks. In other words, you must establish how long (or how many hours of effort) each task will take. However, timing consists of more than determining how many hours, days, or weeks it takes to complete each task. Timing for your project becomes clear only when you’ve set a duration for each task and when you’ve established the relationships, called dependencies, among the tasks. Only then can you accurately predict the amount of time that you will need to complete the project.

Establishing Timing for Tasks

Your boss asks how long it will take to write that report, and you tell her it will take about a week. Your coworker calls and asks when you will be finished repairing the computer network, and you tell him it will take another day. You make estimates about task durations every day. You know your own business, and you’re probably pretty good at setting the timing for everyday tasks based on many factors.
Exactly how do you figure out the timing for a task in a project? The method is virtually identical to the seemingly automatic process that you go through when someone asks you how long it will take to complete a task, such as placing an order for materials. Consider the following example:

1. You estimate that you will spend about 40 minutes doing the research and performing the calculations to determine how many square feet of lumber you'll need for the job.

2. You consider how long the actual task (placing a phone order for materials) will take. This duration could be a matter of only minutes, but if you factor in playing a few rounds of phone tag, you may want to allow half a day.

3. You also think about what's involved in getting a purchase order. With your system, cutting a purchase order can take up to four days. Some of that time requires your presence, but most of it consists of waiting.

So how long is your task? You could say that you need exactly four days, four hours, and 40 minutes; but just to be safe, you should probably allow about five days. In addition, Project has some issues that are specific to task timing that you need to understand to estimate task durations accurately.

**Fixed-unit tasks**

By default, Project creates resource-driven tasks that are referred to as *fixed-unit tasks*. Here's a simple example. You have to plant a tree. One person needs two hours to plant a tree. If you add another person (another resource), together they need only one hour to complete the task. That is, two resources, each putting in an hour of effort, complete the two hours of work in only one hour. With resource-driven scheduling, when you add resources, the task duration becomes shorter; if you take away resources, the task takes longer to complete. And, on the flip side, the resource assignments to a task don’t change when the work increases or decreases. By default, each task that you create in Project is a resource-driven, fixed-unit task type.

Caution: The reduction of time required on a resource-driven task is strictly a mathematical calculation in Project. For example, ten people get work done in one-tenth the time of one person. However, whenever two or more people work on a task, the time savings are seldom so straightforward. You must also factor in the time for those people to communicate, miscommunicate, hold meetings, and so on.
To pad or not to pad?

Although most people agree that delays are inevitable and that you should allow for them, people who schedule projects accommodate these delays in various ways.

Some schedulers build in extra time at the task level, adding a day or two to each task’s duration — just in case. Unfortunately, padding each task may leave you with an impossibly long schedule, and it may suggest to your boss that you’re not very efficient. Why should it take two days to run a three-hour test? It doesn’t — but because you know that setting up the test parameters properly the first time is an error-prone process, you allow a couple of workdays to complete the testing. Just make sure that your boss understands that you’re building a worst-case scenario; when you bring the project in early, he or she will be glad to share the praise.

Some project managers add one long task, maybe two weeks or so in duration, at the end of the schedule, and they name it something like Critical Issues Resolution Period. This task acts as a placeholder that covers you if individual tasks run late. This approach can help you see how the overall time left for delays is being used up as the project proceeds. For example, if the final two-week task is running a week late because of earlier delays, you know that you’ve eaten up half of the slack that the task represents.

Or, you can build a schedule with best-case timing. Then you can document any problems and delays that occur, and request additional time as needed. In the case of a project that you must complete quickly, you may need to work this way. However, best-case timing sets you up for potential missed deadlines.

Which approach should you use? Possibly a combination. For example, try building a best-case schedule. If the completion date is one week earlier than your deadline, by all means add a little time to the tasks that are most likely to encounter problems, such as those that are performed by outside vendors.

Fixed-duration tasks

You also can use the fixed-duration task in Project. The number of resources does not affect the timing of this type of task. To allow a week for a committee to review the company’s new ad campaign — no matter how many people are on the committee — give the task a fixed duration. You can’t shorten the task’s duration by adding resources to it. In fact, adding people to the review process may lengthen the task, because their effort has no impact on getting the work done more quickly, and coordinating their efforts can add time.
Fixed-work tasks

The fixed-work task was a task type that became available in Project 98. When you create a fixed-work task, you set the duration of the task, and Project assigns a percentage of effort that is sufficient to complete the task in the time that is allotted for each resource that you assign to the task. For example, if you assign three people to work on a one-day task, Project would say that each person should spend 33 percent of his or her time on the task to complete it in one day. Similarly, a task may take 48 hours to complete (its fixed-work value). With one resource assigned working 8 hours a day, the task will require six days to complete. With two resources assigned working 8 hours a day, the task will require three days to complete. In either case, the amount of work that’s required remains constant. The task’s duration changes based on the number of resources that are assigned to the task.

Effort-driven tasks

For fixed-duration and fixed-unit tasks, you can tell Project to modify the percentage of total work that is allocated to each resource, based on the number of assigned resources, if the number of resources changes. In effect, you create an effort-driven task. The work that’s required to complete the task remains the same, but Project redistributes the work equally among all assigned resources.

Note

Fixed-work tasks are always effort-driven. You can choose to make fixed-duration and fixed-unit tasks effort-driven, or you can make Project retain the original allocation of work.

In this chapter, I use Project’s default settings: The durations that you assign to tasks are resource-driven. Therefore, a five-day task requires five days of resource effort to complete.

Cross-Reference

In Chapter 5, you find out more about how resource assignments modify task timing.

Assigning Task Timing

You now understand the basics of estimating task timing, and you understand how task timing relates to effort that is expended on the task by resources. The actual process of assigning durations is simple. To assign a duration to a task, you can use one of the following three methods:

♦ Use the Task Information dialog box to enter and view information about all aspects of a task, including its timing, constraints, dependencies, resources, and priority in the overall project.
Enter a duration in the Duration column of the Gantt table.

Use your mouse to drag a task bar to the required length.

You also can enter the work value after assigning the resources to the task. Project then calculates the duration and provides the smart tag help automatically, giving you the option to change the method of calculation.

**Using the Task Information dialog box**

Follow these steps to assign durations from the Task Information dialog box:

1. Display the Gantt Chart view (choose View ➪ Gantt Chart).
2. Double-click a task name to open the Task Information dialog box, as shown in Figure 4-1.

![Figure 4-1](image)

**Figure 4-1:** If you double-click an already-entered task name, that name appears in the Name field in this dialog box. If you double-click a blank task name cell, you can fill in the name here.

You can also click the Task Information button on the Standard toolbar, or right-click either the task name or the task’s Gantt bar and select Task Information to display this dialog box.

3. Click the arrows in the Duration field to increase or decrease the duration from the default setting of one day. Each click changes the duration by one day.
You may have noticed that Project uses estimated durations — a question mark (?) — by default when you type a task name but no duration into the Gantt table. When you establish a task’s duration in the Task Information dialog box, you can place a check mark in the Estimated box to make the duration of the task estimated. Use estimated durations when the time frame for the task isn’t firm. You can easily display tasks with estimated durations by using a new filter in Project. (See Chapter 6 for more information about filters.)

4. Click the Duration field, and highlight the current entry to enter a duration in increments other than a day.

Project 2000 first gave you the ability to specify a duration in months. Project uses the Calendar tab of the Options dialog box to determine the number of days in a month.

5. Type a new duration by using the following abbreviations: $m$ for minutes, $h$ for hours, $w$ for weeks, and $mo$ for months.

6. Click OK to establish the task duration. For example, the Gantt Chart task bars shown in Figure 4-2 reflect the new task lengths.

![Figure 4-2: Task bars become more meaningful after you assign durations.](image)
Start and finish versus duration

You could use the Start and Finish fields in the Task Information dialog box to set a start date and finish date for the task, rather than entering a duration. However, if you use the Start and Finish dates, Project uses only working days in that date range. If you enter a duration, Project calculates the beginning and end of the task, taking into consideration weekends and holidays. These two methods could have different results.

For example, suppose that you have a four-day task that starts on December 23, 2003. The following table shows how that week looks on a calendar:

<table>
<thead>
<tr>
<th>Sun</th>
<th>Mon</th>
<th>Tues</th>
<th>Wed</th>
<th>Thurs</th>
<th>Fri</th>
<th>Sat</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
</tr>
</tbody>
</table>

December 25, 2003, falls on a Thursday. If you entered 12/23/03 as the start date and 12/26/03 as the finish date, Project would calculate that as an estimated three-day task (assuming that your company closes for Christmas), with work on December 23, 24, and 26. However, if you enter 4 days in the Duration field, the calculated start and finish dates would be 12/23/03 and 12/29/03, respectively, taking into account both the Christmas holiday and a weekend. In this example, the workdays are December 23, 24, 26, and 29.

If a task has immutable timing, such as a Christmas celebration on Christmas day, use the Start and Finish fields. If you know how many workdays a task will require, but not the days on which the work will occur, use the Duration field to set timing, and let Project calculate the actual work dates based on the calendar.

Using the Gantt table

To enter a task’s duration on the Gantt table, simply click the Duration column and type in the duration. Even though you’ve set the default to use estimated durations, when you type a duration on the Gantt table, Project assumes that you want a planned instead of an estimated duration — unless you type a question mark (?)..

You can change Project’s default behavior (and use planned instead of estimated durations) on the Schedule tab of the Options dialog box — see the next section for more information.

You can enter a duration in a few different ways. For example, Project recognizes all the following entries as three weeks: 3 w, 3 wks, 3 weeks.

To assign the same duration to several contiguous tasks, type the duration once and then use the fill handle in the Duration column to copy the duration to the other tasks.
Using your mouse and the task bar

Finally, follow these steps to adjust a task’s duration using your mouse and the task bar:

1. Place your mouse pointer on the right edge of a task bar until the pointer becomes a vertical line with an arrow extending to the right of it.

2. Click and drag the bar to the right. As you do, Project displays the proposed new task duration and finish date, as shown in Figure 4-3.

3. Release the mouse button when the duration that you want appears in the information box.

**Figure 4-3:** If you’re a visually oriented person, dragging task bars to change durations may be the best method for you.
Setting scheduling options

You aren’t limited to entering resource-driven tasks or estimated durations on the Gantt table. You can change the default task type and other default scheduling settings for your project. Choose Tools ➤ Options and click the Schedule tab of the Options dialog box to change the default settings for entering tasks, as shown in Figure 4-4.

![Figure 4-4](image)

**Figure 4-4:** Use the Schedule tab of the Options dialog box to change Project’s default behavior for scheduling.

In this dialog box, you determine the default unit of time for entering task durations (the default is days), the work time (hours), and whether new tasks start on the project start date or the current date. For example, if you are working on a five-year project in which most tasks take months — not days — you may want to change the default setting for the Duration is entered in field. If you prefer to have any new tasks begin no earlier than the current date, you can adjust the setting for New tasks. To enter planned durations instead of estimated durations, remove the check mark from the New tasks have estimated durations box on the Schedule tab.

As you gain experience in entering information, you will find ways to customize Project to match your work style. When you are satisfied with the settings in the Schedule tab, click OK to close the Options dialog box.
Assigning a calendar to a task

Task calendars became available in Project 2000. You can assign a calendar to a task by using the same steps that you used to create the Press calendar, described in Chapter 3. Choose Tools ➪ Change Working Time to display the Change Working Time dialog box. Click the New button to create the calendar, and provide a name for the new calendar. Select the dates that won’t be standard, and make the appropriate changes. Click OK to save the calendar.

For more detailed steps on creating a new calendar, see Chapter 3.

To assign a calendar to a task, double-click the task name to open the Task Information dialog box for that task. Click the Advanced tab, and open the Calendar list box to assign a special calendar for the task, as shown in Figure 4-5.

Creating milestones

Managers often use milestones to mark key moments in a project, such as the completion of a phase or the approval of a product or activity. In Project, milestones are tasks that usually have zero duration. The symbol for a milestone on the Gantt Chart is a diamond shape. For example, the diamond in the Gantt Chart shown in Figure 4-6 indicates that the End of Testing task is a milestone.
A milestone typically marks a noteworthy point in your project; a milestone is usually a task of no duration. A task doesn’t have to have a zero duration to be a milestone; you can mark any task as a milestone. On the Advanced tab of the Task Information dialog box, place a check mark in the Mark task as milestone check box. In this case, the task duration doesn’t change to zero. However, the element that represents the task in the Gantt Chart changes from a bar, reflecting the task’s duration, to a milestone diamond symbol, representing the task as a moment in time.

For milestones with durations longer than zero, the diamond appears at the beginning of the duration.

Timing for summary tasks

How do you assign durations for summary tasks? You don’t. Remember, summary tasks simply roll up the timing of their subtasks. Therefore, summary tasks don’t have any timing of their own. If three subtasks occur one right after the other and
each is three days long, the summary task above them takes nine days from beginning to end. If you open the Task Information dialog box for a summary task, most timing settings appear grayed out, indicating that they’re not available.

**Using Recurring Tasks**

Projects often have tasks that occur on a regular basis. Weekly staff meetings, quarterly reports, or monthly budget reviews are examples of these recurring tasks. Rather than have you create, for example, 20 or so weekly staff-meeting tasks over the life of a five-month project, you can use Project’s Recurring Task feature. This feature enables you to create the meeting task once and assign a frequency and timing to it. Follow these steps to create a recurring task:

1. Because Project inserts tasks above the selected task, select the task that you want to appear below the recurring task and choose Insert ➪ Recurring Task to open the Recurring Task Information dialog box, as shown in Figure 4-7.

![Figure 4-7](image)

**Figure 4-7**: If a task occurs at regular intervals during the life of a project, you can save time by creating it as a recurring task.

2. Type a name for the recurring task.

3. Set the task duration in the Duration field. For example, does the meeting run for two hours, or does a report take a day to write?
4. Set the occurrence of the task by selecting one of the Recurrence pattern option buttons: Daily, Weekly, Monthly, or Yearly. Depending on the recurrence that you select, the timing settings to the right of the control buttons change. Figure 4-8 shows the Monthly settings.

![Figure 4-8: Recurring Task Information](image)

5. Select the appropriate settings for the recurrence frequency. For a Weekly setting, place a check mark next to the day(s) of the week on which you want the task to occur. For example, the task shown in Figure 4-7 occurs every Tuesday. For the Monthly or Yearly setting, select the day of the month on which you want the task to occur. The task in Figure 4-8 occurs on Day 9 of every month.

For a daily task, you have only one choice: whether you want it to occur every day or only on scheduled workdays. For example, to schedule a computer backup for every day of the week — regardless of whether anyone is at work — you can have the task occur every day. (Ask your MIS department how to automate the process so that it occurs even when nobody is at work.)

6. Set the Range of recurrence — the period during which the task should recur — by entering Start and End after or End by dates. If you need to repeat a test weekly for only 1 month of your 10-month project, you could set Start and End after or End by dates that designate a month of time.
If you set the End after number of occurrences, Project calculates the date range that is required to complete that many occurrences of the recurring task and automatically displays the ending date in the End by box. This method can be useful if one of these events falls on a holiday: If one of the occurrences falls on a holiday, Project displays a box that allows you to skip the occurrence or to schedule it on the next working day. For a weekly staff meeting, you can skip that meeting or schedule it on a different day. On the other hand, if you must repeat a test 16 times during the project cycle, you can schedule the test to occur on the next working day to compensate for the holiday. Therefore, set the number of occurrences rather than the time range.

7. Click OK to create the task. Project creates the appropriate number of tasks and displays them as subtasks under a summary task with the name that you supplied in Step 2. Note the recurring task symbol in the Indicators column of the Gantt Chart shown in Figure 4-9.

![Figure 4-9: Task bars appear for each occurrence of the recurring task in the Gantt Chart.](image-url)
Mysterious icons in the Indicator column

The symbol next to each Weekly Test Report task in the schedule shown in Figure 4-9 represents a task with a timing constraint applied. Project applies this constraint automatically as you enter settings for the recurring task.

If you move your mouse pointer over one of these symbols, as shown in the following figure, you can see an explanation of that constraint. For example, each Weekly Test Report task has a Start No Earlier Than constraint, based on the timing that you set in the Recurring Task Information dialog box. The first recurring task can start no earlier than the From date entered there, and each task occurs weekly thereafter. You find out more about setting timing constraints in the next section.

Constraints affect the timing of a task relative to the start or end of your project or to a specific date. Setting a deadline date in Project provides you with a visual reminder if you don’t complete a task by the deadline date that you establish.
Establishing Constraints and Deadline Dates

Constraints affect the timing of a task relative to the start or end of your project or to a specific date. Setting a deadline date in Project provides you with a visual reminder if you don’t complete a task by the deadline date that you establish.

Understanding constraints

By default, Project sets all tasks that you create to start with an As Soon As Possible constraint. Barring any dependency relationships with other tasks (see the section “Establishing Dependencies Among Tasks,” later in this chapter), the task would start on the first day of the project. You can set other constraints, as follows:

✦ As Late As Possible: This constraint forces a task to start on a date such that its end occurs no later than the end of the project.

✦ Finish No Earlier Than/Finish No Later Than: This constraint sets the completion of a task to fall no sooner or later than a specific date.

✦ Must Finish On/Must Start On: This constraint forces a task to finish or start on a specific date.

✦ Start No Earlier Than/Start No Later Than: This constraint sets the start of a task to fall no sooner or later than a specific date.

Only the Must Finish On/Must Start On settings constrain a task to start or end on a particular date. All the other settings constrain the task to occur within a certain time frame.

Using deadline dates

You also can establish a deadline date for a task. The deadline date differs from a constraint in that Project doesn’t use the deadline date when calculating a project’s schedule. Instead, the deadline date behaves as a visual cue to notify you that a deadline date exists (the down arrow symbol that you see next to the Acquire materials 2 task bar in Figure 4-10). If you place your mouse over the deadline indicator, Project displays the deadline information. If the task finishes after the deadline date, you also see a symbol in the Indicators column. Be aware that you won’t see an indicator if you complete the task prior to the deadline date.
Figure 4-10: When you set a deadline date for a task, Project displays an indicator to alert you that you set the deadline.

Although deadline dates don’t affect the calculation of a project schedule, they do affect a Late Finish date and the calculation of total slack for the project. Also, be aware that you can assign both a deadline date and a constraint to a task. In a project that you schedule from a beginning date, a deadline date has the same effect as a Finish No Later Than constraint. If you assign deadline dates to tasks in projects that you schedule from an ending date, those tasks will finish on their deadline dates unless a constraint or a dependency pushes them to an earlier date.

Setting constraints and deadline dates

You set constraints on tasks in your project by using the Advanced tab of the Task Information dialog box, as shown in Figure 4-11. Select a constraint type from the Constraint type drop-down list. For all settings in the type list other than As Late As Possible and As Soon As Possible, designate a date by typing in a date or by clicking the arrow next to the Constraint date field and choosing a date from the drop-down calendar that appears. Set a deadline date by clicking the arrow next to the Deadline field and choosing a date from the drop-down calendar that appears.
Under what circumstances would constraints be useful? Consider the following situations:

- A project involves preparing a new facility for occupancy, and you want the final inspection of that facility to happen as late as possible.
- The approval of a yearly budget must finish no later than the last day of the fiscal year, ready to begin the new year with the budget in place.
- Billing of a major account must start no sooner than the first day of the next quarter so that the income doesn’t accrue on your books this quarter.
- Presentation of all severance packages for laid-off employees must finish on the day that a major takeover of the company is announced.

Deadline dates would be useful in the following situations:

- You need to prepare the annual budget by a deadline date to ensure approval in time to begin the new year with the budget in place.
- You need to prepare severance packages for laid-off employees so that you can present the packages on the day that a major takeover of the company is announced.

You see how constraints and dependencies interact in establishing the timing of tasks in the section “Establishing Dependencies Among Tasks,” later in this chapter.
Manipulating the Gantt Chart to View Timing

After you enter several tasks and task durations, you'll probably want to manipulate the timescale in the Gantt Chart to view information about these tasks using different increments of time. Use any of the following methods to modify the appearance of items in your Gantt Chart:

- Adjust the amount of the window that the Gantt table and the Gantt Chart use by moving your mouse pointer over the divider line until it becomes a two-directional arrow pointer. Drag the divider to the right or left to adjust the amount of the window that's taken up by the two panes.

- Modify the width of columns in the Gantt table so that you can see more columns on-screen by moving your mouse pointer over a column heading's right edge until you see the two-directional arrow pointer. Drag the column edge to the right or left to make the column wider or narrower.

- Double-click the column heading, and change the column width in the Column Definition dialog box that appears. You can also use this dialog box to change the column title and the alignment of the column title.

Starting in Project 2002, you can set the timescale to view three levels instead of just two levels.

- Modify the increments of time displayed in the timescale itself either by double-clicking the timescale or by choosing Format ➤ Timescale. The Timescale dialog box appears, as shown in Figure 4-12. You can change the units for the top tier, the middle tier, and the bottom tier. These adjustments enable you to concentrate on a particular period in your project or to view larger increments with less detail. The Count field controls how many instances of the unit Project marks off on your Gantt Chart.

![Timescale dialog box](image)

*Figure 4-12: In the Timescale dialog box, adjust the units to display and set the heading labels and alignment.*
Figure 4-13, for example, shows a top-tier timescale in months, a middle-tier timescale in weeks, and a bottom-tier timescale in days. The count for each is 1:1 month with each of its four or five weeks shown, and each week’s seven days shown.

![Microsoft Project screenshot](image)

**Figure 4-13:** When you specify 1 week in the Count field of the Timescale dialog box, Project marks off every week on the portion of the timescale that displays weeks.

If you change the count for the middle tier — weeks — to 2, the weekly timescale displays two-week increments, as shown in Figure 4-14. To show more of the project on-screen, consider displaying only two tiers of the timescale, as shown in Figure 4-15.
Figure 4-14: Changing the Count field for weeks to 2 causes Project to mark off weeks in two-week chunks.

Tip

To shrink the timescale even more (that is, to see more of your project on-screen) use the Size setting in the Timescale dialog box. This setting enables you to view the timescale at a percentage of its full size.

Starting in Project 2000, you can independently set the use of the fiscal year for any tier of the timescale. To make this feature work, you should set up a fiscal year calendar. Choose Tools ➤ Options and click the Calendar tab of the Options dialog box. Then, change the starting month from January to your fiscal year’s starting month.
Getting Your Project Going

Figure 4-15: You can compress the Gantt task bars of your project so that you see more of the project on-screen by adjusting the timescale.

Entering Task Notes

You can attach notes to individual tasks to remind you of certain parameters or details for the task. For example, if a task involves several subcontractors, you may want to list their contact information here so that it’s close at hand when you’re working on the project schedule. Or, you can use the Notes field to document company regulations that are relative to that type of procedure. When you add a note to a task, you can display the note on-screen and include the note in a printed report.

You can also attach notes to individual resources and to their assignments, as you find out in Chapter 5.

To enter a note for a task, follow these steps:

1. Double-click a task to open the Task Information dialog box.
2. Click the Notes tab, as shown in Figure 4-16.
3. Type your note in the area provided. You can use the tools that are above the description box to format your note text.
4. Click OK to attach the note to your task.
Figure 4-16: The Notes tab provides simple word processing, such as tools for formatting your notes.

A Note icon now appears in the Indicators column of the Gantt table, as shown in Figure 4-17. Move the mouse pointer over this icon to display the note.

Figure 4-17: Project automatically adds an icon for the note to the Indicators column.
You can print notes along with your schedule. To do so, follow these steps:

2. Click the View tab to display the settings that are shown in Figure 4-18.
3. Click the Print notes check box to have Project print notes for tasks.
4. Click OK.

You find out more about printing schedules in Chapter 7.

Establishing Dependencies among Tasks

Whereas constraints tie tasks to the project start or end or to particular dates, dependencies tie tasks to the timing of other tasks in the project. Dependencies are central to visualizing the true length of a project.

Dependencies exist because all tasks in a project rarely can happen simultaneously; usually, some tasks must start or finish before others can begin. Tasks overlap for many reasons; for example, the inability of resources to do more than one task at a time, the lack of availability of equipment, or the nature of the tasks themselves (you can’t start construction until you receive a construction permit). You can’t know the total time that you will need to complete a project until you establish durations and dependencies. For example, a project that comprises five 10-day-long tasks
with no dependencies among the tasks takes 10 days to complete. But, if the tasks must happen one after the other, the project requires 50 days.

Understanding dependencies

A task that must occur before another task is a predecessor task. The task that occurs later in the relationship is a successor task. A task can have multiple predecessors and successors. Tasks with dependency relationships are linked. Gantt Charts show these links as lines running between task bars; an arrow at one end points to the successor task. Some dependency relationships are as simple as one task ending before another can begin. However, some relationships are much more complex. For example, if you’re moving into a new office and the first task is assembling cubicles, you don’t have to wait until all the cubicles are assembled to begin moving in furniture. You may work in tandem, using the first morning to set up cubicles on the first floor. Then you can begin to move chairs and bookcases into the first-floor cubicles while the setup task continues on the second floor.

Understanding the interactions between constraints and dependencies

Both constraints and dependencies drive the timing of a task. Consider for a moment how constraints and dependencies may interact when you apply one of each to a task. Say that you have a task — to open a new facility — that has a constraint set so that it must start on June 6. You then set up a dependency that indicates that the task should begin after a task — fire inspection — that is scheduled for completion on June 10. When you try to set up such a dependency, Project displays a Planning Wizard dialog box, as shown in Figure 4-19. This dialog box indicates a scheduling conflict. Project displays this dialog box when a conflict exists among dependencies or between constraints and dependencies.

Figure 4-19: Multiple dependencies or a combination of dependencies and constraints can cause conflicts in timing.
If a conflict exists between a constraint and a dependency, the constraint drives the
timing of the task; the task does not move from the constraint-imposed date. You
can modify this functionality by choosing Tools➪Options. On the Schedule tab of
the Options dialog box, remove the check mark from the Tasks will always honor
their constraint dates check box. When you change this option, dependencies —
rather than constraints — determine timing.

See Chapter 9 for more information about resolving timing conflicts.

You can create dependencies in one of the following three ways:

✦ You can select two tasks and choose Edit➪Link Tasks or use the Link Tasks
button on the Standard toolbar. The first task that you select becomes the
predecessor in the relationship.

✦ You can open the successor task’s Task Information dialog box and enter pre-
decessor information on the Predecessors tab.

✦ You can use your mouse button to click the Gantt bar of a predecessor and
drag it to the Gantt bar of a successor to create a link to a successor task.

To link a whole range of tasks to be consecutive (one finishes, the next begins, and
so on down through the list of tasks), select the range of tasks (drag from the ID
number of the first task to the ID of the last task). Then use the Link Tasks button
or choose Edit➪Link Tasks to create a string of such relationships at one time.

Allowing for overlap and delays

Although many dependency relationships are relatively clear cut — Task A can
begin only when Task B is complete, or Task C can start only after Task B has
started — some are more finely delineated. These relationships involve overlap and
delay, and these relationships are supported in Microsoft Project by adding lag time
or lead time to the dependency relationship.

To understand these two concepts, consider the following examples. Suppose that
your project tests a series of metals. In the first task, you apply a solution to the
metal, and in the second task, you analyze the results. However, time can be a fac-
tor, so you want the analysis to begin only when several days have passed after the
application of the solution. You build in a delay between the finish of the first task
(the predecessor) and the start of the second (the successor). Figure 4-20 shows a
relationship with some lag between the two tasks. The line between the two tasks
indicates the dependency, and the space between the bars indicates the gap in time
between the finish of one and the start of the next.
After you apply the solution, you must wait four days to analyze the results.

You create lag or lead time using the Predecessors tab of the Task Information dialog box. You create lag time by entering a positive duration in the Lag field, and you create lead time by entering a negative duration in the Lag field.

Some people prefer to build a task to represent lag rather than to modify a dependency relationship. For example, instead of placing a dependency between application of the solution and analysis, you can create a three-day-long task called Solution Reaction Period. Then, create a simple dependency relationship between Solution Reaction Period and the analysis so that the analysis task won’t begin until Solution Reaction Period is complete. Adding the lag tasks can generate a very long schedule with multiple tasks and relationships to track. But, in a simpler schedule, this approach enables you to see relationships as task bars. You can try both methods and see which works best for you.
Another test in your project involves applying both a solution and heat. You first want to apply the solution for three hours and then begin to apply heat as well. Notice the overlap between the tasks: the predecessor task — applying the solution — begins at 8:00 a.m. and runs to 2:00 p.m. The successor task — applying heat — begins three hours after the start of the predecessor task, at 11:00 a.m. The project shown in Figure 4-21 has some overlap between tasks.

![Overlap](image)

**Figure 4-21:** Some overlap occurs between the application of the solution and the application of the heat in this testing project.

**Note**

I set up a task calendar that ignores lunchtime so that both tasks could continue uninterrupted (the icons in the Indicator column represent the task calendar), and I changed the timescale so that you can see the hours of the day.
**Dependency types**

Four basic dependency relationships define the relationship between the start and finish of tasks: start-to-finish, finish-to-start, start-to-start, and finish-to-finish. You can set these dependency relationships on the Predecessors tab of the Task Information dialog box, as shown in Figure 4-22.

![Figure 4-22: Four types of dependencies enable you to deal with every variable of how tasks can relate to each other’s timing.](image)

Tip

Use the Lag column on the Predecessors tab of the Task Information dialog box to create lag time between tasks.

The first timing mentioned in each relationship name relates to the predecessor task and the second to the successor. Therefore, a start-to-finish dependency relates the start of the predecessor to the finish of the successor, and a finish-to-start relationship relates the finish of the predecessor to the start of the successor. Project refers to these relationships by their initials, such as SS for a start-to-start relationship.

Tip

As you view the figures in the following sections, take note of the direction that the arrow points between tasks. The direction of the arrow provides important visual clues about the type of dependency.
**Finish-to-start (FS)**

A finish-to-start relationship is the most common type of dependency and is, in fact, the only relationship that you can create by using your mouse or the Link Tasks tool or command. In the finish-to-start relationship, the successor task can’t start until the predecessor task finishes. Examples of this relationship are as follows:

- You must write a report before you can edit it.
- You must have a computer before you can install your software.

In Figure 4-23, you see examples of the FS relationship in which the successor task can start as soon as its predecessor is finished. The following tasks have a finish-to-start relationship:

- Task 2 and Task 3
- Task 3 and Task 4
- Task 4 and Task 5

![Image of Microsoft Project with finish-to-start relationship](image)

**Figure 4-23:** In the FS relationship, successor tasks can’t start until predecessor tasks finish.
The relationship between Tasks 4 and 5 also contains some lag time, as discussed in the section “Allowing for overlap and delays,” earlier in this chapter.

**Start-to-finish (SF)**

With the start-to-finish relationship, the successor task cannot finish until the predecessor task starts. The following are some examples:

- You can finish scheduling production crews only when you start receiving materials.
- Employees can start using a new procedure only when they have finished training for it. If the use of the new procedure is delayed, you also want to delay the training so that it occurs as late as possible before the implementation.

Can you set up this start-to-finish example as a finish-to-start relationship? Not really. The idea is to allow no delay between training and implementation. If you set the new procedure to start only when the training finishes, the new procedure can start any time after the training ends, depending on how other relationships may delay it. If the training task has to finish just before the other task starts, delays of the later task (implementation) also delay the earlier task. This fine distinction will become clearer when you see projects in action.

Figure 4-24 shows a start-to-finish relationship between acquiring materials for Phase Two Testing and completing the analysis of Phase One Testing. Assuming that the test results of Phase One determine the materials that you’ll need for Phase Two, you can’t begin acquiring materials for Phase Two Testing until you have completed the analysis of Phase One Testing. Notice the direction of the arrow that connects the two tasks; it provides a visual clue of the type of dependency that exists between the tasks. In fact, the direction of the arrow in all dependencies provides you with valuable information.

**Start-to-start (SS)**

In a start-to-start relationship, the successor can’t start until the predecessor starts. Consider the following examples:

- When you start getting results in an election, you can begin to compile them.
- When the drivers start their engines, the flagger can start the race.

In Figure 4-24, Tasks 9 and 10 have a start-to-start relationship.
Figure 4-24: The successor task can’t finish until the predecessor task starts.

**Finish-to-finish (FF)**

In the finish-to-finish dependency, the successor task can’t finish until the predecessor task finishes. Consider the following examples:

- You finish installing computers at the same time that you finish moving employees into the building so that the employees can begin using the computers right away.
- Two divisions must finish retooling their production lines on the same day so that the CEO can inspect the lines at the same time.

Suppose that, in Phase Two of the testing in Figure 4-25, you can begin preparing the solution (Prepare solution 2) while you’re still acquiring materials (Acquire materials 2). However, you can’t finish preparing the solution until you finish acquiring the materials. Therefore, set up a finish-to-finish dependency between the two tasks to make sure that you don’t finish preparing the solution if you experience a delay in acquiring materials.
Establishing dependencies

As previously mentioned, you can set dependencies in several different ways. If you use the tasks on the Gantt Chart to set dependencies, you must establish finish-to-start relationships. To establish more complex relationships, including lag and lead, use the Task Information dialog box.

You can set dependencies between two summary tasks or between a summary task and a subtask in another task group by using a finish-to-start or a start-to-start dependency. You cannot use any other type of dependency, and you cannot set dependencies between a summary task and any of its own subtasks.

Setting finish-to-start dependencies

With the Gantt Chart displayed, you can use your mouse, use the Link Tasks tool, or choose Edit→Link Tasks to set finish-to-start dependencies. Use the following steps to set a simple finish-to-start relationship:

Figure 4-25: The successor task can’t finish before the predecessor task finishes.
1. Place your mouse pointer over the predecessor task until the pointer turns into four arrows pointing outward.

2. Drag the mouse pointer to the second task. An information box describes the finish-to-start link that you are about to create, as shown in Figure 4-26.

3. Release your mouse button when you're satisfied with the relationship, and Project establishes the link.

![Image of Microsoft Project](image.png)

**Figure 4-26:** The relationship isn't established until you release the mouse button. If you have second thoughts, just drag the pointer back to the predecessor task before releasing your mouse button.

To use the Link Tasks tool or the Edit ➪ Link Tasks command, simply follow these steps:
1. Select the tasks that you want to link. To select adjacent tasks, drag through their ID numbers in the Gantt Chart table. To select nonadjacent tasks, hold Ctrl as you click the ID numbers of the tasks that you want to link.

   **Note**
   Starting in Project 2000, you also can select nonadjacent tasks by holding Ctrl as you click their Gantt bars.

2. Click the Link Tasks tool, or choose Edit ➪ Link Tasks. Project establishes the link.

**Setting other types of dependencies**
You can use either the Task Information dialog box or the Task Dependency dialog box to set any type of dependency. Use the Task Dependency dialog box, as shown in Figure 4-27, to establish dependency types or lag times between tasks. To open the Task Dependency dialog box, double-click the line that connects the tasks that you want to change.

![Figure 4-27: Use this dialog box to establish task dependencies or lag time.](image)

From the Task Information dialog box, in addition to establishing dependencies and lag times, you also can set lead times. If you choose to use the Task Information dialog box, open the dialog box for the successor task and build the relationship on the Predecessors tab.

Follow these steps to create a task dependency:

1. Double-click the task that you want to make a successor. When the Task Information dialog box appears, select the Predecessors tab if it’s not already displayed.

2. Click the Task Name column; an arrow appears at its far end.

3. Click the arrow to the right of the column to display the drop-down list of task names, as shown in Figure 4-28.

4. Click the task that you want to identify as the predecessor to this task.
5. Click the Type field; a list box arrow appears.

6. Click the arrow to display a list of dependency types.

7. Click the type of dependency that you want to establish, such as start-to-start or start-to-finish.

To establish a dependency with no lag or lead, click OK at this point to create the relationship. To establish a delay, click the Lag column and supply an amount of time for the delay. To establish an overlap, simply enter a negative number in the Lag column. For example, if you want the successor to finish one week before the predecessor finishes, use a finish-to-finish relationship and type 1 week in the Lag column.

Here’s a quick way to create finish-to-finish, start-to-finish, or start-to-start relationships. Create the default finish-to-start relationship for the tasks. Then, double-click the link line to open the Task Dependency dialog box and change the relationship.

**Viewing Dependencies**

After you’ve established several dependencies in a project, you can study them in several ways. You can, of course, open each task’s Task Information dialog box and look at the relationships listed on the Predecessor tab. You can also view the lines that are drawn between tasks to see dependencies. Finally, you can scroll to the right in the Gantt table, or you can reduce the size of the Gantt Chart to see more of the Gantt table and display the Predecessors column, as shown in Figure 4-29. This column lists any relationships, using the two-letter abbreviations for the dependency type and positive and negative numbers to show lag and overlap.
Figure 4-29: Display the Predecessors column to show all the relationships for a task.

**Deleting Dependencies**

Several techniques for deleting dependencies are as follows:

- Open the Task Information dialog box for the successor task, select the Predecessors tab, click the task name for the link that you want to break, and press Delete.
- Display the Predecessors column in the Gantt table, click the Predecessors cell for the successor task, and either press Delete to delete all relationships or edit the predecessor information in the cell or in the entry bar.
- Select the tasks that are involved in the dependency that you want to delete and click the Unlink Tasks tool, or choose Edit→Unlink Tasks.
- Double-click the dependency line, and click the Delete button in the Task Dependency dialog box.

If you delete a dependency, the task bars may shift accordingly to reflect any new timing.
Summary

In this chapter, you read more about the timing of tasks, including how to set task durations and dependencies. You now should know how to do the following things:

✦ Differentiate between resource-driven and fixed scheduling
✦ Establish task durations
✦ Assign calendars to tasks
✦ Create recurring tasks
✦ Establish constraints and deadline dates
✦ Adjust the timescale to view task durations
✦ Add and view task notes
✦ Set, view, and delete dependencies

In Chapter 5, you begin to assign resources to tasks and to find out more about the relationship between resource assignment and task timing.
Creating Resources and Assigning Costs

The management portion of the term project management suggests that you are overseeing and, supposedly, controlling what goes on during the project’s lifetime. In the last chapter, you found out how to build the tasks that comprise the project. Now you need to identify the resources for each task. Some tasks require people only; other tasks may also require equipment.

As you create resources, you see that various rates are associated with a resource. As you assign the resource to a task in your project, Microsoft Project automatically begins to calculate the cost of your project.

Understanding Resources

Resources are the people, supplies, and equipment that enable you to complete the tasks in your project. In versions prior to Project 2000, you could define only work resources — people or equipment that consume time when working on a task. When you set up work resources, you define the amount of time that the resources have to spend on a project (100 percent is full-time). Similarly, when you assign a work resource to a task, you indicate the amount of time that you want the work resource to spend on the task (100 percent is full-time).

Project 2000 added material resources — items that are consumed while working on a project. Material resources use, well, materials like gasoline or wood — as opposed to time. When you assign a material resource to a task, you specify the amount of the material resource that you intend to use in
units that are appropriate for the material resource. You can also indicate whether the amount of material used is based on time. For example, the number of gallons of water that are used when watering a lawn depends on the amount of time that you run the water and the number of gallons per hour that flow from the faucet. Or, you can indicate that the amount of material is fixed. For example, you need five 2×4s to construct a bench — regardless of how long you take to build the bench.

Project 2002 gave you the capability to define generic resources — resources (as defined by you) that aren’t specific people, equipment, or materials, but rather descriptions of the skills that you need for a task when you don’t know what specific resources are available. Although this generic resource feature was designed to work in conjunction with the Resource Substitution Wizard and Enterprise Resources (available in Project Server), you may find generic resources handy even if you don’t use Project Server. For example, you can use generic resources when you don’t care who does the work — you simply want to track the work that is completed on a project.

If you’re using Project Server, you can also take advantage of three other related features. You can define Enterprise Resources — resources that are available company-wide for projects. You can use Team Builder to help you select resources for your project from the Enterprise Resource pool, and you can use the Resource Substitution Wizard to replace generic resources with actual resources. Read more about creating Enterprise Resources in Chapter 19 and about using Team Builder and the Resource Substitution Wizard in Chapter 21.

Resources cost money and therefore affect the cost of the project. To manage a project effectively, you should define resources and assign those resources to tasks in the project. Thus, you need to know how Project uses those resource assignments to change the duration and length of your project.

If you expect to use the same resources for several projects, consider setting up the resources in a special project that contains no tasks. Then you can use Project’s resource pooling feature and the “resource project” to share resources across multiple projects. This approach enables you to set up resources once and then use them repeatedly on many different projects. For more information about resource pooling and managing multiple projects outside Project Server, see Chapter 15. If you use Project Server, see Chapter 19 for more information about setting up Enterprise Resources.

**How resources work**

By defining and then assigning resources, you accomplish the following goals:

- You can keep track of the tasks that are being performed by resources — because Project identifies the resources that are assigned to each task.
- You can identify potential resource shortages that may force you to miss scheduled deadlines and possibly extend the duration of your project.
✦ You can identify underutilized resources. If you reassign these resources, you may be able to shorten the project’s schedule.

When the tasks that you create are effort-driven — Project defines all new tasks as effort-driven by default — the resources that you assign to a task affect the duration of the task. For example, if you assign two people to do a job, the job typically gets done in less time than if you assigned only one person to the job. But, you ask, what about the cost? Does the use of additional resources increase the project’s cost? Perhaps yes — perhaps no. You may find that completing the project in less time (by using more resources) saves you money because you can accept more projects. Or you may be eligible for a bonus if you complete the project earlier than expected, and the bonus may cover or exceed the cost of the additional resources that you used.

**How Project uses resource information to affect the schedule**

For effort-driven tasks, Project uses the resource information that you provide to calculate the duration of the task and, consequently, the duration of the project. However, if you set up a task with a fixed duration, Project ignores the resources that are assigned to the task when calculating the duration of the project. Similarly, if you don’t assign resources, Project calculates the schedule using only the task duration and task dependency information that you provide.

See Chapter 4 for information on task durations and task dependencies.

Assigning a resource to a task can affect the duration of the project, because work on the task can’t begin until the resource is available. Project uses a resource calendar to define the working days and times for a resource, but the resource’s availability also depends on other tasks to which you have assigned the resource.

If the work assigned to a resource exceeds the time that is available, Microsoft Project assigns the resource to the task and indicates that the resource is overallocated. This technique enables you to see the problem and decide how to fix it.

**How Project gathers cost information**

When you assign costs to resources and then assign resources to tasks, Project can calculate the cost of a project. In addition to resource-associated costs, Project also handles fixed costs, which you read more about near the end of this chapter.

You have the option of assigning costs to resources when you define them, as you see in “Creating a Resource List,” later in this chapter.
Assigning costs enables you to monitor and control the money that you’re spending on a project. Project shows you where and how you are spending your money. This information enables you to control when a project’s costs accrue, which, in turn, helps you to schedule your bill payment. The cost-related information that Project provides helps you to verify the following items:

✦ The cost of resources and materials for any task
✦ The cost of any phase of your project as well as the cost of the entire project

Cost information that you gather on one project may help you to calculate bids for future projects.

Creating a Resource List

If you intend to upload this project into Project Server, you may want to assign resources from the Enterprise Resource pool, a company-wide group of resources. See Chapter 19 for details on assigning resources from the Enterprise Resource pool.

Project gives you the option of creating resources one at a time, as you think of them, or entering all (or most) resources by using the Entry table of the Resource Sheet. To display the Resource Sheet, shown in Figure 5-1, click the Resource Sheet button on the View bar or choose View ➪ Resource Sheet. By default, Project displays the Entry table of the Resource Sheet.

You can switch tables by choosing View ➪ Table and then selecting from the submenu that appears. Each table contains columns that are pertinent to its name. For example, the Cost table shows columns that pertain to a resource’s cost.

To add resources to your projects that exist elsewhere (such as your company address book or in Microsoft Project Server), click the first link on the Resource page of the Project Guide.

If you use the Resource Sheet to define most of the resources for your project, the process of assigning resources goes much faster because you don’t have to stop to create the resource first. Also, using the Resource Sheet is a safe way to define resources; the visual presentation helps you avoid accidentally creating the same resource twice. For example, if you define Vickey and Vicki, Project sees two resources, even though you may have simply misspelled the name the second time.

You can enter the basics for the resource by filling in the Resource Sheet; simply press Tab to move from field to field (cell to cell). The Resource Sheet shown in Figure 5-1 does not show all the fields described in this section. Scroll to the right to see the rest of the Entry table of the Resource Sheet.
Figure 5-1: The Resource Sheet displays a list of the resources that are available to your project.

You can customize the Resource Sheet to show many additional fields that you may want to set up for each resource. For example, if you need to manually enter e-mail addresses for each resource, you can add the E-mail Address column to the Resource Sheet.

See Chapter 7 to find out how to insert a column in a table.

As part of the Project Guide, you can have Project walk you through the process of creating resources. The Resources page of the Project Guide, visible in Figure 5-1, appears when you display the Resource Sheet view or when you click the Resources button on the Project Guide toolbar. Click a link to walk through the associated steps.

A field is a cell in a table into which you type appropriate information. All table and form views contain fields. Each field on the Resource Sheet serves a specific purpose, as follows:
✦ **Indicators:** Although you can’t type in the Indicators field, icons appear here from time to time. Some of the icons appear as Project’s response to an action that you’ve taken. For example, you may see an indicator for an overallocated resource. In other cases, the indicator appears because you entered a note about the resource. See the section “Adding notes to a resource,” later in this chapter, for more information.

If you rest your mouse over an indicator, Project displays the information that is associated with the icon.

✦ **Resource Name:** Type the name of the resource. For a person, you can type the person’s name or you can type a job description, such as Product Analyst 1 or Product Analyst 2.

✦ **Type:** Use this column to specify whether you’re defining a human or material resource. Project refers to human resources as Work.

✦ **Material Label:** For material resources, specify the unit of measure. You can set up any label that you want. For example, you can use minutes for long distance, feet for lumber, or miles for gasoline.

✦ **Initials:** Type initials for the resource, or accept the default that Project provides, which is the first letter of the resource name. This designation appears on any view to which you add the Initials field. Typically, a resource’s name appears, but you can customize the view to display initials if you prefer.

✦ **Group:** Assign resources to groups if they share some common characteristic, such as job function. Then you can use this field as a filtering or sorting mechanism and display information about the group (a particular job function) as opposed to a specific resource. Just type a name to create a group.

Be sure to spell the group name the same way each time if you want to filter or sort by group.

✦ **Max. Units:** Project expresses the amount of the work resource that you have available for assignment as a percentage. For example, 100 percent equals one unit, or the equivalent of one full-time resource; 50 percent equals one-half of a unit, or one-half of a full-time resource’s time; and 200 percent equals two full-time resources.

✦ **Std. Rate:** The standard rate is the rate that you charge for regular work for a resource. Project calculates the default rate in hours. However, you can charge a resource’s work in other time increments. (For work resources, you can use minutes, days, weeks, or years. For material resources, think of the charge as per unit based on the Material Label.) To specify a time increment other than hours, type a forward slash and then the first letter of the word representing the time increment. For example, to charge a resource’s use in days, type /d after the rate that you specify.
✦ **Ovt. Rate:** The overtime rate is the rate that you charge for overtime work for a work resource. Again, Project calculates the default rate in hours, but you can change the default unit the same way that you changed it for the standard rate.

✦ **Cost/Use:** In the Cost/Use column (read as cost per use), supply a rate for costs that are charged for each use of the resource. Resource costs may be based on the Standard rate (which is calculated by multiplying the number of hours times the cost per hour), the Cost/Use rate (a fixed fee for use of the resource), or a combination of the two. Project uses a combination of the Cost/Use field and the Std. Rate field when calculating the cost of a task. If you rent a piece of equipment that costs you $25/hour plus a setup charge of $100, you would assign a Std. Rate of $25/hour and a Cost/Use of $100.

✦ **Accrue At:** This field specifies how and when Microsoft Project charges resource costs to a task at the standard or overtime rates. The default option is Prorated, but you also can select Start or End. The three are described as follows:

- If you select Start and assign that resource to a task, Project calculates the cost for a task as soon as the task begins.

- If you select End and assign that resource to a task, Project calculates the cost for the task when the task is completed.

- If you select Prorated and assign that resource to a task, Project accrues the cost of the task as you complete scheduled work.

If you set the cost-per-use rate for a resource and assign that resource to a task, Project will use the Accrue At field to determine if the cost is applied at the beginning or end of the task. If you set the Accrue At field to Start or Prorated, Project charges the cost at the beginning of the task. If you set the Accrue At field to End, Project charges the cost at the end of the task.

✦ **Base Calendar:** Base calendar identifies the calendar that Project should use when scheduling the resource. The calendar identifies working and nonworking time. Project assumes that each resource uses the Standard calendar, but as you read later in this chapter, you can create calendars for resource groups (perhaps to handle shift work) or you can modify an individual resource’s calendar to reflect vacation or other unavailable time (such as jury duty).

✦ **Code:** You can use this field as a catchall field to assign any information that you want to a resource, using an abbreviation of some sort. For example, suppose that your company uses cost-center codes. You may want to supply the cost-center code for the resource in the Code field. You can sort and filter information by the abbreviations that you supply in the Code field.

After you create a resource, Project displays the resource’s ID number on the left edge of the Resource Sheet, to the left of the Indicator column.
Modifying Resource Information

You just learned a quick way to set up a resource — by typing on the Resource Sheet. In addition, you can use the Resource Information dialog box to fine-tune your resource’s definition.

Use the Resource Information dialog box to modify resource information. To display the Resource Information dialog box, double-click any resource on the Resource Sheet or choose Project ➪ Resource Information. Then click the General tab.

You already provided most of the information on this tab on the Resource Sheet, so this section discusses the fields in the dialog box that didn’t appear by default on the Entry table of the Resource Sheet.

Assigning a communication method

Use the Email field, shown in Figure 5-2, to supply the e-mail address of a resource. You must fill in this field if you want to use Project’s workgroup feature, which enables users to assign, accept, or decline work electronically. You can make a selection from the Workgroup drop-down list to specify an electronic communication method.

Figure 5-2: Use the General tab of the Resource Information dialog box to add information about a resource, such as an e-mail address or availability.
E-mail and Project

If you're using Outlook and you've stored the resource’s e-mail address in your address book, you can click the Details button in the Resource Information dialog box to have Project look up the e-mail address for you. You can then copy the address from the address book, close the address book, and in the Email field, press Ctrl+V to paste the address into the Resource Information dialog box.

However, I suspect that you’ll find it faster to use the Specify people and equipment for the project link on the Resources page of the Project Guide to enter e-mail addresses for resources. When you click the link, the page changes and presents you with four options. Select the second one (Add resources from the company Address Book), click the Address Book link that appears, as shown in the following figure, and follow the on-screen instructions.
While Project 2003 still supports e-mail workgroups, Microsoft is phasing out this feature. It won’t be available in the next version of Project.

See Chapter 16 for more about the e-mail workgroup feature. See Chapters 17 through 23 for more information about using Project and Project Server.

**Specifying resource availability**

Suppose that you set up a resource to represent a specific job, such as Intern, as shown in Figure 5-2. And suppose that you have more than one of this resource, but not at all times. Using the Resource Availability section (refer to Figure 5-2), you can specify the time periods for which the resource will be available. Figure 5-2 shows that three interns are available from June 1 through July 31 and only one intern is available from August 1 through August 31.

Starting in Project 2000, you can contour the availability of resources. See Chapter 10 for more information.

**Specifying a booking type**

Project 2003 introduces the Booking Type field.

Starting with Project 2003, you can specify a booking type for a resource assignment. Booking types are most useful in the Enterprise environment, where you are utilizing the Enterprise Resource Pool.

The Booking type field offers you two choices: Committed and Proposed (see Figure 5-3). When you commit a resource, you are officially assigning the resource to the project. When you propose to use a resource, you are indicating that the resource is not yet officially assigned to the project, which essentially leaves the resource’s calendar untouched by the proposed assignment to your project. Another project manager could commit the resource to a different project for the same time frame, and Microsoft Project will *not* identify the resource as being overallocated. Project does not consider proposed bookings when calculating resource allocation.

The Booking type that you choose for a resource applies to *all* tasks in your project to which you assign the resource.
Chapter 5 ✦ Creating Resources and Assigning Costs

Figure 5-3: Specify whether to commit a resource or simply propose its use.

Creating a generic resource and assigning custom fields

The Intern resource that was discussed in the previous section is essentially a generic resource. It’s a job description, not a person. To mark a resource as generic, place a check mark in the Generic box on the General tab of the Resource Information dialog box (refer to Figure 5-2). Your company may have set up custom fields in Project that apply to your generic resource. To assign the appropriate custom fields, click the Custom Fields tab and assign any appropriate values to your generic resource, as shown in Figure 5-4.

See Chapter 19 for more information about creating custom fields.

When you click OK to close the dialog box, you see an icon in the Indicator column like the one shown in Figure 5-5. This icon signifies that the resource is generic.
Figure 5-4: You can assign custom fields to generic resources to describe the skills that are required.

Figure 5-5: Identify generic resources by the icon that’s shown in the Indicator column.
Adding notes to a resource

Click the Notes tab of the Resource Information dialog box. The Notes text box, shown in Figure 5-6, is a free-form text box in which you can type any information that you want to store about the resource. For example, you may want to store a reminder about a resource’s upcoming vacation or an explanation about resource availability.

![Figure 5-6: Use this text box to store information about a resource.](image)

After you type text in this box and click OK, a Note indicator icon appears in the Indicator column on the Resource Sheet, as shown in Figure 5-7.

Note

If more than one indicator appears in the Indicator column, Project displays information about all indicators when you point to the Indicator column.
Figure 5-7: You don’t need to reopen the Resource Information dialog box to read a note. Instead, place your mouse over the icon in the Indicator column, and Project displays the contents of the note.

Calendars and resources

As you read in Chapter 3, Project uses a base calendar called the Standard calendar to calculate the timing of the project. When you first create a resource for your project, Project uses the Standard base calendar as the default (an 8-hour day and a 40-hour week if you haven’t changed this setting in the Project Information dialog box). As discussed in the preceding section, you can modify the dates that a resource is available; you also can modify working times. For example, you may want to change a resource’s working hours or you may want to block off a period of time — such as vacation time or a business trip — for a resource, making the resource unavailable during that period.

The entire project has a Standard calendar, and each resource also has his or her individual Standard calendar.
Modifying a resource’s working hours

Suppose that a specific resource won’t be available all day on a given day, or even on several specified days. For example, suppose that all the interns work from 1:00 p.m. to 6:00 p.m. To change the working hours of a resource, use the Working Time tab of the Resource Information dialog box. Double-click the resource on the Resource Sheet to open the dialog box. The resource’s calendar appears with today’s date selected. The Legend panel at the left of the dialog box identifies Working days, Nonworking days, Edited working hours, and edits to a day of the week or an individual day on the current calendar. Select the dates that your resource will not be available.

To select contiguous days on the calendar in the Select Dates section, click the first day. Then press Shift, and click the last day that you want to select. To select non-contiguous days, press Ctrl as you click or drag over each day that you want to select. To select all of any day (for example, all Sundays), click the letter of the day. Project selects all of those days, in all months.

Make the necessary changes in the From and To text boxes, as shown in Figure 5-8. The dates that you selected appear underscored in the individual’s calendar because you set an exception to the regular schedule. The Legend panel shows you that the exception involves edited working hours.

![Resource Information dialog box](image)

**Figure 5-8:** Select the dates that you want to change. Project marks exceptions to the typical schedule with an underscore.

If you select all of any given day, Project underlines the letter for the day instead of the individual dates.
You don’t need to select the Nondefault working time option button. While the dialog box continues to show that the Use default option is selected, Project automatically selects the Nondefault working time option button.

To avoid overallocating a resource that works part of a day, level the resource on a day-by-day basis. Read more about handling overallocations in Chapter 10.

**Blocking off vacation time**

Human resources take time off from work, and to avoid overallocating a person by assigning work during a vacation period, you should mark vacation days on the resource’s calendar.

Double-click the resource to display the Resource Information dialog box, and click the Working Time tab. Find the date or dates that you want to block for vacation time by using the scroll bar next to the calendar. With the vacation dates selected, select the Nonworking time option. Click any other date on the calendar to cancel the selection; each date that you marked as vacation time appears with an underscore. Again, by comparing the date to the Legend panel, you can tell the reason for the exception.

Be aware, when selecting dates, that Project changes only the highlighted days of the displayed month unless you select the letter of the day.

**Using Resources and Tasks**

You’ve spent a lot of time in this chapter defining resources and fine-tuning your resource definitions. Now you can finally assign resources to tasks. As noted earlier in this chapter, defining resources helps you to manage your project more effectively, both in scheduling and in cost.

**Assigning resources to tasks**

You can easily assign resources to tasks from the Gantt Chart view. Choose View➪Gantt Chart or use the View bar to switch to the Gantt Chart view, and then follow these steps to assign resources to tasks:

1. Select the task to which you want to assign a resource. You can click the task bar on the Gantt Chart, or you can click any column in the Gantt table.

2. Click the Assign Resources button or choose Tools/Resources/Assign Resources to open the Assign Resources dialog box, as shown in Figure 5-9.
Chapter 5 ✦ Creating Resources and Assigning Costs

Figure 5-9: Use the Assign Resources dialog box to assign a resource to the task that is identified at the top of the box.

3. Select the resource that you want to assign from the Resource Name list of the Assign Resources dialog box.

Did you forget to define a resource? You don’t need to return to the Resource Sheet. Just type the name of the resource in the Resource Name column of the Assign Resources dialog box.

4. (Optional) If you’re using Project Server and you intend to use the Resource Substitution wizard, in the R/D field, type an R for Request to indicate that any resource with the required skills can work on the task. You can also type a D for Demand to indicate that the selected resource is specifically required to work on the task.

For more information about Resource Substitution, see Chapter 21.

5. Do one of the following to assign the amount of a resource:

- To assign any amount other than 100 percent of a resource, type the quantity of the resource as a percentage in the Units column. (Project defines units as percentages, so 100 percent equals one unit of the resource.)

- To assign 100 percent of a resource, leave the Units column blank. Project assigns 100 percent by default.

You don’t need to type the percent sign (%); Project assumes percentages. For example, if you type 50, Project converts your entry to 50%. However, you can’t assign less than 1% of a resource’s time.

6. Click Assign. Project places a check mark in the leftmost column of the Assign Resources dialog box to indicate that the resource is assigned to the selected task.

7. Repeat Steps 3, 4, and 5 to assign additional resources to the selected task, or click Close.
Getting help while selecting resources to assign

You may have noticed a plus sign (+) next to Resource list options at the top of Figure 5-9. If you click the plus sign, the box expands, as shown in Figure 5-10, to provide you with ways to make selecting resources easier.

![Assign Resources](image)

**Figure 5-10:** You can narrow your search for resources by filtering, and you can make additional resources available.

If you check the Filter by check box, Project presents a long list of ways that you can limit the resource list. For example, you can search for only material resources or you can search for resources in a particular group. (Remember that you can assign resources to groups if the resources share a common characteristic.) If you don’t find the filter that you want to use, you can create your own filter by clicking the More Filters button and, in the More Filters dialog box that appears, click New.

See Chapter 7 for information about creating custom filters.

If you check the Available to work box, you can specify the number of hours that you need the resource. Project calculates the remaining available hours of each resource for the duration of the task and compares the results of the calculation with the number of hours that you specified. Resources with available hours equal to or greater than the value that you supplied appear in the list, along with the resources that are already assigned to the selected task.
Chapter 5 ✦ Creating Resources and Assigning Costs

If you need a resource for 12 days, type **12d** in the Available to work box, and Project converts the value to 96 hours.

You can click the Add Resources button to display a list of sources from which you can select a resource: the active directory, your address book (if you use a MAPI-compliant e-mail program such as Microsoft Outlook or Outlook Express), or Microsoft Project Server — the items that are available in the list depend on your working environment.

The Active Directory, one of the options that appears when you click Add Resources, is a Windows network feature. In a Windows network, the administrator can set up an active directory that contains a list of people and the contact information for these people.

The Assign Resources dialog box also contains a Graphs button that shows one of three graphs that you can use to help you select the best resource for the job. Be aware that none of these graphs relate particularly to a task for which you’re considering assignment; instead, they focus on the resource.

Although you can select multiple resources to graph, this action may not be very useful when you’re trying to select resources to assign to a task.

The Work graph, shown in Figure 5-11, shows the amount of work (regardless of the task) that is assigned to the selected resource on a day-by-day basis.

---

How Project calculates Available to work time

Project calculates the value for Available to work time by using the resource’s calendar, availability contour, and the duration of the task. Based on the resource’s calendar, Project calculates the number of working hours for the selected task. Because the resource’s availability may be reduced by the availability contour and by other assignments, Project multiplies available working hours by the availability contour value and then subtracts existing assignment work hours to determine Available to work hours.

To see how this works, assume that you have a task to accomplish within a 10-day window and the calendar provides for an 8-hour workday. If Day 3 is a holiday and Days 6 and 7 are the weekend, you have only 7 days to complete the task. If you assign one resource to this task full-time, that resource would be allocated for 56 hours. But, if the resource’s availability contour is set to 50 percent, the resource’s availability is reduced to 28 hours. And, if the resource is already assigned to another task for 25 percent of the time on Days 1 and 2 (4 hours), the resource’s Available to work hours would be 24 hours.

Tip

If you need a resource for 12 days, type **12d** in the Available to work box, and Project converts the value to 96 hours.

Note

The Assign Resources dialog box also contains a Graphs button that shows one of three graphs that you can use to help you select the best resource for the job. Be aware that none of these graphs relate particularly to a task for which you’re considering assignment; instead, they focus on the resource.

Note

Although you can select multiple resources to graph, this action may not be very useful when you’re trying to select resources to assign to a task.
Figure 5-11: On this graph, you see the amount of work that is assigned to the selected resource.

The Assignment Work graph, shown in Figure 5-12, breaks down the total workload of the resource that you’re considering, showing you the resource’s workload on the selected task, other tasks, and the resource’s total availability based on the calendar. Using this graph helps you to see if you’ll overallocate the resource by assigning it to this task.

Figure 5-12: Use this graph to avoid overallocating a resource.
The Remaining Availability graph, shown in Figure 5-13, shows you the resource’s unassigned time.

If you’ve overallocated a resource, you don’t see a negative availability; the resource’s availability appears to be 0.

![Figure 5-13: Use this graph to check a resource’s availability.](image)

You also can view the Remaining Availability graph from the Resource Center in Project Web Access.

**Some tips about resource assignments**

Use the following tips when assigning resources:

- You can assign several different resources to the same task by simply selecting each resource. You can select a single resource and immediately click Assign, or you can use standard Windows selection techniques to select several resources and then click Assign only once.

- You can assign a resource to a task on a part-time basis by assigning less than 100 in the Units column. The number that you type represents the percentage of working time that you want the resource to spend on the task.

- You can assign more than one resource by assigning more than 100 in the Units column.
You can consume material resources in two ways: fixed and variable. When you use fixed consumption, you indicate that — no matter how long the task lasts — you’ll use the same quantity of the material. For example, to build a swimming pool, you need 2 tons of concrete — no matter how long it takes you to pour the concrete. When you use variable consumption, you indicate that the length of the task does affect the amount of the material that you will use. For example, when you mow the lawn with a gas mower, the amount of gas that you consume depends on how long you run the mower.

You designate fixed or variable consumption in the Units column of the Assign Resources dialog box. To differentiate between fixed and variable consumption, supply the rate at which you consume a variable resource. In Figure 5-14, gasoline is a material resource that is being consumed at a variable rate because I included the time frame used to measure consumption — the per-hour designation.

Figure 5-14: Indicate variable consumption by supplying the rate when you specify the amount that you’ll use.
After you assign a resource to a task, the resource name appears next to the task bar on the Gantt Chart by default. Depending on the task type that you set, you may be able to use resource assignments to modify individual task lengths and the entire project schedule. For example, if you assign additional resources to an effort-driven, fixed-unit task, Project shortens the duration of the task. As you read in Chapter 4, the amount of work to be done doesn’t change, but the extra concurrent effort shortens the time that’s necessary to get the work done. Or, if you assign a resource to work part-time on an effort-driven task, you may find that you can complete several tasks at the same time.

If you overallocate a resource by assigning more of the resource than you have available, Project displays the resource in red on the Resource Sheet view. Chapter 9 explains how to handle these problems.

Removing or replacing a resource assignment

To remove a resource assignment, select the task from which you want to remove the resource assignment using the Gantt Chart view. Then click the Assign Resources button or choose Tools/Resources/Assign Resources to display the Assign Resources dialog box. Highlight the resource that you want to remove from the task. You should see a check mark next to the resource in the leftmost column of the dialog box. Click Remove, as shown in Figure 5-15.

Figure 5-15: Remove resources from tasks by selecting them in the Assign Resources dialog box and clicking Remove.
You can be sure that at some point in your project, you will want to change resource assignments. Follow these steps to switch from one resource to another on a particular task:

1. Select the task for which you want to switch resources.
2. Open the Assign Resources dialog box.
3. Highlight the resource that you want to remove from the task; a check mark appears next to the assigned resource.
4. Select Replace. Project displays the Replace Resource dialog box, which enables you to easily select replacement resources, as shown in Figure 5-16.

5. Highlight each resource that you want to assign, and supply units.
6. Click OK.
Handling Unusual Cost Situations

Resources go hand in hand with tasks if you’re trying to figure out how long it will take to complete a project. If you assign costs to your resources, those costs also affect the cost of your project. Assigning a cost to a resource, however, is not the only way to assign a cost to a project. For example, projects can have fixed costs associated with them. This section starts with a quick look at overall project costs and then focuses on handling unusual cost situations.

Looking at the project’s cost

You’ve seen how to assign costs to resources. You’ve also seen how to assign resources to tasks — and, by the transitive property of equality (remember that one from high school algebra?), assigning a resource to which you have assigned a cost causes your project to have a cost. Are you wondering what that cost is? From either the Gantt Chart view or the Resource Sheet view, choose Project ➪ Project Information to open the Project Information dialog box. Select Statistics to open the Project Statistics dialog box, as shown in Figure 5-17.

![Figure 5-17: Check the cost of your project in the Project Statistics dialog box.](image)

Assigning fixed costs

This chapter has, to this point, focused on resources, and you have learned how to assign costs to a resource. But the costs of some tasks need to be calculated differently. In Project, you can assign a fixed cost to a task or you can assign a fixed resource cost to a task.

Cross-Reference

Part IV covers tracking, recording work done, and analyzing and reporting on progress. Chapter 14 explains additional ways to view project costs. The following sections consider ways to assign unusual costs to a project.
Assigning a fixed cost to a task

Some tasks are fixed-cost tasks, that is, you know that the cost of a particular task stays the same regardless of the duration of the task or the work performed by any resources on the task. For example, your catering service, as part of each job, washes linens. You own the washing machine, and you’ve done the calculation on the amount of water plus electricity used (plus wear and tear) each time that you run the machine for a wash cycle. Or, you’re renting a site for a meeting for a flat fee. In cases like these, you assign the cost directly to the task. If you assign a cost to a task, Project adds the fixed cost of the task to the cost of any resource work that you assign to the task when calculating costs for the project.

Remember that assigning a fixed cost to a task does not necessarily make the total cost of the task equal to the fixed cost that you assigned. You can, for example, assign more than one fixed cost as well as variable costs to a task.

To assign a fixed cost to a task, use the Gantt Chart view and apply the Cost table. Follow these steps:

1. Use the View bar or the View menu to switch to the Gantt Chart view.

2. Choose View ➪ Table ➪ Entry ➪ Cost to switch to the Cost table view of the Gantt Chart, as shown in Figure 5-18.

Figure 5-18: Use the Cost table view of the Gantt Chart to assign costs to tasks.
3. Select the task to which you want to assign a fixed cost.

4. Type the cost for that task in the Fixed Cost column, and press Enter.

You can control the way that Project accrues the fixed cost for a task from the Fixed Cost Accrual column. Your choices are Start, Prorated, and End. These choices have the same meaning as the accrual choices for resources that were discussed in the section “Creating a Resource List,” earlier in this chapter.

To control the way that Project accrues all fixed costs, use the Calculation tab of the Options dialog box (choose Tools ⇒ Options).

**Assigning a fixed resource cost to a task**

Suppose that you hire a consultant to perform a task for a fixed amount of money; you can assign the consultant to the task as a fixed-cost resource. Follow these steps to assign a fixed resource cost to a task:

1. Set up the resource in the Resource Sheet view. If the resource has some sort of “per unit” cost (an hourly or daily rate), assign that rate in the Std. Rate field. Otherwise, assign a standard rate of $0 as I did in Figure 5-19. Supply the fixed-cost amount in the Cost/Use field.

2. Use the View bar or the View menu to switch to the Gantt Chart view.

3. Choose View⇒Table⇒Costs to switch to the Cost table view of the Gantt Chart.

Switching to this table enables you to see the impact on the cost of the task when you assign the resource.

4. Select a task from the Task Name column.

5. Assign the resource to the task by using the steps that were presented in the section “Assigning resources to tasks,” earlier in this chapter. Don’t worry about the number of units that you assign; the cost is a “per use” cost, so Project will assign the value you assigned in the Cost/Use field in Step 1, regardless of the number of units you assign.
Figure 5-19: Setting up a fixed-cost resource.

Project adds a fixed-resource cost to other resource costs when calculating the total cost of a task, but the cost does not depend on the time that a resource spends working on the task.

**Accounting for resource rate changes**

In some situations, you must charge different rates on different tasks for the same resource. Or, you may expect a resource’s rate to change during the life of your project. Project uses cost rate tables to accurately reflect resource costs as they change. On cost rate tables, you can identify up to 125 rates for a single resource, and you can identify the effective date of each rate. Cost rate tables help you to account for pay increases or decreases to resources during the life of your project and enable you to charge the same resource at different rates, depending on the task.

To assign multiple rates to a resource, use the Costs tab of the Resource Information dialog box. On the Resource Sheet view, double-click the resource for which you want to assign multiple rates. Click the Costs tab in the Resource Information dialog box, as shown in Figure 5-20.
Creating Resources and Assigning Costs

Figure 5-20: Use cost rate tables to assign different rates to a resource.

The Costs tab displays five cost rate tables (tabs A through E) that you can use to assign different rates to a resource for use on different dates throughout a project’s life. On each cost rate table, you can enter up to 25 rates for the selected resource and indicate an effective date for each rate. Project uses the effective dates that you supply to apply the correct rate to a resource at different times during the project.

If you are specifying a new rate as an increase or decrease of an existing rate, you can specify the new rate in a percentage (such as +10% or –10%); Project calculates the value of the rate for you. You must enter the percent sign.

If you charge different amounts for resources depending on the type of work that they perform, you may want to use each cost rate table tab to represent sets of rates for different kinds of work.

To assign the correct resource cost rate table to a task, follow these steps:

1. Assign the resource to the task by using the Assign Resources dialog box, as discussed in section “Assigning resources to tasks,” earlier in this chapter.
2. Choose View ➤ Task Usage or use the View bar to switch to the Task Usage view, as shown in Figure 5-21.
3. In the Task Name column, select the resource for which you want to select a cost table.
4. Click the Assignment Information button on the Standard toolbar to display the Assignment Information dialog box. Click the General tab, shown in Figure 5-22, to select a cost rate table.
Figure 5-21: The Task Usage view shows you the amount of time that a resource is assigned to a particular task.

Figure 5-22: Use the General tab of the Assignment Information dialog box to select a cost rate table.
5. Select the correct cost rate table from the Cost rate table drop-down list.

6. Click OK.

Chapter 12 covers project costs in greater detail.

Summary

This chapter detailed more about using resources in Project, including how to create and assign resources. The following topics were covered:

✦ Creating a resource list
✦ Modifying resource information, including using calendars for resources
✦ Assigning resources to tasks and removing resource assignments
✦ Handling fixed costs, both for individual tasks and for resources
✦ Assigning either a fixed or variable cost to a material resource
✦ Setting up different rates for resources to account for pay increases or decreases or for charging resources at different rates on different tasks

Chapter 6 presents the basics of using the standard views in Project.
Refining Your Project

In This Part

Chapter 6
Understanding the Basics of Views

Chapter 7
Using Views to Gain Perspective

Chapter 8
Modifying the Appearance of Your Project

Chapter 9
Resolving Scheduling Problems

Chapter 10
Resolving Resource Problems
Understanding the Basics of Views

A project is like a small business. As in any business, different people attend to various aspects of the work. The Accounting department thinks mainly of the costs of doing business. The plant supervisor focuses on deadlines and having enough machinery to get the job done. Your Human Resources department thinks of people — their salaries, hours, benefits, and so on.

As the owner of your project, you are likely to wear all of these hats (and more) during the project. Changing views in Project is the practical way of changing hats. You switch to another view to see your work from a different perspective. Each view helps you to focus on a different aspect of your project.

Views in Project enable you to enter, organize, and examine information in various ways. Project provides a variety of views, and this chapter provides you with a basic understanding of the default views. The next chapter covers techniques that you can use to customize views and make them work for you.

What Is a View?

A view is a way to examine your project. Different views enable you to focus on different aspects of the project. Project uses three types of views and typically uses them in combination, as follows:
✦ **Chart or graph views:** Present information by using pictures. You’ve already seen the Gantt Chart view, which is a chart view.

✦ **Sheet views:** Present information in rows and columns, similar to the way that a spreadsheet program presents information. The Task Sheet view and the Resource Sheet view are both sheet views, and each row on the sheet contains all the information about an individual task or resource in your project. Each column represents a field that identifies the information that you’re storing about the task or resource.

✦ **Forms.** Present information in a way that resembles a paper form. You saw the Task Form view in Chapter 5. A form displays information about a single item (or task) in your project.

Shortcut menus are available in many views. Right-click the view to see a shortcut menu.

You can modify the default views by switching what appears on-screen. You can also create custom views. The next two sections describe the following common ways of manipulating views:

✦ Switching the table of any view that includes a table
✦ Adding or changing the details that appear in any view that contains a Details section

You can also create a combination view, in which you see one format in one pane of the window and another format in another pane. Read more about creating custom views and combination views in Chapter 7.

### Changing a table

If a view contains a table, you can use the Select All button to quickly switch to another table. The Select All button appears in the upper left of the table portion of the view. Right-click the Select All button to open the menu that appears in Figure 6-1.

Project displays different choices on this menu, and the choices that you see depend on the view that is displayed when you open the menu.

Choose More Tables to open the More Tables dialog box, which displays all the tables that are available in Project, as shown in Figure 6-2.
Figure 6-1: Switch tables by choosing from the menu that appears when you right-click the Select All button.

Figure 6-2: The More Tables dialog box shows the tables to which you can switch in the Task Usage view.
The PERT tables won’t appear in the More Tables dialog box until you’ve displayed PERT views. Read more about PERT views in the section “PERT Analysis Views,” later in this chapter.

**Changing a Details section**

You also can change the information that appears in the Details section of any view that displays a Details section (such as the Task Usage view). Choose any item from the list that appears when you choose Format ➤ Details, as shown in Figure 6-3.

![Figure 6-3: Change the information that appears in the Details section of the view by selecting from this list.](image)

**Note**

Project adds rows to the Details section when you make selections from this menu. To remove a row, choose Format ➤ Details and select the item that you want to remove.

You also can use the Detail Styles dialog box (choose Format ➤ Detail Styles), as shown in Figure 6-4, to add other information to the Details section.
Examining Indicators

_Indicators_ are icons that appear in the Indicator column on table views; the Indicator column appears to the right of the ID column. Indicators represent additional information about the row in which they appear. For example, a Notes indicator appears in the indicator field on the resource sheet if you assign a note to a resource.

For more information about assigning notes to resources, refer to Chapter 5.

Different icons represent different types of indicators, as follows:

- **Constraint indicators**: These indicators identify the type of constraint that is assigned to a task. For example, a task can have a flexible constraint, such as Finish No Later Than, if the task is scheduled from the finish date. Or, a task can have an inflexible constraint, such as Must Start On, for tasks that are scheduled from the start date. Constraint indicators also show that the task hasn’t been completed within the time frame of the constraint.

- **Task type indicators**: These indicators may identify special conditions about a task, such as whether the task is a recurring task or whether the task has been completed. Task type indicators also identify the status of projects that are inserted in a task.

You can find out more about inserted projects in Chapter 20.
✧ **Workgroup indicators:** These indicators provide some information about the task and its resources. For example, a workgroup indicator can tell you that a task has been assigned but that the resource hasn’t yet confirmed the assignment.

✧ **Contour indicators:** These indicators identify the type of contouring that is used to distribute the work assigned to the task.

Read more about contouring in Chapter 10.

✧ **Miscellaneous indicators:** These indicators identify items, such as a note or a hyperlink, that you created; a calendar that’s been assigned to a task; or a resource that needs leveling.

To identify the purpose of an indicator, point at it. Project tells you what the indicator means or displays additional information to remind you of important details. See the Project Help topic, “About Indicators,” for a complete list of each indicator icon and its meaning.

### Admiring the Views

The following is a list of the default views that are available in Project:

✧ Bar Rollup
✧ Calendar
✧ Descriptive Network Diagram
✧ Detail Gantt
✧ Gantt Chart
✧ Leveling Gantt
✧ Milestone Date Rollup
✧ Milestone Rollup
✧ Multiple Bases Gantt
✧ Network Diagram
✧ PA_Expected Gantt
✧ PA_Optimistic Gantt
✧ PA_PERT Entry Sheet
When you initially open the Views window, you see only 24 views listed. The four PERT views don’t appear in the window until you use them. After you use these views, they appear in the window.

Deciding which of Project’s 28 built-in views (or any of your custom views) suits a particular purpose can be tricky. As you become more familiar with the features of Project and the way that you apply project management concepts and terms to Project, you’ll get more comfortable selecting views by name. The View menu and bar list the eight most frequently used views. You can find the other views in the More Views window; simply choose View ➪ More Views to see these other views.

Project managers can view related information from Project Server in Project without switching between two windows. See Chapter 21 for more information.

The following sections describe how these views enable you to look at different aspects of your project. Notice the wealth of detail about your project that is available to you.

To display any of these views, choose them from the View bar or right-click the View bar and choose More Views from the menu that appears to select them from the More Views dialog box.
Calendar

The top selection on the View bar is the Calendar view, as shown in Figure 6-5. The familiar format of the Calendar view makes it easy to use; a black box surrounds “today.” Using a monthly calendar format, the Calendar view indicates the length of a task with a bar running across portions of days, or even weeks. In the Calendar view, nonworking days appear shaded. Although a task bar may extend over non-working days, such as Saturday and Sunday in this example, the work of the task doesn’t progress over those days. Don’t forget that every project has a calendar (not to be confused with the Calendar view) that tells Project how to handle events, such as 24-hour shifts, weekends, and holidays off, over the life of your project.

Figure 6-5: The Calendar view features a familiar, easy-to-read format.

The Calendar view is useful for entering a simple project and for reviewing what needs to be done on a given day. You can move from month to month by using the large arrow buttons in the upper-right corner of the view, next to the current month name. Depending on your screen resolution, you can see slightly more than a month at a time on-screen by using the Zoom Out tool on the Standard toolbar while in Calendar view. Zoom Out shrinks the calendar to accommodate about a month and a half of your schedule.
To modify the appearance of the Calendar view (for example, to shade working days and leave nonworking days clear), double-click anywhere on the calendar to open the Timescale dialog box and change the corresponding settings.

**Detail Gantt**

The Detail Gantt view shows a list of tasks and related information, as well as a chart that displays slack time and slippage as thin bars between tasks, as shown in Figure 6-6. Choose this view from the More Views dialog box (select View ➪ More Views).

![Slippage and Slack in Detail Gantt View](image)

*Figure 6-6: The Detail Gantt view.*

The thin bar that extends from the left edge of the third task shows slack time between the second and third tasks, and the thin bar that appears at the left edge of the second task represents slippage between the first task and the second task. The number of days appears in both cases. You can think of slack time as flexibility in the schedule. Slippage results when you save a baseline on a project initially and then record actual dates or durations for tasks, and the resulting actual finish dates or durations for the task are later than the baseline finish dates or durations.
This view is most useful for evaluating slack and slippage. The default table in the Detail Gantt view is the Delay table. Use the techniques described in the section “Changing a Table,” earlier in this chapter, to change the table.

You may want to incorporate the Task Details Form view in the bottom pane of the Detail Gantt view so that you can look more closely at the tasks that are associated with slippage or slack. Choose Window ➪ Split, or use the split bar to display the Task Form view in the bottom pane. Then, elect a field on the Task Form view, choose View ➪ More Views and select the Task Details Form view.

You can create a combination view, with the Detail Gantt view in the top pane and the Task Details Form view in the bottom pane, and save and use this combination view later. See Chapter 7 for more details.

**Gantt Chart**

Chapter 2 covers the Gantt Chart view, shown in Figure 6-7, in detail. This view makes it easy for you to create a project, link tasks to create sequential dependencies, see how your project is progressing over time, and view tasks graphically while still having access to details.

![Gantt Chart](image-url)
Leveling Gantt

The Leveling Gantt view, shown in Figure 6-8, focuses on task delays. This view provides a graphic representation of delayed tasks while still providing task detail information. The chart portion of the view shows the effects before and after leveling. The default table that appears in the Leveling Gantt view is the Delay table, but you can change the table by using the techniques that are described in the section “Changing a Table,” earlier in this chapter. You can use the Delay table to add or remove delay time and see the effects of your changes.

![Leveling Gantt view](image)

**Figure 6-8:** The Leveling Gantt view.

**Note**

*Leveling* is the process of resolving resource conflicts or overallocations by delaying or splitting certain tasks. You read more about resource leveling in Chapter 10.
In this chart, you see the Theme task showing a leveling delay. The bar to the left of this task represents delay time, and the table indicates the number of days that the leveled task is delayed.

**Tracking Gantt**

The Tracking Gantt view is also based on the Gantt Chart view. The Tracking Gantt view provides a great visual way to evaluate the progress of individual tasks and the project as a whole. By using the Tracking Gantt view, you can see how your project has shifted from your original estimates and then decide how to adjust your plans to accommodate delays. Theoretically, if a project ever goes faster than you’ve anticipated, you can also see the amount of extra time that you’ve bought yourself as a result of your efficiency. (However, projects so seldom go faster than projected that I won’t show that option here!)

Figure 6-9 shows a standard Gantt view of a project that has had some activity. The standard Gantt view shows the progress on tasks as a black bar within the baseline task bar. Tasks that depend on the completed tasks have been moved out to reflect delays in the actual work completed.

Figure 6-9: The standard Gantt view shows you the reality of your project timing at the moment, based on actual work done.
Figure 6-10, on the other hand, shows the same schedule that was displayed in the Tracking Gantt view using the Tracking table (the default table is the Entry table). The Tracking table enables you to update your project by supplying actual information. On the chart portion of the view, you see two bars for every task. The bottom bar shows baseline settings. The top bar reflects current scheduled start and finish dates if a task has not yet been started. If a task has been started — that is, if you have supplied some amount of work that has been completed — the top bar represents actual information, while the bottom bar represents baseline information. Project fills in the top bar and makes it solid to represent completed work; a hatching pattern appears in the top bar to represent unstarted work or work in progress (look specifically at Tasks 8 and 9). The bottom bars represent baseline task bars, which stay put; only actual work bars push out to reflect delays in timing.

![Image of Tracking Gantt view](msproject-trackinggantt.png)

**Figure 6-10:** The Tracking Gantt view shows the discrepancy between your estimates and the real-world activity in your project.

In the Tracking Gantt view, you can see that the Determine budget, Invitation list, and Theme tasks have been completed; the Site task is 50 percent complete; and the Keynote speaker task is 20 percent complete. No other tasks have been started, so the top bars on all other tasks represent scheduled start and finish dates, based on progress made so far in the project.
Multiple Baselines Gantt

The Multiple Baselines Gantt view is also based on the Gantt Chart view. The Multiple Baselines Gantt view enables you to see the first three baselines you save for your project. Each baseline is represented by a different color. In Figure 6-11, you see two baselines; two lines represent each task in the chart portion of the view.

The default table for the Multiple Baselines Gantt view is the Entry table, but you can change the table to any table you want using the techniques that are described in the section “Changing a Table,” earlier in this chapter.

Figure 6-11: The Multiple Baselines Gantt view helps you compare the first three baselines you save.

Cross-Reference
You read more about baselines in Chapter 11.
Network Diagram

The Network Diagram became the name for the PERT Chart view that you found in Project 98.

Project doesn’t really produce a PERT chart, but you can use an add-on product — PERT chart Expert. Try out a sample using the demo that’s on the CD-ROM of this book.

The Network Diagram view, shown in Figure 6-12, has less to do with timing than it has to do with the general flow of work and the relationships between tasks in your project. This view makes it easy for you to evaluate the flow of your project and to check task dependencies.

![Network Diagram View](image)

**Figure 6-12:** The Network Diagram view.

Each node in the Network Diagram view represents a task in your project. For Figure 6-13, I used Project’s Zoom command (View > Zoom) to enlarge a node so that you can see the details. A node contains the task name, duration, task ID number in the sequence of the project outline, start date, finish date, and, if assigned, the...
resource(s). The thickness of the border and color of each node represents different types of tasks — that is, critical tasks are red and thick borders, while non-critical tasks are blue and have thin borders. You can determine (and change) the meaning of node shapes in the Box Styles dialog box (choose Format ➤ Box Styles). The lines that flow between the nodes represent dependencies. A task that must come after another task is completed, called a successor task, appears to the right or sometimes below its predecessor.

Figure 6-13: You can see task details when you examine the nodes of the Network Diagram.

You couldn’t filter Project 98’s PERT Chart view; however, a filtering feature was added in Project 2000. While viewing the Network Diagram, choose Project ➤ Filtered for and select the filter that you want to use.

Cross-Reference
You read more about filtering in Chapter 7.
Starting in Project 2002, you can group tasks in the Network Diagram view; this is similar to the way that you can group tasks in the Gantt view. Colored bands separate the nodes. For example, in Figure 6-14, you see tasks grouped by duration. Open the Project menu and point to Group to see the groups that are available by default. You also can create your own groups.

![Figure 6-14: You can group tasks in a variety of ways in the Network Diagram view.](image)

You can now display indicators and custom fields in Network Diagram nodes. You add the node information to an existing node template, or you create a new template. Follow these steps to display indicators or custom fields in nodes:

1. In the Network Diagram view, choose Format ➪ Box Styles.
2. Click the More Templates button, as shown in Figure 6-15.
3. In the Data Template dialog box, edit one of the existing templates or create a new template from scratch.
4. In the Data Template Definition dialog box, shown in Figure 6-16, click in the cell where you want either indicators or a custom field to appear. Project adds a list box indicator to the cell, thus enabling you to open the list and select the information that you want to appear in that cell of the node. In Figure 6-16, I’m adding the Indicators field to the nodes.
Figure 6-15: In the Box Styles dialog box, select the template that you want for the nodes in the diagram.

Figure 6-16: Add information to a cell of the Network Diagram node.
You can't edit the Standard template, but you can copy it, as I did in Figure 6-15.

5. Click OK to redisplay the Data Template dialog box.

6. Click Close to redisplay the Box Styles dialog box.

7. From the Data template list, select the template that you edited or created.

8. Click OK. You see the new field on appropriate nodes. In Figure 6-17, a Note indicator appears only in the Determine budget task, because no other tasks in view have notes.

**Figure 6-17:** A Network Diagram that displays indicators in the nodes.

### Descriptive Network Diagram

The Descriptive Network Diagram, shown in Figure 16-18, is a cousin of the Network Diagram — and so it focuses on the general flow of work and the relationships among tasks in your project.
Like Network Diagram, each node in the Descriptive Network Diagram view represents a task in your project. If you compare Figures 6-12 and 6-17, you see more detail in the nodes of the Descriptive Network Diagram than you see in the Network Diagram. The Descriptive Network Diagram also indicates whether the task is critical and how complete the task is.

You can filter the Descriptive Network Diagram. Simply choose Project ➤ Filtered for, and select the filter that you want to use.

**Relationship Diagram**

This special version of the Network Diagram view, the Relationship Diagram, displays the current task in the center of the pane, with the task's predecessors to the left and successors to the right. When you are working on a large project, this graphic view helps you to focus on one task and the tasks that are linked to it.
CHAPTER 6
Understanding the Basics of Views

**PERT analysis views**

PERT analysis is sometimes called *what-if analysis*, and many project managers use this approach to estimate a probable outcome. The probable outcome that you estimate may be the duration of a task, its start date, or its end date. As a function of the estimating process, you specify the optimistic, pessimistic, and expected durations of tasks in your project. Then Microsoft Project calculates a weighted average of the three durations.

*Note*

PERT stands for *Program Evaluation and Review Technique*. The Special Projects Office of the U.S. Navy devised this method of tracking the flow of tasks in the late 1950s.

As you may have guessed, PERT analysis has little to do with the PERT Chart view that was available in Project 98 and earlier versions. But you can use the following PERT analysis views in Project to help you make your estimates:

✦ PA_PERT Entry Sheet
✦ PA_Optimistic Gantt
✦ PA_Expected Gantt
✦ PA_Pessimistic Gantt

You can use the PERT Analysis toolbar, shown in Figure 6-19, to perform PERT analysis. Choose View ➪ Toolbars ➪ PERT Analysis to display the toolbar.

*Figure 6-19:* Use this toolbar to help you with PERT analysis tasks.

*Tip*

You need to use the PERT Analysis toolbar to display the four PERT views the first time. After you’ve displayed the views, you can see them in the More Views window.
**PERT Entry Sheet**

The PERT Entry Sheet view, shown in Figure 6-20, focuses PERT analysis entirely on durations. Click the PERT Entry Sheet button on the PERT Analysis toolbar to display this sheet.

Using this sheet, you enter optimistic, expected, and pessimistic durations for each task. When you click the Calculate PERT button on the PERT Analysis toolbar, Project uses a weighted average of the numbers that you supply and calculates the probable duration of the task. Project displays the result in the Duration column for that task. Notice the duration of 1.58 days for the Theme task. Project calculated this duration by using the weighted average of the numbers in the Optimistic Dur., Expected Dur., and Pessimistic Dur. columns for the task.

![Microsoft Project - PERT.mpp](image)

**Figure 6-20:** Use this view to focus on entering estimated durations for PERT analysis.

**Optimistic Gantt**

After you have entered optimistic, expected, and pessimistic durations in the PERT Entry Sheet view and click the Calculate PERT button, you can view the optimistic results for your entire project in the Optimistic Gantt view. Click the Optimistic Gantt button on the PERT Analysis toolbar to display the Optimistic Gantt view. As
its name implies, the Optimistic Gantt view, shown in Figure 6-21, is a variation of
the Gantt Chart view; the Optimistic Case table is on the left side, and Gantt bars
are on the right. You can use this view to enter and evaluate the optimistic scenarios
for task durations, start dates, and end dates.

Initially, you may not see bars in any of the PERT Gantt views. While displaying any
of these views, click the Calculate PERT button on the PERT Analysis toolbar again,
and Project displays the bars.

Figure 6-21: Use the Optimistic Gantt view to analyze optimistic task durations.

If you prefer to work with start dates and end dates or to focus entirely on optimis-
tic durations while estimating, you can use this view to enter and evaluate the
optimistic scenarios for task durations, start dates, and end dates. If you use this
approach, you must also supply the same type of information in the Expected Gantt
view and the Pessimistic Gantt view before you click the Calculate button.

Expected Gantt
After you have entered optimistic, expected, and pessimistic durations on the PERT
Entry Sheet and click the Calculate button, you can view the expected results for
your entire project in the Expected Gantt view. Click the Expected Gantt button on the PERT Analysis toolbar to display the Expected Gantt view, as shown in Figure 6-22. Like its cousins — the Optimistic and Pessimistic Gantt views — the Expected Gantt view is a variation of the Gantt Chart view. Project displays the Expected Gantt table on the left side and Gantt bars on the right side.

![Figure 6-22: Use the Expected Gantt view to help create expected task durations.](image)

If you prefer to estimate with start dates and end dates or to focus entirely on expected durations, you can use this view to enter and evaluate the expected scenarios for task durations, start dates, and end dates. If you use this approach, you also need to supply the same types of information in the Optimistic Gantt view and the Pessimistic Gantt view before you click the Calculate button.

**Pessimistic Gantt**

After you enter optimistic, expected, and pessimistic durations on the PERT Entry Sheet view and click the Calculate button, you can view the pessimistic results for your entire project in the Pessimistic Gantt view. Click the Pessimistic Gantt button on the PERT Analysis toolbar to display the Pessimistic Gantt view, as shown in Figure 6-23. Like its cousins — the Expected Gantt and the Optimistic Gantt views — the Pessimistic Gantt view is also a variation of the Gantt Chart view. Project displays
the Pessimistic Gantt table on the left and Gantt bars on the right. You can use this view to enter and evaluate the pessimistic scenarios for task durations, start dates, and end dates.

Figure 6-23: Use the Pessimistic Gantt view to help create pessimistic task durations.

If you prefer to work with start dates and end dates or to focus entirely on pessimistic durations while estimating, you can use this view to enter and evaluate the pessimistic scenarios for task durations, start dates, and end dates. If you use this approach, you also need to supply start and end dates on the Expected Gantt view and the Optimistic Gantt view before you click the Calculate button.

PERT Weights

Project calculates a weighted average when you use PERT analysis. You can control the weights that Project applies to each scenario from the Set PERT Weights dialog box, as shown in Figure 6-24. Click the PERT Weights button on the PERT Analysis toolbar (the second button from the right on the toolbar). Note that the values you enter must sum to 6.

You can use different weights to change the emphasis that Project applies to its calculation of each scenario.
Figure 6-24: Use the Set PERT Weights dialog box to adjust the weights that Project applies when making PERT calculations.

Resource Allocation

The Resource Allocation view is a combination view. For example, in Figure 6-25, the Resource Usage view appears in the top pane and the Leveling Gantt Chart view appears in the bottom pane.

Figure 6-25: The Resource Allocation view displays resource allocation relative to the project timing.
See the section “Leveling Gantt,” earlier in this chapter, for a discussion of the Leveling Gantt Chart view. Refer to the section “Resource Usage,” later in this chapter, for information about the Resource Usage view.

The default table that appears on the Resource Usage view (the upper pane of the combination view) is the Usage table. The default table that appears on the Gantt Chart view (the lower pane of the combination view) is the Entry table. As you scroll down the window, the top and bottom panes move together. You can use the techniques described in the section “Changing a Table,” earlier in this chapter, to change either table.

**Resource Form**

The Resource Form view displays detailed information about one resource at a time, as shown in Figure 6-26.

![Resource Form view](image)

**Figure 6-26:** The Resource Form view.

Use the Next and Previous buttons in the upper-right corner of the window to display different resources. If you haven’t sorted or filtered resources, Project shows them to you in order of ID number.


**Resource Graph**

The Resource Graph view shows how a particular resource is being used on a project. You can use the Resource Graph view to spot and correct resources that are inappropriately allocated. Note that the Resource Graph view shows information for one resource at a time. To view a different resource, click the scroll arrows that appear below the left pane in this window. This view works well as part of a combination view.

The Resource Graph view highlights resource conflicts: people, equipment, or other resources that are being overworked or underutilized. Looking at the Resource Graph view as both a single and combination view can show you how assignments on individual tasks are affecting a resource’s utilization on a project. Figure 6-27 shows the main Resource Graph view. Figure 6-28 shows the combination view, with details of the tasks being performed shown at the bottom of the Project window. You can create this view by choosing Window ➪ Split.

**Figure 6-27:** The percentage of a person’s available work time is tracked and displayed as overallocated and underallocated.
Figure 6-28: Displaying task information beneath a Resource Graph can help you to see which work assignments are keeping the resource busy.

Project displays a resource’s total work hours on any particular day as a bar. A bar that falls short of the 100 percent mark indicates that a resource isn’t working full-time and may be underutilized. A bar that extends beyond 100 percent indicates that someone is working too many hours in a day. The percentage of the workday that the resource is working appears at the bottom of the usage bars.

Underutilization may indicate that a resource is busy with other projects the rest of that day, and overutilization may signal occasional and acceptable overtime. See Chapter 8 for more information about interpreting these bars. See Chapter 10 for more details about resolving conflicts in resource time.

Resource Name Form
The Resource Name Form view is a simplified version of the Resource Form view (compare Figure 6-29 with Figure 6-26). None of the cost information appears in this view, nor do you see the resources’ maximum units, base calendar, group, or code.
Refining Your Project

Figure 6-29: The Resource Name Form view.

You can use this view to set up basic information about resources for a project — this can give you a good idea about a resource’s workload. Use the Previous and Next buttons to view different resources.

Resource Sheet

The Resource Sheet view, shown in Figure 6-30, gives you a wealth of information about the resources that are assigned to your project, including standard and overtime rates, availability for overtime work, and fixed costs.

By assigning group designations to resources, such as Marketing, Facilities, or Temporary Help, you can use filters to study resource information for just one or two groups at a time.

This columnar interface is a great way to prepare to assign resources if, for example, you want to assign lower-cost people to most tasks and higher-cost people to certain mission-critical tasks. This view clearly shows to which group a resource
belongs. If overallocations exist, you see a warning flag in the Indicator column in the far left of this view. Switch back to the Resource Graph to get resource-by-resource details on these problems.

![Resource Sheet view](image)

**Figure 6-30:** You can view both standard and overtime rates in the Resource Sheet view.

**Tip**

The default table that appears on the Resource Sheet view is the Entry table, but you can change this table by using the techniques that are described in the section “Changing a Table,” earlier in this chapter.

**Resource Usage**

The Resource Usage view, shown in Figure 6-31, displays each resource and the tasks that are assigned to it. You can use the Resource Usage view to enter and edit resource information, and you can assign or reassign tasks to resources in this view by dragging the tasks among resources.
Figure 6-31: The Resource Usage view organizes task assignments by resource so that you can easily figure out who’s doing what and when it’s being done.

The Resource Usage view is also useful when you want to do the following:

- Check resource overallocations
- Examine the number of hours or the percentage of capacity at which each resource is scheduled to work
- View a resource’s progress or costs
- Determine how much time a particular resource has for additional work assignments

The default table on the left side of this view is the Usage table. You can use the Table Selection button, described in the section “Changing a Table,” earlier in this chapter, to switch to a different table. Similarly, you can choose either Format►Details or Format►Detail Styles to add to or change the information that appears in the Details section. (Work is the default selection.)
Rollup views

In Project 98, you could display symbols on a summary task bar that represented subtask dates: Effectively, you “rolled up” the subtasks onto a summary task bar when you collapsed the outline of the Gantt view. However, rollup wasn’t an easy process in Project 98 because you needed to mark each individual task that you wanted to roll up.

Starting in Project 2000, you could allow for rollup behavior at a project level and avoid editing all the tasks. While viewing the Gantt Chart view of your project, choose Format ➔ Layout. Project displays the Layout dialog box, as shown in Figure 6-32.

![Figure 6-32](image)

**Figure 6-32:** Use this dialog box to enable rollup behavior for all tasks in your project.

To allow for rollup behavior at a project level and avoid editing all the tasks, select the Always roll up Gantt bars check box. If you don’t want see the rollup bars when you expand the project outline to view all tasks, also select the Hide rollup bars when summary expanded check box.
Using the summary task bar

When you enable rollup behavior and collapse the outline, Project displays a summary task bar that contains symbols that represent subtask dates. Compare Figures 6-33, 6-34, and 6-35, which show various effects of collapsing the outline and rollup behavior. In particular, compare Figures 6-34 and 6-35.

![Microsoft Project screen shot with task bar and timeline view]

**Figure 6-33:** In this figure, the outline is completely expanded.
Figure 6-34: In this figure, I collapsed the outline for the Selection task, but I didn’t enable rollup behavior.

You can still specify rollup behavior at the task level (using the General tab of the Task Information dialog box) so that Project doesn’t roll up all tasks to summary bars when you collapse the outline. Remember that the changes you make in the Layout dialog box don’t affect tasks whose rollup behavior you specified at the task level.
Figure 6-35: In this figure, I collapsed the outline for the Selection task and enabled rollup behavior.

Using the Rollup_Formatting macro

Project contains a special macro called Rollup_Formatting. When you run this macro, Project displays, on the Gantt Chart view, a summary bar that contains symbols that represent tasks; you can think of these tasks as being rolled up onto the summary bar. This type of view helps you to create a summarized version of your project and makes important dates visible. The following views help you to see your focus on your project’s summary tasks:

✦ Bar Rollup
✦ Milestone Date Rollup
✦ Milestone Rollup

Note

A rollup view displays only the tasks that you format as rollup tasks in the Task Information dialog box. If you format rollup behavior for tasks in the Task Information dialog box, changing rollup behavior in the Layout dialog box (as discussed in the previous section) doesn’t affect the appearance of your Gantt Chart.
This macro doesn’t work unless you first mark tasks on the project as tasks that you want to roll up. Follow these steps to mark tasks and run the Rollup_Formatting macro:

1. Select tasks in the Gantt Chart view.

   You can use Windows selection techniques to select several tasks simultaneously. Click the first task that you want to select. Then, to select contiguous tasks, press Shift and click the last task. Or, to select noncontiguous tasks, press Ctrl and click each task.

2. Click the Task Information button on the Standard toolbar to open the General tab of the Multiple Task Information dialog box, as shown in Figure 6-36.

![Figure 6-36: Use the General tab of the Multiple Task Information dialog box to mark tasks for rollup.](image)

3. Select the Roll up Gantt bar to summary check box.

4. Click OK.

5. Choose Tools ➪ Macros. Then choose Macros from the submenu to open the Macros dialog box, as shown in Figure 6-37.

6. Select the Rollup_Formatting macro, and click Run. Project displays the Rollup Formatting dialog box, as shown in Figure 6-38.
7. Select Bars to display rolled up tasks as bars, or select Milestones to display rolled up tasks as milestones, and click OK. Project displays the rolled up version of your project, as shown in Figure 6-39.
Understanding the Basics of Views

When you format rollup tasks as milestones, Project displays your project using the Milestone Rollup view.

Using the Rollup_Formatting macro can produce unpredictable results if your task start dates are close together. Task names may appear on top of one another — and be unreadable.

Switching rollup views

When you use the Rollup_Formatting macro, Project displays only those tasks that you formatted for rollup. The table that you see in the sheet portion of all of these views is the Rollup table, but you can switch to another table by using the techniques that are explained in the section “Changing a Table,” earlier in this chapter. Figure 6-39 showed the Milestone Rollup view that Project displays if you selected Milestones in Step 7. If you select Bars in Step 7, Project displays the Bar Rollup view, as shown in Figure 6-40.
Figure 6-40: When you format rollup tasks as bars, Project displays your project using the Bar Rollup view.

Tip
To redisplay all subtasks in a typical Gantt Chart view, click the Show button on the Formatting toolbar and choose All Subtasks.

Using the More Views dialog box (click the More Views button on the View bar or choose View ➪ More Views), you can display the Milestone Date Rollup view, as shown in Figure 6-41.
Figure 6-41: Use this view to see rollup tasks along with their start dates.

Note

If your start dates are close together, Project overwrites the task names, thus making them difficult or impossible to read.

Task Details Form

The Task Details Form view closely resembles the Task Form view and the Task Name Form view. The Task Details Form view, shown in Figure 6-42, enables you to view and edit tracking information about one task at a time.
Figure 6-42: The Task Details Form view.

Use the Previous and Next buttons in the upper-right corner of this view to switch from task to task. If you haven’t sorted or filtered tasks, Project displays them in order of ID number. The Task Details Form view is a good choice for part of a combination view.

**Task Entry**

The Task Entry view is a combination view. In Figure 6-43, the Gantt Chart view appears in the top pane, and the Task Form view appears in the bottom pane. To see information about a task in the Task Form view, select the task in the Gantt Chart view. You can see this view easily if you select the Gantt view and then choose Window➪Split.
Chapter 6 ✦ Understanding the Basics of Views

Figure 6-43: The Task Entry view.

Only the Gantt Chart view in the top pane uses a table. The default table is the Entry table, but you can use the techniques that are described in the section “Changing a Table,” earlier in this chapter, to change the table.

**Task Form**

The Task Form view appears on the bottom portion of the Task Entry view, as shown previously in Figure 6-43. The Task Form view, shown in Figure 6-44, closely resembles the Task Details Form view, shown previously in Figure 6-42.

The Task Form view provides more resource information (such as costs) than the Task Details Form view, and the Task Details Form view provides more task information (such as predecessors) than the Task Form view. Use the Previous and Next buttons to switch between tasks. The Task Form view also closely resembles the Task Name Form view.
Task Name Form

The Task Name Form view is a cousin to the Task Details Form view and the Task Form view. This simplified version displays the basic characteristics of tasks, one task at a time, as shown in Figure 6-45.

Use the Previous and Next buttons to switch between tasks. Again, if you compare Figures 6-42, 6-44, and 6-45, you can see how closely these views resemble each other. The Task Name Form view works well as part of a combination view.

Figure 6-44: The Task Form view.
The Task Sheet view is the counterpart of the Resource Sheet view in that the Task Sheet view displays task information in a spreadsheet-like format. In this view, you can create tasks, link tasks (establishing dependencies), and even assign resources, as shown in Figure 6-46.

This view closely resembles the left portion of the Gantt Chart view and makes it easy to view tasks in chronological order. The default table that appears on the Task Sheet view is the Entry table, but you can use the techniques that are described in the section “Changing a Table,” earlier in this chapter, to change the table.
The Task Sheet view helps you to see tasks in chronological order.

**Task Usage**

This powerful view, shown in Figure 6-47, enables you to focus on how resources affect the task by showing resource assignments for each task. Use this view to organize resources by task, evaluate work effort and cost by task, and compare scheduled and actual work and costs.

The default table for the left side of the Task Usage view is the Usage table, but you can display other tables by using the Table Selection button, as described in the section “Changing a Table,” earlier in this chapter. Also, by default, Project shows Work in the Details section on the right. Again, you can select any item from the Format Details menu or in the Details Styles dialog box (choose Format ➤ Detail Styles).

How can you do 12 hours of work in one 8-hour day, as indicated in the sample project shown in Figure 6-47? Remember that this view shows total resource hours: As the figure shows, two people worked 8 hours and 4 hours, respectively.
Chapter 6 ✦ Understanding the Basics of Views

Printing Your Project

When you print a project, you are printing a view. So, before you do anything, select the view that you want to print. If you’re printing a sheet view, the number of columns that you see on-screen determines the number of columns that print. If the printed product requires more than one page, Project prints down and across, that is, the entire left side of your project prints before the right side prints.

Printing in Project is similar to printing in any other Microsoft product. You can use the Print button on the Standard toolbar to print using default settings. And what are the default settings? They appear in two dialog boxes that you can view if you don’t use the Print button.

You can also preview before printing, either by clicking the Preview button in the Print dialog box or by clicking the Print Preview button on the Standard toolbar.

Choose File ➤ Print to open the Print dialog box, as shown in Figure 6-48.
Figure 6-48: From the Print dialog box, you can control, for example, the printer to which you print and the number of copies that you print.

Starting in Project 2000, when you save the project file, Project retains the settings that you make in this dialog box for the timescale, including whether the Print left column of pages only option is selected and whether the Manual page breaks option is selected.

You can’t open the Page Setup dialog box, shown in Figure 6-49, from the Print dialog box, but you can open the Page Setup dialog box either by choosing File ➪ Page Setup or by clicking the Page Setup button that is available in Print Preview. From the Page tab, you can set orientation and scaling. Using scaling, you may be able to fit the printed text onto one page.

Starting in Project 2000, you can set the first page number of the printed product. For example, suppose that your project is 10 pages long but you intend to print only pages 5 and 6. Typically, you would want to number those pages as 1 and 2 — and you can do exactly that by entering 1 in the First page number box.

From the Margins tab, shown in Figure 6-50, you can change the margins for your printed text and determine whether a border should appear.
Figure 6-49: The Page tab of the Page Setup dialog box.

Figure 6-50: The Margins tab of the Page Setup dialog box.

From the Header tab, shown in Figure 6-51, you can define and align header information to appear on the top of every page that you print. Use either the buttons at the bottom of the box or the list box to add information that you want Project to update automatically, such as page numbers.
Figure 6-51: The Header tab of the Page Setup dialog box.

You can include Project level fields in the header, footer, or legend of your printed product. From the appropriate tab of the Page Setup dialog box, use the Project fields list box to select the field that you want to include.

The Footer tab, shown in Figure 6-52, works just like the Header tab. You can align and include the same kind of updating information in the footer on each page of your printed text.

Figure 6-52: The Footer tab of the Page Setup dialog box.
The Page Setup dialog box changes just slightly, depending on the view that you were using when you opened the dialog box. For example, the Legend tab is available only when you’re printing a Calendar, Gantt Chart, or Network Diagram view, as shown in Figure 6-53. The Legend tab works just like the Header and Footer tabs, and you can align and include the same kind of updating information.

![Figure 6-53: The Legend tab of the Page Setup dialog box.](image)

The View tab enables you to control what Project prints, such as all or only some columns, as shown in Figure 6-54.

![Figure 6-54: The View tab of the Page Setup dialog box.](image)
Starting in Project 2003, two options — Print column totals and Print row totals for values within print date range check boxes — appear on the View tab and are checked by default in views where they are applicable: the Task Usage view and the Resource Usage view (the boxes are unavailable in all other views). When you select the Print column totals check box, Project calculates totals in memory and adds a row to the printed page showing totals for timephased data as well as for sheet data. You can take advantage of the Print row totals for values within print date range check box when you’re printing a Usage view. Selecting this box tells Project to add a column to the printed page that shows totals for the timephased data with the date range that you specify in the Print dialog box. The totals lines print on the same page as the last rows or columns of data, before any Notes pages.

**Tip**

In many cases, you can add a column to a table that gives you the same information that you can get in the row totals. The column prints where you place it, while the row totals print on a separate page.

**Summary**

This chapter covered the standard views that are available in Project. You saw a sample of each view and found out how to print in Project.

Chapter 7 takes you beyond the basics in views. You find out how to customize and filter views and show other available information in views.
Using Views to Gain Perspective

In Chapter 6, you saw samples of the built-in views that come with Project. And although you may never need any view other than the ones that come with Project, you’re not limited to just those views. The potential for viewing information about your project is almost mind-boggling. In this chapter, you explore ways to make views work for you.

Customizing Views

You can customize the views in Project so that they show you the information that you need. Fiddle with the tables in views that contain tables or with the views themselves.

Changing tables

In views containing tables, you can make changes as simple as modifying the height of the rows or switching to a different table. Or, you can modify the appearance of the default table by moving columns around, hiding columns, or adding columns — and save your changes in a new table.

Changing row height

This feature helps you out whenever information is too wide to fit within a column. When you change the height of a row, the data wraps to fit within the taller row.

The capability to change the height of a row in a table is new to Project 2000.
Notice that the task names for Tasks 5 and 7, shown in Figure 7-1, don’t fit within the Task Name column. If I increase the height of those rows, both names wrap so that they are visible, as shown in Figure 7-2.

![Figure 7-1: You can change the height of a row when the mouse pointer looks like a double-headed arrow.](image)

To change the height of a row, select the row and move the mouse pointer into the Task ID number column at the bottom of the selected row. The mouse pointer changes to a pair of arrows pointing up and down (as shown in Figure 7-1). Drag down, and when you release the mouse button, Project increases the height of the row and wraps any text in that row that didn’t fit within its column.

**Tip**

To change the height of more than one row, select each row that you want to change. Use Windows selection techniques to select the rows. For example, to select two noncontiguous rows, click the ID of the first row and then press and hold Ctrl while you click the ID of the second row. When you change multiple rows simultaneously, Project assigns a uniform height to the selected rows.
Figure 7-2: When you change the height of more than one row at a time, Project assigns a uniform height to all selected rows.

Note: You can change row heights only in full row increments. In other words, you can make a row twice its original size but not one and a half times its original size.

Hiding and inserting columns
You can temporarily remove a column from a table by hiding it. Right-click the column, and choose Hide Column from the menu that appears. Project doesn't remove the data in the column from the file; instead, the data is hidden from view. To see the column again (or to add a different column to your table), right-click the column heading that you want to appear to the right of the column that you’re going to insert. Then, choose Insert Column from the shortcut menu that appears. You see the Column Definition dialog box, as shown in Figure 7-3.
Figure 7-3: Use this dialog box to add a column to your table.

In the Field name list box, select the name of the column that you want to add. You don’t need to make any other changes; click the Best Fit button to make sure that Project provides enough space for the column title. Project inserts the column to the left of the selected column.

Switching tables
Tables don’t appear in every view. For example, neither the Network Diagram view nor the Resource Graph view has a table that displays columns of information. However, views that have tables, such as any Gantt view or the Task Usage view, shown in Figure 7-4, also have a Select All button. Right-click the Select All button to list the standard tables that you can display as well as the More Tables option.

Clicking (instead of right-clicking) the Select All button selects all information in the table portion of the view.

Creating new tables or editing existing tables
As with views, Project has dozens of built-in tables, with a wide variety of information included to help you focus on issues of scheduling, resources, tracking, and so on. The More Tables window enables you to switch to tables that don’t appear on the shortcut list of tables. You also can use the More Tables window to modify the fields of information displayed in the columns of tables, and even to create new tables. Creating new tables in Project is remarkably similar to editing existing tables; you use the same dialog box for both operations.

Note
How do you decide whether to create a new table or modify an existing one? If you can find a predefined table with a similar focus that has several of the fields that you want to include, start with a copy of that table. Then delete, rearrange, modify, or add fields as needed. If you can’t find an appropriate model, you may need to create a new table. I suggest using a copy of the table because someone else who is using your schedule will expect to find the default fields in Project’s original tables instead of the fields that you establish.
Figure 7-4: Switch to a different table by selecting it from this shortcut menu.

Suppose that the view would be more meaningful if the columns appeared in a different order than the order in which Project shows them. For example, many tables list baseline information first and then list actual information, resulting in this sequence of columns: Baseline Start, Baseline Finish, Actual Start, Actual Finish. Comparing this information may be easier if you create a table that presents the information in this order: Baseline Start, Actual Start, Baseline Finish, Actual Finish — and so on.

Or perhaps you want to add the table to the list of tables on the shortcut menu that appears when you right-click the Select All button. You may even want to add or delete some fields of information (columns) from the table. You can either edit an existing table or make a copy of it and edit the copy.

Caution
The More Tables window does not have a Table reset button; consequently, any changes that you make are permanent. I advise you to always make a copy of a table that you want to modify, rather than editing the original table. That way, the original tables remain intact.
Follow these steps to create a new table or edit an existing table:

1. Choose View ➪ Table ➪ More Tables. Project displays the More Tables window, as shown in Figure 7-5.

![Figure 7-5: Select a table to use, edit, or copy from this dialog box.](image)

2. Click the New button to create a new table, or select a table that you want to edit. You can use the Task or Resource choices at the top of the dialog box to display the type of table that you need. Then click either the Edit button to edit the original table or the Copy button to edit a copy of the table. The Table Definition dialog box appears, as shown in Figure 7-6.

![Figure 7-6: Use the Table Definition dialog box to make changes to the appearance of a table. When you create a new table, no information appears in the bottom portion of the dialog box.](image)
If you create a copy, you may want to rename it in the Name box instead of using the default “Copy of” name that Project supplies.

3. Enter a name for the table in the Name field. To show this table in the shortcut menu that appears when you right-click the Select All button, select the Show in menu check box.

4. To add a field to the table, click a blank space in the area under the Field Name column; an arrow appears on the right side of the field. Click the arrow to display the drop-down list, as shown in Figure 7-7, and select a field name.

![Figure 7-7: You can select fields of predefined information to build the columns in your table.](image)

5. In the same row, click in the Align Data column. Project displays the default settings for alignment of data and title as well as the width of the column. Click the arrow on the right side of the field; then select Left, Center, or Right alignment for the data in the column.

6. Click the Width column and, if necessary, modify the width of the column to accommodate the type of information that you think will typically go there.

   If you aren’t sure about the ideal column width, just accept the default. You can easily adjust column widths when the table is on-screen by dragging the edge of the column heading to the right or left.

7. Click the Title field, and enter a title for the column if you don’t want to use the default field name. Otherwise, skip this step.
8. Click the Align Title column, and select a different alignment for the column title if you like.

9. Repeat Steps 4 through 8 to add more fields to your table. To edit your table, use the Cut Row, Copy Row, and Paste Row buttons to reorganize the order of fields in your table. Use the Insert Row and Delete Row buttons to add rows in between existing rows or to remove existing rows.

10. If you have included any columns that include dates, such as Start or Finish information, you can modify the date format by using the drop-down list of choices in the Date format field. You can also modify the height of all the rows with the Row height setting.

   The Header Wrapping field — a Yes or No choice — controls whether long titles wrap within the column heading. If you set the Header Wrapping field to No, Project hides that portion of a column title that doesn’t fit within the allotted space for the column.

11. If you want the first column of your table to remain on-screen while you scroll across your page, select the Lock first column check box. Typically, the Task ID column is the column that is locked in place in a table.

12. Click OK when you are finished. Then click Apply in the More Tables dialog box to display the new table on your screen.

By default, changes that you make to tables appear only in the current Project file. If you want new or edited tables to be available to other schedules, you must use the Organizer function in the More Tables dialog box to copy these tables to the Global.mpt file. See Chapter 20 for more information.

Working with views

As you discovered in Chapter 6, views display a variety of information: tables with several fields of data, task bars, network diagram nodes, and so on. Microsoft has provided a plethora of views, meeting just about every information need. Nevertheless, you may want to create a variation on one of those views to look at information from a different perspective. For example, you can create a second Network Diagram view in which you set the nodes to display a different set of information than the standard Network Diagram view. Then, rather than having to modify the nodes in the original Network Diagram view each time to see different information that you call on frequently, you can simply display the new view to use the alternative Network Diagram view. You can base an alternative view on any of the existing views and then change the information that Project displays by default to include only the information that you need.
Adding views
You can select a view from the View bar, or you can choose View ➪ More Views. Project gives you dozens of alternative views from which to select, as shown in Figure 7-8. When you create a new view, you can include it on the View bar or make it available in the More Views dialog box only.

![More Views dialog box](image)

Figure 7-8: A wide selection of built-in views meets most informational needs.

**Caution**
You can edit an existing view instead of creating a new view. But, like the More Tables dialog box, the More Views dialog box does not have a View reset button; consequently, any changes that you make are permanent. As I previously suggested, make a copy of a view that you want to modify, rather than editing the original view. That way, the original views remain intact.

To add a new view to your copy of Project, follow these steps:

1. Choose View ➪ More Views.
2. Click the New button in the More Views dialog box (shown in Figure 7-8). The Define New View dialog box appears, as shown in Figure 7-9.

![Define New View dialog box](image)

Figure 7-9: A simple choice awaits you in the Define New View dialog box: a single or combination view.
If you can, base your new view on a copy of an existing view — you’ll have less to do to create the view.

3. Select the Single view option, and click OK. The View Definition dialog box opens, as shown in Figure 7-10.

![View Definition dialog box](image)

**Figure 7-10:** Use this dialog box to name and describe your new view.

If you select the Combination view option, the View Definition dialog box requests slightly different information.

4. Enter the name of the new view in the Name box. Choose a name that describes the information that you’ll show in the view.

5. Select a current view on which to base the new view by clicking the arrow to open the Screen drop-down list. Then choose a view name.

6. Do one of the following:
   - If the screen that you chose in Step 5 gives you the option of selecting a table to include with it, select that table from the Table drop-down list shown in Figure 7-11.
   - If the screen that you chose in Step 5 does not give you this option, go to Step 7.
7. Open the Filter list box to choose a filter to apply to the view. By default, Project applies the All Tasks filter; therefore, all tasks appear in the view. To apply a selective filter so that Project highlights only filtered tasks, select the Highlight filter check box at the bottom of the View Definition dialog box.

You can set filters to remove tasks from the display that don't meet the filtering criteria, or you can set filters to simply highlight the tasks that meet the criteria. To reformat text that Project highlights as meeting filter criteria, choose Format ➪ Text Styles. You read more about these techniques in the section “Filtering Views to Gain Perspective,” later in this chapter.

8. Select the Show in menu check box to make the new view available as a selection in the View bar and on the View menu. If you don’t check this box, you must display the view by selecting it from the More Views dialog box.

9. Click OK, and then click Apply in the More Views dialog box to save the new view and display it on-screen.

Creating a combination view
You can manipulate views to see either a single or combination configuration. Combination views display the view that you’ve selected, as well as a second view that includes information about the selected task. Figure 7-12 shows the Network Diagram view with a combination of visual and textual information.
You can display a combination in any view by moving your pointer to the split bar, shown in Figure 7-13, until the cursor becomes two horizontal lines with arrows; then double-click. You can also click and drag the split bar toward the top of your screen, or you can choose Window ➪ Split. You can return to the simple Network Diagram view by double-clicking the split bar again.

If you are displaying a combination view and you switch views, the new view also appears as a combination view. To display a new view and have it occupy the full screen, choose Window ➪ Remove Split. You can always tell which portion of the split view you’re in by the active view bar, a dark line that appears along the left edge of the view when you click the upper or lower view.
Figure 7-13: When the mouse pointer appears in this shape, you can double-click to create a combination view.

Suppose that you want to create a combination view that you can display at any time. Create a new combination view that includes the two views that you want to see together by following these steps:

1. Choose View ➤ More Views to display the More Views dialog box.
2. Click New to display the Define New View dialog box.
3. Choose the Combination view option to display the dialog box shown in Figure 7-14.
4. Name the view, and designate which view should appear at the top of the screen and which view should appear at the bottom.

5. To be able to display the view by choosing it from the View menu, select the Show in menu check box.

6. Click OK when you finish.

Figure 7-14: In the combination view version of the View Definition dialog box, select the two views to place on-screen.

**Ordering Tasks in a View**

You can think of project management as the attempt to comprehend a large job by breaking the job into progressively smaller pieces — until the job is a collection of tasks. You want to organize the tasks so that you can estimate schedules, resource requirements, and costs. You can sort tasks and, starting in Project 2000, you can assign WBS codes or outline numbers to help you organize the project.

**Sorting tasks**

Sometimes, sorting information in a different way helps you to see things that you may not have seen otherwise or even to get a better handle on a problem. In Project, you can sort a project from most views in almost any way that you want.
For example, in the Gantt Chart view, Project automatically sorts tasks by ID (see Figure 7-15). But you may find it easier to view your project information if you sort by Start Date. Choose Project ➤ Sort ➤ by Start Date and Project reorders the Gantt Chart view so that tasks are ordered by Start Date, as shown in Figure 7-16.

Figure 7-15: By default, Project sorts the Gantt view in Task ID order.
When you choose Project ➤ Sort, you see five common sort keys, as shown in Figure 7-17, but if you choose the Sort by command at the bottom of the submenu, the Sort dialog box appears, as shown in Figure 7-18. From this dialog box, you can sort down to three levels. That is, if Project finds a “tie” at the first level, it uses the second sort that you specify to break the tie. And, if Project finds a tie at the second level, it uses the third sort that you specify to break the tie. Using the check boxes at the bottom of the dialog box, you can make your sort choices permanent by reassigning Task IDs, and you can choose to retain the outline structure of the project.
Chapter 7 ✦ Using Views to Gain Perspective

Figure 7-17: Choose one of these five common sort keys directly from the Sort menu.

Figure 7-18: You can set up a more complex sort structure for Project to use in the Sort dialog box.
Creating WBS codes

The U.S. defense establishment initially developed the work breakdown structure (WBS), and you find it described in Section 1.6 of MIL-HDBK-881 (2 January 1998) as follows:

- A product-oriented family tree is composed of hardware, software, services, data, and facilities. The family tree structure results from systems engineering efforts during the acquisition of a defense materiel item.
- A WBS chart displays and defines the product, or products, to be developed and/or produced. It relates the elements of work to be accomplished to each other and to the end product.

More simply put, a WBS chart shows a numbered list of the tasks that you must complete to finish a project.

In Project 2003, you still can’t produce a WBS graphic representation of your project that is similar to the one shown in Figure 7-19. You can, however, assign WBS codes to each task. WBS codes can be letters and numbers (or combinations of letters and numbers) that help you identify the relationship among tasks and organize the project.

Figure 7-19: The WBS chart is reminiscent of a company organization chart.

WBS Chart for Project, an add-on product for Project, creates a WBS chart from a Microsoft Project file. The CD-ROM that accompanies this book includes a sample of the program.
You can use any numbering system that you want for your WBS code structure. Suppose that you assigned codes to your project that are similar to the ones shown in Figure 7-20. The task numbered 1.1.2.3 identifies the first box in Level 2, the second box in Level 3, and the third box on Level 4 of the outline structure of the project. Although Project doesn’t produce the graphic representation, it assigns the numbers based on the task’s level within the project outline.

![Figure 7-20: WBS numbering shows you the hierarchical relationship of tasks in the project.](image)

To assign WBS numbers to a project, follow these steps:

1. Choose Project ➤ WBS ➤ Define Code. Project displays the WBS Code Definition dialog box. The Code preview box shows you the format of the WBS code that you’re designing as you design it — and therefore remains blank until you make selections in this dialog box.

2. Use the Project Code Prefix box to apply a prefix to all WBS codes that you assign. For example, you may want to use the initials of the project name.

3. In the Sequence column at the bottom of the box, select the type of character that you want to use for each level of the WBS code. In Figure 7-21, I’ve selected Numbers (ordered) for both Levels 1 and 2, but you can also include Uppercase Letters or Lowercase Letters. If you choose Characters (unordered), Project inserts an asterisk at that position of the WBS code.
Refining Your Project

Figure 7-21: Use the WBS Code Definition dialog box to define the type of WBS code that you want to use.

If you choose Characters (unordered) in the Sequence column, you can enter any characters that you want into that part of the WBS code. For example, suppose that you use a mask of Numbers (ordered) Length 1, Numbers (ordered) Length 1, Characters (unordered) Length 3. For any third-level task, you can enter any three characters that you want for the third part of the WBS code. In this example, when you enter a third-level task, you initially see a WBS of 1.1.***. However, you can change it to something like 1.1.a#3.

4. Open the list box in the Length column, and choose the length for the level of the WBS code. In Figure 7-21, I set Level 1 to two digits, but I allowed any number of digits for Level 2. You can choose Any, select from the predefined list of numbers 1–10, or type in any other number.

For the technically curious, I tested the number 100, and Project accepted it, but using a 100-digit number in a WBS code isn’t particularly practical.

5. In the Separator column, use the list box to select period (.), dash (–), plus (+), or slash (/), or type in any character that is not a number or a letter (such as =).

6. Repeat the previous steps for each level that you want to define.

7. Click OK when you finish.

You should probably select both check boxes at the bottom of the WBS Code Definition dialog box, because this ensures that all tasks are assigned WBS codes and that the codes are unique.
The WBS codes don’t appear by default in the Gantt Chart view; to view the WBS codes, you must add the WBS column. To add the WBS column to the left of the Task Name column, right-click the Task Name column. Project selects the column and displays a shortcut menu. Choose Insert Column from the shortcut menu, and Project displays the Column Definition dialog box. Open the Field Name list box, and select WBS. If you want, you can change the alignment of data to Left. Then, click Best Fit to add the column to the worksheet portion of the Gantt Chart view, as shown in Figure 7-22.

![Figure 7-22](image.png)

**Figure 7-22:** When you display the WBS column, Project displays the WBS codes for each task in your project.

*Note*

If you had added the WBS column *before* defining WBS codes, you would have seen outline numbering that corresponded to the task’s position in the project outline.
Renumbering WBS codes

WBS codes *don't* automatically renumber themselves in all cases when you change the structure of the project outline, as shown in Figure 7-23. WBS Codes *do* automatically renumber themselves if you change the level of a task within the outline structure of the project. That is, if you drag a Level 1 task to a new Level 1 location or if you drag a subtask to a new location beneath its original parent task, both tasks retain their original WBS code number. However, if you promote or demote the task, or if you move it so that it appears at a new level in the outline, Project assigns the task a new WBS code. You can test the premise by dragging Request Purchase Order so that it appears before Order Food. Each task retains its original WBS code, and Project assigns a new WBS Code — AM-08 — to Request Purchase Order.

![Figure 7-23: Because I moved tasks around, the WBS codes are no longer sequential.](image-url)
If you’re working on a government contract for which you and the government have agreed to a numbering scheme and you don’t want WBS codes to change, even if you move tasks around, use Outline codes, which are static. You can assign both an Outline code and a WBS code to a task. (You read about Outline codes later in this chapter.)

At times, you’ll want to renumber the WBS codes, even though Project didn’t renumber them automatically — and you can. In fact, you can renumber the entire project or only selected portions of the project. If you choose to renumber selected portions, you must select the tasks before starting the renumbering process.

You can’t undo renumbering WBS codes, so save your project before you start this operation. That way, if you don’t like the results, you can close the project without saving it and reopen it in the state before you renumbered it.

To renumber all tasks in the project shown in Figure 7-23, follow these steps:

1. Choose Project ➪ WBS ➪ Renumber. Project displays the dialog box shown in Figure 7-24.

![Figure 7-24: Use this dialog box to renumber the project.](image1.png)

2. Click OK. Project prompts you before renumbering.
3. Click Yes. Project reassigns all WBS numbers, as shown in Figure 7-25.
At this point, I'm going to hide the WBS column to keep the display as clean as possible.

**Defining outline numbers**

In the preceding section, I offered a scenario in which you're working on a government contract, and you and the government have agreed to a numbering scheme. In a case like this, you *don't* want WBS codes to change — even if you move tasks around. So, don’t rely on WBS codes in Project; instead, use outline codes, which are static.

You can assign both an outline code and a WBS code to a task.

Outline codes work similarly to the way that WBS codes work. However, outline codes are customizable, and they are not tied to the outline structure of your project. For example, you may want to assign a department code to a task so that you can view the project organized by department. Or, you may want to assign a company cost code to a task so that you can view tasks by cost code. And, you can create a list of valid outline codes for users to enter.
To define outline codes, follow these steps:

1. Choose Tools ➪ Customize ➪ Fields. Project displays the Customize Fields dialog box, as shown in Figure 7-26. Click the Custom Outline Codes tab.

![Customize Fields dialog box](image)

**Figure 7-26:** Select an outline code to customize.

Read more about customizing fields in Chapter 19.

2. Choose an Outline Code to customize.

3. To provide a meaningful name for the code, click the Rename button and type the new name. Then click OK to redisplay the Customize Fields dialog box.

4. Click the Define Code Mask button to display the Outline Code Definition dialog box, shown in Figure 7-27.

5. In the Sequence column, select the type of character that you want to use for each level of the outline code.

6. In the Length column, use the list to choose the length for the level of the outline code.

7. In the Separator column, use the list box to select period (.), dash (–), plus (+), or slash (/), or type in any character that is not a number or a letter (such as =).

8. Repeat the previous steps for each level that you want to define.
If you simply want to create a mask for the outline code so that users use the correct format, you can click OK. You may want to select the last check box to ensure that users enter outline codes that match the mask.

To restrict the use of outline codes to a specific list of codes, click the Edit Lookup Table button in the Outline Code Definition dialog box to define permissible codes in the Edit Lookup Table dialog box, as shown in Figure 7-28.

**Figure 7-27:** The Outline Code Definition dialog box looks and operates like the WBS Code Definition dialog box.

**Figure 7-28:** Use this dialog box to define the allowable lookup codes.
On the first line, type a permissible outline code for Level 1. On the second line, type an outline code for Level 2 that is permissible under the outline code that you supplied for Level 1 and click the Indent button (the right arrow) at the top of the dialog box. On the third line, type another acceptable Level 2 outline code. If you need a Level 3 outline code under a Level 2 outline code, simply type the code on a blank line below the Level 2 outline code and click the Indent button again. To supply another Level 1 code, type the code and click the Outdent button (the left arrow) as many times as necessary, depending on the last code that you entered.

Repeat the process, filling in the acceptable outline codes. If you forget to include a code, highlight the code that you want to appear below the code that you’ll add, and then click the Insert Row button at the top of the dialog box. And, if a code becomes invalid at some later date, reopen this dialog box, highlight the code, and click the Delete Row button.

Click the Close button to redisplay the Outline Code Definition dialog box. If you don’t want to allow outline codes that don’t appear in the lookup table, select the Only allow codes listed in the lookup table check box. Then click the OK button to redisplay the Customize Fields dialog box, and click OK again to redisplay your project.

To display a column for an outline code, you follow the same process that you used to display the column for the WBS code. Right-click the column that you want to appear to the right of the Outline Code column, and choose Insert Column. In the Column Definition dialog box, open the Field Name list box and select the outline code that you defined. Click Best Fit, and Project displays the column, but it’s empty. Because outline codes don’t follow an “ordered” pattern (in other words, alphabetical or numerical), Project has no way of knowing what outline codes to assign to a particular task. If you didn’t create list entries, you can simply type the outline codes into the column.

**Tip**

Outline codes may need to match the mask that you created.

If you created list entries (and if you told Project to only allow outline codes listed in the lookup table), click in the column. You see a list box arrow. When you open the list box, the entries from the lookup table appear, as shown in Figure 7-29.
Filtering Views to Gain Perspective

Filters help you to focus on specific aspects of your project. For example, suppose that you want to view the tasks that are assigned to only certain resources or you want to display only the tasks that are on the critical path of your project. You can apply filters to views to limit the information that you see and to help you focus on a particular issue.

Project filters come in two varieties: task filters, which enable you to view specific aspects of tasks, and resource filters, which enable you to view specific aspects of resources. In Table 7-1, you find a description of the default task filters, and in Table 7-2, you find a description of the default resource filters. Many of the filters perform similar functions.

Note

The Tasks with Deadlines filter and the Tasks with Estimated Durations filter (shown in Table 7-1) first appeared in Project 2000.
### Table 7-1
**Default Task Filters**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Tasks</td>
<td>Displays all the tasks in your project.</td>
</tr>
<tr>
<td>Completed Tasks</td>
<td>Displays all finished tasks.</td>
</tr>
<tr>
<td>Confirmed</td>
<td>Displays the tasks on which specified resources have agreed to work.</td>
</tr>
<tr>
<td>Cost Greater Than</td>
<td>Displays the tasks that exceed the cost you specify.</td>
</tr>
<tr>
<td>Cost Overbudget</td>
<td>Calculated filter that displays all tasks with a cost that exceeds the baseline cost.</td>
</tr>
<tr>
<td>Created After</td>
<td>Displays all tasks that you created in your project on or after the specified date.</td>
</tr>
<tr>
<td>Critical</td>
<td>Displays all tasks on the critical path.</td>
</tr>
<tr>
<td>Date Range</td>
<td>Interactive filter that prompts you for two dates and then displays all tasks that start after the earlier date and finish before the later date.</td>
</tr>
<tr>
<td>In Progress Tasks</td>
<td>Displays all tasks that have started but haven't finished.</td>
</tr>
<tr>
<td>Incomplete Tasks</td>
<td>Displays all tasks that haven't finished.</td>
</tr>
<tr>
<td>Late/Overbudget Tasks Assigned To</td>
<td>Prompts you to specify a resource. Then, Project displays tasks that meet either of two conditions: the tasks assigned to that resource that exceed the budget you allocated for them, or the tasks that haven't finished yet and will finish after the baseline finish date. Note that completed tasks do not appear when you apply this filter, even if they are completed after the baseline finish date.</td>
</tr>
<tr>
<td>Linked Fields</td>
<td>Displays tasks to which you have linked text from other programs.</td>
</tr>
<tr>
<td>Milestones</td>
<td>Displays only milestones.</td>
</tr>
<tr>
<td>Resource Group</td>
<td>Displays the tasks that are assigned to resources that belong to the group you specify.</td>
</tr>
<tr>
<td>Should Start By</td>
<td>Prompts you for a date and then displays all tasks not yet begun that should have started by that date.</td>
</tr>
<tr>
<td>Should Start/Finish By</td>
<td>Prompts you for two dates: a start date and a finish date. Then Project uses the filter to display those tasks that haven’t started by the start date and those tasks that haven’t finished by the finish date.</td>
</tr>
</tbody>
</table>

*Continued*
### Table 7-1 (continued)

<table>
<thead>
<tr>
<th>Filter</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slipped/Late Progress</td>
<td>Displays two types of tasks: those that have slipped behind their</td>
</tr>
<tr>
<td></td>
<td>baseline scheduled finish date and those that are not progressing</td>
</tr>
<tr>
<td></td>
<td>on schedule.</td>
</tr>
<tr>
<td>Slipping Tasks</td>
<td>Displays all tasks that are behind schedule.</td>
</tr>
<tr>
<td>Summary Tasks</td>
<td>Displays all tasks that have subtasks grouped below them.</td>
</tr>
<tr>
<td>Task Range</td>
<td>Shows all tasks that have ID numbers within the range that you provide.</td>
</tr>
<tr>
<td>Tasks with Attachments</td>
<td>Displays tasks that have objects attached or a note in the Notes box.</td>
</tr>
<tr>
<td>Tasks with Deadlines</td>
<td>Displays all tasks to which you have assigned deadline dates.</td>
</tr>
<tr>
<td>Tasks with Estimated</td>
<td>Displays all tasks to which you have assigned an estimated</td>
</tr>
<tr>
<td>Durations</td>
<td>duration.</td>
</tr>
<tr>
<td>Tasks with Fixed Dates</td>
<td>Displays all tasks that have an actual start date and tasks to which</td>
</tr>
<tr>
<td></td>
<td>you assign some constraint other than As Soon As Possible.</td>
</tr>
<tr>
<td>Tasks/Assignments</td>
<td>Displays the tasks or assignments that have overtime.</td>
</tr>
<tr>
<td>with Overtime</td>
<td></td>
</tr>
<tr>
<td>Top Level Tasks</td>
<td>Displays the highest-level summary tasks.</td>
</tr>
<tr>
<td>Unconfirmed</td>
<td>Displays the tasks on which specified resources have not agreed to work.</td>
</tr>
<tr>
<td>Unstarted Tasks</td>
<td>Displays tasks that haven’t started.</td>
</tr>
<tr>
<td>Update Needed</td>
<td>Displays tasks that have changes, such as revised start and finish</td>
</tr>
<tr>
<td></td>
<td>dates or resource reassignments, and that need to be sent to resources</td>
</tr>
<tr>
<td></td>
<td>for update or confirmation.</td>
</tr>
<tr>
<td>Using Resource</td>
<td>Displays all tasks that use the resource that you specify.</td>
</tr>
<tr>
<td>Using Resource in</td>
<td>Displays the tasks that are assigned to a specified resource that</td>
</tr>
<tr>
<td>Date Range</td>
<td>start after the first date you specify and finish before the second</td>
</tr>
<tr>
<td></td>
<td>date you specify.</td>
</tr>
<tr>
<td>Work Overbudget</td>
<td>Displays all tasks with scheduled work greater than baseline work.</td>
</tr>
</tbody>
</table>
### Table 7-2
**Default Resource Filters**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Resources</td>
<td>Displays all the resources in your project.</td>
</tr>
<tr>
<td>Confirmed Assignments</td>
<td>Available only in the Resource Usage view; displays only those tasks for which a resource has confirmed the assignment.</td>
</tr>
<tr>
<td>Cost Greater Than</td>
<td>Displays the resources that exceed the cost that you specify.</td>
</tr>
<tr>
<td>Cost Overbudget</td>
<td>Calculated filter that displays all resources with a cost that exceeds the baseline cost.</td>
</tr>
<tr>
<td>Date Range</td>
<td>Interactive filter that prompts you for two dates and then displays all tasks and resources with assignments that start after the earlier date and finish before the later date.</td>
</tr>
<tr>
<td>Group</td>
<td>Prompts you for a group and then displays all resources that belong to that group.</td>
</tr>
<tr>
<td>In Progress Assignments</td>
<td>Displays all tasks that have started but haven’t finished.</td>
</tr>
<tr>
<td>Linked Fields</td>
<td>Displays resources to which you have linked text from other programs.</td>
</tr>
<tr>
<td>Overallocated Resources</td>
<td>Displays all resources that are scheduled to do more work than they have the capacity to do.</td>
</tr>
<tr>
<td>Resource Range</td>
<td>Interactive filter that prompts you for a range of ID numbers and then displays all resources within that range.</td>
</tr>
<tr>
<td>Resources with Attachments</td>
<td>Displays resources that have objects attached or a note in the Notes box.</td>
</tr>
<tr>
<td>Resources/Assignments</td>
<td>Displays the resources or assignments that have overtime with Overtime.</td>
</tr>
<tr>
<td>Should Start By</td>
<td>Prompts you for a date and then displays all tasks and resources with assignments not yet begun that should have started by that date.</td>
</tr>
<tr>
<td>Should Start/Finish By</td>
<td>Prompts you for two dates: a start date and a finish date. Then Project uses the filter to display those tasks or assignments that haven’t started by the start date and those tasks or assignments that haven’t finished by the finish date.</td>
</tr>
</tbody>
</table>

*Continued*
Table 7-2 (continued)

<table>
<thead>
<tr>
<th>Filter</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slipped/Late Progress</td>
<td>Displays two types of resources: those that have slipped behind their baseline scheduled finish date and those that are not progressing on schedule.</td>
</tr>
<tr>
<td>Slipping Assignments</td>
<td>Displays all resources with uncompleted tasks that are behind schedule because the tasks have been delayed from the original baseline plan.</td>
</tr>
<tr>
<td>Unconfirmed Assignments</td>
<td>Displays the assignments for which requested resources have not yet agreed to work.</td>
</tr>
<tr>
<td>Unstarted Assignments</td>
<td>Displays confirmed assignments that have not yet started.</td>
</tr>
<tr>
<td>Work Complete</td>
<td>Displays resources that have completed all their assigned tasks.</td>
</tr>
<tr>
<td>Work Incomplete</td>
<td>Displays all resources with baseline work greater than scheduled work.</td>
</tr>
<tr>
<td>Work Overbudget</td>
<td>Displays all resources with scheduled work greater than baseline work.</td>
</tr>
</tbody>
</table>

Applying a filter to a view

By applying a filter to a view, you specify criteria that Project uses to determine what tasks or resources should appear in that view. Project then selects information to display and either highlights the selected information or hides the rest of the information. To apply a filter and hide all other information, follow these steps:

1. Display the view that you want to filter.
2. Choose Project ➤ Filtered for.
3. Choose the filter that you want from the Filtered for menu.

Because Project enables you to apply task filters to task views only and resource filters to resource views only, the Filtered for hierarchical menu shows either All Tasks or All Resources, depending on the view that you displayed before starting these steps.
To apply a filter that doesn’t appear on the list, or to apply a highlighting filter, follow these steps:

1. Display the view that you want to filter.
2. Choose Project ➪ Filtered for ➪ More Filters. Project displays the More Filters dialog box, as shown in Figure 7-30.

![](figure.png)

**Figure 7-30:** Use the More Filters dialog box to apply a filter that doesn’t appear on the Filtered for list or to apply a highlighting filter.

3. Click the Task option button to select and apply a task filter; select the Resource option button to apply a resource filter.

   **Caution**

   Remember that Project doesn’t let you apply a task filter to a resource view or a resource filter to a task view.

4. Select a filter name from the list.
5. Click Apply to apply the filter or click Highlight to apply a highlighting filter. If the filter that you want to apply is an interactive filter, type the requested values.
6. Click OK.

   **Tip**

   To turn off a filter, choose Project ➪ Filtered for. Then choose All Tasks or All Resources, as appropriate.
Creating custom filters

If none of Project’s default filters meet your needs, you can create a new filter or modify an existing filter by customizing a filter’s criteria from the More Filters dialog box. To edit an existing filter, follow these steps:

1. Display the view that you want to filter.
2. Choose Project ➪ Filtered for ➪ More Filters to open the More Filters dialog box.
3. Select the option button of the type of filter that you want to use: Task or Resource.
4. Highlight the filter that you want to modify, and click the Copy button. Project displays a Filter Definition dialog box that is similar to the one shown in Figure 7-31.

![Filter Definition dialog box](image)

**Figure 7-31:** The Filter Definition dialog box enables you to edit an existing filter.

The More Filters dialog box does not have a Filter reset button; consequently, any changes that you make are permanent. For this reason, I advise you to click the Copy button to make a copy of a filter that you want to modify, rather than clicking the Edit button to edit the original filter. That way, the original filters remain intact.

5. Click in the Field Name column; Project displays a list box arrow to the right of the field.
6. Select a field from the list.
7. Repeat Steps 5 and 6 for the Test column, and supply a comparison operator.
8. Repeat Steps 5 and 6 in the Value(s) column, and supply a filtering value.
When creating a new filter, Project 2003 enables you to choose values from a list in the Value(s) column.

9. Repeat Steps 5 through 8 for each criterion that you want to create; also supply an And/Or operator if you supply additional criteria. Remember, And means that the filter displays information only if the task or resource meets all criteria, whereas Or means that the filter displays information if a task or resource meets any of the criteria.

10. Click OK to redisplay the More Filters dialog box.

11. Click Apply to apply the filter.

To create a new filter, click the New button in Step 4. In the Filter Definition dialog box, the name Filter 1 appears in the Name box and no information appears at the bottom of the box. You need to supply a name for the new filter and some filtering criteria. To have your new filter appear in the Filtered for list, select the Show in menu check box.

Each line that you create in the Filter Definition dialog box is called a statement. To evaluate certain statements together, but separate from other statements in your filter, group the statements into a set of criteria. To group statements, leave a blank line between sets of criteria, and select either operator in the And/Or field for the blank row.

If your filter contains three or more statements within one criteria group, Project evaluates all And statements before evaluating Or statements. Because versions of Project earlier than 98 did not work this way, using filters that you created in versions of Project prior to Project 98 may produce results that you don’t expect in Project 2003. However, across groups, Project evaluates And conditions in the order in which they appear.

Using AutoFilters

AutoFilters are similar to regular Project filters, but you can access them directly on the sheet of any sheet view instead of using a menu or a window. By default, the AutoFilters option is off when you create a project, but you can enable it by clicking the AutoFilter button on the Formatting toolbar.

When you enable AutoFilters, a list box arrow appears at the right edge of every column name in a sheet view. When you open the drop-down list, Project displays filters that are appropriate to the column, as shown in Figure 7-32.
You can turn on AutoFilters automatically for new projects that you create. Choose Tools ➪ Options and click the General tab. Select the Set AutoFilter on for new projects check box.

Using grouping

Grouping is another technique that you can use to view information about your project. You may be able to solve a problem if you group tasks by some common denominator. In Figure 7-33, I’ve grouped tasks by duration to help identify shorter versus longer tasks.
Project contains some predefined groups. To use one of these groups to arrange tasks in a view by the group common denominator, follow these steps:

1. Display the view that you want to use to group tasks.
2. Choose Project ➤ Group By, or use the Group By tool on the Standard toolbar.
3. Choose the group that you want from the Group By menu.

Because Project enables you to group tasks only in task views and resources only in resource views, the Group By menu shows either task groupings or resource groupings, depending on the view that you displayed before starting these steps.
You’re not limited to using the groups that appear on the Group By menu; you can group by almost any field. To group in a way that doesn’t appear on the menu, follow these steps:

1. Display the view that you want to use to group tasks.
2. Choose Project > Group by > More Groups. Project displays the More Groups dialog box, as shown in Figure 7-34.

![Figure 7-34: Use the More Groups dialog box to apply a group that doesn’t appear on the Group By list or to create a new group by copying and editing an existing group.](image)

3. Select the Task option button to apply a task grouping; select the Resource option button to apply a resource grouping.

Tip

Project doesn’t let you apply a task group to a resource view or a resource group to a task view.

4. Select a group name from the list.
5. Click Apply to apply the filter or click Edit or Copy to edit a group or make a copy of a group so that you can edit it.

Caution

Like its cousins, the More Groups dialog box does not have a Group reset button; consequently, any changes that you make are permanent. I advise you to click the Copy button to make a copy of a group that you want to modify, rather than editing the original group. That way, the original groups remain intact.
6. If you simply want to apply a group, click OK. If you are creating a new group by copying an existing group, you see the Group Definition dialog box, as shown in Figure 7-35.

![Figure 7-35: Use this dialog box to create a custom group based on an existing group.](image)

7. Assign a name to the group that you’re creating, and select the Show in menu box if you want the group to be available from the Group By menu.

8. Open the Field Name list box, and select a field on which you want Project to group.

9. In the Order column, choose Ascending or Descending.

10. (Optional) Select a font for the grouping title information.

11. (Optional) Change the cell background and the pattern that Project displays for the field.

12. (Optional) Click the Define Group Intervals button to display the Define Group Interval dialog box, as shown in Figure 7-36. In this dialog box, you can control the grouping intervals that Project uses. Click OK when you finish to redisplay the Group Definition dialog box.
Refining Your Project

13. Select the Show summary tasks box to include summary tasks in the grouping.
14. Click OK to save your choices and redisplay the More Groups dialog box.
15. Click Apply to apply the group the you just defined.

Starting in Project 2002, you can group on assignment fields; follow these steps to do so:

1. Select either the Task Usage view or the Resource Usage view.
2. Choose Project ✪ Group by ✪ Customize Group By. You see the Customize Group By dialog box, as shown in Figure 7-37.
3. Select the fields by which you want to group.

4. Select the Group assignments, not tasks check box.

5. In the Field Type column, select whether to group by assignment or by task.

   In the example, I started working from the Task Usage view. If you start working from the Resource Usage view, the name of the check box changes to refer to resources instead of tasks, and, in the Field Type list, you choose whether to group by assignment or by resource.

6. Click OK.

   To turn off grouping, choose Project➪Group By. Then choose No Group.

Summary

This chapter covered techniques that you can use to get more information from Project’s views. You learned the following:

✦ How to work with tables
✦ How to customize views
✦ How to order tasks in a view
✦ How to assign WBS codes and outline codes to tasks
✦ How to filter information while working
✦ How to group information while working

You can use the skills that you’ve learned here to make Project work in the way that’s most comfortable for you.

Chapter 8 explains how to change the appearance of your project by formatting elements and inserting drawings and objects.
Modifying the Appearance of Your Project

After you enter the information for your project, you may want to take the time to format the individual elements of the schedule. After all, you may be working with this project for months or even years. Why not get it to look just right?

Project has dozens of ways to format the appearance of elements, from text to taskbars, link lines, and network diagram nodes. Some of these changes are practical; others simply provide shapes or styles that may be more pleasing to you. You can use color and insert drawings or pictures into your schedule to make a visual point. You can also copy pictures of your Project file into other Office documents — for example, to include in a report. So get ready: This chapter is where you can get creative!

Changing Project’s Looks

Beyond the obvious motivation of making the lines and colors in your schedule more appealing, you may have a practical reason for modifying a schedule’s appearance. You may, for example, want to do any of the following to make information about your project more accessible:

✦ Display information, such as the start and end dates or resources assigned to the task, in text form alongside taskbars. This technique is especially useful for longer schedules in which a taskbar may appear on the printed page far to the right of the task information in the Gantt table.
Refining Your Project

- Use a bolder color for tasks that are on the critical path (tasks that, if delayed, will delay the final completion of the project). This method helps you keep an eye on tasks that are vital to meeting your deadline.

- Modify the display of baseline timing estimates versus actual progress on tasks so that you can more clearly see any divergence.

You can store multiple baselines. You may want to format your project schedule to more easily distinguish various baselines. See Chapter 11 for more information on multiple baselines.

- Display or hide dependency lines between tasks. In a project with many complex dependency relationships, multiple lines can obscure taskbar elements or network diagram nodes.

In short, beyond mere cosmetics, paying attention to the format of your schedule elements can help you focus on your project. Keep in mind that these changes pertain only to the currently open schedule, and any changes that you make to the format of these elements appear both on-screen and on any corresponding printed versions of the project.

You can change formats whenever you like and then change them back again without changing the data in your project. For example, you may decide not to display dependency lines to print out a report of resource assignments for your boss because printing the lines can obscure the list of resources next to each taskbar. You can always redisplay the dependency lines later.

**Consistency counts**

Displaying an abundance of elements on a schedule can be a mixed blessing. For example, highlighting critical tasks, adding end shapes to taskbars, and showing both baseline and actual lines as well as slack can result in a chart that is confusing. Remember that you’re not formatting elements to satisfy your particular penchant for one color or another, but to make project information easier to read.

You’ll help everyone in your organization read and understand Project schedules if you make the formatting consistent across your organization. The more that your coworkers and management see the same formatting in various schedules, the more quickly they will learn to read the symbols, and the less likely they are to misread a schedule. Set standards for formatting projects in your workgroup and your division (even across your company) and stick to them.
Using the Gantt Chart Wizard

You can make changes to specific elements in several Project views. However, the Gantt Chart view has its own wizard to help you format the various pieces. Running through the Gantt Chart Wizard highlights some of the options.

A *wizard* is an interactive series of dialog boxes that require you to answer questions or make selections. Project uses your input to create or modify some aspect of your project (in this case, the formatting that is applied to your Gantt Chart). The Microsoft Office family of products uses wizards to automate many functions.

You can use the Gantt Chart Wizard from either the Gantt Chart view or the Tracking Gantt view. Because Gantt Chart Wizard changes apply only to the project file that’s open when you run the wizard, start by displaying the project that you want to format. Then follow these steps to run the Gantt Chart Wizard:

1. Click the Gantt Chart Wizard button on the Formatting toolbar, or choose Format ➤ Gantt Chart Wizard to start the wizard. A dialog box appears, as shown in Figure 8-1.

![Figure 8-1](image)

*Figure 8-1:* Step 1 of the wizard simply greets you and tells you what the wizard does.

The four buttons at the bottom of this dialog box appear at the bottom of each wizard dialog box. Click Cancel to leave the wizard without saving any settings, click Back to move back one step, and click Finish to complete the wizard based on the information that you've provided to that point.
2. Click Next to move to the next step. In the second wizard dialog box, as shown in Figure 8-2, indicate the category of information that you want to display. You can select only one item here. Try clicking each of the following choices to see a preview of its style on the left of the dialog box:

- **Standard**: Shows blue taskbars, black summary taskbars, and a black line superimposed over the taskbars to indicate progress on tasks.
- **Critical path**: Is the Standard layout, with critical-path tasks in red.
- **Baseline**: Displays baseline taskbars and progress taskbars separately, rather than superimposed as with the Standard setup, as shown in Figure 8-2.
- **Other**: Displays a drop-down list that contains several alternative, pre-defined chart styles for the categories of Standard, Critical Path, Baseline, and Status.
- **Custom Gantt Chart**: Displays several additional screens to enable you to create a highly customized Gantt Chart.

Highlighting critical tasks in a project helps you to pay special attention to them when reviewing or tracking progress. If you don’t want to format the Gantt Chart to treat critical tasks differently, try using a filter to temporarily display only critical tasks, as I discuss in Chapter 7.

![Gantt Chart Wizard](image)

**Figure 8-2**: The preview provides an idea of how each option formats your Gantt Chart.

3. Click the option button for Custom Gantt Chart, and then click the Next button. The third wizard dialog box appears, as shown in Figure 8-3. In this box, you can choose the type of task information to display with your Gantt bars: Resources and dates (the end date only), Resources, Dates, None (of the choices), or Custom task information. When you choose Dates, as I did in
Figure 8-3, Project displays the start date and end date in the taskbar area. If you choose this setting, you don’t need to show the corresponding columns for start date and end date in the Gantt table, so this option can help you modify the size of your schedule printout.

![Figure 8-3](image)

**Figure 8-3**: Placing text alongside taskbars can be useful with larger schedules.

4. Click Next to display the next wizard dialog box, shown in Figure 8-4. Here you can decide whether you want to show link lines between dependent tasks.

![Figure 8-4](image)

**Figure 8-4**: Decide whether to display link lines to indicate dependent tasks.

5. Click Next. This Gantt Chart Wizard dialog box, shown in Figure 8-5, previews your formatting options. You can use the Back button to go back and make changes.
6. Click the Format It button to apply your choices. Project displays a final dialog box to tell you that your formatting is complete.

7. Click the Exit Wizard button to close the dialog box and see your changes.

Caution
You cannot undo the changes that the Gantt Chart Wizard makes to your project. You can only close the project without saving it and then reopen it.

When enough is too much

If you select the Custom task information option in the Gantt Chart Wizard (refer to Figure 8-3), the wizard opens three consecutive dialog boxes. These three dialog boxes prompt you to display one set of information alongside normal taskbars, another set on summary taskbars, and a third set next to milestone tasks, respectively. The wizard also prompts you to display one set of data to the left of each taskbar, one set to the right, and one set inside the taskbar itself. You could end up with nine pieces of information in and around your various taskbars!

You make your selections from drop-down lists in these three dialog boxes. The information ranges from task name, duration, and priority to percentage of work complete and types of constraints.

Obviously, if you display nine sets of data in and around taskbars, your Gantt Chart will become unreadable. However, consider this scenario: Put the task name inside both summary and normal taskbars, put the start date to the left and the finish date to the right of normal taskbars, and put the cost of summary tasks to the right of their bars. (The final element is a total of the cost of all tasks beneath the summary tasks.)

You can also modify the information that is available to someone viewing your schedule by changing the columns that are displayed in the Gantt table pane of the Gantt Chart view.
Formatting Elements One by One

The Gantt Chart Wizard enables you to make changes to several common elements, such as summary taskbars or dependency lines. But Project also enables you to format each of these elements separately, and to format them with even more options. You can change the style of many other elements in Project, including the following:

✦ Text used in your charts
✦ Boxes used in the Network Diagram Chart view
✦ Gridlines displayed in various views

Working with text

You may want to change text to be more readable; for example, some people prefer a larger font to make views easy to read. Perhaps you want to use boldface for row and column titles or a distinctive font for summary tasks.

You format text the same way for any view. You can’t format fonts in the Calendar view, but you can format categories of text.

You can make all of these changes and more in Project. You can even change all text in a certain category, or simply change the attributes of a single, selected piece of text in any Project table. For example, you may want to apply boldface to the task name of the milestone Grand Opening, but not to all milestone task names.

The Undo function is not available when you make changes to fonts and other formatting features. You must manually return the text to its original settings if you’re unhappy with the change.

Formatting selected text

To format selected text, follow these steps:

1. Move to any view that contains a table of columns (for example, the Gantt Chart, Task Usage, or Resource Sheet views).
2. Click the cell containing the text that you want to format. To format more than one adjacent cell, click the first cell. Then drag your mouse to highlight cells above, below, to the left, or to the right.
3. Choose Format ➤ Font to open the Font dialog box, shown in Figure 8-6. From the three lists across the top of this dialog box, you can select a new font, select a font style such as Italic or Bold (Regular is normal text that has neither italic nor bold applied), or change the font size. Select the Underline check box to apply underlining to text, or select a color from the Color drop-down palette. A preview of your selections appears in the Sample area.
You can also use a context menu; instead of choosing Format ➪ Font, right-click and choose Font.

**Figure 8-6:** Project uses the standard Windows Font dialog box, so many settings are probably familiar.

4. If you prefer, you can use buttons on the Formatting toolbar to change font and font size or to apply bold, italic, or underline styles. And, you can preview fonts before you select them from the Formatting toolbar, as shown in Figure 8-7.

5. Click OK to save your changes.

**Figure 8-7:** When you view the fonts in the Font list box, you see a facsimile of the font as it will appear if you choose it.
Applying formatting to categories of text

You can use text styles to change the format of text for one cell in a table or to apply a unique format to an entire category of information, such as all task names for milestones. Text styles are identical to the formatting options for text that were described in the preceding section, but you can apply text styles to specific categories of text.

Follow these steps to use text styles to modify text:

1. Choose Format ➪ Text Styles to open the Text Styles dialog box, shown in Figure 8-8.

   ![Figure 8-8: The default in the Item to Change list box is All (that is, all the text in your project schedule).](image)

2. Click the down arrow next to the Item to Change field to display the options. (This field is the only element that distinguishes the Text Styles dialog box from the Font dialog box that you saw earlier.)

3. Use the scroll bar to move down the list. You can format text for categories such as row and column titles, summary tasks, tasks on the critical path, and milestones. Click a category to select it.

4. Select the settings that you want for the text, including the font, font size, style, color, and script. When you’re done, click OK to apply the formatting.

Using the Item to Change list box, you can format categories of text to add emphasis to certain key items, such as critical tasks and milestones, or to make your schedule more readable by enlarging text or choosing easy-to-read fonts. Figure 8-9 shows a schedule with text styles applied to critical and noncritical tasks.
Good advice bears repeating: Don’t go overboard with multiple fonts on a single schedule. You can make a project harder to read by using too many fancy fonts. Avoid using more than one or two fonts in your schedule, and vary the text by using bold or italic or by modifying the font size between categories, rather than using many different fonts. Also, try to set up company standards for formatting so that all your project schedules have a consistent, professional look.

**Changing taskbars**

In addition to changing text styles in your schedule, you can modify the look of the taskbars. You can make changes to the shape, pattern, and color of bars, as well as to the style of shape that appears on either end of the taskbar.
Formatting taskbars

Formatting taskbars is similar to formatting text. You can format either an individual taskbar or a category of taskbars, such as milestones or critical tasks. Click a particular task and access the dialog box for formatting just that taskbar by choosing Format ➤ Bar. Alternatively, you can open the dialog box for formatting categories of taskbars by choosing Format ➤ Bar Styles. The settings that you can modify are the same either way.

You can open the Format Bar dialog box by right-clicking the bar that you want to modify and choosing Format Bar from the shortcut menu that appears. You can open the Bar Styles dialog box by right-clicking a blank spot in the taskbar area of the Gantt Chart and choosing Bar Styles from the shortcut menu that appears.

Figure 8-10 shows the Format Bar dialog box; Figure 8-11 shows the Bar Styles dialog box. The bottom half of the Bar Styles dialog box has two tabbed sheets called Text and Bars. Counterparts to these tabbed sheets appear in the Format Bar dialog box and are called Bar Shape and Bar Text. The Bar Styles dialog box has a table from which you can designate the category of taskbar that you want to modify and the changes that you want to make.

Figure 8-10: You can modify the appearance of an individual taskbar to draw attention to it.
Figure 8-11: Use the Bars tab of the Bar Styles dialog box to change the appearance of an entire category of tasks.

You can use the Bars tab at the bottom of the Bar Styles dialog box to set the shape, type or pattern, and color for the bar and its end shapes. Use the Text tab to add text to the chart portion of the Gantt Chart view by following these steps:

1. Click the Text tab to select the information that you want to display to the left, to the right, above, below, or inside the selected category of taskbar, as shown in Figure 8-12.

2. Select the Name of the category of taskbar to which you want to add text. If necessary, make changes to the category in the Bar Styles table at the top of the dialog box. Immediately following these steps is an explanation of the type of information that appears in each column of the table.

3. At the bottom of the dialog box, select the location for the text that you want to add. Project displays a list box arrow at the edge of the box.

4. Select the text that you want to appear on the chart portion of the Gantt Chart view for the selected category.

5. Click OK to save your changes.

Caution
No Undo button exists for the changes that Project applies to your schedule when you use the Bar Styles dialog box. Save your project before you start. If you don’t like what you get at the end, close your project without saving it and reopen it.
Figure 8-12: Be careful not to place too much information around taskbars or you’ll create a cluttered, illegible Gantt Chart.

The columns in the Bar Styles table at the top of the dialog box are as follows:

- **Name**: This column specifies the taskbar category. To create a new taskbar category name, click the Insert Row button at the top of the dialog box and type in a name. This name appears in a legend for your chart when you print it.

- **Appearance**: This column provides a sample of the current formatting settings for the bar.

    When you click in any of the next four columns, Project displays a list box arrow at the right edge of the column. Open the list box to identify valid choices for these columns.

- **Show For . . . Tasks**: This column defines the types of tasks that the specified formatting affects. You can specify the type of task to affect by selecting the category from a drop-down list or by typing a category name directly in the cell or in the entry bar. To specify more than one category, add a comma (,) after the first type and then select or type a second category. For example, to specify Normal tasks that are critical and in progress as a new category of taskbar style, choose or type in one of the following: Normal, Critical, In Progress.

    You can type directly in a Bar Styles table cell; you don’t need to type in the Entry bar.
Row: The Row column specifies how many rows of bars (as many as four) you want to display for each task. If you have only one row and you are showing a bar for both the baseline timing and progress, the bars overlap each other. If you want two separate bars, you need two rows. You also can add extra rows to accommodate text above or below taskbars.

If a task fits in several categories, what happens? Project tries to display multiple formatting settings. (For example, if one category is solid blue and the other is a pattern, you get a blue pattern.) If Project can’t display the formats together, the item that is higher in this listing takes over. To modify the formatting precedence, use the Cut Row and Paste Row features to rearrange the rows in the Bar Styles dialog box.

From and To: These columns define the time period that is shown by the bar. The Progress bar, for example, shows the actual date that the task started and the amount of task that was completed through today. Select the time frames from drop-down lists in each of these fields.

Figure 8-13 shows a schedule with expanded rows; the baseline duration is displayed beneath normal taskbars, and the baseline finish date appears to the right of summary taskbars. To display the expanded rows and the baseline duration beneath normal tasks, I used the settings shown in Figure 8-14. In the top of the dialog box, I changed the Row setting for Task from 1 to 2; in the bottom of the dialog box, on the Text tab, I displayed Baseline Duration on the bottom of the tasks and Resource Names to the right of tasks. I then clicked Summary in the top of the box and, on the Text tab below, I chose to display Baseline Finish to the right of summary tasks.

You cannot undo the changes that Project makes when you use the Bar Styles dialog box. You can only close the project without saving it and then reopen it.

The settings in the Bar Styles dialog box enable you to modify, in great detail, the appearance of your schedule and how Project displays or prints it. If you print a legend along with your schedule, the legend reflects these changes. However, remember that modifying taskbar colors isn’t of much use in black and white printouts of schedules, and creating too many kinds of formatting with too many variables can make your schedule difficult to read. The advice given previously about standardizing these settings across your organization also holds for changes that you make to taskbar formatting.

Changing the layout of the Gantt Chart

The layout of a Gantt Chart refers to the appearance of link lines, date formats used for information displayed near taskbars, the height of taskbars, and how Project displays certain characteristics of taskbars.
Figure 8-13: Adding rows to each task can make your schedule easier to read.

Figure 8-14: In the table, I changed the number of rows for Normal tasks. At the bottom of the dialog box, I added Baseline Duration to the bottom row of Normal tasks.
In views other than the Gantt Chart view, layout affects different elements. For example, in the Calendar view, layout affects the order in which Project lists multiple tasks on one calendar day and how it splits date bars. And, as you'll read in the next section, layout in the Network Diagram Chart view affects link lines and how Project handles page breaks.

To modify the layout, choose Format ➪ Layout. In the Gantt Chart view, the Layout dialog box appears, as shown in Figure 8-15.

![Layout dialog box](ch08.png)

**Figure 8-15:** Because layout affects different elements in different views, the Layout dialog box for the Gantt Chart view is different than the Layout dialog box for the Network Diagram and Calendar views.

- **Caution**
  If you have a short schedule with many tasks running only hours in length, don’t round taskbars to whole days.

- **Caution**
  No Undo button exists for the changes that Project applies to your schedule when you use the Layout dialog box. Save your project before you start. If you don’t like the results, close your project without saving it and reopen it.
The options that you can set for the Gantt Chart layout are as follows:

✦ **Links**: Click one of these option buttons to display either no link lines or to use one of the available styles. Remember, link lines graphically display dependency relationships among tasks. To take a quick look at your schedule with no dependency information showing, use the choice of no link lines in this dialog box.

✦ **Date format**: Use this drop-down list to select a date or time format. Two interesting date formats include a week number (W5/1 and W5/1/02 12:33 PM) of the year and the day of the week. Therefore, W24/3/03 is June 11, 2003 (the third day of the 24th full week of 2003).

Your nation or industry may use conventions for numbering weeks that may be different than what Project produces.

✦ **Bar height**: Select a height in points for the taskbars in your Gantt Chart.

The check boxes in the Layout dialog box have the following effects:

✦ **Always roll up Gantt bars**: This setting gives you the freedom to display your Gantt schedule by rolling up tasks onto summary bars.

✦ **Hide rollup bars when summary expanded**: This check box works with the preceding check box to hide rollup behavior if your schedule is completely expanded.

See Chapter 6 for more on Project’s rollup capabilities.

✦ **Round bars to whole days**: This option works well on longer schedules but not as well on schedules with tasks that tend to run in hourly or half-day increments.

✦ **Show bar splits**: This option provides graphic representation of split tasks on the Gantt Chart.

*SPLIT TASKS* are tasks that start, then stop for a time, and then start again. For example, if you expect to begin hiring employees for the project, but you know that your company imposes a two-week hiring freeze during the last two weeks of the year for accounting purposes, you can create a split task (see Chapter 9). The setting for splits in the Layout dialog box simply enables you to show the split task as separate taskbars or as one continuous taskbar.

✦ **Show drawings**: If you select this check box, Project displays drawings that you’ve inserted on your chart.

Make any choices in the Layout dialog box, and click OK to implement them.
Changing gridlines

Gridlines are those lines in your Gantt Chart and the Gantt table that mark off periods of time, rows and columns, pages in your schedule, and regular intervals in the chart. In Figure 8-16, gridlines mark off regular intervals across the chart; this format can help you read across the page on a long schedule. Also, the vertical line that marks the current date appears as a dashed line, rather than as the typical small-dotted line that you've seen in other figures in this chapter.

![Figure 8-16: Displaying additional gridlines can make a schedule easier to read.](image)

To modify gridlines, choose Format ➪ Gridlines. The dialog box shown in Figure 8-17 appears. In the Line to change list, the options Gantt Rows, Sheet Rows, and Sheet Columns enable you to set gridlines at regular intervals. For example, the project in Figure 8-16 has the Gantt Rows set to show at an interval of every four rows. You can change the line type and color only (not the interval) for the other choices in the Line to change list. To modify these settings, highlight the kind of line that you want to change and then select the desired settings from the Type and Color drop-down lists.
Figure 8-17: You can choose gridlines from five different styles.

If you make substantial changes in the Gridlines dialog box, consider saving the file as a template for everyone else in your organization to use for their projects. This template not only saves you and your coworkers the effort of repeating the changes, but it also helps to enforce consistency throughout your organization.

While you can’t undo the effects that you apply in the Gridlines box, you can simply reopen the box and select no line style in the Type box.

Changing network diagrams

You can format the nodes in a network diagram, and you can control the layout of the network diagram. You can modify the style of text that is placed in network diagram boxes and control the number of fields per node. You can control the size and the shape of the node and adjust the thickness and color of the line that defines the box.

Formatting network diagram nodes

You can modify the boxes that form the various nodes displayed in the Network Diagram Chart view similarly to the way that you can format taskbars in the Gantt Chart. You can format the color and line style of the box itself for each type of task. You can also control the number of fields that appear per node, the shape of the node, the horizontal and vertical alignment of text within the node, and the font that’s used in each cell of the node. Use these settings to draw the reader’s attention to categories of nodes that you want to emphasize.

As with task text and taskbars in the Gantt Chart view, be careful about keeping track of changes that you make: The Undo feature doesn’t work here. Project has its own color and line scheme for various types of tasks, and you run the risk of formatting one category to look just like another category by mistake. Because interpreting the information in a Project chart is so key to its success, be careful about changing formatting defaults.
Modifying node box styles

You can change the formatting of network diagram boxes individually, or you can change the formatting of a particular category of boxes. To change an individual box, select the box in the network diagram and choose Format ➤ Box to display the dialog box shown in Figure 8-18.

![Figure 8-18: To modify the appearance of a single box in the network diagram, use this dialog box.](image)

While you make many changes there is a combined “effect.” Use the Shape box to select one of ten shapes for the box. Similarly, use the Color box to identify the color for the lines of the box, and use the Width box to specify the width of the box’s border. You also can set the Background color and pattern for the node. Make changes and watch the Preview to determine the effects of your changes. When you finish, click OK to save the changes.

To format a category of box, such as all Critical Milestones, use the Box Styles dialog box, shown in Figure 8-19. You can display this dialog box by choosing Format ➤ Box Styles.

Select the type of box that you want to format from the Style settings for list. The current settings for the box appear in the Preview window. The rest of the options in this dialog box are the same as the options in the Format Box dialog box, except for the Set highlight filter style check box. You can filter information on the network diagram, as you read in Chapter 7. Selecting the Set highlight filter style check box enables you to set the color that Project uses when filtering tasks on the network diagram.
Figure 8-19: Use this dialog box to select a category of box to format.

You should make Name one of the pieces of information that you display. Otherwise, the flow of tasks in the network diagram chart is nearly incomprehensible.

**Tip**

**Formatting fields that appear on nodes**

Network diagram nodes display the following information by default: Task Name, Duration, ID, Start and Finish Dates, Percent Complete, and Resource Name, if assigned. However, you can display up to 16 fields of information. For example, to focus on costs in today’s staff meeting, change the network diagram node information to Task Name, Baseline Cost, Actual Cost, Actual Overtime Cost, and Cost Variance. If your manager wants a network diagram chart report so that he or she can see whether the project schedule is on track, change this information to Task Name, Critical, Free Slack, Early Finish, and Late Finish.

**Caution**

Although you can specify up to 16 pieces of information, beware of information overload. Providing too much information in a node makes the network diagram difficult to read and evaluate, and your reader may miss your point.
To modify a node, you can change the information that is included in a node, the font that’s used to display the information, and the horizontal and vertical alignment of the information. Follow these steps to modify a node:

1. Open either the Format Box or Box Styles dialog box.
2. Click the More Templates button. Project displays the Data Templates dialog box, as shown in Figure 8-20.

![Data Templates dialog box](image)

**Figure 8-20:** Select a template to modify or copy, or create a new template.

A template contains previously established node format settings.

3. Highlight the template that you want to change and click the Edit button. Alternatively, you can create a new template by clicking the New button, or you can copy an existing template and make changes to the copy by clicking the Copy button. For this exercise, I’ll copy the Standard template by clicking the Copy button. Regardless of whether you click the New, Edit or Copy button, Project displays the Data Template Definition dialog box, as shown in Figure 8-21.

![Data Template Definition dialog box](image)

As you can see in Figure 8-20, you cannot edit the Standard template—the Edit button is not available. To make changes based on the Standard template, you must copy it, as I did in Step 3.
Chapter 8 ✦ Modifying the Appearance of Your Project

Figure 8-21: Use this dialog box to change the information that you show in network diagram nodes.

The picture at the top of the dialog box provides a preview of the current structure of the cell. In this figure, the node contains eight cells — two on each row and four in each column. Blank cells (one each in the top and bottom rows) are merged with nonblank cells.

4. To change the contents of a cell of the node, click the corresponding cell in the middle of the dialog box. A list box arrow appears to the right of the cell. Open the list box to select a new field for the selected cell.

5. To change the font for a particular cell, select that cell and click the Font button. A dialog box appears, from which you can select a new font, the font size, and font attributes, such as boldface or italics.

6. Use the Horizontal alignment and Vertical alignment list boxes to change the alignment of text within its cell.

7. Use the Limit cell text to list box to specify the number of lines for each cell; a cell can have as many as three lines.

8. Select the Show label in cell check box to include an identifier in the cell for the type of information. For example, if you select the cell containing Name and then select the Show label in cell check box, the title of the task contains Name: followed by the title of the task.
You also can change the label text that appears in the box after you click the Show label in cell text box.

9. To increase or decrease the number of cells in the node, click the Cell Layout button to display the dialog box that is shown in Figure 8-22. From this dialog box, specify the number of cells for all nodes. After you click OK, Project redisplay the Data Template Definition dialog box, with the appropriate number of cells available for formatting.

![Figure 8-22: Use this dialog box to change the number of cells in a node.](image)

10. Click OK to close the Data Template Definition dialog box, click Close to close the Data Templates window, and click OK to close the Box Styles dialog box.

**Changing the layout of the network diagram**

The number of layout controls available for the network diagram increased significantly starting in Project 2000 over those previously available for the PERT chart that was available in Project 98 and earlier. As Figure 8-23 demonstrates, you can control the layout mode, the box arrangement, the link style and color, and several overall options for the network diagram.

By default, Project automatically positions all boxes on the diagram, but you can choose to manually position the boxes by choosing the Allow manual box positioning option at the top of the Layout box.

Using the Arrangement list box, you can change the order in which Project displays the boxes. Choose from Top Down From Left, Top Down By Day, Top Down By Week, Top Down By Month, Top Down – Critical First, Centered From Left, and Centered From Top. The varying arrangements change the number of pages that are required to print your network diagram.
You can control layout mode, box arrangement, and link style for the network diagram.

You also can change the row and column alignment and spacing as well as row height and column width. Using check boxes in the Box Layout section, you can hide or display summary tasks, keep tasks with their summaries, and adjust for page breaks.

You can control the style of the link lines, and you can choose to show arrows and link labels, which, by default, show the type of link dependency that exists between two tasks (Finish-to-Start, Finish-to-Finish, and so on). And, you can select different colors for both critical and noncritical links.

For more information on types of links, see Chapter 4.

Tip
Cross-Reference

To choose a background color or pattern for individual nodes, use the Format Box or Format Box Styles dialog box; you saw the Format Box Styles dialog box in Figure 8-19.

For the network diagram as a whole (not the individual nodes) you can choose a background color and pattern. You also can mark in-progress tasks with half an X and completed tasks with an entire X. If you hide all information on the nodes except the ID, Project reduces the size of the nodes on your network diagram and therefore reduces the number of pages that will print. You can also choose to show page breaks, which appear as dotted lines on-screen in the Network Diagram view. In Figure 8-24, I’ve included link labels and hidden all task information except the ID. A page break appears at the right side of the diagram (not shown in the figure).
Figure 8-24: By adjusting the layout of the network diagram, you can dramatically change its appearance.

Remember, creating too many kinds of formatting with too many variables can make your schedule difficult to read. The advice given previously in this chapter about standardizing these settings across your organization also holds for changes that you make to network diagram layouts.

**Formatting the Calendar view**

As I mentioned earlier in the chapter, you format text in the Calendar view in the same way that you format text in any other view. Although you can’t format the text of individual items in the Calendar view, you can use the Text Styles dialog box as described in the section “Applying formatting to categories of text,” earlier in this chapter, to format categories of text.

In the Calendar view, you can format bar styles and you can change the layout of the calendar. This section explores those types of changes.
**Formatting the Calendar entries**

By default, when you display the Calendar view, entries appear in boxes that Project calls bars. You can change the style of these bars. For example, you can make all critical tasks appear on the Calendar in red. Choose Format > Bar Styles in the Calendar view to display the dialog box that is shown in Figure 8-25. Select a type of task from the list on the left. As you make changes in the Bar shape area and the Text area, watch the Sample window at the bottom of the box for the effects of your changes.

![Figure 8-25: Use this dialog box to change the appearance of the Calendar view. Add different colors for different task types, or use a line instead of a box to represent the task's duration.](image)

In the Bar shape area, use the Bar type box to display tasks by selecting Line, Bar, or None — choosing None hides the selected task type from the Calendar view. If you choose Bar from the Bar type box, open the Pattern list box and select a pattern, which appears inside the box for the task type. You can also choose a pattern for Project to display between split tasks from the Split pattern box. Select the Shadow box to display a shadow behind a bar. (This option is available only if you choose Bar from the Bar type box.)

Select the Bar rounding box to tell Project to draw the bar for tasks that take less than one day so that the task’s duration is implied. For example, use bar rounding to tell Project to draw a bar that extends three-quarters of the width of the day to represent a task that takes 0.75 days. If you don’t use bar rounding, Project doesn’t imply the duration of the task by the length of the bar.
In the Text area, you can include Project fields for each task type; to include more than one field, separate fields with a comma (refer to Figure 8-25). Align the text with the bar or line using the Align list box. If you chose Bar as the Bar type, you can select the Wrap text in bars check box. When you select this box, Project wraps text so that it fits within the box. For example, if you show the task name and duration in the box, and the task name is fairly long but the task lasts only one day, Project wraps the text so that the task takes more than one row when it appears on the calendar. You’ll be able to read all displayed information about every task. If you don’t select the Wrap text in bars check box, Project displays only as much information as it can fit in a box that’s sized to match the task’s duration. In the example just described, you may not see the entire task name, and you certainly won’t see the task duration, because the box only spans one day.

**Changing the Calendar layout**

Use the Layout dialog box, shown in Figure 8-26, to change the layout of tasks in the Calendar view. By default, Project displays tasks in the Calendar view using the currently sorted order of tasks.

![Layout dialog box](image)

**Figure 8-26:** Use the Layout dialog box to change the way that Project presents tasks in the Calendar view.

You can read about sorting tasks in Chapter 7.

If you don’t want tasks to appear in the Calendar view using the currently sorted order, select the Attempt to fit as many tasks as possible option button. Project sorts tasks by Total Slack and then by Duration (longest task first) to try to fit the maximum number of tasks into the rows for a week without overlapping bars.

Deselect the Show bar splits check box to hide the designation for split tasks from the Calendar view. Select the Automatic layout check box to have Project automatically adjust the Calendar view to accommodate new tasks that you add or tasks that you delete.
Inserting Drawings and Objects

We’re living in the age of multimedia and MTV. Visual elements have a way of getting a message across that simple text often can’t match. Statistics show that 75 percent of the world learns visually. In Project, you can insert graphic images (for example, photos, illustrations, or diagrams) in the following places:

- In a Gantt Chart, in the taskbar area
- In notes (task, resource, or assignment)
- In headers, footers, and chart legends
- In resource or task forms

You also can copy your Project schedule into other Office products.

Copying pictures

Suppose that you’ve written a report in Microsoft Word and you would really like to include your Gantt Chart in the report. You can print it on a separate page, but you can also insert it as a picture in the appropriate place in your Word document. Or, suppose that you want to post a picture of your Project schedule on the Web. You can easily create a picture for either of these purposes. You can use either the Copy Picture to Office wizard or the Copy Picture dialog box.

The Copy Picture to Office wizard is new in Project 2003.

Using the Copy Picture to Office wizard, you can send an image and selected fields to Word, PowerPoint, or Visio. To use the Copy Picture to Office wizard, follow these steps:

1. Right-click on any toolbar to display the available toolbars.
2. Click Copy Picture to Office. The toolbar appears, containing only one button.
3. Click the Copy Picture to Office Wizard button and the wizard begins.
4. Click Next to display the Step 1 box of the wizard (see Figure 8-27).
5. Identify the method you want the wizard to use when handling your outline level and click Next.

6. Select the options you want Project to use while creating the image (see Figure 8-28). You can select the rows and portion of the timescale to copy, and the size of the image. Click Next.
7. Select the Office application to which you want to send the picture and the orientation of the picture (see Figure 8-29). Click Next.

![Figure 8-29: Select the Office application that should receive the image.](image)

8. Select the Project fields you want to include with the image (see Figure 8-30).
9. Click Finish.

![Figure 8-30: Identify Project fields to include with the image.](image)
Using the Copy Picture command, you can copy your Project schedule to the Windows clipboard and then paste it into any application as a graphic image. This technique copies only a picture without Project fields. Click the Copy Picture button on the Standard toolbar or choose Edit ➤ Copy Picture. The dialog box shown in Figure 8-31 appears. To copy the picture to the clipboard, select the For screen option button in the Render image section and click OK. If the image that you’re copying will fit well into another document, Project simply copies the picture to the Windows clipboard. But, if the picture that you are copying is particularly large, Project warns you and displays a dialog box that gives you the opportunity to scale the picture before saving or pasting it.

![Copy Picture dialog box](image)

**Figure 8-31:** Choose the For screen option to copy a Project schedule to the Windows clipboard.

After you’ve copied the picture, simply switch to the other document in which you want to place the picture and click the Paste button in that document. Figure 8-32 shows a Gantt Chart in Microsoft Word.

When you use the Paste button, you place a graphic in your document. The graphic is not linked to Project in any way, so from the program where you pasted the chart, you cannot do the following:

- Edit the chart to make scheduling changes
- Double-click the image to open the chart in Project

**Note**

Even if you choose the Paste Special command, the image that you copied from Project is exactly that — an image. It is not a Project file that you can link to from another application.
Figure 8-32: After you use the Copy Picture command to render an image for the screen, you can paste the image into any document.

To create a graphic image file that you can use on a Web page or in a document, select the To GIF image file option in the Copy Picture dialog box (shown previously in Figure 8-31). When you render the image for a printer, Project copies the image to the Windows clipboard but formats the image using your printer driver. If you have a black-and-white printer, the image appears in shades of gray rather than in the colors that you see on-screen. If you have a color printer, the image appears in color, like it looks on-screen. You can view the image in the Clipboard Viewer applet that comes with Windows (see Figure 8-33), or you can paste the image into another application.
Figure 8-33: When you render the picture for a black-and-white printer, Project places a black-and-white image of your project on the Windows clipboard. If you use a color printer, the image appears in color on the clipboard.

To access the Clipboard Viewer, choose Start ➤ All Programs ➤ Accessories ➤ System Tools. If the Clipboard Viewer doesn’t appear in the System Tools group, you need to install it. To install the Clipboard Viewer in Windows XP (the directions are similar for other versions of Windows), choose Start ➤ Control Panel ➤ Add or Remove Programs. In the Add or Remove Programs box that appears, click the Add/Remove Windows Components icon. In the Windows Components Wizard that appears, click Accessories and Utilities and then click the Details button. In the next box that appears, click Accessories and then click the Details button. Select Clipboard Viewer, and then click OK twice. When the Windows Components Wizard reappears, click Next and then follow the on-screen directions.

### Using visuals in schedules

Because project management is often a serious, information-oriented business, you don’t want to overdo the visuals. Remember, both the Gantt Chart and the network diagram are visuals. And, pictures of bunnies and curly doodads aren’t likely to sit well with the head of your engineering division. However, used judiciously, images
can reinforce the information about your project and lend a professional look to your reports.

Consider using graphics in the following ways:

✦ Add a company logo to the header of your schedule so that it appears at the top of every page.

✦ Add a photograph of each of your key resources in his or her resource note. The photo helps you get to know all the team members in a large-scale project so that you can address them by name when you see them.

✦ If a particular task involves a schematic or diagram of a product, place a copy of the diagram in the task notes for reference.

Placing graphics in a schedule can take up a big chunk of memory, making your file larger and possibly increasing calculation time; for this reason, use graphics only on an as-needed basis.

✦ If your schedule has a key milestone, place a graphic that suggests success or accomplishment next to the milestone in the Gantt Chart. Every time that you review your schedule with your team, you’ll subconsciously focus on that goal and how close you’re getting to it, which can boost morale.

Graphic objects come in a variety of file formats, depending on the type of graphic and the program in which it was created. You can use scanned images, photo files, illustrations such as clip art, a chart that you’ve created in Excel, a Word table, and even a video clip. Check the Internet for sources of graphics files, or use the images that are available to the Microsoft Office family of products.

**Inserting visual objects**

To insert an object into a header, footer, or legend, choose File ▶ Page Setup and click the appropriate tab. Use the Insert Picture button to open a dialog box that enables you to select a picture file to insert. For task notes, double-click the task to open the Task Information dialog box, select the Notes tab, and use the Insert Object button to insert a file.

Suppose that you have an Excel worksheet that provides information that you need for a budgeting task. You can insert a graphic object that shows the worksheet data on the Notes tab of the Task Information dialog box for the budgeting task. Follow these steps to insert the graphic object of worksheet data:

1. Double-click the task with which you want to associate the worksheet.
2. Click the Notes tab.
3. Click the Insert Object button. The Insert Object dialog box appears, as shown in Figure 8-34.
4. Select the Create from File option.

5. Click the Browse button to select the worksheet.

6. Click the OK button. The worksheet information appears as a graphic on the Notes tab, as shown in Figure 8-35.

Instead, suppose that you want to see a chart of the information on the Notes tab. Logically, you create the chart in the worksheet and then use the preceding steps — but you get the entire worksheet, both numbers and chart. To place just the chart on the Notes tab, follow these steps:
1. Select the chart in Excel, and click the Copy button to copy the chart to the clipboard.

2. Switch to Project.

3. Open the Task Information dialog box for the appropriate task.

4. Click the Notes tab.

5. Right-click in the area where the note would appear, and from the submenu that appears, click Paste. The chart alone appears on the Notes tab, as shown in Figure 8-36.

![Figure 8-36](image)

**Figure 8-36:** You can copy any image that you place on the Windows clipboard into Project.

You can place any image directly on the Gantt Chart. Don’t open the Task Information dialog box. Instead, copy the image to the clipboard and, after you switch to Project, click the Paste button.

**Using the Drawing toolbar**

Project has a drawing feature that you can use to build simple diagrams or add shapes or text boxes to the Gantt Chart area of your Project file. For example, you may want to draw a circle around an important taskbar in your schedule to draw attention to it in a presentation. Or, suppose that you want to suggest cutting a task from the project, as shown in Figure 8-37. The formatting methods that I presented in the section “Changing taskbars,” earlier in this chapter, enable you to create settings so that predefined information appears next to taskbars in your schedule. However, you must use the Drawing Text Box tool to enter your own text.
Refining Your Project

Figure 8-37: Consider using this type of drawing when you display a project on-screen using an LCD panel, or at a trade show.

To display the Drawing toolbar, shown in Figure 8-38, you can choose either View ➤ Toolbars and select the Drawing toolbar for display, or choose Insert ➤ Drawing.

Figure 8-38: The Drawing toolbar is a floating toolbar. Drag it up near the Formatting toolbar to dock it at the top of your screen, or click the dark blue bar at the top and drag to move it around your screen.
The following points show you how to use the tools on the Drawing toolbar:

✦ To draw an object, click the Line, Arrow, Rectangle, Oval, Arc, or Polygon button and then click the taskbar area of the Gantt Chart. Hold down your mouse button, and drag to draw the shape. When using the Polygon tool, you need to draw several segments to define the multisided shape, clicking at the end of each segment. To complete the polygon, double-click at the end of the last segment. With all the other tools, the shape appears automatically when you drag in one direction and release your mouse button.

✦ To create text anywhere around your taskbar, click the Text Box button and drag to draw a box. Your insertion point appears in the box whenever you select the box; you can then enter text.

✦ To fill an object with color, click the Cycle Fill Color button on the Drawing toolbar repeatedly until you see the color that you want.

✦ By default, Project anchors drawing objects to the timescale. To anchor a drawing object in the Gantt Chart to a particular taskbar — so that if you move the task in the schedule the graphic moves with it — select the object and click the Attach to Task button on the Drawing toolbar. Select the Attach to task option button in the Format Drawing dialog box, shown in Figure 8-39, enter a task ID number, and enter the settings for the point on the taskbar at which you want to attach the object. Then click OK. (You can reach the Format Drawing dialog box at any time by selecting the drawing and choosing Format ➪ Drawing ➪ Properties.)

![Format Drawing dialog box](image)

**Figure 8-39:** You can also attach a graphic to a position on the timescale, rather than attaching it to a particular task. For example, you can place a graphic at a particular date on the timescale.
You can also use three tools on the Drawing toolbar with other types of graphic objects that you insert. The Draw, Cycle Fill Color, and Attach to Task buttons work with any selected object, such as clip art.

When you no longer need the Drawing toolbar, click the Close button in the upper-right corner to remove it.

**Modifying graphics and drawings**

You can also use the Format Drawing dialog box to format graphic object styles. To open this dialog box, right-click any drawing object and choose Properties from the shortcut menu that appears. You see the Size & Position tab initially (refer to Figure 8-39). Click the Line & Fill tab to see the choices that are shown in Figure 8-40.

![Figure 8-40](image)

**Figure 8-40:** Rather than cycling through fill colors by using the button on the Drawing toolbar, you can select a fill color from a drop-down palette in the Line & Fill tab of the Format Drawing dialog box.

In the Line panel, use the Color and Line drop-down options to assign a style of thickness and color to lines. In the Fill panel, use the Color and Pattern options to place a color and pattern, such as solid or thatched lines, inside an object.

**Tip**

You can fill-color and pattern-fill the inside of a drawn object and the background area of clip art or other predrawn graphic object. The Preview box of Figure 8-36 demonstrates how a fill pattern surrounds the clip art object — filling the background of the object rather than filling the object itself.
Resizing and moving drawings and other objects are similar to working with objects in other programs. These are described as follows:

✦ To resize an object: Click the object to select it. Click any of the eight selection handles, and drag inward to make the object smaller or drag outward to make the object larger.

✦ To move an object: Move your mouse pointer over the object until your cursor changes to four arrows. Click the object, hold down your mouse button, and drag the object anywhere in the Gantt Chart area. Release the mouse button to place the object.

Summary

In this chapter, you discovered many ways to do the following:

✦ Format text for individual selections or globally by category of task
✦ Format taskbars and the information that is displayed near them
✦ Format network diagram boxes and change the information that you display in the Network Diagram view
✦ Change the layout options for Gantt Chart taskbars and network diagram nodes
✦ Add gridlines to the Gantt Chart view
✦ Insert graphic objects and drawings in the Gantt Chart and in notes, or as a header and footer

Chapter 9 explains how to fine-tune timing to resolve scheduling conflicts.
Resolving Scheduling Problems

Scheduling conflicts are the bane of the project manager’s existence. Scheduling conflicts typically fall into the following categories:

- Your project is taking longer than you had planned.
- Your resources are overassigned.

This chapter considers the first problem and focuses on identifying and then resolving scheduling problems; Chapter 10 focuses on the second problem.

Scheduling conflicts announce themselves in a number of ways. Changing views and filtering information by using the techniques that are described in Chapters 6 and 7 may identify some glaring problem that’s inherent in your original logic. For example, if you filter your project to view only incomplete tasks or slipping tasks, you may spot some problems. More likely, however, you’ll unknowingly create a problem by using a task constraint, which is explained in the next section.

Resolving Scheduling Conflicts

Project provides several techniques that you can use to resolve scheduling conflicts. This section covers the following strategies:

- Adding resources
- Using overtime
Adding resources to tasks

Adding resources to a task can decrease the time that’s necessary to complete the task. On the Advanced tab of the Task Information dialog box, which is shown in Figure 9-1, set the task type to Fixed Units. In this instance, adding resources to the task reduces the duration of the task. Also, remember that a check mark appears by default in the Effort driven check box of the Task Information dialog box. When you use the Effort driven option, Project reallocates the work among the assigned resources.

![Task Information dialog box](image)

**Figure 9-1:** The Advanced tab of the Task Information dialog box controls the task type and shows whether the task is effort driven.

Using overtime

In the best of all worlds, you have unlimited resources and you can add resources to resolve scheduling problems. After giving yourself a reality check, though, you’ll discover that you don’t have unlimited resources, and adding resources may not be an option. But you may be able to use overtime to shorten a task’s duration, which is the next strategy that you can use to resolve scheduling problems.
For information on resolving resource conflicts, see Chapter 10.

*Overtime* in Project is defined as the amount of work that is scheduled beyond an assigned resource’s regular working hours. Overtime hours are charged at the resource’s overtime rate. Overtime work does not represent additional work on a task; instead, it represents the amount of time that’s spent on a task outside regular hours. For example, if you assign 30 hours of work and 12 hours of overtime, the total work is still 30 hours. Of the 30 hours, 18 hours are worked during the regular work schedule (and charged to the project at the regular rate), and 12 hours are worked during off hours (and charged to the project at an overtime rate). Therefore, you can use overtime to shorten the time that a resource takes to complete a task.

To enter overtime, follow these steps:

1. Select the Gantt Chart view from the View bar.
2. Choose Window ‹ Split to reveal the Task Form in the bottom pane.
3. Click the Task Form to make it the active pane.
4. Choose Format ‹ Details ‹ Resource Work. Project adds the Ovt. Work column to the Task form, as shown in Figure 9-2.

![Figure 9-2: Use the Task form and display the Overtime (Ovt. Work) column to add overtime.](image-url)
5. Move to the top pane, and select the task to which you want to assign overtime.

6. Move to the bottom pane, and fill in the overtime amount for the appropriate resource.

Tip
After you finish entering overtime, you can hide the Task form by choosing Window $\Rightarrow$ Remove Split.

**Adding time to tasks**

You can also solve scheduling conflicts by increasing the duration of a task. Again, in the best of all worlds, you have this luxury. In reality, you may not. But if you can increase the duration of a task, you may find that once-scarce resources are now available to complete the task — given the task’s new timing.

As you know, you can change the duration from several different views, such as the Task Usage view or the Gantt Chart view. You can also use the Task Information dialog box to complete this task, as shown in Figure 9-3. To open the Task Information dialog box, double-click the task and use the Duration box to change the duration.

![Task Information dialog box](image)

**Figure 9-3:** Change the duration from the Task Information dialog box.

**Adjusting slack**

*Slack time* is the amount of time that a task can slip before it affects another task’s dates or the finish date of the project. *Free slack* is the amount of time that a task can be delayed without delaying another task. Most projects contain *noncritical tasks with slack* — these tasks can start late without affecting the schedule. If you
have slack in your schedule, you may be able to move tasks around to balance phases of the schedule that have no slack with phases that have too much slack. Therefore, you can use tasks with slack to compensate for tasks that take longer than planned or to help resolve overassignment of resources.

Slack values can also help you identify inconsistencies in the schedule. For example, you see a negative slack value when one task has a finish-to-start dependency with a second task, but the second task has a Must Start On constraint that is earlier than the end of the first task.

Almost by definition, you create slack time if you use the Must Start On constraint when you create your task. As you read in Chapter 4, you set constraints on the Advanced tab of the Task Information dialog box, as shown in Figure 9-4. To display the Task Information dialog box, double-click the task in your schedule. When the dialog box appears, select the Advanced tab.

![Task Information dialog box](image)

**Figure 9-4:** Constraints can often create slack time.

To avoid creating slack time, use the As Soon As Possible constraint whenever possible. To find tasks with slack time, follow these steps:

1. Choose View ➪ More Views to open the More Views dialog box.
2. Select Detail Gantt from the list, and then click Apply.

**Tip**

You can identify slack on the Gantt bars. Slack appears as thin lines that extend from the regular Gantt bars.

3. Right-click the Select All button, and select Schedule from the list of tables.
4. Drag the divider bar to the right to view more of the table. Now you can see the Free Slack and Total Slack fields, as shown in Figure 9-5.
Figure 9-5: You can find slack time in tasks by using the Detail Gantt view and the Schedule table.

Changing task constraints

Task constraints are the usual culprits when projects fall behind schedule. By default, Project uses the Planning Wizard to warn you when you are about to take an action that is likely to throw your project off schedule. For example, if you impose a Must Start On task constraint on a task with no slack time and with other tasks linked to it, Project displays the Planning Wizard dialog box, as shown in Figure 9-6.

Similarly, if you impose an illogical start date on a task when recording actual dates, Project displays a Planning Wizard dialog box that resembles the one that is shown in Figure 9-7. For example, you see a Planning Wizard dialog box if you accidentally enter a start date for Task 2 that is earlier than Task 1, and Task 2 is linked to and succeeds Task 1.
Figure 9-6: The Planning Wizard appears by default when you apply a constraint that is likely to lengthen your project schedule.

Figure 9-7: The Planning Wizard also warns you if you try to record a start date that will cause a scheduling conflict.

Notice that you can turn off the Planning Wizard warnings by placing a check in the Don’t tell me about this again check box at the bottom of the Planning Wizard dialog box. (Some people just don’t like to have wizards popping up all the time.)

If you turn off the Planning Wizard, Project still warns you if you take actions that cause scheduling problems. Instead of the Planning Wizard, Project displays a more traditional message, as shown in Figure 9-8.
When you disable the Planning Wizard and take an action that may cause a scheduling problem, Project displays this warning message.

Project makes suggestions concerning actions that you can take to avoid these kinds of conflicts — these suggestions all refer to the predecessor task. Notice also that, unlike the Planning Wizard, this message box does not give you the option of canceling your action.

So, although you may find the Planning Wizard annoying at some levels, it can actually save you effort at other levels. Sorry that you turned it off? To turn it on again, choose Tools ➪ Options and click the General tab, as shown in Figure 9-9.

Select the Advice from Planning Wizard check box, and then select the Advice about errors check box. (You also can control the other types of advice that you receive in the same location.)

**Adjusting dependencies**

By changing task dependencies, you can tighten up the schedule and eliminate scheduling conflicts. If you inadvertently link tasks that don’t need to be linked, you may create a situation in which you don’t have the resources to complete the tasks, and as a result, the project schedule falls behind. If you discover unnecessary links, you can remove them. When you remove the dependencies, you may find holes in the project schedule where work can be performed but isn’t. After you remove unnecessary dependencies, you may be able to move tasks around and fill those holes.
Reviewing dependencies is easiest if you use the Relationship Diagram view in the bottom pane of the Gantt view, as shown in Figure 9-10. The Relationship Diagram view shows you the selected task and its immediate predecessor and successor. Use the following steps to select the Relationship Diagram view:

1. Choose Window ➪ Split.
2. Click the bottom pane.
3. Choose View ➪ More Views.
4. Select Relationship Diagram from the More Views window, and click Apply.
Figure 9-10: Use the Relationship Diagram view to review task dependencies.

Click each task in your project to review its dependencies. As you review the tasks, ask yourself the following questions:

✦ Do I really need to complete Task A before Task B begins?
✦ Could I perform the tasks concurrently?
✦ Could I do one of the tasks later without harming the project?

Splitting a task

Splitting a task can sometimes be the best way to resolve a scheduling conflict. You may not be able to complete the task on consecutive days, but you can start the task, stop work on it for a period of time, and then come back to the task. Project enables you to split a task anytime you determine that you need to make this type of adjustment. Remember that splitting a task creates a gap, which you see in the task’s Gantt bar. Follow these steps to split a task:
1. Switch to the Gantt Chart view.

2. Click the Split Task button on the Standard toolbar. The button appears to be pressed, the mouse pointer changes shape, and a screen tip tells you how to split a task, as shown in Figure 9-11.

![Figure 9-11: Use the Split Task button to divide a task.](image)

3. Move the mouse pointer along the bar of the task that you want to split. As the mouse pointer moves, dates representing the split date appear in the screen tip.

4. Click when the screen tip shows the date on which you want to split the task; Project inserts a 1-day split.

   If you want the split to last longer than 1 day, drag to the right instead of clicking.

After you split a task, it will look similar to Task 5, as shown in Figure 9-12, with dotted lines appearing between the two portions of the split. If you decide that you want to remove a split, drag the inside portions of the split together so that they touch.
Using the Critical Path to Shorten a Project

Earlier in this chapter, you examined ways to resolve the scheduling conflicts that may develop. But what about simply shortening the time frame that you originally allotted for the entire project, and thus becoming a hero? How would you accomplish that goal? You would evaluate — and try to shorten — the critical path.

The critical path shows the tasks in your project that must be completed on schedule in order for the entire project to finish on schedule — and these tasks are called critical tasks. Most tasks in a project have some slack, and you can delay them some without affecting the project finish date. However, if you delay critical tasks, you affect the project finish date. As you use the techniques that are described in the section “Resolving Scheduling Conflicts,” earlier in this chapter, to modify tasks to resolve scheduling problems, be aware that changes to critical tasks will affect your project finish date.

Noncritical tasks can become critical if they slip too much. You can control how much slack that Project allows for a task before defining the task as a critical task. Choose Tools ➤ Options, and then click the Calculation tab. In the Tasks are critical if slack is less than or equal to box, at the bottom of the tab enter the number of slack days.

Note
Identifying the critical path

You can see the critical path best if you use the Gantt Chart Wizard to display the critical path in red.

No Undo button exists for the changes that Project applies to your schedule when you use the Gantt Chart Wizard. Save your project before you start. If you don’t like what you get at the end, close your project without saving it and reopen it.

This discussion of the Gantt Chart Wizard focuses on displaying the critical path; see Chapter 8 for a more complete description of that wizard.

Open the View menu, and select Gantt Chart. Then click the Gantt Chart Wizard button on the Formatting toolbar (the button at the right edge), or choose Format ➤ Gantt Chart Wizard. The first Gantt Chart Wizard dialog box welcomes you to the Gantt Chart Wizard. Click Next to move on to the next Gantt Chart Wizard dialog box, as shown in Figure 9-13. Then select Critical path to describe the kind of information that you want to display on the Gantt Chart.

![Figure 9-13: Select the Critical path option button when you run the Gantt Chart Wizard.](image)

Subsequent dialog boxes in the Gantt Chart Wizard enable you to select other types of information to display, such as resources or dates on Gantt bars and links between dependent tasks. These other choices that you can make while running the Gantt Chart Wizard are a matter of personal preference. When you finish, click the Format It button and then click the Exit Wizard button.

When you view the Gantt Chart, all tasks in the project still appear, but tasks on the critical path appear in red.

After you use the Gantt Chart Wizard, you can switch to any view and the critical tasks appear in red. Try the Network Diagram view, for example; the critical tasks appear in red boxes.
You can use formatting to identify critical tasks. When you apply formatting to critical and noncritical tasks, this formatting appears in all views in which you can see task bars. The formatting identifies critical tasks with a Yes in or near the bar of the tasks and noncritical tasks with a No.

To apply formatting, follow these steps:

1. Display the Gantt Chart view.
2. Choose Format ➤ Bar Styles; Project displays the Bar Styles dialog box.
3. Select Task from the list at the top of the Bar Styles dialog box to apply formatting to noncritical tasks.
4. Click the Text tab at the bottom of the dialog box.
5. Select a position for the formatting: Left, Right, Top, Bottom, or Inside. When you click a position, a list box arrow appears.
6. Click the list box arrow and scroll to select Critical, as shown in Figure 9-14.

![Bar Styles dialog box](image)

**Figure 9-14:** Use the Text tab of the Bar Styles dialog box to apply formatting that distinguishes critical from noncritical tasks.

7. Click OK.
After you apply the formatting, the Gantt Chart shows critical and noncritical tasks, as shown in Figure 9-15. Because I placed critical information inside task bars, No appears inside noncritical tasks and Yes appears inside critical tasks.

![Gantt Chart Example](image)

**Figure 9-15:** The formatting in this Gantt Chart identifies critical and noncritical tasks.

Even with formatting, this approach to identifying the critical path can be cumbersome if your project contains many tasks. Alternatively, you can identify the critical path by filtering for it. As Chapter 7 explains, you can apply the Critical filter to any task view to display only critical tasks, as shown in Figure 9-16. To apply the filter, display the view that you want to filter and choose Project ➤ Filtered for ➤ Critical or choose Critical from the Filter list box on the Formatting toolbar.
Filtering is an effective tool to display only certain aspects of the project, but sometimes you need to view all the tasks in your project and still identify the critical ones. If you use formatting (your own or the formatting that is supplied by the Gantt Chart Wizard), you can always identify critical and noncritical tasks — even if you are viewing all the tasks in your project.

**Tip**

Filtering is an effective tool to display only certain aspects of the project, but sometimes you need to view all the tasks in your project and still identify the critical ones. If you use formatting (your own or the formatting that is supplied by the Gantt Chart Wizard), you can always identify critical and noncritical tasks — even if you are viewing all the tasks in your project.

**Shortening the critical path**

Shortening the time that is allotted on the critical path shortens your project’s duration. The converse is also true; lengthening the time that’s allotted on the critical path lengthens the project. In all probability, you, as the project manager, are also responsible (at least to some extent) for the cost of a project. Typically, the longer a project goes on, the more it costs. Therefore, shortening the critical path is often the project manager’s goal.
Shortening a project’s duration can result in an earlier finish. But it also can mean starting later. Obviously, the second alternative is riskier, particularly if you are not confident in your estimates. If you are new to project management, you probably should not plan to start later; instead, use project management tools to help you evaluate the accuracy of your estimating skills. Over time (and multiple projects), you’ll know how accurate your estimates are, and then you can take the risk of starting a project later than initially planned.

To reduce the time that is allotted on the critical path, you can do one or both of the following:

✦ Reduce the duration of critical tasks.
✦ Overlap critical tasks to reduce the overall project duration.

To reduce the duration of critical tasks, you can do any of the following:

✦ Reassess estimates and use a more optimistic task time. The PERT Analysis views can help you here.
✦ Add resources to a critical task. Remember, however, that the task must not be a fixed-duration task — adding resources to a fixed-duration task does not reduce the time of the task.
✦ Add overtime to a critical task.

To overlap critical tasks, you can do one or both of the following:

✦ Adjust dependencies and task date constraints.
✦ Redefine a finish-to-start relationship to either a start-to-start or a finish-to-finish relationship.

After you know the techniques that you can apply to adjust the critical path, you need to ask the important question: What’s the best way to identify tasks that you want to change and then make the changes? The answer: Select a view, and filter it for critical tasks only. I prefer the Task Entry view, which is a combination view of the Gantt Chart and the Task Form view, because the top pane displays a graphic representation of your project and the bottom pane displays most of the fields that you may want to change, as shown in Figure 9-17.
Figure 9-17: The Task Entry view, filtered for critical tasks, is probably the easiest view in which to work if you're trying to adjust the critical path.

To set up this view, select the Gantt Chart view. The table that you apply to the Gantt Chart is a matter of personal preference; you may consider the Schedule table because it shows slack information. After you select the Gantt Chart view, choose Window ➪ Split. The Task Form appears in the bottom pane.

If you don’t see the Predecessor information in the Task Form, right-click the Task Form window and choose Resources & Predecessors from the menu that appears.

To filter for critical tasks, choose Project ➪ Filtered for ➪ Critical. Click each critical task to evaluate it, and make changes in the Task Form at the bottom of the screen.
You also can sort your critical tasks by duration. That way, the critical tasks are in order from the longest to the shortest, and you can focus on trying to shorten longer tasks.

**Using Multiple Critical Paths**

Project enables you to view more than one critical path in a project. This feature comes in handy when you have lots of tasks that are driving other tasks and you want to find out which ones are truly critical to finishing the network of tasks on time.

By default, when you view only one critical path, you’re viewing the tasks that must be completed to finish the project on time. These tasks have no total slack. (*Total slack* is the amount of time that you can delay a task without delaying the completion of the project.)

Suppose, however, that your project contains lots of subtasks, and within the subtasks you have dependencies. You may start wondering, within a given network of tasks, which ones are really critical. In this case, view your project with multiple critical paths, where Project displays a separate critical path for each network of tasks.

Consider the project that is shown in Figure 9-18. In this figure, you see the following four networks of tasks:

- Network 1: Task IDs 2, 3, and 4
- Network 2: Task IDs 6 and 7
- Network 3: Task IDs 9 through 13
- Network 4: Task IDs 15 through 18

The critical path for the project appears with a cross-hatched pattern (on-screen, it’s also red) and revolves around the tasks in the first two networks.
Figure 9-18: This project contains four networks of tasks.

When you display multiple critical paths, you see a critical path for each network of tasks, as shown in Figure 9-19. For each unique task, Project sets its late finish date equal to its early finish date. When a task has no links, it is critical because its late finish is equal to its early finish. If a network of tasks contains slack, like Network 3, some tasks are not critical while others are critical. When you view multiple critical paths, you can determine which tasks within a network of tasks must be completed on time to avoid delaying the network.
Figure 9-19: When you view multiple critical paths, you see the critical tasks within each network of tasks in your project.

By default, Project displays only one critical path, but you can change this default. Choose Tools → Options and click the Calculation tab to display the dialog box that is shown in Figure 9-20. Select the Calculate multiple critical paths check box and click OK.
Figure 9-20: Display multiple critical paths within a project from the Calculation tab of the Options dialog box.

Summary

This chapter described the following techniques that you can use to resolve scheduling conflicts and shorten the length of your project:

✦ Adding resources to tasks
✦ Using overtime
✦ Adjusting slack
✦ Changing task constraints and dependencies
✦ Adjusting the length of the critical path

In Chapter 10, you find out how to resolve conflicts that occur with resources.
Resolving Resource Problems

Resource allocation is the process of assigning resources to tasks in a project. Because the potential for resource overallocation always accompanies resource assignment, this chapter explores the causes of resource overallocation and suggests methods to resolve the conflicts.

Understanding How Resource Conflicts Occur

As you assign resources to tasks, Project checks the resource’s calendar to make sure that the resource is working. However, Project doesn’t assess whether the resource is already obligated when you assign the resource to a new task; Project enables you to make the assignment. Be aware, though, that the additional assignment may lead to overallocating the resource. Overallocation occurs when you assign more work to a resource than the resource can accomplish in the time that you’ve allotted for the work to be completed.

For example, if you assign Mary to work full-time on two tasks that start on the same day, you actually assign Mary to 16 hours of work in an 8-hour day — not possible unless Mary is a really dedicated employee who has no life outside work. On the other hand, if you have a group of three mechanics and you assign two mechanics to work on two tasks that start on the same day, you still have one spare mechanic and no overallocation.
Figure 10-1 shows a series of tasks under the Plan Entertainment and Public Relations tasks that begin on the same day. By assigning the same resource to them, an overallocation is inevitable. And, overallocations can cause delays in the project schedule.

![Microsoft Project screen](image)

**Figure 10-1:** Assigning the same resource to tasks that run simultaneously causes an overallocation.

To calculate the scheduled start date for a task, Project checks factors such as the task's dependencies and constraints. Project then checks the resource's calendar to identify the next regular workday and assigns that date as the start date for the task. If you haven’t assigned resources to the task, Project uses the project’s calendar to calculate the next regular workday. But when Project calculates the task start date, it does not consider other commitments that the resource may have outside of the current project.
Spotting Resource Conflicts

Before you can resolve resource conflicts, you need to spot them. You can use views or filters to help you identify resource overallocation problems.

Using views to spot resource conflicts

Use a resource view, such as the Resource Sheet view or the Resource Usage view, to find resource conflicts. In these views, overallocated resources appear in red. In addition, a Caution icon appears in the Indicator column to signal an overassigned resource. You can see a message about the overallocation if you point at the icon with your mouse. For information on addressing overallocations, see “Delaying tasks by leveling resource workloads” later in this chapter.

To display the Resource Usage view that is shown in Figure 10-2, select Resource Usage from the View bar or choose View ➪ Resource Usage.

![Figure 10-2: The Resource Usage view displays overallocated resources in red, and an icon appears in the Indicator column.](image-url)
You also can see a graphic representation of a resource’s allocation by switching to the Resource Graph view. To display the view that is shown in Figure 10-3, select Resource Graph from the View bar or choose View ➪ Resource Graph.

![Figure 10-3: The Resource Graph view provides a picture of a resource’s allocation.](image)

The Resource Allocation view is useful for working with overallocations — a Gantt Chart in the lower pane shows the tasks assigned to the resource that you select in the top pane. Tasks that start at the same time overlap in the Gantt Chart pane; this view helps you pinpoint the tasks that are causing the resource’s overallocation. The top portion of the view in Figure 10-4 shows that Ellen Peck is overallocated on Monday, June 2. If you examine that day more closely, you’ll notice that Ellen is scheduled to work 12 hours that day. In the bottom portion of the view, the two tasks to which she’s assigned 100 percent of the time are Baseball Game and Opera — and the Gantt view makes it easy to see the overlap of the two tasks on that Monday.
Resolving Resource Problems

Figure 10-4: The Resource Allocation view uses the Gantt Chart format to show the tasks assigned to the resource that is selected in the top pane.

To switch to the Resource Allocation view, choose View → More Views and then select Resource Allocation.

Using filters to spot resource conflicts

Filtering is another simple technique that you can use to resolve resource conflict problems. If you filter the Resource Usage view to display only overallocated resources, as shown in Figure 10-5, the problems become even more apparent. To filter the view, switch to it first by choosing View → Resource Usage. Then open the Filter list box on the Formatting toolbar and choose Overallocated Resources, or choose Project → Filtered → Overallocated Resources.
Figure 10-5: You can filter the Resource Usage view to show overallocated resources only.

Next, add the Overallocation field to the view to identify the extent of the resource’s overallocation. Choose Format ➪ Details ➪ Overallocation. As Figure 10-6 shows, Project adds a row to the timescale portion of the view to show you the number of hours that you need to eliminate to correct the overallocation.
Resolving Conflicts

After you find the overallocations, you need to resolve the conflicts. Project managers use several methods to resolve conflicts.

Changing resource allocations

If you play around with resource allocations, you can resolve a resource conflict. Adding a resource is one obvious way to resolve an overallocation. For example, suppose that Task 3 is an effort-driven task that has a resource conflict with Task 4. The two tasks don’t run concurrently, but Task 3 is continuing when Task 4 is supposed to start. Suppose also that you need the same resource, Deena Tanenblatt, to work on both tasks. Adding a resource (Do Lahr) to Task 3 reduces the amount of time that it takes to finish Task 3, which can eliminate Deena’s conflict between Tasks 3 and 4.
You can add a resource by using the techniques that are described in Chapter 5, or you can add a resource to a task by using the Resource Usage view (described in the section “Adding a task assignment to a resource,” later in this chapter).

**Switching resources**

You also can resolve resource conflicts by switching resources. You can use this technique when one resource is overallocated but you have another resource available that's capable of doing the job. You switch resources by replacing resources on the task in question.

Start in the Resource Usage view where you can focus on resource conflicts (refer to Figure 10-2; Figures 10-5 and 10-6 are also based on the Resource Usage view). When you are ready to make a switch, I suggest that you create a combination view that shows the Gantt Chart in the top of the view and the Resource Usage view in the bottom of the view (see Figure 10-7).

![Figure 10-7: Using a combination of the Gantt view and the Resource Usage view helps focus on correcting resource overallocations.](image)

See Chapter 6 to learn how to create a combination view.
In the upper pane, find and click the task on which you want to switch resources. In the bottom of the window, Project displays all of the tasks assignments for each resource assigned to the selected task. Click the Assign Resources button to open the Assign Resources box. Highlight the resource you want to switch, click the Replace button, and select the resource you want to use on the task. Fill in the Units column, click OK, and then click Close. Project will change the assignment without affecting historical actuals, and no resources are affected other than the ones involved in the switch.

If you’re using Project Server, you can take advantage of the Resource Substitution Wizard to substitute generic resources automatically. See Chapter 21 for more details.

**Adding a task assignment to a resource**

You add a task assignment to a resource using essentially the same process as I described in the preceding section, “Switching resources” — except you don’t replace a resource. Set up the combination view where the Gantt Chart appears in the top pane and the Resource Usage view appears in the bottom pane. In the upper pane, find and click the task to which you want to add a resource. In the bottom of the window, Project displays all of the tasks assignments for each resource assigned to the selected task. Click the Assign Resources button to open the Assign Resources box. Highlight the resource you want to add, fill in the Units column, and click Close. Project will add the resource to the task.

**Adding or deleting a resource assignment**

You can add or delete a resource assignment by using a number of techniques. For example, you can work in the Gantt Chart view and then split the view (choose Window→Split) to display the Task Entry view (a combination of the Gantt Chart view in the top pane and the Task Form view in the bottom pane). Select a task in the Gantt Chart view, and then do the following:

- To add a resource assignment, select the resource from the list box that appears when you click the Resource Name column of the Task Entry view.
- To delete a resource assignment, select the resource’s ID number in the Task Entry view and press Delete.
- To switch resources, use the Replace Resource dialog box (see Chapter 5 for more details).

Working in the Gantt Chart view is effective, but the Resource Usage view helps you to focus on resource conflicts.
You shouldn’t delete a resource assignment that contains actual work. If you do, you will see misleading information about the task. Suppose, for example, that you assign one resource to a task, the resource completes the task, and then you delete the resource assignment. Project shows the task as completed, but you won’t complete any work or actual work at the task level.

**Scheduling overtime**

You also can resolve a resource conflict by scheduling overtime for the resource. *Overtime* in Project is the amount of work that is scheduled beyond an assigned resource’s regular working hours, and overtime hours are charged at the resource’s overtime rate. Overtime work does not represent additional work on a task; instead, it represents the amount of time that’s spent on a task during nonregular hours. By scheduling overtime, the resource may finish the task faster and therefore eliminate the conflict. As you read in the last chapter, you assign overtime from the Gantt Chart view. Use the following steps to schedule overtime:

1. Display the Gantt Chart view (choose View ➪ Gantt Chart).
2. Choose Window ➪ Split to switch to the Task Entry view and reveal the Task Form in the bottom pane.
3. Click the Task Form to make it the active pane.
4. Choose Format ➪ Details ➪ Resource Work. Project displays the Ovt. Work column in the Task Form pane, as shown in Figure 10-8. In this column, 0h means that you have not yet assigned overtime.
5. Select the task in the top pane to which you want to assign overtime.
6. Go to the bottom pane, and fill in the overtime amount for the appropriate resource.

When you finish entering overtime, you can hide the Task Form by choosing Window ➪ Remove Split.
Redefining a resource’s calendar

If your resource is a salaried resource, you may have the option of redefining a resource’s calendar so that hours typically considered nonworking (and therefore charged at an overtime rate if worked) become working hours. If a resource has a conflict and the number of hours in conflict on a given day is low enough, you can eliminate the conflict by increasing the working hours for the resource for that day.

You can make this kind of change to any resource — Project won’t stop you. But you need to consider the effects on the cost of your project. If you are paying a resource at an overtime rate for working during nonworking hours, you don’t want to change nonworking hours to working hours in Project. If you do, you will understate the cost of your project.
To change a resource's working calendar, go to the Resource Usage view. Identify the resource that has a conflict, and note the number of hours that the conflict involves. Double-click the resource that has a conflict to open the Resource Information dialog box for that resource. Click the Working Time tab to view that resource's calendar, as shown in Figure 10-9.

![Resource Information dialog box](image)

**Figure 10-9:** Use the Working Time tab of the Resource Information dialog box to change the standard working hours for the resource.

To change the standard working hours for a resource, follow these steps:

1. Click the first date on which the resource is overallocated.
2. Select the Use default option button.
3. Use the From and To boxes to set up nonstandard working hours for that day.
4. Repeat this process for each day that you want to change the work schedule for a particular resource.
5. Click OK when you finish.

**Assigning part-time work**

Suppose that a resource is assigned to several concurrent tasks and is also overallocated. Suppose also that you don’t want to add other resources, switch to a different resource, or add overtime. You can assign the resource to work part-time on
each of the tasks to solve the conflict, although the tasks may take longer to complete by using this method. Or, you may want to use this method in conjunction with additional resources to make sure that you can complete the task on time.

To assign a resource to work part-time, you can change the number of units of the resource that you apply to the task. By default, Project sets task types to Fixed Units. Therefore, if you change the amount of time that a resource works on a task, Project changes the duration of the task accordingly.

To retain the duration and assign a resource to work part-time on a task, change the task type to Fixed Duration. By making this change, however, you are indicating that the task can be completed by the resource in the allotted amount of time — effectively, you are shortening the amount of time that it takes to complete the task because you’re applying less effort during the same time frame.

To change the task type to Fixed Duration, follow these steps:

1. Display the Resource Allocation view by using the More Views window (choose View ➪ More Views).
2. Click the task that you want to change in the upper pane. Project displays that task in Gantt format in the lower pane.
3. Double-click the task that you want to change in the lower pane. Project displays the Task Information dialog box. Click the Advanced tab, as shown in Figure 10-10.
4. Open the Task type list box, and select Fixed Duration.
5. Click OK.

![Figure 10-10: Use the Advanced tab of the Task Information dialog box to change the task type.](image)
Now you can assign resources to work part-time on this task without changing the task’s duration. Follow these steps to assign the resources:

1. In the Resource Allocation view, click a task in the top pane to which the over-allocated resource is assigned.

2. Click the Assignment Information button on the Standard toolbar, or double-click the task to open the Assignment Information dialog box. You can see the General tab in Figure 10-11.

![Figure 10-11: Use the Assignment Information dialog box to change a resource’s workload to part-time.](image)

3. Change the default value in the Units box (100%) to reflect the percentage of time that you want the resource to spend on the task — in this case, the value should be less than 100%.

4. Click OK.

**Controlling when resources start working on a task**

For cases in which you’ve assigned more than one resource to a task, consider staggering the times that the resources begin working on the task to resolve resource conflicts. When you delay a resource’s start on a task, Project recalculates the start date and time for that resource’s work on the task. To stagger start times for resources, work in the Task Usage view and follow these steps:

This technique can extend the duration of the task, which may not be a viable option for you.
1. Choose View ➪ Task Usage.

2. Select the resource whose work time you want to delay in the Task Name column.

3. Click the Assignment Information button, or double-click the resource. Project displays the General tab of the Assignment Information dialog box (as shown previously in Figure 10-11).

4. Change the dates in the Start or Finish boxes.

5. Click OK.

You also can alter the assignment start and finish dates directly in the Task Usage table.

### Delaying tasks by leveling resource workloads

If you have scheduled several tasks to run concurrently and you now find resource conflicts in your project, you can delay some of these tasks to level — or, spread out — the demands that you’re making on your resources. Leveling is the process of resolving resource conflicts by delaying or splitting tasks to accommodate the schedules of assigned resources. You can ask Project to select the tasks to delay or split by using its leveling feature, or you can control the process manually by examining the project to identify tasks that you are willing to delay or split.

### Automatic leveling

When Project does the leveling for you, it redistributes a resource’s assignments and reschedules them according to the resource’s working capacity, assignment units, and calendar. Project also considers the task’s duration, constraints, and priority.

What is a task’s priority? Well, in some circumstances, you want Project to level some tasks before it levels other tasks. You can do so by assigning different priority levels to tasks. By default, Project assigns all tasks a priority of 500. When you assign different priorities to tasks, Project considers the priorities of each task when you level and attempts to avoid delaying tasks in order of their priority, from highest to lowest. Effectively, Project delays tasks with lower priorities before delaying tasks with higher priorities; if everything else is equal, Project will delay a task with a priority of 5 before it will delay a task with a priority of 15. So, before you start to use the automatic-leveling feature, consider how you want to prioritize tasks.

The priority of 1000 is treated in a special way; Project will not consider delaying any task to which you assign a priority of 1000.
To set a priority, follow these steps:

1. Choose View ➪ Gantt Chart.
2. Double-click the task for which you want to set a priority, or select the task and click the Task Information button on the Standard toolbar. Project displays the Task Information dialog box.
3. Use the General tab to set a priority, as shown in Figure 10-12.

You might prefer to set priorities from the table portion of the Gantt Chart view or the Task Usage, where you can easily see the priorities of neighboring tasks.

![Figure 10-12: Set a priority for the task.](image)

**Tip**

After you prioritize tasks — but before you level — you can sort tasks by priority to view the tasks that Project is most likely to level.

To level tasks automatically, follow these steps:

1. Choose Tools ➪ Level Resources to open the Resource Leveling dialog box, as shown in Figure 10-13.
2. Select the Automatic option button to have Project automatically level resources, if necessary, whenever you make a change to your schedule. Select Manual to perform leveling only when you click the Level Now button in this dialog box.
3. Use the Look for overallocations on a . . . basis list box to select a basis. The *basis* is a time frame, such as Day by Day or Week by Week. (The Indicator box in the Resource Usage view may contain a note that suggests the appropriate basis.)
4. Select the Clear leveling values before leveling check box to make Project 2003 behave like Project 98 when leveling — that is, Project resets all leveling delay values to 0 before leveling. If you deselect this box, Project 2003 does not reset leveling values but builds upon the values. During leveling, the scheduling for previously leveled tasks will probably not change.

5. In the Leveling range for panel, select either to level the entire project or to level only for specified dates.

6. In the Leveling order list box, select the order that you want Project to consider when leveling your project. If you choose ID Only, Project delays or splits the task with the highest ID number. If you choose Standard, Project looks at predecessor dependencies, slack, dates, and priorities when selecting the best task to split or delay. If you choose Priority, Standard, Project looks first at task priority and then at all the items that are listed for the Standard leveling order.

7. Select any of the following options:
   - Level only within available slack: This avoids changing the end date of your project.
   - Leveling can adjust individual assignments on a task: In this case, leveling adjusts one resource’s work schedule on a task independent of other resources that are working on the same task.
• Leveling can create splits in remaining work: This allows leveling to split tasks to resolve resource conflicts.

• Level resources with the proposed booking type: Check this box to have Project include tasks containing proposed resources during the leveling process.

8. Click Level Now to apply leveling.

You can review the effects of leveling from the Leveling Gantt Chart view, as shown in Figure 10-14. Choose Views ➪ More Views ➪ Leveling Gantt, and then click Apply. Project adds green bars to your Gantt Chart, which represent the duration of tasks before leveling. Depending on the nature of your project, Project may build more slack into your tasks.

![Figure 10-14: The Leveling Gantt Chart view shows how leveling affects your project.](image)

To remove the effects of leveling, reopen the Resource Leveling dialog box (choose Tools ➪ Level Resources) and click the Clear Leveling button. A subsequent dialog box enables you to clear leveling for the entire project or for selected tasks only.
If you are scheduling from a finish date, you still can level to resolve resource conflicts. Project calculates the delay by subtracting it from a task’s or assignment’s finish date, causing the finish date to occur earlier.

**Manual leveling**

Manual leveling is especially handy when automatic leveling doesn’t provide acceptable results. Manual leveling is also useful when you have just a few resource conflicts to resolve. To manually level resources in Project, use the Resource Allocation view and follow these steps:

1. Choose View ➪ More Views. From the More Views dialog box, highlight Resource Allocation and click Apply.
2. Highlight the task that you want to delay in the top pane.
3. In the bottom pane, enter an amount in the Leveling Delay field. Project delays the task accordingly and reduces the resource’s conflict.

Figures 10-15 and 10-16 show before and after pictures for manual leveling. I used a simple situation to demonstrate the effects of manual leveling: I set up a project with only two tasks and one resource, and I assigned the same resource full-time to both tasks. Notice that manually leveling the second task delays the second task so that it starts when the first task finishes.

![Figure 10-15: The Resource Allocation view before manual leveling.](image-url)
Contouring resources

*Contour* is the term that Project uses to refer to the shape of a resource’s work assignment over time. Contours come in several flavors; the most common are Flat, Back Loaded, Front Loaded, and Bell. The default contour is Flat, which means that a resource works on a task for the maximum number of hours that he or she is assigned to a task for the duration of the assignment. You can use different contours to control how much a resource is scheduled to work on a task at a given time — and possibly resolve a conflict.

Add the Peak Units field to the Resource Usage view to display the maximum effort — as distributed over time — that a resource is expected to work. This field is particularly useful when you have selected a contour other than the default (Flat).

The Flat contour assigns a resource to work the maximum number of hours per time period throughout the duration of the task. By changing the contour, you can more accurately reflect the actual work pattern for the resource while working on a task.
To better understand contours, think of dividing each task into 10 equal timeslots. By using the various contours, Project assigns percentages of work to be done in each timeslot. Contours help you to assign work to a task, based on when the task requires the effort. For example, if a task requires less effort initially, consider using a Back Loaded contour. If a task requires most effort in the middle of the task, consider using a Bell, Turtle, or even an Early Peak contour.

If you start changing contours from the default Flat contour, you may inadvertently create a resource conflict. Therefore, viewing the contours that you set can help you resolve resource conflicts.

**Setting a contour pattern**

To set a contour pattern, follow these steps:

1. Choose View ➪ Task Usage. In the sheet portion of the view, Project displays each task in your project with the resources that are assigned to it listed below the task, showing the number of hours per day that a resource is assigned to a task.

2. In the Task Name column, double-click the resource for which you want to apply a contour, or select the resource and click the Assignment Information button on the Standard toolbar. Then click the General tab of the Assignment Information dialog box, as shown in Figure 10-17.

![Assignment Information dialog box](image)

**Figure 10-17:** Use the General tab of the Assignment Information dialog box to select a contour.

3. Open the Work contour list box, and select a contour.

4. Click OK.
To change the start and end dates for the resource’s work on the task, use the Start and Finish list boxes.

When you select a contour other than Flat, an indicator appears next to the resource in the Indicator column. If you pass the mouse pointer over the indicator, Project identifies the contour that was applied to the resource, as shown in Figure 10-18.

![Microsoft Project](image.png)

**Figure 10-18:** Project displays an icon in the Indicator column next to a resource for which you have chosen a contour other than Flat.

The same icon appears in the Indicator column in the Resource Usage view.

Keep the following points in mind when working with contours:

- Suppose that you apply a contour other than the default Flat contour to a task, and later you add new total work values to the task. Project automatically reapplies the contour pattern to the task and the resources by first distributing the new task work values across the affected time span and then by assigning new work values to the resources that are working on the task.
If you set a contour and then change the start date of the task or the start date of a resource’s work on the task, Project automatically shifts the contour and reapplies it to include the new date, thus preserving the pattern of the original contour.

If you increase the duration of a task, Project stretches the contour to include the new duration.

Suppose that you apply a contour other than the default contour to a task. If you manually edit a work value on the portion of a view that displays the contour, Project no longer applies the contour pattern automatically. However, you can reapply the contour to redistribute the new values.

If you enter actual work and then change the task’s total work or total remaining work, Project automatically redistributes the changes to the remaining work values and not to the actual work.

Contouring a resource’s availability

Starting in Project 2000, you can contour a resource’s availability. To contour a resource’s availability, use the General tab of the Resource Information dialog box, as shown in Figure 10-19. In the Resource Availability list box, set Available From and Available To dates for the selected resource. A particular resource may be available to work on your project only part-time for a specified time frame. Or, suppose that you have five computer programmers, but only three are available in August and one retires in September. Use the Resource Availability section to specify the availability of your resources, which will influence your project’s schedule.

![Figure 10-19: Set dates that represent the resource’s availability so that you can assign the resource to a task by using only the dates that the resource is available.](image-url)
Pooling resources

Finally, you can try to solve resource conflicts by using a resource pool. A resource pool is a set of resources that are available to any project. You can use resources exclusively on one project, or you can share the resources among several projects.

Typically, resource pooling is useful only if you work with the same resources on multiple projects and you don’t use Project Server. Different project managers can share the same resources. Because resource pooling is so closely tied to the topic of managing multiple projects, I’ll postpone further discussion until Chapter 15; in that context, you’ll better understand the application of resource pooling to resolving resource conflicts.

If you’re using Project Server, you don’t need to use resource pooling. Instead, you’ll be more interested in using Enterprise resources and the Resource Substitution Wizard to resolve resource conflicts. See Chapters 19 and 21 for more information.

Summary

This chapter explained how to identify and resolve resource conflicts that can delay a project. The techniques involved include the following:

✦ Changing resource allocations
✦ Scheduling overtime
✦ Redefining a resource calendar
✦ Assigning part-time work
✦ Controlling resource start times
✦ Leveling resource workloads
✦ Contouring resources

In the next chapter, you discover the art of tracking your progress by comparing your project to its baseline.
Tracking Your Progress

In This Part

Chapter 11
Understanding Tracking

Chapter 12
Recording Actuals

Chapter 13
Reporting on Progress

Chapter 14
Analyzing Financial Progress
Understanding Tracking

This chapter marks something of a turning point in this book and in your use of Project. Up to this point, you’ve been in the planning phase: building a project schedule, entering tasks, adding resources, and shifting things around so that resource assignments don’t conflict and so that tasks have the proper relationships to each other. You’ve even tweaked details such as text formatting and the appearance of task bars. You now have a workable, good-looking project in hand — and now you are ready to start the project.

*Tracking* is the process of comparing what actually happens during your project to your estimates of what would happen. To track, you need to take a picture of your project schedule at the moment your planning is complete; this moment is called a *baseline*. But you also have to understand what steps are involved in tracking and how to set up efficient procedures to handle these steps.

Starting in Project 2003, you can store up to 11 baselines for any project.

Understanding the Principles of Tracking

A good plan is only half the battle. How you execute that plan is the key. Think of yourself as the quarterback in a football game. If you run straight down the field toward the goalpost, never swerving to avoid an oncoming opponent, you won’t get very far. Project tracking is similar: If you don’t swerve and make adjustments for the changes in costs and timing that are virtually inevitable in any human endeavor, you’re not playing the game correctly.
Project management software greatly enhances your ability to quickly see problems and revise the plan to minimize any damage. Project enables you to compare what you thought would happen to what actually happens over the course of the project.

**Estimates versus actuals**

The plan that you’ve been building is an estimate of what can occur. It’s your best guess (an educated one, hopefully) about how long tasks may take, how one task affects another, how many resources you need to complete the work, and what costs you expect your project to incur. Good project managers keep good records of their estimates and actuals to become better project managers. By comparing these two sets of data, you can see where your estimates were off and then use this information to make your next plan more realistic. You can also use data on actual costs and timing to make the changes in your strategy that are necessary to keep you on track and meet your current project’s goals.

Tracking in Project consists of entering information about actuals, such as the actual start date, the actual finish date, and the actual duration of a task. You enter actual time that is worked by resources and actual costs that are incurred. When you enter information about actuals, Project shows you a revised schedule with projections of how the rest of the schedule is likely to play out, based on your actual activity.

---

**How much have you accomplished?**

As I describe in Chapter 12, you record activity on a task by entering an estimate of the percentage of the task that’s complete, actual resource time spent on the task, or actual costs incurred (such as fees or equipment rentals paid), or by entering the hours of work done per time period. Estimating “the completeness” of a task is not an exact science, and different people use different methods.

With something concrete, such as a building under construction, you can look at the actual building and estimate fairly accurately how far along the project has progressed. Most projects aren’t so straightforward, however. How do you estimate how far along you are in more creative tasks, such as coming up with an advertising concept? You can sit in meetings for five weeks and still not find the right concept. Is your project 50 percent complete? Completion is hard to gauge from other, similar projects on which you’ve worked — perhaps on the last project, you came up with the perfect concept in your very first meeting.

Don’t fall into the trap of using money or time spent as a gauge. It’s (unfortunately) easy to spend $10,000 on a task that is estimated to cost $8,000 and still be only 25 percent to completion. You probably have to use the same gut instincts that put you in charge of this project to estimate the progress of individual tasks. Hint: If your project has individual deliverables that you can track, document them and use them consistently when you make your estimate.
Project managers usually track activity on a regular basis, such as once a week or every two weeks. This tracking includes information about tasks in progress as well as about tasks that have been completed.

This tracking activity also enables you to generate reports that show management where your efforts stand at any given point in time. By showing managers the hard data on your project’s status — rather than your best guess — you can make persuasive bids for more time, more resources, or a shift in strategy if things aren’t going as you expected. Figure 11-1 shows a Tracking Gantt view using its default table, the Tracking table.

Chapter 12 explains the specific steps for updating a project to reflect actual progress.

Figure 11-1: Use the Tracking Gantt view to display the progress of your project.

Making adjustments as you go

Tracking isn’t something that you leave to the end of the project, or even to the end of individual tasks. Tracking tasks in progress on a regular basis helps you to detect any deviation from your estimates. The earlier you spot a delay, the more time you have to make up for it.
If Project determines that you’re running late on a task, it automatically moves dependent tasks into the future.

For example, suppose that you estimated that a task would take three days. However, you have already put four days of effort into it, and it’s still not complete. Project not only tells you that you’re running late but also moves future tasks that depend on this task farther out in the schedule. Project also shows any resource conflicts that result when resources have to put in more work than you estimated in resource views, such as the Resource Sheet and Resource Graph view. Project clearly shows how one delay ripples through your schedule.

Tip
Project adjusts your project’s cost as you track to reflect the effect of higher-than-expected costs.

Project also shows the effect of unanticipated costs on the total budget. If the costs that you track on early tasks are higher than anticipated, Project displays your projected total costs, based on a combination of actual costs and the remaining estimates. Project shows you exactly how much of your budget you have used and how much you have remaining, so you can revise your resource allocations to stay within your overall budget.

Using Baselines

You complete the planning phase of your project by setting a baseline. You have seen this term in previous chapters, but take a moment to grasp its significance in the tracking process.

What is a baseline?

A baseline is a snapshot of your project when you complete the planning phase, or sometimes at the end of some other critical phase. The baseline is one set of data that is saved in the same file where you track actual progress data. Project enables you to save up to 11 baselines and up to 10 interim plans during your project. You can show a wide variety of information about your baseline(s), or you can choose not to display baseline information.

Some projects, particularly shorter ones that run only a few weeks or even a couple of months, may have one baseline set at the outset and may proceed close enough to your estimates that they can run their course against that single baseline. Other projects, especially longer ones, may require you to set several baselines along the way, particularly if the original estimate is so out of line with what has transpired in the project that the original is no longer useful. You can modify the entire baseline if changes are drastic and occur early in the project, or you can modify the baseline estimates only going forward from a particular point in the project.
For example, if your project is put on hold shortly after you complete the schedule and you actually start work three months later than you had planned, you would be wise to set a new baseline schedule before restarting. If, however, you’re six months into your project and it is put on hold for three months, you may want to modify the timing of future tasks and reset the baseline only for tasks going forward to help you retain the ability to accurately assess how well you estimated.

Costs can change a baseline, too. For example, what if you save a baseline that is set to fit within a $50,000 budget and, before you start work, cost-cutting measures hit your company and your budget is cut to $35,000? You would be wise to make the changes to your resources and costs, and then reset your baseline. Setting interim baselines keeps your projects from varying wildly from your estimates when mitigating circumstances come into play.

### Setting a baseline

Starting in Project 2002, the Planning Wizard no longer appears when you save your project.

In most cases, you need to save the project file — without saving the baseline itself — several times during the planning phase.

When you’re ready, you can use the Save Baseline dialog box to save up to 11 baselines and 10 interim plans for your project. Each baseline is a picture of your project at the time that you save it, and each baseline that you save includes information about tasks, resources, and assignments. For tasks, Project saves duration, start and finish dates, work, timephased work, cost, and timephased cost. For resources, Project saves work, timephased work, cost, and timephased cost information with the baseline. For assignments, Project saves start and finish dates, work, timephased work, costs, and timephased costs.

When you save interim plans, Project saves a set of task start and finish dates that you can compare with another interim plan or with a baseline plan, thus helping you to keep an eye on progress or slippage. Saving baselines and interim plans helps you to compare current information (found in the start and finish fields) with baseline information (found in the baseline fields). The distinction between baselines and interim plans in Project is the amount and type of information that Project saves.

To control the settings when you save a baseline, follow these steps:

1. Choose Tools ➪ Tracking ➪ Save Baseline to open the Save Baseline dialog box, as shown in Figure 11-2.
2. Set up the baseline that you want to save.
3. Open the Save baseline list box, and select the baseline that you want to save.
4. Click OK.

When you save baselines for selected tasks, you can choose to roll up baselines to all summary tasks and from subtasks into their parent summary task(s) — thus helping to maintain accurate baseline information, as shown in Figure 11-3. The relationship between the tasks in the project and the task(s) that you select prior to opening the dialog box determines the effect of these check boxes.

For example, suppose that you have a project set up like the one shown in Figure 11-4. Furthermore, suppose that you select Task 6, a child of Task 1 and the parent of Tasks 7 and 8, before you open the Save Baseline dialog box. If you select only the From subtasks into selected summary task(s) check box, Project rolls up the information from Tasks 7 and 8 to Task 6. If you select only the To all summary
tasks check box, Project rolls up baseline information from Task 6 without regard to the baseline information that is stored for Tasks 7 and 8. If you select both check boxes, Project rolls up baseline information from Tasks 7 and 8 to Task 6 and then rolls up that information to Task 1.

Suppose that you want to update the baseline to reflect approved changes to the project, such as added tasks, or changes to existing tasks that affect the cost or schedule of the tasks. Highlight the added or changed tasks and the parent summary task and then save the baseline. In the Save Baseline box (refer to Figure 11-3), choose the Selected tasks option and check both boxes in the Roll up baselines section. Project will update the baseline for the changed tasks and then change all the summary levels to reflect the change.

![Figure 11-4: Ancestry determines baseline information rollup behavior. In this sample project, Tasks 3 and 6 are children of Task 1, and Task 6 is the parent of Tasks 7 and 8.](image)

### Changing the Baseline

Most of the time, you don’t want to make changes to a baseline. It’s a moment that’s frozen in time, a record against which you can compare your progress. If you change a baseline on a regular basis, you are defeating its purpose.
That said — you will encounter some circumstances in which, for strategic reasons, you need to modify a baseline and resave it, or to save a second or third baseline to document major shifts in the project. However, if you are overriding the original baseline, you must do so in a thoughtful and efficient way. This section discusses some of the times when changes to a baseline are necessary and explains how you can make those changes.

**Adding a task to a baseline**

It is fairly common to set your baseline plan and then realize that you left out a step, or then decide to break one step into two steps. Perhaps your company institutes a new requirement or process, and you have to modify a task to deal with the change. You don’t want to reset your whole project baseline, but you want to save that one task along with the original baseline. You can make this change after you save the original baseline.

To add a task to your baseline so that you can track its progress, follow these steps:

1. Do one of the following:
   - To add a new task to the schedule and then incorporate it into the baseline, first add the task in the Task Name column on your Gantt Chart and then select it.
   - To save modifications to an existing task, first make the changes and then select the task.

2. Choose Tools ➪ Tracking ➪ Save Baseline. The Save Baseline dialog box appears.

3. Select the baseline that you want to modify from the Save baseline list.

4. Choose the Selected tasks option button, as shown in Figure 11-5.

![Save Baseline dialog box](image)

**Figure 11-5:** Make modifications to tasks, and save them in an already established baseline.
5. Choose the appropriate Roll up baselines settings (see the preceding section for details on these options).

6. Click OK to save the baseline, which now includes the new task.

You can add tasks to the baseline by entering them in the Gantt table, using columns such as Baseline Duration and Baseline Start or Finish. However, adding baseline data this way does not enable all baseline calculations. For example, adding a task at the end of the project with this method doesn’t affect a change in the baseline finish date.

Using interim plans

You can use the baseline in different ways. You can refer to it as your original estimate and compare it with actual results at the end of the project to see how well you guessed, and to learn to make better guesses on future projects. But the baseline also has an important practical use during the project: It alerts you to shifts so that you can make changes to accommodate them. The second use may prompt you to save interim plans.

The initial baseline(s) may quickly take on more historical rather than practical interest. You should not change the initial baseline(s) because that record of your original planning process is important to retain. However, if timing shifts dramatically away from the baseline plan, all the little warning signs that Project gives you about being off schedule become useless. A project that starts six months later than expected will show every task as late and every task as critical. To continue generating useful project information, you need to revise the schedule to better reflect reality. Only by saving interim plans can you see how well you’re meeting your revised goals.

Remember that interim plans contain a set of task start and finish dates that you can compare with another interim plan or with a baseline plan, thus helping you to keep an eye on progress or slippage. A baseline includes much more information — duration, start and finish dates, work, and cost information about tasks, resources, and assignments. Saving baselines and interim plans helps you to compare current information, found in the start and finish fields, with baseline information, found in the baseline fields.

You can set interim plans for all the tasks in the project. However, you should usually save an interim plan only for tasks going forward. For example, if a labor strike pushes out a manufacturing project by two months, you should keep the baseline intact for all the tasks that were completed at the time the strike started and save an interim plan for all the tasks that must still be performed when the strike ends.

You also can use interim plans to copy baseline information from one baseline to another.
You can save an interim plan by following these steps:

1. Select various tasks to include in the interim plan.

2. Choose Tools ➪ Tracking ➪ Save Baseline to open the Save Baseline dialog box.

3. Select the Save interim plan option button. Project makes the Copy and Into fields available.

4. Click the arrow to the right of the Copy field to display the drop-down list. Figure 11-6 shows that I’ve opened the Into list, which contains the same choices that you’ll find in the Copy list.

5. Select Start/Finish from the Copy drop-down list to copy the current start and finish dates.

6. Open the drop-down list for the Into field and select a numbered item, such as Start1/Finish1, to copy the dates into new fields, thus creating an interim plan.

7. Select the Entire project option button to create an interim plan for the whole project, or choose the Selected tasks option button to create an interim plan that retains the original baseline information for any tasks that you didn’t select, yet saves new baseline information for the tasks that you have selected.

8. Click OK to save the interim baseline plan.
Remember that you can use the various numbered Start/Finish items to save up to 10 interim plans plus the original, for a total of 11 interim plans over the life of your project.

**Clearing a baseline or interim plan**

Inevitably, you set a baseline or an interim baseline and then find a reason to clear it. Suppose, for example, that you thought you finished the planning stage of the project. The project hasn’t yet started, and you attend a meeting in which you inform everyone that you’re “good to go” for next Monday. Naturally, your announcement triggers discussion and — by the time the discussion ends — the scope of the project has expanded (or contracted) considerably. You now need to work again on the planning phase of your schedule — and you really don’t want to adjust the baseline. Instead, you want to get rid of it; after you make all your changes, you can set the correct baseline.

Starting in Project 2000, you can clear baselines. Choose Tools ➪ Tracking ➪ Clear Baseline. Project displays the Clear Baseline dialog box, as shown in Figure 11-7. In this dialog box, you can choose to clear a baseline plan or an interim plan for the entire project or for selected tasks.

![Clear Baseline dialog box](image)

**Figure 11-7:** Set the baseline too soon? Clear it from this dialog box so that you can make adjustments and set the baseline correctly.

**Viewing Progress with the Tracking Gantt View**

Baselines help you to see how your estimates differ from actual activity in the project. Project enables you to see this variance both graphically, with baseline and actual task bars, and through data that is displayed in tables in various views. The next section briefly explains how to display baseline and actual data, and how you can use this feature to understand the status of your project.

In Chapter 12, you find out how to enter tracking data.
Interpreting the Tracking Gantt view

The Tracking Gantt view is most useful in viewing progress against your baseline estimates. To open the Tracking Gantt view, click its icon in the View bar or choose View ➪ Tracking Gantt. This view shows the Entry table by default. However, you can add or remove fields (columns), or you can display other tables of information. The columns that are shown in Figure 11-8 include baseline information that I added to the Tracking table.

![Tracking Gantt table](image)

**Figure 11-8:** The Tracking Gantt table can display a wealth of information.

Review Chapter 7 for more information about changing and modifying tables.

Notice the Baseline Duration and Baseline Cost fields that I added to the table, as well as the Actual Duration and the Actual Cost fields which appear in the default Tracking Gantt table. These fields help you to compare estimated versus actual timing and costs.

**Tip**

You can modify this table so that the Baseline Duration column is next to the Actual Duration column and Baseline Cost is next to Actual Cost.
The default Tracking Gantt table also contains the following information:

✦ **% Complete**: This field shows the progress of various tasks in the schedule. Figure 11-9 shows that one task is complete.

✦ **Physical % Complete**: A field that you can use to calculate BCWP (budgeted cost of work performed). Project calculates the % Complete field for you based on Total Duration or Actual Duration values you enter, but Project allows you to enter a value for the Physical % Complete field. Use this field to calculate BCWP when the % Complete value would not accurately represent the real work performed on a task.

✦ **Remaining Duration**: This field reflects the amount of time needed to complete an unfinished task. You can enter a value into this field or you can allow Project to calculate it for you by entering a value into either the Actual Duration field or the % Complete field. If you enter a value for Remaining Duration, Project calculates a new % Complete value and a new Duration value; Project changes the Duration value to equal the sum of Actual Duration and Remaining Duration, leaving Actual Duration untouched.

✦ **Actual Work**: In the Actual Work field, you’ll see the amount of work that has been performed by resources. There are Actual Work fields for tasks, resources, and assignments, as well as time-phased Actual Work fields for tasks, resources, and assignments.

You also can display the task bars by manipulating the divider between the table and chart areas to get a graphic view of progress on the project. Figure 11-9 displays the Tracking Gantt view with the Schedule table. The Tracking Gantt displays various styles of task bars to indicate progress on tasks in the project. At the top of the Gantt Chart, you see the summary task for the project, and below it, you see a black-and-white hatched bar. That bar represents progress on the summary task. The noncritical tasks are shown in blue, and critical tasks are in red.

On all tasks that aren’t summary tasks, you see two bars; the top bar represents expected duration, and the bottom bar represents baseline duration.

The percentage indicator at the edge of a task reflects the percentage complete for that task. The top bars of completed tasks, such as the Dig the hole task, are solid in color, while the top bars of incomplete tasks, such as the Build the deck task, are patterned and appear lighter in color. The bars of partially completed tasks, such as the Pour the pool task, are solid on the left and patterned on the right.

You also can tell at a glance if a task completed earlier or later than estimated. Look at the Dig the hole task; the top bar (actual duration) is shorter than the bottom bar (baseline duration).
Figure 11-9: Various task bar styles and color codes display the project's progress and variances.

The Task Variance table

As you change the tables that are displayed in the Tracking Gantt view, you see different information about your progress in the project. The Variance table, for example, highlights the variance in task timing between the baselines and actuals. To display this table, shown in Figure 11-10, right-click the Select All button in the upper-left corner of the table where the row containing column headings and the task number column meet. Select Variance from the list of tables that appears.

You can easily compare the Baseline Start and Baseline Finish and the actual Start and Finish columns that show actual data for tasks on which you have tracked
progress as well as baseline data for tasks with no progress. This table also contains fields to show you the Start Variance (how many days late or early the task started) and the Finish Variance (how many days late or early the task ended).

![Microsoft Project - 0514.mpp](image)

**Figure 11-10:** If you’re behind schedule, you can easily see the awful truth in the Variance table.

### The Task Cost Table

The Task Cost table is most useful for pointing out variations in money spent on the project. Figure 11-11 shows a Task Cost table for a project in progress, with some costs incurred and others yet to be expended. At this point, the Pour the pool task is exceeding its projected cost by $400. Project takes the following factors into account when calculating cost variations:

- Actual resource time worked
- The estimate of days of resource time still to be expended to complete the task
- Actual costs (such as fees and permits) that have been tracked on the task
Figure 11-11: The Task Cost table shows where you’ve spent too much and where you have a lot more money to spend.

Compared to a baseline estimate of $1600.00, the Pour the pool task is over budget.

**The Task Work table**

The Task Work table of the Tracking Gantt view, as shown in Figure 11-12, focuses on the number of work hours put in by resources that are working on tasks. For example, the Baseline work for the Pour the pool task was 64 hours. However, the task is only partially complete and has taken 94 hours. Therefore, the Variance field (the difference between the baseline hours of work and the actual hours spent) shows a loss of 30 hours. On the other hand, the Baseline estimate for the Dig the hole task was 32 hours, and the task was completed in 30 hours. The Variance column shows a saving of 2 hours; the negative value indicates that fewer hours were used than were estimated in the baseline.

You’ll see many of these tables and more tracking views as you work through the next few chapters. At this point, you should have a good idea of the types of information that you can get by tracking progress on your project.
Figure 11-12: To determine whether a task is taking much more effort than you estimated, check the Task Work table.

Understanding Tracking Strategies

As you use Microsoft Project on real projects, your tracking skills will improve. However, if you follow certain basic principles of tracking from the start, you can save yourself a lot of aggravation in your first few projects.

Tackling the work of tracking

First, update your project schedule frequently and at regular intervals. Many people see tracking as a monumental task: All the details of each task's progress and duration, as well as all the resources and costs that are associated with each task, must be entered one by one. You have to gather that data through resource timecards, reports from other project participants, and vendor invoices. You must type in all the information that you gather. I won't kid you: Tracking can be hard work. However, the more often you track, the less the tracking data will pile up, and the less likely it is to overwhelm you.
Help yourself with the tracking task by assigning pieces of the updating to various people in your project. If a particular resource is in charge of one phase of the project, have him or her track the activity on just that phase. You can use various methods of compiling those smaller schedules into a master schedule.

Part V of this book provides ideas for compiling several schedules and managing schedules with workgroups.

If you have a resource available, such as an administrative assistant who can handle the tracking details — all the better. Make sure that you provide this assistant with appropriate training (and a copy of this book) so that he or she understands the tracking process well enough to be accurate and productive. However, this resource probably does not need to be a Project expert to take on some of the work.

To help you remember to track, enter tracking as a recurring task, occurring once every week or two, within your project file. And don’t forget to include required meetings (such as progress meetings and performance reviews) in your schedule.

**Keeping track of tracking**

Using task notes to record progress and changes can be another good strategy for effective tracking. If an important change occurs that doesn’t merit changing your baseline, use the task notes to record it. When you reach the end of the project, these notes help you to document and justify everything from missed deadlines to cost overruns.

Try to set some standards for tracking in your organization. For example, how do you determine when a task is complete? How do you measure costs, and what is the source of information on resource time spent on a task? Project becomes a much more effective management tool if each project manager uses identical methods of gauging progress and expenditures, just as your company’s accounting department uses standards in tracking costs.

Setting multiple baselines is useful, but how do you decide when to save each iteration? You may want to consider setting a different baseline for each major milestone in your project. Even long projects usually have only four or five significant milestones, and they are likely to occur after you have accomplished a sizeable chunk of work.
Summary

This chapter explored some of the fundamental concepts of tracking activity on a project. You became familiar with the following:

✦ How to set, modify, and clear baselines
✦ How to view your baseline estimates against actual progress

Chapter 12 covers the mechanics of tracking, recording the actuals, and streamlining the entry of this data.
Recording Actuals

Actuals represent what has, in fact, occurred during your project. In Microsoft Project, you can record actual information about the cost of a task and about the time that was spent completing the task. By recording actual information, you accomplish the following things:

✦ You let Project automatically reschedule the remainder of your project.
✦ You provide management with a way to measure how well your project is going.
✦ You provide yourself with valuable information on your estimating skills — information that you can apply to the remainder of the current project and to your next project.

Organizing the Updating Process

Before you launch into the mechanics of updating a project, you should take a moment to examine the updating process. Updating a project can become complicated, particularly for large projects with many resources assigned to them. You need to establish efficient manual procedures for collecting information in a timely fashion, and then you need to determine the best ways to enter that information into Project.

Individuals working on tasks should answer the following questions regularly:

✦ Is the task on schedule?
✦ How much is done?
✦ Is a revised estimate available on the duration of the task?
✦ Is a revised estimate available on the work that is required to complete the task?
If your organization has forms and processes in place to capture actuals and status information, use those forms and processes as much as possible. While the organization’s forms and processes may not currently capture project information, sometimes it is easier to ask for a little more information using current forms than it is to create new forms and processes.

You may want to create a form for participants to use for their regular reports. Their reports should provide the information that you need to update your project plan in Project. You may be able to use one of the reports in Project (or customize one of Project’s reports) to provide the necessary information.

If you use Project in an e-mail workgroup or you use Project Server, you can take advantage of electronic reporting capabilities. See Chapters 16, 18, and 19 for more information.

You also should decide how often you need to receive the collection forms. If you request the reports too frequently, your staff may spend more time reporting than working. On the other hand, if you don’t receive the reports often enough, you won’t be able to identify a trouble spot early enough to resolve it before it becomes a major crisis. As the manager, you must decide on the correct frequency for collecting actual information for your project.

You can use the timephased fields in Project to track actual work and costs on a daily or weekly basis. Read more about timephased cost tracking in the section “Tracking work or costs regularly,” later in this chapter.

When you receive the reports, you should evaluate them to identify unfinished tasks for which you need to adjust the planned duration, work, and costs. You’ll find that these adjustments are easiest to make if you make them before you record a task’s actual dates or percentage of completion.

Also, remember that recording actual information enables you to compare estimates to actuals; this comparison often proves to be quite valuable. To make this comparison, make sure that you set a baseline for your project.

See Chapter 11 for more information on setting baselines.

**Understanding Calculation Options**

You need to understand the calculation options that you can set in Project — they affect the “bottom line” of both the project’s cost and schedule. You can review and change calculation options on the Calculation tab of the Options dialog box. Choose Tools ➪ Options to display the Options dialog box, and then click the Calculation tab, as shown in Figure 12-1. In the paragraphs that follow, I describe the various options that you see in this figure.
Calculation Mode and Calculate options: You can control when Project calculates changes that you make to the project; if you choose Automatic, Project updates your project as you make changes. If you choose Manual, Project reopens the Options dialog box and you can click the Calculate Now button to update your project. You also can choose to apply the calculation mode to all open projects or only to the active project. Automatic calculation is the default, but if your project is very large, calculating can take quite a while; under these circumstances, you may want to switch to manual calculation to save time. When your project is set to manual calculation and you make a change that requires recalculation, you see Calculate in the status bar — a reminder to calculate the project when you finish making changes.

Updating task status updates resource status check box: Select this box to have Project update resource status to correspond with any updated task status. (This option works in reverse, too. If you update a resource’s status, Project also updates task status accordingly.) Suppose, for example, that you update the percentage of completion for a task. When you select this box, Project also updates the % Complete field for the resource and the assignment.

You can set calculation options that make Project change task start dates and adjust remaining portions of tasks when tasks begin early or late.
Adjusting for late or early starts: By default, when tasks begin late or early, Project doesn’t change the task start dates or adjust the remaining portions of tasks. The following four check boxes are new to Project 2003 and enable you to change this default behavior so that Project updates the tasks in relation to the Status Date:

- Move end of completed parts after status date back to status date
- And move start of remaining parts back to status date
- Move start of remaining parts before status date forward to status date
- And move end of completed parts forward to status date

You can find the project’s status date in the Project Information dialog box (choose Project ➤ Project Information). If the status date isn’t set, Project uses the current date.

The check boxes work in pairs — that is, the first two check boxes work together, and the second two check boxes work together. To better understand Project’s behavior and the first pair of check boxes, suppose that the Status Date is December 9 and you have a task with a Start Date of December 14 and a duration of 4 days. Furthermore, suppose that the task actually starts on December 7. If you select the first check box, Project moves the task start date to 12/7, sets the percent complete to 50%, and schedules the start of the remaining work for 12/16 — thus creating a split task. If you also select the second check box, Project makes the changes that I just described and moves the start of the remaining work to 12/9.

Now consider the second pair of check boxes. Again, suppose that the Status Date is December 9 and you have a task with a Start Date of December 1 and a duration of 4 days. Furthermore, suppose that the task actually starts on December 7. If you select the third check box, Project leaves the task start date at 12/1, sets the percent complete to 50%, and schedules the start of the remaining work for 12/9 — again creating a split task. If you also select the fourth check box, Project makes the changes that I just described but also moves the task’s actual start date to 12/7.

Note that these options don’t apply when you record actual information on Summary tasks. These options only apply when you make total actual value edits, including task total actual work, task actual duration, total percent complete, and percent work complete. The settings of these check boxes don’t apply if you use timesheet information from Project Server to update your project.

Earned Value button: Click this button to set earned value options for the project.

Cross-Reference
See Chapter 14 for more information about earned value.
Edits to total task % complete will be spread to the status date check box: By default, this box is not selected, which makes Project distribute changes to the task percentage of completion to the end of the actual duration of the task. If you select this check box, Project, instead, distributes the changes evenly across the schedule to the project status date.

Inserted projects are calculated like summary tasks check box: When this box is selected (as it is by default), Project treats inserted projects like summary tasks when calculating the project schedule, instead of treating them like a separate project.

Actual costs are always calculated by Microsoft Office Project check box. When you select this check box, Project calculates actual costs. You can’t enter actual costs until a task is 100% complete — Project will overwrite any costs that you enter prior to 100% completion as it recalculates costs. You also can’t import actual cost values.

Default fixed costs accrual list box: Use this list box to choose a method for Project to accrue fixed costs for new tasks. You can have Project accrue fixed costs at the start of a task or at the end of a task, or you can prorate the costs throughout the duration of the task.

Calculate multiple critical paths check box: When you select this check box, Project calculates and displays separate critical paths in the project — and sets the late finish date for tasks without successors or constraints to their early finish date. By changing the finish dates of these tasks, Project makes these tasks critical. When you deselect this box, Project sets the late finish date for these tasks to the project finish date, which leaves these tasks off the critical path.

Tasks are critical if slack is less than or equal to x days list box: By default, Project sets this value to 0 — only tasks with no slack appear on the critical path. You can force tasks in your project onto the critical path by increasing this value.

Set as Default button: The calculation options listed at the top of the box apply to all projects. While all other options shown in Figure 12-1 apply only to the project you are currently viewing, you can make them apply to all projects by clicking the Set as Default button.

Throughout the rest of this chapter, I use the default settings in Project to demonstrate the effects of updating a project.
Updating Tasks to Reflect Actual Information

You can record actual information for a project by filling in the following fields for each task that tracks the progress of your project:

- Actual start date
- Actual finish date
- Actual duration
- Remaining duration
- Percentage complete

The fields mentioned above are one possible set of fields that you can use to record actual information; there are other alternatives. For example, some people focus on updating only Actual Work and Remaining Work; in this case, Project updates the fields listed above.

In some cases, when you enter information into one of these fields, Project calculates the values for the other fields. For example, if you enter a percentage complete for a task, Project calculates and supplies a start date, an actual duration, a remaining duration, and an actual work value.

Setting actual start and finish dates

The Gantt Chart view displays projected start and finish dates for tasks. In this section, you find out how to enter and view actual start and finish dates (and compare current, baseline, and actual dates) in the Task Details view, as shown in Figure 12-2.

Starting from the Gantt Chart view, follow these steps to set up your screen:

1. Choose Window ➪ Split to display the Task Form view.
2. Click the bottom pane.
3. Choose View ➪ More Views to open the More Views dialog box.
4. Select Task Details Form, and click Apply.
5. Select the task (in the top pane) for which you want to record actuals.
6. Select the Actual option button in the bottom pane to identify the type of dates that you want to enter.
   The three option buttons (Current, Baseline, and Actual) refer only to the dates that you can view and set. In other words, you don’t see baseline assignments at the bottom of the view if you click Baseline.
7. Record either a Start or a Finish date, and click OK.
Project initially sets the Actual Start Date and Actual Finish Date fields to NA to indicate that you have not yet entered a date. When you update your project to provide actual start and finish dates, Project changes the projected start and finish dates to the actual dates that you enter. When you enter an actual start date, Project changes only one other field — the projected start date. However, when you enter an actual finish date, Project changes several other fields: the Percent Complete field, the Actual Duration field, the Remaining Duration field, the Actual Work field, and the Actual Cost field. If you didn’t set an actual start date, Project also changes that field.

**Recording actual durations**

The actual duration of a task is the amount of time that was needed to complete the task. To record an actual duration, you can use the Update Tasks dialog box. Choose Tools ➪ Tracking ➪ Update Tasks or click the Update Tasks button on the Tracking toolbar to display the Update Tasks dialog box, as shown in Figure 12-3.

**Tip**

You can display the Tracking toolbar by choosing View ➪ Toolbars ➪ Tracking.
When you set an actual duration that is less than or equal to the planned duration, Project assumes that the task is progressing on schedule. Therefore, when you click OK, Project sets the actual start date to the planned start date — unless you previously set the actual start date. In that case, Project leaves the actual start date alone. In either case, Project calculates the percentage complete and the remaining duration for the task.

To see the updated remaining duration, reopen the Update Tasks dialog box.

If you set an actual duration that is greater than the planned duration, Project assumes that the task is finished but that it took longer than expected to complete. Project adjusts the planned duration to match the actual duration and changes the Percent Complete field to 100% and the Remaining Duration field to 0%.

You can use the Calculation tab in the Options dialog box (choose Tools ➪ Options) to set Project to update the status of resources when you update a task’s status. If you set this option and then supply an actual duration, Project also updates the work and cost figures for the resources.

You find out more about this option in the section “Overriding resource cost valuations,” later in this chapter.

Don’t change the actual duration of a task if you use effort-driven scheduling. Instead, change the number of resource units that are assigned or the amount of the resource assignment. Remember that the duration of effort-driven tasks is affected by resource assignments.

**Setting remaining durations**

In the two preceding sections, you saw that you can use the Task Form Details view and the Update Tasks dialog box to record and view actual information. The Task Form Details view provides a limited way to update tasks. Although the Update
Tasks dialog box provides a complete way to enter actual information, I find that it’s easiest to enter all actual information into Project by using the Tracking Table view, as shown in Figure 12-4.

![Figure 12-4: The Tracking Table view helps you view and enter actual values for tasks.](image)

The Rem. Dur. (Remaining Duration) column shows how much more time you need to complete a task. To display the Tracking Table view, start in the Gantt Chart view and follow these steps:

1. Click the top pane of the Gantt Chart.
2. Choose Window ➪ Remove Split to display the standard Gantt Chart.
3. Right-click the Select All button, and choose Tracking from the menu that appears. Project displays the Tracking Table view in the left portion of the Gantt Chart view.

To see all the columns that are available on the Tracking Table view, narrow the chart portion of the window.

If you enter a value into the Rem. Dur. (Remaining Duration) column, Project assumes that the work has begun on the task and will be completed based on the remaining duration value. Therefore, Project sets the Act. Dur. (Actual Duration)
and % Comp. (Percent Complete) values based on a combination of the remaining
duration value that you supplied and the original planned duration. If necessary,
Project also sets the actual start date. If you set Project’s options to update the sta-
tus of resources when you update a task’s status, Project updates the work and cost
figures for the resources on the task.

Entering 0 in the Rem. Dur. (Remaining Duration) column is the same as entering
100% in the Percent Complete column. For example, suppose that you change the
value in the Remaining Duration column so that it is higher than the existing figure.
Project assumes that you are changing the planned duration of the task instead of
tracking actual progress for the task. In this case, Project adjusts the schedule
based on the new planned duration. If the task has already started and you have
entered an actual duration when you make the Remaining Duration value higher,
Project adds this new estimate to the previously calculated actual duration and
adjusts the Percent Complete value.

**Setting the Percent Complete value**

You can establish the progress of work performed on a task by assigning a Percent
Complete value to the task. Any value less than 100 indicates that the task is not
complete. You can set Percent Complete value from the Task Details form, from the
Update Tasks dialog box, or from the Tracking Table view. Or, you can select the
task from any task view and use the percentage buttons on the Tracking toolbar, as
shown in Figure 12-5. Right-click any toolbar, and choose Tracking to display the
Tracking toolbar.

A value in the Percent Complete column also affects the Actual Duration and
Remaining Duration values. If you make an entry into any of these columns, Project
automatically updates the others. When you set the Actual Duration value, Project
calculates the value for the Percent Complete column by dividing the Actual
Duration value by the original planned duration. If, alternatively, you set the
Remaining Duration value, Project recalculates (if necessary) the Actual Duration
value and the Percent Complete value.

If you change the Percent Complete value, Project assigns an Actual Start Date
(unless you had entered one previously). Project also calculates the Actual
Duration and Remaining Duration values. If you set your options to update
resources when you update tasks, Project also calculates the Actual Cost and
Actual Work values. If you enter 100 in the Percent Complete column, Project assigns the planned finish date to the Actual Finish Date column. If this value is not correct, don’t enter a Percent Complete value; instead, enter an Actual Finish Date.

**Setting work completed**

Sometimes, you must schedule tasks based on the availability of certain resources. In these cases, tracking progress on a task is easiest if you update the work completed. Updating this value also updates the work that each resource is performing.

In the same way that Project calculates duration information when you fill in a duration field, Project updates the work remaining by subtracting the work performed from the total work scheduled.

Use the Tracking Table view to enter information into the Act. Work (Actual Work) column, but start in the Task Usage view so that you can enter actual work performed for specific resources. Choose View ➪ Task Usage, right-click the Select All button, and choose Tracking from the shortcut menu that appears. You’ll probably need to drag the divider bar almost completely to the right edge of the screen to reveal the Act. Work column, as shown in Figure 12-6.

![Figure 12-6: The Tracking Table view with resources displayed.](image-url)
If you are scheduling tasks based on the availability of resources in general, instead of the availability of specific resources, you can still use this technique to record actual work. However, you need to enter the value on the same row as the task, rather than on the individual rows for the resources. Project divides the actual and remaining work among the resources.

Project calculates some of the fields that store actuals when you enter information in other fields that store actuals. For this reason, I recommend that you create your own version of the Tracking table that displays the fields into which you will enter information in contiguous columns. Placing the fields together on a customized Tracking table will make your data entry much easier — and provide an easy way for someone other than you to enter the data. See Chapter 6 for details on customizing a table. You might want to consider including the project’s status date and the current date on your tracking table to help you easily find any tasks not completed prior to the status date, identifying work that needs to be rescheduled. To include this information, you need to create custom fields.

For information on creating custom fields, see Chapter 23.

On the CD, you’ll find the Status Date Field and Current Date Field Example.mpp file, which contains the formulas you need to create these fields. On each field's column heading, right-click and choose Customize Fields to open the Customize Fields dialog box; then, click the Formula button to view the formula for that field.

### Using Actuals and Costs

Except for fixed-cost tasks, Project uses the cost of the resources that are assigned to the task over the duration of the task to calculate a task’s cost. Costs are accrued, and total project costs are the sum of all resource and fixed costs. Therefore, if you previously set up and assigned resources to your tasks, Project has been calculating and accruing the costs for you — all you need to do is review and analyze the costs.

Alternatively, you may have chosen not to assign resources to your tasks, or you may have changed your default options so that Project wouldn’t calculate costs. How can you do that? Choose Tools ➤ Options to display the Options dialog box. On the Calculation tab, look at the Calculation options for your project, as shown in Figure 12-7. If the Updating task status updates resource status check box is not selected, Project has not been calculating your project’s costs. Remember, however, that this check box is selected by default, as you see in the figure.
Recording Actuals

If you did not assign resources or you changed the defaults, Project can’t calculate the cost of your project unless you provide additional information after the task is completed. You can review and update your project’s costs from one of two cost tables: the Cost table for tasks or the Cost table for resources. You can also override the costs that Project assigns.

Using the Cost table for tasks

The Cost table for tasks, shown in Figure 12-8, demonstrates cost information based on each task in your project. This table shows you the baseline cost (the planned cost), the actual cost, the variance between planned and actual costs, and the remaining cost of the task.

If you assign a fixed cost to a task in this table, Project adds the fixed cost to the calculated cost for the task. To display this table, start in the Gantt Chart view. Then right-click the Select All button to display the shortcut menu of tables, and choose Cost. You may also need to slide the chart pane all the way to the right to see all the fields on the Cost table for tasks.
Figure 12-8: The Cost table for tasks.

The Cost table for tasks is most useful if you saved a baseline view of your project, because it enables you to compare baseline costs with actual costs.

Using the Cost table for resources

The Cost table for resources is similar to the Cost table for tasks, with the breakdown of costs being displayed by resource rather than by task, as shown in Figure 12-9.

To display this table, begin with a resource view such as the Resource Sheet view. Then, right-click the Select All button and choose Cost from the shortcut menu that appears.

Like the Cost table for tasks, the Cost table for resources is useful if you saved a baseline view of your project, because it enables you to compare baseline costs with actual costs.
Overriding resource cost valuations

Project’s default settings automatically update costs as you record progress on a task. Project uses the accrual method that you selected for the resource when you created the resource.

For more information about setting a resource’s accrual method, see Chapter 5.

Alternatively, you can enter the actual costs for a resource assignment, or you can track actual costs separately from the actual work on a task. To do so, after the task is completed, you must enter costs manually to override Project’s calculated costs. Before you can override the costs that Project calculated, however, you must turn off one of the default options. Follow these steps to adjust Project’s default settings so that you can override calculated costs:

1. Choose Tools ➪ Options to display the Options dialog box.
2. Click the Calculation tab.
3. Deselect the Actual costs are always calculated by Microsoft Office Project check box, as shown in Figure 12-10.

![Options dialog box](image)

**Figure 12-10:** Revise the default settings to override Project's calculated costs.

The Edits to total actual cost will be spread to the status date check box becomes available. Select this box if you want Project to distribute the edits that you're going to make through the Status Date. If you deselect the box, Project distributes the edits to the end of the actual duration of the task.

4. Click OK.

5. Choose View ➪ Task Usage.

6. Right-click the Select All button to display the table shortcut menu, and choose Tracking. Project displays the Tracking Table view, as shown in Figure 12-11.

7. Drag the divider bar to the right so that you can see all the columns.

8. Select the task or resource to which you want to assign a cost.

9. Enter the cost in the Act. Cost (Actual Cost) column.

**Tip**

If you change your mind and want Project to calculate costs as it originally did, repeat Steps 1 and 2 to display the Calculations tab of the Options box and select the Actual costs are always calculated by Microsoft Office Project check box to restore the default calculation method. Project warns you that it will overwrite any manually entered costs when you click OK.
Techniques and Tips for Updating

Project users can find ways to accelerate the updating process. For example, you can do the following:

- Use Project’s timephased fields to easily update your project on a regular basis
- Update the progress of several tasks simultaneously
- Reschedule incomplete work so that it starts on the current date

You can speed up the data entry process if you create a custom Tracking table that groups the fields into which you enter actual information. You might want to consider including the project’s status date and the current date on your tracking table to help you easily find any tasks not completed prior to the status date, identifying work that needs to be rescheduled. To include this information, you need to create custom fields.

See Chapter 6 for details on creating customized tables. For information on creating custom fields, see Chapter 23.

![Figure 12-11: The Tracking Table view with the Act. Cost (Actual Cost) column visible.](image-url)
On the CD, you’ll find the Status Date Field and Current Date Field Example.mpp file, which contains the formulas you need to create these fields. On each field’s column heading, right-click and choose Customize Fields to open the Customize Fields dialog box; then, click the Formula button to view the formula for that field.

**Tracking work or costs regularly**

Project’s timephased fields enable you to update the progress of your project on a regular basis, such as daily or weekly. To use timephased fields to record progress information for resources, start by displaying the Resource Usage view (choose View ➪ Resource Usage). Then right-click the Select All button, and select Work from the shortcut menu that appears to change the table. Your screen should resemble Figure 12-12.

![Figure 12-12: Preparing to use timephased fields.](image)

You’re going to want to use most of the right side of the view, but on the left side of the view, you really need only the Actual Work column, which is hidden by the right side of the view. You can slide the divider bar over to the right, but then you would lose the right side of the view. Or, after sliding the divider bar, you can hide all the columns between the Resource Name column and the Actual Work column — to redisplay them, you need to insert each of them.
To set up the left side of the view so that you can see the Actual Work column, insert that column between the Resource Name column and the % Comp. (Percent Complete) column. To insert the column, follow these steps:

1. Click the title of the Percent Complete column to select the entire column.
2. Choose Insert➪Column to open the Column Definition dialog box, as shown in Figure 12-13.

![Figure 12-13: Add the Actual Work column from the Column Definition dialog box.](image)

3. Open the Field name drop-down list and select Actual Work.
4. Click OK.

Project inserts the Actual Work column to the left of the % Comp. column and to the right of the Resource Name column.

Next, you should decide how often you want to update your project. To update daily, you don’t need to make any changes to the timescale on the right side of the window. But if you want to update weekly (or with some other frequency), you need to change the timescale. To change the timescale, choose Format➪Timescale.

Project opens the Timescale dialog box, as shown in Figure 12-14. This example doesn’t require any timescale changes, but if you wanted to change the timescale to weekly (for example), choose a tier, open the Units list box, and select Weeks. Then hide the other tiers using the choices in the Show list box in the Timescale options section on any tier’s tab.

When you add a timephased field for Actual Work, you can see the results as you update the schedule. Choose Format➪Details➪Actual Work. Project adds a row for every task on the right side of the view. To enter hours worked for a particular day, click the letter of the column representing that day to select the entire day, as shown in Figure 12-15. Then enter the hours for the correct resource and task in the Actual Work column that you added on the left side of the view.

![Note](image)

Remember, however, that you can’t add costs to override Project’s automatically calculated costs unless you open the Options dialog box (choose Tools➪Options), select the Calculation tab, and deselect the Actual costs are always calculated by Microsoft Office Project check box.
Figure 12-14: Use the Timescale dialog box to change the increments that appear on the right side of the Resource Usage view.

Figure 12-15: Add actual work information for a specific day.

This entire process also works if you are updating costs on a daily basis, with the following minor changes:
✦ Begin in the Task Usage view instead of the Resource Usage view.
✦ Add the Tracking table instead of the Work table.

To hide the Actual Work column that you added to the left side of the view, select the entire column and then choose Edit ➪ Hide Column. The left side of the view returns to its default appearance. To hide the Actual Work row that you added to the right side of the view, choose Format ➪ Details ➪ Actual Work again and remove the check mark from Actual Work.

Accelerating the updating process

If you have several tasks that are on schedule or were completed on schedule, you can update these tasks all at once by following these steps:

1. Select the Gantt Chart view.

   Tip
   If you want to update the entire project, don’t select any tasks.

2. In the Task Name column, select the tasks that you want to update. For example, Figure 12-16 shows three tasks selected for updating.

Figure 12-16: Selecting tasks to update.
You can select tasks by using the same techniques that you use in Windows Explorer. To select two or more contiguous tasks, click the first task, hold down Shift, and click the last task. To select two or more noncontiguous tasks, hold down Ctrl as you click each task that you want to select.

3. Choose Tools ➪ Tracking ➪ Update Project to display the Update Project dialog box, as shown in Figure 12-17.

![Figure 12-17: Use the Update Project dialog box to update your project.](image)

4. Make sure that the correct date appears in the list box next to the Update work as complete through option button.

5. Select one of the following:
   - Set 0% – 100% complete: This tells Project to calculate the Percent Complete for each task.
   - Set 0% or 100% complete only: Select this option to have Project mark completed tasks with 100% and leave incomplete tasks at 0%.

6. Specify whether to update the entire project or selected tasks by selecting the appropriate option.

7. Click OK.

When you select the Entire project option in Step 6 and update your project, Project sets the project status date to the date that you selected in Step 4.

### Letting Project reschedule uncompleted work

If you updated your project and you had partially completed tasks, you can guarantee that no remaining work is scheduled for dates that have already passed. You can make sure that all remaining work is scheduled for future dates by rescheduling the work to start on the current date.

In Project 2000 and earlier, if you rescheduled work by using the technique that I describe in this section, Project would remove task constraints that you applied. For example, suppose that you rescheduled the work of a task that had a Must Finish On constraint, and rescheduling moved the finish date beyond the constraint date.
Project 2000 and earlier did not honor the constraint date; instead, these versions changed the constraint to As Soon As Possible. To preserve a task’s constraints, you had to reschedule the remaining work manually.

Starting in Project 2002, Project does not remove constraints and reschedule tasks without progress. However, be aware that this behavior may leave your project in an infeasible situation. Project displays a message if this situation occurs, and you can manually make changes as needed.

Follow these steps to tell Project to reschedule remaining work for future dates:

1. Select the Gantt Chart view.
2. Go to the Task Name column, and select the tasks that you want to update. See the previous section for techniques that you can use to select tasks.
3. Choose Tools ➪ Tracking ➪ Update Project to open the Update Project dialog box, as shown in Figure 12-18.

![Figure 12-18: Use this dialog box to reschedule incomplete work to start today.](image)

4. Select the Reschedule uncompleted work to start after option button, and choose the date from which you want to reschedule all unfinished work.

Project 2000 introduced the ability to set a date from which you wanted to reschedule uncompleted work. However, suppose that you rescheduled work twice; Project 2000 ignored all dates except the first rescheduling date that you supplied. Starting in Project 2002, Project reschedules selected tasks or your project each time that you change the date.

5. Specify whether to update the entire project or selected tasks by selecting the appropriate option button.
6. Click OK.

When you reschedule a partially completed task by using the technique just described, Project automatically splits the task between the completed portion and the remaining portion. Therefore, the Gantt Chart may display a split task that has a gap between its two parts because the completed portion may have finished sometime before the remaining portion is scheduled to start.
Reviewing Progress

When you start recording actuals, you're going to want to review the progress of your project — and Project can help you.

Using the Tracking Gantt view

The Tracking Gantt view, shown in Figure 12-19, uses the Entry table and probably provides the most effective picture of your project’s progress. The bottom bar on the chart portion of the view (black hatching on your screen) represents the baseline dates for each task. The top bar spans either the scheduled start and finish dates or (if a task has been completed) the actual start and finish dates for each task.

Figure 12-19: The Tracking Gantt view helps you understand the progress of your project.

Tip

If a task is finished, a check mark appears in the Indicator column on the left side of the view next to the task.
Project formats the task bar to indicate the task’s status as follows:

✦ If a task is scheduled, but not yet complete, the top bar appears as blue hatching (it appears red if the task is on the critical path).

✦ If the task is complete, the bar appears solid blue (it appears red if the task is on the critical path).

✦ If a task is partially complete, the completed portion appears as solid blue in the top bar, but the unfinished portion appears as blue hatching (red hatching appears if the task is on the critical path).

Using the Work table for tasks

The Work table for tasks, shown in Figure 12-20, shows the total time that is required from all resources to complete the task. Work differs from task duration in the following ways:

✦ Work measures how many hours of effort are needed to complete a task.

✦ Task duration measures the amount of time (number of days) that is allotted to the task.

![Figure 12-20: The Work table for tasks.](image-url)
If the total work for a task is 16 hours but the task duration is only one day, you either need to add another resource (meaning that two people can complete the task in one day) or extend the task’s duration.

The Work table for tasks includes baseline information so that you can compare your progress to your original estimate. For this table to be meaningful, therefore, you must have saved a baseline for your project. And as you may have guessed, you can enter information in the Work table for tasks.

You can apply the Work table for tasks to any task sheet view. For example, in Figure 12-20, the Work table appears on the left side of the Task Usage view. Choose View ➪ Task Usage; then right-click the Select All button and choose Work from the shortcut menu that appears.

**Using the Work table for resources**

The Work table for resources, shown in Figure 12-21, demonstrates work information for resources. Again, work represents the total time that is required from all resources to complete the task. The Work table for resources also includes baseline information so that you can compare your progress to your original estimate.
You can apply the Work table for resources to any resource sheet view. In Figure 12-21, for example, the Work table for resources appears on the left side of the Resource Usage view. Select the Resource Usage view from the View bar; then right-click the Select All button and choose Work from the shortcut menu that appears.

**Viewing progress lines**

Project contains another tool that you can use to show the progress that you’re making on your project — if you have saved a baseline of your project. If you add progress lines to the Gantt Chart of your project, as shown in Figure 12-22, Project draws a line that connects in-progress tasks. The progress line creates a graph of your project with peaks pointing to the right for work that is ahead of schedule and peaks pointing to the left for work that is behind schedule. The distance between the peaks and the line indicates the degree to which the task is ahead of or behind schedule.

![Image of a Gantt Chart with a progress line added.](image)
To add a progress line, follow these steps:

1. Choose View ➪ Gantt Chart.
2. Choose Tools ➪ Tracking ➪ Progress Lines to open the Progress Lines dialog box and display the Dates and Intervals tab.
3. Select the Display selected progress lines check box to activate the Progress Line Dates list.
4. Click once in the Progress Line Dates list. Project displays a list box arrow.
5. Click the list box arrow, and a small calendar appears, as shown in Figure 12-23.

6. Select a date for the progress line.
7. Select either Actual plan or Baseline plan in the Display progress lines in relation to panel.
8. Click OK.

Project adds the progress line to your Gantt Chart, which looks like the progress line shown previously in Figure 12-22.

As you can imagine, a progress line on a project with a large number of tasks can begin to look messy. But if you decide that you like progress lines, you can display them at varying intervals, as shown previously in Figure 12-23. You also can add specific dates to the Progress Line Dates list on the right side of the Progress Lines dialog box to display multiple progress lines on the Gantt Chart. If you decide to display more than one progress line, you may want to use the Line Styles tab of the
Progress Lines dialog box to format the lines so that you can tell them apart (for example, you can change their colors).

To stop displaying progress lines, reopen the Progress Lines dialog box and deselect any check boxes on the Dates and Intervals tab.

**Summary**

In this chapter, you found out how to record actual information about tasks and resources. For example, you should now be able to do the following:

- Set start and finish dates
- Set actual and remaining durations
- Set the percent complete for a task
- Set the work completed for a task
- Use cost tables for tasks and resources
- Review the progress of your project

Chapter 13 shows you how to report on a project’s progress.
Reporting on Progress

As you saw in Chapters 6 and 7, Project contains various views that help you to evaluate the progress of your project, identify areas with problems, and even resolve problems. Although you can print views, sometimes you need to present information in a format that is not available in any view. This chapter examines the use of reports for presenting your Project information.

Reporting Commonalities

All reports in Project have certain common characteristics. For example, you can print any report or you can review the report on-screen.

Project organizes reports into categories of reports that are related to the same subject; for example, all the cost reports fall into the Costs category.

Follow these steps to display the reports that are available in a particular category:

1. Choose View ➤ Reports to open the Reports dialog box, as shown in Figure 13-1.
2. Click the category of report that you want.
3. Click Select. Project displays the reports that are available in that category.
4. Select a report.
As you read through this chapter and see the reports that are available in each category, you can use the Edit button in the Reports dialog box to change the information that appears on the report. You can also use the Edit button to customize the report, which I discuss near the end of this chapter.

5. Click Select. Project displays the report on-screen in Print Preview mode, as shown in Figure 13-2.

Use the scroll arrows on the toolbar at the top of the screen to move around the report. The Zoom button enlarges the image so that you can read the report’s content on-screen. Or, if you prefer, click the portion of the report that you want to enlarge — the shape of the mouse pointer indicates that it will zoom in on the area that you click. To zoom out again, click the Full Page button or click again on the report. To display more than one page at a time, click the Multiple Pages button.

If you decide to print the report, you can review the page settings first. Click the Page Setup button to display the Page Setup dialog box, as shown in Figure 13-3.

Chapter 6 describes the tabs of the Page Setup dialog box.
Figure 13-2: A report in Print Preview mode.

Figure 13-3: The Page Setup dialog box.
To print a report, click the Print button. Project displays the Print dialog box, as shown in Figure 13-4. Alternatively, you can return to Project by clicking the Close button.

![Print dialog box](image)

**Figure 13-4**: In the Print dialog box, select a print range for the report.

### Looking at the Big Picture

When you select Overview in the Reports dialog box, Project displays the top-level, summary-type reports, as shown in Figure 13-5.

![Overview Reports](image)

**Figure 13-5**: The reports that are available in the Overview category.
Project Summary

The Project Summary report, as shown in Figure 13-6, shows top-level information about your project. This report presents summarized information about dates, duration, work, costs, task status, and resource status.

![Figure 13-6: The Project Summary report.]

Top Level Tasks

The Top Level Tasks report, as shown in Figure 13-7, shows — as of today’s date — the summary tasks at the highest level in your project. You can see scheduled start and finish dates, the percentage complete for each task, the cost, and the work required to complete the task.

![Figure 13-7: The Top Level Tasks report.]

<table>
<thead>
<tr>
<th>ID</th>
<th>Task Name</th>
<th>Duration</th>
<th>Start</th>
<th>Finish</th>
<th>% Comp.</th>
<th>Cost</th>
<th>Work</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Conference</td>
<td>1 day?</td>
<td>Mon 06/02/03</td>
<td>Mon 06/03/03</td>
<td>0%</td>
<td>$0.00</td>
<td>0 hrs</td>
</tr>
<tr>
<td>2</td>
<td>Preplanning</td>
<td>4 days</td>
<td>Mon 06/02/03</td>
<td>Thu 06/05/03</td>
<td>0%</td>
<td>$920.00</td>
<td>55 hrs</td>
</tr>
<tr>
<td>7</td>
<td>Solication</td>
<td>6 days</td>
<td>Mon 06/02/03</td>
<td>Tue 06/03/03</td>
<td>0%</td>
<td>$2,537.00</td>
<td>76.5 hrs</td>
</tr>
<tr>
<td>11</td>
<td>Hire</td>
<td>8 days</td>
<td>Thu 06/06/03</td>
<td>Mon 06/16/03</td>
<td>0%</td>
<td>$2,920.00</td>
<td>132 hrs</td>
</tr>
<tr>
<td>17</td>
<td>Film Entertainment</td>
<td>1 day</td>
<td>Mon 06/02/03</td>
<td>Mon 06/03/03</td>
<td>0%</td>
<td>$240.00</td>
<td>72 hrs</td>
</tr>
<tr>
<td>20</td>
<td>Public Relations</td>
<td>2 days</td>
<td>Tue 06/03/03</td>
<td>Thu 06/12/03</td>
<td>0%</td>
<td>$800.00</td>
<td>48 hrs</td>
</tr>
<tr>
<td>23</td>
<td>Rent Equipment</td>
<td>1 day</td>
<td>Tue 06/03/03</td>
<td>Wed 06/11/03</td>
<td>0%</td>
<td>$0.00</td>
<td>0 hrs</td>
</tr>
</tbody>
</table>
Critical Tasks

The Critical Tasks report, as shown in Figure 13-8, shows the status of the tasks on the critical path of your project — those tasks that make the project late if you don’t complete them on time. This report displays each task’s planned duration, start and finish dates, the resources that are assigned to the task, and the predecessors and successors of the task.

![Figure 13-8: The Critical Tasks report.](image)

Milestones

The Milestones report, as shown in Figure 13-9, shows information about each milestone in your project. If you marked summary tasks to appear as milestones in the Task Information dialog box, summary tasks also appear on this report as milestones. For each milestone or summary task, Project displays the planned duration, start and finish dates, predecessors, and the resources that are assigned to the milestone.

![Figure 13-9: The Milestones report.](image)

Working Days

As Figure 13-10 demonstrates, the Working Days report shows the base calendar information for your project. You can see the name of the base calendar for the project and the working hours that are established for each day of the week, along with any exceptions that you defined.
Chapter 13 ✦ Reporting on Progress

Generating Reports on Costs

When you select Costs in the Reports dialog box, Project displays thumbnail sketches of the reports that describe the costs that are associated with your project, as shown in Figure 13-11.

![Figure 13-11: The reports that are available in the Cost category.](image)

Cash Flow

The Cash Flow report, as shown in Figure 13-12, is a tabular report that shows, by task, the costs for weekly time increments.

If you click Cash Flow in the Cost Reports dialog box (previously shown in Figure 13-11) and then select Edit before you choose Select ➪ Project, the Crosstab Report dialog box opens, as shown in Figure 13-13. On the Definition tab, you can change the time increments.
Figure 13-12: The Cash Flow report.

<table>
<thead>
<tr>
<th>Conference</th>
<th>06/01/03</th>
<th>06/03/03</th>
<th>06/15/03</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preplanning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Determine budget</td>
<td>$720.00</td>
<td></td>
<td></td>
<td>$720.00</td>
</tr>
<tr>
<td>Invitation list</td>
<td>$200.00</td>
<td></td>
<td></td>
<td>$200.00</td>
</tr>
<tr>
<td>Send out invitations</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selection</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Theme</td>
<td>$350.00</td>
<td></td>
<td></td>
<td>$350.00</td>
</tr>
<tr>
<td>Site</td>
<td>$872.50</td>
<td>$177.50</td>
<td></td>
<td>$1,050.00</td>
</tr>
<tr>
<td>Keynote speaker</td>
<td>$1,137.50</td>
<td></td>
<td></td>
<td>$1,137.50</td>
</tr>
<tr>
<td>Hire</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caterer</td>
<td>$320.00</td>
<td>$480.00</td>
<td></td>
<td>$800.00</td>
</tr>
<tr>
<td>Bartenders</td>
<td>$320.00</td>
<td>$160.00</td>
<td></td>
<td>$480.00</td>
</tr>
<tr>
<td>Security</td>
<td>$880.00</td>
<td>$220.00</td>
<td></td>
<td>$1,100.00</td>
</tr>
<tr>
<td>Photographers</td>
<td>$220.00</td>
<td></td>
<td></td>
<td>$220.00</td>
</tr>
<tr>
<td>Cleanup Crew</td>
<td>$320.00</td>
<td></td>
<td></td>
<td>$320.00</td>
</tr>
<tr>
<td>Plan Entertainment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Baseball Game</td>
<td>$160.00</td>
<td></td>
<td></td>
<td>$160.00</td>
</tr>
<tr>
<td>Opera</td>
<td>$80.00</td>
<td></td>
<td></td>
<td>$80.00</td>
</tr>
<tr>
<td>Public Relations</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alert community</td>
<td></td>
<td>$400.00</td>
<td></td>
<td>$400.00</td>
</tr>
<tr>
<td>Press release</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rent Equipment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PA System</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Events</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Baseball game</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Opera</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Meeting</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>$5,260.00</td>
<td>$1,597.50</td>
<td>$160.00</td>
<td>$7,017.50</td>
</tr>
</tbody>
</table>

Figure 13-13: Use the Crosstab Report dialog box to change the default settings for the report.
See the section “Customizing Reports” later in this chapter, for more information about the Crosstab Report dialog box.

## Earned Value

The Earned Value report, as shown in Figure 13-14, shows you the status of each task’s costs when you compare planned to actual costs. Some column headings in this report may seem cryptic; see Table 13-1 for translations.

![Figure 13-14: The Earned Value report.](image)

Even printed in landscape format, the columns of this report don’t fit on one page. The BAC and the VAC columns are missing from the figure; they are printed on Page 2 of the report.

For more information about how Project handles earned value, see Chapter 14.

<table>
<thead>
<tr>
<th>ID</th>
<th>Task Name</th>
<th>BCWS</th>
<th>BCWP</th>
<th>ACWP</th>
<th>SV</th>
<th>CV</th>
<th>EAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Determine budget</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$720.00</td>
</tr>
<tr>
<td>5</td>
<td>Initiation fees</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$200.00</td>
</tr>
<tr>
<td>6</td>
<td>Send out invitations</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$200.00</td>
</tr>
<tr>
<td>8</td>
<td>Briefing</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$200.00</td>
</tr>
<tr>
<td>9</td>
<td>Site</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$1,277.00</td>
</tr>
<tr>
<td>10</td>
<td>Keynote speaker</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$805.00</td>
</tr>
<tr>
<td>11</td>
<td>Colabor</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$805.00</td>
</tr>
<tr>
<td>13</td>
<td>Bartenders</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$805.00</td>
</tr>
<tr>
<td>14</td>
<td>Security</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$1,100.00</td>
</tr>
<tr>
<td>15</td>
<td>Photographe</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$220.00</td>
</tr>
<tr>
<td>16</td>
<td>Cleanup Crew</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$220.00</td>
</tr>
<tr>
<td>18</td>
<td>Baseball Game</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$165.00</td>
</tr>
<tr>
<td>19</td>
<td>Opera</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$605.00</td>
</tr>
<tr>
<td>21</td>
<td>Aspell community</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$805.00</td>
</tr>
<tr>
<td>22</td>
<td>Press release</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$805.00</td>
</tr>
<tr>
<td>24</td>
<td>PA System</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$805.00</td>
</tr>
<tr>
<td>26</td>
<td>Basketball game</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$805.00</td>
</tr>
<tr>
<td>27</td>
<td>Opera</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$805.00</td>
</tr>
<tr>
<td>28</td>
<td>Meeting</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$805.00</td>
</tr>
</tbody>
</table>

Table 13-1: Headings in the Earned Value Report

<table>
<thead>
<tr>
<th>Heading</th>
<th>Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCWS</td>
<td>Budgeted Cost of Work Scheduled</td>
</tr>
<tr>
<td>BCWP</td>
<td>Budgeted Cost of Work Performed</td>
</tr>
<tr>
<td>ACWP</td>
<td>Actual Cost of Work Performed</td>
</tr>
<tr>
<td>SV</td>
<td>Schedule Variance</td>
</tr>
<tr>
<td>CV</td>
<td>Cost Variance</td>
</tr>
<tr>
<td>BAC</td>
<td>Budgeted at Completion</td>
</tr>
</tbody>
</table>

Continued
Table 13-1 (continued)

<table>
<thead>
<tr>
<th>Heading</th>
<th>Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAC</td>
<td>Estimate at Completion</td>
</tr>
<tr>
<td>VAC</td>
<td>Variance at Completion</td>
</tr>
</tbody>
</table>

Project calculates BCWS, BCWP, ACWP, SV, and CV through the project status date. SV represents the cost difference between current progress and the baseline plan, and Project calculates this value as BCWP minus BCWS. CV represents the cost difference between actual costs and planned costs at the current level of completion, and Project calculates this value as BCWP minus ACWP. EAC shows the planned costs based on costs that are already incurred plus additional planned costs. VAC represents the variance between the baseline cost and the combination of actual plus planned costs for a task.

**Budget**

The Budget report, as shown in Figure 13-15, lists all tasks and shows the budgeted costs as well as the variance between budgeted and actual costs.

![Figure 13-15: The Budget report.](image)

This report doesn’t have much meaning unless you have saved a baseline of your project; the values in the variance column change from $0.00 as you complete tasks. Also, the report includes a Remaining column that wouldn’t fit on the same page as the other columns in the figure.

**Overbudget reports**

Project contains two Overbudget reports: one for tasks and one for resources. Neither report prints if you haven’t yet indicated that some tasks are at least
partially completed. Instead, you see the message that appears in Figure 13-16. Overbudget tasks and overbudget resources are described as follows:

Figure 13-16: This message appears when you attempt to print an Overbudget report before you mark any tasks as being at least partially complete.

**Overbudget Tasks:** This report, shown in Figure 13-17, shows cost, baseline, variance, and actual information about tasks that exceed their budgeted amounts. In the figure, the Remaining column is missing because it wouldn’t fit on the first page of the report.

![Microsoft Office Project](image)

**Overbudget Resources:** This report, shown in Figure 13-18, displays resources whose costs are going to exceed baseline estimates, based on the current progress of the project.

![Overbudget Resources report](image)

**Producing Reports on Time**

By using the Current Activities reporting category, you can produce reports on the timing of your project. Click Current Activities in the Reports dialog box. Choose Select to open the Current Activity Reports dialog box, as shown in Figure 13-19, and view the reports that are available in this category.
Unstarted Tasks

The Unstarted Tasks report, as shown in Figure 13-20, lists the tasks that have not yet started, sorted by the scheduled start date. For each task, Project displays the duration, predecessor, and resource information (if you assigned resources).

![Unstarted Tasks report](image)

**Figure 13-20:** The Unstarted Tasks report.
Tasks Starting Soon

When you print the Tasks Starting Soon report, as shown in Figure 13-21, Project displays the Date Range dialog boxes. The information that you provide in these two dialog boxes tells Project the date range to use when selecting tasks for this report. In the first dialog box, specify the earlier date, and in the second dialog box specify the later date, using the mm/dd/yy format. On the report, Project includes tasks that start or finish between the two dates that you specify.

<table>
<thead>
<tr>
<th>ID</th>
<th>Task Name</th>
<th>Duration</th>
<th>Start</th>
<th>Finish</th>
<th>Predecessors</th>
<th>Resource Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Determine budget</td>
<td>4 days</td>
<td>Mon 9/16/03</td>
<td>Thu 9/19/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Date</td>
<td>5 days</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Design</td>
<td>4 days</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Write specification</td>
<td>3 days</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Review</td>
<td>2 days</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Edit</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Test</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Quality assurance</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Final review</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Proofreading</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Final edits</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Final review</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Final edits</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Final review</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Final edits</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Final review</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Final edits</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Final review</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Final edits</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Final review</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Final edits</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Final review</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Final edits</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Final review</td>
<td>1 day</td>
<td>Mon 9/23/03</td>
<td>Thu 9/26/03</td>
<td>Ben Steady</td>
<td></td>
</tr>
</tbody>
</table>

Figure 13-21: The Tasks Starting Soon report.

The information that appears on the report is similar to the information that you find on the Unstarted Tasks report: the duration, start and finish dates, predecessors, and resource information (if you assigned resources). Completed tasks also appear on this report; the check mark that appears in the Indicator column on the report identifies them.

Tasks in Progress

As Figure 13-22 demonstrates, the Tasks in Progress report lists tasks that have started but not yet finished. You see the tasks’ duration, start and planned finish dates, predecessors, and resource information (if you assigned resources).
Completed Tasks

The Completed Tasks report, as shown in Figure 13-23, lists tasks that have completed. You can see the actual duration, the actual start and finish dates, the percent complete (always 100 percent — if a task is only partially complete, it won’t appear on this report), the cost, and the work hours.

Should Have Started Tasks

When you print the Should Have Started Tasks report, as shown in Figure 13-24, you must supply a date by which tasks should have started. Project uses this date to determine which tasks appear on the report.

For each task on the report, Project displays planned start and finish dates, baseline start and finish dates, and variances for start and finish dates. Successor task information appears when a task on the report has a successor defined.
Slipping Tasks

The Slipping Tasks report, as shown in Figure 13-25, lists the tasks that have been rescheduled from their baseline start dates.

This report displays the same information as the information that you saw on the Should Have Started Tasks report, but the presentation of the information changes the focus of your attention.

<table>
<thead>
<tr>
<th>ID</th>
<th>Task Name</th>
<th>Start</th>
<th>Finish</th>
<th>Baseline Start</th>
<th>Baseline Finish</th>
<th>Start Var.</th>
<th>Finish Var.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Conference</td>
<td>Mon 06/2020</td>
<td>Wed 06/2022</td>
<td>Mon 06/2020</td>
<td>Mon 06/2020</td>
<td>0 days</td>
<td>2 days</td>
</tr>
<tr>
<td>2</td>
<td>Preplanning</td>
<td>Mon 06/2030</td>
<td>Mon 06/2023</td>
<td>Mon 06/2030</td>
<td>Mon 06/2030</td>
<td>0 days</td>
<td>7 days</td>
</tr>
<tr>
<td>3</td>
<td>Initial planning</td>
<td>Mon 06/2030</td>
<td>Mon 06/2023</td>
<td>Mon 06/2030</td>
<td>Mon 06/2030</td>
<td>0 days</td>
<td>7 days</td>
</tr>
<tr>
<td>4</td>
<td>Separation</td>
<td>Tue 06/2020</td>
<td>Tue 06/2020</td>
<td>Tue 06/2020</td>
<td>Tue 06/2020</td>
<td>0 days</td>
<td>3.25 days</td>
</tr>
<tr>
<td>5</td>
<td>Keynote speaker</td>
<td>Tue 06/2020</td>
<td>Tue 06/2020</td>
<td>Tue 06/2020</td>
<td>Tue 06/2020</td>
<td>0 days</td>
<td>2.13 days</td>
</tr>
<tr>
<td>6</td>
<td>Mike</td>
<td>Wed 06/2020</td>
<td>Wed 06/2020</td>
<td>Wed 06/2020</td>
<td>Wed 06/2020</td>
<td>0 days</td>
<td>2 days</td>
</tr>
<tr>
<td>7</td>
<td>Carol</td>
<td>Fri 06/2020</td>
<td>Thu 06/2020</td>
<td>Thu 06/2020</td>
<td>Thu 06/2020</td>
<td>2 days</td>
<td>2 days</td>
</tr>
</tbody>
</table>

Figure 13-25: The Slipping Tasks report.

Making Reports on Work Assignments

Using the Assignments reporting category of the Reports dialog box, you can produce reports on the resource assignments in your project. Click the Assignments category. Choose Select to open the Assignment Reports dialog box, as shown in Figure 13-26, and view the reports that are available in this category.

Who Does What

The Who Does What report, as shown in Figure 13-27, lists resources and the tasks to which they are assigned, the amount of work planned for each task, the planned start and finish dates, and any resource notes.
Who Does What When

The Who Does What When report, as shown in Figure 13-28, also lists resources and the tasks to which they are assigned. This report, however, focuses your attention on the daily work that is scheduled for each resource on each task.

You can use the Edit button in the Assignment Reports dialog box to change the timescale on the report from daily to some other increment, such as weekly. Also, you may want to change the date format on the Details tab to a wider format (as I did in Figure 13-28) if you see pound signs (###) in your report. See the section “Customizing Reports,” later in this chapter, for more information.

<table>
<thead>
<tr>
<th>ID</th>
<th>Resource Name</th>
<th>Work</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Joe Johnson</td>
<td>28 hrs</td>
</tr>
<tr>
<td>2</td>
<td>Deena Tannenblatt</td>
<td>40.5 hrs</td>
</tr>
<tr>
<td>3</td>
<td>Ellen Peck</td>
<td>76 hrs</td>
</tr>
<tr>
<td>4</td>
<td>Bob Wook</td>
<td>71 hrs</td>
</tr>
<tr>
<td>5</td>
<td>Do Lahr</td>
<td>56 hrs</td>
</tr>
<tr>
<td>6</td>
<td>Intern</td>
<td>36 hrs</td>
</tr>
<tr>
<td>7</td>
<td>Long distance</td>
<td>0 hrs</td>
</tr>
<tr>
<td>8</td>
<td>Lumber</td>
<td>0 hrs</td>
</tr>
<tr>
<td>9</td>
<td>Gasoline</td>
<td>0 hrs</td>
</tr>
</tbody>
</table>

Figure 13-27: The Who Does What report.
**Chapter 13 ✦ Reporting on Progress**

**To Do List**

The To Do List report, as shown in Figure 13-29, lists, on a weekly basis, the tasks that are assigned to a resource that you select. When you are ready to print this report, Project first displays the Using Resource dialog box, which contains the Show tasks using list box. When you open the list box, you see a list of your resources. Select a resource, and click OK. The To Do List report shows the task ID number, duration, start and finish dates, predecessors, and a list of all of the resources that are assigned to each task.

![Figure 13-29: The To Do List report.](image)

**Overallocated Resources**

The Overallocated Resources report, as shown in Figure 13-30, shows the overallocated resources, the tasks to which they are assigned, and the total hours of work that are assigned to them. You can also see the details of each task, such as the allocation, the amount of work, any delay, and the start and finish dates.

![Figure 13-30: The Overallocated Resources report.](image)
**Figure 13-30:** The Overallocated Resources report.

**Presenting Reports on Workloads**

You can use the Workload category to produce reports on task and resource usage in your project. Click Workload in the Reports dialog box and choose Select to open the Workload Reports dialog box, as shown in Figure 13-31.

**Task Usage**

The Task Usage report, as shown in Figure 13-32, lists tasks and the resources that are assigned to each task. It also displays the amount of work that’s assigned to each resource in weekly time increments.
Figure 13-32: The Task Usage report.

You can change the time increment by clicking Edit in the Workload Reports dialog box. See the section “Customizing Reports,” later in this chapter, for more information about editing reports.
Resource Usage

The Resource Usage report, as shown in Figure 13-33, lists resources and the tasks to which they are assigned. Like the Task Usage report, this report shows the amount of work that is assigned to each resource for each task in weekly time increments, but this report focuses your attention on the resource.

Project 2000 introduced two variations of the Resource Usage report—the Resource Usage (material) and Resource Usage (work) reports. Both reports look identical to the Resource Usage report but, as you would expect, one shows only material resources while the other shows only work resources. Both reports are custom reports; to print them, follow the instructions in the next section.

<table>
<thead>
<tr>
<th>Joe Johnson</th>
<th>06/01/03</th>
<th>06/08/03</th>
<th>06/15/03</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td>28 hrs</td>
<td>20 hrs</td>
<td>28 hrs</td>
<td></td>
</tr>
<tr>
<td>Cleanup Crew</td>
<td>8 hrs</td>
<td>8 hrs</td>
<td>8 hrs</td>
<td></td>
</tr>
<tr>
<td>Deena Tanenblatt</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invitation list</td>
<td>29.5 hrs</td>
<td>20 hrs</td>
<td>49.5 hrs</td>
<td></td>
</tr>
<tr>
<td>Theme</td>
<td>8 hrs</td>
<td>16 hrs</td>
<td>24 hrs</td>
<td></td>
</tr>
<tr>
<td>Keynote speaker</td>
<td>14 hrs</td>
<td>7.5 hrs</td>
<td>14 hrs</td>
<td></td>
</tr>
<tr>
<td>Photographers</td>
<td>7.5 hrs</td>
<td>4 hrs</td>
<td>11 hrs</td>
<td></td>
</tr>
<tr>
<td>Ellen Peck</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keynote speaker</td>
<td>12 hrs</td>
<td>40 hrs</td>
<td>52 hrs</td>
<td></td>
</tr>
<tr>
<td>Caterer</td>
<td>40 hrs</td>
<td>40 hrs</td>
<td>80 hrs</td>
<td></td>
</tr>
<tr>
<td>Bartenders</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Baseball Game</td>
<td>8 hrs</td>
<td>24 hrs</td>
<td>32 hrs</td>
<td></td>
</tr>
<tr>
<td>Opera</td>
<td>4 hrs</td>
<td>4 hrs</td>
<td>8 hrs</td>
<td></td>
</tr>
<tr>
<td>Bob Woock</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Determine budget</td>
<td>47 hrs</td>
<td>24 hrs</td>
<td>71 hrs</td>
<td></td>
</tr>
<tr>
<td>Keynote speaker</td>
<td>32 hrs</td>
<td>12 hrs</td>
<td>44 hrs</td>
<td></td>
</tr>
<tr>
<td>Security</td>
<td>15 hrs</td>
<td>4 hrs</td>
<td>19 hrs</td>
<td></td>
</tr>
<tr>
<td>Do Lahr</td>
<td>20 hrs</td>
<td>36 hrs</td>
<td>56 hrs</td>
<td></td>
</tr>
<tr>
<td>Site</td>
<td>20 hrs</td>
<td>12 hrs</td>
<td>32 hrs</td>
<td></td>
</tr>
<tr>
<td>Alert community</td>
<td>16 hrs</td>
<td>16 hrs</td>
<td>32 hrs</td>
<td></td>
</tr>
<tr>
<td>Press release</td>
<td>8 hrs</td>
<td>8 hrs</td>
<td>16 hrs</td>
<td></td>
</tr>
<tr>
<td>Intern</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Site</td>
<td>14 hrs</td>
<td>22 hrs</td>
<td>36 hrs</td>
<td></td>
</tr>
<tr>
<td>Photographers</td>
<td>14 hrs</td>
<td>6 hrs</td>
<td>20 hrs</td>
<td></td>
</tr>
<tr>
<td>Cleanup Crew</td>
<td>14 hrs</td>
<td>8 hrs</td>
<td>22 hrs</td>
<td></td>
</tr>
<tr>
<td>Long distance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lumber</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gasoline</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>######</td>
<td>170 hrs</td>
<td>24 hrs</td>
<td>316.5 hrs</td>
</tr>
</tbody>
</table>

Figure 13-33: The Resource Usage report.
Customizing Reports

Project contains some custom reports. In addition to printing these custom reports, you can customize any of the other reports that are described in this chapter. Click the Custom category in the Reports dialog box and choose Select to open the Custom Reports dialog box, as shown in Figure 13-34.

![Figure 13-34: The Custom Reports dialog box.](image)

Not all the reports listed in the Custom Reports dialog box are custom reports. However, you can print any of the standard reports either from this dialog box or as described earlier in this chapter. Remember, though, that you must use this dialog box to print the three custom reports.

You can create your own reports by clicking the New button in the Custom Reports dialog box, as shown in Figure 13-34. When you define a new custom report, Project offers you four formats. Three formats are based on the reports that are discussed in this section: the Task report format, the Resource report format, and the Crosstab report format. The fourth format, the Monthly Calendar format, functions just like the Working Days report that I discussed earlier in this chapter.

Custom reports

Project contains the following custom reports:

- The Task report
- The Resource report
- The Crosstab report

Task report

The Task report, as shown in Figure 13-35, shows task information, such as the ID number, task name, indicator icons, task duration, planned start and finish dates, predecessors, and (if resources have been assigned) resource names.
Resource report

As you can see from the report sample shown in Figure 13-36, the Resource report shows resource information: resource ID numbers; indicator icons; resource names, initials, and groups; maximum units; rate information; accrual information; base calendar information; and code information.

Crosstab report

The Crosstab report, as shown in Figure 13-37, is a tabular report that shows task and resource information in rows and time increments in columns.

Much of the information on the Crosstab report also appears on the Task Usage report and the Resource Usage report. These reports give you more formatting options, such as the period that’s covered by the report and the table that’s used in the report.
<table>
<thead>
<tr>
<th>Conference</th>
<th>06/01</th>
<th>06/08</th>
<th>06/15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preplanning</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial planning</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Determine budget</td>
<td>$960.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bob Wook</td>
<td>$960.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invitation list</td>
<td>$200.00</td>
<td>$400.00</td>
<td></td>
</tr>
<tr>
<td>Deena Tanenblatt</td>
<td>$200.00</td>
<td>$400.00</td>
<td></td>
</tr>
<tr>
<td>Send out invitations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Selection</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Theme</td>
<td>$350.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deena Tanenblatt</td>
<td>$350.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Site</td>
<td>$872.50</td>
<td>$477.50</td>
<td></td>
</tr>
<tr>
<td>Do Lahr</td>
<td>$500.00</td>
<td>$300.00</td>
<td></td>
</tr>
<tr>
<td>Intern</td>
<td>$210.00</td>
<td>$90.00</td>
<td></td>
</tr>
<tr>
<td>Keynote speaker</td>
<td>$1,137.50</td>
<td>$120.00</td>
<td></td>
</tr>
<tr>
<td>Deena Tanenblatt</td>
<td>$187.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ellen Peck</td>
<td>$500.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bob Wook</td>
<td>$450.00</td>
<td>$120.00</td>
<td></td>
</tr>
<tr>
<td>Hire</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caterer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ellen Peck</td>
<td>$800.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bartenders</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ellen Peck</td>
<td>$480.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Security</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Joe Johnson</td>
<td>$1,100.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bob Wook</td>
<td>$500.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photographers</td>
<td>$220.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deena Tanenblatt</td>
<td>$100.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intern</td>
<td>$120.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cleanup Crew</td>
<td>$320.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Joe Johnson</td>
<td>$200.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intern</td>
<td>$120.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plan Entertainment</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Baseball Game</td>
<td>$160.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ellen Peck</td>
<td>$160.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Opera</td>
<td>$80.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ellen Peck</td>
<td>$80.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Public Relations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alert community</td>
<td>$400.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Do Lahr</td>
<td>$400.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Press release</td>
<td>$200.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Do Lahr</td>
<td>$200.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 13-37:** The Crosstab report.
Customizing an existing report

You can customize almost every report that you’ve seen in this chapter. For a few reports, such as the Working Days report, the only item that you can change is the font information that Project uses to print the report. For other reports, however, you can change the table or the task or resource filter to change the content of the report. Click the Edit button when preparing to print the report to make these changes. When you click the Edit button, Project opens the dialog box that relates to the report that you selected. For example, if you select the Working Days report in the Overview Reports dialog box (choose View ✴ Reports ✴ Overview) and then click Edit, Project opens the Report Text dialog box, as shown in Figure 13-38.

![Figure 13-38: Use the Report Text dialog box to change the font of the report items.](image)

Similarly, if you select the Tasks Starting Soon report from the Current Activities dialog box and then click Edit, Project opens the Definition tab of the Task Report dialog box, as shown in Figure 13-39.

![Figure 13-39: Use the Definition tab to change the report's filter or table.](image)
From the Details tab, shown in Figure 13-40, select the information that you want to have included on the report. You may want to display predecessors for tasks or place a gridline between details.

**Figure 13-40:** Use the Details tab to specify the information that you want to include on the report.

<table>
<thead>
<tr>
<th>Task Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definition</td>
</tr>
<tr>
<td>Details</td>
</tr>
<tr>
<td>Sort</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>Bounces</td>
</tr>
<tr>
<td>Objects</td>
<td>Schedule</td>
</tr>
<tr>
<td>Predecessors</td>
<td>Cost</td>
</tr>
<tr>
<td>Successors</td>
<td>Work</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Border around details</td>
</tr>
<tr>
<td>Gridlines between details</td>
</tr>
<tr>
<td>Show details</td>
</tr>
</tbody>
</table>

**Note**

The options on the Details tab change from report to report.
From the Sort tab, shown in Figure 13-41, select the sort orders for the report.

**Figure 13-41:** Select a sort order for the report.

### Summary

In this chapter, you found out how to produce reports in Project, and you examined samples of the reports that are available in each of Project’s six report categories:

- Overview
- Current Activities
- Costs
- Assignments
- Workload
- Custom

In addition, you should now know how to customize any standard report in Project. The next chapter shows you how to analyze your project’s progress.
Analyzing Financial Progress

When you analyze the progress of your project, you must measure not only the progress of the schedule but also the progress based on the costs that you incur. In Microsoft Project, you measure the earned value of your project.

Understanding Earned Value

*Earned value* is the measurement that project managers use to evaluate the progress of a project based on the cost of work performed up to the project status date. When Project calculates earned value, by default it compares your original cost estimates to the actual work performed to show whether your project is on budget. You can think of earned value as a measurement that indicates how much of the budget should have been spent in comparison to the cost of the work performed thus far to the baseline cost for the task, resource, or assignment.

You can calculate earned value by manually recording the Physical % Complete instead of letting Project calculate % Complete, which is actual duration divided by total duration.

To work with and use earned value information effectively, you must first perform the following tasks:

✦ Save a baseline for your project
✦ Assign resources with costs to tasks in your project
✦ Complete some work on your project
Understanding earned value fields

Remember the Earned Value report from Chapter 12? The fields that appear as headings in that report also appear on various earned value tables. Earned value fields are currency fields that measure various aspects of earned value. The following table translates the acronyms that Project uses to represent the earned value fields.

<table>
<thead>
<tr>
<th>Acronyms</th>
<th>Earned Value Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>BCWS</td>
<td>Budgeted Cost of Work Scheduled</td>
</tr>
<tr>
<td>BCWP</td>
<td>Budgeted Cost of Work Performed</td>
</tr>
<tr>
<td>ACWP</td>
<td>Actual Cost of Work Performed</td>
</tr>
<tr>
<td>SV</td>
<td>Schedule Variance</td>
</tr>
<tr>
<td>CV</td>
<td>Cost Variance</td>
</tr>
<tr>
<td>BAC</td>
<td>Budgeted at Completion</td>
</tr>
<tr>
<td>EAC</td>
<td>Estimate at Completion</td>
</tr>
<tr>
<td>VAC</td>
<td>Variance at Completion</td>
</tr>
</tbody>
</table>

Three of the preceding fields are really at the heart of earned value analysis, as follows:

- **BCWP** indicates how much of a task’s budget should have been spent given the actual duration of the task. For example, suppose that you have a task budgeted at $100 and work has been performed for one day. You find that, after one day, 40 percent of the work has been completed. You would expect that 40 percent of the cost of the task, or $40, would also be incurred. Therefore, the BCWP for the task is $40.

- **BCWS** measures the budgeted cost of individual tasks based on the resources and fixed costs that are assigned to the tasks when you schedule them.

- **ACWP** measures the actual cost that is incurred to complete a task. During the completion process, ACWP represents the actual costs for work performed through the project’s status date.

BCWS, BCWP, ACWP, SV, and CV are all calculated through today or through the project status date. SV represents the cost difference between current progress and the baseline plan, and Project calculates this value as BCWP minus BCWS. CV represents the cost difference between actual costs and planned costs at the current level of completion, and Project calculates this value as BCWP minus ACWP. EAC
shows the planned costs based on costs that are already incurred plus additional planned costs. VAC represents the variance between the baseline cost and the combination of actual costs plus planned costs for a task.

Project calculates BCWP at the task level different from how it calculates BCWP at the assignment level. Because Project rolls the task-level BCWP values into summary tasks and the project summary task, I suggest that you use the task-level BCWP values.

Project uses BCWS, BCWP, ACWP, SV, and CV as task fields, resource fields, and assignment fields; Project also uses timephased versions of each field. BAC, EAC, and VAC, however, are task fields only.

Project 2003 introduced some new earned value fields. Some of these fields appear by default on earned value tables, and you can add any of these fields to any table. Project 2003’s new earned value fields are as follows:

✦ **Physical % Complete**: This field represents your estimate of the progress of a task, regardless of actual work or time, and is not a timephased field. Project calculates Physical % Complete by rolling up BCWP on subtasks to BCWP on associated summary tasks. You enter Physical % Complete estimates, and Project applies the Physical % Complete to assignment data or Fixed Costs data for the associated summary task. See the next section for details on having Project use Physical % Complete as the method for calculating earned value.

You may be wondering about the difference between % Complete, which is not new to Project 2003, and Physical % Complete. Project calculates % Complete by dividing actual task duration by total duration. Physical % Complete is your estimate of where a task stands and has no connection to duration.

✦ **CPI**: CPI stands for Cost Performance Index, and Project calculates CPI by dividing BCWP by ACWP. This field appears by default in the Earned Value Cost Indicators table and is a timephased field.

✦ **SPI**: SPI stands for Schedule Performance Index, and Project calculates SPI by dividing BCWP by BCWS. This field appears by default in the Earned Value Schedule Indicators table and is a timephased field.

✦ **CV%**: CV% stands for Cost Variance %, and Project calculates this field by dividing CV by BCWP and multiplying the result by 100. This field appears by default in the Earned Value Cost Indicators table and is a timephased field.

✦ **SV%**: SV% stands for Schedule Variance %, and Project calculates this field by dividing SV by BCWS and multiplying the result by 100. This field appears by default in the Earned Value Schedule Indicators table and is a timephased field.
✦ **EAC**: EAC stands for *Estimate at Completion*, and although this field isn’t new (it existed in Project 2000), it is improved in Project 2003. Project calculates this field by using the following formula: \( ACWP + \frac{BAC - BCWP}{CPI} \). This field appears by default in the Earned Value for Tasks and the Earned Value Cost Indicators tables and is not a timephased field.

In Project 2000, EAC was simply the cost of the task, because EAC was nothing more than the task’s cost, retitled to “EAC.” In Project 2003, the field is a new, separate field with a formula behind it.

✦ **TCPI**: TCPI stands for *To Complete Performance Index*, and Project calculates this field by using the following formula: \( \frac{BAC - BCWP}{EAC - ACWP} \). This field appears by default in the Earned Value Cost Indicators table and is not a timephased field.

**Using the Physical % Complete method to calculate earned value**

Project can use the % Complete method or the Physical % Complete method to calculate earned value. Unless you specify otherwise, Project uses the % Complete method.

You can set Physical % Complete as the default earned value calculation method for your project by following these steps:

1. Choose Tools ➪ Options.
2. Click the Calculation tab.
3. Click the Earned Value button. You see the Earned Value dialog box, as shown in Figure 14-1.

![Figure 14-1: Choose the method of earned value calculation that you want Project to use.](image-url)
4. From the Default task Earned Value method list box, choose Physical % Complete.

5. From the Baseline for Earned Value calculations list box, choose a baseline (Project stores 11 baselines for earned value).

   *Note: Clearing a baseline after entering Physical % Complete values does not clear those values.*

6. Click OK twice to save the settings.

The preceding steps set the default for all new tasks that you enter in your project. If your project already contains tasks (or if you want to use the Physical % Complete method for some but not all tasks), set the earned value calculation method on a task-by-task basis. Follow these steps to do so:

1. Select the task(s) for which you want to set the earned value calculation method to Physical % Complete.
2. Click the Task Information button on the Standard toolbar.
3. Click the Advanced tab.
4. From the Earned value method list box, choose Physical % Complete, as shown in Figure 14-2.

![Figure 14-2: Assign the Physical % Complete method as appropriate to tasks in the Task Information dialog box.](image-url)
To record Physical % Complete, add the field as a column on a table view (in Figure 14-3, I’ve added it to the Earned Value for Tasks table), and then type in appropriate amounts for tasks. You’ll see other earned value fields update accordingly.

![Microsoft Project](image)

**Figure 14-3:** Record Physical % Complete values by adding the field to a table and then typing in the information.

**Tip**

To insert a column, click the heading of the column to the right of the column that you are inserting. Then choose Insert Column.

**Setting the date for earned value calculations**

By default, Project uses today’s date to calculate earned value information. However, you can set a project status date for Project to use instead of today’s date when it calculates earned value. From any view, choose Project Project Information to open the Project Information dialog box, as shown in Figure 14-4.

From the Status Date list box, select the date that you want Project to use when it calculates earned value, and click OK.
Project contains four earned value tables that you can use to compare your expected costs with your actual costs. The four earned value tables — Earned Value for Tasks, Earned Value Cost Indicators, Earned Value Schedule Indicators, and Earned Value for Resources — help you evaluate the relationship between work and costs. You can use the earned value tables to forecast whether a task will finish within the budget based on the comparison of the actual costs incurred for the task to date and the baseline cost of the task.

**Using the Earned Value table for tasks**

When you use the Earned Value table for tasks, you can compare the relationship between work and costs for tasks. This table helps you evaluate your budget to estimate future budget needs and prepare an accounting statement of your project. You can use the information in the table to determine whether sufficient work is getting done for the money that you’re paying or whether tasks need more money or less money, or perhaps should be cut. That is, the information in the Earned Value table helps you assess whether the money that you’re spending on a task is enough money, too much money, too little money, or perhaps wasted money.

To display the Earned Value table for tasks, start in any view that contains a table. You can get to the table in Figure 14-5, for example, by starting with the Task Usage view. Right-click the Select All button, and choose More Tables from the shortcut menu that appears. In the More Tables dialog box, select Earned Value and click Apply.
Figure 14-5: The Earned Value table for tasks.

All the fields on this sheet are calculated, except EAC and BAC. You can type values in those fields to change information in the table.

**Using the Earned Value table for resources**

When you use the Earned Value table for resources, you can compare the relationship between work and costs for resources. This table also helps you to evaluate your budget to estimate future budget needs and prepare an accounting statement of your project. You can use the information in the table to determine whether the work is getting done for the money that you’re paying or whether you need more or less of a particular resource.
To display the Earned Value table for resources, follow these steps:

1. Start in any resource view, such as the Resource Sheet view.
2. Right-click the Select All button, and choose More Tables from the shortcut menu that appears.
3. Select Earned Value in the More Tables dialog box, and click Apply. Your screen will look similar to the one shown in Figure 14-6.

All the fields in this sheet are calculated, except BAC. You can type values in this field to change information in the table.

Figure 14-6: The Earned Value table for resources.
Using the Earned Value Cost Indicators and Earned Value Schedule Indicators tables

Project 2003 introduced two new tables that are similar to their cousin, the Earned Value for Tasks table; the main difference between them is the fields that you find in each table. The Earned Value Cost Indicators table for tasks enables you to compare the various cost factors in your project, as shown in Figure 14-7. The Earned Value Schedule Indicators table for tasks enables you to focus on the effects of scheduling variances on the cost of your project, as shown in Figure 14-8.

To display the Earned Value Cost Indicators table for tasks, start in any task view that contains a table. Then, right-click the Select All button and choose More Tables from the shortcut menu that appears. In the More Tables dialog box, select Earned Value Cost Indicators and click Apply.

To display the Earned Value Schedule Indicators table for tasks, start in any task view that contains a table. Then, right-click the Select All button and choose More Tables from the shortcut menu that appears. In the More Tables dialog box, select Earned Value Schedule Indicators and click Apply.

Figure 14-7: The Earned Value Cost Indicators table closely resembles the Earned Value for Tasks table but focuses on different earned value fields.
Evaluating Cost Information

If you own Microsoft Excel, you can use it to assist you in evaluating cost information. By exporting information to Excel, you can chart earned value, analyze timescaled information, or create PivotTables.

Charting earned value

The saying goes: A picture is worth a thousand words. And when looking at earned value information, you may find it easier to understand the information if you use a picture rather than study Project’s earned value tables. You can export the earned value information to Microsoft Excel (you must be using Excel version 5.0 or later) and then use Excel’s Chart Wizard to create charts of earned value information.

To find out more about Project’s capabilities to export and import data, see Chapter 22.
When you export earned values from Project to Excel, you create an Excel workbook that contains a task ID, a name, and the various earned values for each task, as shown in Figure 14-9.

![Figure 14-9: An Excel workbook that was created by exporting earned value information from Project to Excel.](image)

To create an Excel workbook like the one shown in Figure 14-9, follow these steps:

1. In the Project file containing the information that you want to use in Excel, choose File ➪ Save As to open the Save As dialog box.
2. Type a name for the Excel workbook in the File Name list box. Don’t worry about the extension; Project supplies it.
3. Open the Save as type list box, and select Microsoft Excel Workbook. The Save As dialog box should resemble the one that is shown in Figure 14-10.
4. Click Save to start the Export Mapping wizard.
5. Click Next.
6. Choose Selected Data in the next box of the wizard, and then click Next.
7. Choose Use existing map in the next box of the wizard, and then click Next.

8. Choose Earned Value information from the list of available maps in the Export Wizard dialog box, as shown in Figure 14-11, and click Finish.

You can continue clicking Next in the wizard, but to chart earned value in Excel, you usually don't need to make any changes in the remaining dialog boxes that the wizard presents.

Figure 14-10: The Save As dialog box as it appears after you choose to save an Excel workbook file.

Figure 14-11: Choose Earned value information as the map from the Export Wizard dialog box.
Open Microsoft Excel and then choose File ➪ Open to open the workbook that you just created. You can use Excel’s Chart Wizard to create as many charts from this data as you want. For example, the chart in Figure 14-12 shows all earned values for one task, and the chart in Figure 14-13 shows one earned value for selected tasks.

![Figure 14-12: An Excel chart of all earned values for one task.](image)

If your project is small, you may be able to chart one earned value for all tasks, but if your project is large, Excel may display an error message if you try to chart one earned value for all tasks.

To create a chart like the one shown in Figure 14-12, follow these steps:

1. Click the Chart Wizard button on the Standard toolbar to start the Chart Wizard. In the first Chart Wizard dialog box, select the type of chart that you want to create.

2. Click Next to open the second Chart Wizard dialog box, as shown in Figure 14-14. In this dialog box, select Rows for the Series in option.

3. Click the Collapse Dialog button at the right edge of the Data range box, which is shown in Figure 14-14, to hide the Chart Wizard so that you can select the task that you want to chart from the worksheet.
4. Highlight (by dragging) the cells in the row containing the information that you want to chart. Note that I’ve excluded the ID in Column A in Figure 14-15.

**Figure 14-13:** An Excel chart of one earned value for selected tasks.

**Figure 14-14:** Chart the data by rows.
Your chart will be more meaningful if you omit Column A, which contains the task ID number.

5. Click the Collapse Dialog button to redisplay the Chart Wizard.

6. Click the Series tab.

7. Click the Collapse Dialog button at the right of the Category (X) axis labels box.

8. Select the headings in Row 1 that contain the labels for the earned value fields. Your selection will probably include cells C1 through J1.

9. Click the Collapse Dialog button to redisplay the Chart Wizard. The Series tab should look similar to the one shown in Figure 14-16.

10. Click Next, and fill in the other dialog boxes for the Chart Wizard.

After you finish, your chart should resemble the chart shown in Figure 14-12, which displays all earned values for one task.
Figure 14-16: The Series tab after you have selected X-axis labels.

To create the chart shown in Figure 14-13, use the Chart Wizard again. Then, in the second Chart Wizard dialog box, use the following settings:

- On the Data Range tab, select Columns for the Series in option. For the Data Range, select the cells containing the earned value information that you want to chart. In the chart that is shown in Figure 14-13, I charted only about half of the available tasks to keep the chart cleaner.

- On the Series tab, remove all series except for one from the Series list (otherwise your chart will be very messy). In the Category (X) axis labels list box, select the cells containing the task names (cells in Column B in the pictured worksheet).

**Analyzing timescaled information**

Project contains a wizard that helps you chart timescaled earned value data. You can use the Analyze Timescaled Data Wizard to automatically create a chart in Microsoft Excel of earned value information for the entire project. After you complete the wizard, the resulting chart looks similar to that shown in Figure 14-17.
To use the Timescaled Data Wizard in Project, follow these steps:

1. Choose View ➪ Gantt Chart.

   **Tip**
   If you want to chart data for selected tasks, select them now.

2. Choose View ➪ Toolbars ➪ Analysis. Project displays the Analysis toolbar, as shown in Figure 14-18.

   **Figure 14-18:** The Analysis toolbar.

   You may need to click the More Buttons button at the right end of the toolbar to see and click the Analyze Timescaled Data in Excel button.

3. Click the Analyze Timescaled Data in Excel button. Project opens the first of five Analyze Timescaled Data Wizard dialog boxes, as shown in Figure 14-19.
4. Select either the Entire project or Currently selected tasks option button, and then click Next to open the Step 2 dialog box.

5. Select the appropriate earned value fields from the Available fields list box; click Add to move the fields to the Fields to export list box. Highlight the Work field in the Fields to export list box, and click the Remove button, as shown in Figure 14-20. Click Next.

6. Select the date range and time increments that you want to use. The default time increment is days, which I selected in Figure 14-21. Click Next to open Step 4.

7. Select the Yes, please option button to graph the data, as shown in Figure 14-22. Otherwise, select No, thanks. Click Next to open the wizard’s final dialog box.

8. Click Export Data to export the Project data into Microsoft Excel, as shown in Figure 14-23.
Figure 14-21: Select the date range and time increments for which you want to export data.

Figure 14-22: Tell Project whether to graph the data.

Figure 14-23: Finish the process by exporting your data to Excel.
After you finish, the hourglass icon for the mouse pointer appears, indicating that you should wait while action takes place. Excel starts up, processes your data, and then displays a chart similar to the one that’s shown in Figure 14-17 (located at the beginning of this section). Excel also creates a worksheet in the workbook, which you can view by clicking the Timescaled Data tab, as shown in Figure 14-24. The worksheet contains the earned value information that Excel used to create the chart shown in Figure 14-17.

Figure 14-24: The worksheet that Excel uses to create the chart.

Using PivotTables for analysis

Excel PivotTables can be interesting and useful when you want to analyze Project earned value data. The PivotTable is an interactive table that summarizes large amounts of data in a cross-tabular format. When you use Project to create a PivotTable in Excel, you get two PivotTables in the same workbook: a Task PivotTable and a Resource PivotTable. The Task PivotTable shows resources, tasks to which the resources are assigned, and costs for the resource per task. The Resource PivotTable summarizes resources by showing work that is assigned to each resource and the total cost of each resource. In addition to the PivotTable worksheets, the same Excel workbook also includes two worksheets — Tasks and Resources — that Excel uses to create these two PivotTables.
To export Project information to create PivotTables in Excel, follow these steps:

1. Start in any view of your project.
2. Choose File ➪ Save As to open the Save As dialog box.
3. Type a name for the Excel workbook that you want to create in the File name box. Don’t worry about the extension — Project supplies it.
4. Select Microsoft Excel PivotTable from the Save as type list box.
5. Click Save to start the Export Mapping Wizard.
6. Click Next.
7. Choose Use existing map, and click Next.
8. Select Task and resource PivotTable, and click Finish, as shown in Figure 14-25.

![Figure 14-25: The Map Selection portion of the Export Wizard dialog box.](image-url)
You can continue clicking Next in the wizard, but to chart earned value in Excel, you usually don’t need to make any changes in the remaining dialog boxes that the wizard presents.

The hourglass icon for the mouse pointer appears, indicating that you should wait while action takes place. You’ll also hear action on your hard drive. To view the PivotTables and their source data, start Excel and open the file that you just created. The workbook contains four sheets that should resemble the sheets that are shown in Figures 14-26, 14-27, 14-28, and 14-29.

![Figure 14-26: The Resource PivotTable.](image-url)
Figure 14-27: The Resources sheet that Excel used to create the Resource PivotTable.
Figure 14-28: The Task PivotTable.
Figure 14-29: The Tasks sheet that Excel used to create the Task PivotTable.

You may need to widen columns in Excel to see all the data. Double-click the right border of the column letter to do so.

Making Adjustments During the Project

Now that you’ve seen the various ways you can collect and analyze financial data about your project, you need to use that information to make improvements to your project. You can use many of the techniques that you used to implement changes to your project because of scheduling problems or resource conflicts.

Cross-reference

Find out how to deal with scheduling problems by using the techniques that are discussed in Chapter 9. You can find help resolving resource problems in Chapter 10.
Changing the schedule

After evaluating earned value information, you may want to change the schedule. For example, you may want to do the following:

✦ Add resources to tasks
✦ Use overtime
✦ Increase task duration
✦ Adjust slack
✦ Change task constraints
✦ Adjust dependencies
✦ Split tasks
✦ Adjust the critical path

You may also need to make changes to the baseline project that you saved.

For more information on adjusting the baseline, see Chapter 11.

Modifying resource assignments

Your evaluation of earned value information may prompt you to make changes to resource assignments on your project. For example, you may need to do the following:

✦ Change resource allocations
✦ Schedule overtime
✦ Redefine a resource’s calendar
✦ Assign part-time work
✦ Control when resources start working on a task
✦ Level workloads
✦ Contour resources
✦ Pool resources

When you’re working on an unusually large project, you may find it easier to break your project into smaller, more manageable portions called subprojects. In Project, you can create subprojects and then consolidate them into the larger project to see the bigger picture (see Chapter 15).
Summary

This chapter explained how to analyze the costs in your project. After reading this chapter, you should know the following:

✦ How to use Project’s earned value tables
✦ How to chart earned value information, analyze timescaled information, and use Microsoft Excel PivotTables
✦ How to make adjustments to your project

In Chapters 15 through 19, you discover how Project helps you work in groups.
Working in Groups

In This Part

Chapter 15
Coordinating Multiple Projects Outside Project Server

Chapter 16
Using Project in an E-mail Workgroup
Large projects are the most difficult to manage. Organization is a cornerstone to good project management, and in a large project, the sheer number of tasks makes the job more difficult than usual. In Microsoft Project, you can use the concept of consolidated projects to break projects into smaller, “bite-sized” pieces and then combine the smaller projects to view the bigger picture.

Consolidating Projects

When you’re faced with a complex problem, finding the solution typically becomes easier if you can simplify the problem. Similarly, when you need to manage a complex project with many tasks, you may find it easier to organize the process if you deal with a limited number of tasks at one time.

Microsoft Project makes it easy for you to take this approach to planning large, complex projects. By using Project’s consolidation features, you can create subprojects, which you can think of as the tasks that constitute one portion of your large project. When you create a subproject, you save it as a separate project file. You can assign resources and set up each subproject with links and constraints — just as if it were the entire project. When you need to view the bigger picture, you can consolidate the subprojects into one large project. When you consolidate, you insert one project into another project; therefore, subprojects are also called inserted projects.
When you work in a consolidated project, you can focus on just the desired portion of the project. Subprojects appear as summary tasks in the consolidated project, and you can use Project’s outlining tools to hide all tasks that are associated with any subproject.

See Chapter 3 for more information on outlining.

From the consolidated project, you can view, print, and change information for any subproject—just as if you were working with a single project.

If you’re a Project Professional user who also uses Project Server, you may be wondering if consolidation applies to you. While views in Project Server can “roll up” project information, you still need consolidation techniques if you want to see one critical path across all consolidated projects. Also, I describe resource pooling in this chapter. This concept applies more to Project Standard users than Project Professional users, who can use Enterprise Resources in Project Server.

**Setting up to use consolidation**

Consolidation can help you achieve the following objectives:

✦ Tasks in projects that are managed by different people may be interdependent. Through consolidation, you can create the correct dependencies to accurately display the project’s schedule and necessary resources.
A project may be so large that breaking it into smaller pieces can help you to organize it. You can use consolidation to combine the smaller pieces and then view the big picture.

You may be pooling the resources of several projects and find that you need to level the resources. Consolidating enables you to link the projects sharing the resources so that you can level the resources.

If you’re using Project Standard, you can’t take advantage of the Enterprise Resource Pool that’s available in Project Server; therefore, the resource pooling techniques that I describe in this chapter apply to you. If you’re using Project Professional, you may want to consider using the Enterprise Resource Pool instead of using resource pooling as described in this chapter. To do so, see Chapter 19.

When should you decide to use consolidation? It doesn’t really matter. You may realize right away that the project is too large to handle in a traditional way, or you may discover that the project is bigger than you originally thought. Suppose, for example, that the Marketing department of a software company decides midway through the development cycle to bundle various products under development. This introduces dependencies where none originally existed—and provides an interesting opportunity for using consolidation.

If you decide to use consolidation before you start your project, simply create separate Microsoft Project files for various portions of the project. These files act as subprojects when you consolidate. You need to set up each subproject file so that it is independently complete, and you need to create links within each subproject file, as necessary. This chapter explains techniques for consolidating the subprojects and linking them.

If you start a project and then decide that you want to use consolidation, you can create subprojects by following these steps:

1. Save your large project file.
2. Select all the tasks that you want to save in your first subproject file, and click the Copy button.
3. Click the New button to start a new project, and use the Project Information dialog box that appears, as shown in Figure 15-1, to set basic project information, such as the project’s start date and scheduling method.
4. Click the Paste button.
5. Save the subproject, and close it.
6. Select all the tasks that you want to save in your second subproject file, and click the Copy button.

7. Repeat Steps 3 through 7 until you have saved several separate files that contain portions of your larger project.

Edit each subproject file that you create to make it an independently complete project. Then, you can use the techniques that are explained in the following section to consolidate the subprojects and link them.

**Inserting a project**

To consolidate project files into one large project, you insert projects into a host project file, often referred to as the *consolidated project file*. Each project that you insert appears as a summary task in the consolidated project file, and Project calculates inserted projects like summary tasks. An icon in the Indicator field identifies an inserted project, as shown in Figure 15-2.
Figure 15-2: A special icon in the Indicator field identifies inserted projects.

You can insert projects at any outline level. The level at which an inserted project appears depends on the outline level that appears at the location where you intend to insert a project. To insert a project, simply select the task that you want to appear below the inserted project; Project then inserts the project above the selected task. Typically, an inserted project appears at the same level as the selected task. However, if the task that is above the selected task is indented farther than the selected task, the inserted project appears at the same level as that indented task. Or, if the task that’s above the selected task is at the same level or outdented farther than the selected task, the inserted project appears in the outline at the same level as the selected task. Compare Figures 15-3, 15-4, and 15-5.
Figure 15-3: I expanded the Initial planning meeting task and then chose the Selection task when I inserted subproject2. This subproject appears at the same outline level as the Send out invitation task that's above it.
Figure 15-4: I collapsed the Initial planning meeting task and then chose the Selection task when I inserted subproject2. This subproject appears at the same outline level as the Initial planning meeting task.
Figure 15-5: I selected the Determine budget task and then inserted subproject2. This subproject appears at the same outline level as Determine budget because the task above—Initial planning meeting—is outdented farther than Determine budget (the selected task).

To produce a consolidated project in which the inserted projects line up at the highest outline level, as is shown in Figure 15-6, make sure that you collapse the preceding inserted project so that you can’t see its tasks when you insert the next subproject.

Tip

You can hide or show tasks after you insert the project by clicking the summary task’s outline symbol—the plus or minus sign next to the task name.
Figure 15-6: When subproject3 was inserted, subproject2 was selected and its subordinate tasks were visible, but the subordinate tasks of subproject1 were not visible.

To insert a project, follow these steps:

1. Open the project in which you want to store the consolidated project.
2. Switch to the Gantt Chart view.
3. Click the Task Name column in the row where you want the inserted project to begin.

When you insert a project, Project places the project immediately above the selected row. Therefore, if your consolidated project already contains tasks, click the task in the Task Name column that you want to appear below the subproject.

4. Choose Insert ➪ Project to open the Insert Project dialog box, as shown in Figure 15-7.
Figure 15-7: The Insert Project dialog box works like the Open dialog box.

5. Use the Look in list box to navigate to the folder that contains the project that you want to insert.

6. Highlight the file that you want to insert.

7. Change any insert project options, as follows:
   - If you deselect the Link to project check box, the inserted project isn’t linked to its source project.
   - If you choose Insert Read-Only from the Insert drop-down menu, Project does not change the source project when you change the inserted project.

8. Click Insert (or Insert Read-Only). Project inserts the selected file into the open project. The inserted file appears as a summary task, with its subordinate tasks hidden.

Using inserted projects and their source files

You can link an inserted project to its source file, as was shown in Figure 15-2. If you don’t want to link an inserted project to its source file, any changes that you make to the inserted project in the consolidated project file don’t affect the source file. Similarly, any changes that you make to the source file don’t affect the consolidated project file that contains the subproject. Therefore, why wouldn’t you want to link the files? You may want to create a consolidated file just so you can generate a report quickly.
In many circumstances, linking the files makes updating easier. Linking ensures that any changes that you make in either the consolidated project or the subproject file affect the other file. When you insert a project and link it to its source file, you are creating a link between two files; that link works like any link that you create between two files in the Windows environment. For example, if you rename the subproject file or move it to a different folder than the one in which you originally saved it, you need to update the link to the consolidated project; otherwise, the link does not work. If you move a file that you have linked, you can update the link on the Advanced tab of the Inserted Project Information dialog box for the inserted project, as shown in Figure 15-8.

You also can unlink subprojects from their source files by using the Advanced tab of the Inserted Project Information dialog box. To do so, deselect the Link to project check box.

Or, you can simply attempt to expand the inserted project. When you click the plus sign next to the subproject, Project automatically displays a dialog box that looks like the Open dialog box. Use this dialog box to navigate to the new location of the file, and click OK after you finish.

**Consolidating all open projects: A shortcut**

Follow these steps to consolidate several subprojects at the same time:

1. Open all the subprojects that you want to consolidate.
2. Choose Window ➪ New Window to open the New Window dialog box, as shown in Figure 15-9.
3. Press and hold down Ctrl, and click each project that you want to consolidate.
4. Click OK.

Project creates a new consolidated project that contains the projects that you selected in the New Window dialog box. Project inserts the subprojects into the consolidated project in the order in which the subprojects appear in the New Window dialog box.

**Moving subprojects within a consolidated project**

You can move subprojects around in the consolidated project by cutting a subproject row to delete it and then pasting the row where you want it to appear. When you select a summary row that represents a subproject and click the Cut button on the Standard toolbar, Project opens the Planning Wizard dialog box, as shown in Figure 15-10.
Select the Continue option button, and click OK. The summary task that represents the subproject and all its subordinate tasks disappears. When you paste the subproject, Project places the subproject immediately above the selected row. Therefore, in the Task Name column, you must click the task that you want to appear below the subproject. Then click the Paste button on the Standard toolbar. Project reinserts the subproject at its new location.

If you’re going to be moving a lot of tasks, you may want to select the Don’t tell me about this again check box to avoid viewing the Planning Wizard dialog box.

Understanding Consolidated Projects and Dependencies

In a consolidated project, you typically have tasks — either in the consolidated project or in one subproject — that are dependent on tasks in another subproject. You can create links between projects in a consolidated file, and if necessary, you can change the links that you create.

Linking tasks across projects

You can create four different types of dependencies: finish-to-start, start-to-start, finish-to-finish, and start-to-finish. In addition, these types support lead and lag time. The process of linking tasks with dependencies across projects is much the same as the process of creating dependencies for tasks within the same project. Starting in the consolidated project file, follow these steps:

1. Click the Gantt Chart on the View bar.
2. Select the tasks that you want to link.
3. Click the Link Tasks button on the Standard toolbar. Project creates a finish-to-start link between the two tasks.

You can create the link in the consolidated project file by dragging from the Gantt bar of the predecessor task to the Gantt bar of the successor task.

You also can link tasks by typing in the Predecessors field, using the format `project name\ID#`. The project name should include the path to the location of the file as well as the filename, and the ID# should be the ID number of the task in that file. The Buy room decorations task, shown in Figure 15-11, is linked to the...
Site task, which is Task 8 in a Project file called SP1-2002.MPP. You can see the complete pathname of a linked task in the Entry bar (just below the toolbars) when you highlight the task.

When you link tasks between projects, the task links look like standard links in the consolidated project. However, when you open either of the subproject files, you see that Project has inserted an external link, as shown in Figure 15-12. The name and the Gantt Chart bar of each externally linked task appear gray. If you point at the Gantt Chart bar, Project displays information about the task, including the fact that it is an external task.

If you double-click the task name of the external task, Project opens the subproject that contains the task to which the external task is linked.
Coordinating Multiple Projects Outside Project Server

Figure 15-12: When you link tasks across files, Project inserts an external link in the subproject file.

Changing links across projects

After you link tasks across projects, you may need to change information about the link. For example, you may want to change the type of dependency from the default finish-to-start link, or you may want to create lag time.

You can modify a link between tasks in different subprojects from either the subproject or from the consolidated project. In the subproject, double-click the line that links an internal task to the external task, as shown in Figure 15-13. In the consolidated project, double-click the line that links the two tasks, as shown in Figure 15-14. In both cases, Project displays the Task Dependency dialog box.
Figure 15-13: In a subproject, double-click the link line between the internal task and the external task to display the Task Dependency dialog box.

The two versions of the dialog boxes differ slightly. If you work from within the subproject, you can update the path of the link and use the Type list box to change the type of link and the Lag list box to change the amount of lag time between the linked tasks. If you work from within the consolidated project, you can’t update the path of the link, but you can change the type of link and the amount of lag time.

**Consolidated projects — to save or not to save**

You don’t need to save consolidated project files unless you want them. You can create the consolidated project file by choosing either Window ➪ New Window or Insert ➪ Project — both are described earlier in this chapter. You can use the consolidated project to create links and even reports, and then close the consolidated project file without saving it. For example, suppose that you created the consolidated project by inserting projects and the inserted projects are not open. When you close the consolidated project, Project first asks if you want to save the consolidated project. Your answer does not affect changes that you made to inserted projects, as shown in Figure 15-15.
Coordinating Multiple Projects Outside Project Server

Figure 15-14: In a consolidated project, double-click the line that links the tasks to the Task Dependency dialog box and change the dependency information about tasks that are linked across projects.

Figure 15-15: When you close a consolidated project that you created by inserting projects, Project asks if you want to save changes, including links, that you made to each subproject.

If you created the consolidated project by choosing Window ➤ New Window, Project asks whether you want to save changes to the subprojects as you close them.

If you save the changes to the subprojects — even if you don’t save the consolidated project — external tasks, such as the one that you saw previously in Figure 15-12, appear in the subproject files when you open them.
Viewing Multiple Projects

Creating a consolidated project makes your work easier because you can display and hide selected portions of your project. The consolidated project that is shown in Figure 15-16 contains three inserted projects. As you can tell from the outline symbols, you can’t see all the tasks in this consolidated project in the figure; the tasks for subproject3 are hidden.

Figure 15-16: This consolidated project contains three inserted projects.

Suppose that you need to focus on the middle portion of the project. As Figure 15-17 demonstrates, you can easily focus on the portion of the project that currently needs your attention by clicking the outline symbols to the left of each summary task to expand only the portion of the project that you want to view.
Close inserted projects so that just their summary tasks appear when you want to focus on a portion of a consolidated project.

**Figure 15-17:** Close inserted projects so that just their summary tasks appear when you want to focus on a portion of a consolidated project.

**Viewing the Critical Path across Projects**

When you consolidate projects, by default Project calculates inserted projects like summary tasks, effectively showing you the overall critical path across all the projects by using the late finish date of the master project to make calculations. This behavior can make subprojects within the master project look like they don't have critical paths of their own, as shown in Figure 15-18.
Figure 15-18: By default, Project treats inserted projects like summary tasks, and you don’t see critical paths for individual inserted projects.

Suppose that you want to see each subproject’s critical path while viewing the master project. To do so, you think, “I’ll turn on multiple critical paths in the master project.” That’s the right idea, but because multiple critical paths apply only to tasks that are owned by the project, nothing will change. In this example, the tasks (Task 1 and Task 2) in Figure 15-18 are owned by subprojects, so turning on multiple critical paths in the master project won’t have any effect.
You can, however, tell Project to stop treating subprojects as summary tasks. If you do, Project uses the late finish dates that the subprojects pass along to the master project to determine the critical path — and you’re likely to see each subproject’s critical path, as shown in Figure 15-19. When you turn off this setting, you see critical paths in the master project as they appear in each subproject.

To change Project’s behavior in the master project, choose Tools ➪ Options and click the Calculation tab. Then, deselect the Inserted projects are calculated like summary tasks check box, as shown in Figure 15-20.
Sharing Resources Among Projects

Creating a resource pool can be useful if you don’t use Project Server and you work with the same resources on multiple projects. A resource pool is a set of resources that are available to any project. You can use resources exclusively on one project, or you can share the resources among several projects.

If you work in an environment in which several project managers use the same set of resources on various projects, consider using a resource pool. Setting up a resource pool in Project can be a good way to schedule resources and resolve resource conflicts.

See Chapter 10 for more information on other techniques that you can employ to resolve resource conflicts. See Chapter 19 for information about using the Enterprise Global Resources feature of Project Server.
Creating a resource pool and sharing the resources

Setting up a resource pool in Project can facilitate resource management, especially for resources that are shared on several projects. To create a resource pool, you simply set up a project file that contains only resource information.

If you have already set up a project that contains all the resources that are available, you can use that project as a model. After you identify a project that can serve as the resource pool, you designate it as the resource pool project by using the following steps:

1. Open the project that contains the resources and that will serve as the resource pool file.
2. Open the project that is to use the resource pool (that is, the project on which you want to work).
3. Choose Tools ➪ Resource Sharing ➪ Share Resources. Project displays the Share Resources dialog box, as shown in Figure 15-21.

![Figure 15-21: The Share Resources dialog box.]

4. Click the Use resources option button, and then use the From list box to select the resource pool project. This indicates that you want to use the resources that are defined in that project.

If you open only the project on which you want to work, the Use own resources option button is the only choice available, and you can’t share resources with the resource pool. The first time that you want to enable resource sharing, you must open both the project that you determined would be the resource pool and the project on which you want to work. In addition, if you have any other projects open, they appear as candidates for the resource pool project when you open the From list box, because Project enables you to select from any open project when you identify the resource pool.
5. Tell Project how to handle calendar conflicts. If you select the Pool takes precedence option button, the resource calendars in the resource pool file take precedence when conflicts arise. If, however, you select the Sharer takes precedence option button, the resource calendars in the file that you're updating take precedence over the resource calendars in the resource pool file when conflicts arise.

6. Click OK.

If you switch to the Resource Sheet view of the file that you want to update, Project displays all the resources that are contained in the resource pool file, along with any resources that you may have set up in your project file.

You can now continue working in your project, or you can save your project and close it. You can also close the resource pool file.

**Opening a project that uses a resource pool**

At some point, you will save and close your file and then come back to work on it at a later time. You don’t need to open the resource pool file at that time. Instead, when you open your file after you have set it up to share resources, the Open Resource Pool Information dialog box appears, as shown in Figure 15-22.

![Open Resource Pool Information dialog box](image)

**Figure 15-22: The Open Resource Pool Information dialog box.**

When you select the first option, Project opens your file and the resource pool. If you select the second option, Project opens only your file. Project does not transfer any changes that you make to the resources in your file to the resource pool because the resource pool file isn’t open.

When you select the first option in the Open Resource Pool Information dialog box, Project automatically opens the resource pool file as a read-only file. This action enables you to make changes to your project without tying up the resource pool file; therefore, multiple users can use the resource pool simultaneously.
Updating information in the resource pool

If you make changes to resource information while you’re working on your project, you must update the resource pool file so that others who are using the resource pool have the most up-to-date information. To update the resource pool, make sure that the resource pool file is open, even in read-only mode. Then choose Tools ➤ Resource Sharing ➤ Update Resource Pool, as shown in Figure 15-23.

To ensure consistency and avoid arguments in the workplace, it’s best to make one group or person responsible for updating the resource pool.
If you forget to update the resource pool after you make a change in your project that affects the resource pool, Project displays a message, shown in Figure 15-24, when you close your project and save it.

![Figure 15-24: If you forget to update the resource pool, Project alerts you when you close and save your project.](image)

Starting with Project 2000, Project stores the relative path to projects that are linked to resource pools. If you move one or the other, Project is still able to open the files.

### Quit sharing resources

Suppose you decide that you no longer want to use the resource pool file. Follow these steps to disable the resource pool for a specific project:

1. Open that project.
2. Choose Tools ➪ Resource Sharing ➪ Share Resources.
3. Select the Use own resources option button in the Share Resources dialog box (refer back to Figure 15-21).

However, suppose that you decide that you want to disable the resource pool in general for all files that are sharing the resources of one resource pool. Do you need to open each file and disable resource sharing? No. Follow these steps to disable the resource pool file in general:

1. Open the resource pool file in read-write mode by using the Open dialog box—the same way that you would open any file. Project displays the Open Resource Pool box, as shown in Figure 15-25. Choose the middle option or the last option in this dialog box—either option enables you to disable the pool because both options open the file as a read-write file.
Figure 15-25: Use this dialog box to determine whether you open the resource pool file as a read-only file or a read-write file.

2. Choose Tools ➪ Resource Sharing ➪ Share Resources. Project displays the Share Resources dialog box, as shown in Figure 15-26.

Figure 15-26: The Share Resources dialog box.

3. Select the project(s) that you want to exclude from the resource pool. You can select multiple noncontiguous projects by pressing and holding down Ctrl when you click the mouse, or you can select contiguous projects by pressing and holding down Shift when you click the mouse.

4. Click Break Link.
Summary

This chapter described how to consolidate projects and pool resources. You should now know how to do the following:

✦ Insert projects
✦ Understand and work with consolidated projects and dependencies
✦ Manage the view of a consolidated project
✦ Display multiple critical paths
✦ Share resources

In Chapter 16, you read about using Project in an e-mail workgroup.
To paraphrase John Donne, no project manager is an island. Most projects involve you and at least one other person. The people who are involved in your project constitute your workgroup, and the project manager is the workgroup manager. Workgroups can vary in their structure. For example, on one project, you may manage it and coordinate activities of all its resources; on another project, you may simply be a member of a workgroup team that someone else is managing. In either case, you’ll be interacting with many people over the days, weeks, or months that it takes to reach your goal—and you need tools to make that interaction a success.

Project has many workgroup features to help you manage and work with other members of a project team, and Project permits you to collaborate by using either e-mail or the Internet. Project 2003 is the last version of Project that will allow users to collaborate using e-mail. For the past several versions, Project has been moving toward Web-based collaboration. In future versions, according to Microsoft, Web-based collaboration will be the only form of collaboration available, and the techniques that are described in this chapter won’t be available.

This chapter explores workgroup tools that you can use when collaborating via e-mail to accomplish the following tasks:

✦ For communication
✦ To make task assignments
✦ To keep your schedule up to date
In Chapters 17 through 22, you find out about using Project Server and Project Web Access, Project’s Web-based project management tool, to update and manage projects.

If you’ve used versions of Project prior to Project 2003, you may have noticed a significant change in Microsoft’s strategy for handling project management for workgroups using e-mail and using the Web; the change began in Project 2000. In Project 98, Project combined techniques for workgroup project management. In other words, you basically used the same techniques whether you used e-mail or the Web. Beginning with Project 2000, Microsoft separated the Web-based strategy from the e-mail strategy—and the techniques changed completely. This chapter focuses on using e-mail to manage projects in workgroups from the perspective of people who are using Microsoft Exchange Server and Microsoft Outlook.

When you use e-mail to collaborate, the project manager publishes assignments from Project and the team members updates and status information in the inbox of your organization’s e-mail program.

Setting Up an E-mail Workgroup

To use an e-mail–based workgroup, the manager and workgroup members must have access to a Messaging Application Programming Interface (MAPI)–compliant, 32-bit e-mail setup. MAPI is a standard e-mail interface that Microsoft supports with products such as Outlook, Microsoft Exchange, and Microsoft Mail, but it is common to other major e-mail products as well.

Because Microsoft is planning to disable this feature in future versions, you will need to edit your registry to use e-mail collaboration in Project 2003.

Editing the registry

Unless you add a key to the registry of each computer that is running Project, you can’t use the techniques that are described in this chapter. You don’t see the commands and dialog boxes.

Editing the registry incorrectly can keep your computer from booting. If you aren’t confident in your ability to follow these steps exactly, find someone with an advanced computing background to perform them.

Back up the registry before following these steps. In the Registry Editor window, choose File ➤ Export, and then save the file in a location that you’ll remember.
To add the registry key, make sure that Project is closed and follow these steps:

2. In the Run box that appears, type regedit. The Registry Editor window opens (see Figure 16-1).

![Registry Editor](image)

**Figure 16-1:** Use this window to edit the registry of each computer that is running Project.

3. Click plus signs (+) in the left pane of the window to navigate to the following key, which is shown in Figure 16-2:

   HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\MS Project\Options\ 

   The path for the key appears at the bottom of the Registry Editor window.
4. Click the **Options** folder so that it is selected (refer to Figure 16-2).

5. If you don’t see a folder called **Workgroup**, you need to add it. Choose **Edit** ➪ **New** ➪ **Key**. You see a new folder in the left pane of the Registry Editor window (see Figure 16-3).
6. Type **Workgroup** to name the key, and press Enter.

7. With the **Workgroup** folder selected, add a new String value by choosing **Edit** ➪ **New** ➪ **String Value.** You see a new entry in the right pane of the Registry Editor window (see Figure 16-4).

8. To name the new string value, type **Workgroup Mail** and press Enter. When you finish, your screen should resemble the one shown in Figure 16-5.

9. Close the registry.
Figure 16-4: Add a string value.

Figure 16-5: The registry after adding a new key and string value.
Installing the Project Workgroup Message Handler

To use e-mail to send and receive workgroups messages, all workgroup members (including the workgroup manager) must run an executable file called Wgsetup.exe, which will be available for download from TechNet at the Microsoft Web site. Search the download area of the Microsoft Web site for this file.

Some members of your team won’t have Project on their computers — and that’s okay. By running Wgsetup.exe, these members can have everything that they need to communicate via e-mail.

To run Wgsetup.exe, place the downloaded information on a network drive so that you can easily run the installation from each workstation that will be participating in the e-mail workgroup. Run Wgsetup.exe, and follow the on-screen prompts to install the Project Workgroup Message Handler.

Setting up the workgroup in Project

Within Project, you set up a workgroup by establishing a workgroup manager and the members of the workgroup. You can then exchange workgroup messages via e-mail. This exchange of information enables the workgroup manager to alert workgroup members to task assignments by using commands on Project’s Publish menu. Workgroup members can then return information to the workgroup manager via e-mail, which the manager can use for tracking progress throughout the life of the project. Finally, managers can use commands that are on the Publish menu to notify workgroup members about shifts in the schedule or other project parameters.

The workgroup manager builds and maintains the project schedule and makes task assignments. (In most cases, the workgroup manager is also the project manager.) The “boss” creates the schedule, makes assignments, and uses communications from workgroup members to track their activities.

Because Project Server is the preferred method of collaborating, and users of Project Server use many of the same dialog boxes as e-mail collaborators, you see references to Project Server in many of the screens that appear throughout this chapter.

As the workgroup manager, you must first install and set up Project to enable workgroup management on your computer. Although workgroup members can also install Project on their computers, this step isn’t necessary. On your computer, complete the following steps to set up a particular project to exchange information via e-mail:

1. Choose Tools ➤ Options.

2. Click the Collaborate tab to select it, as shown in Figure 16-6.
3. Open the Collaborate using list box, and choose E-mail only. Project displays a message indicating that Project Server is the preferred method of collaboration. Click OK to accept the message.

4. Click the General tab.

5. In the User name box, fill in the workgroup manager’s e-mail address, as shown in Figure 16-7, so that workgroup members who receive e-mail from the manager can respond to that e-mail.

6. Click OK to save your settings.
Building a Resource Workgroup

To use Project’s workgroup collaboration features, you first must assign resources to your project and designate them as belonging to your workgroup. When you create these resources, you enter an online address so that Project can communicate with them. Follow these steps to create a resource workgroup:

2. Enter a resource name and any other pertinent information about the resource in the columns of the Resource Sheet.
3. Double-click the resource name to open the Resource Information dialog box, as shown in Figure 16-8.
Figure 16-8: Enter a group name and e-mail address for every resource that you want in your workgroup communication circle.

4. Enter an e-mail address in the Email field.

5. Enter a group name in the Group field; this entry is required to use the workgroup features with this resource.

6. Select a workgroup from the Workgroup drop-down list. This choice should match the messaging method that you chose when you set up the workgroup manager’s connection.

7. Click OK to save the resource, which is now part of the workgroup and is set up for workgroup communications.

Tip

If you need to enter many e-mail addresses, you may find that editing is faster if you add a column to the Resource Sheet view for the e-mail address and the workgroup. See Chapter 7 to find out how to insert columns.

Communicating via E-mail

After a manager sets up a workgroup, both the manager and the workgroup members can use Project’s workgroup collaboration features. The manager uses Project’s collaboration commands on the Collaborate menu, as shown in Figure 16-9, to notify workgroup members of project-related information. In particular,
the manager uses three of the commands — All Information, New and Changed Assignments, and Republish Assignments — that appear on the Publish submenu as well as the Request Progress Information command on the Collaborate menu.

Figure 16-9: Use the Publish submenu when collaborating in an e-mail workgroup.

Publishing all information

After you (the workgroup manager) have set up the project, made assignments, and established a workgroup, you can automatically generate e-mail messages notifying resources of assignments. Choose Collaborate ➪ Publish ➪ All Information. Project indicates that it will save your project after sending e-mail messages. When you click OK, Project generates the messages and displays a dialog box stating that the process has completed successfully. In your project, you see indicators next to each task showing that an e-mail was sent but that no reply has been received, as shown in Figure 16-10.

Whenever you choose the All Information command, Project generates an e-mail message to all resources who have not yet responded to their assignments. Although other ways are available, workgroup managers can use the All Information command to nag resources if necessary.

Team members receive an e-mail that contains an attachment with the extension .MTM. When the team member opens the attachment, he or she sees the Publish All Information reply dialog box. To accept an assignment that was received through e-mail, the team member leaves the Yes in the Accept? column. To decline the assignment, the recipient double-clicks in the Accept? column to change Yes to No, or the recipient can type N in the Accept? column. Once the recipient clicks the Reply button, he or she is given the opportunity to enter a message, as shown in Figure 16-11. To send the message, click Send.
Figure 16-10: Indicators in your project let you know that you sent e-mail messages to each resource.

Figure 16-11: Use this dialog box to respond to an assignment.
After the workgroup member sends a reply, the workgroup manager receives an e-mail with the .MTM extension. When the workgroup manager opens the attachment, a dialog box that contains an Update Project button appears, as shown in Figure 16-12. The workgroup manager can click this button to transfer the changes to the project schedule. If the manager clicks the Update Project button, Project opens and applies the changes.

**Figure 16-12:** The response that the workgroup manager receives contains an Update Project button that is used to transfer changes automatically to Project.

## Publishing new and changed assignments

As the project progresses, you may need to make assignment changes. You can update resources about new and changed assignments by choosing **Collaborate** ➤ **Publish** ➤ **New and Changed Assignments**. Project displays the Publish New and Changed Assignments dialog box, as shown in Figure 16-13.

If you select only one task in the project, Project shows (by default) that everyone in the project will receive an e-mail assignment update. You can limit the e-mail update by selecting tasks prior to opening the dialog box; in this case, Project only shows resources that are assigned to the selected tasks.

The All Information command sends out messages to all resources about assignments—without showing the workgroup manager who will receive messages. If you want more control, use the Publish New and Changed Assignments dialog box and choose Entire project in the Publish new and changed assignments for drop-down list.
Figure 16-13: In this dialog box, you can see who will receive an e-mail message.

Project lists the task(s) to which the resource is assigned in a table below your message, indicating the following:

- The name of the task
- The amount of time that you expect the resource to work on the task
- The task start and finish dates
- Any comments that you entered in the Comments column of the Gantt table

You can choose to view the information either by resource or by task by clicking the appropriate option button toward the bottom of the dialog box.

Project automatically generates a message that asks the recipient to indicate his or her acceptance of the assignment. To view or change the message that each resource receives, click the Edit message text button to display the Edit message text dialog box, as shown in Figure 16-14.
Figure 16-14: In this dialog box, you can change the message that resources receive, along with their assignments.

You can modify the information in this table, as explained in the section Customizing Your Workgroup, later in this chapter.

When the information is correct in the Publish New and Changed Assignments dialog box, click the OK button to send the message. Project indicates that it will save your project after sending e-mail messages. After generating the messages, Project places indicator icons next to the tasks that are included in the message, just like the indicator icons that you saw in Figure 16-10. Project also places messages that you need to send in the outbox of your e-mail application.

Team members receive an e-mail that contains an attachment with the .MTM extension. When the team member opens the attachment, he or she sees the Publish New and Changed Assignments reply dialog box, as shown in Figure 16-15. To accept an assignment received through e-mail, the team member keeps the Yes in the Accept? column. To decline the assignment, the recipient double-clicks in the Accept? column to change Yes to No, or the recipient can type N in the Accept? column. If appropriate, the recipient can enter a message and click Reply.
Part V ✦ Working in Groups

Figure 16-15: Use this dialog box to respond to an assignment.

After the workgroup member sends a reply, the workgroup manager receives an e-mail with the .MTM extension. When the workgroup manager opens the attachment, a dialog box that contains an Update Project button appears (as shown previously in Figure 16-12). The workgroup manager can click this button to transfer the changes to the project schedule. If he does so, Project opens and applies the changes.

Republishing assignments

As the workgroup manager, you may feel the need to periodically republish assignments, even if they haven’t changed. You can republish all or selected assignments by choosing Collaborate ➪ Publish ➪ Republish Assignments. Project displays the Republish Assignments dialog box, as shown in Figure 16-16, which closely resembles the Publish New and Changed Assignments dialog box. When you choose this command, Project creates e-mail messages for all resources—even if you previously sent messages to and received replies from them.

Team members receive an e-mail that contains an attachment with the .MTM extension. When the team member opens the attachment, he or she sees the Republish Assignments reply dialog box, as shown in Figure 16-17. To accept an assignment received through e-mail, the team member keeps the Yes in the Accept? column. To decline the assignment, the recipient double-clicks in the Accept? column to change Yes to No, or the recipient can type N in the Accept? column. If appropriate, the recipient can enter a message and click Reply.
Figure 16-16: Use this dialog box to republish assignments.

Figure 16-17: Use this dialog box to respond to an assignment.

Note
The check boxes at the bottom of the Republish Assignments dialog box apply to Project Server.
After the workgroup member sends a reply, the workgroup manager receives an e-mail with the `.MTM` extension. When the workgroup manager opens the attachment, a dialog box that contains an Update Project button appears (as shown previously in Figure 16-12). The workgroup manager can click this button to transfer the changes to the project schedule. If she does so, Project opens and applies the changes.

**Requesting a status update**

As the workgroup manager, you may periodically want to request a status report from your team members. To do so, choose Collaborate ➪ Request Progress Information. Project displays the usual message about saving your project and then displays the Request Progress Information dialog box, as shown in Figure 16-18. You can select tasks prior to opening this dialog box to request status updates for the selected items.

![Figure 16-18: Use this dialog box to request status updates from some or all resources for some or all tasks.](image)

You can view information in this dialog box either by resource or by task. As with the other dialog boxes in this chapter, you can edit the message text and specify a time frame for which you want to receive status information.

The team member receives an e-mail message that contains an attachment with the `.MTM` extension, as shown in Figure 16-19.
Figure 16-19: To respond to the Progress Information request, the recipient clicks the Reply button — and the Reply button changes to the Send button.

While not visible in the figure, team members can scroll to the right in the Report period for section and edit the task information fields for Start, Remaining Work, and the days of the week. The team member enters information in the Remaining Work field that reflects actual work progress, optionally adds a return message about the status of the tasks, and then clicks Send to return the message to the workgroup manager. When the manager receives the response and clicks the Update Project button at the top of the message, Project uses the team member’s entries to automatically update the tasks in the actual schedule.

**Customizing Your Workgroup**

You can modify the task information that appears in your workgroup messages by using the customizing feature of Project. This feature enables you to add or delete items that appear in the task information fields, rearrange the fields, or request more detailed breakdowns of task timing.
Follow these steps to customize your messages:

1. Choose Tools ➪ Customize ➪ Published Fields to open the Customize Published Fields dialog box, as shown in Figure 16-20.

![Customize Published Fields dialog box](image)

**Figure 16-20:** Use the Customize Published Fields dialog box to include the information that is most relevant to your project in your workgroup messages.

2. To add a field, highlight the field in the Available fields list in the left side of the dialog box and click the adjacent right-facing arrow button (the Add button). If you add more than one new field, each new field appears above the field that was highlighted when you clicked the Add button.

   **Note**
   You can remove a field that you previously added. Click the name of the field that you want to remove in the Fields in the Tasks View list in the right side of the dialog box, and then click the left-facing arrow button.

   **Tip**
   If you have made several changes and want to return to Project’s standard settings for workgroup messages, click the Reset button in the Customize Workgroup dialog box.

3. Click OK to save the new settings.
Establishing Management Procedures

If you are responsible for managing a workgroup, your job involves more than just setting up your group to send and receive workgroup messages. You also need to orchestrate those communications and manage project files efficiently to get the most out of the workgroup structure. Use the following suggestions to guide you:

✦ Make sure that all workgroup members understand how Project’s workgroup features function. You (the workgroup manager) may be the only person in the workgroup to have a copy of Project on your computer. Help your team to understand not only how to use the workgroup features that are available to them but also why these features are important to using Project effectively.

✦ Set up a communication schedule with your workgroup. Make assignments and status requests on a regular basis, perhaps allowing a week or two of activity to occur before you perform updates. If workgroup members know that they will receive requests for updates and status reports every Friday, for example, and that they must respond by the end of the day every Tuesday, they can establish a routine to deliver the information in a timely way.

✦ Check your mailbox on a regular basis. If you aren’t being responsive to your workgroup’s input, they will stop being responsive to your requests.

Sending Notes and Routing Files

Project has two other tools that are helpful in communicating with various resources that are assigned to a project—regardless of whether they are part of your designated workgroup. First, you can send a project schedule note to selected resources that are assigned to the project. Second, you can route a project file from one resource to another. The ability to route notes and files can be useful if you want each resource to add information to the file or note and then forward it to the next person for his or her comments.

Sending Project notes

You can send a copy of your Project file, and perhaps a note to all resources or a subset of resources on a project, even if the resources are not part of your regular workgroup. Before beginning this procedure, select a specific task to send a note concerning the resources that are assigned to that task only. Otherwise, don’t select a specific task. To send a message through your MAPI-compliant e-mail system, follow these steps:
1. Choose File ➪ Send to ➪ Mail Recipient (as Schedule Note).

2. Select the people to whom you want to send the note in the Address message to panel of the Send Schedule Note dialog box, as shown in Figure 16-21. Your choices include the project manager, resources for the selected task or entire project, and contacts. Then select the appropriate options, as follows:

   • **Address message to:** If you want everyone on the project to get this message, select the Entire project option button. If you want only the resources that are assigned to the task that you selected before opening this dialog box to receive this message, choose the Selected tasks option button.

   • **Attach:** To attach the currently open Project file to your message, select the File check box. Remember, only those people who have Project installed on their computers can open the Project file.

3. Click OK. A new e-mail message form appears, with a copy of the Project file attached.

4. Type your message in the large, blank message area.

5. Use your e-mail addressing method to send the message to anyone other than the designated resources (that is, those who were automatically addressed when you created the message) that are assigned to tasks.

6. Send the message.

**Routing a Project file**

Routing a Project file to a group of people is another good way to keep workgroup members informed and involved in the project. Each person can add information that the next person along the route can build or comment on. Routing a file is a simple process. Follow these steps to do so:
1. Choose File ➪ Send To ➪ Routing Recipient to open the Routing Slip dialog box, as shown in Figure 16-22.

![Routing Slip dialog box](image)

**Figure 16-22:** The Routing Slip dialog box enables you to track your message as it moves along its route by selecting the Track status check box.

2. Click the Address button to display the address book for your e-mail program. Select as many addressees as you want by using this method, and then click OK to return to the Routing Slip dialog box.

3. Enter information in the Subject box.

4. Type your message in the Message text box.

5. Select one of the option buttons in the Route to recipients panel, choosing to route sequentially or all at once.

6. Select the Return when done check box if you want Project to return the file to you at the end of the route.

7. Select the Track status check box if you want Project to notify you each time that the file moves to the next person on the routing list.

8. Click Route to send the message.

**Tip**

If you are the last recipient of the routing, you can remove the routing slip from the Project file. Click the Remove All button in the Routing Slip dialog box.
Using the Web Toolbar

While you’re communicating by e-mail, you may also need to use the Internet, and as you may have found with other software packages, Project contains tools to facilitate interfacing with the Internet. Using the Web toolbar saves you time and effort. You can save lists of your favorite Web sites and go quickly to a site on that list by using the Web toolbar. Your favorite sites may include your company’s Web page, a newsgroup that’s related to your industry, or a data source, such as a university library, that you search often for information that is related to your project.

You can display the Web toolbar by right-clicking on the Standard toolbar and choosing Web from the shortcut menu that appears; or, you can choose View ➪ Toolbars ➪ Web. The tools that are available on the Web toolbar are shown in Figure 16-23.

Figure 16-23: The Web toolbar appears just below the Formatting toolbar, although you can drag it away to be a floating toolbar if you prefer.

The tools on the Web toolbar work with your Web browser to help you to navigate either an organizational intranet or the Web. Table 16-1 briefly describes each tool.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Takes you back to the last site that was visited during the current online session.</td>
</tr>
<tr>
<td>Forward</td>
<td>Moves you one site ahead in the list of sites that were visited during the current online session.</td>
</tr>
<tr>
<td>Stop Current Jump</td>
<td>Becomes active if you initiate a jump to a site; clicking this button when it’s active stops the hyperlink jump that’s in progress.</td>
</tr>
<tr>
<td>Refresh Current Page</td>
<td>Refreshes or updates the contents of a currently displayed page, incorporating any changes that were made by the author as you read the page.</td>
</tr>
<tr>
<td>Start Page</td>
<td>Takes you to the home page that you have set your Web browser to access by default.</td>
</tr>
</tbody>
</table>
To use these tools on the World Wide Web, you need an Internet connection and a Web browser. After you have all the elements in place, click the Search tool button (for example); Project connects with the Internet and opens the search page that you have set up in your browser. After you are connected, you can use the Back and Forward buttons to move through the Web pages. You can use your browser’s Favorites feature to save addresses of sites that you like to visit often; Project also saves these addresses in its own Favorites list.

You also can use the Web toolbar to open Project files that are located on a server or on your own hard drive; simply fill in the correct address in the Address box of the Web toolbar.

### Working with Hyperlinks

A hyperlink is a mechanism that enables you to jump from the currently displayed document to another document on your hard drive or on a computer network, or to an Internet address (referred to as a Uniform Resource Locator, or URL).

You can insert hyperlinks to Internet addresses within your project file. This way, you or someone who is using your schedule can move instantly to an area on the Web that contains related information or images. For example, if your project involves the design of a network for your company, you can insert a hyperlink in your schedule that links to the network software vendor’s home page so that you can find answers to technical questions or order software.

Or, suppose that your company is planning to move into a new manufacturing facility, and the Finance department has placed the budget for the move in an Excel spreadsheet on your company’s network. You, on the other hand, must manage the
move and have created a project schedule that deals with moving all the equipment into your new manufacturing facility. You can place a hyperlink in the project schedule that connects to the Excel file that contains the budget for the move to the new facility. The hyperlink appears as an icon in the Indicator field of the Gantt Chart. When you open the project file and click that hyperlink, the Excel file appears so that you can check on the budgeted dollars for each aspect of the move.

**Inserting a hyperlink**

To insert a hyperlink in your project, follow these steps:

1. Select the task for which you want to create a hyperlink. (After you finish inserting the hyperlink, a link icon appears in the Indicator column for the selected task.)

2. Choose Insert ➪ Hyperlink, or click the Insert Hyperlink button on the Standard toolbar. The Insert Hyperlink dialog box appears, as shown in Figure 16-24.

![Figure 16-24: Enter a file path and name, or a URL, to set up the hyperlink.](image)

3. Use the Look in list box to perform one of the following tasks:
   - To link to an Internet address, type the URL (for example, `www.microsoft.com`) or browse for a URL by clicking the Browse the Web button.
   - To link to a file on your hard drive or a network, type the path or browse for the file by clicking the Browse for File button.
4. In the Text to display box, type the text that you want to appear in your Project schedule to represent the hyperlink.

5. Click OK to insert the hyperlink. A hyperlink icon, like the one shown in Figure 16-25, appears in the Indicator field to the left of the selected task.

![Figure 16-25: To go to a URL or file, click the hyperlink icon.](image)

To remove a hyperlink, right-click the task for which you created the link and choose Hyperlink: Remove Hyperlink from the shortcut menu that appears. No warning appears; Project simply removes the hyperlink.

**Editing hyperlinks**

If you create a lot of hyperlinks, identifying them can be a tedious chore if you rely on the ScreenTip that you see when you point at each link. You can, however, display the links in one of Project’s built-in tables. Begin in any view that includes a table, such as the Gantt Chart view. Choose View: Table: Hyperlink. The hyperlink table shown in Figure 16-26 displays columns of information that are relevant to any links that you’ve created for your project.
Figure 16-26: The hyperlink address and representation are two fields that are available here.

To edit the hyperlink, its address, or its subaddress, click the name of the task for which you created the hyperlink. Then, use the right-arrow key to move to the cell that you want to edit and make the desired changes. You also can press F2 to make changes directly in the cell, or you can edit the cell contents in the Formula bar that appears below the toolbars in Project. If you prefer to work in the Hyperlink dialog box, right-click the link and choose Hyperlink ➤ Edit Hyperlink to reopen the dialog box and make changes.

Because the cells in this table contain hypertext, clicking the cell itself activates the link.
Moving or copying hyperlinks

You can also use the hyperlink table to move or copy a hyperlink by following these steps:

1. Select the hyperlink cell by clicking its task name and then by using the right-arrow key to select the hyperlink cell.
2. Press Shift and the right-arrow key together to also select the address of the hyperlink.
3. Do one of the following:
   - **To move the link**: Click the Cut button on the Standard toolbar, click the hyperlink cell next to the task where you want to move the link, and then click the Paste button.
   - **To copy the link**: Select the link, click the Copy button, click the hyperlink cell next to the task where you want to place a copy of the link, and then click the Paste button.

When hyperlinks don’t work

After you establish a hyperlink, some things can happen to stop the link from working. This condition usually involves a change in the location of the linked file. On a network or hard drive, a file may simply have been deleted or moved to another directory. Similarly, a Web site may have been moved to a new URL, or perhaps it no longer exists.

Or, you may have mapped your hyperlink to a file on a network that is in a location to which you don’t have access. Perhaps you gave a copy of your schedule to a coworker, and she doesn’t have access to that location from her computer.

The best way to work around this problem is to use relative addressing whenever possible when you create the hyperlink. For example, `f:\budget.xls` is an absolute address. If your server drive changes from F:, the link won’t work. However, if you use `\server\share\budget.xls`, a relative address, your server drive can change from F: to G:, for example, and the relative address to your server still works. For more help with hyperlink problems, check out the topic “Hyperlink troubleshooting” in Project’s Help feature.
Summary

Because most projects are team efforts and because successful teams communicate effectively, establishing good workgroup procedures in your projects is key. And, Project’s Web capabilities enable you to link files or to create links from a file to an Internet address. These simple Web features can help you to communicate project information to coworkers or clients in an effective, high-tech way. In this chapter, you read about how to do the following:

✦ Set up the workgroup manager and workgroup members to send and receive project information via e-mail
✦ Use commands on the Collaborate menu to keep members informed and update the project file
✦ Route messages and files among team members
✦ Use the Web toolbar
✦ Work with hyperlinks

In addition to knowing how to use these features, you must know how to set up effective, consistent procedures for use among your workgroup members.

In Chapters 17 through 22, you find out about Project Server, a Web-based way of working with Project and schedules.
Project, Project Web Access, and Project Server

In This Part

Chapter 17
Preparing to Use Project Server

Chapter 18
Installing and Configuring Project Server

Chapter 19
Organizational Roles and Project Server: The Administrator

Chapter 20
Organizational Roles and Project Server: The Project/Resource Manager

Chapter 21
Organizational Roles and Project Server: The Day-to-Day User

Chapter 22
Organizational Roles and Project Server: The Executive
Preparing to Use Project Server

You’ll be tempted, but don’t skip this chapter. I know it sounds like a pun when talking about project management software, but planning the implementation of Project Server (a project) will be the single most important action that you can take to ensure a successful venture.

Implementing Project Server isn’t only about hardware configurations and installing software. It’s about planning for the needs of your organization so that you can correctly configure Project Server. It’s about assessing where your organization is today and where it plans to go. It’s about identifying the players, their needs, and their roles in the process. It’s about figuring out what needs to be done, who has the skills and availability to do it, when it needs to be done, and what else depends on it getting done.

In this chapter, you review the process that you need to follow for your organization to accept the changes that using Project Server will bring and make the changing process successful and as painless as possible.

Understanding Project Server and Project Web Access

The concept behind Project Server is that all the projects that your organization manages affect each other, and the need for collaboration on projects is greater than it has ever been. As the number of projects and the size of your organization grow, so does the need to manage the management of projects. Project Server enables you to store all projects and all resources for the organization in one central database on your company’s local-area network (LAN) or intranet so that limited resources can be matched to projects. Only the project
manager must actually install and use Project Professional. All other resources on
the project use Project Web Access, a browser-based product, to view project data
that is stored in the Project Server database. Using Project Server and Project Web
Access (and without using Project Professional), team members, managers, and
executives can accomplish the following:

✦ Enter and view time sheet information
✦ View a project’s Gantt chart
✦ Receive, refuse, and delegate work assignments
✦ Update assignments with progress and completion information
✦ Attach supporting documentation, such as budget estimates or feasibility
  studies, to a project
✦ Receive notices about task status
✦ Perform analysis and produce organization-wide reports
✦ Carry out basic issue and risk management
✦ Send status reports to the project manager

For more detail about the roles of managers, team members, and executives, see
Chapters 21, 22, and 23, respectively.

Here’s how the process works in general. The network administrator (or someone
with similar skills and network privileges) installs Project Server on a Web server or
the company’s server. The project manager creates a project in Project Professional
that is “Web-based.” When the project manager is ready to store the project in the
Project Server database, he or she publishes the project information. At this point,
anyone with Internet Explorer 5.5 (or a later version), access to the Project Server
database, and viewing rights can view the project information as it appears in
Project Professional by using Project Web Access, the browser-based client side of
Project Server.

For details on the hardware and software that are needed for Project Server, see
Chapter 18.

Using a variety of tools, the project manager can assign resources to the project
using as a company-wide pool of available resources that are stored in the Project
Server database. Team members can see, in Project Web Access, the assignments
that they have received and use Project Web Access to update work assignments,
send status reports to the project manager, and even set up to-do lists.

The project manager uses both Project Professional and Project Web Access, but
other project resources use only Project Web Access.
Using the Outlook add-in that's available in Project Web Access, resources can import tasks from Project Server and export work information from Outlook to Project Server.

For more information on using Outlook with Project Web Access, see Chapter 22.

Project Server enables you to create consistent projects that use the same custom settings. Using the Enterprise Global template, each project that you create contains all the same fields, maps, views, tables, reports, filters, forms, toolbars, groups, and calendars that are stored in the global template file that's included in Project Professional, along with additional enterprise-only fields. Administrators can define whether fields are required and can create look-up tables and value lists for fields. Because the settings are stored in the Enterprise Global template, they can be used repeatedly without having to re-create information.

Does your organization need Project Server? The following is a list of scenarios where Project Server would work well:

✦ You manage many different projects using the same resources.
✦ Your organization is growing and has identified a need for tracking projects more accurately or utilizing resources more efficiently.
✦ Your organization has determined that the time of project managers and resources time would be used more efficiently if resources could record their time directly in the project schedule instead of providing it to the project manager, who then updates the schedule.
✦ Your executives want better organization-wide reporting and analysis tools than you can currently provide.
✦ Your managers need to model if-then scenarios.
✦ Your users need access to project data anywhere in the world.

Project Server was originally designed as a LAN-based product. If your organization uses a LAN and wants one central database to store both projects and resources, Project Server should meet your needs.

Suppose that your organization uses a wide-area network (WAN). You can still use Project Server, but performance will not be as good as the performance that you can achieve on a LAN, unless you use additional software such as Terminal Services, Citrix, or New Moon.

See Chapter 18 for more information related to using Project Server in a WAN environment.
Planning the Project

If you simply think about the implementation of Project Server the same way that you think about planning other information technology projects, you won’t be surprised to find out that you need to take the same actions, which are as follows:

✦ Assess requirements  
✦ Design the system  
✦ Develop an implementation strategy

Assessing requirements

Determining your organization’s direction and needs may be the most important phase of the implementation process, because the Project Server design ultimately depends on the information that you gather.

Start by setting up a team to implement the system. You’ll need people who are good at gathering information, making design decisions, and managing implementation. Be sure to include people who are experienced in using enterprise project management systems. You’ll need a mix of businesspeople and technical people to address the various facets of implementing Project Server. The businesspeople should include senior project managers and staff with experience using Project. The technical people should include those who are experienced in your company’s network architecture and hardware configuration and, to customize or automate Project Server functions, should include a technical person with skills in developing object models for Project. Everyone on the team should be familiar with your company’s standards.

If you find yourself missing key team members, check the CD that comes with this book. It contains the Project 2003 Bible Web page, on which you’ll find links to the sites of many Project Partners—companies that are experienced in doing project management and in using and implementing project management systems, Microsoft Office Project Professional, and Project Server.

The team needs to set milestone dates and task durations for each of the activities in the next five sections.

**Identify the people who will approve the Project Server design**

It is important to identify the decision-makers up front. If possible, include one or more of them on the team so that they are a part of the process and they feel ownership for the system that you ultimately design.
Identify staff members to interview

Identify people who fill the following roles:

✦ **Team members**: People to whom work is assigned.

✦ **Resource managers**: People who delegate work to team members and monitor project progress and resource utilization.

✦ **Project managers**: People who prepare project plans.

✦ **Portfolio managers**: People who are familiar with company standards and can manage the Enterprise global template as well as other enterprise templates. The portfolio manager may also manage enterprise resources.

✦ **Executives**: People who view reports on projects and resources.

✦ **Administrators**: People who manage changes and access to the Project Server database. The people who start the administrator job may ultimately phase out of the job, because the job changes over time. Initially, the administrator installs and sets up Project Professional, Project Server, and SQL Server and may use both Project Server and SQL Server tools to meet the needs of users. Eventually, the administrator role becomes a maintenance function, where knowledge of Project Server administrative functions is the only prerequisite.

In some environments, the resource manager, project manager, and portfolio manager may all be the same person.

Create a requirements definition questionnaire

To effectively interview, the team should create a questionnaire to obtain information about how people work. To gather information for your questionnaire, use the reports that your company currently uses to record project performance. Evaluate each report to identify the resources and projects that are (or should be) included on the report; how tasks, projects, and resources are categorized; and who uses each report. To help you produce your questionnaire, you may want to download Microsoft’s Enterprise Information Framework (EIF), a series of documents that describe implementing Project Server. In particular, the EIF Interview spreadsheet contains sample questions and codes them based on who should answer the question. Then, the Requirements Specification document assigns the question to a category that helps you identify how each question can help you with some aspect of the implementation. You can download the EIF at the following Web site:

www.microsoft.com/technet/prodtechnol/project/project2002/reskit/toolbox/tbdply.asp

Click the Microsoft Project Enterprise Information Framework Files link, and download the file eif.exe.
Some of the Project Partners have developed their own questionnaires to help define requirements and design the system. For example, Project Server Support, Inc., has created the EWQ (Enterprise Web Questionnaire), which is role-based and customizable and includes reports.

**Conduct interviews**

When you conduct interviews, make sure that you include more than one person in each role. Because no two people are identical, two people filling the same role do things differently and potentially have different needs.

**Calculate ROI**

As part of your organization’s consideration of using Project Server, you should calculate your return on investment (ROI). Implementing Project Server will require software and role-based training for resources, and it may also require investments in hardware. Don’t skip this important step; use whatever technique your organization has developed to calculate ROI to assess the costs and benefits of implementing Project Server.

**Designing the system**

You design your Project Server system using the information that you gathered while defining requirements. This information should help you identify which features in Project Server you want to implement. The EIF also contains a System Design workbook and guide that can help you transfer your requirements information into Project Server database elements.

As a part of the design process, the implementation team must also address issues that are not directly related to the construction of the Project Server database.

**Assessing the technology environment**

As you find out in Chapter 18, Project Server requires certain software, and the hardware that you use affects the performance of Project Server. You must evaluate the software and hardware that you have, as well as your network architecture, and factor in costs and time lines for upgrading as necessary.

**Addressing special needs**

From the requirements definition, you need to identify whether your organization wants to construct a document library and deal with issues in a collaborative way. To use these Project Server features, you also need Windows Sharepoint Services (formerly called Sharepoint Team Services), which comes with Windows 2003 Server.
Project Server comes with some standard e-mail notifications that it can send when certain conditions are met. Your organization may want to add to these notifications; if so, the implementation team needs to create these special e-mail notifications.

The implementation team also needs to customize the Project Guide, which was introduced in Project 2002, if the requirements definition indicates that customization would benefit your organization.

**Establishing and enforcing organizational standards**

To use an organization-wide project management tool, you need shared terminology across projects that all project managers use. All managers need to apply the same processes and procedures to their projects. If your organization doesn’t already have standardized language, processes, and procedures in place, you’ll need to develop them. If your organization has established standards, your standards may or may not work within the framework of Project Server.

Project Server contains several features that can help you establish and enforce standards in your organization’s project management efforts. The Enterprise Global template — comparable to the Global template in Project Professional — contains a collection of all default settings that are used by projects across your organization. Someone with administrative privileges in your company customizes the Enterprise Global template so that it contains the custom fields, look-up tables for outline codes, views, and calendars that meet the needs of your organization. When a project manager creates a new project, the project is based on the Enterprise Global template, enforcing standard usage across all the organization’s projects. The Enterprise Resource Pool helps you ensure that resource names, definitions, contact information, and calendars are consistent across all projects.

**Custom fields**

You create and use custom fields to meet some specific need concerning the data that your organization uses in its projects. Project enables you to create custom fields to assign to either resources or tasks. Because Project Server stores custom fields in the Enterprise Global template, you can enforce standards across projects by setting up custom fields for all project managers to use on all projects.

In Chapter 19, you find out about creating custom fields.

**Outline codes**

Outline codes can be used to produce work breakdown structures or organization breakdown structures to provide different ways of looking at tasks, resources, and projects. Project uses outline codes to help create these different structures. Outline codes, also stored in the Enterprise Global template, can be standardized by using look-up tables for the values that are available for the outline codes. In this way, projects remain standardized because everyone uses the same set of outline codes.
In Chapter 7, you find out about outline codes.

**Views**
The administrator creates views in the Project Server database to control the information that is seen by various Project Web Access users. For each view, the administrator specifies the format of the view, grouping of information on the view, any filters for the view, and the categories to which the view belongs. Because views are stored in the Enterprise Global template, information views by Project Web Access users are standardized.

In Chapter 19, you find out about creating views.

Views that the project manager creates and uses in Project Professional are based on the Enterprise Global template. The fields that are used to create views in Project Web Access are stored in the Enterprise Global template, but the views in Project Web Access are unique to Project Web Access and are *not* based on the Enterprise Global template. Views that are created in Project Professional cannot be duplicated in Project Web Access.

**Calendars**
Project makes use of the following four types of calendars:

- **Base calendar**: Provides the source information for the other three types of calendars.

Project provides the following types of base calendars (you can customize others):

  - Standard (Monday through Friday, 8 a.m. to 5 p.m., with an hour break)
  - 24-hour
  - Night-shift

Chapter 3 covers base calendars.

- **Project calendar**: The base calendar that is assigned to a specific project.

Chapter 3 covers project calendars.
Resource calendar: Assumes the working and nonworking times of the project calendar for a resource, and can be customized to show the following resource data:

- Nonstandard working times
- Planned time off

Chapter 10 covers resource calendars.

Task calendar: Assumes the working and nonworking times of the project calendar for a task, and can be customized to show nonstandard working time. The task calendar is useful for situations such as shutting down a server for maintenance during nonbusiness hours.

Chapter 4 covers task calendars.

Enterprise resource pool
By using an enterprise resource pool, you can share resources between projects and identify conflicts between assignments in different projects. An enterprise resource pool is simply a central repository of all available resources. By storing information about all resources, their calendars, and their assignments in one place, you can manage resource utilization and sharing more easily because resource information across your company is standardized; every project manager knows the skills and availability of every resource.

You find out more about the enterprise resource pool in Chapter 19.

Training
Chapters 20 through 23 describe the ways that various organizational members may use Project Server. Each role player requires training to successfully fill his or her role. Factor both the time and the cost of training in your project plan.

Developing a strategy for implementation and configuration
Project Server isn’t the type of software that you install and then immediately start using. To make your implementation successful, you should plan it as a phased process.
Consider first creating a prototype of the system, and from your requirements document, identify a few projects and project teams to participate in the prototype test. Make sure that you select users who represent all the various roles that were identified earlier so that you can fully test the system. Also, select projects that don’t depend on other projects that won’t be a part of the prototype. Design and develop the prototype system, and demonstrate it to the implementation team. Make modifications to the prototype design based on input from the implementation team, and demonstrate the prototype to senior management. Again, make changes as needed.

Don’t assume that project managers who have been using Project Professional for years can build plans that are suitable for the enterprise. For portfolio analysis and resource management to have meaning across the enterprise, plans and resource management must be consistent and standard across projects.

Once you complete the prototype, you need to develop training materials and, once again, select projects and project teams that represent each of the roles that were identified earlier to participate in the pilot phase. Reset the Project Server database, and load the pilot projects. At this stage, you should include at least one project that has external dependencies to another project to test that aspect of usage, and then make adjustments as needed. Train the pilot group, and allow them to use Project Server for at least four reporting cycles. Be sure to solicit feedback so that you can address all the issues that arise.

Identify groups to which you can open the system, and plan the timing of each group’s introduction to the system. As you introduce each group, you need to add their projects to the Project Server database and provide training to the group. Allow enough time for each group to get up and running before introducing the next group.

Once you’re satisfied that you’ve ironed out any kinks that were identified during the prototype and pilot phases, expand the user base of the system again, adding projects to the Project Server database based on the groups that you identified, and train the new group that is to begin using the system. Allow each group to work through at least three reporting cycles before you add additional groups. Remember, as you add new groups, you must provide training to users.

Avoiding the Pitfalls

You need to consider one last subject — avoiding the pitfalls that are associated with implementing Project Server.

When you define requirements, be sure that you ask how many projects each project manager expects to be managing at any one time and determine the average
size of the project. You may discover that some project managers define a project differently than others. This presents a problem only if you find that project managers tend to manage many projects, and each project has only one or two tasks. In cases like these, defining these projects as separate entities in Project 2003 will make maintenance difficult. You may instead want to combine these smaller projects into one larger Project 2003 file.

Also ask both project managers and team members about the current reporting process. Ask whether the organization has one, and determine whether it works or whether people regularly bypass it. If people bypass the reporting process, try to determine why. The process may need to be changed to better suit the needs of those who are using it. If you expect to produce accurate reports and forecasts, the information that you provide to Project 2003 needs to be accurate and timely.

Determine whether the organization considers available resources when it accepts projects. If it does not, it will probably experience changes to project scope, costs, and resources regularly, and Project 2003 won’t provide accurate information about resource requirements. Try to get senior management to agree to new methods that include the evaluation of resource needs when considering new projects.

Ask different role players how they deal with problems that arise on projects. If you get different answers from different people, then you don’t have a company-wide mechanism in place that deals with resolving problems. In such cases, only some projects will be accurately reporting status, and any comparison or forecasting that you do will be inaccurate. To solve this problem, find a method that you can standardize across the organization. Define what tools to use to look for problems, when to use these tools, what options are available to solve problems, and who needs to be in the loop to resolve problems.

Don’t forget to establish a method to deal with problems while implementing Project Server—that is, make sure that the implementation project has a mechanism to address problems.

Ask project managers about the methods they use to analyze performance. Determine whether they use earned value, and identify the method of earned value. Project supports only the Percent Complete and Physical Percent Complete methods. If the organization is using some other method or uses methods inconsistently throughout the organization, you can’t accurately analyze performance across the organization.

Identify the types of costs that the organization wants to track, because Project tracks costs by calculating the cost of resources using rate tables or fixed costs. Many projects have sizeable costs that are not resource related. The implementation team must make it clear to the organization exactly what Project can and cannot calculate.
Phase the introduction of Project Server into your environment to avoid disrupting your regular business process, but don’t let more than six months pass without introducing a new group to Project Server. In this way, you interrupt your business only minimally, but you don’t lose the momentum of the implementation.

Identify the criteria that the implementation team needs to meet to have the system accepted by management as well as by team members. Keep those criteria in mind through all phases of the process.

Summary

To successfully implement Project Server, you must think of the process as a project that needs to be managed. By its nature, this project is an information technology project that affects the majority of your organization.

In this chapter, you reviewed the following items:

✦ Understanding the basic functioning of Project Server and Project Web Access
✦ Defining requirements
✦ Using requirements to identify elements that are needed for the Project Server database
✦ Developing a strategy to implement the Project Server database
✦ Avoiding pitfalls while implementing Project Server

In Chapter 18, you find out about installing Project Server.
Installing and Configuring Project Server

This chapter is aimed at IT administrators — the people who handle the hardware and software setup. If you’re an everyday user or a project manager, you probably won’t enjoy this chapter very much.

To install and use a Project Server database, you must install certain software — and, in some cases, the software that you install depends on the features of Project Server that you decide to use. The hardware that you use must also meet some basic specifications. And, you need to consider the user and network environment in which you will run Project Server to maximize performance.

In this chapter, you read about the software that you need, the basic hardware specifications, and the network issues that affect Project Server performance. You also find some sample hardware configurations that you may consider, given your user and network environment. You work through installing peripheral software, such as IIS and Windows SharePoint Services, and then you install Project Server. And finally, you find a troubleshooting section that addresses some of the problems that you commonly encounter.

Reviewing Requirements

While Project 2002 and Project 2003 can work together, I advise you to connect Project Professional 2003 to Project Server 2003, rather than connecting some combination of Project 2002 and Project 2003 versions. Read the next three sections completely before you install anything; you’ll have a more complete picture of the process if you do.
Meeting software requirements

As you would expect, the software requirements for servers differ from those for client computers.

Software requirements for servers

For basic use of Project Server, you need, at a minimum, Windows 2000 Server with Service Pack 3 or above and Microsoft Internet Information Server (IIS) 5.0 or above. When you install Project Server, it sets up a connection between your database engine and IIS.

For your database engine, you need SQL Server 2000 with Service Pack 3 or higher. If you want to use the portfolio modeling features that are available in Project Web Access, you need SQL Server Analysis Services, which is included with SQL Server but must be installed separately.

Microsoft also recommends that you use Windows Server 2003 as the operating system platform for Project Server, and if you want to use the documents and issues features of Project Server, you must be running Windows Server 2003 (the shipping build — if you were a tester, you need Build 3790 or above) and Windows SharePoint Services (WSS), formerly called SharePoint Team Services. Microsoft WSS is available for download at the Windows Update Web site (the link listed below) where you will find WSS by scanning for updates. WSS requires the NT File System (NTFS).

If you use Windows Server 2003, your version of IIS is 6.0.

A word to the wise: Windows Server 2003 Enterprise requires SQL 2000 Service Pack 3 (SP3); it will not work with SP2. At the time of this writing, Microsoft did not have a version of SQL 2000 with Service Pack 3 available either as a download or on CD; that is, you needed to install SQL 2000 Service Pack 2 and then apply SP3. If you are upgrading to Windows Server 2003 Enterprise (I can't speak for other versions of Windows Server 2003), be sure that you apply SQL 2000 Service Pack 3 before you upgrade. That way, you avoid the “catch-22” that I encountered that forced me to ultimately reformat my drive, load an older version of Windows, load SQL 2000 with SP2, apply Service Pack 3, and then upgrade to Windows Server 2003.

To use e-mail notifications, both the server and client machines need Microsoft Exchange 5.5, 2000, or later or Internet SMTP/POP3, IMAP4, or MAPI-compliant messaging software.
Software requirements for client computers
On the client side, the project manager needs Project Professional, but other resources need any of the following:

- Internet Explorer 5.01 with Service Pack 3
- Internet Explorer 5.5 with Service Pack 2
- Internet Explorer 6.0 with Service Pack 1

If you plan to import and export tasks between Project and Outlook, the client machine also needs Office 2000 with Service Pack 1, Office XP, or Office 2003.

Meeting hardware requirements
The recommendations in this section come from Microsoft and depend largely on the number of services that you intend to install.

Hardware requirements for servers
Typically, you install Project Server on a Web server or on the company’s server. If you’re planning to use the bare-minimum hardware, you should load only Project Server on that computer. Other components, such as Windows SharePoint Services (WSS) and SQL Server, should run on separate computers.

Microsoft recommends that you install Project Server on a computer with a minimum Pentium III processor that runs at 700 MHz and has 512MB of RAM. If necessary, you can run Project Server on a Pentium III, 550-MHz machine with only 128MB of RAM. This computer must also have a CD-ROM drive, a Super VGA (800 × 600) or higher resolution monitor, and a Microsoft Mouse–compatible pointing device.

For the computer on which you install Project Server, you need 50MB of available hard drive space. To install WSS, you need another 70MB of hard drive space and a minimum of 256MB of RAM — 512 MB of RAM is recommended.

To install SQL Server 2000, you need 250MB of hard drive space and 64MB of RAM — 128MB is recommended. If you also intend to install SQL Analysis Services, you need another 130MB of hard drive space and another 64MB of RAM — another 128 MB is recommended.
**Hardware requirements for client computers**

Microsoft recommends that each client machine have a 300-MHz processor, have 192MB of RAM, and use Windows XP Professional as the operating system. The minimum processor on a client machine is a Pentium 133-MHz. Each client machine should have a Super VGA (800 × 600) or higher resolution monitor with 256 colors and a Microsoft Mouse–compatible pointing device.

**Assessing the network environment**

The total number of users, the number of concurrent users updating the Project Server database, and the number of projects that you store in the Project Server database are directly related to the amount of traffic that you can expect on your network. Using older network architecture (10Base-T) in a heavily trafficked environment will undoubtedly result in complaints that the system is slow. You may want to plan to upgrade your network infrastructure.

Project Server is designed as a local-area network–based product that can provide one central database to store projects and resources. If your organization wants to use Project Server across a wide-area network (WAN), plan to use Terminal Services, Citrix, or New Moon software to improve performance.

**Considering software/hardware scenarios**

The hardware/software configuration that works most effectively in your environment is influenced by the following factors, which contribute to the overall performance of Project Server:

- The total number of users
- The number of concurrent users
- The number of projects that you want to store in the Project Server database
- The features of Project Server that you want to use

As you already know, you must install IIS and SQL Server. Optionally, you can install SQL Analysis Services and Windows SharePoint Services. In addition to this software, Project Server itself loads four additional services: Views Notification Service, Trace Service, Session Manager, and Scheduled Process Service. Succinctly stated, you’re loading a lot of software.

But you have some choices about how you load the software, and the choice that you make will affect the performance of Project Server. Consider the following possible setups, each with the potential to improve performance:
✦ **One server:** In this scenario, you install all the software on one server.

✦ **Two servers:** In this scenario, you load Project and Windows SharePoint Services on one server, and SQL 2000 and Analysis Services on a separate server.

✦ **Three servers:** Using this approach, you load Project Server on one server, Windows SharePoint Services on a second server, and SQL 2000 and Analysis Services on the third server.

✦ **Six servers:** In this scenario, you install the software as follows:

- Server 1: SQL 2000
- Server 2: SQL Analysis Services
- Server 3: Windows SharePoint Services
- Server 4: Project Server *without* the Views Notification Service and the Session Manager Service
- Server 5: Views Notification Service
- Server 6: Session Manager Service

When views are published, loads increase. Off-loading the Views Notification Service to a dedicated server helps improve performance by isolating this processor-intensive task to a server that doesn’t need to also support other activities.

Obviously, these are not the only possible scenarios; I’m trying to offer you some options to consider.

As another approach, you can balance the load by separating the storage of core projects onto one server, core project tables onto another server, and views onto a third server.

The one-box approach makes installation and maintenance particularly easy. However, depending on how your environment stacks up when you review the four factors that affect Project Server performance, this approach could be dysfunctional for your organization. Each of the other approaches *can* improve performance in that each reduces the load for a particular server. But a server’s performance is also affected by the hardware that you use and by your network infrastructure. See the section “Troubleshooting,” later in this chapter, for more information.

So, how do you know which configuration to consider? As a rule of thumb, if you have less than 250 users and projects, start with the one-server configuration. For each additional 250 users and projects, consider adding servers. In addition, put SQL 2000 on the server with the fastest CPU and the most memory. And, if you’re expecting growth in your organization, plan your implementation with the growth factored in to the configuration.
The number 250 (of users) is a rule of thumb, and I can't offer you absolutes here. Each project varies in size, based on the number of tasks, resources, and assignments, so you're not dealing in absolute numbers. Assume that small projects have 100 or fewer tasks and assignments and approximately 10 resources, medium-sized projects have 500 tasks and assignments and approximately 50 resources, and large projects have 1500 tasks and assignments and approximately 150 resources. If you have predominantly large projects, the rule-of-thumb number is too high for you. Similarly, if you have predominantly small projects, this number is too low for you.

**Installing Peripheral Software**

Let me state upfront that this is a long, labor-intensive process. For those of you who have installed Project Server in the past, you'll find the process somewhat easier, but it still is a long process that requires user intervention.

If you are upgrading from Project Server 2002 to Project Server 2003, you can find documents on the Project Server CD that describe the process for you. You can also find documents that tell you how to migrate from SharePoint Team Services to Windows SharePoint Services. Follow those documents, but in this chapter, the information applies to new installations.

Before you install Project Server, you need to install Windows 2000 with Service Pack 3 or Windows 2003 (the released version — not a beta version) or above. You also need to install SQL Server 2000 with Service Pack 3 and, if you’re going to use the Portfolio Management feature of Project Server, SQL Analysis Services (also with Service Pack 3). If you’re going to use the document and risk management features of Project Server, you also need to install Microsoft Internet Information Server (IIS) 5.0 or above and Windows SharePoint Services. You have a lot of software to install and configure before you ever get to installing Project Server.


As you saw from the preceding section, you don’t need to install all products on one machine, but you must install all products before you install Project Server. And, you need to adjust some of the settings for most of these products.

Please don’t try skipping anything. You will not be a happy camper. A successful installation for Project Server depends on first installing and configuring the peripheral software. The author of *Microsoft Project 2003 For Dummies* (published by Wiley Publishing, Inc.) and I worked through her installation together, and she learned the hard way that installing these programs out of order can be very painful — and, to quote her, “can really make you feel like a dummy.”
After installing SQL Server and Analysis Services following the instructions that are provided by Microsoft, add an SQL Server account used only by Project Server that belongs to the Database Creators and Security Administrators roles. Use SQL Enterprise Manager to add the new Security Login (select SQL Server Authentication and the correct roles). Then verify in SQL that you are using the correct version and that SQL is operating in Mixed mode.

Checking the SQL version
To confirm that you are using SQL 2000 with Service Pack 3 or higher, in Windows 2003, choose Start➪All Programs➪Microsoft SQL Server➪Query Analyzer.

In the top portion of the SQL Query Analyzer window, type the following query and press F5 (see Figure 18-1).

```
Select @@version
```

![Figure 18-1: Use this query to check the version of SQL.](image)
In the bottom of the window, you see the version of SQL that you have installed. Any version equal to or higher than 8.00.760 is acceptable.

If you don’t have SQL with Service Pack 3 installed, you can download Service Pack 3 from the following URL:


When you get to this Web site, you find three files to download. When you execute each file, it, in turn, places batch files on your computer; you need to run all of them. Once you’ve run them, use the Query Analyzer to double-check your version.

**Setting SQL to operate in Mixed mode**

SQL Server must operate in Mixed mode—that is, using either Windows Authentication or SQL Authentication. To confirm or change this setting, follow these steps:

1. Open the SQL Enterprise Manager by choosing Start ➪ All Programs ➪ Microsoft SQL Server ➪ Enterprise Manager.

2. In the left pane of the window, click the plus signs to open the tree until you find your SQL server, and then select it (see Figure 18-2).

![Figure 18-2: Select your SQL server.](image)
3. Choose Action ➪ Properties to display the SQL Server Properties dialog box (see Figure 18-3).

![SQL Server Properties dialog box](image)

**Figure 18-3:** The SQL Server Properties dialog box.

4. Click the Security tab and, if necessary, select the SQL Server and Windows Authentication option.

5. When prompted to stop and restart the SQL Server service, click Yes, and wait while SQL stops and restarts.

### Internet Information Services (IIS)

IIS is a Windows component, and it is *not* enabled by default when you install Windows. You need IIS if you intend to use Windows SharePoint Services. If you’ve already enabled IIS, skip to the next section.

#### Enabling IIS

In the Control Panel, choose Add or Remove Programs. In the Add or Remove Programs window that appears, click Add/Remove Windows Components. Then, follow these steps to enable IIS:
1. In the Windows Components window, highlight Application Server and click the Details button.

2. Select the Application Server check box, and click the Details button.

3. Select the ASP.NET check box.

4. Select the Internet Information Services (IIS) option (see Figure 18-4), and click the Details button.

![Figure 18-4: After selecting the ASP.NET check box, highlight Internet Information Services (IIS) so that you can click Details.]

5. In the Internet Information Services (IIS) dialog box, select the Internet Information Services Manager check box.

   If the FrontPage 2002 Server Extensions check box is selected, click to deselect it.

6. Select the World Wide Web Service check box, and click Details (see Figure 18-5).

7. In the World Wide Web Service dialog box, make sure that the Active Server Pages check box and the World Wide Web Service check box are selected.

8. Click OK three times to redisplay the Windows Components Wizard dialog box.

9. Click Next. Windows installs the selected components.

10. Click Finish.
Checking the IIS mode
For Project Server components to function properly, IIS cannot run in Isolation mode. To confirm or change the IIS mode, follow these steps:

2. Click Internet Information Services (IIS) Manager to display the Internet Information Services (IIS) Manager window, as shown in Figure 18-6.

Figure 18-6: Use this window to check the mode in which IIS is running.
3. In the left pane, expand the tree to view the Web Sites folder.
4. Right-click the Web Sites folder, and choose Properties from the shortcut menu that appears.
5. In the Web Sites Properties dialog box that appears, click the Service tab (see Figure 18-7).

![Web Sites Properties dialog box]

Figure 18-7: Confirm that IIS is not running in Isolation mode.

6. If the Run WWW service in IIS 5.0 isolation mode check box is selected, click to deselect it.
7. Click OK, and close the Internet Information Services (IIS) Manager window.

**Setting up Windows accounts**

During Microsoft Project Server Setup, you are asked for Windows account information twice. Project Server uses the account information to generate the COM+ packages that Project Server uses to start other processes, such as creating OLAP cubes or administering the SharePoint server. Before starting Project Server Setup, you need to create an OLAP Administrator account and a WSS Administrator account.

**Creating an OLAP Administrator account**

You need to set up an OLAP Administrator account so that you can complete Project Server Setup and be able to create OLAP cubes. Follow these steps to set up an OLAP Administrator account:
2. Click Computer Management to display the Computer Management window (see Figure 18-8).

3. Click the plus sign (+) next to Local Users and Groups to expand the folder.
4. Right-click the Users folder, and choose New User from the menu that appears. The New User dialog box opens.
5. In the User name box, enter OLAPAdmin (see Figure 18-9).

Figure 18-8: Use this window to create new Windows accounts.

Figure 18-9: Create a Windows account called OLAPAdmin.
6. In the Password box, type a password, and retype it in the Confirm password box.

   WRITE DOWN THIS PASSWORD. You’re going to need it later. You can write it down here: _____________________________.

7. Deselect the User must change password at next logon check box.
8. Select the User cannot change password check box and the Password never expires check box.
9. Click the Create button.

Creating a WSS Administrator account
You create the WSS Administrator account in the same Computer Management window, using the same technique as you used to create the OLAP Administrator account.

If you didn’t close the New User dialog box in the previous set of steps, you can continue with the steps below. If you closed the New User dialog box, repeat Steps 1 through 4 in the preceding section to reopen it.

   1. In the User name box, type WSSAdmin (see Figure 18-10).
   2. In the Password box, type a password, and retype it in the Confirm password box.

      WRITE DOWN THIS PASSWORD. You’re going to need it later. You can write it down here: _____________________________.

   3. Deselect the User must change password at next logon check box.
   4. Select the User cannot change password check box and the Password never expires check box.
   5. Click the Create button.
   6. Click the Close button.

Adding new Windows accounts to the proper groups
Now add the two Windows accounts that you just created to the proper groups, using the Computer Management window. If you closed the window after the last set of steps, reopen it by choosing Start ➪ Administrative Tools ➪ Computer Management. Then, follow these steps to add the new accounts:

   1. In the left pane, click the Groups folder (see Figure 18-11).
   2. In the right pane, click OLAP Administrators.
3. Choose Action ➪ Add to Group to display the OLAP Administrators Properties dialog box.

4. Click the Add button to display the Select Users dialog box (see Figure 18-12).
5. In the Enter the object names to select box, type `servername\OLAPAdmin`, where `servername` is the name of the computer on which you installed SQL Analysis Services.

6. Click OK twice to redisplay the Computer Management window.

7. In the right pane, click Administrators.

8. Choose Action ➪ Add to Group to display the Administrators Properties dialog box.

9. Click the Add button to display the Select Users dialog box (refer Figure 18-12).

10. In the Enter the object names to select box, type `servername\WSSAdmin`, where `servername` is the name of the computer on which you will install Windows SharePoint Services.

11. Click OK twice, and close the Computer Management window.

### Installing and Configuring Windows SharePoint Services

You need to install Windows SharePoint Services (WSS) if you intend to use the document, issue, and risk management features of Project Server. As described in the section “Considering software/hardware scenarios,” earlier in this chapter, you don’t need to install WSS on the same computer as you install Project Server.
Install WSS the same way that you install any software package — double-click the executable file or follow the on-screen prompts. On the Type of Installation page, select the Server Farm option button and click Next. When the installation finishes, you see the Windows SharePoint Services Configure Administrative Virtual Server page, which asks you for information about the Application Pool (see Figure 18-13), and you can begin configuring WSS. Follow these steps to begin the configuration:

Security and Windows SharePoint Services — read before installing WSS

Windows Server 2003 enables a feature called Internet Explorer Security Configuration. You need to modify some of the settings of this feature before you can install and configure Windows SharePoint Services. These settings also affect your ability to connect to Project Server from Internet Explorer. Follow these steps to uninstall Internet Explorer Security Configuration:

1. Open the Control Panel, and double-click Add or Remove Programs.
2. Click Add/Remove Windows Components.
3. Click Internet Explorer Enhanced Security Configuration, and then click the Details button.
4. Deselect the For administrator groups check box, and click OK.
5. Click Next.
6. Click Finish.
7. Close the Add or Remove Programs window.

The enhanced security configuration settings affect only those Internet Explorer connections that are made at the server; they do not affect users who connect to the server. When you view a Web page such as the SharePoint Central Administration page, you may see a message indicating that Internet Explorer’s Enhanced Security Configuration is currently enabled on your server. You can click OK, and you can choose not to display the message in the future.

If you’re not comfortable with the reduced security of this process, you can, alternatively, add the SharePoint sites to the list of Local intranet sites. While more time-consuming, this alternative is more secure.
1. In the Configure Administrative Virtual Server dialog box, select the Use an existing application pool option button (in the text box, you see StsAdminAppPool). Scroll to the bottom of the page, and click OK. The Application Pool Changed page appears (see Figure 18-14), where you are instructed to restart IIS.
2. Without closing the Application Pool Changed page, choose Start ➪ Run, and in the Run box, type `iisreset` and click OK. After restarting IIS, click the OK button on the Application Pool Changed page. The Set Configuration Database Server page appears (see Figure 18-15).
Figure 18-15: Use this page to create or connect to a SharePoint configuration database.

3. Enter the database server name and an SQL Server database name (any name that does not already exist). In the Database connection type section, select the Use SQL authentication option button and enter the database account user name and password. Scroll down, and click the OK button. The Windows SharePoint Services Central Administration page appears (see Figure 18-16).
Extending the WSS site

As part of the WSS configuration, you need to extend the WSS site. Follow these steps to do so:

1. On the WSS Central Administration page, in the Virtual Server Configuration section, click the Extend or upgrade virtual server link. The Virtual Server List page appears (see Figure 18-17).

2. On the Virtual Server List page, select the Default Web Site. The Extend Virtual Server page appears (see Figure 18-18).
Figure 18-17: On this page, select the virtual server that you want to extend.

Figure 18-18: On this page, extend a virtual server with WSS.
3. Click the Extend and create a content database link. You see the Extend and Create Content Database page. In Figure 18-19, I scrolled down the page so that you can see most of the information that I discuss in Steps 4 through 7.

4. In the Application pool name text box, enter a name—I used WSSAppPool.

5. Set the Select a security account for this application pool option to Configurable, and in the User name box, enter `machinename\WSSAdmin`, where the `machinename` is the name of the server, and WSSAdmin represents the Windows User account that you created earlier—one of the two accounts that I asked you to write down because you would need them later. Enter the password information for the WSSAdmin account.

6. In the Site Owner section, enter the User name in the format `machinename\WSSAdmin` or `domainname\WSSAdmin`, where WSSAdmin is the same Windows account that you used in Step 5.

7. In the Site Owner section, enter the e-mail address that you want to use to contact members of a server.

   **Tip**

   You can use a nonexistent e-mail address if you wish.

8. Click the OK button at the bottom of the page. You see the Virtual Server Successfully Extended page (see Figure 18-20), where you can click OK.

---

**Figure 18-19:** Use this page to supply application pool, security, site owner, and e-mail information about the content database that you are creating.
Figure 18-20: This page notifies you that you have successfully created a new, empty Web site.

When you click OK, you see the Windows SharePoint Services Virtual Server Settings page. You can now simply close your browser.

**Completing the integration of Project Server and WSS**

Technically, you’ve finished the installation and configuration of Windows SharePoint Services, but you need to complete one remaining set of steps: You need to finish the integration of Project Server and WSS by copying Project Server–specific templates to the SharePoint site. Use the Windows SharePoint Services Wizard to copy the templates. Follow these steps to finish the integration:

1. Insert the Microsoft Office Project Server 2003 CD into the CD-ROM drive.
2. When the opening screen appears, select Microsoft Windows SharePoint Services.
3. On the screen that appears, click the Windows SharePoint Services Configuration Wizard.
4. On the Welcome page of the wizard, click Next.
5. On the virtual servers page (see Figure 18-21), click Default Web Site and click Next.
6. On the Select the managed path under which project sites will be created page, click Next.

7. On the Enter the following information for the site page (see Figure 18-22), type in the information that you entered in the Site Owner section of the Extend and Create Content Database page (refer to Figure 18-19, and see Steps 6 and 7 in the previous section). Click Next.

8. On the We now have enough information to configure Windows SharePoint Services page, click Next.
A status bar appears on this page, and after a few moments, you may see the message that’s shown in Figure 18-23. Click OK to continue. The wizard stops running and then restarts.

Figure 18-23: At this point, the wizard stops running and restarts.

When the SharePoint Configuration Wizard completes successfully, you see a page similar to the one shown in Figure 18-24. In the next section, when you’re installing Project Server, you’ll need the URL information for both Items 1 and 2 on this screen, so write them down or take a screen shot of this page. After collecting this information, click Finish.

This is another one of those places where you really need to take note of this information, either by taking a screen shot or by writing down the information.

Figure 18-24: Write down the test links that are shown on your screen because you’ll need them in the next section while installing Project Server.
Finally, you need to reset IIS. Choose Start ➪ Run, and in the Run box, type `iisreset` and click OK. A DOS window opens, showing IIS stopping and restarting itself.

And now, you’re finally ready to install Project Server.

### Installing Project Server

Just to review: Make sure that you have installed Windows 2000 with Service Pack 3 or Windows 2003 (the released version—not a beta version) or above and Microsoft Internet Information Server (IIS) 5.0 or above. Also, be sure that you have installed SQL Server 2000 with Service Pack 3 and, if you’re going to use the Portfolio Management feature of Project Server, SQL Analysis Services (also with Service Pack 3).

As you read earlier in this chapter, you don’t need to install all products on one machine, but you must install all products before you install Project Server. Also, make sure that you have read and completed the steps in the sections “Installing Peripheral Software” and “Installing and Configuring Windows SharePoint Services,” both earlier in this chapter.

> **Caution**
>
> I can’t stress strongly enough how important it is for you to follow all the steps of the installation process in order. If you skipped something earlier, please go back and do it now. You’ll be much happier if you do.

To install Project Server, follow these steps:

1. Insert the Microsoft Office Project Server 2003 CD into your CD-ROM drive, and click the Server installation link.
2. Confirm the user name, initials, and organization in the User Information dialog box, and click Next.
3. In the End User License Agreement dialog box, agree to the license and click Next.
4. In the Select a location for installation box, confirm or change the installation location if desired and click Next.
5. On the Choose the services you want to install on this server page (see Figure 18-25), click Next.
Microsoft included this page so that you can install separate functions on separate servers. If you choose to install functions separately, make sure that you install View Processing and Session Manager before you install Project Server front-end.

Starting in Project 2003, Microsoft ships a sample Project Server database. You can install it when you install the software or after you finish the installation; in either case, it requires some setup work.

To use the sample database, all components (Windows 2003, SQL Server 2000, Analysis Services, IIS, Windows SharePoint Services, and Project Server) must be installed on the same computer. You can find instructions for installing and configuring the sample database on your Microsoft Office Project Server CD.

6. On the Enter database server information page (see Figure 18-26), select the Create a new database option button.
7. In the Database server box, enter the name of the server where the Project Server database is to reside.

8. In the Connect using section, choose Windows Authentication if you are logged on to your server using a Windows domain account and if you have the dbcreator and securityadmin roles on the SQL server. Otherwise, select the SQL Server Authentication option button and enter a logon name and password. If you know the SA account password, you can use this account. Click Next.

   **Note**  
   Project Server does not use the SA account after you create the Project Server database.

9. Click Next on the Enter database server information for Views tables page.
If you have more than one database server, you can create the Views tables on a separate machine, which can ultimately mean better performance for larger installations.

10. On the Create database account information page, enter passwords for the MSPProjectServerUser and MSProjectUser accounts (see Figure 18-27). Project Server uses the MSPProjectServerUser account to gain access to the Project Server database. Project Professional uses the MSProjectUser account to read and write projects to the Project Server database. Click Next.

![Figure 18-27: Enter and confirm passwords so that Project Server and Project Professional can connect to and update the Project Server database.](image)
11. On the Enter Analysis Services connection information page, enter the name of the server where you installed SQL Analysis Services (see Figure 18-28). In the lower portion of this page, supply the Windows account information for the OLAPAdmin Windows account that you created earlier in this chapter. (See the section “Creating an OLAP Administrator account.”) Click Next.

![Figure 18-28: Supply Analysis Services connection information on this page.](image)

When you created this account, I suggested that you write down this information and keep it handy, because you would need it during Project Server installation.
12. On the Select a Web site page (see Figure 18-29), choose a Web site and click Next.

*Note*

If you are installing on the same server where you installed Windows SharePoint Services, choose Default Web Site.

13. On the Enter Web Server address information page, select the Enter this information now option button and supply the name of the server where Project Server is to reside. Optionally, supply the extranet protocol and domain name. Click Next.

*Note*

You can enter or modify this information after you complete the installation of Project Server using Project Web Access.

Figure 18-29: Choose the Web site where you want to install the virtual directory for Project Server.
14. On the SMTP mail server information page, select the Enter this information later option button and click Next.

Note
Like Web server address information, you can enter mail server information after you complete the installation of Project Server by using Project Web Access.

Tip
If you choose to enter the SMTP mail server information, the From address should contain only the portion of the address that precedes the `@` sign.

15. On the Connect to a Web server running Microsoft Windows SharePoint Services page (see Figure 18-30), select the Enter this information now option button. Then, supply the information that you wrote down at the end of the SharePoint Configuration Wizard (see Figure 18-31). Click Next.

**Figure 18-30:** Enter the information that you wrote down at the end of the SharePoint Configuration Wizard.
Figure 18-31: This information was supplied at the end of the SharePoint Configuration Wizard.

You can enter this information after you complete the installation of Project Server by using Project Web Access. To perform this step later, select the Enter this information later option button and click Next.

16. If you chose to enter information in Step 15, you see the page that’s shown in Figure 18-32. In the Logon name box, type in \username, where servername is the name of the server on which you installed WSS and username is the Windows account information for the SharePoint administrator that you created earlier in this chapter—I called mine WSSAdmin and suggested that you write down the necessary information. In the Password box, type the password that you assigned to the SharePoint administrator. Click Next.

This is only one of many steps that demonstrates why I suggested that you do things “in order.” This account is used to create the COM+ package that Project Server uses to communicate with the SharePoint server. If you haven’t already created this Windows account using the steps that were supplied in the section “Creating a WSS Administrator account,” earlier in this chapter, you won’t be able to complete this step.
17. On the Connect to a Web server running Microsoft SharePoint Portal Server 2003 page, select the Enter this information later option button and click Next.

This information is used to connect a SharePoint portal server—a separate product used in a multiserver environment—to your Windows SharePoint Services server so that you get the advanced searching capabilities of SharePoint Portal Server. And, you can enter this information after you finish installing Project Server by using Project Web Access.

18. On the Choose an installation environment page, select the Enterprise option button or the Non-enterprise option button and click Next (see Figure 18-33). If you plan on using Project Professional and you use only enterprise resources, choose the Enterprise option. Otherwise, choose the Non-enterprise option. Click Next.
Figure 18-33: Choose an installation environment.

After you complete Project Server installation, you can change this setting using Project Web Access.

19. In the Enter the Administrator password box, enter the password that is to be used for the Project Server Administrator account. Click Next.

Tip

Write the Administrator password down—you’ll need it to make any changes to Project Server Setup in Project Web Access.

20. In the Summary box, click Install, and Project Server finishes the installation process. At the end of installation, click Finish.

You’ve now completed the installation of Project Server, but . . . you still have some work to complete, based on the choices that you made during setup to do certain tasks later.
Connecting to Project Server through Project Web Access

If you chose to enter information later on the page where you were to specify an Analysis Services server or a Windows SharePoint Services server, you need to run a utility called PSCom+ to complete those processes. Then, you are ready to open Project Web Access. To read about the PSCom+ utility, see the sidebar “Specifying an Analysis Server and a Windows SharePoint Services Server.”

Specifying an Analysis Services server and a Windows SharePoint Services server

Before you can use the analysis tools of Project Server and Project Web Access, you must identify the server(s) where Analysis Services and Windows SharePoint Services are installed.

You can find the tool, PSComPlus.exe, in the following directory:

\Program Files\Microsoft Office Project Server 2003\Bin\1033

where drive is the drive where you installed Project Server. When you run the tool, you see a box like the one in the following figure.

In the section “Setting up Windows accounts,” earlier in this chapter, you created an account for the OLAP Administrator and an account for the WSS Administrator. At the time, I suggested that you write down the user names and passwords that you supplied. You need to enter them here, preceded by the server name, as shown in the figure, and then click the Create/Update COM+ Apps button. When the utility finishes, you see a message stating that Project Server components are now running in COM+. 
OK, now for the fun part — finally seeing what you installed! Open Internet Explorer and, in the address bar, type the following text:

http://servername/projectserver

You replace *servername* with the name of your server. The default database that was created during the installation is named projectserver. And, if you were silly like I was and named your server projectserver, you would use a Web address like the following:

http://projectserver/projectserver

You are then automatically redirected to the logon page that is shown in Figure 18-34.

*Figure 18-34:* Use this page to log on to the Project Server database using Project Web Access.
Throughout the rest of my discussion of Project Server, I’m going to use the sample database. If you installed it, you can view it by typing the following URL into the Address bar: http://servername/sample.

Log on to the Project Server database using Administrator as the User name, and provide the password that you supplied when you installed Project Server (see Step 19 in the section “Installing Project Server,” earlier in this chapter). You see the opening page of the Project Server database (see Figure 18-35).

At this point, you have some housekeeping tasks to do to complete the installation of Project Server.
Setting up mail server information
During the installation of Project Server, you had the opportunity to provide mail server information—and you could choose to enter it later. Well, “later” has arrived. Follow these steps to provide mail server information:

1. Click the Admin tab (refer to Figure 18-35).
2. From the Actions list in the left pane, click Customize Project Web Access.
3. In the Customization options list in the left pane (see Figure 18-36), click the Notifications and reminders link.
4. On the Notifications and reminders page (see Figure 18-37), supply the name and port of the SMTP mail server.
5. In the From address box, type the first part of the e-mail address (everything that normally appears before the at sign (@)).

Figure 18-36: Use the list in the left pane to find the options that you want to change.
Figure 18-37: Supply mail server information.

6. In the Company e-mail address box, type the last part of the e-mail address (everything that appears after the at sign (@)).

7. If you want a default message to appear in notifications, type it in the Default e-mail message box.

8. Scroll down and click the Save Changes button.

Modifying SharePoint portal server information

During installation, you also had the opportunity to provide Windows SharePoint portal server information — and again, you could choose to enter it later. Once again, “later” has arrived. Follow these steps to provide portal server information:

1. Click the Admin tab (refer to Figure 18-35).

2. From the Actions list in the left pane, click Manage Windows SharePoint Services.
3. From the Options list in the left pane, click the Connect to SharePoint Portal Server link.

4. On the Connect to SharePoint Portal Site page (see Figure 18-38), provide the appropriate portal site information.

5. Click the Save Changes button.

![Figure 18-38: Provide SharePoint portal server information.](image)

**Changing operation modes**

During installation, you chose an operating environment for Project Server: Enterprise or Non-enterprise. You can change this setting using Project Web Access. Follow these steps to make this change:

1. Click the Admin tab (refer to Figure 18-35).

2. From the Actions list in the left pane, click Server configuration.
3. Select the Enable enterprise features option button or the Enable only non-enterprise features option button, as appropriate (see Figure 18-39).

4. Scroll down and click the Save Changes button.

Figure 18-39: Change the mode of operation.

**Entering OLAP server information**

If you didn’t supply OLAP server information while installing Project Server, you ran the PSCom+ package, and now you need to finish setting up the OLAP server account information. Follow these steps to do so:

1. Click the Admin tab (refer to Figure 18-35).
2. Click the Server configuration link.
3. Scroll down, and provide the appropriate information in the Enter the intranet and/or extranet addresses of Project Server section (see Figure 18-40).
4. Click the Save Changes button.
Entering WSS server information

If you didn’t supply Windows SharePoint Services server information while installing Project Server, you ran the PSCom+ package, and now you need to finish setting up the WSS server account information. Follow these steps to do so:

1. Click the Admin tab (refer to Figure 18-35).
2. From the Actions list on the left, click the Manage Windows SharePoint Services link.
3. From the Options list in the left pane, click the Connect to SharePoint server link.
4. On the Connect to SharePoint server page, provide the URL information that you received after completing the SharePoint Configuration Wizard. In Figure 18-41, you see the Connect to SharePoint server page; in Figure 18-42, you see the page of the SharePoint Configuration Wizard containing the information that you need.
Figure 18-41: Enter the URL information that you saw after running the SharePoint Configuration Wizard.

Figure 18-42: Use this information to provide the appropriate URLs.
In Figure 18-41, I collapsed the left pane to hide the Action list by clicking the small arrow in the upper-right corner of that pane. Because I hid the Action list, you can see more of the screen. Notice that you can test the URL that you provide by clicking the Test URL link to the right of the first box in this figure. When you click the link, you should see the SharePoint Central Administration page.

**Troubleshooting Your Installation**

If you follow the installation steps in order, your installation should be problem-free. Once all the software is installed, the most common problem is system performance. You can improve system performance by balancing the load on your system.

What techniques should you try to balance the load? You need to approach this problem by determining the cause of the problem, because the solution that you choose is dictated by the cause of the problem. For example, it would be a waste of money to upgrade all your CPUs if network traffic is the source of the problem.

Make use of the Windows System Monitor to determine where you have bottlenecks. If you find that you are fully utilizing your CPU, you can try upgrading the CPU, adding another CPU, or off-loading services to reduce the load on the CPU. You can also use clustering to help balance the load; all Project Server components can now be clustered.

**New Feature**

Project Server 2003 uses Windows SharePoint Services (WSS) 2.0 instead of SharePoint Team Services 1.0. A major enhancement to WSS enables you to cluster it for load-balancing purposes.

The new Windows SharePoint Services 2.0 that you use with Project 2003 has a feature that wasn’t available in SharePoint Team Services (STS) 1.0. When WSS saves a document, it saves the document to an SQL database. STS saved the document to your hard drive. Because WSS saves documents to an SQL database, you can now cluster WSS to help you balance the load.

**Note**

While you can cluster SQL, you don’t cluster SQL to balance a load; instead you cluster it to provide a fail-safe mechanism. If you cluster SQL and a server goes down, the event will be invisible to the end user.

If you determine that network traffic is the source of the problem, balance the load by installing additional NICs. For example, you may install a second NIC in the computer where SQL is stored, and then tie Project Professional traffic to one NIC and Project Server traffic to the other NIC. You can also make use of switches and routers to help balance network traffic.

Review the sample configurations that I discussed earlier in this chapter in the section, “Considering software/hardware scenarios”.

Summary

In this chapter, you explored the software and hardware requirements for Project Server. You found out about the order in which you need to install the other software packages before you install Project Server and the basic configuration settings for those packages. You installed and configured Project Server so that the database was ready to be customized for your organization’s needs.

You read about potential performance issues and saw some sample hardware configurations to help you improve performance. In Chapter 19, you explore the administrative tasks that are associated with customizing the Project Server database to support your organization.
In Chapter 17, you reviewed design issues and approaches to successfully implementing Project Server. In Chapter 18, you went through the process of installing and configuring the software that is necessary to use a Project Server database. In this chapter, you explore setting up and customizing the Project Server database to meet your organization’s needs.

During this stage where you set up and customize the Project Server database, you need the skills of the following types of people:

- An information technology (IT) person with background in hardware, networking, and connectivity
- A project management (PM) person with extensive knowledge of your organization’s needs while managing projects

Once the design and implementation team has identified certain components that your organization will use, the IT person can work independently on some tasks while, at the same time, the PM person works independently on other tasks. To complete the setup, these two individuals will probably work together. As you read the tasks in this chapter, you can decide who should perform each task.

This chapter is organized to present the tasks in the order that they need to be done. Doing things in order when setting up and customizing the Project Server database to meet your
organization’s needs is not as critical as doing things in order was when installing the software, but doing some tasks before other tasks can make the implementation run smoother. And, you’ll find that some of the tasks overlap. For example, you add users to categories and categories to users. In most of these cases, it really doesn’t matter which you do first, because you’ll complete one task when you complete the other task.

Once you have Project Server up and running, you will need to make occasional changes to the database. For these types of changes, the Project Server administrator needs to be someone with project management background rather than someone with an information technology background. The role of administrator for the Project Server database over time will fall to someone who is more intimately involved with project management and will become a maintenance job.

**Double-Checking the Settings**

As you read in Chapter 17, the Project Server database contains many useful default values and settings. You should double-check these values and settings to make sure that they will work within the framework of your organization. Use Project Web Access to check settings.

On all the Project Web Access pages that you see in this section, you can make changes if necessary. Usually, it is not necessary to change the information.

Launch Project Web Access by starting Internet Explorer and entering the URL for your Project Server database. If your organization uses Project Server authentication, the administrator types **Administrator** in the User name box, supplies the password for the administrator, and clicks Go. The administrator sees the Project Web Access Home page for the administrator, which contains an additional tab: the Admin tab. From the Admin tab, the administrator can manage and customize the Project Server database and Project Web Access by using the links that are shown in Figure 19-1.

Unless otherwise specified, all tasks that I describe in the following sections assume that you begin by logging on to Project Web Access as administrator and clicking the Admin tab.
Specifying Project Server features for your organization

The Server configuration page is shown in Figure 19-2. Display this page by clicking the Server configuration link in the Actions pane on the Admin tab. Then, click the Features link in the Actions pane. On the Server configuration page, the administrator confirms whether your organization will do the following:

- Use enterprise features (if you don’t select this check box, no one in the organization has access to any Project Server features)
- Allow master projects in the Project Server database
- Allow projects to use the local base calendar instead of the Enterprise base calendar
- Enforce a uniform, single currency in the Project Server database (you specify the currency in the enterprise global template)
Figure 19-2: The features on this page control some basic enterprise features in the Project Server database.

If you choose to enable only non-enterprise features, only one check box is available: Allow master projects to be published to Microsoft Project Server.

Figure 19-3 shows the bottom portion of the same page; here you can confirm the features that you want to make available in Project Web Access and supply intranet and/or extranet addresses for Project Server, if appropriate. Enabling a feature doesn’t let everyone use it; instead, the feature is available only if you also give specified users permission to use it. You enable or disable features by scrolling to the right in the grid shown and selecting the Allow check box or the Deny check box for each Project Server feature.

For the curious, yes, you can select both the Allow and Deny check boxes (although I can’t think why you would want to). And, although the visual effect is that you have both allowed and denied permission, you haven’t—Deny takes precedence over Allow.
Figure 19-3: Choose the features that you want to enable in Project Web Access and, if appropriate, supply intranet and/or extranet addresses.

Managing user authentication options

On the User authentication page, shown in Figure 19-4, the administrator uses the information gathered during the requirements definition phase (see Chapter 17) to select the method that the Project Web Access server uses to authenticate users who try to log on to Project Web Access. From this page, the administrator can also set the minimum length to which users must set their passwords. Display this page by clicking the Manage security link in the Actions pane on the Admin tab and then clicking the User authentication link in the Actions pane.
Figure 19-4: Control authentication and password issues from this page.

Managing Windows SharePoint Services

Project Web Access uses Windows SharePoint Services technology to manage documents, issues, and risks. If your organization chooses to use these features, the administrator can manage Windows SharePoint Services by clicking the Manage Windows SharePoint Services link in the Actions pane on the Admin tab.

Initially, the administrator should check the Windows SharePoint Services settings that were established during installation for connection, site provisioning, and the SharePoint Portal. Later in this chapter, when you review housekeeping tasks, you also review the other links that are available in the Actions pane when managing Windows SharePoint Services.
On the Connect to SharePoint server page, shown in Figure 19-5, the administrator can confirm and validate connection information for SharePoint servers. Display this page by clicking the Manage Windows SharePoint Services link and then the Connect to SharePoint server link in the Actions pane.

![Connect to SharePoint server](image)

**Figure 19-5:** From this page, you can verify SharePoint server connections.

When you click the Manage Windows SharePoint Services link and then the Site provisioning settings link, you see a page where you can control root Web site settings. On the bottom of that page, shown in Figure 19-6, you can control whether Web sites are created automatically or manually and then choose whether to grant users access to project Web sites automatically or manually.
When you click the Manage Windows SharePoint Services link and then the Connect to SharePoint Portal Server link, you see the page that is shown in Figure 19-7. Here you can confirm that the address for the portal server is correct, if you are using a portal site.

**Managing security templates**

The Project Server database contains some default security templates, which are sets of permissions. You use security templates to assign a set of permissions to a user or a group of users. The permissions that a given user will have for a specific function in Project Web Access is dependent on the combination of group and individual permission settings.
The Project Server database contains security templates for each of the predefined groups that you find in the database. You can modify the default security templates or create your own. As you can see on the Modify Template page, shown in Figure 19-8, security templates contain a long list of information; you include or exclude permissions in a template by selecting the Allow or Deny check box for that right.

Typically, you don’t “deny” a feature; instead, you either select or deselect the Allow box.

You display this page by clicking the Manage Security link in the Actions pane on the Admin tab. Then click the Security templates link in the Actions pane, and on the Security templates page that appears, click Add Template or select a template and click Modify Template.
Managing groups

As you read in Chapter 17, groups are collections of users. Project Server enables you to group users in some fashion that is logical in your organization. Grouping users makes it easier to assign security permissions. You find the following predefined groups in the database:

- Administrators
- Executives
- Portfolio Managers
- Project Managers
- Resource Managers
- Team Leads
- Team Members

Double-check the predefined groups, and make sure that you have groups that accurately reflect the structure of your organization. Display this page by clicking the Manage users and groups link and then clicking the Groups link in the Actions
When you create or modify a group, you can add users to the group, assign
categories and category permissions to the group, assign global permissions to the
group, and assign a Digital Dashboard to the group. In Figure 19-9, you see the
Global Permissions portion of the Add Groups page. Notice that you can set permis-
sions using a template and that all the available templates appear in a list box next
to the Set Permissions with Template button.

![Figure 19-9: When you create groups, you can assign permissions to them using a
template.](image)

I realize that you’re double-checking the groups before adding users to the Project
Server database, so you can’t add users to groups. Don’t worry, though. When you
add users, you get the opportunity to assign them to groups, so you don’t need to
assign users to groups when you create or modify groups.

### Working with views

A **view** contains a set of fields and filters that Project Web Access uses when dis-
playing project information. Through views, the administrator controls what you
see in Project Web Access, because views enable users to examine project informa-
tion in different ways.
The Project Server database contains many default views. The administrator uses the Specify Views page, shown in Figure 19-10, to create new views and modify or delete existing views. Display this page by clicking the Manage views link in the Actions pane on the Admin tab.

![Figure 19-10: On this page, you can create a new view or modify or delete an existing view.](image-url)

Before you make changes here — either to create a view or to modify an existing view — I suggest that you continue customizing until you can load a project into the Project Server database. With a project in the database, you can view that project using each default view that’s available in the Project Server database. You may find that Microsoft has already created the view that you want or a view that is close enough to the one you want that you can modify an existing view.
Whether you decide to add or modify a view, you use the same page. Click the Add View link, or select a view and click the Modify View link; you then see the Specify Views page. At the top of the page, select a type for the view: Project, Project Center, Assignment, Resource Center, or Portfolio Analyzer. The type of view that you select determines the choices that appear as you scroll down the page to create the view. For example, for Project, Project Center, and Assignment views, you can choose a Gantt Chart format that is not available for a Resource Center view. In Figures 19-11, 19-12, and 19-13, you see the top, middle, and bottom of the Specify Views page, respectively, for modifying a Project view.

Figure 19-11: At the top of the page, specify the type of view, the view name, and the fields that you want to appear in the view.
Figure 19-12: In the middle of the page, indicate the Gantt Chart format, grouping options, outline levels, and filter options.

Figure 19-13: At the bottom of the page, specify categories for the view.
I realize that you haven’t worked with categories yet, so specifying a category for a view may seem to pose a problem. However, when you work with categories in the next section, you see that you can assign a view to a category. So, you get the opportunity to “double back” and connect the view with the category.

**Working with categories**

Categories enable you to map users to projects and views. In other words, in a category, you identify the users, projects, project views, Project Center views, Portfolio Analyzer views, Resource Center views, and Assignment views to include in the category. The Project Server database includes, by default, the following four categories that are tied to the default groups that were identified in the section “Managing groups,” earlier in this chapter:

- **My Direct Reports**: Includes all projects and views that are worked on or managed by a user, and resources that are managed by a user. This category includes the Resource Managers group.
- **My Organization**: Includes all projects, all views, and all groups.
- **My Projects**: Includes all projects that are worked on or managed by a particular user, all views that are defined for those projects, and the Project Managers, Resource Managers, and Team Leads groups.
- **My Resources**: Includes the projects that are worked on by resources who report to a specific user as well as views for those projects. Resource Managers and Team Members belong to this group.
- **My Tasks**: Includes all projects to which a user is assigned, a view of the assignments for those projects, and the Team Members group.

To create a new category or edit an existing category, click the Manage security link in the Actions pane on the Admin tab. Then, click the Categories link in the Actions pane. On the Categories page that appears, click Add Category or select a category and click Modify Category. If you click Modify Category, you see the Modify Category page (the top of the page is shown in Figure 19-14), where you select the users that you want to include in this category.

Scroll down, and identify the permissions that you want to be assigned in the category. Notice that you can use a security template to assign permissions (see Figure 19-15).
Figure 19-14: Use this page to define the users that you want to include in the category.

Figure 19-15: Identify the permissions that you want to be assigned in the category.
In the next section of the page, shown in Figure 19-16, specify the projects and project views that you want to include in the category and the options that you want to apply to the projects.

![Figure 19-16: Specify the projects that you want to include in the category.](image)

In the next section of the page, shown in Figure 19-17, add the resources whose information will be visible by users of the category and the Assignment and Resource Center views that you want to be included in the category.

![Figure 19-17: Add resources to the category.](image)
I realize that you haven’t added users yet, so specifying resources for a category may seem to pose a problem. However, when you add users in the next section, you see that you can assign a user to a category. So, you get the opportunity to “double back” and connect the category with the user.

In the last portion of the page, shown in Figure 19-18, add the Project Center views, Portfolio Analyzer views, and models that you want to include in the category.

![Figure 19-18: Add the project-related views and models that you want to include in the category.](image)

At the bottom of the page, click Save Changes to save the category.

### Managing Users

OK, “double-checking” is over. Now, you’re doing “new stuff.” To enable people to use Project Web Access, you need to add users. From the Users page, the administrator can add, modify, or delete users. In addition, the administrator can merge two user names into one account if a user appears twice in the Log On list under two different names. Display this page by clicking the Manage users and groups link in the Actions pane on the Admin tab. Then, click the Users link in the Actions pane.
When you add or modify a user, at the top of the page (see Figure 19-19), you specify the type of authentication to use (Windows Authentication or Project Server authentication), the user’s e-mail address, and the groups to which the user belongs.

![Figure 19-19: At the top of the page, supply basic user identification information.](image)

Scroll down the page (see Figure 19-20), and you can specify the categories of information that the user can access as well as category permissions. You can use templates to apply category permissions, even though you can’t see the list of templates in this figure.

Scroll down farther (see Figure 19-21), and you can specify the global permissions for the user — and again use a template to model the permissions on the permissions of a Project Server group.
Figure 19-20: Select categories for the user.

Figure 19-21: Set or modify user global permissions here.
You also can add or change the properties of groups. In the Actions pane, click Groups of users. Then, select a group and click the Add Group or Modify Group button.

### Managing Enterprise Project Versions

Your organization may want to make multiple versions of the same project available. You can establish versions for your organization so that you standardize the versions that are used across the organization. Follow these steps to do so:

1. Click the Admin tab.
2. Click the Manage Enterprise Features link in the Actions pane.
3. Click Versions under the Enterprise Options heading on the left side of the window. Project Web Access displays any available versions on the Versions page, as shown in Figure 19-22.

The Published version is a protected version that is created automatically when Project Server is installed; this version always appears on the Versions page.

![Figure 19-22: From this page, you can add, modify, or delete versions.](image-url)
4. Click the Add Version button. You see the Add Version page, as shown in Figure 19-23.

![Add Version Page](image)

**Figure 19-23:** Create a version on this page.

5. Supply a version name.

6. Decide whether the version should be archived. When a user opens an archived project version, it isn’t updated with any enterprise global or enterprise resource pool information. Instead, it is a snapshot of the project at the time that it was saved.

7. Choose an entry from the Gantt Bar Name drop-down list box. By default, you can choose Project Summary, Project Summary Version 1, Project Summary Version 2, Project Summary Version 3, Project Summary Version 4, or Project Summary Version 5.

8. Click Save Changes.
Working with the Enterprise Global Template

You can compare the Enterprise Global template to the Global template in Project Professional. Both serve the same purpose — to store a collection of all default settings that are used by projects across your organization. Each new project is based on the Enterprise Global template, enforcing standard usage across all the organization’s projects.

Someone with administrative privileges in your company customizes the Enterprise Global template so that it contains the custom fields and calendars that meet the needs of your organization.

Creating custom Enterprise fields

Custom fields can be used for many purposes. For example, your organization may want to set up a custom field for Project Status and assign values such as Proposed, Awarded, In Progress, and Completed. Or, if your organization opts to use generic resources and wants to be able to match the skills of a generic resource with a real resource that possesses those skills, you can create a custom field and establish a value list for the field where each value represents a set of skills. Once you assign the appropriate value to each resource by using the custom field, you can use the code to match skills that are required by generic resources with skills that are possessed by real people when project managers run the Team Builder.

In Chapter 20, you can find an example where I used an enterprise resource custom outline code with the Team Builder to substitute real resources for generic ones.

You set up enterprise custom fields and outline codes essentially the same way that you set up custom fields, as I describe in Chapter 23, and custom outline codes, as I described in Chapter 7, but you use a different dialog box and a special project. In the following example, I create an enterprise resource multivalue custom field that includes a lookup table. An enterprise resource multivalue field enables you to assign more than one value for the field to a resource. The skill set field, which I described in the preceding paragraph, is one example where you would create a multivalue field. It would enable you to assign, using only one custom field, skills, such as Computer Programming and Database Administration, to the same resource. In one of the case studies that you find in Chapter 27, the company used an enterprise resource multivalue field to identify the machines on which a resource was certified. In my example, I define a multivalue field for Languages. This field is useful if you need to identify the languages that your resources speak when making resource assignments.

Enterprise resource multivalue custom fields, new to Project 2003, are a very powerful addition.
See Chapter 23 for more details about creating custom fields and Chapter 7 for more information about creating custom outline codes.

1. Open Project Professional, and make sure that you connect to the Project Server database.

2. Choose Tools ➤ Enterprise Options ➤ Open Enterprise Global to open the Enterprise Global template code. Project displays the Checked-out Enterprise Global template (see Figure 19-24).

![Microsoft Project - Checked-out Enterprise Global](image)

**Figure 19-24:** The most obvious difference between regular projects and the Checked-out Enterprise Global template in Project Professional is the title bar.

While the Checked-out Enterprise Global template looks like other projects, if you poke around, you find that certain commands, such as the Build Team from Enterprise command, are disabled.

3. Choose Tools ➤ Customize ➤ Enterprise Fields. You see the Customize Enterprise Fields dialog box, as shown in Figure 19-25.
4. Click the Custom Outline Codes tab.

5. In the Outline Code panel, select the Resource option button.

6. Select an enterprise resource outline code to customize. For this example, I’m going to use Enterprise Resource Outline Code 21.

   **Tip**

   To create a multivalue code, make sure that you select any code between Enterprise Resource Outline Code 20 and 29.

7. Click the Rename button, and in the Rename Field dialog box that appears, type a new name for the enterprise resource outline code. Then click OK to redisplay the Customize Enterprise Fields dialog box.

8. Click the Define Code Mask button to open the Outline Code Definition dialog box, as shown in Figure 19-26.
9. In the Sequence column, define the type of values that are acceptable in your company’s code. In the Length column, provide a number (or choose Any) for the length of the code. If your code is composed of parts, choose a separator character to distinguish the first part of the code from the second part of the code.

10. Click OK to redisplay the Customize Enterprise Fields dialog box.

11. Click the Edit Lookup Table button to display the Edit Lookup Table dialog box, as shown in Figure 19-27.

![Figure 19-26: Define the structure for your outline code here.](image1)

![Figure 19-27: In the Lookup table, define the codes that you want to use.](image2)
12. Enter the values that your organization uses for the custom field, and click Close.

13. Click Close.

14. Click the Save button to save the Enterprise Global template and your new enterprise custom field.

If you’ve already stored resources in the Enterprise Resource Pool, you need to edit the resources to assign a value to each of them for the new custom field. Follow the steps described in the section “Creating the Enterprise Resource Pool,” later in this chapter, to assign values for the custom field to resources that are stored in the Enterprise Resource Pool. In that section, you see how you can use the multivalue enterprise resource custom field when assigning values to resources.

If you have not yet stored resources in the Enterprise Resource Pool, edit the resources in the usual way. When you import the resources to the Enterprise Resource Pool, you have the option of including the custom fields.

**Creating calendars**

Assign a calendar to the Enterprise Global template to enforce common workdays and work times across all projects. Resources in the Enterprise Resource Pool can use the calendar that is in the Enterprise Global template unless you override that calendar by assigning a resource-specific calendar.

You set up the calendar for the Enterprise Global template the same way that you set up a calendar for a project.

For details on making calendar changes, see Chapter 3.

**Setting Up and Editing Enterprise Resources**

The Enterprise Resource Pool is a single repository that project and resource managers can use when assigning resources to their projects. The Enterprise Resource Pool includes summary resource assignments, resource base calendars, and any enterprise resource fields that you defined in the Enterprise Global template. Project managers “check out” resources from the Enterprise Resource Pool to assign them to a project. The Project Server administrator can set the permissions for others to add, edit, and delete resources from the Enterprise Resource Pool. Project Server manages the check-out/check-in operations.
Creating the Enterprise Resource Pool

The easiest way to create the Enterprise Resource Pool is to use a project that contains the resources that you want to store in the Enterprise Resource Pool. Then, a wizard can walk you through setting up the Enterprise Resource Pool. Make sure that the project containing the resources is closed or checked in, and then follow these steps to create the Enterprise Resource Pool:

1. Open Project Professional, and make sure that you connect to the Project Server database.

2. Choose Tools ➪ Options ➪ Import Resources to Enterprise. The Import Resources Wizard starts. On the first screen of the wizard, click Next.

3. From the Open from Microsoft Office Project Server dialog box that appears, select the project that contains the resources and click Open. Otherwise, click the Open from File button and open the .mpp file that contains the resources.

4. If you’ve set up any custom fields for resources, complete the Map Resource Fields page of the wizard, as shown in Figure 19-28. Map custom fields that you’ve set up for resources to enterprise resource fields.

![Map custom resource fields to enterprise resource fields.](image)

**Figure 19-28:** Map custom resource fields to enterprise resource fields.

Custom fields and values for resources don’t appear in the Enterprise Resource Pool unless you map them to enterprise resource fields.

5. Click Next, and identify the resources that you want to upload to the Enterprise Resource Pool by placing a check mark next to their names, as shown in Figure 19-29.
Organizational Roles and Project Server: The Administrator

Figure 19-29: Identify resources that you want to store in the Enterprise Resource Pool.

You can view and change the information for any displayed resource by selecting that resource and clicking the Resource Information button. Project displays the Resource Information dialog box for the selected resource. Errors appear in red.

6. Click Next. Project sends the resources to the Enterprise Resource Pool in the Project Server database.

7. Click Finish.

Editing resources in the Enterprise Resource Pool

After you have stored a resource in the Enterprise Resource Pool, what happens if you find out that you need to make a change to that resource? Suppose, for example, that you create a new custom field and you need to assign a value for the field to a resource in the Enterprise Resource Pool. You can edit the resource by checking it out, making the change, and then checking it back in. While resources are checked out, others can't make and save changes to the resources.

Follow these steps to check out resources from the Enterprise Resource Pool:

1. Open Project Professional, and connect to the Project Server database.

2. Choose Tools ➪ Enterprise Options ➪ Open Enterprise Resource Pool. Project displays the Open Enterprise Resources dialog box, as shown in Figure 19-30.
3. Place a check mark next to the resource(s) that you want to edit.

4. Make sure that the Read/write to check out option button is selected, and click Open/Add. Project opens a temporary project called Checked-out Enterprise Resources (see Figure 19-31) and lists the resources that you checked on the resource sheet of that project.

5. Make changes to the resource(s) by displaying the Resource Information box. As long as you have checked out the resource, no one in your company can assign work to that resource. Make changes to the resource by using the Resource Information dialog box. After you have finished, check the resource back in by clicking the Save button. At that time, Project Server updates the resource information in the Enterprise Resource Pool.
Figure 19-31: When you check out resources, they appear on the Resource Sheet view of the Checked-out Enterprise Resources project.

To complete the example of creating and using an enterprise resource multivalue field, click the Custom Fields tab in the Resource Information dialog box. You see two versions of the enterprise resource multivalue field that you created earlier in this chapter—one with the original name and one with -MV at the end of the name (see Figure 19-32). If you open the Value list for the first version of the field, you see a typical lookup table that contains a list of values where you can select only one value. However, if you open the Value list for the MV version of the code, you see that the lookup table contains a check box next to each value (see Figure 19-33). You can select as many values as you want, assigning multiple values for the field to your resource.
Figure 19-32: This Value list provides a typical lookup table, from which you can select a single value.

Figure 19-33: The multivalue lookup table enables you to select multiple check boxes and therefore select multiple values from the lookup table.

You can assign values to both versions of the enterprise resource multivalue custom field. You may use the version that is shown in Figure 19-32 to assign a default value to the resource.
Importing Projects

You will, no doubt, have projects already created and in progress that you want to load into the Project Server database. You can find a wizard in Project Professional that helps you to load these projects. Follow these steps to do so:

1. Open Project Professional, and log on to Project Server.

2. Choose Tools ➪ Enterprise Options ➪ Import Project to Enterprise. Project starts the Import Projects Wizard.

3. On the first screen of the wizard, click Next. Project displays the Import Project dialog box, which you use to navigate to the .mpp file that you want to import into the Project Server database.

4. After you find the .mpp file that you want to import, click the Import button. If any of the settings in your file are different from the settings in the Enterprise Global template, you see a message like the one shown in Figure 19-34. Click OK to allow the Enterprise Global template settings to overwrite the settings in your project.

Figure 19-34: You see warnings like this when your project’s settings don’t match the settings in the Enterprise Global template.

5. On the next screen of the wizard, shown in Figure 19-35, select the name, version, type, calendar, and enterprise project custom field values for the project that you’re importing to the Project Server database. To set enterprise custom field values, click in the Value column, and a list box appears. When you finish, click Next.
Figure 19-35: Establish Project Server settings for the project that you're importing.

6. Use the next screen, shown in Figure 19-36, to map resources in your project to enterprise resources. To map resources, click in the Action on Import column, and a list box appears. Repeat this process in the Calendar or Enterprise Resource column. When you finish, click Next.

Figure 19-36: Map project resources to enterprise resources.
7. Use the next screen, shown in Figure 19-37, to map task fields in your project to enterprise task fields. To map, place a check mark in the column of the field that you want to map. Click in the From: Task Field column, and a list box appears. Click in the To: Enterprise Task Field column, and another list box appears. When you finish, click Next.

![Map Task Fields](image)

**Figure 19-37:** Map project task fields to enterprise task fields.

8. On the next screen, shown in Figure 19-38, you see a summary of the settings that you’ve selected using the wizard. The wizard also analyzes tasks in your project for errors and reports any errors that it finds on this screen. Click the Import button, and Project imports the project to the Project Server database.

9. When the wizard completes the import, you see the screen shown in Figure 19-39. Choose to import more projects, or click the Finish button.
Figure 19-38: This screen summarizes the settings that you selected using the wizard.

Figure 19-39: After importing a project, the wizard enables you to import additional projects.
Now that you have some projects in the Project Server database, review the defaults views that are available in the database and decide whether you need any additional views or modifications to existing views.

**Setting Up Administrative Projects**

As you found out in Chapter 17, you use administrative projects in Project 2003 to account for nonworking time. These administrative projects contain tasks that represent reasons why a resource may not be available for work—for example, vacation, sickness, jury duty, or bereavement. In these projects, you assign all your resources to all the administrative tasks. When you publish this project, all the tasks appear at the bottom of each resource’s time sheet with a work assignment of 0 hours. The resource can fill time in these tasks as needed.

When the resource fills in time, you receive notification, but if your resource is assigned to projects that you don’t manage, you need to notify the managers of those projects to the change in the resource’s availability.

Project Web Access no longer makes calendar changes based on working time changes. Instead, it changes a resource’s availability. Because of this behavior change, resource or project managers may have additional responsibilities regarding administrative projects, and they need to fill a potential communication gap. Your organization should standardize the way in which administrative projects are handled to minimize the manual intervention that these projects require.

To create an administrative project, log on to Project Web Access and click the Projects link. At the bottom of the Actions pane, click the Manage Administrative Projects link. Project Web Access displays the Manage Administrative Projects page (see Figure 19-40).

Click the Add Project link, and Project Professional opens using a template that contains sample administrative tasks (see Figure 19-41).

Use the Build Team from Enterprise dialog box to assign the resources that you manage to this project. Then, assign each resource to every task in the project. Finally, publish the project to your Project Server database to make the administrative project and its tasks appear on the time sheets of the resources that you manage.
Figure 19-40: From this page, you can create an administrative project.

Figure 19-41: Use this project as the foundation for your administrative project.
Customizing Project Web Access

The administrator can customize Project Web Access in the following ways:

✦ Customize menus
✦ Establish tracking settings
✦ Control the formatting of Gantt task bar styles and the timescale
✦ Establish grouping formats for the time sheet and views in the Project Center and the Resource Center
✦ Set up nonworking time categories
✦Modify the default home page appearance
✦ Set up defaults for the e-mail server and messages that are used in the Notifications and Reminders features

Establishing Project Web Access menus

In Project Web Access, click the Admin tab and then click the Server configuration link in the Actions pane. Then click the Menus link in the Actions pane. You see the Menus page, as shown in Figure 19-42. From this page, the administrator can modify the appearance of all pages in Project Web Access by setting the order of the links on each page, moving links to different pages, changing a link's name, adding custom menus (tabs), and providing custom ToolTips for links.

Establishing tracking settings

By using the Tracking settings page, as shown in Figure 19-43, the administrator can set the default tracking method for projects that are published to the Project Server database and permit project managers to select different tracking methods when creating their projects. Display this page by clicking the Customize Project Web Access link in the Actions pane on the Admin tab. Then click the Tracking Settings link in the Actions pane.
Figure 19-42: Use this page to customize the appearance of menus and pages in Project Web Access.

Figure 19-43: The administrator can select a default tracking method for published projects and allow managers to choose a different method.
As you scroll down this page, you find that you can lock down time sheet periods so that resources can report time only in open periods (see Figure 19-44). Using this feature, you can connect Project Server to external time-tracking programs and import time from them into the Project Server database. This feature also enables you to connect the Project Server database to your general ledger.

![Figure 19-44: Use the Managed time sheet periods section of this page to identify time-reporting periods and their status.](image)

The capability to lock down time reporting periods is new to Project 2003.

**Selecting the Gantt taskbar styles and timescales**

Using the Gantt Chart formats page, shown in Figure 19-45, the administrator can control the appearance of Gantt taskbars and the timescale on Gantt Charts for some or all Gantt Charts that team members and managers view in Project Web Access. To select specific Gantt Charts to change, use the Gantt Chart list box on the page. Display this page by clicking the Customize Project Web Access link in the Actions pane on the Admin tab. Then click the Gantt Chart formats link in the Actions pane.
Selecting grouping formats

Using the Grouping formats page, shown in Figure 19-46, the administrator can format the appearance of grouped information on the time sheet that is shown on the Tasks tab. The administrator can also define the appearance of up to ten groups for views in the Projects Center and the Resource Center. Display this page by clicking the Customize Project Web Access link in the Actions pane of the Admin tab. Then, click the Grouping formats link in the Actions pane.

Figure 19-45: The administrator can modify the appearance of Gantt taskbars and timescales in Project Web Access.
Figure 19-46: Establish grouping formats for the time sheet that is shown on the Task tab and for views that are shown in the Project Center and the Resource Center.

Setting the default home page appearance

Using the Home page format page, shown in Figure 19-47, the administrator can add links or content to the Project Web Access Home page. Links jump team members to other places on the company server or on the Internet. Content may include important information or an announcement that you want users of Project Web Access to see when they log on. Display the Home page format page by clicking the Customize Project Web Access link in the Actions pane on the Admin tab. Then, click the Home page format link in the Actions pane.
Links appear in a special Links section at the bottom of each user’s home page. For links, the administrator must supply the URL (the full path, including http or the file prefix) for the link. The content from each file appears in its own section on the home page. For content, the administrator must specify the height (in pixels) that the content is to occupy on the home page and provide the full URL, including http or the prefix of the file that contains the content.

**Establishing notifications and reminders options**

Using the Notifications and reminders page, shown in Figure 19-48, the administrator can set up the SMTP mail server that is used in the Notifications and Reminder feature of Project Server and customize the default e-mail message that is sent. Display this page by clicking the Customize Project Web Access link in the Actions pane on the Admin tab. Then, click the Notifications and reminders link in the Actions pane.
Completing Housekeeping Chores

As you would expect, some housekeeping tasks need to be done to keep the Project Server database in good working order. You need to do the following tasks:

✦ Maintain the OLAP cube
✦ Update resource tables
✦ Periodically check in projects and resources
✦ Delete information from the Project Server database
✦ Periodically manage the SharePoint information

Managing the OLAP cube

To use the Portfolio Analyzer feature in the Project Server database, you need to build an Online Analysis Processing (OLAP) cube using Analysis Services repository information. Building the OLAP cube consists of the following three-part process:
1. Migrate the Analysis Services repository to an SQL database.

2. Build the cube.

3. Give users permissions to use the cube.

Building the cube is a processor-intensive procedure. You should avoid running other processes or using Project Web Access while building the cube.

**Migrating the Analysis Services Repository**

The following is a one-time-only procedure.

The information that is stored in the Analysis Services Repository is used to build the OLAP cube. Initially, this information is stored in the format of an Access database. If you leave the information in this format, permissions for using the cube are difficult to control. Therefore, before you build the cube, you should migrate the Analysis Services Repository to an SQL Server database. This two-part process involves first creating an empty SQL database and then migrating the Analysis Services data into it. To create the SQL database, follow these steps:

1. Choose Start ➪ All Programs ➪ Microsoft SQL Server ➪ Enterprise Manager. You see the SQL Server Enterprise Manager window, as shown in Figure 19-49.

![Figure 19-49: Use this window to create a new SQL database.](image)
2. Expand the tree in the left pane until you see the Databases folder.

3. Right-click the Databases folder, and choose New Database from the shortcut menu that appears. You see the Database Properties dialog box.

4. In the Name text box, type a name for the database that is to hold the OLAP information (I called mine OLAPRepository) and click OK.

5. Close the SQL Server Enterprise Manager window.

To migrate the Analysis Services information into the SQL database that you just created, follow these steps:

1. Choose Start ➪ All Programs ➪ Microsoft SQL Server ➪ Analysis Services ➪ Analysis Manager. You see the Analysis Manager window, as shown in Figure 19-50.

   ![Figure 19-50: Use this window to migrate the Analysis Services Repository.](image)

2. Expand the tree in the left pane until you see the name of the server on which Analysis Services is installed.

3. Right-click the name of the Analysis Services server, and choose Migrate Repository from the shortcut menu that appears to start the Migrate Repository Wizard.

4. On the first screen, choose Analysis Services native format and click Next.
5. On the next screen, enter the name of the server on which SQL 2000 is installed; then click Next.

6. On the next screen, choose the authentication method that you use to connect to the SQL server — either Windows Authentication or SQL Server authentication. If you use SQL Server authentication, enter your login ID and password.

7. Click Next, select the database that you created in the preceding set of steps (see Figure 19-51), and click Finish.

8. When the process finishes, close the Analysis Manager window.

Building the OLAP cube

Building the OLAP cube can be a time-consuming process, so plan to do it during a period when people don’t need to be using the Project Server database. To build the cube, follow these steps:

1. Log on to Project Web Access as the administrator, and click the Admin tab.
2. In the Actions pane, click the Manage enterprise features link.
3. In the Actions pane, click the Update resource tables and OLAP cube link.
4. Scroll down to the Build the OLAP cube section (see Figure 19-52), and select the Yes, I want to update resource availability information and build an OLAP cube option button.
5. In the OLAP cube name and description section, enter the name of the server on which Analysis Services is installed, the name that you want to assign to the OLAP cube, and, optionally, a description.

6. In the Date range section, choose the date range that you want to use when building the cube.

7. In the Date range for resource availability section (see Figure 19-53), choose the date range that you want to use for resource updates.

8. In the Update frequency section, select the Update only when specified option button and then click Update Now. You see a message telling you that the cube creation process has started.
As I mentioned at the beginning of this section, building the cube can take a while. And, you don’t see anything happening on-screen while the cube is being built. You can, however, monitor the activity if you refresh the page and check the Current Cube Status section.

Remember the name of the OLAP cube that you are generating because you will need to refer to it later.

If you see an error message stating that the connection to the repository cannot be established, you may need to set additional permissions for the OLAP repository. Follow these steps to do so:

1. Open Windows Explorer.
2. Browse the folders until you are viewing the contents of the \Program Files\Microsoft Analysis Services folder (see Figure 19-54).
3. Right-click the Bin folder, and click Properties from the shortcut menu that appears to open the Bin Properties dialog box (see Figure 19-55).
Figure 19-54: Use Windows Explorer to find the Bin folder.

Figure 19-55: Use this box to add permissions to the repository.
4. Click the Security tab, and then click the Add button to open the Select Users or Groups dialog box.

5. Click the Advanced button, and then click Find Now. Choose OLAP Administrators from the list that appears, and click OK twice (see Figure 19-56).

6. In the Groups or user names section of the Bin Properties dialog box, click OLAP Administrators.

7. In the Permissions for Administrators section of the Bin Properties dialog box, select the Allow check box next to Full Control.

8. Click OK.

**Enabling users to view the cube**

Once you’ve created the OLAP cube, you need to give users access to it so that they can use it with the Portfolio Analyzer feature in Project Web Access. Follow these steps to provide access to the OLAP cube:
1. Choose Start ➪ All Programs ➪ Microsoft SQL Server ➪ Analysis Services ➪ Analysis Manager to open the Analysis Manager window.

2. Expand the tree in the left pane until you open the OLAP cube to which you want to give permissions (see Figure 19-57).

![Analysis Manager](image)

**Figure 19-57:** Find the OLAP cube to which you want to assign permissions.

3. Right-click Database Roles, and choose Manage Roles from the shortcut menu that appears to display the Database Role Manager dialog box.

4. Click New to open the Create a Database Role dialog box (see Figure 19-58).
5. Enter the name of the role in the Role name box, and then click Add on the Membership tab to open the Add Users and Groups dialog box (see Figure 19-59).

Figure 19-58: Use this box to enable additional users to use the OLAP cube.

Figure 19-59: Select users to add to a role.
6. In the List Names From list box, select the `servername/machinename` or domain name as appropriate.

7. Click Show Users, and select a user who you want to be able to use the cube. Click Add.

8. Repeat Step 7 for each user who should have access to the cube. Then click OK.

9. Click the Cubes tab of the Create a Database Role dialog box (see Figure 19-60), and select the `MSP_PORTFOLIO_ANALYZER` check box. Then click OK.

![Figure 19-60: Select the cube to which you want to add the role.](image)

10. When you finish, close the Database Role Manager dialog box and the Analysis Manager window.

**Updating resource tables**

You use the same page to update resource tables that you used to create an OLAP cube (see Figure 19-61). You can, however, update the resource tables without building the cube. Display this page by clicking the Manage enterprise features link in the Actions pane on the Admin tab. Then click the Update resource tables and OLAP cube link in the Actions pane. To build the resource tables but not the OLAP cube, choose the No, I only want to update resource availability information option button.
As is the case when building an OLAP cube, updating resource tables is processor intensive on the machine that houses the Project Server database because the process gathers lots of information for reporting purposes. You should schedule this operation at a time when most people are not using the Project Server database.

**Caution**

Checking in enterprise projects and resources

Occasionally, as administrator, you may need to check in projects or resources. For example, after hours, you may be planning maintenance to the Project Server database, and someone may have left work without closing a project.

Instead of tracking down the machine of the person who checked out the project, you can use the Check in enterprise projects page, shown in Figure 19-62, and the Check in enterprise resources page, shown in Figure 19-63, to check in projects or resources. Simply highlight the project or resource, and click the Check-In link. Display these pages by clicking the Manage enterprise features link in the Actions pane on the Admin tab. Then click the Check in enterprise projects link or the Check in enterprise resources link in the Actions pane.
Figure 19-62: Check in projects from this page.

Figure 19-63: Check in resources from this page.
Managing information in the Project Server database

The administrator can (and should) periodically delete old information from the Project Server database, because response time from the database increases as the database grows in size. To help maintain some semblance of speed for team members when they use the database, the administrator can delete old, unnecessary information by using the Clean up Project Server database page, shown in Figure 19-64. Display this page by clicking the Clean up Project Server database link in the Actions pane on the Admin tab.

![Image of Clean up Project Server database page](image.png)

**Figure 19-64:** Use this page to reduce the size of the database and speed the processing in the database.

Click the option buttons next to the types of items that you want to delete; note that you can selectively delete information. And, although you can’t see these options in Figure 19-64, on the bottom of the Clean up Project Server database page, you can delete tasks, resource task changes, and status report information for all users or specified users. After setting up the page, click the Delete button at the bottom to delete the information.
Managing SharePoint sites and synchronizing administrator accounts

On the Manage Windows SharePoint Services sites page, shown in Figure 19-65, the administrator can create a site, change the address of a site, delete a site, and synchronize access to sites. To display this page, click the Manage Windows SharePoint Services link in the Actions pane on the Admin tab. Then, click the Manage SharePoint sites link in the Actions pane.

Figure 19-65: Use this page to make changes to SharePoint sites.

To display the Synchronize administrator accounts page, shown in Figure 19-66, click the Manage Windows SharePoint Services link in the Actions pane on the Admin tab. Then, click the Synchronize administrator accounts link in the Actions pane.
Figure 19-66: Synchronize administrators from this page.

On this page, the Project Server administrator can add users who have permission to manage Windows SharePoint Services via Project Web Access to the administrator (Microsoft Project Server) role of each project site on the Windows SharePoint Services server. By default, granting permission to manage WSS in Project Web Access does not automatically grant the user access to all project sites on the Windows SharePoint Services server. Synchronizing administrators solves the problems and grants the user access to all project sites.

Summary

Customizing the Project Server database to meet your organization’s needs is a task that initially requires a person with project management background and a person with information technology background. Some of the customization tasks are performed in Project Professional, and the rest are performed in Project Web Access. Once the database is set up, the Project Server administrator’s role becomes mostly occasional maintenance.
In this chapter, you completed tasks that were needed to customize the Project Server database to meet the needs of your organization. Specifically, you did the following:

✦ Double-checked settings
✦ Set up users
✦ Set up the Enterprise Global template
✦ Set up the Enterprise Resource Pool
✦ Imported projects into the Project Server database
✦ Customized Project Web Access
✦ Reviewed housekeeping tasks

In Chapter 20, you see how the Project/Resource Manager works with Project Professional and Project Web Access.
Project Server offers a wide variety of tools to project managers to help them manage projects more effectively. In this section, you find out how to connect to Project Server, create a Web-based project, use the Enterprise Resource Pool to assign resources to your project, track project progress, and take advantage of Project Server’s management tools to more effectively utilize resources and manage projects.

The information in this chapter, in Chapter 19, and in Chapters 21 through 23 applies to Project Professional. If you are using Project Standard, you can’t use Project Server and Project Web Access. You can, however, use the Internet to communicate with your workgroup via e-mail. Chapter 16 covers this feature in more detail.
Connecting to Project Server

If you’re going to use Project with Project Server (as opposed to using Project in a stand-alone environment), you need a Project Server account, which enables you to log on to Project Server.

Creating a Project Server logon account

You can easily create your own Project Server account from within Project after you know the URL for your Project Server database — your Project Server administrator will most likely give you this URL.

To create a Project Server Account, follow these steps:

1. In Project Professional, choose Tools ➪ Enterprise Options ➪ Microsoft Project Server Accounts. You see the Project Server Accounts dialog box, as shown in Figure 20-1.

![Figure 20-1: Use this dialog box to add a Project Server logon account and to specify connection state detection options.]

2. Click the Add button. You see the Account Properties dialog box, as shown in Figure 20-2.
3. In the Account Name box, type a name for the account. You must use a name that no other user is already using — such as your own name.

4. In the Project Server URL box, type the URL for the location of your Project Server database.

To ensure that you type the URL correctly, click the Test Connection button. If you’ve typed it correctly, you see a dialog box telling you that Project has successfully connected to the server that you specified.

5. In the When connecting section, choose the type of connection that your organization uses, as follows:

   - Use your Windows logon information by selecting the Use Windows user account option button.
   - Use your Project Server account, which uses Project Server authentication, by selecting the Use a Microsoft Project Server account option button. In the User name box, type your name.

Windows user account authentication is generally more stringent than Project Server authentication.

6. (Optional) If you intend to create more than one account and you want the current account to be your default logon account, select the Set as default account check box.

Why create another account? If your company uses more than one database in Project Server, you need more than one account to access the correct database.

7. Click OK. You see the Project Server Accounts dialog box again.
8. At the bottom of the box, choose whether you want to log on automatically or manually control the connection state. If you choose the Automatically detect connection state option button, you don’t see the dialog box that is shown in Figure 20-3, in which you choose the account that you want to use to log on. Instead, Project simply attempts to detect the Project Server.

Figure 20-3: You see this box if you choose to manually control the connection state.

Tip

You may also see the Project Server Accounts dialog box if you’ve lost your connection with the Project Server.

Logging on to Project Server

You have the option of working with a project while connected to Project Server or working with the project in a stand-alone environment — and you make that choice when you start Project Professional.
For example, suppose that you use Project from a notebook computer while traveling. During your time away from the office, you want to keep track of the time that you spend working. If you manually control the connection state, which was discussed in the previous section, click the My Computer icon in the Project Server Accounts dialog box (shown previously in Figure 20-3) and then click the Work Offline button. If you chose to automatically detect the connection state, you won’t connect to Project Server when you start Project if your computer isn’t connected to the network.

The first time that you log on to Project Server, you see the message shown in Figure 20-4. Click the Make Server Trusted button, and then click the Retry accessing the Project Server link. If your organization chose to use Project Server authentication, you see the dialog box shown in Figure 20-5.

**Figure 20-4:** Make your Project Server site a trusted site the first time you log on.

**Figure 20-5:** Supply your password and click Go to finish opening Project and logging on to Project Server.
If you are connected to the Project Server database and you see a message that indicates you’re not allowed to log on because the database is unavailable, double-check with the Project Server administrator, and make sure that you have been set up as a user in Project Server who belongs to the Project Managers group or any group with higher permission settings.

Creating a Web-Based Project

The project manager is the person who builds and maintains the project schedule and makes task assignments. The “boss” uses Project to create the schedule and make assignments to team members to track their activities. When setting up the project schedule, the project manager must set up the project so that it can be uploaded (published) to the Project Server database. To successfully establish a Web-based project, the project manager should complete the following tasks in Project:

✦ Set the project’s options to use Web communications
✦ Publish project information to the Project Server database

Setting a project’s Web-based options

While logged on to the Project Server database, follow these steps to set the options of a project to use Web communications:

1. Choose Tools ➪ Options.
2. Click the Collaborate tab, as shown in Figure 20-6.
3. In the Collaborate using drop-down list, select Microsoft Office Project Server.

Cross-Reference

See Chapter 16 for more information about setting up a project schedule to collaborate using e-mail.

4. In the Project Server URL box, enter the URL that resources should use in their Web browsers to display Project Web Access. This Internet address points to a Web server or your organizational server and a folder that contains the Project Server database. It is the same URL that you supplied when you created your Project Server logon account.
5. For the method of identification, you can specify one of the following methods:
   - Use Windows logon information by selecting the Windows user account option button.
   - Use Microsoft Project user names, which you can set on the General tab in the Options dialog box.

   The name on the General tab is grayed out and can’t be changed when you are logged on to Project Server. You must open Project Professional without logging on to Project Server to be able to change the user name on the General tab.

6. In the E-mail address box, type in the e-mail address of the person who should receive notifications about assignment updates; typically, this is the project manager.

7. At the bottom of the tab, choose whether resources can delegate tasks in Project Web Access, and what updated information is sent to the Project Server database when you save your project. You can also choose the types of changes that will cause resources’ assignments to be updated.

8. Click OK to save your settings.
Storing a project in the Project Server database

At this point, you’ve probably set up a project schedule on your local hard drive that you’re ready to store in the Project Server database. After you’ve set the project’s options to define it as a Web-based project, you need to log on to Project Server and then save the project in the Project Server database.

Open Project Professional, and log on to Project Server (refer to the section “Logging on to Project Server,” earlier in this chapter). Then, open the project that you want to store on the Project Server and choose File ➪ Save As. You see the Save to Project Server dialog box. The version of the box that you see in Figure 20-7 includes custom fields. If your Enterprise Global template doesn’t contain custom fields, you see a box similar to the one shown in Figure 20-8.

![Figure 20-7](image1)

**Figure 20-7:** When the Enterprise Global template contains custom fields, the Save to Project Server dialog box looks like this.

![Figure 20-8](image2)

**Figure 20-8:** When the Enterprise Global template has no custom fields, the Save to Project Server dialog box looks like this.
If you prefer wizards, you can use the Import Project Wizard to save your project to the Project Server database. Don’t open your project; instead, choose Tools ➪ Enterprise Options ➪ Import Project to Enterprise. Then, follow the wizard’s steps.

After saving your project, Project changes the name of your project in the title bar so that you know that you’re viewing the version that you saved to the Project Server database. The name of the published version includes the word Published; for example, if your original project name was network, the published version would be named network.Published.

Opening a project stored in the Project Server database
Even if you’re connected to the Project Server database, in Project Professional, you have the option of opening either the original project schedule or the version that’s been published to Project Server. Click the Open button on the Standard toolbar. You see the Open from Microsoft Project Server dialog box, as shown in Figure 20-9.

Figure 20-9: In this dialog box, open a project in the Project Server database or open it from the original .mpp file.

Select the project that you want to open, and then click the Open button to open the version that is stored in the Project Server database. To open the original Project .mpp file, click the Open from File button.
When do you use the Open from File button? Suppose that you publish a project and then discover that you want to make major changes to it; for example, the project start date may have changed. Open the original file instead of the version that is stored in the Project Server database. Make the necessary changes to the original file, and then republish it.

You see the .published version of your project in Project Professional — the word Published is added to the project name in the title bar. At this point, Project Server views this project as being checked out — that is, no one else can open the project in Project Professional and save changes to it. You can see the status of the project from the Open from Microsoft Office Project Server dialog box (refer to Figure 20-9); for each checked-out project, you can see who has opened it.

You can open a project in the Project Server database and, using the Save As command, create a local .mpp version of it that you can work on at the airport or at home.

Once you’ve published a project, you can’t overwrite it with changes from the .mpp file. To replace the file, use the Save As command to assign a new name to the project and then delete the old published project.

When you close the project, Project automatically checks the project back in. If the project remains checked out, you can check it in from Project Web Access. Click the Projects link to view the Project Center; from the Actions list in the left pane, click the Check in my projects link.

Checking in your own projects in Project Web Access is new to Project 2003.

**Viewing Project Server pages in Project Professional**

One of the neat features available in Project 2003 is the ability to display Project Server pages in Project. Choose Collaborate ➪ Project Center to see the Project Center, as shown in Figure 20-10, or choose Collaborate ➪ Resource Center to see the Resource Center, as shown in Figure 20-11. To return to Project, click the Click here to close this view link in the upper-right corner of the page.

If you don’t see any projects or resources (or projects or resources that you think you should see) in the Project Center and Resource Center views, check with the Project Server administrator and make sure that you have the proper security permissions.
Figure 20-10: View the Project Center while working in Project.

Figure 20-11: View the Resource Center while working in Project.
Publishing project information

Saving the project to the Project Server database (as in the section “Storing a project in the Project Server database,” earlier in this chapter) doesn’t send any of the scheduling or summary information that can be seen by using Project Web Access; saving a project puts a placeholder in the Project Server database for the project. To view the details of the project, you need to publish information. Use the commands on the Collaborate menu to publish information.

Choose Collaborate ➪ Publish to see the following menu of commands, which you can use to update the Project Server database with information from Project:

- **All Information**: Publishes both new and changed assignments and a project plan (either complete or summary — see Project Plan in this list for details).
- **New and Changed Assignments**: Publishes changes to tasks, such as new start or finish dates. Resources receive notification in Project Web Access and via e-mail if your organization has set up Project Server to provide e-mail notifications and reminders.
- **Project Plan**: When you choose this command, you are given the option to publish the entire plan or a summary of the plan. The summary includes only task and scheduling information, and the complete plan includes assignments. If you publish the summary only, you see the project in the Project Center, but you can’t drill down and see details because they aren’t there.
- **Republish Assignments**: Use this command to force Project to publish assignments — even if they’ve been published previously. You can choose to republish all or only some assignments.

A note about administrative projects

When a resource reports a change in working time availability, he reports them using tasks that are stored in one or more administrative projects. Furthermore, Project Web Access no longer makes calendar changes based on these working time changes; instead, it changes a resource’s availability. Because of this behavior change, you, as a resource or project manager, may have an additional responsibility regarding administrative projects and may need to fill a potential communication gap. See Chapter 17 for more details.

Because of a behavior change between Project 2002 and Project 2003, you, as a manager, may need to create an administrative project that contains tasks such as vacation, sick leave, jury duty, and bereavement.

Your organization should standardize the way that administrative projects are handled to minimize the manual intervention that these projects require.
In this project, you assign all your resources to all the administrative tasks. When you publish this project, all the tasks appear at the bottom of each resource’s timesheet with a work assignment of 0 hours. The resource can fill in time for these tasks as needed.

When the resource fills in time, you receive notification, but if your resource is assigned to projects that you don’t manage, you need to notify the managers of those projects to the change in the resource’s availability.

To create an administrative project, log on to Project Web Access and click the Projects link. At the bottom of the Actions list in the left pane, click the Manage Administrative Projects link. Project Web Access displays the Manage Administrative Projects page (see Figure 20-12).

![Figure 20-12: From this page, you can create an administrative project.](image)

Click the Add Project link, and Project Professional opens using a template that contains sample administrative tasks (see Figure 20-13).
Use the Build Team dialog box — which you read about in the section “Adding enterprise resources to your project,” later in this chapter — to assign the resources that you manage to this project. Then, assign each resource to every task in the project. Finally, publish the project to your Project Server database to make the administrative project and its tasks appear on the time sheets of the resources that you manage.

When you receive notification of administrative time from a resource, you need to double-check the resource’s project assignments and, as appropriate, notify the managers of those projects of the resource’s availability change.

**Using to-do lists**

Suppose that you’re using Project Web Access and you find that you really need a “to-do” list. If the Project Server administrator has enabled this feature, you can use the To-Do List feature in Project Web Access to start the list. You can maintain the list in Project Web Access, or you can upload it to Project Professional and use it to create a new project if appropriate.
You can create as many to-do lists as you want. Think of each list as the task list for a potential new project.

Click the Projects tab in Project Web Access to view the Project Center. In the Actions list in the left pane, click the Create a new personal or shared to-do list link to display the page shown in Figure 20-14.

Figure 20-14: Creating a to-do list.

You may not have security rights to view projects in the Project Center, but you can still create a to-do list.

After you complete the first page of the to-do list and click Next, you see a page like the one shown in Figure 20-15, where you can create tasks. Any task that you assign to a resource appears immediately on that resource's Task page. Resources can update progress, delegate, or reject tasks that you created on a to-do list.
After you complete the second page, click the Save New Tasks button. You see the Manage my to-do lists page, which lists your tasks in a Gantt Chart view, as shown in Figure 20-16. You can add new tasks by clicking the New Task(s) button in this window.
Figure 20-16: You manage to-do lists from this view.

If you click the To-do list options link in the Actions pane, you see the To-do list options page, as shown in Figure 20-17. From this screen, you can rename a to-do list, transfer the list to someone else, send the tasks in the list to Project Professional, delete the list, or change the viewing permissions of the list.
Assigning resources to projects

If your organization uses Project Server, you have some additional powerful tools at your disposal to assign resources and manage resource utilization. Your organization will probably use the Enterprise Resource Pool that's available in Project Server; this provides a list of all resources that are owned by your organization. The administrator initially builds the Enterprise Resource Pool and imports existing projects to Project Server. If you have appropriate permissions, you can add resources to the Enterprise Resource Pool.

See Chapter 19 for more information on adding resources to the Enterprise Resource Pool and importing projects to Project Server.

As the project manager, you can use the Team Builder feature and the Enterprise Resource Pool to select resources that are appropriate for your project. You also can assign generic resources to your project and then use the Team Builder feature to help you replace the generic resources with real resources.

Typically, the Project Server administrator sets up the Enterprise Resource Pool. See Chapter 19 for more information.
See Chapter 5 for information on creating generic resources.

In addition, if you manage more than one project at a time, you can take advantage of the Resource Substitution Wizard to identify the best possible utilization of limited resources.

You can assign resources to Web-based projects the same way that you assign them to stand-alone projects—see Chapter 5 for details.

### Adding enterprise resources to your project

You can use the Build Team dialog box to view the resources in the Enterprise Resource Pool and assign them to your project. Choose Tools ➪ Build Team from Enterprise. Project displays the dialog box, as shown in Figure 20-18.

**Figure 20-18:** Use this dialog box to select resources to assign to your project.

By default, you see all resources, but you can limit the resources that you see by applying filters. Use the Existing filters drop-down list, and click the plus sign (+) that appears next to Customize filters to choose fields by which to filter. In Figure 20-18, I’ve already clicked the plus sign, so it appears as a minus sign (−), and you can see the additional space for specifying filters. You also can filter by available hours to work for a given time period.
You can filter by RBS (Resource Breakdown Structure) code, and you can set as many filters as you want. By using the And choice, you reduce the number of possible resources that Project displays.

After you select resources and click OK, the resources appear on the Resource Sheet of your project, and you can assign tasks to them. When you republish your project, the Enterprise Resource Pool is updated to reflect the assignments.

**Replacing generic resources with real resources**

If your organization uses generic resources, you can use the Team Builder to match a generic resource in your project to a real resource that has the same skill set that you defined for the generic resource. Project Server matches generic resources to real resources by using an enterprise resource custom outline code with a value list for the field, where each value represents a set of skills. Once you assign the appropriate value to each resource by using the custom field, you can use the code to match skills that are required by generic resources with skills that are possessed by real people when project managers run the Team Builder.

You’ll find one enterprise resource custom outline code that the staff at Microsoft prenamed — the RBS code. Conceptually, you can compare this code for resources to a WBS code for tasks. Your organization may want to use the RBS code to establish a skill set, or your organization may want to use the RBS code for a different purpose, such as assigning a resource’s geographic location. Regardless of the enterprise custom outline code that you choose, the concept I’m about to describe is the same.

The Project Server administrator typically creates the enterprise custom fields and outline codes in Project Server. Anyone who has security rights to update the Enterprise Resource Pool can assign the appropriate RBS code to each resource. To find out how to set up and assign enterprise custom fields and outline codes, see Chapter 19.

To use the Team Builder to replace generic resources with real resources, filter the Enterprise Resource Pool so that it displays only those that match the generic resource. Follow these steps to filter the Enterprise Resource Pool:

1. In Project, open the published version of the project containing generic resources that you want to replace.
2. Choose Tools ➤ Build Team from Enterprise. Project displays the Build Team dialog box.
3. In the list on the right side of the dialog box, click the generic resource for which you want to search for a replacement.
4. Click the Match button. Project displays, in the left side of the dialog box, those resources that match the selected generic resource (see Figure 20-19).

![Figure 20-19: Replace a generic resource in your project with a real resource from the filtered Enterprise Resource Pool list.](image)

5. To assign a real resource in place of a generic resource, click the resource that you want to use in your project from the list on the left.

6. Click the Replace button. Project replaces the resource in the Team Resource list with the Enterprise resource that you selected. When you click OK, Project also updates the project by replacing the generic resource with the one that you selected.

**Notifying resources of assignments**

The project manager assigns work to resources. To notify the resources of the work assignments, the project manager publishes the assignments. At a minimum, the team members receive notifications in Project Web Access of new or updated assignments. If your organization chooses, team members may also receive e-mail notifications.
After making assignments in Project, follow these steps to send work assignments to resources:

1. (Optional) Select tasks about which to notify resources of work assignments.

2. Choose Collaborate ➪ Publish. At this point, you have the following choices:
   • Choose New and Changed Assignments to send notifications only about those assignments.
   • Choose Republish Assignments to force Project to update all assignments.

3. When you choose Republish Assignments, Project displays the Republish Assignments dialog box, as shown in Figure 20-20, from which you can set options for updating assignments. Before you click OK, you can choose to do any of the following:
   • Send e-mail messages to all affected resources. The e-mail message is sent in addition to the notification that the resource sees in Project Web Access. In Figure 20-21, you see the standard e-mail notification that Project sends; you can modify this text by clicking the Edit message text button.
   • Tell Project to overwrite actual work entered by resources.
   • Become the manager for the assignments.

![Figure 20-20: Use this window to send notice of work assignments to resources.](image-url)
Support for multiple managers began in Project Server 2002. You can be the manager of one or more assignments without being the overall project manager. You become a manager not by publishing the project plan but by publishing an assignment for a task or assuming responsibility upon republishing assignments. You can only view and process resource updates on assignments for which you are the manager.

**Using the Resource Substitution Wizard**

Suppose that you manage multiple projects with the same set of resources and you want to try to smooth work assignments and reduce overallocations across one or more projects. You can use the Resource Substitution Wizard to help you find resources to fill your needs.


The Resource Substitution Wizard can use different criteria to substitute resources. For example, the wizard can simply consider the resources in the projects that you select and reallocate them to better utilize their time. Or, the wizard can use the RBS (Resource Breakdown Structure) code that is assigned to resources to match skills required by resources that are already assigned to tasks and then substitute other resources with the same RBS code.

The Project Server administrator typically creates the RBS code; the creator of the resource (often the Project Server administrator) assigns the code to the resource. To find out how to set up and assign the RBS code, see the Chapter 19.
Follow these steps to run the Resource Substitution Wizard:

1. Open the project(s) for which you want to substitute resources.
3. Check the project(s) that you want the wizard to consider while substituting resources, as shown in Figure 20-22. Click Next.

![Figure 20-22](image-url)

**Figure 20-22:** Each project that you have open is listed and selected.

4. Choose resources for the wizard to consider when rescheduling projects, as shown in Figure 20-23. Click Next.

![Figure 20-23](image-url)

**Figure 20-23:** Use this screen to identify the resources that the wizard should consider when making substitutions.
5. Choose related projects to consider when rescheduling (see Figure 20-24). Click Next.

![Figure 20-24: Select other related projects that you want the wizard to consider when rescheduling resources.](image)

6. Specify options for the wizard to use when rescheduling, as shown in Figure 20-25. You can set the priority or choose to use resources from the pool or from the project. Click Next.

![Figure 20-25: Specify options for rescheduling.](image)
By selecting the check box at the bottom of Figure 20-25, you can also level resources set up with a booking type of “proposed.”

7. You see a summary of the options that you’ve selected. Click the Run button to run the wizard with the options that you’ve selected.

8. Click Next. The wizard displays a grid of assignments that it has changed, as shown in Figure 20-26, so that you can do the following:
   • Review the results
   • Back up and change the wizard’s options to try again

After you make your decision(s), click Next.

![Figure 20-26: The wizard’s suggested changes.](image)

9. You see the Update Options screen of the wizard, where you can choose to have Project update the projects considered by the wizard based on the results of the wizard. You also can choose to save the results of the wizard to a file. When you click Next, a final page appears.

10. If you aren’t satisfied with the results of the wizard, simply close the affected projects without saving them.

The Resource Substitution Wizard can also help you to select resources for more than one project at a time, so you can quickly develop staffing models. As Step 3 demonstrated, you can select the open projects that you want the Resource Substitution Wizard to consider; simply open each project before you start the wizard. After the wizard has finished, don’t forget to level the projects to see how the wizard’s resource assignments change project finish dates and resource utilization. If you aren’t satisfied with the results of the wizard, simply close the affected projects without saving them.
Project Web Access contains another tool that can help you with resource allocation: the Portfolio Modeler. By using the Portfolio Modeler, you can select projects to include in the model and then interactively change tasks or staffing to view the impact on a project portfolio. Although you can save the models, you can’t automatically transfer changes that you make in models to actual projects. See Chapter 22 for more information.

Assigning resources using Project Web Access

Are you a resource manager, but you don’t have Project Professional? You can manage resources, including building a team for your project, using Project Web Access (PWA). Follow these steps to assign and manage resources:

1. Log on to PWA.
2. Display the Projects page by clicking Projects on the bar at the top of the page (see Figure 20-27).

![Figure 20-27: Start the team-building process from the Project Center.](image-url)
3. Click the row of the project for which you want to build a team.

4. Click the Build Team link. PWA displays a list of resources on the left side of the Build Team page (see Figure 20-28). You only see resources for which you have permission to view within your RBS code. On the right side of this page, you see resources that are already used in your project.

![Figure 20-28: Build a team for a project using Project Web Access.](image)

5. In the list on the left, select the resources that you want to add to the project.

6. Click the Add button.

You can create a filter to find resources with specified skills. Click the plus sign (+) next to Filter enterprise resources to display the area where you can use enterprise outline codes to define and apply a filter.

You can replace generic resources easily. Select the generic resource on the right, and then click the Match button. PWA displays, on the left, real resources with the same skills as the selected generic resource. To replace the generic resource, select it on the right side of the window and select the real resource that you want to use on the left side of the window. Then click the Replace button.
By clicking a resource in the list on the right and then clicking Change Booking Type, you also can specify whether you want the resources to be committed to the project or only proposed for the project.

You can view an availability graph of a resource (see Figure 20-29) before you add it to your project. Click the resource in the Filtered Enterprise Resources list, and then click the Availability button (refer to Figure 20-28).

![Figure 20-29: The View Resource Availability graph that you see when you click the Availability button.](image)

You can view availability information as a graph or as a spreadsheet.

To assign the resource, click the Save Changes button on the Build Team page.
Tracking progress
After you’ve set up a project and uploaded it to Project Server, you need to track
the progress of your project. To effectively track progress, you need to do the
following:

✦ Establish a tracking method
✦ Set up a status report form for team members to complete
✦ Receive updates from team members as they update the project in Project
  Web Access
✦ As appropriate, adjust actual work

Establishing a tracking method
Project offers three possible ways for users to record actual work in Project Server.
The advantages and disadvantages of each are as follows:

✦ Percent of Work Complete: This method is the fastest way for resources to
  record time, but it is also the least accurate because it is based on the
  resource’s estimate of the total amount of work to be done, along with the
  amount that is actually completed. Resources enter the percentage amount.

✦ Actual Work Done and Work Remaining: This method is the “middle of the
  road” method. It is both moderately accurate and moderately fast. Resources
  enter the hours, days, weeks, and so on of the amount of work done and the
  amount of work remaining to be completed.

✦ Hours of Work Done per Time Period: This method is the most accurate
  method but also the most time-consuming. Resources enter the actual hours
  worked on each task for a specified time — typically, a day.

Your organization may have selected a tracking method for you — if so, you can’t
select a tracking method. To check the tracking method (and possibly change it),
choose Tools ➤ Customize ➤ Published Fields. Project displays the Customize
Published Fields dialog box, as shown in Figure 20-30.

If your organization has locked down the tracking method in Project Server, the first
option shown in Figure 20-30 is selected and the next three options are grayed out
(unavailable). If the options are available, you can choose to use the Project Server
method or select a method for the current project.

Setting up status reports
As a manager, you can create the layout for the status report that you want to view
from your team members — and you can specify how often you want status reports,
as shown in Figure 20-31.
Figure 20-30: Use this dialog box to check the tracking method and, if possible, change it.

Figure 20-31: The project manager can create a status report format for use by the team.
By using the Group Status Reports feature, managers can combine the status reports of team members into one overall status report.

To create a standard layout for a status report, click the Status Reports link at the top of the page. Then, in the Actions pane, click the Request a status report link to start a wizard that walks you through the process. On the first screen of the wizard, you can choose to create a new status report, edit an existing status report, or delete a status report. After you select Set up a new status report for your team to respond to and click OK, Project Web Access displays the first of four screens, on which you provide titles and information about how often you want the report, as shown in Figure 20-31.

Fill in the page, and click Next. You see a page where you can identify who should report, as shown in Figure 20-32.

![Figure 20-32: Select resources to submit status reports.](image-url)
Decide who should submit status reports, and click Next. Project displays a page like the one shown in Figure 20-33, where you can identify the topics that you want to have covered in the status report, and click Next.

![Figure 20-33: List the topics that you want to have included in the status report.](image)

On the last page of the wizard, shown in Figure 20-34, click the Send button to send a skeleton of the status report to the selected team members. The team members can then use the skeleton to fill in the information that you want to see.
Receiving updates from team members

When team members record time on the Tasks page, they click either the Update All button or the Update Selected Rows button. In either case, they see a message like the one shown in Figure 20-35, indicating that an update was sent to the project manager for approval.

Figure 20-35: Project team members see notices that their project managers will be notified of actual work that they’ve recorded.
Functional managers can also track and approve actuals that are recorded by resources who are working for them. From the Resource Center of PWA, click the Approve timesheets link in the Actions pane.

When the project manager logs on to Project Web Access, the home page contains a link that isn’t found on a team member’s home page — the Updates link, as shown in Figure 20-36.

![Figure 20-36: The project manager’s home page contains an Updates section that contains information about pending updates.](image)

When the project manager clicks the Update link, Project Web Access displays the View task changes submitted by resources page, as shown in Figure 20-37.
Figure 20-37: The project manager views and accepts or rejects the update(s).

If resources submit calendar changes, the project manager sees the View changes to resource calendars page.

The project manager can accept or reject any update by clicking in the Accept? column to display the drop-down list. If, after reviewing updates, the project manager wants to accept all updates received, the project manager can click the Accept All link. After accepting or rejecting task updates, the project manager clicks the Update button in the upper-right corner of the window. If Project isn’t already running, Project Web Access launches it, opens the project from the server in Project, and updates the project. After updating has completed, you see a message indicating that you need to save your project. If you click Yes, Projects save the project.

If you don’t save the Project file, updates remain in Project Web Access until you save the file.

In Project Web Access, you see a message indicating that approved task changes have been updated in Project and resources have been notified by e-mail of rejected tasks.
The project manager can set up rules for automatically accepting changes from selected users for selected projects. Click the Set rules for automatically accepting changes link in the Actions pane.

**Adjusting actual work**

In most cases, your organization will lock down actual work so that, once reported, actual work can’t be changed — this is simply good business practice. However, in some cases, adjusting actual work is appropriate and makes sense, and the administrator can give you permission to adjust actual work.

If you have this privilege, you can view the Adjust actuals page (see Figure 20-38) when you click the Adjust actuals link in the Actions pane of the Resource Center (click Resources at the top of the PWA page).

![Figure 20-38: Use this page to adjust actual work when appropriate.](image)

Select the resource whose actual work you want to adjust, click the Add button, and then click the Apply button. The reported information appears at the bottom of the page, giving you the opportunity to adjust the work by supplying either a percentage (the left side of the page) or an hourly adjustment (the right side of the page). Navigating away from the page saves the change.
Working with issues and risks

If your organization is using Windows SharePoint Services, you can create and track issues and risks that are associated with a project. Issues and risks can be initiated by anyone with proper permissions, and the concept behind them is to promote collaboration on the project team.

You also can attach documents to projects, tasks, or to-do lists. See Chapter 21 for more information about document tracking.

Tracking issues

Issues are unexpected things that occur on projects. They may be problems, or they may be opportunities. When they arise, you can create an issue, let others on the team review the issue, assign the issue to someone to address, and monitor the progress of the issue.

The Project Server administrator must give you rights to work with issues.

To set up an issue for tracking, click the Issues tab. Project Web Access displays an overview screen like the one shown in Figure 20-39, which shows each project that you have security rights to view and the manager of that project.

![Figure 20-39: On this overview page, you see the projects for which you have rights to view and the managers of those projects.](image-url)
You can see an overview of the number of issues on each project if you click the View issue summary for all projects link.

Click a project to view the issues for it and set up a new issue. Click the New issue button to create a new issue; Project Web Access displays the Issues: New Item page. In Figure 20-40, you see the top half of the page, where you assign a title, status, and priority to the issue; assign the issue to someone; identify the issue owner; set a due date; describe the issue; and (if possible) provide a resolution for it.

You save an issue by clicking the Save and Close link at the top of the Issues: New Item page.

Figure 20-40: You describe basic identifying information on the top half of the Issues: New Item page.

When you scroll down the page, as shown in Figure 20-41, you have the opportunity to identify affected tasks, tasks that can help resolve the issue, other linked tasks, linked issues, and linked documents.
You edit an issue by clicking its link. You can filter issues by using the links in the Actions pane.

To save the issue, scroll to the top of the page and click the Save and Close link. PWA redisplay the Issues page for the selected project, with the new issue listed (see Figure 20-42).

**Tracking risks**

Risks are possible events or conditions that could negatively impact a project. Risks are events that have not yet occurred but that *could occur.* Essentially, a risk is an issue before it happens.

You create a risk the same way that you create an issue, but you start by clicking the Risks link at the top of the PWA window. Again, you see the list of projects that you have permission to view along with each project’s manager. The window closely resembles that previously shown in Figure 20-39. Click the link for the project for which you want to create a risk and, on the Risks page, which closely resembles that previously shown in Figure 20-42, click the New Risk link. The page that you use to create a new risk closely resembles that previously shown in Figures 20-40 and 20-41.
Figure 20-42: On the Issues page, you see issues for the currently selected project.

**Using versions**

Your organization may decide to create a variety of versions that you can use when you publish projects so that you can compare variations of the same project. For example, your organization may create versions that enable you to compare versions that include added and deleted tasks that were not saved in baselines. Making comparisons between snapshots of a project taken at different times can help you with trend analysis.

Before you can use the Versions feature, the Project Server administrator must define the available versions. After the administrator makes versions available for use, create a version by doing nothing more than saving your previously published project to Project Server as a type of version. Choose File→Save As. In the Save to Project Server dialog box, as shown in Figure 20-43, select a version.

To open a version, click the Open button in Project. You see the available version for each project in the Open from Microsoft Office Project Server dialog box, as shown in Figure 20-44. Simply highlight the appropriate project and version, and click the Open button.
You may also want to take a look at the Portfolio Analyzer feature in Project. This feature provides graphic representations of project and resource information that give you a fast and powerful way to analyze information. After the Project Server administrator sets up the technology that is needed to generate the views, Project Web Access users with appropriate security rights can use the Portfolio Analyzer from either the Project Center or the Resource Center. See Chapter 22 for more information.
Summary

In this chapter, you read about how to address your primary concerns as a project or resource manager who deals with Web-based projects. You found out how to do the following:

- Log on to Project Server
- Create a Web-based project
- Manage resource assignments for Web-based projects
- Track the progress of Web-based projects

For information about the behind-the-scenes tasks that helped create your Project Server environment, read Chapter 19. For more information on the day-to-day tasks that your team members can perform, see Chapter 20. To see how an executive can take advantage of Project Web Access, see Chapter 22.
Organizational Roles and Project Server: The Day-to-Day User

At this point in the book, you have probably realized that the world of project management has moved beyond the traditional pencil-and-ruler war room and into the world of technology. Nowhere is this shift more evident than in the many ways that project managers can take advantage of the Internet to communicate with others, present information, and gather data.

If your organization has purchased Project Server and implemented a Project Server database, then you, as a team member, should read this chapter to find out how you can make use of Project Web Access — the browser-based interface that connects to the Project Server database — to view the tasks that you need to accomplish, update the schedule with work completed, and even enter new tasks that may arise.

In this chapter, you read about how the average team member can connect to the Web database, update task status, and report to the project manager. Project Web Access also interacts with Outlook, and in this chapter, you find out how to use those tools together.

The information in this chapter and in Chapters 20 and 22 applies to Project Professional. If you are using Project Standard, you can’t use Project Server and Project Web Access. You can, however, use the Internet to communicate with your workgroup via e-mail. Chapter 16 covers this feature in more detail.
Logging on to Project Web Access

To log on to Project Server by using Project Web Access (PWA), a resource needs to know the URL for the Web database; the project manager should notify the resource of the URL. To log on to Project Server, open Internet Explorer and, in the Address box, type the URL of the Web database.

Save the URL in your Favorites list, or if you use Project Web Access more than any other Web page, set it up as your home page so that Project Web Access appears when you open Internet Explorer. To set Project Web Access as your home page, type the address into the Address box. Then choose Tools ➤ Internet Options. On the first page, click the Use Current button in the Home Page section and click OK.

The window that appears next depends on the method that you use to log on to Project Server. If you aren’t using Windows user accounts, you see a Web page similar to the one shown in Figure 21-1.

![Figure 21-1: The opening page of Project Web Access for users who don’t use Windows user account logon information.](image-url)
If you’re using Windows user account logons, you don’t see the logon page; instead, you bypass this page and see your home page, which is discussed in the next section.

Type your name in the User name box. If you’re not using Windows user account logons, initially your password is blank, so you don’t need to enter anything in the Password box. Simply click Go.

If you set a password by using the techniques described in the section “Setting your password,” later in this chapter, you need to supply that password in the Password box during subsequent logons to Project Web Access.

**Reviewing the Home Page**

The Project Web Access Home page serves the same function as most home pages on the Web. It introduces you to Project Web Access; displays summary information, such as the number of new tasks that you have; and provides you with links to navigate to other areas of Project Web Access. Your Project Web Access Home page looks similar to the page shown in Figure 21-2. In the center of the page, you see notices of new events.

If you need to work away from the office (for example, if you use a notebook computer while traveling), you can keep track of the time that you work by working offline. Click the Go offline link in the Actions pane, as shown in Figure 21-2. When you reconnect in the office, you can upload information.

The tabs — Home, Tasks, Projects, Status Reports, Risks, Issues, Documents, Log Off, and Help — that are located across the top of Project Web Access remain visible at all times, and you can click them to move to different areas within Project Web Access. The Actions pane that runs down the left side of the screen contains links that enable you to view pages within a particular area. To navigate in Project Web Access, you click a link or a tab.

You can hide the Actions pane by clicking the small arrow at the upper-right corner of the pane.
Changing Your Password

When you begin to pass around plans for a project, you may run into security issues. For example, you may have resource rate information that you don’t want everyone to see, or perhaps you want messages that you receive on project status to be for your eyes only. You can protect the contents that are available for viewing in Microsoft Project Web Access by assigning a password to it.

If you aren’t using Windows user account logon information, your password box is initially blank. As long as your password box remains blank, Project Web Access prompts you to change your password each time you use Project Web Access. You see a dialog box similar to the one shown in Figure 21-3.
A word about passwords and security

The password is the basic method of protecting project data. However, setting a password does not guarantee safety. The procedures that you use to devise an effective password and keep it from being discovered are vital to project security.

For information on setting passwords for individual files in Project, see Chapter 2.

Whether they have criminal motives, such as industrial espionage, or just simple workplace curiosity, people may try to peek at your project information. The computer world has spawned a whole subculture of hackers who have made an art out of breaking into supposedly secure files.

Follow these guidelines when working with passwords:

✦ Don’t use an easy-to-guess password. A clever hacker can find out your spouse’s name, your middle name, your phone extension, and your date of birth in no time.

✦ Use the longest password that Project allows (up to 17 characters); the longer the password, the harder it is to crack.

✦ Don’t give your password to anyone. If you have to give it out (for example, if you are away from the office and someone else must access data to keep the project going), be sure to change your password as soon as you return.

✦ Create a password that is a random combination of letters and numbers. For example, T2J773N is a good password; MyFile isn’t.

✦ Change your password on a regular basis, even if you never give it to anyone. Hackers break passwords by using software that randomly generates and tries different options and combinations. Hackers may need a few sessions to break your code, but they can break your code. The more often you change your password, the more times someone else must start from scratch to break it.
Setting your password

When you haven’t set a password, Project Web Access prompts you to set one each time you log on, as was shown in Figure 21-3. If you click Yes, you see the page shown in Figure 21-4, where you enter a password and confirm it.

![Figure 21-4: After you set a password, you must enter it in the Password box to log on to Project Web Access.](image)

You can display this page at any time by clicking the Change password link on the left side of the Project Web Access Home page.

Tip

If you had no password, leave the Old Password box blank. Type your new password twice—first in the New Password box and then in the Confirm Password box. If you make a mistake, Project asks you to enter the password again. Click Change Password to save the password. The next time you log on to Project Web Access, you need to supply this password.

Note

You can change your password at any time by clicking the Change password link on the Actions list in the left pane of the Project Web Access Home page. If you previously assigned a password, type it in the Old password field.
Working with Your Tasks

If you previously worked with Project Central, you know about the Inbox. Project Server and Project Web Access don’t use an inbox like Project Central did; instead, work assignments go from Project Professional to team members via Project Web Access. If your organization chooses, the Project Server administrator can set up e-mail notifications so that Project Server generates e-mail notices and reminders of events, such as past due tasks. These e-mail notices and reminders appear in your regular e-mail client inbox.

Click the Tasks tab at the top of the Project Web Access page or click the Tasks link at the top of the Home page to view tasks, as shown in Figure 21-5. By default, you see all your tasks in the Gantt Chart view. (You can identify what you’re viewing by looking in the Actions pane to see which option has the small box next to it.) You can use the Timesheet view to record and report any work that you’ve performed, as shown in Figure 21-6.

Figure 21-5: The Gantt Chart view of the View my tasks page in Project Web Access.
In the Timesheet view, you can use the Current Tasks link in the Actions pane to filter out completed tasks and tasks that are far ahead in the future.

Above the timesheet, you see two tabs: View Options and Filter, Group, Search. To use these tabs, click the plus sign (+) at the left edge of the tabs and then click the appropriate tab. In Figure 21-7, you see the View Options tab of the Timesheet page. When you click the Filter, Group, Search tab, you see options that enable you to change the order in which tasks appear from the default (by project) to start date, work, or task name.

Depending on your permissions, you may see a third tab, the Delegation tab. From this tab, you can choose to show only delegated tasks, only your own tasks, or both; you also can delegate tasks from this tab.
Entering time on tasks

The Timesheet view is actually divided in half—notice two scroll bars that run across the bottom of the view, as shown in Figure 21-8. What you see in either half of the Timesheet view depends on the options that your manager or your organization chose for you to record updates. The Timesheet view works like a spreadsheet: You click in the cell that you want to update, and then you type. At the upper-right corner of the view, you see a set of dates with arrows pointing in either direction; click the arrows to display the time frame that you want to update. Then, click in the cell that represents the intersection of the period that you worked and the task on which you worked, type the appropriate number, and then click the Save Changes button at the top of the Project Web Access page.
Figure 21-8: Enter information on the left side of the Timesheet view; the updates appear on the right side of the view.

The numbers that you can enter depend on the settings that your project manager or your organization has selected. You may be able to fill in the % Work Complete and Remaining Work fields, the Total Actual Work and Remaining Work fields, or the Actual Work and Remaining Work fields.

The information that you save updates the Project Server database, but it doesn’t automatically update the manager’s information that is stored in the Project file. To let your manager know that you’ve completed some work, click the Update All button or the Update Selected Rows button. Project Web Access sends an e-mail message to your manager.

If necessary, you can add a note to a task by clicking the Insert Note link while the task is selected. Project Web Access displays a dialog box in which you can type. The note is included in updates to the project manager, and the text becomes read-only as soon as Project Server does an update. If you add more than one note to a task, Project Web Access appends notes so that the project manager isn’t deluged with notes.
Notice the following two links at the bottom of Figure 21-8: Print Grid and Export Grid to Excel. You can use these links to do exactly what they imply. When you click Print Grid, PWA displays the window that you see in Figure 21-9. Here you can choose columns to exclude when you print, and you can set column properties. You can click the Print Grid link, or you can choose File ➪ Print or File ➪ Print Preview. From the Worksheet list box, you can choose to view and print either your timesheet, shown in Figure 21-9, or the data that appears in the Timesheet view in PWA.

![Project Web Access](image)

**Figure 21-9:** Project Web Access enables you to print a nice-looking copy of your timesheet or the grid information that appears in the Timesheet view of Project Server.

When you click Export Grid to Excel, Excel opens and displays your timesheet on one tab of the workbook and the grid data on another tab (see Figure 21-10).
As a team member, you may realize that what you’re doing requires more work than the manager anticipated—and may even call for tasks that the manager didn’t assign to you. You can enter the tasks in Project Web Access and notify your manager about the additional work.

To create a new task, click the Create a new task link in the Actions pane. Project Web Access displays a page similar to the one shown in Figure 21-11.
Select the project to which you need to add the task from the Project drop-down list, and then select the task's level in the outline. In the Task information section, supply a task name, a comment about the task (optional), a start date, and the amount of work that you estimate the task will require. Click the Save New Tasks button, and Project Web Access adds the task to your time sheet, along with an icon in the Remarks column on your time sheet (see Figure 21-12).
Figure 21-12: After you create a new task, Project Web Access reminds you that you haven’t notified your manager about the task.

To notify your manager of the new task, click the Update All button or the Update Selected Rows button. Project Web Access sends the notice of the new task to the manager and changes the icon to reflect the task’s new status—that you’ve notified your manager but your manager hasn’t yet updated the project. Your manager has the option to add the task to the project or to reject the task.

**Project Web Access and Microsoft Outlook**

Do you use Outlook? Would you like to be able to get a better handle on *all* the things you need to do by viewing them all in one place? If your Project Server administrator has enabled Outlook integration, you can view Outlook tasks in PWA and you can update Outlook to include PWA tasks.

*Note*

If you want Project Web Access to display in Outlook, you need Outlook 2000 or a later version. If you want to transfer Outlook information to Project Web Access, you can use Outlook 98 or a later version.
Viewing Outlook information in PWA

To view Outlook information in PWA, log on to PWA and click the Tasks link. On the View my tasks page, click the View Options button and select the Show Outlook tasks check box. Then, click the Get from Outlook button. Project Web Access adds Outlook tasks at the bottom of the view, as shown in Figure 21-13.

![Figure 21-13: You can display Outlook tasks in Project Web Access.](image)

**Tip**
If you no longer want to see Outlook tasks, simply deselect the Show Outlook tasks check box on the View Options tab.

Integrating the Outlook calendar with PWA

Using Outlook 2003, you also can import assignments from PWA to your Outlook calendar. You can choose to import assignments automatically at regular intervals, or you can import them when you choose. And, you can work on tasks, record the information in Outlook, and then upload the information to PWA.

**New Feature**
Both importing assignments into the Outlook calendar and reporting on work performed via Outlook are new features in Project 2003.
You cannot exchange information between PWA and the Outlook Task List. You can only exchange information between PWA and the Outlook calendar.

If Outlook integration is set up, the appearance of Outlook changes. You notice a PWA toolbar in the main window, and on the Tools menu, you see a menu for Project Web Access. In Figure 21-14, I've moved the PWA toolbar so that you can see it; it typically appears anchored below the Standard toolbar.

Figure 21-14: When Outlook is integrated with PWA, you’ll notice changes in Outlook.

Using the link on the Project Web Access Home page, you can open Outlook (refer to Figure 21-2).

**Setting up integration**
To enable integration between PWA and Outlook, open PWA. Then, click the Work with Outlook to share calendar and task information link on the PWA Home page. You can also navigate to the View my tasks page and, in the Actions pane, click the View and report on your tasks from your Outlook calendar link. Clicking either link displays the Work with Outlook page, as shown in Figure 21-15. Click the Download Now button, and follow the directions that the wizard supplies.
Figure 21-15: Use this page to establish integration between Outlook and PWA.

You may need to edit your logon information in Outlook. Choose Tools ➤ Options. On the Project Web Access tab, click the Enter Login Information button to display the dialog box that you see in Figure 21-16. Supply the URL for your Project Server database, and select a connection method.

Figure 21-16: In this box, supply the information that is needed to log on to your Project Server database.
Importing PWA assignments into Outlook

When you have assignments in PWA and you click the Import New Assignments button on the PWA taskbar in Outlook, you see a window similar to the one shown in Figure 21-17.

Click OK to add your PWA assignments to your Outlook calendar. Once the import completes, the assignments appear on your calendar on the start date of the assignment, but not associated with a particular time (see Figure 21-18).

Updating PWA with Outlook information

When you work on a task that was imported from PWA, you record your work by double-clicking the task and then clicking the Project Web Access tab. Depending on the method of recording actuals that your organization has selected, you see a screen like the ones in Figure 21-19, Figure 21-20, or Figure 21-21.
Figure 21-18: PWA assignments appear in your Outlook calendar after you import them.

Figure 21-19: If your organization’s tracking mode is hours of work done per day or per week, the Project Web Access tab of an Outlook calendar appointment looks like this, and the time that you work on an assignment is saved directly in Project Web Access.
Figure 21-20: If your organization's tracking mode is percent of work completed, the tab of an Outlook calendar appointment looks like this, and the time that you work on an assignment is saved in Outlook but not in Project Web Access.

Figure 21-21: If your organization's tracking mode is Actual Work Done and Work Remaining, the tab of an Outlook calendar appointment looks like this, and the time that you work on an assignment is saved in Outlook but not in Project Web Access.
If you’re looking at a screen like the one shown in Figure 21-17, when you click the Save & Close button to save the information, the information that you recorded is automatically saved to Project Server.

Tip

You can open PWA and view your time sheet by clicking the Timesheet button.

If you’re looking at a screen like the ones shown in Figure 21-20 or 21-21, the information that you record is stored in Outlook, and you need to click the Update Now button to immediately transfer it to Project Server. If you prefer, you can click Save & Close and use the Update Project Web Access button on the PWA toolbar in Outlook. Either technique causes Outlook to display a dialog box like the one shown in Figure 21-22.

Figure 21-22: When you manually update PWA with information that is stored in Outlook, you see this dialog box.

Click OK to send the information that is stored in Outlook to PWA.

Setting integration options

You have some choices about the way that updating occurs. By default, you manually import all assignments from PWA to Outlook and all updates from your Outlook calendar to PWA. You can import for a specific time period, and you can set up the updating process to occur automatically.

If you prefer to import assignments for a specific time period, change your Assignment Import settings. In Outlook, choose Tools ➪ Options and then click the Project Web Access tab (see Figure 21-23). In the Date Range section, select the Next option button and specify the time frame.
Figure 21-23: On this tab, set the options for exchanging information between Outlook and PWA.

You can choose to import assignments from PWA to Outlook automatically based on a time frame. You can make similar choices about updating PWA with information that you record on your Outlook calendar. When you click the Advanced Options button, you can determine whether your updates from Outlook to PWA affect only your Timesheet view in PWA or also update your project manager. You also determine PWA's behavior for creating reminders.

**Notifying managers of workday changes**

Suppose that you were just selected for jury duty. And, of course, you're scheduled to work on a project at the same time. It happens—something comes up, and you are not available to work during the time that you had been scheduled to work. Or, you may now be available to work when you thought you wouldn't be available. For example, the case that you were hearing wrapped up earlier than expected and the jury was dismissed.

The behavior of the feature has changed between Project 2002 and Project 2003. The feature no longer makes calendar changes; instead, it changes a resource's availability. It is important to understand this distinction. When the resource submits this information, the manager of the administrative project receives the notification, but the manager of the administrative project may not manage all the
projects to which the resource is assigned, leaving an obvious communication gap. Therefore, using this feature requires the manager of the administrative project to double-check the projects to which the resource is assigned and then notify the managers of the affected projects of the change in the resource’s availability.

In Project 2003, your organization needs to create administrative projects that contain tasks for each type of nonworking time to which a user may need to assign himself. Once the administrative project is published, the tasks in it appear at the bottom of the user’s View my tasks page, with no work assigned.

When a user notifies a manager of a change in available working time, he is not creating a calendar change. Instead, he is sending a notification to his manager. If the resource is assigned to a project that is not managed by his manager, no notification is sent to the other manager. And, someone has to manage the administrative project.

You can use Project Web Access to notify your manager of changes to your workday from Project Web Access. Click the Notify your manager of time you will not be available for project work link in the Actions pane. Project Web Access displays the page that is shown in Figure 21-24. Next to the appropriate task, enter your anticipated unavailable time.

Figure 21-24: Notify your manager about a change in your work schedule.
When you click Submit at the bottom of the page, you see a message indicating that nonworking time was updated successfully. If you navigate back to the Timesheet view on the View my tasks page and, in the View Options section, select the Show scheduled work check box, you see your entry in the appropriate administrative task at the bottom of your time sheet.

Delegating a task

You’re overloaded with work, and you can’t possibly complete everything that you’ve been assigned. But—lucky for you—management just approved your request to hire an intern to help you. Now you need to delegate some tasks—and keep your project manager informed of the change in assignments.

You can delegate tasks only if you have the correct permissions in Project Server.

To delegate tasks, navigate to the View my tasks page and click the Delegation link to view the choices for delegation (see Figure 21-25).

![Figure 21-25: Select a task to delegate, and click the Delegate Task button.](image-url)
Select the tasks that you want to delegate, and click the Delegate Task button. A new page appears — and a wizard walks you through the delegation process, as shown in Figure 21-26. Scroll down and click Next after you fill in the information for Step 1.

**Figure 21-26:** Identify to whom you want to delegate the tasks and what role you want to continue to play.

If you select a summary task, Project Web Access delegates all subtasks.

In Step 2 of the wizard, send a message to the delegate and to your project manager to notify them of the action, as shown in Figure 21-27.

Click the Send button to complete the process; new tasks now appear in the Microsoft Project Web Access Task view of each affected recipient and the project manager. The person to whom you delegated can refuse the assignment by selecting the task and clicking the Reject button.
Figure 21-27: To complete the delegation process, notify everyone who is affected by the delegation.

Note that you may not be able to delegate certain tasks because of one or more of the following items:

- Your manager doesn't permit tasks to be delegated.
- Your manager has deleted the task.
- The task is a tracking copy of a delegated task or is a nonworking time entry.
- A resource created the task, or actual work has been performed and the manager's approval is still pending.

Working with Documents

Windows SharePoint Services gives you the ability to attach supporting documents to a project, a task, or a to-do list.

You also can create and track issues and risks that you can associate with projects, tasks, or to-do lists. And, if your Project Server administrator has given you rights, you can use the To-Do List feature in Project Web Access. For more information on both subjects, see Chapter 20.
Attach supporting documents to projects

You can link supporting documents to a project, a task, or a to-do list. This feature comes in handy when you have a budget justification or a feasibility study or some other supporting document that you want to be able to “grab” whenever the need arises.

You can post documents in the Shared Documents folder, which is a public, company-wide space that anyone in the organization can access, or you can store them in a project-specific space, where only those with access to the project plan also have access to the documents.

To use this feature, your administrator must install and set up Windows SharePoint Services.

To work with documents, click the Documents tab in Project Web Access. You see a page that’s similar to the one shown in Figure 21-28, which shows all the projects to which you have access and any documents that are available to view for those projects.

Figure 21-28: The projects to which you have access and for which you can view documents.
Viewing documents

To view the documents for a particular project, click the link for that project. You see a page that’s similar to the one shown in Figure 21-29. Notice that each project has a Shared Documents folder; the project can also have libraries of its own. Click the Shared Documents link to view any documents that are shared by the team. You see the contents of the Shared Documents library, as shown in Figure 21-30.

![Microsoft Project - Contoso AD Deployment screen](image1)

**Figure 21-29:** All projects have a Shared Documents library. You can also create special libraries for your project that are visible only to team members who have access to your project.

To view a document, click its link. You are prompted to save the file to your local drive or view it from its current location. After you make a choice, click OK, and you see the contents of the document.
Figure 21-30: The contents of the Shared Documents library.

**Posting a document**

You can add a document to a document library. From the main Documents page, which was shown in Figure 21-27, select the project for which you want to add a document. On the next screen, which was shown in Figure 21-28, select the library to which you want to upload a document. You can now create a new document by clicking the New Document button or by clicking the Upload Document button (as I did) to upload a document from your hard drive or the network server to one of your project’s document libraries. When you upload, you see a screen like the one shown in Figure 21-31.
Figure 21-31: Locate the file that you want to upload.

After you locate the file that you want to upload, you can link the file to a particular task, an issue, or a risk by clicking the appropriate link toward the bottom of the page. For example, if you click the Select project tasks that are related to this document link, you see a box that is similar to the one shown in Figure 21-32. If you click the other links, you see similar boxes.

Figure 21-32: Use this box to link a document to a task.
When you click Save and Close on the Update Document page, PWA redisplay the Shared Documents page with your new document displayed (see Figure 21-33).

![Image: The Shared Documents page after uploading a document.](image)

**Figure 21-33:** The Shared Documents page after uploading a document.

### Creating a document library

You can create libraries specifically for your project. Any documents that you place in those libraries are visible only to team members who have access to your project.

From the main Documents page, which was shown in Figure 21-27, select the project for which you want to add a document. On the next screen, which was shown in Figure 21-28, click the Create Document Library link. You see a screen like the one that is shown in Figure 21-34.

Supply a name for the library, and then enter a description for the library. After you finish, click the Create button. Your new library now appears on the Shared Documents page, which was shown in Figure 21-33.
Viewing Information

As life would have it, you may not work on only one project at a time. To help you manage your time, the Project Center in Project Web Access enables you to view tasks from more than one project at a time. In the Project Center, you can see individual projects, or you may see Project Center views, which are collections of projects. The administrator creates Project Center views and then identifies the team members who can view each Project Center view.

You must have appropriate permissions from the Project Server administrator to view projects in the Project Center.

In Chapter 19, you see how the administrator creates a Project Center view.
When you click the Projects tab in Project Web Access to view the Project Center, you see line-item entries that represent Web-based projects, as shown in Figure 21-35. Typically, you see entries for projects for which you have work assigned, but what you see depends on your security setting. On each line, you see a Gantt bar that shows you the duration of the project and progress that’s been made on the project so far.

![Project Web Access](image)

**Figure 21-35:** In the Project Center, you see one-line entries representing projects that are stored in the Project Server database.

You can organize the projects by using the list boxes that appear on the Filter, Group, Search tab, as shown in Figure 21-36, and you can open a particular project in Project Web Access by clicking the link that appears in the Project Name column.
When you open a project, you choose a view using the Choose a view list box at the top of the page; in Figure 21-37, you see the Tasks Tracking view. Again, you can organize the tasks in the project, or you can zoom in or out or go to a particular task.

You can also view your assignments from the Resource Center, as shown in Figure 21-38. Click the Resources tab, and then click the View resource assignments link in the Actions pane. From the Enterprise Resource Pool, select the resource whose assignments you want to view. You can see assignments for the resources that you have permission to view.
Figure 21-37: When you open a project, you can choose the view of that project that you want to see.

Figure 21-38: Viewing your assignments.
Reporting Status

Project Web Access provides you with status reports that you can send to your project manager.

Don’t forget: You can create an issue if you’ve run into something unexpected that you want to report; other team members, as well as your project manager, can see and comment on the issue.

You’ve already seen how Project Web Access enables you to send updates from the View my tasks page. But you can also send both solicited and unsolicited status reports to your project manager. Click the Status Reports tab, and click the Submit a status report link in the Actions pane. If your project manager has not requested a status report, you see a page like the one that’s shown in Figure 21-39. If your project manager has set up status reports that are due on certain dates, you see a notice on your home page like the one that’s shown in Figure 21-40.

Figure 21-39: Use this page to submit an unsolicited status report or to simply communicate with other members of your team.
Figure 21-40: Use the Status Reports section of your home page to display the status report layout as requested by your project manager.

You may only be able to send solicited status reports, depending on your security settings.

You can click the link on your home page to open the status report, or you can go to the Status Reports page, where you see a link to the status report that your manager has requested. When you click either link, you see a page that is similar to the one shown in Figure 21-41. The page that you see depends on the status report that your manager sets up. Fill in the report. If you need to include information that doesn’t fit in any of the existing sections, you can add a section at the bottom of the report. When you’re ready to submit the report, click the Send button at the bottom of the page.
Logging Off

When you finish working in Project Web Access, click the Log Off button in the upper-right corner of the PWA page to complete your session. You don’t need to worry about saving before logging off; Project Server saves every action that you take while logged on.

Summary

In this chapter, you read about how the day-to-day user interacts with Project Server using Project Web Access. The user can view and update tasks, provide status reports, and create documents, issues, and risks that are associated with tasks or projects. The user can interface Outlook with Project Web Access and exchange information seamlessly between the two programs. If the appropriate features are enabled, the user can create a personal to-do list and view documents that are pertinent to projects.

In Chapter 22, you see how executives use Project Web Access.
Organizational Roles and Project Server: The Executive

Executives use Project Web Access to evaluate the portfolio of work that is happening across the organization. They make use of the Project and Resource Centers to gain high-level views of the work and drill down to get details. Using analysis and modeling tools, executives can identify trends in schedule, resource, and cost information and proactively address problem areas. In this chapter, you review the areas of Project Web Access that are of interest to an executive.

Reviewing Your Portfolio

When you click the Projects link at the top of the Project Web Access (PWA) page, you see the Project Center, as shown in Figure 22-1. This opening view provides a high-level picture of all the projects that you have security permissions to view.

You can use the To-Do List feature in Project Web Access to keep track of things that may turn into projects in the future. If you use the To-Do List feature, the items in the list can be converted into a project in Project Professional. For more information on the To-Do List in PWA, see Chapter 20.
Figure 22-1: In the Project Center, you see projects for which you have security permissions to view.

Your organization can create custom views for the Project Center, each providing you with different kinds of detail. Use the Choose a view list box to see the views that are available to you (see Figure 22-2).

In the sample database for A. Datum Corporation, the A. Datum Executive Summary view has been customized to include color indicators that help a viewer determine, at a glance, projects that pose potential problems (don’t you love that alliteration?). As you move the cursor over an indicator, you see a tip that describes the meaning of that indicator (see Figure 22-3).

You can drill down in any project and use additional views to see different kinds of detail. In Figure 22-4, I drilled down in the 100X DVD Drive project in the sample database because the project is running behind schedule, and I want to try to determine why. After the project appeared on-screen, I selected the A. Datum Project Detail view. Other views in the Choose a view list box provide different kinds of detail for the selected project.
Figure 22-2: Use this list box to select different views of your portfolio of projects.

Figure 22-3: Your organization can use indicators in customized views to help draw your attention.
After viewing the project, I scrolled down to find the Assess manufacturing capabilities task, the first task with a red indicator in the Schedule Indicator column, because that would be the first task that is behind schedule. To try to determine why the task is behind schedule, I use the Portfolio Analyzer in the next section.

Identifying Trends and Potential Problems

To use the analysis and modeling tools that are described in this chapter, the Project Server administrator must build an OLAP (Online Analysis Processing) cube. Periodically, the cube must be rebuilt to keep the information that is being analyzed and modeled up to date. If you get an error message when trying to use the Portfolio Analyzer or you suspect that the information that you're seeing is out of date, contact your Project Server administrator.

Chapter 19 describes how to build the OLAP cube and give rights to use it.
The Portfolio Analyzer helps executives analyze project data to identify trends and potential problem areas.

Click the Analyze projects in Portfolio Analyzer link in the Actions pane. PWA displays a chart and PivotTable, with the PivotTable appearing below the chart. In Figure 22-5, I clicked the Chart link to display only the chart, and in Figure 22-6, I clicked the PivotTable link to display only the PivotTable.

![Portfolio Analyzer](image)

**Figure 22-5:** The chart data.

**Tip**

You can save the chart, the PivotTable, or both as a .gif file.
Figure 22-6: The PivotTable data on which the chart is based.

Again, use the Choose a view list box to look at the information in various ways and help identify the problem. I displayed the Manufacturing resource workload by skill view and then clicked the arrow in the Projects box to display information for only the published version of the 100X DVD Drive project. When I chose to view only the chart (see Figure 22-7), I could see that Bradley Beck is working more time than he is available for. On-screen, the bar for work is blue, and this bar appears to the left of the bar for availability, which is red.
Bradley Beck’s work exceeds his availability.

The chart appeared a bit messy to me, so I redisplayed both the chart and the PivotTable and examined the PivotTable, shown in Figure 22-8, more closely.
When I clicked the minus signs next to Management and Operations, I eliminated the detailed information for the individual resources in these categories, and information in the chart became even more useful (see Figure 22-9).

If you identify a potential problem, you can draw attention to it using the collaboration tools that are provided by Windows SharePoint Services (WSS). You can create and monitor an issue or a risk. You also can respond to issues and risks. And, you can attach documents to projects, tasks, or to-do lists.

See Chapter 20 for more information on issues and risks. See Chapter 21 for more information on document sharing.
Answering the Famous “What If” Question

To use the analysis and modeling tools that are described in this chapter, the Project Server administrator must build an OLAP (Online Analysis Processing) cube. Periodically, the cube must be rebuilt to keep the information that is being analyzed and modeled up to date. If you suspect that the information that you’re seeing is out of date, contact your Project Server administrator.

Chapter 19 describes how to build the OLAP cube.

Project Web Access contains another tool that can help you when making resource allocation decisions: the Portfolio Modeler. By using the Portfolio Modeler, you can select projects to include in the model and then interactively change tasks or staffing to view the impact on a project portfolio. Essentially, you can ask, “If I make these changes, what will be the impact?”
Suppose, for example, that you are an executive, portfolio manager, or resource manager who is considering a list of potential projects. You would like to find out if it is possible to do these projects with the resources that you have.

You can find the Portfolio Modeler tool in the Project Center. Click Projects at the top of PWA. Then, from the Actions pane, click the Model projects with Portfolio Modeler link.

You start by creating a model from the Model projects with Portfolio Modeler page. Click the New link, and PWA displays the page that you see in Figure 22-10. At the top of the page, you name and describe the model. In the middle of the page, you select the projects that you want to include in the model. At the bottom of the page, shown in Figure 22-11, you identify the resources that you want to use to staff the projects that you include in the model.

Figure 22-10: Name the model, and identify the projects to consider in the model.
Figure 22-11: Identify the resources that you want to use to staff the projects that are in the model.

When you click Next at the bottom of the page, you see the page that’s shown in Figure 22-12, where you identify any projects that share resources with the projects in the model or that are related to projects in the model through an external dependency.
Figure 22-12: Identify projects that are related to the ones that you are including in the model.

Click Next at the bottom of the page to view the page that’s shown in Figure 22-13, where you indicate scheduling options for your model.
Choose scheduling options for the model.

When you click Next, PWA saves your model and redisplays the list of available models that you saw when you first clicked the Model projects with Portfolio Modeler link in the Actions pane (see Figure 22-14).
After you’ve created a model, you can open it to view the details of the model. At the top of the page, you see a Gantt Chart that displays summary statistics for each project that is included in the model (see Figure 22-15). The colors of the bars represent the overallocated status of the project’s resources during the specified time frame, as follows:

- **Green** means that no resources are overallocated.
- **Yellow** means that less than 10% of the resources are overallocated.
- **Red** means that more than 10% of the resources are overallocated.

**Tip**
You can add projects to the model by selecting a model and clicking the Modify link.
Figure 22-15: View a summary Gantt Chart for each project in the model.

At the bottom of the page, you can view a resource allocation graph for each resource that is included in the model (see Figure 22-16).

**Tip**

You can see a resource allocation chart for a combination of resources by holding down Ctrl while you click each resource that you want to include in the chart. Then, click the Refresh button.

To change the parameters for the model, click the Toolbox link to display the dialog box that is shown in Figure 22-17 and make your changes.
Figure 22-16: View a resource allocation chart for any resource that is included in the modeled projects.

Figure 22-17: You can easily modify the scheduling parameters of the model.
While you are using a model, no one else can use it; it becomes locked. You can unlock the model from the Model projects with Portfolio Modeler page (refer to Figure 22-14). Select the model, and click the Unlock button. In this figure, the second model is locked by Jo Brown.

And now, the moment you’ve been waiting for . . . (drum roll, please). On the Model projects with Portfolio Modeler page, select the model to use and click the Analyze button. PWA produces a combined text and graphics report that describes the resource allocation in the model and makes staffing recommendations. At the top of the report (see Figure 22-18), you find summary statistics that describe both the shortest schedule and the modeled schedule. The shortest schedule assumes an unlimited number of resources.

Figure 22-18: The top portion of the report provides summary statistics for the shortest schedule and the modeled schedule.
In the middle of the page, you see a chart with three data series on it, comparing time to work for each data series (see Figure 22-19). Essentially, the chart tells you how efficiently the modeled project uses resources, as follows:

✦ The Demand data series shows you how much work is required to complete all projects in the model without considering resource availability.

✦ The Capacity data series shows you how much work resources can do while working on the modeled project without considering current assignments of the resources.

✦ The Utilization data series shows you the work that needs to be done when current resource schedules are considered during modeling.

![Demand/Capacity/Utilization Chart](image)

Figure 22-19: The chart compares work over time for three data series.

Your resources are underutilized when the Utilization data series is greater than the Demand data series. And, you’re looking at a resource-deficit situation when the Utilization data series is greater than the Capacity data series.
At the bottom of the page, you can review the scheduling options for all projects in the model (see Figure 22-20).

![Figure 22-20: The report includes a summary of the scheduling options for each project in the model.](image)

**Tip**

You can compare one model with another model. Open the first model that you want to include in the comparison, and then click the Compare button. You see a page where you can choose models to compare with the selected model.

At the present time, there is no way to take information that is generated in a model and apply it to a project. You must manually reconstruct the information in Project Professional.

And, although you can save the models, you can’t automatically transfer changes that you make in models to actual projects.
Summary

In this chapter, you’ve seen how executives can use Project Web Access to evaluate the portfolio of work that is happening across the organization. They can use the Project Center to view work at a high level and drill down to get details. Using the Portfolio Analyzer, executives can identify trends in schedule, resource, and cost information and proactively address problem areas. Using the Portfolio Modeler, executives can evaluate resource utilization and determine whether the organization has enough resources available to take on a particular project.
Advanced Microsoft Project

In This Part

Chapter 23  
Customizing Microsoft Project

Chapter 24  
Using Macros to Speed Your Work

Chapter 25  
Customizing Microsoft Project Using VBA and Active Scripting

Chapter 26  
Importing and Exporting Project Information

Chapter 27  
Project Case Studies
Customizing Microsoft Project

You can customize the Project working environment in several ways. For example, you can use custom fields to store and manipulate custom data in a project file. And you can change the way that various elements appear on-screen and how you use Project’s tools and commands. Suppose that you use a particular command for sharing resources all the time—you can perform that action quickly if you could access the command from a tool on the standard toolbar. Or, maybe you never use the Task Note tool and prefer to get it off the toolbar and place its command on a menu. Perhaps none of Project’s built-in views or tables contains quite the combination of information that you use most often.

Microsoft Project enables you to customize most of its elements. This chapter shows you how to create and use custom fields, make changes to the behavior of the Project interface, and create and modify toolbars and menus to make Project work the way that’s best for you.

This chapter focuses on customizing Project. See Chapter 19 for information about customizing Project Server.

Using Custom Fields

In Chapter 7, you read about outline codes, which are custom fields in Project. In previous versions of Project, you’ve had the ability to store custom data in a project file. However, you haven’t been able to manipulate that data. Starting in Project 2000, custom fields enable you to create pick lists to use to ensure accurate data entry, create formulas to perform calculations on custom data, and insert icons that indicate graphically that a field contains custom data.
Consider customizing fields to help create standardization within your organization. If all projects in your organization use the same standards, you avoid problems when projects are merged, consolidated, or moved into Project Server.

Customizing data entry

Suppose that your boss wants your best guess about whether you’ll keep to the schedule on a task-by-task basis. You can set up a custom field and provide the information on any sheet view of Project. I’ll show you this process in two phases. In the first phase, I create the custom field and, in the second phase, I show you how to use it.

To create a custom field, follow these steps:

1. Choose Tools ➪ Customize ➪ Fields. Project displays the Customize Fields dialog box, as shown in Figure 23-1.

   ![Figure 23-1: Select a custom field type.](image)

2. Select either Task or Resource. Then, open the Type list box and choose the type of field that you want to customize. The type that you choose determines the values that you can include in the pick list. Choose Text to include only alphanumeric characters in the pick list. If you choose Date, Start, or Finish, you must include date-formatted numbers in the pick list. If you choose Number or Cost, you can include only numbers in the pick list. If you choose...
Flag, you can include only Yes or No in the Value List dialog box. For this example, I chose Text because I want to set up a value list that contains Yes, No, and Maybe.

3. To provide a meaningful name for the code, click the Rename button and type the new name. You can't use any name that Project is already using. In this example, I named the field Best Guess. Then, click OK to redisplay the Customize Fields dialog box.

4. Click the Value List button to display the value list for Field Name dialog box, as shown in Figure 23-2.

![Figure 23-2: Use this dialog box to define the values that you want Project to display in the pick list during data entry.](image)

5. In the Value column, type the first value that you want to appear in the list. The values that Project lets you include in the value list depend on the field type that you chose in Step 2. If you chose Text, you can include only combinations of letters and numbers. If you chose Date, Start, or Finish, you must include date-formatted entries. If you chose Number or Cost, you can include only numbers in the value list. If you chose Flag, you can include only Yes or No in the value list.

   If you chose Flag, you need to substitute Yes or No for standard flag choices, such as True and False or On and Off.

6. (Optional) In the Description column, provide a description of the value.
7. Repeat Steps 5 and 6 for each list value that you want to define.

8. You can set a default value to appear as the entry for the field by selecting the Use a value from the list as the default entry for the field check box. If you choose this option, highlight a value in the list and click the Set Default button to select the value as the default.

9. In the Data Entry options panel of the dialog box, you can restrict data entry so that the user can enter only values in the value list, or you can permit the user to enter values other than those in the list and add those values to the value list.

When should you restrict entries to the list and when should you allow any value? Consider what you plan to do with the information the user enters. I suggest that you restrict list entries when you intend to use the entered information for grouping or integrating with other systems, where exact matches are important. Keep in mind that the intent of list values is to speed up data entry as well as make it more accurate.

10. You can specify the order for the value list in the last section of the dialog box.

11. Click OK to save the value list and redisplay the Customize Fields dialog box.

If you select the Restrict field to items in the value list option button as I did, Project displays a message explaining that only the values that you created will be accepted during data entry.

12. Click OK again to redisplay your project.

Steps 1 through 12 comprise Phase 1. In Phase 2, you use the custom field that you defined. To use the custom field, you need to display it as a column in a sheet view. If you defined a task field, you can use any task sheet view; if you defined a resource field, use any resource sheet view.

To display the custom field in a column on a sheet view, right-click the title of the column that you want to appear to the right of the custom field. Project selects the column and displays a shortcut menu from which you can choose Insert Column. In the Column Definition dialog box, as shown in Figure 23-3, open the Field Name list box and select the custom field that you defined, using the name that you supplied when you defined the field. Optionally, change the rest of the information in the dialog box and click OK. The custom field appears on-screen.

When you click in the field, a list box arrow appears. When you open the list box, the value list that you established appears, as shown in Figure 23-4. Select values from the list, or simply type them. In my example, if you try to enter a value that doesn’t exist in the list, Project displays an error message instructing you to use a value from the list.
You can’t use custom fields to create value lists for regular Project fields. For example, suppose that you’ve decided that you don’t want to use all 1,000 of Project’s priorities. In fact, you want your people to use only five possible priorities: 100, 200, 300, 400, and 500 (100 being the lowest priority and 500 being the highest priority). You can create a Number custom field (called Priority Lvl, for example) that only allows the entry of these five values in a sheet view. However, users can open the Task Information dialog box and assign any priority value in the Priority field — and Project permits the assignment. The custom field Priority Lvl is not substituting for the actual field Priority, and users can circumvent the custom value list.
Using formulas in custom fields

Suppose that your manager tells you that part of your evaluation in project management depends on the accuracy of your cost estimates. Under these circumstances, you may want to monitor the tasks for which actual cost exceeds baseline cost. You can set up a custom field to help you easily identify those tasks. Follow these steps to do so:

1. Choose Tools  Customize  Fields. Project displays the Customize Fields dialog box, shown previously in Figure 23-1.

2. Select either Task or Resource, and then open the Type list box and choose the type of field that you want to customize. For this example, I’ll choose Task and Cost because I want to compare task cost values.

   Tip

   The type of field that you select from the Type list matters in a different way when you’re creating a formula instead of a value list. If you select the wrong type when creating a value list, you can’t set up the appropriate values for the list. However, if you select a type that doesn’t match what you’re trying to calculate in a formula, Project lets you create the formula but displays ERROR in the custom field column on the sheet. For example, suppose that you want to calculate a cost and you select Date from the Type list. Project still permits you to create the formula, but because the formula doesn’t make sense, you see the message ERROR when you display the custom field column.

3. To provide a meaningful name for the code, click the Rename button and type the new name. You can’t use any name that Project is already using; in the example, I named the field Difference. Then, click OK to redisplay the Customize Fields dialog box.

4. Click the Formula button to display the Formula for dialog box. Figure 23-5 shows the formula that I set up for this example.

![Formula for Difference](image)

**Figure 23-5:** This dialog box lets you define the values that you want Project to display in the pick list during data entry.
5. Create a formula in the text box by selecting fields or functions. To select a field, click the Field button; Project displays a list of field categories. Select the appropriate field category, and Project displays a list of the available fields, as shown in Figure 23-6. To select a function, follow the same process by clicking the Function button.

![Figure 23-6: Select a field or a function to include in the formula.](image)

In Appendix C, you find three tables. Table C-1 contains a list of all available Task fields, and Table C-2 contains the same information for Resource fields. Table C-3 lists the functions that you can include in a formula as well as a description of each function’s purpose.

6. To make a calculation, use the operators that appear above the Field and Function buttons.

Tip If you’ve created this formula in another project, you can import the formula from the Global template (assuming that you saved the formula in the Global template), or you can open the project that contains the formula before you create the formula in the new project. When you click the Import Formula button, Project displays a list of available templates or open Project files. Select the appropriate location, field type, and field name. Then click OK.
7. In the Formula for dialog box, click OK. Project warns you that it will discard any information that was previously stored in the custom field and replace the information with the calculated values based on the formula.

8. In the Customize Fields box, click OK to save the formula and redisplay the Customize Fields dialog box.

9. (Optional) Assign the formula to summary rows.

If you click OK at this point, Project calculates a value for the formula. You can see the value if you display the column for the custom field, as shown in Figure 23-7. Based on the formula that I created, positive values represent tasks where Actual Cost exceeded Baseline Cost — and technically, my Difference column is nothing more than the Variance column of the Cost table.

Figure 23-7: When you display the column for the Difference custom field, you see the result of the formula.
Suppose that you don’t want to eyeball figures to find the problem tasks. You can
insert icons to represent positive and negative values (and make the job of identify-
ing the problem tasks much easier) by following these steps:

1. In the Custom Fields dialog box, highlight the custom field that you created
and click the Graphical Indicators button, as shown in Figure 23-8.

2. Choose the type of row to which you want to assign an indicator:
Nonsummary, Summary, or Project summary.

3. In the Test for section, set up the test that Project should use. In each column,
you can choose from lists. In the Value(s) column, you can compare the formula
result to the value of another field or to a numeric value, as shown in Figure
23-9. In my example, if the result of the formula is greater than 0, I want to see
a red flag, because the actual cost of the task exceeds the baseline cost. If,
however, the actual cost is less than or equal to the baseline cost, things are
fine, so I want to see a happy face (you can find other indicator choices in the
Image list).
If you’ve set up graphical indicators in another project, you can import the criteria from either the Global template (assuming that you saved the formula in the Global template) or from another open project. When you click the Import Indicator Criteria button, Project displays a list of available templates or open Project files. Select the appropriate location, field type, and field name. Then click OK.

**Figure 23-9:** Set up the test that Project should perform on the formula’s result and the indicator to display, based on the test results.

4. To see the mathematical results of the formula in a ToolTip when you point the mouse at the indicator, select the Show data values in ToolTips check box.

5. Click OK to redisplay the Customize Fields dialog box.

6. Click OK again to redisplay your project.

If necessary, display the column for the custom field. Right-click the column that you want to appear to the right of the custom field, and choose Insert Column. Then, select the custom field. When Project displays the column, it will contain an indicator, as shown in Figure 23-10. If you selected the Show data values in ToolTips check box, you can point the mouse at an indicator to see the results of the formula. (The ToolTip hides the icon on-screen; otherwise, I would show you the ToolTip.)
Customizing the Interface

In addition to using custom fields to customize data entry and make calculations, you can customize Project’s interface. For example, you can control the number of icons that appear in the Windows taskbar when you open multiple projects. Use Project’s Organizer to move tables and views among project files. And, you can modify toolbars and customize menus to make them work the way that you work.

Windows taskbar icons

In Project 98 and earlier versions of Project, you saw only one icon on the Windows taskbar while Project was open — regardless of the number of Project files that you opened. Starting in Project 2000, by default, you see an icon on the Windows taskbar for every open Project file, as shown in Figure 23-11.
Figure 23-11: By default, you see multiple icons for Project on the Windows taskbar when you open multiple projects.

Although you can’t necessarily identify the file from the icon on the Windows taskbar, you can see a few letters of the filename on the icon. In addition, if you point the mouse at the icon, you see a ToolTip that shows the entire path and filename.

Suppose that you belong to the school of users who don’t want an icon on the Windows taskbar for each open file—you believe that makes working harder, not easier. You can reinstate the behavior of Project 98 and earlier versions by deselecting the Windows in Taskbar check box on the View tab of the Options dialog box, as shown in Figure 23-12.
Figure 23-12: To reintroduce the behavior of Project 98 and earlier versions, deselect the Windows in Taskbar check box.

Regardless of the behavior that you choose, all open Project files appear at the bottom of the Window menu. You can switch among Project files by using the Windows menu in Project or the Windows taskbar.

**Saving Project files**

Using the Save tab of the Options dialog box, as shown in Figure 23-13, you can set the following defaults:

- By opening the Save Microsoft Office Project list box, you can specify the default file format for each new Project file that you save. For example, you can save all Project 2003 files in Project 98 format if you regularly share files with someone who uses Project 98.

If you save files that were created in Project 2003 in the format of Project 98 or earlier, you may lose information. For example, WBS and outline codes don't exist in any version of Project prior to Project 2000. If you use WBS and outline codes in a file and then save the file in Project 98 format, you'll lose these codes.
Figure 23-13: Project has several features that are associated with saving files.

Because Project 2003, Project 2002, and Project 2000 share the same file format, you can’t (and don’t need to) select Project 2000 as a file format in the Save Microsoft Office Project list box.

✦ You can set a default file location to save all files, user templates, and workgroup templates. By setting this location, you don’t need to navigate to the correct folder each time that you want to save a new file.

✦ Use the Auto Save feature to save project files on a regular basis. The Auto Save feature is particularly valuable to people who tend to work extensively, forget to save regularly, and become victims of power failures or server crashes. If you use Auto Save, you can open your file as of the last automatic save.

✦ You can choose to expand timephased data in a database; this setting only applies when you save Project data to a database such as SQL or Access. If you check this box, your SQL programmer will be able to create a report directly from the database (without going through Project) that analyzes timephased data. If you deselect this box (the default), Project stores timephased data in binary format, which you can’t read (unless you’re a computer guru or a VB programmer), but using binary format for this data speeds Project’s reading and writing to the database.
Using the Organizer

Project uses the Organizer to help you share views, tables, forms, reports, and more among projects. To display the Organizer box shown in Figure 23-14, choose Tools ➪ Organizer. You also can open the Organizer box from the More Views box shown in Figure 23-15.

![Organizer]

**Figure 23-14:** All views in the Global template (Global.mpt) file are available to every file that is based on the Global.mpt file.

![More Views]

**Figure 23-15:** You can display the Organizer by clicking the Organizer button in the More Views dialog box.
Use the various tabs in the Organizer dialog box to copy elements from the Global template (Global.mpt) to the current project. You also can copy elements from the current project to the Global template or simply between projects. First, open the Project file that contains the information you want to copy and the Project file into which you want to copy the information. Then, in the Organizer box, use the list boxes at the bottom of each tab to select the file containing the information and the file that should receive the information.

When you copy an element to the Global template, that element becomes available to all files that were created with your copy of Project.

**Making changes to toolbars**

Toolbars are to Windows software what remote controls are to television: effortless, hi-tech ways to take action. Toolbars are easy to use and always right at hand. However, you and Microsoft may not agree on which tools you use most often.

You can easily modify the arrangement of tools in Project. You can add or remove tools from a toolbar, change the function of a tool, create your own set of tools, or even edit the look of tools.

You can make changes to your Project environment effective for your copy of Project alone, for those in a group, or across your company. Project saves your changes to the Global.mpt file and opens new projects based on this Global template file by default; consequently, your changes remain intact.

**Combining or separating toolbars**

Throughout this book, you’ve seen the Standard toolbar on a separate row from the Formatting toolbar—much like they appeared in Project 98 and earlier versions. If screen real estate is vital to you, consider placing the toolbars on the same row, as shown in Figure 23-16. When you use this feature, Project initially displays the tools that Microsoft thinks users use most often. If you need a tool that you don’t see, click the Toolbar Options button to display a hidden palette of additional available buttons, as shown in Figure 23-17. After you select a tool from the hidden palette, that tool appears on the toolbar, replacing the least-used tool, if necessary. As you work, the toolbars become personalized to your work habits, displaying the tools that you use most often.
Figure 23-16: You can make the Standard and Formatting toolbars share a row on-screen.

Figure 23-17: You can select a button that you don’t see initially by opening the hidden palette.
Starting in Project 2000, the Standard and Formatting toolbars can share the same row on-screen, increasing the screen real estate that’s available for your project information. Also, menus can show only the most recently used commands.

In a similar fashion, you can personalize the menus in Project to display the commands that you use most frequently. When you enable this behavior and open a menu, you see a limited set of commands. At the bottom of the menu, you see the expand arrows pointing down, as shown in Figure 23-18. When you click the expand arrows, the rest of the commands on the menu appear. The gray bar that runs down the left side of the menu is lighter for hidden commands than for the more frequently used commands, as shown in Figure 23-19. Like the tools that are on the toolbars, if you select a hidden command, it becomes a frequently used command and appears on the abbreviated menu the next time that you open the menu.

Figure 23-18: Initially, only some commands appear on the menu.
You control this toolbar and menu behavior by using the first three check boxes on the Options tab of the Customize dialog box, as shown in Figure 23-20.
By checking the Show full menus after a short delay check box, you tell Project to automatically show all commands on the menu after a short delay so that you don't have to click the Expand arrows.

**Adding and deleting tools from a toolbar**

Although toolbars include many commonly used functions, they aren’t all-inclusive. For example, the Formatting toolbar includes commands to change the font and font size; apply bold, italic, and underline effects; and align tasks. But it doesn’t include tools for modifying the timescale, gridlines, or bar styles. If you use those features often, you may want to add them to the Formatting toolbar. Alternatively, you may prefer to have a tool that appears on one toolbar by default appear on the Standard toolbar instead.

To add tools to any toolbar, locate the tool in the appropriate category and then drag it onto the toolbar where you want it to appear. Follow these steps to add a tool to a toolbar:

1. Choose View ➪ Toolbars ➪ Customize to open the Customize dialog box, as shown in Figure 23-21, and click the Toolbars tab.

![Customize dialog box](image)

**Figure 23-21:** The toolbars that have a check mark here are currently displayed on-screen.

2. Select the check box for the toolbar on which you want to place the tool so that Project displays that toolbar. For example, if you want to add the Paste as Hyperlink button to the Web toolbar, make sure that the Web toolbar is displayed.

3. Click the Commands tab, as shown in Figure 23-22.
4. Click the category of command that contains the tool that you want to add to a toolbar. For example, the Paste as Hyperlink tool appears in the Edit category because that category is where cutting, copying, and pasting tools typically reside.

If you don’t know the category to which a tool command belongs, use the scroll bar in the Categories list and select All Commands at the bottom of the list. The Commands list displays every available command in alphabetical order.

5. Click the item in the Commands list, drag it from the dialog box onto your screen, and place it on the toolbar of your choice.

You also can easily remove a tool from a toolbar. With the Customize dialog box open, display the toolbar that contains the tool that you want to remove and drag the tool off the toolbar.

To restore a toolbar’s original settings, open the Customize dialog box, select the Toolbars tab, click the toolbar name in the list of toolbars, and click Reset. Project restores the default tools.

Creating custom toolbars
Rather than modifying some of Project’s toolbars, you may prefer to create a custom toolbar that contains all the tools that you use most often. You create custom toolbars from the Customize dialog box by following these steps:

1. Display the Toolbars tab of the Customize dialog box.
2. Click the New button. The New Toolbar dialog box appears, as shown in Figure 23-23.
3. Type a toolbar name and click OK. A small toolbar, devoid of tools at the moment, appears. You can drag this floating toolbar to any location on the screen that’s convenient for you.

4. Click the Commands tab.

5. Click tools in any category, and drag them onto the new toolbar. Figure 23-24 shows the new toolbar that I created.

6. You can add dividers (thin gray lines) to separate groups of tools on your new toolbar. Select the tool that you want to place to the right of the divider, and click the Modify Selection button on the Commands tab. The menu shown in Figure 23-25 appears.

Figure 23-23: Name your toolbar anything you like—perhaps after your spouse, your pet, or your favorite movie star.

Figure 23-24: Place tools in any order that you like. To move a tool, drag it to its new position on the toolbar.

Figure 23-25: This menu offers options to work with button images as well as options to modify other toolbar features.
7. Select the Begin a Group command from this menu to insert a divider in your toolbar, as shown in Figure 23-26.

![Figure 23-26: Place a divider on a toolbar to make logical groupings of tools that perform certain types of functions.](Divider)

To delete a divider, select the tool to the divider's right and, using the Modify Selection pop-up menu, select Begin a Group again to deselect that command.

**Changing and editing button images**

Don’t like the little pictures that Microsoft assigned to its tools? Feeling creative? Project enables you to select from a whole set of other button designs, from smiling faces to musical notes, or to edit a button image with picture and color tools.

If anyone else uses your copy of Project, be cautious about changing tool images. Someone who is accustomed to Project’s standard tool images may press a button and, unaware of its true function, do damage, or simply not be able to function with your copy of Project. And you aren’t immune from forgetting the changes that you made.

To change the images that appear on tools, follow these steps:

1. Choose Views ➪ Toolbars ➪ Customize to open the Customize dialog box.
2. Click the Commands tab.
3. Click a tool on any toolbar that you have displayed. (To display a toolbar, select it on the Toolbars tab of this dialog box.)
4. Click the Modify Selection button, and select Change Button Image. The pop-up palette of images appears, as shown in Figure 23-27.
5. Click an image that you want to use.

   To return an image to its original setting, choose Modify Selection ➪ Reset Button Image.

6. Click Close to close the Customize dialog box after you finish.

   ToolTips still work with modified buttons and are a great help in remembering what function a button performs. Just pass your mouse pointer over any tool, and its original name appears.
Rather than replacing the button image with a predefined picture, you can edit the existing picture by modifying the pattern and colors on it. For example, if two tools seem similar to you, you can differentiate them by applying a bright red color to either one. Button images comprise many tiny squares called *pixels*. By coloring in the pixels, you can form an image. You can use a color palette and the individual pixels to modify button images or even draw an entirely new image.

To edit a button image, follow these steps, starting from the Customize dialog box Commands tab:

1. Click a tool on any displayed toolbar, and then click Modify Selection.
2. Select the Edit Button Image command to open the Button Editor dialog box, as shown in Figure 23-28.
3. Try the following techniques:

- To make changes to an image, click a color block in the Colors palette and then click an individual pixel.

- To remove color from a pixel, click the Erase block in the Colors palette and then click the pixel.

To color in or erase a large area of pixels, click a color in the palette or the Erase block, click a pixel, and then drag your cursor in any direction to color or erase multiple pixels in one motion. Release your cursor to stop painting or erasing the pixels.

- To see more of a large button that doesn’t fit in the Picture box, use the Move arrows to move up and down or from side to side to display the image’s edges.

4. Click OK to save your changes and to return to the Customize dialog box. Click Close to return to your Project screen.

Customizing project menus

Toolbars aren’t the only way to get things done in Project, and toolbars aren’t the only elements in Project that you can customize. You also can create new menus and modify existing menus to your heart’s content. For example, you can add a command to the File menu that changes the current view to the Network Diagram view and prints a report. You can add these functions because menu commands are actually macros, that is, recorded series of keystrokes or programming commands.

Macros are really a form of computer program. Visual Basic is the macro-programming language that you use in Microsoft products. In a macro, you save a string of commands that instruct the software to perform one or more actions. Project provides an easy method for selecting commands to associate with a macro and for saving the macro as a custom menu command. See Chapter 24 for more on macros.

When you select a menu command, you are really running a macro, telling Project to repeat the sequence of events that copies a selected piece of text, causes a dialog box to appear, and so on.

You can use your own macros and Project’s built-in commands to customize Project by building new menus and changing the function of existing commands. Or, you can delete menus or commands on menus that you don’t need.
Adding menus

To add a new menu to your Project menu bar, you follow a process that is similar to that used to add a new toolbar. First, you drag a new, blank menu to the menu bar, then you assign it a name, and finally you drag commands onto it.

As with toolbars, Project adds new menus to your Global template file, the default file on which all project files are based. Therefore, changes that you make to menus or the menu bar are, in effect, for all files that you create with this copy of Project.

Follow these steps to add a new menu to Project:

1. Choose View ➪ Toolbars ➪ Customize to open the Customize dialog box.
2. Make sure that the menu bar is showing on your screen. If it’s not, click the menu bar item on the Toolbars tab of the Customize dialog box.
3. Click the Commands tab.
4. Scroll to the bottom of the list of Categories and click the New Menu category. The single selection, New Menu, appears in the list of commands, as shown in Figure 23-29.

5. Click the New Menu item in the Commands list and drag it up to the menu bar. When the dark vertical line of your mouse pointer appears where you want to place the new menu, release the mouse button. Project places the New Menu on the menu bar.
6. Select the New Menu, and then click the Modify Selection button. From the new pop-up menu, as shown in Figure 23-30, highlight New Menu and type a specific menu name. Then click outside the Modify Selection menu to close it.

![Image of Microsoft Project interface with Customization dialog box open]

**Figure 23-30:** The menu name should help you remember the commands that the menu contains.

7. Select a category of commands that you want to place on the new menu. If you have created a macro and want to place it on the menu, select the All Macros category, which includes standard menu-command macros as well as macros that you’ve created.

8. Drag an item in the Commands list up to the New Menu on the menu bar. A small, blank box appears under the menu heading.

9. Place the mouse pointer in that blank area, and release the mouse button to place the command on the menu.

10. Click Close to close the Customize dialog box.

You can repeat Steps 7 through 9 to build the new menu. To divide the menu into groups of commands, you can choose Modify Selection ➪ Begin a Group to add dividing lines.
Assigning new commands
You may also want to modify the function of an existing menu command. For example, if you create a macro that invokes the Print command and accepts all the Print dialog box defaults for you, you can assign that macro to the Print command. That way, you don’t have the extra step of clicking OK to accept print defaults every time you print. As always, be careful about replacing the function of one command with another if other people will be using your copy of Project.

You can reinstate all the menu defaults by clicking the Toolbars tab in the Customize dialog box, clicking the Menu Bar item, and clicking Reset.

To change the macro that is associated with a command, follow these steps:

1. Display the Customize dialog box (choose View ‹ Toolbars ‹ Customize).
2. Open the menu on which you want to edit a command.
3. Right-click the command that you want to change; the menu shown in Figure 23-31 appears.
4. Select the Assign Macro command from this menu to open the Customize Tool dialog box, as shown in Figure 23-32.
5. Click the Command drop-down list, and select the command that you want to associate with the menu item.
6. (Optional) Type a description of what this command does.
7. Click OK to return to the Customize dialog box, and then click Close to save the new command with the menu item.

Deleting commands and menus
Is your screen getting cluttered with custom commands and menus? To remove a particular command or a whole menu without resetting all the menu changes that you’ve made, follow these steps:

1. Open the Customize dialog box.
2. Click a menu name, or open the menu and click a particular command.
3. Drag the item off the menu bar, and close the Customize dialog box.

That’s all there is to it!
Figure 23-31: You can use this menu to add a button image next to a menu command.

Figure 23-32: The Command entry in the Customize Tool dialog box is the name of the macro that Project invokes.
Summary

In this chapter, you found out how to do the following:

✦ Work with custom fields to create data entry value lists and formulas
✦ Modify Project’s behavior to display only one icon on the Windows taskbar or to display an icon for each open project
✦ Take advantage of the new features for saving your projects
✦ Display the Standard and Formatting toolbars on the same row or on separate rows
✦ Customize the features (toolbars and menus) that you use to get things done

In the next chapter, I discuss details about creating your own macros, which can form the basis for new tools and menus and streamline the repetitive tasks that you perform to create and track a schedule.
Using Macros to Speed Your Work

Macros are small programs that carry out repetitive tasks that you perform frequently. You may have used macros in a word processing program. Macros work the same way in Project as they do in your word processor.

Don’t let the word program in the preceding paragraph deter you from getting to know macros. Although you can work with the macro programming code, Project provides an easier way for you to write a macro, which I present in this chapter.

Using Macros

Macros are most useful when you need to perform any repetitive task. In particular, you can use Project macros to do the following:

✦ Display or hide frequently used toolbars
✦ Display frequently used tables
✦ Display frequently used views
✦ Switch to a custom view
✦ Generate standard reports

As you become comfortable using Project, you’ll identify the steps that you take over and over again; these tasks are excellent candidates for macros.
Recording Macros

Project stores macros in the Visual Basic for Applications (VBA) programming language. And, if you're adept at programming, you can write your macro directly in the VBA programming language. Figure 24-1 shows a sample of the instructions that are stored in a macro in Visual Basic.

![Figure 24-1: A sample set of instructions that are stored in a macro.](image)

Most people prefer to record a macro. When you record a macro, you have Project memorize the steps that you want to take and then store those steps. That is, you do whatever it is you want Project to do. Project then converts those actions into Visual Basic statements and stores the statements in a macro. Later, when you want to take that action again, you run your macro, which I discuss in the next section.

Before you record a macro, you should run through the steps that you want to take. You may even want to write down the steps. That way, you are less likely to make (and record) mistakes.

Suppose that you find yourself often displaying a split view with the Gantt Chart on top and the Task Details Form below. Since you do this often, it would make a useful macro. First, walk through the process to create the view, so that you know what steps you take:
1. Open the View menu, and click Gantt Chart.

   By selecting the view first, you force Project to start your macro from the Gantt Chart view, regardless of the view that you were using before you ran your macro.

2. Choose Window ➪ Split to open the bottom pane that shows, by default, the Task Form view.

3. Click the bottom pane, and choose View ➪ More Views to open the More Views dialog box.

4. Select the Task Details Form.

5. Click Apply.

Now that you know what you’re going to record, use the following steps to record the macro:

1. Choose Tools ➪ Macro ➪ Record New Macro to open the Record Macro dialog box, as shown in Figure 24-2.

2. Enter a name for the macro in the Macro name box.

   The first character of the macro name must be a letter, but the other characters can be letters, numbers, or underscore characters. You can't include a space in a macro name, so try using an underscore character as a word separator, or capitalize the first letter of each word.

3. (Optional) To assign the macro to a keyboard shortcut, type a letter in the Shortcut key box. The letter that you assign can be any letter key on your keyboard, but it can’t be a number or a special character. You also can’t assign a key combination that is already used by Microsoft Project. If you select a reserved letter, Project displays the warning message that is shown in Figure 24-3 when you click OK.
Keyboard shortcuts are only one of the ways that you can run a macro. In the section “Using Shortcuts to Run Macros,” later in this chapter, you discover other methods to play back a macro as well as how to assign a keyboard shortcut after you’ve recorded and stored your macro.

4. In the Record Macro dialog box, open the Store macro in list box and click the location where you want to store the macro. You can store the macro in the Global File or in the current project. To make a macro available to all projects, select Global File.

The Global File is also called the Global template file, and it acts like the Normal template in Word or the Book1 template in Excel. Any customized features (such as macros, toolbars, or menus) that you store in the Global File are available to any project file. On the other hand, customized features that you store in an individual project file are available only to that file.

5. Type a description of the macro or the function that it performs in the Description box. This description appears whenever you run the macro from the Macros dialog box.

6. Use the options that are in the Row references and Column references sections to control the way that the macro selects rows and columns if you select cells while running a macro. For rows, the macro always selects rows—regardless of the position of the active cell—because it records relative references to rows. If you want a macro to always select the same row, regardless of which cell is first selected, select Absolute (ID).

For columns, the macro always selects the same column each time that it is run—regardless of which cell is selected first—because the macro records absolute references to columns. If you want a macro to select columns, regardless of the position of the active cell when you run the macro, select Relative in the Column references section.

7. Click OK, and Project redisplay your project. You don’t notice any differences, but Project is now recording each action that you take.

8. Take all the actions that you want to record.

9. Choose Tools*Macro*Stop Recorder, as shown in Figure 24-4, to stop recording your macro.
Running Macros

To use a macro that you have recorded, simply run the macro. Some people refer to this action as “playing back” the macro because they associate recording and playing back with the process of recording a TV program on a VCR and then playing back the recording.

If your macro makes substantial changes to your project, you should save the project before you run the macro. You can’t undo the effects of a macro easily. To run a macro, follow these steps:

1. Open the project that contains the macro. If you stored the macro in the Global template file, you can open any project.

2. Choose Tools ➪ Macro ➪ Macros to open the Macros dialog box, as shown in Figure 24-5.

3. Select the macro that you want to run from the Macro name list.
Figure 24-5: The Macros dialog box.

4. Click Run. Project performs the steps that you recorded in the macro.

Tip
If your macro is long and you want to stop it while it’s still running, press Ctrl+Break. If your macro is short, it will probably finish before you can stop it.

Using Shortcuts to Run Macros

Although you can run macros by selecting them from the Macros dialog box, if you use a macro on a regular basis, you may want to shorten the method for running the macro. You can create one of the following to do so:

✦ A toolbar button that runs the macro
✦ A menu command that runs the macro
✦ A keyboard shortcut that runs the macro

Assigning a macro to a toolbar button

Suppose that you’re a fan of toolbar buttons, and you create a macro that you use a lot. You find yourself wanting a toolbar button that you can click to make your macro run. Well, you can get your wish by adding a button to a toolbar and assigning your macro to that button.

Caution
Adding buttons to the toolbars that come with Project isn’t always a good idea. If you add a toolbar button to one of the toolbars that comes with Project and you reset that toolbar, the button that you added disappears.
The following steps explain how to add a button that's assigned to a macro to the Standard toolbar, but you can also add toolbar buttons for macros to a custom toolbar that you create.

Chapter 20 explains how to create a custom toolbar.

1. Check to see whether the toolbar to which you want to add a button appears on-screen. If it does, go to Step 2. Otherwise, display the toolbar by right-clicking any toolbar button and choosing the toolbar from the shortcut menu that appears.

2. Choose View ➪ Toolbars ➪ Customize to open the Customize dialog box.

Tip
You can also open the Customize dialog box by choosing Tools ➪ Customize ➪ Toolbars.

3. Click the Commands tab, as shown in Figure 24-6.

![Figure 24-6: From the Commands tab of the Customize dialog box, you can add macros as buttons to toolbars.](image)

4. Scroll down the Categories list, and select All Macros. Project displays a list of macros in the Commands list on the right side of the dialog box.

5. Drag the macro that you want to add onto the desired toolbar, as shown in Figure 24-7. As you drag, the mouse pointer image changes to include a small button and a plus sign. As you move the mouse pointer over a toolbar, a large insertion point marks the location where the button will appear when you release the mouse button.
6. Release the mouse button and a new button appears on the toolbar, as shown in Figure 24-8. The name of the button is so long that Project wrapped the Standard toolbar onto a second row.

Tip
If you’re concerned about using excessive screen real estate, you may want to take advantage of the feature in Project that permits the Standard toolbar and the Formatting toolbar to share the same row. Buttons that are not used frequently reside on a hidden palette. See Chapter 23 for more information about customizing Project.

7. To change the name of the toolbar button, click Modify Selection in the Customize dialog box to open the pop-up menu that is shown in Figure 24-9.

8. Type the name, exactly as you want it to appear on the toolbar button, into the Name box. You can include spaces.

9. Press Enter. The pop-up menu disappears, and Project renames the macro toolbar button, as shown in Figure 24-10.
Chapter 24  ✦ Using Macros to Speed Your Work

Figure 24-8: The new button after dropping it on the toolbar.

Figure 24-9: The menu that appears when you click the Modify Selection button to change a macro button’s name.
10. Close the Customize dialog box.

When you add a toolbar button to an existing toolbar, Project saves it in your Global template file. Any other project files that you open on your computer using that Global template file contain the new toolbar button.

**Tip**

If you change your mind and don’t want the button on the toolbar, you can remove it by opening the Customize dialog box and then simply dragging the button off the toolbar and dropping it anywhere on your project. The button disappears, but the macro is still available.

**Assigning a macro to a menu command**

Maybe you’re not a toolbar person, or maybe you just prefer to use menu commands. This section shows you how to add a command that’s assigned to a macro to the Tools menu.

**Caution**

As with toolbars, be aware that adding commands to the menus that come with Project isn’t always a good idea. If you add a command to one of the standard menus and you reset that menu, the command that you added will disappear.
You can also add commands for macros to custom menus that you create, and if you don’t want your custom menu to appear all the time, you can create a custom toolbar and drag menus onto it. Then you can hide or display the toolbar as needed.

See Chapter 20 for more information about creating custom menus and toolbars.

Follow these steps to add a command that runs your macro from a menu:

1. Choose View ➪ Toolbars ➪ Customize to open the Customize dialog box.

   You also can open the Customize dialog box by choosing Tools ➪ Customize ➪ Toolbars.

2. Click the Commands tab, as shown in Figure 24-11.

   Figure 24-11: You can add macros as commands on menus by using the Commands tab of the Customize dialog box.

3. Scroll down the Categories list, and select All Macros. Project displays a list of macros in the Commands list on the right.

4. Drag the macro that you want to add to the desired menu, as shown in Figure 24-12. As you drag, the mouse pointer image changes to include a small button and a plus sign (+). As you move the mouse pointer over a menu, the menu opens; a large horizontal insertion point marks the location where the button will appear when you release the mouse button.

5. Release the mouse button. The macro appears on the menu, as shown in Figure 24-13.
6. To change the name of the macro on the menu, click Modify Selection in the Customize dialog box to open the pop-up menu, as shown in Figure 24-14.

7. Type the name (including spaces, if you want) in the Name box, exactly as you want it to appear on the toolbar button.

Alt-T opens the Tools Menu so Alt-T-D opens the tools menu and selects the item in that menu with D as the hot key. JmpTo provides a hotkey character for your macro name, place an ampersand (&) immediately before the character that you want to be the hotkey—as I did before the D of Detail in Figure 24-14. If your macro name contains a number, you can make it the hotkey character using the same technique. Make sure that the letter you select is not already in use by some other command on the same menu. When the command appears on the menu, the hotkey character will be underscored, enabling you to choose the command from the menu by pressing the hotkey character combination. For example, I can choose the Detail Form command by pressing Alt+T+D. Alt-T opens the Tools menu, and D selects Detail Form, the item in that menu with D as the hot key.

8. Press Enter. The pop-up menu disappears, and Project renames the menu command. As Figure 24-15 shows, the command includes your hotkey if you added an ampersand.
Figure 24-13: A macro has been placed on the Tools menu.

Figure 24-14: Modifying the command name on the menu.
9. Close the Customize dialog box.

When you add a command to one of the default menus, Microsoft Project saves the command and the menu in your Global template file. Any other project file that you open on your computer using that Global template file contains the new menu command.

**Tip**

If you change your mind and don’t want the command on the menu, you can remove it by opening the Customize dialog box and then simply dragging the command off the menu and dropping it anywhere on your project. The command disappears, but the macro is still available.

### Assigning a keyboard shortcut to a macro

Suppose that after you experiment, you decide that you really want to run your macro from a keyboard shortcut. Furthermore, suppose that you didn’t set a shortcut when you created the macro. Follow these steps to add a keyboard shortcut to the macro after you create it:

1. Open the project that contains the macro.
2. Choose Tools ➪ Macro ➪ Macros to open the Macros dialog box, as shown in Figure 24-16.
You can also press Alt+F8 to display the Macros dialog box.

3. Highlight the macro to which you want to add a keyboard shortcut.

4. Click Options to open the Macro Options dialog box that appears in Figure 24-17.

5. Place your cursor in the Shortcut key box, and type a letter.

6. Click OK. If the combination that you selected (Ctrl plus the letter that you typed) is not in use by Project, Project displays the Macros dialog box again. If Project is using the combination that you selected, even for another macro, Project asks you to try a different combination.

7. Close the Macros dialog box.
To run your macro, press the keyboard combination that you assigned. If you decide that you don’t want to run your macro by using this keyboard combination, you can change the combination by using the preceding steps, or you can remove the keyboard combination that you assigned by reopening the Macro Options dialog box and deleting the letter from the Shortcut key box.

**Summary**

In this chapter, you found out how to use macros in Project. In particular, you now know how to do the following:

- Create macros
- Use macros
- Assign shortcuts to macros to make them easy to run

Chapter 25 explains how to customize Project using VBA.
As you saw in Chapter 24, a macro is an automated set of instructions that can help you accomplish a specific task in Project. Macros are especially useful for completing tedious, repetitive tasks. You can record a macro in Project, or you can produce even more powerful automation by writing your own Visual Basic for Applications, or VBA, code.

For example, suppose that you need to increase the work for every task in your project that is assigned to a new, less experienced resource. If you had to accomplish this manually, you could edit every task to which this resource is assigned in your project and modify the assignment’s work field. If this were a large project with several hundred tasks, you could see how this could take you hours to accomplish. It is easier to write some VBA code and then take just a few seconds to run the code. Furthermore, once you write your code, you can reuse it as many times as you like. If this idea appeals to you, customizing Project using VBA code is definitely worth exploring.
In this chapter, you find the following three case studies, which show the benefits of customizing Project 2003 using code:

- Writing VBA code to filter all tasks on the project’s critical path that should have finished by the current date, but have not.
- Increasing the work value for a particular resource in the project for all tasks that have not yet completed.
- Customizing the Project Guide to incorporate your company standards into the project initiation process.

This chapter is not intended to be a comprehensive VBA reference guide for Project. Instead, its purpose is to introduce you to many concepts of automating Project, and to help you “get your feet wet” in the world of writing custom code.

**Example One: Creating a Filter to See Critical Tasks and Resource Assignments**

As a project manager, you must be able to easily identify the tasks in your project that are falling behind schedule. In particular, if a late task is on the project’s critical path, the late task is having a direct impact on your ability to complete the project on schedule.

In this first example, you see how you can use VBA to easily identify the tasks on your project’s critical path that should have finished by the current date, but have not. Once you have identified the affected tasks, you can filter the list of tasks for a particular resource — that is, you can identify late, critical tasks by person.

**Recording a macro to create a filter for critical tasks**

Recording a macro that captures the basic steps of the process is an excellent technique for producing the foundation for the VBA code that you will ultimately need. Once you’ve recorded the basic VBA code in a macro, you can customize the code to accomplish your exact requirements. In Figure 25-1, you see a project with all of its tasks visible.
Use the following steps to create a filter that shows only the tasks in the project that should have finished by the current date and are on the critical path:

1. Start Project, and open the Example One.mpp file.

You can find Example One.mpp on the CD that accompanies this book.

2. Choose Tools ➪ Macro ➪ Record New Macro. The Record Macro dialog box appears.

3. In the Macro name box, type FilterCriticalTasksByDateAndResource, as shown in Figure 25-2, and click OK. The macro recorder will now capture all your actions.
4. Choose Project ‹ Filtered for ‹ More Filters to open the More Filters dialog box.
5. Click the New button to open the Filter Definition dialog box.
6. Complete the Filter Definition dialog box, as shown in Figure 25-3, and click OK.

In this figure, you're setting up the macro to filter for critical tasks for the Analyst resource.

![Figure 25-3: The Filter Definition dialog box contains the filter criteria that are used by the macro.](image)

The text `Today` in the Value field is automatically translated to the current date when you run the macro.
7. Click the Close button in the More Filters dialog box.

8. Choose Tools ➪ Macro ➪ Stop Recorder to stop recording the macro. At this point, your recorded keystrokes have filtered the project to show only critical tasks that have not yet been completed.

Since the Close button was used the filter has not been applied. The code generated matches the code in Figure 25-5. But the comparison between Figures 25-1 and 25-4 does not show the expected differences because there was no “Apply” of the filter. The code in listed in the book agrees with use of Close and not Apply. The code on Figure 25-6 contains the code to apply the filter, which the user would never have supplied following the above instructions. The code presented in the text of the book does not contain the apply of the filter so as written, the code will not generate the result shown on Figure 25-8. jmpCompare Figure 25-4 with Figure 25-1. Notice that only the tasks that are on the critical path are now visible.

Figure 25-4: The project has been filtered to show only the critical tasks.
Editing the macro to show only specified resources

The macro that you just recorded works fine for the Analyst resource, but you would really like to be able to run this same code for any resource in your project. To add this flexibility to the code, add a few additional lines to the macro to prompt the user to enter the name of a resource. Use the following steps:

1. Choose Tools ➤ Macro ➤ Macros to open the Macros dialog box.

2. Select the FilterCriticalTasksByDateAndResource macro, and click the Edit button. This opens the Visual Basic Editor. See the sidebar “Key components of the Visual Basic Editor.”

The terminology may seem a bit confusing: You use the UserForm window to create dialog boxes or windows that will be a part of your user interface. The windows or dialog boxes that you create in the UserForm window are known as UserForm objects and are usually called simply UserForms. In this chapter, whenever you see UserForm by itself, the term refers to a UserForm object. All references to the window will appear as UserForm window.

3. Close the Project Explorer and the Properties window (if open) by clicking the X in the upper-right corner of each window. The Code window now occupies the full screen, as shown in Figure 25-5.

![Figure 25-5: The Code window displays the VBA code that was generated by recording a macro.](image)
The Code window contains the VBA code that was generated when you recorded your macro. The macro code is known as a sub procedure. A sub procedure is a set of instructions in your program that are executed as a unit. The code between the lines `Sub FilterByCurrentDateAndCritical()` and `End Sub` are the instructions that create a filter programmatically. The lines with the green text (it really is green, even though you can’t tell because the book is black and white) that begin with an apostrophe are comments that are used to document the code.

4. In the Code window, modify the sub procedure by adding the following lines and changes that appear in boldface:

```vba
Sub FilterCriticalTasksByDateAndResource()
    Dim strResourceName As String
    ' Macro FilterCriticalTasksByDateAndResource
    ' Macro Recorded Sun 5/4/03 by Administrator.
    strResourceName = InputBox("Please enter the resource name:")
    FilterEdit Name:="Late Tasks On Critical Path", TaskFilter:=True, Create:=True, OverwriteExisting:=True, FieldName:="Finish", Test:="is less than", Value:="Today", ShowInMenu:=False, ShowSummaryTasks:=True
End Sub
```

This module is available on the CD that accompanies this book. To add the module from the CD instead of creating it manually, display the Code window and choose File ➪ Import File. Then, browse the CD for the file `modFilterCriticalTasks.bas`.

**Note**
Key components of the Visual Basic Editor

The Visual Basic Editor is the common programming environment that is used in all Microsoft Office applications, including Project 2003. Some of the key components of the Visual Basic Editor, shown in this figure, are as follows:

✦ **Project Explorer:** The Project Explorer displays a hierarchical list of the projects and all the items that are contained in and referenced by each of the projects.

✦ **Properties window:** The Properties window lists design-time properties for selected objects and their current settings. An object is a piece of the application that can be manipulated. In Project, entities such as a task, resource, or assignment are objects. In fact, the entire application of Project is considered to be an object. A property is a value that you can set to determine the object's appearance or behavior. For example, the Start date and Name are properties of a task object.
Testing the code

Now you can run the modified code to test the changes that you made. Use the following steps to do so:

1. Click the Run Sub/UserForm button in the toolbar at the top of the screen, as shown in Figure 25-6.

Figure 25-6: Click the Run Sub/UserForm button to run the VBA sub procedure.
2. The Microsoft Project dialog box opens, as shown in Figure 25-7. At the prompt to enter the resource name, type **Project Manager** and click OK.

![Figure 25-7: Select a resource whose tasks you want to view.](image)

The filter is then applied so that you can only view the tasks in the project that are late, on the critical path, and assigned to the resource Project Manager (see Figure 25-8).

![Figure 25-8: After adding the filter, you can view tasks that are on the critical path for the specified resource.](image)
I’ll review the changes that you made to the code so that you can understand the purpose of each change. The line that begins with Dim declares a variable that is used to store the resource name that the user types into the dialog box. The variable that you created is known as a string variable, which is designed to store text.

The line strResourceName = InputBox("Please enter the resource name:") displays a dialog box, known as an InputBox, that prompts the user to type in the resource name, and the name that the user enters is stored in the variable strResourceName.

On the last line, which begins with FilterEdit, you substituted the text Analyst with the variable strResourceName. The name that the user entered in the InputBox is used as the filter value for the Resource Names field.

To run your macro without having to choose Tools ➪ Macro ➪ Macros, you can assign your macro to a toolbar button or add it to a custom menu.

See Chapter 24 for detailed instructions on assigning macros to toolbars or menus.

Example Two: Creating a UserForm Object to Adjust Work

To use Project effectively and consistently in an organization, you should begin each new project using a template. A template may contain items such as standard tasks that have been defined within your organization as well as generic resources, such as Programmer, Systems Analyst, and so on. In addition, a template is often created so that generic resources are assigned to standard tasks with the typical amount of work that it takes for that resource to complete each task in the project.

For example, it may typically take the resource programmer 16 hours of work on the Write Design Document task. But suppose that your organization has just hired a new programmer, with little experience in writing design documents in your organization’s format. In this case, you would increase the work for each task that the programmer is assigned to by a factor of 50 percent. If the programmer is assigned to many tasks in your project, it would be time consuming to adjust the work for each task manually.

In the following example, you will see how to create a UserForm Object to automate the process of adjusting the work for a selected resource in your project.
Designing the UserForm

A UserForm is a window or a dialog box that you design based on the requirements of your application. When you design a UserForm, try to make it appear like other Project dialog boxes. The more familiar you can make a UserForm, the more likely someone will use it.

This completed UserForm is available on the CD that accompanies this book. To add the UserForm from the CD instead of creating it manually, choose File ➪ Import File and browse for the file frmAdjustWork.frm.

Creating a UserForm

You need to insert a new UserForm so that you can create a custom interface for your application. Follow these steps to create a UserForm:

1. Start Project, and open the Example Two.mpp file.
2. Choose Tools ➪ Macro ➪ Visual Basic Editor to open the Visual Basic Editor (VBE), as shown in Figure 25-9.

![Figure 25-9: The UserForm will be inserted in the Visual Basic Editor.](image-url)
3. Choose Insert ➪ UserForm. You see a screen similar to that shown in Figure 25-10.

![A UserForm for designing a custom dialog box.](image)

**Figure 25-10:** A UserForm for designing a custom dialog box.

**Adjusting the size of the UserForm**

Now that you have inserted a UserForm, you need to adjust the size of the UserForm to accommodate the controls that you will place on the form. To change the size of the form, adjust the UserForm’s properties. Properties include attributes such as height, width, position, font, color, text, and so on.

Click anywhere on the UserForm, and choose View ➪ Properties Window to open the Properties window, as shown in Figure 25-11.
Figure 25-11: The Properties window allows you to set the attributes of the UserForm.

The Properties window was probably already displayed in the Visual Basic Editor. This window is typically displayed in the lower-left corner of your screen.

In the Properties window, set each of the properties for the UserForm, as shown in the following table.

<table>
<thead>
<tr>
<th>Property</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Name)</td>
<td>FrmAdjustWork</td>
</tr>
<tr>
<td>Caption</td>
<td>Adjust Work</td>
</tr>
<tr>
<td>Height</td>
<td>145</td>
</tr>
<tr>
<td>Width</td>
<td>240</td>
</tr>
</tbody>
</table>
Adding controls to the UserForm

To make the form useful, you need to add controls to the form. For this UserForm, you need the following controls:

- Label controls to identify the various elements on the UserForm
- A ComboBox control to select a resource
- A text box to enter the amount by which you want to increase or decrease the work for the selected resource
- OK and Cancel command buttons

Once you have completed the UserForm, it should look like Figure 25-12.

![Figure 25-12: The Adjust Work dialog box, based on the completed UserForm.](image)

Label control

The UserForm won’t be meaningful to the user unless he knows what the various controls do, so start by adding a Label control to the UserForm for the box where the user must select a resource. Click the Label button in the Toolbox to select the Label control, as shown in Figure 25-13. Then, on the UserForm, use your mouse to “draw” the control toward the upper-left corner of the form, as shown in Figure 25-14.
Figure 25-13: The Toolbox allows you to select the controls for the UserForm.

Figure 25-14: The Label control is displayed on the UserForm.

In the Properties window, set each of the properties for the Label control, as shown in the following table.

<table>
<thead>
<tr>
<th>Property</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Name)</td>
<td>LblResource</td>
</tr>
<tr>
<td>Caption</td>
<td>Select Resource:</td>
</tr>
<tr>
<td>Height</td>
<td>12</td>
</tr>
<tr>
<td>Left</td>
<td>12</td>
</tr>
<tr>
<td>Top</td>
<td>12</td>
</tr>
<tr>
<td>Width</td>
<td>60</td>
</tr>
</tbody>
</table>
The Label control has many other properties, but you can accept the default value for all the other properties.

**ComboBox control**

To select the resource whose work needs to be adjusted, you need a ComboBox control. Click the ComboBox button in the Toolbox, and use your mouse to “draw” the control below the Label control, as shown in Figure 25-15.

![Figure 25-15: The ComboBox control is displayed on the UserForm.](image)

In the Properties window, set each of the properties for the ComboBox, as shown in the following table.

<table>
<thead>
<tr>
<th>Property</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Name)</td>
<td>cboResource</td>
</tr>
<tr>
<td>Height</td>
<td>15.75</td>
</tr>
<tr>
<td>Left</td>
<td>12</td>
</tr>
<tr>
<td>Top</td>
<td>12</td>
</tr>
<tr>
<td>Style</td>
<td>fmStyleDropDownList</td>
</tr>
<tr>
<td>Width</td>
<td>210</td>
</tr>
</tbody>
</table>

Add another Label control to the UserForm, just below the resource ComboBox control. Click the Label button in the Toolbox, and use your mouse to “draw” the Label control below the resource ComboBox control, as shown in Figure 25-16.
In the Properties window, set each of the properties for the Label control, as shown in the following table.

<table>
<thead>
<tr>
<th>Property (Name)</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>lblPercent</td>
</tr>
<tr>
<td>Caption</td>
<td>Enter percent to increase or decrease work:</td>
</tr>
<tr>
<td>Height</td>
<td>12</td>
</tr>
<tr>
<td>Left</td>
<td>12</td>
</tr>
<tr>
<td>Top</td>
<td>48</td>
</tr>
<tr>
<td>Width</td>
<td>192</td>
</tr>
</tbody>
</table>

**TextBox control**

Add a TextBox control to the UserForm, just below the Label control that you just created. Click the TextBox button in the Toolbox, and use your mouse to “draw” the TextBox control below the second Label control, as shown in Figure 25-17.

**Figure 25-16:** The second Label control is displayed on the UserForm.

**Figure 25-17:** The TextBox control is displayed on the UserForm.
In the Properties window, set each of the properties for the TextBox control, as shown in the following table.

<table>
<thead>
<tr>
<th>Property</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Name)</td>
<td>txtPercent</td>
</tr>
<tr>
<td>Height</td>
<td>15.75</td>
</tr>
<tr>
<td>Left</td>
<td>12</td>
</tr>
<tr>
<td>Top</td>
<td>60</td>
</tr>
<tr>
<td>Width</td>
<td>66</td>
</tr>
</tbody>
</table>

**CommandButton control**

Finally, add a CommandButton control—that represents the OK button—to the UserForm toward the bottom of the form. Click the CommandButton button in the Toolbox, and use your mouse to “draw” the control below the previous TextBox control, as shown in Figure 25-18.

![Figure 25-18: The OK button is added as a CommandButton control on the UserForm.](image)

In the Properties window, set each of the properties for the CommandButton control, as shown in the following table.
Now, add a CommandButton control next to the OK button that represents the Cancel button. Click the CommandButton button in the Toolbox, and use your mouse to “draw” the CommandButton control next to the OK button, as shown in Figure 25-19.

![UserForm1](image)

**Figure 25-19:** The Cancel button is added as a CommandButton control on the UserForm.

In the Properties window, set each of the properties for the CommandButton control, as shown in the following table.

<table>
<thead>
<tr>
<th><strong>Property</strong></th>
<th><strong>Input</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>(Name)</td>
<td>cmdOK</td>
</tr>
<tr>
<td>Accelerator</td>
<td>0</td>
</tr>
<tr>
<td>Caption</td>
<td>OK</td>
</tr>
<tr>
<td>Default</td>
<td>True</td>
</tr>
<tr>
<td>Height</td>
<td>19</td>
</tr>
<tr>
<td>Left</td>
<td>114</td>
</tr>
<tr>
<td>Top</td>
<td>90</td>
</tr>
<tr>
<td>Width</td>
<td>50</td>
</tr>
</tbody>
</table>
Adding code to the UserForm

You now have the graphical user interface for the UserForm, but it isn’t much more than “a pretty face” at this point. You need to add code to the UserForm so that it performs the functions that you need.

Adding code to display resource names

Initially, you need to add code to the UserForm so that when the form loads, it adds the names of all the resources in your project as items in the Resource drop-down list. Follow these steps to add the appropriate code:

1. Click anywhere on the UserForm (other than directly on a control), and choose View ➤ Code. The Code window for the UserForm appears, as shown in Figure 25-20.

2. From the Object drop-down box at the upper-left corner of the Code window, select UserForm (it will most likely already be selected).

3. From the Procedure drop-down box at the upper-right corner of the Code window, select Initialize.

4. In the Code window, type the following code between the lines Private Sub UserForm_Initialize and End Sub:

```vba
Private Sub UserForm_Initialize()
    Dim r As Resource
    For Each r In ActiveProject.Resources
        cboResource.AddItem r.Name
    Next r
End Sub
```
Figure 25-20: The Code window for the UserForm allows you to add resource names to the ComboBox when the UserForm loads.

I’ll now review this code to give you a better understanding of how it works.

Because you want this code to run before the form displays, you place the code within the `UserForm_Initialize` procedure. The code is automatically run by VBA when the UserForm loads.

The line `Dim r As Resource` declares a variable named `r`, and you instructed VBA to create this variable as a resource object. This allows you to manipulate a resource’s properties and methods programmatically. An object’s properties are the attributes that are associated with a type of object. A resource has many properties, including Name, Cost, and EMailAddress.
These properties are also fields that are associated with a resource in Project. In fact, all resource fields are properties of a resource object in VBA.

A method is a procedure or action that can be performed on an object to achieve a particular result. For example, the resource object has the Add method, which allows you to add resources to a project, and the AppendNotes method, which appends notes to the resource’s notes field.

The line For Each r In ActiveProject.Resources begins a section of code known as a For . . . Next loop. The line Next r closes the loop. The lines of code that are contained within this loop run once for every resource in the project. The line cboResource.AddItem r.Name adds the Name property of the resource r as an item to the drop-down list. Each time that the code runs through the loop, the code keeps adding the next resource’s name to the list until it reaches the last resource in the project.

You can now run the form and test some of its functionality. Choose Run ➤ Run Sub/UserForm (or press F5). The UserForm appears on the screen, as shown in Figure 25-21.

![Figure 25-21: The completed Adjust Work dialog box, based on the UserForm.](Note)

On the UserForm, click the drop-down list, and you see a list of all the resources that are in your project. But when you try clicking the OK button or Cancel button, at this point nothing happens. Later in this chapter, you will add code to the form that will be associated with clicking the OK button and Cancel button. For now, close the dialog box.

**Adding code to the OK button to change work**

You can add code to the OK button on the UserForm to increase or decrease the work for each task to which the selected resource is assigned. When the user clicks OK on the UserForm, the code that you’re about to add will run.
Double-click the OK button. The Code window appears, as shown in Figure 25-22.

![Code window](image)

**Figure 25-22:** The Code window for the UserForm allows you to add VBA code that will run when the user clicks the OK button.

Add the following code between the lines `Private Sub cmdOK_Click` and `End Sub`. Note the comments that precede each section that describe the purpose of that section of code.

```vba
Private Sub cmdOK_Click()
Dim t As Task
Dim a As Assignment
Dim Adjuster As Single

' Make sure the user has typed a number
If Not IsNumeric(txtPercent.Text) Then
    MsgBox "You must type a valid number in this field.", vbInformation
    Exit Sub
End If
```

---

**Part VII ✦ Advanced Microsoft Project**

Double-click the OK button. The Code window appears, as shown in Figure 25-22. The Code window for the UserForm allows you to add VBA code that will run when the user clicks the OK button.

Add the following code between the lines `Private Sub cmdOK_Click` and `End Sub`. Note the comments that precede each section that describe the purpose of that section of code.

```vba
Private Sub cmdOK_Click()
Dim t As Task
Dim a As Assignment
Dim Adjuster As Single

' Make sure the user has typed a number
If Not IsNumeric(txtPercent.Text) Then
    MsgBox "You must type a valid number in this field.", vbInformation
    Exit Sub
End If
```
'Divide the number the user entered by 100, since they entered a percentage
  Adjuster = Val(txtPercent.Text) / 100

  'Loop through each task in the project
  For Each t In ActiveProject.Tasks
    'Skip over blank rows, if any
    If Not t Is Nothing Then
      'Loop through each resource in your project
      For Each a In t.Assignments
        'If the resource name is equal to the resource the user selected,
        'the adjust the work by the Adjuster value
        If a.ResourceName = cboResource.Text Then
        End If
      Next a
    End If
  Next t

  'Display message confirming success
  MsgBox "The work has been adjusted successfully!", vbInformation

  'Close the form
  Unload Me
End Sub

I'll now review this code to give you a better understanding of how it works.

In this sub procedure, you declared three variables: t is a task object for when the code loops through the tasks in the project, a is an assignment object for when the code loops through the assignments on a task, and Adjuster is a numeric variable with the data type of single to store the percentage that a user types in to adjust the amount of work that’s assigned to the task for the resource.

The section that begins with If Not IsNumeric(txtPercent.Text) then validates that the text that the user has typed in is a valid number. This is an important step, because the sub procedure requires a valid number to perform the work adjustment. If the user types in a nonnumeric character, an error message is displayed.

The line Adjuster = Val(txtPercent.Text) / 100 uses the Val function to convert the text that the user entered to a number, and then divides the number by 100. For example, if the user typed in 20%, the Val function would convert this to 20 and then divide by 100 to set the Adjuster variable to 0.2.
The line `For Each t In ActiveProject.Tasks` begins a section of code that loops through every task in the project. The line `Next t` closes the loop.

The line `If Not t Is Nothing Then` checks to make sure that the sub procedure is not on a blank row in the task list, and if it is on a blank row, this line makes the sub procedure skip that row as it loops through the tasks. This line is important, because it prevents errors if you run the code on a project that contains blank task rows.

The line `For Each a In t.Assignments` begins a section of code that loops through each assignment of a task in your project. The line `Next a` closes the loop. Within this section of code, the line `If a.ResourceName = cboResource.Text Then` compares the name of the resource assignment to the name of the resource that the user selected from the drop-down list. If the two are equal, the resource that the user selected is assigned to the current task in the loop.

The line `a.RemainingWork = a.RemainingWork + (a.RemainingWork * Adjuster)` sets the remaining work for the resource assignment equal to its current value plus the remaining work multiplied by the Adjuster variable. For example, if the resource assignment had 10 hours of work and the Adjuster was 50%, the code would add an additional 5 hours to the 10 hours for a total of 15 hours.

The `MsgBox` line displays a message to the user that the sub procedure has run successfully.

The line `Unload Me` closes the form (literally unloading it from memory), and `Me` is a reserved word that refers to the current form (without having to specify its name).

### Adding code to the Cancel button

You just added code that will run when the user clicks the OK button. You now need to add code to the Cancel button so that the UserForm closes when the user clicks this button. From the Code window, select the `cmdCancel` object from the Object drop-down list. Add the following code between the lines `Private Sub cmdCancel_Click` and `End Sub`:

```vbscript
Private Sub cmdCancel_Click()
    'Close the UserForm
    Unload Me
End Sub
```

Now, all the required code has been added to the UserForm. Click the Save button on the toolbar to save the UserForm.
Adding a sub procedure to show the UserForm

The UserForm is now designed and coded. You only need to add a simple sub procedure to display the UserForm.

The module that you create in these steps is available on the CD that accompanies this book. To add the module from the CD instead of creating it manually, choose File ➪ Import File, and browse for the file `modAdjustWork.bas`.

1. Choose Insert ➪ Module. VBA adds a new module to the project.

A module is simply a container for one or more procedures.

2. In the Properties window, set the name for this module to `modAdjustWork`.

3. In the Code window, add the following sub procedure (see Figure 25-23):

```
Sub ShowAdjustWorkForm ()
   'Display the UserForm
   frmAdjustWork.Show
End Sub
```

![Figure 25-23: The ShowAdjustWorkForm sub procedure displays the UserForm.](image)
The purpose of this sub procedure is to display the UserForm called `frmAdjustWork`. This is the sub procedure that you will run whenever you want to run the code on the UserForm. To run this sub procedure, click any line within the sub procedure and press F5. The UserForm appears and is now functional.

To avoid having to choose Tools › Macro › Macros, you can assign your macro to a toolbar button or add it to a custom menu.

### Example Three: Customizing the Project Guide

Microsoft first introduced the Project Guide in Project 2002 to make the software easier to use and more intuitive, especially for new users. The Project Guide interface is integrated into the left of the main Project screen, where Microsoft Office applications display the Task pane (see Figure 25-24).

![Project Guide](image)

**Figure 25-24:** The Project Guide appears on the left side of the main Project screen.
The Project Guide can be customized, extended, or built from scratch to meet your organization's requirements. Organizations can define and develop business processes and procedures and implement them by using a customized Project Guide. Because a Project Guide can be associated to a project plan or project template, you can develop different Project Guides for the various types of projects that are performed by your organization.

The Project Guide is comprised of three components: a toolbar, a side pane, and a main view area (see Figure 25-25). These items are described as follows:

![Figure 25-25: The Project Guide features a toolbar, side pane, and main view area.](image)

- **Toolbar**: The toolbar is the top level of the Project Guide's structure. The toolbar displays buttons for each of the guide's goal areas. Goal areas organize the project into logical groups of functions that correspond to the major activities that are required to manage a project. The default Project Guide that comes with Project is made up of four goal areas: Tasks, Resources, Track, and Report.
✦ **Side pane:** The side pane displays on the left side of Project’s main screen. This pane displays a list of the tasks that are defined within a particular goal area when you click the button on the Project Guide toolbar for that goal area. For example, the Resources side pane lists each of the resource-related steps that are used to manage a project. When a user clicks the Specify people and equipment for the project resource step, a screen appears in the side pane to lead the user through all the required steps to add resources to a project.

✦ **Main view area:** The main view area refers to the main Project window that is displayed to the right of the side pane. The main view area usually displays a Project view, but it can also display a Web page from Project Web Access or even your organization’s intranet. The main view area’s content can change, depending on the task that the user has selected in the Project Guide’s side pane.

### Content of the Project Guide XML document

The structure and content for the Project Guide are defined within an XML file. XML, or eXtensible Markup Language, is used to create dynamic content for your browser, and in this case, the Project Guide. The default XML document that is used by Project is a compiled document called `Gbui.xml`. On the CD that accompanies this book, you can find an uncompiled version of this file that you can edit. You can also can download this editable version from the Microsoft Web site as part of the Project Guide Software Developer’s Kit (also known as the Project Guide SDK). The URL for the Project Guide SDK is as follows:

http://microsoft.com/downloads/details.aspx?familyId=469a2976-8da8-4c43-b7bc-7ecce1bd136e&displaylang=en

The SDK also contains the sample code for several Project Guide examples. You only need a basic ability to read and modify XML, because the XML structure, or schema, is fairly simple. To customize the Project Guide, you modify the XML document and replace the default `Gbui.xml` document with your own customized version. Then, you configure your project to use the new customized guide instead of the default Project Guide.

The Project Guide displays a series of HTML (HyperText Markup Language) pages in the side pane based on the XML document. HTML is the language that is widely used to display content for your browser. The level of complexity of the HTML pages that are used by the Project Guide depends on the complexity of the functionality being implemented.
Project Guide XML document elements
The Gbui.xml document is broken into many elements, each with a corresponding design and function within the Project Guide. Some elements invoke an action, such as navigating to an HTML page, while others define the Project Guide’s organization and layout (see Figure 25-26). The elements of Gbui.xml are described as follows:

- ViewChanges: This element defines how the Project Guide should respond as the user changes views in Project. Because the users can switch to a different Project view at any time, the content of the side pane must change in tandem with the Project view so that it is relevant to the view that the user has displayed. For example, if a user is working with the Gantt Chart view, the side pane may show steps that are related to creating task dependencies. If the user changes the view to the Resource Sheet view, the side pane content would need to be refreshed to be applicable to the new view.
PageChanges: This element defines how the Project Guide should respond when the user displays Project Web Access pages within Project. For example, the PageChanges element responds whenever a user displays Project Web Access–based content, such as risks, issues, and documents, from within Project Professional.

GoalArea: Each GoalArea element (see Figure 25-27) defines the Project Guide side panes that are displayed for the tasks or activities in that goal area and creates an entry in the Project Guide toolbar. The default Project Guide includes the GoalAreas as Tasks, Resources, Track, and Report. Each GoalArea element is made up of a GoalAreaID, GoalAreaName, GoalAreaDescription, URL, and RelevantViews. When a user selects a goal area in the Project Guide toolbar, a corresponding HTML page appears in the side pane that displays the steps that are associated to that GoalArea. A GoalArea element consists of the following items:

- GoalAreaID: This is a unique identifier for the goal area.
- GoalAreaName: This is the name of the goal area that is shown on the toolbar, such as Tasks.
- GoalAreaDescription: This text is displayed at the beginning of a goal area side pane.
- URL: This is the reference to the HTML page that is associated with the goal area. When the user clicks a goal area in the Project Guide command bar, the corresponding HTML page is displayed in the side pane. By default, this page displays the list of the tasks within the goal area that are defined in the Gbui.xml document GoalAreaTasks.
- RelevantViews: This element is used to define the views that are relevant to a particular goal area. If the user switches to a view that is not relevant, the ViewChanges element responds and switches the goal area or side pane. This ensures that the content in the side pane is always relevant to the view.

GoalAreaTask: This element corresponds to an individual Project Guide side pane task. Each GoalArea element can contain one or more GoalAreaTask elements, corresponding to all the tasks within that goal area.

The GoalAreaTask element (refer to Figure 25-27) consists of the following items:

- TaskID: This is a unique identifier.
- Title: This is displayed in the header area at the top of each Project Guide side pane.
- TaskName: This displays in its associated goal area’s side pane.
Figure 25-27: The GoalArea element defines the tasks that appear in the Project Guide side panes.
Defining the Project Guide for a project

Because a Project Guide is associated with a project, you must be able to define the Project Guide that a particular project plan should use. To do so, select Tools ➪ Options and click the Interface tab (see Figure 25-28). A user can change the Project Guide for a specific project or set the Project Guide for all projects by clicking the Set as Default button. In addition, the properties are also available in the Project Object Model, on the Project Object making these settings available to custom macros and VBA code.

Customizing the Project Guide to create a new project

When you start a project, you may want to collect certain project properties, such as the project title or project description. And, you may want to base the new project on a particular template. A good way to accomplish this would be to add a new task to the Tasks goal area called Create a new project. This new task will display a screen that prompts the user for a project title, project category, and project description and will display a set of option buttons from which the user can select a project template from the standard templates that are supplied with Project.
You can also design the project category interface to display a drop-down list of choices, instead of requiring the user to type in this information. Upon completing this screen, the entered information is copied to the project properties, just as if you had entered this information directly in the Properties dialog box, and a new project plan is created using the selected template. To accomplish this, follow these steps:

1. Add a new task to the Tasks goal area by modifying the default XML document Gbui.xml and adding a new GoalAreaTask called Create a new project.

2. Create a custom HTML page that displays in the side pane when the user clicks the new Project Guide task. This page will contain the necessary functionality to collect information, display a drop-down list of available categories, and populate the associated project plan properties. In this example, the HTML page scripts use JScript, a commonly used scripting language, and the VBScript language.

3. Configure the current project plan to use the custom Project Guide using the Interface tab in the Options dialog box.

After you create a custom Project Guide, you must make it available to the users in your organization; you have several ways to accomplish this task. You can store customized HTML pages, scripts, and XML documents locally on a user’s computer, on a network share, or on an intranet or Internet server. Once you select the location where you intend to store the HTML pages, scripts, and XML documents, make sure that all the custom URL references in the Gbui.xml document, HTML pages, and scripts point to the correct file share or URL in your environment.
Adding a new task to the Tasks goal area

The CD that accompanies this book contains sample code to add a new task, called Create a new project, to the Project Guide. Using this code as a framework, you should ultimately be able to create your own code to add new tasks.

To add the new task to the Tasks goal area, follow these steps:

1. From the CD that accompanies this book, copy the folder `Examples\ProjectGuide\CreateNewProject` to the location where users can find your custom Project Guide.

   The `Examples\ProjectGuide\CreateNewProject` folder includes files for a custom Project Guide with an additional task named Create a new project in the Tasks goal area.

2. Using Notepad or another text editor, open the `Gbui.xml` file from the folder that you just copied. Locate the section that contains the following addition to the default `Gbui.xml` document:

   ```xml
   <GoalAreaTask>
   <TaskID> 100 </TaskID>
   <Title> Create New Project </Title>
   <TaskName> Create a new project </TaskName>
   <URL> file://C:/Examples/ProjectGuide/CreateNewProject/CreateNewProject.htm </URL>
   <RelevantViews>
   <ViewType> -1 </ViewType>
   </RelevantViews>
   </GoalAreaTask>
   ```

3. Change the line that begins with `<URL>` to reference the folder where you copied these files, and save the file.

4. For each task that you want to add to your goal area, copy and paste the code from Step 2 in the `Gbui.xml` document, replacing the `TaskID`, `Title`, `TaskName`, and other elements that pertain to your new task.

This addition to the default XML document adds a new `GoalAreaTask`. Figure 25-29 shows the custom Project Guide content that is displayed in Project, with the new `GoalAreaTask`, Create a new project, included in the Tasks goal area.
Chapter 25 ✦ Customizing Microsoft Project Using VBA and Active Scripting

**Figure 25-29:** The custom Project Guide displays a new task called Create a new project.

**Creating a custom HTML page**

Once you have deployed your custom Project Guide and the user clicks the Create a new project task, the Project Guide displays the HTML page `CreateNewProject.htm`, which is located in the Project Guide folder that you copied from the CD (see Figure 25-30). This file contains the code to create the graphical user interface and functionality for the Create a new project task. You don’t need to make changes to this file, unless you want to add or modify the functionality on this page.

In the `Gbui.xml` file, you can find a `GoalAreaTask` that references the HTML page `CreateNewProject.htm`. And, each `GoalArea` or `GoalAreaTask` page usually has its own `script file` associated with it. The script file contains functions and code that are specific to the new `GoalAreaTask` page. Notice how the code from the `CreateNewProject.htm` file, shown as follows, references the script file `CreateNewProject.vbs`. This `.vbs` file contains all the functionality for creating a new project.
Figure 25-30: The Project Guide displays a custom screen called Create Project.

It is a good programming convention to keep script and code separate from the content that displays on your screen. In other words, keep the underlying functionality in the .vbs or .js file, and place the user interface elements in the .htm file.

```html
<script src="gbui://util.js" language="JScript"></script>
<link rel="stylesheet" href="gbui://ProjIE.css" type="text/css" />
</head>
<script src="CreateNewProject.vbs" language="VBScript">
</script>
A behind-the-scenes look: How Project controls the behavior of the Project Guide

The previous code also references items such as util.js and ProjIE.css. These items, which are part of the compiled Project 2003 application, control the appearance and scrolling behavior of the Create a new project task, among other things. The following list describes the purpose of these items:

- **Util.js** is a script file that contains some common functions that are used by the default Project Guide and includes functions for handling resizing and setting scroll-bars. Including this reference from the default Project Guide allows your custom page to use functions that are already defined in the script file.

- **ProjIE.css** is a style sheet that contains the descriptions that define the appearance of the default Project Guide's user interface elements. Including this reference allows the custom page example to inherit its appearance from the default Project Guide's style sheet.

The rest of the CreateNewProject.htm page contains the basic HTML elements and script that prompts the user for the information that is needed to populate the project properties.

The script file CreateNewProject.vbs demonstrates the ability of the custom Project Guide to perform actions on the current active project plan. The sub procedure **validateData()** sets a reference to the *Project Object Model* (the way that we programmatically interact with Project) using the code window. **external.application**. Once this reference is established, you can utilize the same properties and methods that are used by custom macros and VBA code. In this example, you set a reference to the active project plan and populate the project properties with the information that is entered on the custom page. You also create a new project based on the template that the user has selected in the Project Guide.

```
sub validateData()
    dim currentApplication
    dim templateName
    dim errorMessage

    ' Suppress any excess script errors to avoid user confusion.
    on error resume next

    ' Check for blank data
```
errorMessage = ""
if trim(ProjectTitle.value)="" then
    errorMessage = " Enter a Project Title." & chr(10) &
    ProjectTitle.value = ""
end if
if trim(ProjectNotes.value)="" then
    errorMessage = errorMessage & " Enter a Project Description." & chr(10)
    ProjectNotes.value=""
end if

' Set template name
select case true
    case projectOffice.checked
        testCaseName = "C:\Program Files\Microsoft Office\Templates\1033\PROJOFF.MPT"
    case newBusiness.checked
        testCaseName = "C:\Program Files\Microsoft Office\Templates\1033\NEWBIZ.MPT"
    case infrastructure.checked
        testCaseName = "C:\Program Files\Microsoft Office\Templates\1033\INFSTDEP.MPT"
    case softwareDevelopment.checked
        testCaseName = "C:\Program Files\Microsoft Office\Templates\1033\SOFTDEV.MPT"
    case else
        errorMessage = errorMessage & " Select a Project Type." & chr(10)
end select

if errorMessage <> "" then
    errorMessage = "To continue you must:" & chr(10) &
    chr(10) & errorMessage & chr(10) & errorMessage & chr(10)
    messagebox errorMessage,"Project Guide"
    exit sub
end if
set currentApplication = window.external.application
pNavigate 1,-1,"createPlan"
end sub

I’ll now review the portions of this code to give you a better understanding of how it works.
Each of the sections that begins with `case` evaluates the type of project template that is selected by the user in the Project Guide. The guide creates a new project based on the project template that is associated with the selected option.

The `FileOpen` method opens the template that the user selected in the Project Guide. When the user clicks the `Create` hyperlink, this triggers the `validateData()` routine and completes the custom `GoalAreaTask`. Figure 25-31 displays the Project Properties window that contains the information that was entered in the custom Project Guide.

![Project Properties](image)

**Figure 25-31:** The Project Properties dialog box displays the information that was entered in the custom Project Guide.

**Deploying the customized Project Guide**

Once you have created a custom Project Guide, you need to configure Project to use the custom guide. Each user can select the Interface tab in the Options dialog box to point Project to the custom Project Guide. Another convenient way to ensure that a project references the correct Project Guide is to set the options within a project template, and any new project that is based on the template will use the correct Project Guide.
Summary

This chapter presented an introduction to VBA, particularly as you can use it in Project. You learned that VBA forms the foundation for macros and that you can easily produce VBA code by recording a macro. You followed through three examples of creating and modifying VBA code. In the first example, you created a filter to see critical tasks and their resource assignments. In the second example, you used code to adjust work. In the third example, you saw how to customize the Project Guide so that you can modify it to function the same way that your organization works.

In Chapter 26, you explore importing and exporting Project information.
Importing and Exporting Project Information

Sometimes you need to move information in and out of Project. Although you can do this by copying and pasting the information, you’ll find that you make these moves primarily by using Project’s import and export functions. You can import and export information using various file formats. For example, you can export a Project schedule as a graphic image to use in a graphics program or on a Web page, or to print on a plotter.

Note

You can import tasks from Outlook into Project.

Occasionally, you may find it convenient to start a project in an Excel workbook or Outlook’s Task List.

Note

Project 2003 contains a new wizard that enables you to generate an XML file.

Understanding General Importing and Exporting Concepts

Importing is the process of bringing information into a Project file from another program. Exporting is the process of sending information from Project to another program. When you import or export information, you use an import/export map. Project comes with a series of useful import/export maps that you can edit if necessary, or you can create a custom map. To view, copy, or edit any of the predefined import/export maps, or to create your own map, you use the Import/Export Wizard.
Think of an import/export map as a template that Project uses to correctly translate information from one program to another. An import/export map defines the information that you want to import or export and enables you to describe how to match the information in the Project file with the information in the other program’s file. For example, when you charted earned value in Excel in Chapter 14, you selected the Earned Value Information export map to send the data to Excel. This mapping information told Project what data to send to Excel for charting and how to identify the information in Excel. Whenever you import or export, you can use one of the predefined maps that comes with Project, or you can create a new map. Because the wizard walks you through the process, creating a new map is fairly easy to do.

Exporting Information

You can export information to Microsoft Office products, such as Excel workbooks, Access databases, or Word documents. You also can export some Project information to graphic images that you can use in a graphics program or as an image on a Web page. And you can export information to XML, text (.TXT) files or comma-separated value (.CSV) files.

Although the steps for each file type vary slightly, the process for importing or exporting is generally the same.

Exporting to Office files

You can export information to Excel workbooks or to Access databases. You can also include Project information in Word, but you don’t use the export process.

Sending Project data to Excel

Using the Import/Export Wizard, you can easily send information to Excel. The wizard gives you the choice of creating a new map or using an existing map. Follow these steps to start the process of sending information to Excel:

1. Open the Project file that contains the information that you want to export.
2. Choose File ➪ Save As to open the Save As dialog box.
3. Type a name in the File name list box for the file that you want to export.
4. Open the Save as type list box, and select Microsoft Excel Workbook or Microsoft Excel PivotTable.

When you create an Excel PivotTable file, Project creates two sheets in the workbook for each type of data that you export. One sheet contains the data that is used in the PivotTable, and the other sheet contains the PivotTable. Project uses the last field in each map as the default field for the PivotTable, and all the other fields appear as rows in the PivotTable.
5. Click Save. Project starts the Export Wizard. Click Next.

6. Choose Selected Data, and click Next.

   You can choose Project Excel Template to export the entire Project file to Excel.

7. Choose New map or Use existing map.

   If you choose Use existing map, you see the Map Selection dialog box, as shown in Figure 26-1.

![Figure 26-1: Use this dialog box to select the map that you want to use to export your data.](image)

8. Select a map, and click Next. The Export Wizard displays the Map Options dialog box.

9. Select the type of data to export, as shown in Figure 26-2. The boxes that you select determine which wizard screens will subsequently appear when you click Next.

   The map you selected in Step 8 contains a predefined collection of data. The boxes you check in Step 9 identify the type of data to export within the predefined collection.

   If you want your Excel workbook to contain assignments that are listed under tasks or resources, similar to the Task Usage or Resource Usage views, select the Include assignment rows in output check box.
10. When you click Next, you see one of the mapping dialog boxes. In this example, I selected Tasks in the Map Options dialog box. The Task Mapping dialog box appears, as shown in Figure 26-3, and includes the following functions:

**Figure 26-3:** As you add fields in the Task Mapping dialog box, a preview of the Excel worksheet that you’re creating appears at the bottom of the Task Mapping dialog box.
- **Destination worksheet name:** This box contains the name that Excel will assign to the sheet in the workbook. You can change this name.

- **Export filter:** Use this list box to select the tasks that you want to export. By default, Project assumes that you want to export all tasks, but you can export, for example, only completed tasks.

- **From: Microsoft Office Project Field:** Under this column, click (Click here to map a field) or any blank cell to add fields to export one at a time. After you click, you can use the list box arrow that appears to view a list of the fields that are available for exporting and to select a field.

- **To: Excel Field:** Select a field to export, and click the column next to the field that you added. Project suggests a column heading for the field in the Excel worksheet; you can change this heading.

- **Data Type:** You can’t change the data type for the field in the destination program, which appears in this column.

- **Add All:** To quickly add all the fields in the Project file, click the Add All button.

You can export a maximum of 255 fields to Excel for each type of data. Project contains over 700 task fields and over 400 resource or assignment fields. So, if you choose Add All, you will have to delete some of the fields before Project will allow you to proceed to the next step in the wizard.

- **Clear All:** To remove all the fields that you added, click the Clear All button.

- **Insert Row:** If you decide to add a field between two existing fields, click the row that you want to appear below the new field. Then click the Insert Row button, and Project inserts a blank row above the selected row.

- **Delete Row:** To delete a field, click anywhere in the row that contains the field and click the Delete Row button.

- **Base on Table:** To add all the fields in a particular Project table, such as the Entry table or the Cost table, click the Base on Table button. Project displays the Select Base Table for Field Mapping dialog box, from which you can select a table. When you click OK, Project adds all fields that are contained in that table to the list of fields that you want to export.

- **Move:** You can use the Move buttons on the right side of the dialog box to reorder fields. Click the field that you want to move, and then click either the Move Up arrow or the Move Down arrow.

If you selected the Resources and the Assignments check boxes as well as the Tasks check box in the Map Options dialog box (shown previously in Figure 26-2), when you click Next, the Export Wizard displays additional boxes that are almost identical to the Task Mapping dialog box, but for each of these data types.
11. After you finish defining your map, you see the final box of the Export Wizard, as shown in Figure 26-4. If you elect to save your map by clicking the Save Map button, Project displays the Save Map dialog box, as shown in Figure 26-5. Provide a name for the new map in the Map name text box.

![Figure 26-4: In the final dialog box of the Export Wizard, choose whether to save the map that you've defined.](image_url)

![Figure 26-5: If you decide to save the map, provide a name for it in the Save Map dialog box, which displays a list of all existing maps.](image_url)

**Sending Project data to an Access database**

You can export some or all of the information in a Project file to an Access 97 or later database file using the Export Wizard and an export map. If none of the existing maps can export data into the proper fields in your Access database, you may need to create a new map.
Because Access tables are conceptually the same as Excel worksheets—both consist of data that is organized in rows and columns—you will notice that the process for exporting Project information to Access sounds suspiciously like the process for exporting Project information to Excel. And you are right!

When you export to any database format, Project makes the following changes to the names of some fields in the database to ensure compatibility with database field naming conventions:

- Underscores (_) replace spaces and forward slashes (/).
- The string Percent replaces the percent sign (%).
- Periods are deleted.
- Start changes to Start_Date.
- Finish changes to Finish_Date.
- Group changes to Group_Name.
- Work changes to Scheduled_Work.

You can append Project information to an existing Access database. However, you should make sure that you have a backup copy of the database, just in case the information doesn’t appear the way that you expect in Access. You may even want to create a test copy of your database and use the copy to ensure that Project information appears in the correct fields.

Follow these steps to export Project information to a file in Microsoft Access database format:

1. Open the Project file that contains the data that you want to export.
2. Choose File ➪ Save As to open the Save As dialog box.
3. Open the Save as type list box, and select Microsoft Access Database.
4. Type a name in the File name box for the file that you are exporting.
5. Click Save. Project starts the Export Wizard.

If you selected an existing Access database, Project displays the Existing Database screen of the wizard, where you can choose to append information to an existing database or overwrite that database.

6. On the Data screen of the Export Wizard, select the A full project option button or the Only selected data option button and click Next.

If you select the A full project option button, the Project Definition dialog box appears, as shown in Figure 26-6. Type a name for the project in the Project name box, and click Finish.

Once you save the entire project in an Access database you can use it instead of the “mpp” file.
If you select the Only selected data option button, the Map dialog box of the Export Wizard appears, where you can choose to create a new map or use an existing map.

7. If you choose to use an existing map, you see the Map Selection dialog box, as shown in Figure 26-7. After you select a map and click Next, the Export Wizard displays the Map Options dialog box.

Figure 26-6: When you export your entire project to Access, you supply a name for the project in this dialog box.

Figure 26-7: Use this dialog box to select the map that you want to use to export your data.
If you choose to create a new map, you don’t see the Map Selection dialog box. Instead, when you click Next, you see the Map Options dialog box, as shown in Figure 26-8.

![Figure 26-8: Select the type of data to export in the Map Options dialog box.](image)

8. Select the type of data to export. (The boxes that you select determine which Wizard screens will appear when you click Next.)

9. When you click Next, you see one of the mapping dialog boxes. In this example, I selected the Tasks check box in the Map Options dialog box. The Task Mapping dialog box appears, as shown in Figure 26-9, and includes the following functions:

- **Destination database table name**: This box contains the name that Access will assign to the table in the database. You can change this name.

- **Export filter**: Use this list box to select the tasks that you want to export. By default, Project assumes that you want to export all tasks, but you can export, for example, only completed tasks.

- **From: Microsoft Office Project Field**: Under this column, click (Click here to map a field) to add fields to export one at a time. After you click this option, you can use the list box arrow that appears to view a list of fields that are available for exporting and to select a field.

- **To: Database Field**: Select a field to export, and click the column next to the field that you added. Project suggests a column heading for the field in the Access table; you can change this heading.
Figure 26-9: As you add fields in the Task Mapping dialog box, a preview of the Access database table that you're creating appears at the bottom of the Task Mapping dialog box.

- **Data Type:** You can't change the data type for the field in the destination program, which appears in this column.
- **Add All:** To quickly add all the fields in the Project file, click the Add All button.

You can export a maximum of 255 fields to Access for each type of data. Project contains over 700 task fields and over 400 resource or assignment fields. So, if you choose Add All, you will have to delete some of the fields before Project will allow you to proceed to the next step in the wizard.

- **Clear All:** To remove all the fields that you added, click the Clear All button.
- **Insert Row:** If you decide to add a field between two existing fields, click the row that you want to appear below the new field. Click the Insert Row button, and Project inserts a blank row above the selected row.
- **Delete Row:** To delete a field, click anywhere in the row that contains the field and click the Delete Row button.
- **Base on Table:** To add all the fields in a particular Project table, such as the Entry table or the Cost table, click the Base on Table button. Project displays the Select Base Table for Field Mapping dialog box, from which you can select a table. When you click OK, Project adds all fields that are contained in that table to the list of fields that you want to export.
- **Move:** You can use the Move buttons on the right side of the dialog box to reorder fields. Click the field that you want to move, and then click either the Move Up arrow or the Move Down arrow.
If you selected the Resources and the Assignments check boxes as well as the Tasks check box in the Map Options dialog box (shown previously in Figure 26-8), when you click Next, the Export Wizard displays additional boxes that are almost identical to the Task Mapping dialog box, but for each of these data types.

After you finish defining your map, you see the final box of the Export Wizard in which you can elect to save the map that you just defined. If you elect to save your map by clicking the Save Map button, Project redispers the Save Map dialog box. Provide a name for the new map in the Map name text box.

**Sending Project data to Microsoft Word**

Although you can't export Project data directly into Word, you can use the Windows Copy and Paste commands to incorporate Project text or table data into a Word file. For example, you can copy the columns in any table to a Word document. Start in Project, and follow these steps to send Project data to Word:

1. Open the file that contains the information that you want to incorporate into a Word document.

2. Select the information. You can copy text information from the Notes tab of either the Task Information dialog box or the Resource Information dialog box. In addition, as shown in Figure 26-10, you can copy table columns.

3. Click the Copy button on the Standard toolbar.

![Figure 26-10: Select information to copy to Word.](image-url)
4. Open or switch to Word.

5. Position the insertion point where you want the Project information to begin.

6. Click Paste. The Project information appears in Word.

As shown in Figure 26-11, table information appears in Word as tab-separated columns. Using Word’s Convert Text to Table feature (select the data, and choose Table ➪ Convert ➪ Text to Table), you can convert the information into a Word table.

If you save a Project file as an HTML file, Project uses the Export Wizard to help you save the table portion of the file in a nice format that you can open in Word and then save as a Word .doc file. See “Saving Project files as Web pages” later in this chapter for information on using the Export Wizard to create an HTML file.

**Exporting Project information to a graphic image**

You can create a picture from your Project information and view the picture in any graphics program or save the picture in a Web-compatible file format. When you use the following technique, you copy Project information to the Windows clipboard. You can copy all or part of any view except the Task PERT, Task Form, and Resource Form views. Follow these steps to create a picture from Project information:
1. Select the view of which you want a picture.

2. Tell Project how much of your plan to copy. To copy only a portion of your plan, select the information that you want to copy. To copy all visible portions of your plan, click the Copy Picture button on the Standard toolbar. The Copy Picture dialog box appears, as shown in Figure 26-12.

![Copy Picture dialog box](image)

**Figure 26-12:** Use the Copy Picture dialog box to describe how you want to copy the picture.

3. In the Render image section, select from the following option buttons to specify how you want Project to copy the picture:
   - **For screen**: Select this option to copy the information for display on a computer screen.
   - **For printer**: Select this option to copy the information for a printer to use.
   - **To GIF image file**: Select this option to save the information as an image that you can use on a Web page and in other programs. Be sure to specify the path and filename in the box below this option.

4. (Optional) If you selected rows before you started this process because you want to copy only those rows, select the Selected rows check box.

5. (Optional) To copy information for a range of dates other than those currently displayed, select the Date option button (the last one in this dialog box) and then enter From and To dates.

6. Click OK.

To view an image that you copied as a screen or printer image, switch to the program in which you want to display the Project information and then paste the picture by using the program’s Paste command. A copied image in Microsoft Paint appears in Figure 26-13.
Figure 26-13: A Project image that has been pasted into Microsoft Paint.

Exporting to other formats

To export information to a program that can read either text files or XML files, create an export file that the receiving program can read. Text files come in two varieties: Files that can be read by word processing programs are plain text files, and files that can be read and converted into data by other programs are called comma-separated value (.CSV) files or ASCII, comma-delimited files. When you export to XML, Project exports the entire file except fields that contain null values, and maps the data automatically, without using the Export wizard.

If the program to which you want to export information supports the Microsoft Access database format (.MDB files), you should use that format for the best results when you import the information that you exported from Project. If you are creating an interface to another program consider using XML, since Microsoft has made XML a key technology of the Office 2003 set of products.

Exporting to text files

If you have a program that can read either a text file or a CSV file, you can export information from Project to that program. You need to save the information that you want to export as either a text file or a CSV file in Project.
This process uses the Export Wizard and closely resembles exporting information to Excel or Access.

Follow these steps to export information to a text file:

1. Open the Project file that contains the information that you want to export.
2. Choose File ➪ Save As to open the Save As dialog box.
3. Select Text or CSV, whichever format works best in the program to which you’re exporting, in the Save as type box.
4. Type a name in the File name box for the file that you are exporting.
5. Click Save. The Export Wizard begins. Click Next.
6. Choose to create a new map, and click Next. Project displays the Map Options dialog box, as shown in Figure 26-14.

![Figure 26-14: Select the options for the export map.](image)

*Note*

If you choose to use an existing map, Project displays a list of available maps. Choose one and click Next to display the Map Options dialog box. If you choose to create a new map, you don’t see the list of available maps.

7. Select the options for the export map, and click Next. You see one of the mapping dialog boxes. The one(s) that you see depends on the information that you chose to export. Refer to the sections “Sending Project data to Excel” and “Sending Project data to an Access database,” earlier in this chapter, for details on completing this dialog box.
8. Click Next, and complete the additional mapping dialog boxes as appropriate. You can click the Save Map button to save the map that you created.

**Exporting to other project management software**

You can use the .MPD file format to export Project 2003 information to older versions of Project. Some other project management software packages also support .MPD files, so if you need to export Project information to another project management software package, you can save it as an .MPD file.

To export information in MPD format, follow these steps:

1. Choose File ➪ Save As.
2. In the Save As dialog box, open the Files of type list box and select MPD.
3. In the File name box, supply a name for the file that you want to export.
4. Click Save, and Project displays the Project Definition dialog box, which suggests a name for the Project.
5. Click Finish.

The Microsoft Project database (.MPD) file format has replaced the .MPX file format. You can use the .MPD file format with any program that supports either the .MPD file format or Microsoft Access database formats.

**Saving Project files as Web pages**

Suppose that you want to include information from your schedule within an HTML document—for example, as a page on a company intranet or a corporate Web site. To do so, you must save the project file in HTML format. This process uses the Export Wizard and closely resembles exporting Project information to Excel, Access, or a text file.

To save project information in HTML format, follow these steps:

1. Choose File ➪ Save As Web Page to open the Save As dialog box.
2. Type a new filename, or accept the default of your project filename with the .html extension. Click Save. Project starts the Export Wizard.
3. Choose to create a new map. Project displays the Map Options dialog box, as shown in Figure 26-15.

If you choose to use an existing map, Project displays a list of available maps. Choose one and click Next to display the Map Options dialog box. If you choose to create a new map, you don’t see the list of available maps.
4. Choose the options for the export map, and select any of the following HTML options check boxes:

- **Export header row/Import includes headers**: Includes the row of field titles in the HTML file.

- **Include assignment rows in output**: Includes rows that contain information about resource assignments in the file.

- **Base export on HTML template**: Enables you to use a template that applies a predesigned look to the HTML document.

- **Include image file in HTML page**: Enables you to include a graphic file in the HTML document.

5. Click Next. You see one of the mapping dialog boxes; the one(s) that you see depends on the information that you chose to export. Refer to the sections “Sending Project data to Excel” and “Sending Project data to an Access database,” earlier in this chapter, for details on completing this dialog box.

6. Click Next, and complete the additional mapping dialog boxes as appropriate.

You can click the Save Map button to save the map you create.

Figure 26-16 shows a Project file in HTML format. When you save a file in this format, you can publish the file as a Web page by using any Web page design and management software.
Creating XML files from Project data

XML (Extensible Markup Language) is a markup language for structured documents. When a document is structured, you can tell the purpose of its content based on where the content appears in the document. A structured document will contain elements such as body text, section headings, headers, footers, figures, figure captions, and footnotes. Almost all documents have some structure. A markup language provides a means to identify the structures in a document, and XML defines a standard way to mark up documents.

You use XML so that richly structured documents can be used on the Internet. XML differs from HTML because, in HTML, tag semantics and tag sets are fixed, while XML specifies neither tag semantics nor tag sets. XML enables you to define tags and the structural relationships between them using either the applications that process them or using style sheets.

In Project, you can use the XML Reporting Wizard to create an XML file from Project data. The XML Reporting Wizard uses an XSL template to create an XML file, and the sample templates that come with Project generate HTML documents. You can use the XML file created by the wizard to create custom reports in any format you want. You also can create your own XSL templates.
The XML Wizard is new to Project 2003.

The reports you create cannot display Project views; they are limited to displaying Project data.

To create an XML file and an HTML report, follow these steps:

1. Display the Analysis toolbar by right-clicking any toolbar and choosing Analysis from the menu that appears.

2. Click the XML Reporting Wizard button. Project starts the wizard (see Figure 26-17).

Figure 26-17: The first box of the wizard explains the process you’re about to follow.

3. Click Next. From the Specify XML File box (see Figure 26-18), you can choose to create a new XML file from the active project or use an existing file to create the report.

Figure 26-18: Choose to create a new XML file or use an existing one.
If you choose to create a new file, Project displays the Save Project as XML File box and asks you for a filename.

If you choose to use an existing file and click the Browse button, Project displays the Open XML File box, which you use to navigate to the XML file.

For this example, I chose to create a new file.

4. In the Select the Transform To Apply box (see Figure 26-19), click the Browse button. Project displays the Select XSL/T Template box, from which you can select an existing XSL template on which to base the report. This box works like an Open dialog box; select a template and click Open. When Project redisplay the Select the Transform To Apply box, click Next.

5. In the Complete the Report box (see Figure 26-20), you can preview your report in Internet Explorer and save your report to an HTML file.

6. After you preview and/or save your report, click Finish to close the wizard.
Importing Information

You can bring information into Project from another Project file or from Microsoft Excel, Microsoft Access, or Microsoft Word. You also can import information that was created in any program that can save text (.TXT) files or comma-separated value (.CSV) files. When you import a Project file, you actually consolidate two Project files. When you import non-Project files, you use an import/export map to define the data that you want to import.

You can import XML files into Project. In the Open dialog box, select the XML file. Project launches the Import Wizard, where you make one choice: You choose to append the data in the file to the active project, merge the data in the file with the data in the active project, or import the file as a new file.

Inserting another project

When you import one Project file into another, you don’t use an import/export map. Instead, importing one Project file into another Project file is the same as consolidating Project files, which you read about in Chapter 15.

Importing Office files

You can import information from Excel workbooks, Access databases, or your Outlook Task List by using the Import Wizard and maps that define the way that the information should be viewed by Project. You can also include information from Word, but you don’t use the import process.

Bringing Excel workbook information into Project

Want to start your project in Excel? You can use the Excel template and then easily transfer the information from Microsoft Excel workbooks to Microsoft Project files. The Excel template automatically installs to the Office template folder (drive:\Program Files\Microsoft Office\Templates\1033) and is available in the Templates dialog box in Excel.

The Excel template made its appearance in Project 2002.

You can use any of the existing import/export maps to either import to or export from an Excel workbook, but you can’t import an Excel PivotTable into Project.

Follow these steps to transfer Excel information to Project:

1. Open Excel, and choose File ➤ New.
2. From the New Workbook task pane, click General Templates. Excel displays the Templates dialog box, as shown in Figure 26-21.
3. Click the Spreadsheet Solutions tab.

4. Choose Microsoft Project Task List Import Template. The workbook that you see looks like the one shown in Figure 26-22.

![Image of Spreadsheet Solutions tab](image1)

**Figure 26-21:** You find the Excel template on the Spreadsheet Solutions tab of the Templates dialog box.

![Image of Excel workbook](image2)

**Figure 26-22:** An Excel workbook that's based on the Microsoft Project Task List Import Template.
The first time that you use the template, you may be prompted for your Project CD so that the template can be installed.

If you already started your project in Excel without using the template, you can still use the Import Wizard to bring your Excel data into Project. Follow these steps to do so:

1. In Project, choose File ➪ Open or click the Open button on the Standard toolbar.

2. Open the Files of type list box, and select Microsoft Excel Workbooks, as shown in Figure 26-23.

![Figure 26-23: Set the type of file that you want to import to Microsoft Excel Workbooks.](image)

3. Use the Look in list box to navigate to the folder that contains the Excel workbook that you want to import.

4. Highlight the workbook, and click Open. Project starts the Import Wizard.

5. Click Next. In the Map dialog box, choose New map.

   If you choose the Use existing map option, Project displays the list of maps from which you can choose. After you select a map, Project imports your data.

6. Click Next. In the Import Mode dialog box, select the As a new project option button.

   If you select the Append the data to the active project option button, Project imports the data and places it after any existing tasks in the Project file. If you select the Merge the data into the active project option button, you'll complete Steps 7 and 8, but in the Task Mapping dialog box, you'll click the Set Merge Key button to identify the field that's found in both the Excel file and the Project file.
7. Click Next. In the Map Options dialog box, select the types of data that you want to import, as shown in Figure 26-24.

![Import Wizard - Map Options](image)

**Figure 26-24:** Select the types of data that you want to import.

8. Click Next. If necessary, make changes to the Task Mapping dialog box, as shown in Figure 26-25. Select the Source worksheet name; Project attempts to resolve the column names in the worksheet with Project fields. Look for fields that have "(not mapped)" in the To: Microsoft Office Project Field. Type in the Project field name or select it from the list that appears when you click in the To: Microsoft Office Project Field. You should also verify the mapping of all fields the first time you use a new Map. If you used Name in Excel as the column title, you will get unexpected results, because Project uses Resource Name and Task Name, but not Name.

For a complete list of the functions of each field in this dialog box, see the section “Sending Project data to Excel,” earlier in this chapter.

9. Click Next. You see the final box of the Export Wizard, in which you can elect to save the map that you just defined.

Note

If you selected the Resources and the Assignments check boxes as well as the Tasks check box in the Map Options dialog box (shown previously in Figure 26-20), when you click Next, the Export Wizard displays additional boxes that are almost identical to the Task Mapping dialog box, but for each of these data types.

10. If you elect to save your map by clicking the Save Map button, Project displays the Save Map dialog box. Provide a name for the new map in the Map name text box.
Figure 26-25: The Task Mapping dialog box shows the fields that Project expects to import from your workbook.

Bringing Access database information into Project
Importing Access databases into Project is similar to importing Excel workbooks, except that you can import all or part of an Access database into a Project file. Again, you use an import/export map to describe to Project the type of data that you're importing. If the map that you need doesn't exist, you must create it. Refer to the section “Sending Project data to an Access database,” earlier in this chapter, for details about creating maps.

To import some or all of an Access database into Project, follow these steps:

1. Choose File→Open, or click the Open button on the Standard toolbar.
2. Open the Files of type list box, and select Microsoft Access Databases.
3. Use the Look in list box to navigate to the folder that contains the Access database that you want to import.
4. Highlight the database, and click Open. Project starts the Import Wizard.
5. Click Next. In the Map dialog box, choose New map.

   If you choose the Use existing map option, Project displays a list of available maps from which you can choose. After you select a map, Project imports the Access file.

6. Click Next. In the Import Mode dialog box, select the As a new project option button.
If you select the Append the data to the active project option button, Project imports the data and places it after any existing tasks in the Project file. If you select the Merge the data into the active project option button, you'll complete Steps 7 and 8, and in the Task Mapping dialog box, you'll click the Set Merge Key button to identify the field that's found in both the Excel file and the Project file.

7. Click Next. In the Map Options dialog box, select the types of data that you want to import.

8. Click Next. If necessary, make changes to the Task Mapping dialog box,

If you selected Merge the data into the active project in Step 6, you need to tell Project how to link the Access table with the project tasks. Highlight the field you will use to merge, typically the ID, and then click the Set Merge Key button.

9. Click Next. You see the final box of the Export Wizard, in which you can elect to save the map that you just defined.

10. If you elect to save your map by clicking the Save Map button, Project displays the Save Map dialog box. Provide a name for the new map in the Map name text box.

**Bringing Outlook task lists into Project**
Perhaps you started a task list in Outlook’s Task List, and now you realize that your list of tasks is really a project and you need the scheduling and cost features in Project. You don’t need to start over — you can import the Outlook Task List into Project. Follow these steps to do so:

1. In Project, choose Tools→Import Outlook Tasks. Project displays the Import Outlook Tasks dialog box, as shown in Figure 26-26.

2. Check the tasks that you want to import, and click OK. The tasks appear in Project. If the open project already contains tasks, the Outlook tasks are appended to the task list.

**Bringing Word document information into Project**
Unlike other types of files, you can’t import Word files directly into Project. You can, however, include information in Word documents in a Project file by using one of the following techniques:

✦ You can paste information.
✦ You can link or embed information.
Figure 26-26: In this dialog box, mark the tasks that you want to import into Project.

Pasting information from Word into Project
When you use the paste method, you can paste the information either into a table view or into a note in Project. Pasting eliminates the extra step of retyping information.

If you paste text into blank rows, Project treats the information as new tasks or resources. If you paste information into fields that already contain information, Project replaces the information in those fields with the pasted information. However, you can’t paste information into Project fields that contain calculated values, such as some of the fields in a cost table.

You can use the following technique to paste information from an Excel workbook into a Project table view, but first you must organize the information in your workbook to match the organization of a Project table. For example, suppose that you want to paste information into a resource sheet with the Entry table applied. Your workbook has 3 columns, but the resource sheet has 12 columns, and you want to paste the information into Columns 2, 5, and 8.

To paste this information, you need to create and apply a table in Project that displays only the fields that you intend to paste from your workbook. Make sure that the order and type of columns in the Project table match the order and type of information in the Excel table that you’re pasting.
To paste information from Word into a Project table, follow these steps:

1. Open the Word document from which you want to copy information, and then copy the information to the Windows clipboard, as shown in Figure 26-27.

2. Switch to Microsoft Project.

3. Switch to the view into which you want to paste the information. If necessary, choose View ➪ More Views. From the More Views dialog box that appears, select the view that you need and then click Apply.

4. Select the table into which you want to paste information by choosing View ➪ Table ➪ More Tables. Choose the table that you want from the More Tables dialog box, and then click Apply.

5. (Optional) If the table that you select has columns that you don’t need or is missing columns that you do need, you can add or hide columns. You can also add rows if necessary.

6. Click the first field in which you want information to appear after you paste.

7. Click the Paste button on the Standard toolbar. The information that is stored on the Windows clipboard appears in the Project table, as shown in Figure 26-28.
You can paste information from a Word document into a note in Project by using the same technique. Copy the information in Word to the Windows clipboard. Switch to Project, and double-click either the task or the resource to which you want to add a note. In the Task Information or Resource Information dialog box that appears, click the Notes tab. Then right-click the Notes area to display a shortcut menu, shown in Figure 26-29, and choose Paste. The information from Word appears in the Notes area.

**Linking or embedding a Word document in Project**

When you link or embed a Word document in Project, you actually insert the document as an object in your Project schedule, as follows:

- When you link a Word document to a Project file, the Project file reflects any changes that you make to the Word document.
- When you embed a Word document in a Project file, the Project file does not reflect subsequent updates to the Word document.

Project views objects that you insert as graphics. Therefore, you can link or embed a Word document as a graphic element in any graphics area of a Project file. A **graphics area** is any area in Project that can display picture information, including task, resource, or assignment notes; headers, footers, and legends in views; headers and footers in reports; the chart portion of the Gantt view; and the Objects box in a task or resource form.
Figure 26-29: You can use a shortcut menu to paste information from the Windows clipboard into a task or resource note.

To insert a Word document as a linked or embedded object, follow these steps:

1. Open a Microsoft Project file, and display the graphics area into which you want to insert a document.

2. Open the Insert Object dialog box, as shown in Figure 26-30.

Figure 26-30: Use the Insert Object dialog box to link a Word document to a Project file or embed a Word document in a Project file.

Tip

To open the Insert Object dialog box in a task, resource, or assignment note, right-click to display a shortcut menu and choose Object. To open the Insert Object dialog box in the Gantt Chart view or Objects box, choose Insert ➤ Object.
3. Select the Create from File option button.
4. Type in the path and filename of the document that you want to insert, or click Browse to locate and select the file.
5. Do one of the following:
   • To link the object to the source document, select the Link check box.
   • To embed the object, deselect the Link check box.
6. Click OK. Project displays a graphic image of your file, as shown in Figure 26-31.
   You can use the handles around the image in the Task Information dialog box to move or resize the image.

   ![Figure 26-31: A Word document inserted as a graphic image in a task note.](image)

   By default, Project displays the contents of the file that you insert rather than an icon that represents the file. To display the object as an icon, select the Display As Icon check box in the Insert Object dialog box.

   You can delete the object by making sure that you see the handles that surround it and pressing Delete.

   After you click OK, an icon appears in the Indicator column. When you slide the mouse over that icon, however, you don't see the contents of the note in the tip because it is a graphic image. Instead, you see a pair of single quotation marks, as shown in Figure 26-32.
Importing other files

If the information that you want to import comes from a program that can produce either text files or Microsoft Project Exchange files, you can import that information. Text files, a common format, are also called comma-separated value (.CSV) files. Microsoft Project Exchange (.MPX) files are of the ASCII, record-based file format.

Importing Microsoft Project Exchange files

You can use the MPX file format to import information from older versions of Project into Project 2003. Some other project management software packages also support the MPX file format, so if you need to import information from another project management software package, you can save it as an MPX file and import it into Project. Importing an MPX file is similar to opening any project. Follow these steps to import an MPX file:

1. Choose File ➪ Open.
2. In the Open dialog box, open the Files of type list box and choose MPX.
3. Use the Look in list box to navigate to the appropriate file, and click Open.
The currently recommended method of interchanging project data with other products is XML.

**Importing text files**

If you have a program that can create either a text file or a comma-separated value file, you can import information from that program into Project. You need to save the information that you want to import as either a text file or a CSV file in the native program. The Import Wizard walks you through the process. If the map that you need doesn’t exist, you need to create it.

Follow these steps in Project to import the information:

1. Choose File ➪ Open, or click the Open button on the Standard toolbar.
2. Open the Files of type list box, and choose Text (*.txt) or CSV (*.csv).
3. Use the Look in list box to navigate to the folder that contains the file that you want to import.
4. Highlight the file, and click Open. Project starts the Import Wizard.
5. Choose an existing map or create a new one. See the section “Bringing Excel Workbook information into Project,” earlier in this chapter, for details.

**Troubleshooting**

Importing and exporting can be tricky operations. Little things go wrong that cause these operations to fail. This section suggests ways to solve some of the problems that you may encounter while importing or exporting.

On a general note, use some common procedures when you export or import data. For example:

- Create a table on which to base your export/import map.
- Include unique identifier fields in export/import maps whenever possible to ensure traceability.
- Include descriptive fields to make the export/import easy to read.
- When updating existing project data, first import to a new project and use the Compare Project Versions utility to confirm correct mappings. Display the Compare Project Versions toolbar and click the Compare Project Versions button. Project displays the box you see in Figure 26-33. Select the two projects and the task and resource tables to compare.
- Save the Map so that you can compare it easily.

None of the above techniques are trouble-free, but getting in the habit of creating repeatable and verifiable maps will help you avoid many problems.
Figure 26-33: Use this box to select two projects to compare.

Project imports incorrect times in data from Microsoft Excel

In Excel, when you assign a date to a cell, Excel assigns a default time to the cell of 12:00 a.m. You may not see that time, but Excel has attached it to the cell. If the data that you import from Excel to Project contains dates without specific times, Project automatically uses Excel’s default time of 12:00 a.m. If you don’t want to use Excel’s default time in Project, enter times in Excel before you import.

Linked or embedded objects don’t import or export

You’re not imagining things. Project does not import or export linked or embedded objects when exchanging data with Microsoft Excel, Microsoft Access, or HTML. You need to relink or re-embed the objects after you complete the import or export operation.

The export file contains more or less information than expected

The information that you find in your exported file depends on the import/export map that you select, the table that you choose, and the filter that you apply. If you export more or less information than you expect, check the map, table, and filter.

Export/Import Maps are created and edited using the Export Wizard; you won’t find an “Edit Map” menu command or button. To troubleshoot an existing map choose...
File: Save As and specify a filename and file type to start the Export Wizard. On the Export Wizard – Map dialog box select Use existing map and click Next. On the Export Wizard – Map Selection dialog box, select the map that was used to generate the export file that is in question and click Next. On the Export Wizard - Map Options dialog box, do not change any settings; simply click Next. Review the fields selected and the Export Filters on the Task, Resource, or Assignment Mapping dialog boxes.

**Project imports invalid information**

Project checks data that you import to ensure that the data types for each field are valid. If necessary, Project may modify the values of some fields to handle inconsistencies.

If Project warns that you are trying to import invalid data, check the import/export map that you’ve selected to make sure that you are importing the correct type of information into a Project field. Also, check the data in the import file, and make sure that the field values are valid and within the acceptable range for the Project field into which you intend to import the data.

**The values of imported information change**

This situation is similar to the previous one, where Project determines that the information that you’re trying to import is invalid. Project checks (and changes, if necessary) the data that you import to ensure that the data types and the values for each field are valid. Project may also change data to make sure that it falls within ranges that are valid for Project fields and doesn’t create inconsistencies between fields that depend on each other. Project also overrides values that you attempt to import into calculated fields by replacing the imported data with the calculated value.

**The imported project is empty**

As you know, importing depends on the import/export map that you select. If you choose the wrong map, no data may import. Also, make sure that you’re looking at the correct view after importing. If you import task information, you may not see it if you’re looking at a resource view.

**Project displays imported information in the wrong fields**

When imported information appears in the wrong Project field, you should check the import/export map. Make sure that you select the correct map and that the table you used contains the correct fields. Finally, check the mapping of the fields between the import file and your Project file.
Summary

In this chapter, you found out how to import and export information in Microsoft Project. In particular, you should now know how to do the following:

✦ Create and edit import/export maps
✦ Export information to Excel, Access, and Word
✦ Export information to graphics files, text files, HTML files, and other project management software files
✦ Import information from another project; from Excel, Access, or Word; or from text files
✦ Solve common problems that occur when you export or import information
In this chapter, I provide ten case studies featuring the use of Project 2000, Project 2002, and Project 2003 — sometimes in conjunction with an add-on product — to solve real-life problems. Also, I deliberately included cases that run the gamut from small businesses to large corporations. For example, in one case you’ll read about a non-profit organization that used Project to solve a problem.

Case 1

DEA Brown & Sharpe, part of Hexagon Metrology, the leading producer of coordinate measuring systems with world headquarters in Heathrow, UK, serves the measurement needs of industrial companies around the globe. DEA Brown & Sharpe offers the most complete source for metrology products anywhere in the world. Coordinate measuring machines, precision measuring instruments, software and post-warranty aftermarket services that keep measuring systems operating at peak performance levels are all available through a worldwide distribution channel and strategically located precision centers. Hexagon Metrology Group is a multi-national group of companies that includes Brown & Sharpe GmbH, Brown & Sharpe Qianshao, CE Johansson, DEA, Mirai S.R.L, Quality Ltda, TESA, and Wilcox Inc.

The challenge faced by DEA Brown & Sharpe Limited was met by Technology Associates International, a global company with offices worldwide. Headquartered in the United Kingdom, Technology Associates is a Microsoft Project Premier Partner and a Microsoft Gold Certified Partner and specializes in Microsoft Project EPM solutions, services and deployment. The experience of Technology Associates in deploying Enterprise Project Management solutions across
global companies is very extensive and was a key factor in providing confidence to
tenior management that DEA Brown & Sharpe would be able to successfully imple-
ment such a mission-critical solution. DEA Brown & Sharpe Limited was the first UK
country to fully adopt the Microsoft Office Project 2003 EPM solution and was part
of the Early Adopters program.

**Problem statement**

To gain and preserve a competitive advantage, DEA Brown & Sharpe must continu-
uly deliver and develop new products for its customers and maintain an outstand-
ing level of customer service and support. When DEA Brown & Sharpe was faced
with the expansion of its business, the challenge of dealing with customer support
contracts and meeting the increasing demand for service personnel to be on site,
with the right skills and in the right location, within hours in some cases, was a big
problem in itself. But the same personnel also are involved in installation and com-
missioning of new machines all over the world, and it is vital to get the right people
at the right place at the right time. With over 200 different products and a range
that is increasing all the time, the problem was becoming ever more complex. In
addition, the Senior Management at DEA Brown & Sharpe wanted to control prod-
uct development projects more closely, especially from a financial perspective. DEA
Brown & Sharp needed a solution that could handle a complex mix of projects,
some long term development and manufacturing projects and some projects that
are very short term, service support projects. The system also had to be flexible,
customizable and very adaptable.

**Problem solution**

During the initial discussions, it quickly became apparent that Microsoft Office
Project 2003 would be the ideal solution, even though it was still in very early devel-
opment. Through Technology Associates International, DEA Brown & Sharpe was
invited to take part in the Rapid Adoption Program for Microsoft Office Project 2003
and they enthusiastically accepted. Once enrolled on the program, Technology
Associates worked closely with DEA Brown & Sharpe IT Manager Nick Ward and
members of the senior management team to complete the system design and initial
consultation process.

After considering the system design proposal, DEA Brown & Sharpe chose to imple-
ment Microsoft Office Project Professional 2003 and Microsoft Office Project Server
2003. Combined, these products make up the Microsoft Solution for Enterprise
Project Management (EPM).

One key aspect of the solution is the new feature in Microsoft Office Project 2003
called multi-value fields. To meet the demands for engineers to respond to service
calls for customers that may or may not have support contracts, it is vital that the
company is able to quickly respond to demands for on-site support and prioritize
those requests. The multi-value field provides an excellent way of setting up multiple skills for a service engineer — most service engineers can have skills in up to 40 different machines, out of a possible range of 200 or so. In addition, the level of skill required also had to be classified (Advanced or Competent) for each skill attributed to a resource.

Using multi-value fields, managers at DEA Brown & Sharpe can quickly identify the correct resources by matching a generic resource with the right machine skills to a list of named engineers with those skills. The Resource Breakdown Structure (RBS) also can be used to identify the location of service personnel by region, country, county or city. This process enables resources to be identified efficiently and effectively by geographical location, minimizing travel time and maximizing the engineers’ time on site.

Service logs, job cards and all relevant documentation can be uploaded and tracked using the document tracking mechanism provided by Microsoft Office Project Server 2003 and Windows SharePoint Services (WSS), which can be integrated into the solution. When you use WSS, each project has its own SharePoint web site so project managers and team members are able to maintain all relevant documentation for a project (including CAD drawings, photographs, specifications, quality documentation, control and change request documentation) in one easily accessible place. This collaborative workspace is easy for users to navigate to and utilize, and is truly the focus of all documentation and information concerning each program or project.

When site engineers visit client premises to assess the site and location of a new machine, they produce site surveys. Site surveys are vital, since some machines can weigh several tons and require special handling to ensure correct alignment of the large CMMs and avoid distortion of the precision-engineered table. Site engineers can arrive on site with a digital camera, take video footage and still photographs of the site, and then upload the pictures to the SharePoint web site for that project. The commissioning/installation team has ready access to this vital information almost instantly, and the whole process ensures an accurate transmission of key information to the people who really need it, which is backed up by actual photographic or video evidence. Microsoft Office Project 2003 Server helps to keep project information secure because project managers can decide that only people directly involved with the project can have access to the related documents.

Accessing key corporate management data is a breeze because the management team can obtain a global view of development projects and the resources involved in those projects. And, since the information is updated in real time, it is always accurate.

The solution uses customizable views such as the Project Center and Resource Center in Microsoft Office Project Web Access. This enables the management team to view high-level key performance indicators and then drill down to a more
detailed level if the information presented seems to warrant further investigation. Before using the Microsoft EPM solution, the management team did not have such strong visibility into ongoing projects, or have an effective control on costs or resource loading/capacity.

With a growing customer base, it is extremely important for DEA Brown & Sharpe to be able to determine if a certain project is on schedule and evaluate the impact of slippage or reduced resource availability. DEA Brown & Sharpe also wants to be able identify the number of engineering resources being used by a project and whether the project is a cost-effective investment in terms of ROI.

**Business Benefits**

Using the Microsoft EPM solution, DEA Brown & Sharpe can capture each element of a project more accurately, from the number of hours needed to design the new product to the development cost of the project. Managers are now better able to estimate how many resources a new project will require and if there is sufficient budget to undertake a particular project at a certain point of the fiscal year.

Furthermore, Microsoft EPM allows users to capture best practices to create enterprise-wide project templates that ensure standardized reporting throughout the business. With consistent and accurate project reports, managers are able to make more informed business decisions, ultimately resulting in a better bottom line for the business in terms of profit, revenue, quality, control and delivery as well as customer satisfaction.

The senior management team is able to review high-level project information and make strategic decisions about projects. Internally, project review meetings are now more focused and effective because of the information and tools at the disposal of managers. The meetings enable everyone to get a perspective on potential and current issues that might affect a particular project’s progress and help everyone stay informed about the progress of all current development projects. The executive staff has a complete, high-level, enterprise-wide view of all ongoing development and service projects because of the portfolio management features in the Microsoft EPM solution that provide an overview of the status of all projects within an enterprise. In addition, if there are any issues with a project, Microsoft EPM enables executives to conduct “what if” analysis through the Portfolio Modeler and evaluate all the options available to get a project back on track.

The benefits of the solution have been tremendous. The solution was rolled out completely in a matter of just weeks. The vision for the business and the goals achieved by the company were to:

- Develop a common, network-based method for planning and tracking projects on a company-wide basis
- Enhance management visibility of the status of major development projects and resource utilization
✦ Provide a rapid decision making model to enable the fast deployment of service personnel with correct skills

✦ Enhance the speed of execution, quality, effectiveness and productivity of development projects and activities

✦ Provide effective tools to DEA Brown & Sharpe project managers which streamlines their job of managing projects within their department, synchronizing with geographically dispersed personnel and generating useful management reports

✦ Improving speed of response to customers

Problem solvers

Technology Associates International (UK Office)
The Mansley Centre, Timothy’s Bridge Road
Stratford Upon Avon, Warwickshire CV37 9NQ UK
Tel: +44 (0) 1789 292150  Fax: +44 (0) 1789 292191

Technology Associates International (US Office)
Suite 3600, One Market, Spear Tower
San Francisco, CA 94105 USA
Tel: 415-449-3602   Fax: 415-293-8001
Web Site: www.techassoc.com
E-mail: info@techassoc.com

Case 2

The challenge that faced this Fortune 100 company was met jointly by Ray Coker and Neal Boring of The Southern Project Group.

Problem statement

One division within a major Fortune 100 company in the aerospace industry made the corporate decision to use Microsoft Project to support widely adopted project management practices. After a close look at Microsoft Project, they found that it didn’t calculate certain factors the way that the company needed. Specifically, the company wanted to report on progress on a summary level, have progress bars drawn on the summary task bars, and calculate the SPI (Schedule Performance Index) metric to support the green light/yellow light/red light reporting model that they use.

When calculating Percent Complete duration on a Summary Task, Microsoft Project weighs and averages durations of detail tasks below summary task without considering the effort (work) involved. For example, Project weighs a 3-day task that takes...
5 hours of effort as heavily as a 3-day task that takes 50 hours when calculating Percent Complete on a Summary Task.

The company preferred to view Percent Progress rather than Percent Complete on Gantt Charts. In the mathematical model that the company developed, Percent Progress considers both the duration of a task and the effort involved, and calculates SPI, the Budgeted Cost of Work Performed (BCWP)/Budgeted Cost of Work Scheduled (BCWS). Project contains the information to calculate SPI but doesn’t calculate it.

**Problem solution**

The solution that Ray and Neil produced was a collection of menus and toolbars that managed the process for updating and reporting in Microsoft Project and the actual analysis or math in Excel. In other words, updated Project data was mapped to Excel, where formulas that calculate SPI, supplied by the company, are applied to the data. Finally, the data calculated in Excel is brought back into Project, updating the project for the company’s reporting criteria.

An official for the company comments on the solution: “Microsoft Project, customized with our Schedule Tracking Tool, has provided our company with valuable tools that are used weekly to report progress against plan.”

**Problem solvers**

Ray Coker  
Project Direct  
4523 Azeele Street West  
Tampa, FL 33609  
Phone: 813-282-8246  
Email: ray@projectdirect.com

Neal Boring  
Southern Project Group  
11206 Big Canoe*461 Chestnut Rise Trail  
Jasper, GA 30143  
Phone: 706-268-2154  
Email: rneal@mindspring.com

**Case 3**

The challenge facing Longs Drug Stores was met by Sicun Management Group, Inc., using Microsoft Project and Project KickStart.
**Problem statement**

Longs Drug Stores’ Human Resources Department had to implement a new Human Resources Information and Payroll System (HRIS) while going through an acquisition and conducting business as usual. For Longs, a delay in deploying the HRIS system was not an option for two primary reasons:

- The system was linked to a massive HR re-engineering effort that would bring a new information system to the $3 billion company and its 16,000 employees.
- The existing HR/payroll system was almost 30 years old, had no additional capacity, and had year 2000 problems that couldn’t be fixed, thus placing the majority of the burden for human resources on individual operating managers.

**Problem solution**

To ensure the success of this massive project, skeptical operating managers had to buy in to the transformation. Input from all participants involved in the project plan was paramount; with this concept in mind, a steering committee and a working staff group — both composed of representatives of operations and Human Resources — were established, and brainstorming sessions began.

Sally Cabbell of Sicun Management Group, Inc., used Project KickStart — a project planning tool that links to Microsoft Project — in order to capture ideas during brainstorming sessions. Project KickStart is ideal to use when a group is providing input; it allows for easy and rapid entry of Phases, Tasks, Resources, Notes, and some timing.

During the dynamic brainstorming sessions, Sally projected Project KickStart on a screen so that the task forces could see their ideas being captured. When the group was satisfied with their work each day, Sally printed the Project KickStart plan and each member of the group took away a beginning project plan. In this way, project-management discipline was introduced into a segment of the organization where project plans had never before been used.

Sally then dumped the Project KickStart data into Microsoft Project, where the more sophisticated project planning of resources, timing, dependencies, and baselines can be captured. Project KickStart fed beautifully into a Microsoft Project plan.

Microsoft Project was then used throughout the project, which lasted about 18 months. At the end of the project, the HR functional operations were completely transformed, including reassigned responsibilities and staffing the key jobs with new, internal operations people who were taught HR during the long transformation process.
The success of this project proved to the participants that managing change is a logical, methodical, carefully planned activity; and when done well, everyone benefits and no one loses — even when sweeping changes are implemented. Careful planning and rigorous management of the plan does not have to be disruptive, but can actually improve productivity without the pain of an unproductive period due to the change.

**Problem solvers**

Sicun Management Group, Inc.
2255 Morello Ave., Suite 166
Pleasant Hill, CA 94523
Phone: 925-288-8755
Fax: 925-735-8071
E-mail: scabbell@sicun.com

Experience in Software
2000 Hearst Ave.
Berkeley, CA 94709-2176
Phone: 510-644-0694
Web: [www.projectkickstart.com](http://www.projectkickstart.com)

**Case 4**

The challenge that faced the Nebraska Arts Council was met by Barbee Davis of Davis Consulting.

**Problem statement**

Education budget cuts have, for the most part, been felt most strongly in the arts programs of most schools. Many schools have lost their music or art programs entirely or those programs have been cut back significantly. The Nebraska Arts Council received substantial grant money to be used to find a way to make arts basic to education through teacher education and school reform. The Nebraska Arts Council decided to use the money to re-educate classroom teachers at six schools to include the arts as part of the typical classroom curriculum — as opposed to relying on schools to provide separate arts programs. Initially, the Nebraska Arts Council ran into some challenges while trying to organize an effective approach to meet all of the requirements of the various grant providers. So, Barbee Davis of Davis Consulting was hired as a project consultant to help the Nebraska Arts Council clarify and meet their goals.
Problem solution

Using the process in Microsoft Project for planning a project, Davis Consulting met with the Nebraska Arts Council, and together they clarified the charge of the Nebraska Arts Council: to aid teachers in producing curriculum units that included visual arts selections, and to help produce a plan to sustain the production and use of curriculum units in the coming years when the funding was no longer available. In particular, they decided that they had to deal with four distinct issues:

✦ Ensure that the teachers finished the curriculum units as their final product to meet the grant requirements
✦ Motivate the teachers
✦ Get administrators to buy in and support the project
✦ Create a plan for sustaining the project

To meet the first goal, the Nebraska Arts Council chose a curriculum writing process and set up a “teach the teacher” program, in which several “mentor” teachers were trained. Then, the teachers attended a series of four classes/workshops where they learned a formal curriculum process and actually began to write their units under the supervision of their mentors.

To meet the second goal, the Nebraska Arts Council kicked the year off by offering up to ten people at each school a $400 trip to London to view the actual art pieces that the teachers were using in their curriculum units. The teachers paid $200 at the beginning of the year and signed a contract in which they agreed to produce the curriculum units. The terms of the contract stated that, if the teachers met a series of performance goals during the year, they would pay the balance of the money due — (another $200) and the grant money would fund the rest of the trip.

To meet the third goal, the Nebraska Arts Council decided to allow each school involved in the program to send up to eight teachers and two administrators to London. The administrators had their own series of activities to complete to qualify for the trip.

To meet the fourth goal, the teachers put their units on a Web site for all Nebraska teachers and agreed to mentor other teachers to help develop additional curriculum units. They agreed to teach their curriculum units throughout the upcoming school year.

Davis Consulting and the Nebraska Arts Council created a plan in Microsoft Project and tracked and reported on the progress systematically. It was a great success: Every goal was met and the morale for the year was higher than it had ever been. Teachers who had been bored and some who had never really understood what the project was all about were awakened and involved.
Each teacher was set up as a subproject within the overall project and most of the dates had “Must Finish On” constraints — the final date was the trip to London. Each teacher’s requirements were listed separately and not merged to an entire project, because the successful completion of the project didn’t depend on each person completing his or her individual activities. If a teacher fell behind or dropped out of the program, other teachers signed up as alternates and stepped in.

In this case, Project wasn’t used in the traditional way — to set up task dependencies and determine a critical path to figure out when the project would end. Instead, Project was used to track tasks that needed to be completed by each teacher and by specified dates; if a teacher didn’t complete the tasks, he or she was dropped from the program, but the project continued along.

This example is an important one because users of Microsoft Project often narrow their thinking to believe that it is only useful for construction, architecture, and manufacturing. In fact, it also is an extremely powerful software tool for organizing more esoteric projects and keeping them on track. Microsoft Project’s feedback reports have credibility, whereas mere progress updates are soon forgotten. Microsoft Project helped to boost enthusiasm and buy-in for the project, which is critical to the success of any project. This case, which can also be used in any business environment, demonstrates a very effective use of Microsoft Project as a model for change management.

Problem solver

Barbee Davis
Davis Consulting
9524 Hascall
Omaha, NE  68124
Phone: (402) 397-4716
Cell: (402) 690-7066
Fax: (402) 397-1551
Email: barbeedavis@home.com

Case 5

The challenge that faced this young Webcasting services company was met by Bluewater Project Management Services, LLC.

Problem statement

In 2000, a young company that offers Webcasting services 24 hours a day, 7 days a week for radio, television, and Internet-only programming found themselves facing
a new challenge. Their client base and Webcasting services had grown to such a degree that they needed to increase their Webcasting ability. To meet this need, they began constructing the largest and most advanced Webcasting facility in the Seattle area, working with proprietary hardware suppliers and installation contractors. Because they needed to complete the facility rapidly to satisfy work contracts and customers’ needs, the project required in-depth management and some customized tools.

In developing their hardware and software systems, the Webcasting company chose a hardware supplier who competed on the supply side with their integration contractor. This situation required management diligence and help in understanding how to communicate project information through all parties. The integration contractor provided a schedule that described when parts would be needed, based on their integration schedule. The Webcasting company internally managed the P.O. process to get hardware on site in time for integration and at or below the budgeted price through the integration contractor. The Webcasting company began this process using a Microsoft Excel 2000 spreadsheet, listing all of the parts required, the budgeted cost, and supplier names in separate columns.

Based on the spreadsheet information, the Webcasting company used a manual process to determine when orders needed to be placed and when they would arrive on site. There were several drawbacks to this approach:

- The manual process was very labor-intensive and required continuous phone calls between the Webcasting company staffers, the integration contractor, and the hardware supplier.

- This solution required that the spreadsheet be passed around among team members to add information, thus calling into question versioning and data integrity issues.

- The Webcasting company staffers also lacked the time to work through the estimations to determine when P.O.s needed to be placed.

As a result, several of the first integration parts were ordered too late to be on site in time to meet the integration schedule established by the integration contractor. To help them better manage the procurement process, the Webcasting company hired Bluewater Project Management Services, LLC, to develop a custom software solution using Microsoft Project 2000, Project Central, and Microsoft Excel 2000.

**Problem solution**

The Webcasting company requested a system that used a familiar interface that would do the following:
Give them an understanding of the hardware and software orders that needed to be completed

Identify when the orders would be on site

Report on this process based on the role that the individual played in the process — supplier, integration contractor, the Webcasting company employee, and project stakeholder

Bluewater worked with the Webcasting company to understand their internal and external P.O. process constraints and developed a software solution based upon these discussions. Using the Microsoft Excel spreadsheet that the Webcasting company had created, Bluewater estimated the date that each P.O. needed to be submitted for a particular part to arrive at the dock on time. After the P.O. was placed, the spreadsheet rolled forward through the process, detailing when certain activities in the process needed to be completed, and providing a more solid estimate of the delivery and testing date.

All of the information in this workbook was processed through Microsoft Project automatically and forwarded to Microsoft Project Central for reporting. This information was then customized using the Microsoft Project fields that are forwarded into Project Central, providing these users with graphical indicators of the procurement process for each part in the integration process. Each user, according to their role in the project, sees reports of project status down to the hardware part level, with the supplier seeing cost and schedule information, the integration contractor seeing schedule information only, and the Webcasting company seeing all procurement-related information.

This solution gave the Webcasting company the ability to make hardware purchasing decisions easily and in a timely manner based upon the integration schedule. The use of Microsoft Project Central allowed the Webcasting company to give information to and receive information from outside contractors and suppliers, and allows internal project participants to have a deep understanding of what is happening within the procurement process to ensure that the project, and any future projects, is on time and on budget. Through the integration of Microsoft Project 2000, Project Central, and Microsoft Excel 2000, Bluewater Project Management Services, LLC, was able to help the Webcasting company control the supply chain in their largest project to date.

Several key factors influenced the use of Microsoft Project and Project Central:

**Support for Collaboration.** The Webcasting company hardware procurement solution put in place by Bluewater Project Management Services, LLC, relies on the integration of Microsoft Excel front end; Microsoft Project 2000 capabilities of OLE linking and embedding, customized fields, and graphical indicators; and Microsoft Project Central for role-based security and Web-based project reporting of delivery procurement process information to company
project participants, suppliers, and contractors in an easily interpretable format. The solution also maintains the integrity of the data by allowing a single copy to be maintained and controlled by a single individual of the project team. The value of getting information out easily and quickly helps everyone stay up to date on where the project is and what needs to be done, thus giving people a better idea of where changes need to be made and when things need to be done.

♦ **Portfolio View.** With the Portfolio View, the Webcasting company employees and external participants can view rollup project information and drill down to see where individual part issues are slowing the integration project. This allows them to see how their contributions to the project affect the end date of the integration.

♦ **Field Linking.** By linking information from Microsoft Excel with Microsoft Project and Project Central, the Webcasting company staffers are able to use their familiar Microsoft Excel interface and formulas to enter and maintain information, while relying on Microsoft Project and Project Central to display this information based upon their role in the process. Microsoft Project’s membership in the Microsoft Office group provides interactivity between it and other popular office productivity software pieces to aid in customizing solutions and meeting customer needs.

The solution offered the following benefits:

♦ **Quicker information dispersal.** By providing a Web-based interface with connectivity to the Webcasting company’s spreadsheet, current project information can be published with the push of a button, thus making the information immediately available to all participants in the project. Changes can be made and distributed much more quickly than through previous methods.

♦ **Project status from anywhere.** Because Project Central uses a Web interface, team participants can check status information from supplier and contractor offices, on site, or on the road.

♦ **More control over data access and integrity.** Placing the project information into a single source document means that only one version of the document can exist — and no one needs to ask, “Is this the latest information?” Project Central’s role-based security ensures that the appropriate people can see the information that they are meant to see, and have the appropriate rights (viewing or modifying), so change order processes are better managed.

With their hardware procurement solution, developed by Bluewater Project Management Services, LLC, on Microsoft Project 2000, Microsoft Project Central, and Microsoft Excel 2000, the Webcasting company employees have more control over the procurement process and are able to share their vital information with those who need it while still maintaining control over who has access to that data. All team members can stay informed about what is happening on the project and
have a communication mechanism to share that information and maintain a rigid change control process. The Webcasting company can focus on delivering Webcasting and broadcasting solutions and know that they will have the infrastructure to meet their customers' needs.

**Problem solver**

Bluewater Project Management Services, LLC  
S. 336th Ave., Ste. 204  
Federal Way, WA 98003  
Phone: (253) 874-8884  
Fax: (253) 838-1798  
Web: www.bluwtr.com  
E-mail: bluewater@bluwtr.com

**Case 6**

The challenge faced by a large Asian conglomerate that needed a unique software application was met by John D. Callos of IdeaBridge — an international strategy and management consulting firm. Callos used Microsoft Project and Project KickStart — a Project add-on developed by Experience in Software.

**Problem statement**

An IdeaBridge client was in negotiations to sell their e-commerce company with a unique software application to a large Asian conglomerate that needed to use and integrate the IdeaBridge client's application in order to quickly establish a new market position. This project was a high-profile initiative, and it was vital that the solution/technology be integrated, checked, marketed, promoted, and launched within a three-month period.

The conglomerate's team called John Callos, Managing Director of IdeaBridge Consulting Group, to say that they were coming over in a few days to try to close a deal with his client, but that they wanted to meet him to gauge his ability to assist the integration team. They wanted Callos to be involved because of his familiarity with the product and the target market. They gave him a few scant details and asked him to have a proposed project plan and integration timeline mapped-out by the time their flight touched down in Los Angeles.

For this multi-million-dollar project, John had to be able to use Microsoft Project, which concerned him greatly; at the time, he was just a novice user of Microsoft Project.
John used the Internet to research project management approaches for a project of this magnitude and to look for some templates available for download to hit the ground running, but he wasn’t able to find any that would have been viewed as an impressive platform from which to launch the project.

**Problem solution**

John found a program called Project KickStart that turned out to be perfect for what he needed. The program was instantly intuitive. John answered the series of questions that Project KickStart asked him, and the program then logically and simply walked him through all the project phases. The simplicity of Project KickStart was vital, because John had no time to learn anything from scratch. John’s job was made even easier, because he could merge Project KickStart information instantly into Microsoft Project, which was a requirement of the project.

Within a few hours, John had a *very* detailed outline of the project plan. With this outline in hand, John augmented the plan with some bullet points he found on the Microsoft Project portion of the Microsoft Web site and other project management sites. By the time the prospective buyers had arrived, John was able to present them with an extremely detailed plan that took just a few hours to complete.

The prospective buyers were impressed with the detail of the plan and began negotiating for a role far beyond what they had initially envisioned, ultimately leading to John’s full time, on-site management of the entire project team in Asia. During this time, John used Project KickStart’s link to Microsoft Project to transfer his project plan to Microsoft Project and to e-mail the particulars to the team in Asia.

Using a full-time person to keep the project plan constantly updated, the project team integrated the various project plans of the technology development firm, the advertising and marketing firms, the business partners, the media people, and the opening day kick-off event planners. They developed an incredibly useful document that kept everyone on task and prevented things from falling through the cracks. The client was thrilled that they could focus on other pressing matters, knowing that the project was 100 percent under control because John had a detailed project plan that included well over 500 distinct items. Anytime this company has a similar project, they can refer to this plan and use it as a template to ensure that they have thought of everything that should be included in a project plan.

In this case, Project KickStart enabled John’s firm to land a large international project with a well-known Asian conglomerate because Project KickStart helped John put together a project plan outline quickly — even before he learned Microsoft Project. And none of John’s efforts were wasted because of Project KickStart’s seamless integration with Microsoft Project.
Case 7

EDS provides strategy, implementation, and hosting for clients managing the business and technology complexities of the digital economy. The challenge faced by EDS was met by Tenrox, Inc. — a Quebec-based developer of business-optimization software products — using Microsoft Project and Projeca.

Problem statement

EDS, based in the United Kingdom (UK), had to track all the resources and work for the largest IT project in Europe. This project consisted of building a whole new suite of applications for a department of the British government.

During this crucial and long-term project, the most pivotal area was the need to track detailed time entries and hourly costs for 1,000 users. The reporting of these entries needed to be presented in detailed fashion on a weekly basis with minimum error and in real-time.

Problem solution

After careful considerations and evaluation of several options, Projeca, from Tenrox, was selected for four reasons: its complete, fast and live integration with Microsoft Project, it required no installation on the part of the client, it has an intuitive user interface, and it can be rapidly launched. Projeca enabled EDS to better control budgets and estimates through the life cycle at various phases of this exceptionally sizeable project. This was a key point for EDS — the decision had just been made to proceed with the use of Microsoft Project 2000 as a planning tool.
Currently, 1,000 active users are benefiting from this system. The staff is spread across six sites in the UK and others across Europe. EDS is the general contractor, but the project involves several market leaders in the IT industry.

Projeca is used to track all work — including time, labor costs, and related notes for the entire labor costs of the project. The timesheet management process has been streamlined due to Projeca’s intuitive and powerful features. Projeca includes:

- Work submission
- Validation and approval
- Compliance reporting
- Supervisory controls
- Automatic approval
- Notes
- Document attachments
- Work assignment
- Regional holiday
- Overtime and administrative tasks processing
- Constraints
- Validations
- Usage rules with full compliance for the European Time Directives

The cost and revenue accounting engine has provided the flexibility required to support rate dependencies and history (defined for general conditions and overridden for special cases). EDS can define rate rules for fixed, hourly, daily, and custom rates, as defined at various Work Breakdown Structure (WBS) and Organization Breakdown Structure (OBS) levels.

The benefits have been tremendous: The software was rolled out completely in a matter of weeks, and the entire project staff now consists of just two people who have no difficulties managing over 150 project plans — each produced by individual managers. The previous full-time and temporary staff consisted of approximately ten people who would manually enter all the time and related information into a Microsoft Project plan or a high-level Excel spreadsheet. Their entire cost and time reporting, which used to take roughly four working days to fully compile, now takes approximately 14 seconds in precisely the same format that EDS was using previously. The software runs with 100 percent uptime.
Problem solvers
Tenrox, Inc.
600 Boulevard Armand-Frappier
Laval, Quebec
Canada, H7V-4B4
Web: www.tenrox.com/
Phone: (450) 688-3444
Fax: (450) 688-7862

Case 8
The challenge faced by this Fortune 100 company was met by Project Assistants, Inc. — a Microsoft Project Certified Partner based out of Wilmington, Delaware.

Problem statement
The IT division within a major Fortune 100 company was looking for a way to collect project management metrics data in a more consistent, accurate, and automated fashion. This data would be used to support trend analysis across all the projects within the organization. The company had initiated other programs previously to collect project management metrics, but these programs were always very time-consuming and created a lot of additional work for the project managers.

Project Assistants convinced the company to standardize on the use of Microsoft Project by demonstrating how the company would be able to collect the project management metric data directly from within Microsoft Project — without changing the current process used by the project managers. In this way, current work processes in Microsoft Project wouldn’t be interrupted.

In particular, the company wanted to:

✦ Collect metric data on schedule and work variances throughout the life of a project. This data would allow management to identify why some projects finish behind schedule or over budget and in turn improve the estimating accuracy over time.

✦ Collect methodology compliance data to determine whether a correlation existed between overall project quality, when project managers closely followed the standard methodology tools, and procedures that the organization had invested heavily in developing.
Problem solution

To solve these problems, Project Assistants developed a COM add-in to collect key metric data directly from within Microsoft Project. To address the company’s first business requirement, the COM add-in collects metric data on schedule and work variances throughout the life of a project. The system calculates the finish variance and work variance at key stages of a project, and if the variance exceeds the allowed tolerance (e.g., 10 percent), the project manager must enter the reason for the variance being out of tolerance.

To address the company’s second requirement, the COM add-in collects methodology compliance information, thus allowing project managers to map their project to one of the approved methodologies and in turn associate the required deliverables for the methodology to their corresponding tasks in the Microsoft Project plan. For example, the “Conceptual Data Model” deliverable would be mapped to the task “Create Conceptual Data Model” in the project plan. The metrics collection tool allows the project manager to report the status of these required deliverables to management, as well as provide a reason why the project manager may have chosen not to follow an approved methodology at certain points in the project.

The COM add-in also includes an automated status-reporting module that allows project managers to complete a questionnaire that focuses on key project management factors, such as scope, budget, and risk. Based on the answers to the questions, the project manager receives a “red light,” “yellow light,” or “green light” for his or her project. In this way, the company can measure the “health” of a project in a consistent and standard way throughout the organization.

Problem solvers

Project Assistants, Inc.
1409 Foulk Road, Suite 200
Wilmington, DE 19803
Phone: (302) 477-9711
Fax: (302) 477-9712
Web: www.projectassistants.com
E-mail: ibrown@projectassistants.com

Case 9

BCE Emergis caters to a client list that includes leading banks, insurance companies, and healthcare companies across North America, developing sophisticated transaction-based Web applications to transform their customers’ business processes and provide them with a competitive edge in the global economy. The challenge faced by BCE Emergis was met by Tenrox, Inc. — a Quebec-based developer of business-optimization software products — using Projeca and Microsoft Project.
Project statement

BCE Emergis has enjoyed tremendous success in quickly growing its business to 2,000 employees, but this growth has been accompanied by challenges. After several company acquisitions and offices in Montreal, Toronto and Greensboro, North Carolina, BCE Emergis quickly found itself with a mixture of multilingual reporting systems being used by its project managers. Because the company did not have a standardized bilingual management system in place to measure each project’s time allocation and budget cost center, reporting results had to be manually combined and analyzed — a time-intensive and tedious effort.

Upper management found it very difficult to consolidate project information and track profitability. Management had no tools or metrics to reorganize groups according to workload and to improve productivity. Additionally, project managers were only able to track the amount of time spent on a project — as opposed to being able differentiate overtime hours.

BCE Emergis sought an affordable and easy-to-use turnkey solution that was designed to handle time management and expense management and would be compatible with all leading ERP, CRM, Project Management, Payroll, and accounting systems.

Project solution

Projeca — an out-of-the-box, pure HTML system developed by Montreal-based Microsoft Certified Partner, Tenrox — automates, optimizes, and helps standardize paper-intensive and time-consuming administrative tasks. Designed for integration with Microsoft Project (used by the majority of BCE Emergis project managers), Visual Basic, C++, SAP, and other popular systems, Projeca’s deployment and implementation was painless and saved the company countless hours of training and replicating data. It also provides 250 reports that can be modified by using other software and allows users to create new reports with ease.

Problem solvers

Tenrox, Inc.
600 Boulevard Armand-Frappier
Laval, Quebec
Canada, H7V-4B4
Web: www.tenrox.com/
Phone: (450) 688-3444
Fax: (450) 688-7862
Summary

In this chapter, you’ve had an opportunity to read about some real-life situations in which Project helped provide a solution. The cases covered a variety of industries, including some where you wouldn’t expect Project to be used.

✦ ✦ ✦
Appendixes

In This Part

Appendix A
What’s on the CD-ROM

Appendix B
Project Management Worksheet
(on the CD-ROM)

Appendix C
Available Fields and Functions for Custom Field Formulas
(on the CD-ROM)

Appendix D
Project Management Resources
(on the CD-ROM)

Glossary
(on the CD-ROM)
What’s on the CD-ROM

The CD-ROM that accompanies this book contains demos or demonstration/trial versions of several popular add-on products for use with Microsoft Project. In addition, this CD-ROM includes sample files for three of the most common types of projects that you can use as time-savers when you begin building similar schedules. You’ll also find this book in Adobe Acrobat Reader (.PDF) format — along with Adobe Acrobat Reader — and a Web page of links to some Project partners.

If you have AutoRun enabled on your computer, the CD should load automatically; you’ll see an HTML interface with hot links to view various components on the CD. If you don’t have AutoRun enabled (or if you prefer to navigate on your own), you can view the contents of the CD manually; and you’ll find the contents of the CD organized into folders.
Software on the CD-ROM

This appendix describes the contents of the CD-ROM and, where necessary, gives instructions for installing programs on your computer. You can use the demo versions of these products to see how they fit your needs. Each listing includes contact information so that you can buy the software directly from the vendor.

Your system needs Windows 2000 or XP to use this CD-ROM. See Chapter 18 for Project Server software and hardware requirements.

In some cases, these vendors did not have the fully updated version of their software for Project 2003 prepared in time for this book’s publication. If you have access to Project 2002, you can test the early version and then order the Project 2003 version. If you no longer have access to Project 2002, you can contact the companies to get an updated demo or more product information.

PDF

You’ll find a .PDF file of this book on the CD. You can use this file to electronically search for topics in the book. You’ll also find a .PDF file of the forms in Appendix B of this book, which you can use to help you plan your project. You can read .PDF files with Adobe Acrobat Reader, which you’ll also find on the CD-ROM. If you open either file in Adobe Acrobat Reader, you can easily search for topics or print the forms.

Project Partner Links page

This is a Web page of links to the sites of Microsoft Project partners who offer software that enhances Microsoft Project and assistance in using Microsoft Project. At several of the Web sites, you’ll find Web-based demo products.

Empire TIME

The Windows Support Group, Inc.
150 West 22nd St.
New York, NY 10011
Phone: (212) 675-2500
Web: www.wsg.com
**Installation instructions:** On the software screen of the Microsoft Project 2003 Bible CD, click Empire TIME. Follow the onscreen prompts to install the demo version of the program. Installation creates a Demo folder on your hard drive and an Empire TIME Demo group on the Programs menu. You can uninstall the demo by running uninstallSHIELD from the same Empire TIME Demo group.

**Running the program:** To run Empire TIME from the Windows Start menu, choose Programs ➪ Empire TIME Demo ➪ ETDemo.

You can use Empire TIME, a multicurrency project time and expense accounting system, for internal chargebacks or external billing. Empire TIME is a high-performance, Windows-based client/server system that integrates with Microsoft Project, allowing managers to analyze time, staff assignments, costs, and revenue on their projects. Empire TIME is distinguished by its robust accounting capabilities for tracking and invoicing actual cost and revenue for time, expenses, services, and materials.

**Innate Info**

Innate, Inc.
Saracens House, 25 St. Margarets Green
Ipswich, Suffolk
England IP4 2BN
Phone: +44 1473 251550
E-mail: mikew@innate.co.uk

**Running the demonstration:** On the Bonus Software screen of the Microsoft Project 2003 Bible CD, click Innate Info. The demo will run correctly in Internet Explorer 4 or Netscape 4 or later. Follow the onscreen links and prompts to see the demonstration and more information.

Innate Info works with Innate products to publish your data for staff and managers to view as a web of information (via browsers or via printers). Exception reports and progress reports, from top-level views to the finest level of detail, can all be produced automatically.
Innate Timesheets

Innate, Inc.
Three First National Plaza
70 W. Madison, Ste. 1400
Chicago, IL 60602
Phone: (312) 781-9674
E-mail: sales@innateus.com
Web: www.innateus.com

Running the demonstration: On the Bonus Software screen of the Microsoft Project 2003 Bible CD, click Innate Timesheets. The demo will run correctly in Internet Explorer 4 or Netscape 4 or later versions. Follow the onscreen links and prompts to see the demonstration and more information.

Innate Timesheets is a simple-to-use application for use with the Web or Microsoft Windows. You record time, effort, and progress into a central open database, and Innate Timesheets gives you a wide range of reports and options to link to other corporate systems. You can automatically incorporate and update Microsoft Project plans.

Milestones Professional 2002

Kidasa Software
1114 Lost Creek Blvd., Ste. 300
Austin, TX 78746
Phone: (800) 765-0167
E-mail: sales@kidasa.com

Installation instructions: On the Bonus Software screen of the Microsoft Project 2003 Bible CD, click Milestones Professional 2002. Follow the onscreen prompts to install the trial version of the program. (Note that no serial number is required to install this trial version.) When you are asked to enter this number, remove any characters from the Program Key field and type Eval to proceed.

Milestones Professional 2002 is a front end for Microsoft Project. You can enter and manage project data in Milestones and then move (export) it into Project. You can also import Project data to Milestones. This approach enables you to better control the display of some Project data because you can make settings for the number of tasks per page, column and page layout, and OLE linking and embedding.

You also can use Milestones Professional 2002 as a stand-alone scheduler for creating and updating simple Gantt or timeline schedules without using the resource management features of Project.

**PERT Chart EXPERT**

Critical Tools  
8004 Bottlebrush Dr.  
Austin, TX 78750  
Phone: (512) 342-2232  
Web: www.criticaltools.com

**Installation instructions:** On the Bonus Software screen of the Microsoft Project 2003 Bible CD, click PERT Chart EXPERT.

**Running the program:** When you install this program, you can opt to add a toolbar to Project. Then simply open a Microsoft Project file and either select the PERT Chart EXPERT menu or click the toolbar button to automatically generate a PERT chart. Alternatively, you can open the program from the Windows Start menu. Choose Programs ➤ PERT Chart EXPERT ➤ PERT. When the program window opens, choose Tools ➤ Microsoft Project ➤ Project to open Project 2003.

PERT Chart EXPERT is a Windows-based application that enables you to create PERT charts from existing Project schedules, text files, or spreadsheets. As an add-on to Microsoft Project, PERT Chart EXPERT integrates with Project to generate presentation-quality PERT chart diagrams.
Project KickStart

Experience in Software
2000 Hearst Ave.
Berkeley, CA 94709-2176
Phone: (510) 644-0694
Web: www.experienceware.com

**Installation instructions:** On the main screen of the Microsoft Project 2003 Bible CD, click Project KickStart. Follow the prompts onscreen to complete the installation.

**Running the program:** This trial version of Project KickStart is compatible with Project 2003. Double-click the icon placed on your desktop during installation or click Start ➪ Program Files ➪ Project KickStart 3 ➪ Project KickStart 3. The first screen of this 20-day trial version gives you the option of purchasing the full program or running the trial version. From the main screen, you can start to build a project outline with Project KickStart’s easy-to-use tools.

Project KickStart is the fast, easy way to plan and organize your projects. The software’s seven-step icons quickly guide you through the process of building a strategic plan. You’ll consider project goals, obstacles, resources, and other “big picture” issues. Use the Project KickStart “hot-link” icon to transfer your plan into Microsoft Project. Project data will appear in MS Project’s Task column, ready for scheduling.

Project Kickstart is a front-end planning tool for project managers. With Project Kickstart, you can outline your objectives, list things to do, and anticipate major project issues. The software has features to help you brainstorm, strategize, and organize the details of your project before you start to build your project schedule. An online planning Advisor and templates for project planning help you to formulate your approach to your project. Then you can seamlessly output your data to Microsoft Project.
**WBS Chart Pro**

Critical Tools  
8004 Bottlebrush Dr.  
Austin, TX 78750  
Phone: (512) 342-2232  
Web: www.criticaltools.com

**Installation instructions:** On the Bonus Software screen of the Microsoft Project 2003 Bible CD, click WBS Chart for Project. You will be prompted to download a file. After the download completes (the file is approximately 2MB and the length of time needed for the download depends on the speed of your Internet connection), click the Open button to install WBS Chart for Project.

This setup program needs access to Microsoft Project through a network, you may not have Read/Write access to the Global.mpt file.

**Running the program:** When you install the program, you can choose to add a toolbar to Project 2003. Then open Project and simply use the toolbar to run WBS Chart. Alternatively, you can open WBS Chart from the Windows Start menu. Choose Programs » WBS Chart Pro » WBS Chart Pro. From the program window, choose Tools » Microsoft Project » Project to open Project 2003.

Depending on your hardware configuration, you may see messages about setup failure. However, because this is a demo, click OK or Continue; the program should install correctly. If you continue to have problems, call the tech support number that appears on-screen.

WBS Chart for Project is a planning tool that enables you to create projects by using a WBS (work breakdown structure) Chart. You can use this method to plan, manage, and display projects with a tree-style diagram. With WBS Chart for Project, you can sketch a project quickly and easily by dragging your mouse on the screen. You can then transfer the plans that you create in WBS Chart for Project directly to Microsoft Project or to any program that can read a Microsoft Project file format (*.mpp). You can also use WBS Chart for Project to automatically generate presentation-quality WBS charts from existing Microsoft Project files.
Project Sample Files

The CD-ROM also contains three sample files that give you a head start on typical projects. Copy these sample files to your hard drive, open them, save them with your own project name, and then add, delete, and change settings for the various tasks included here. Sample files for Chapter 25 are included.

You need to create your own resources and assign them to tasks and add timing and dependency relationships between tasks. The three sample files are as follows:

- Publication sample file (Publish.mpp). This sample file is useful for any kind of publishing project, from a simple brochure to a product documentation manual. Phases for writing and editing content, design, layout, printing, and distribution give you the basis for your own publishing project.

- Meeting sample file (Meeting.mpp). Everybody plans meetings. Whether it’s a regular weekly staff meeting or your company’s annual meeting, this sample file provides the tasks that you need to arrange for location, transportation and lodging, invitations, catering, equipment, and speakers.

- Facility sample file (Facility.mpp). You can use this sample file to set up a new facility or to move to a new space. Tasks include planning space, coordinating movers, managing utilities, and setting up computer networks.

Bonus Appendixes

The CD-ROM contains bonus Appendixes in the Adobe Acrobat .pdf format. You can read these on your computer screen or print them out:

- Appendix B: Project Management Worksheet
- Appendix C: Available Fields and Functions for Custom Field Formulas
- Appendix D: Project Management Resources
- Glossary
Troubleshooting

If you have difficulty installing or using any of the materials on the companion CD, try the following solutions:

✦ **Turn off any anti-virus software that you may have running.** Installers sometimes mimic virus activity and can make your computer incorrectly believe that it is being infected by a virus. (Be sure to turn the anti-virus software back on later.)

✦ **Close all running programs.** The more programs you’re running, the less memory is available to other programs. Installers also typically update files and programs; if you keep other programs running, installation may not work properly.

If you still have trouble with the CD, please call the Wiley Customer Care phone number: (800) 762-2974. Outside the United States, call 1 (317) 572-3994. You can also contact Wiley Customer Service by visiting our Web site at www.wiley.com/techsupport. Wiley will provide technical support only for installation and other general quality control items; for technical support on the applications themselves, please consult the program's vendor or author.

✦✦✦
Index

A
Access (Microsoft) database
exporting to, 820–825, 828
importing from, 839–840
accounting system, 876
Active Directory, 135
Active Scripting, 773
actual cost of work performed. See ACWP
actuals
adjusting, 659
calculation options, 356–359
costs, 366–371
defined, 355
estimates versus, tracking, 336–337
progress, reviewing, 378–383
uncompleted work, rescheduling, 376–377
updating
accelerating, 375–376
organizing, 355–356
tasks, 360–366
techniques and tips, 371–377
work done and remaining, 652
ACWP (actual cost of work performed), 393, 394, 412
adding
documents to projects, 693
project menus, 752–753
resource assignment, 317–318
task assignment to resource, 317
tasks, 678–680
time to tasks, 290
tools to toolbars, 746–747
views, 211–213
address, e-mail
company, setting, 553
looking up, 125
of resources, 124
adjusting
actual work, 659
dependency, task, 294–296
Gantt table columns, 97
group task timing, 80
ongoing in tracking, 337–338
slack, 290–292
through UserForm object, 787–789
work, automating
code, adding, 793–798
controls, adding, 789–793
creating, 784–785
described, 783
size, adjusting, 785–786
sub procedure showing, 799–800
Administrator
administrative projects, setting up, 597–598
defined, 505
double-checking settings
categories, 575–578
features, specifying, 563–565
groups, 570–571
security templates, 568–570
tool, 562–563
user authentication, 565–566
views, 571–575
Window SharePoint Services, 566–568
Enterprise Global template, 583–587
Enterprise Project versions, managing, 581–582
time to tasks, 290
structures and timescales, 601–602
tool, 562–563
user authentication, 565–566
views, 571–575
Window SharePoint Services, 566–568
Enterprise Global template, 583–587
Enterprise Project versions, managing, 581–582
enterprise projects and resources,
checking in, 587–597, 616–617
OLAP cube, managing, 605–615
Project Server
database, managing, 618
peripheral software, installing, 518–528
requirements, reviewing, 513–518
troubleshooting, 558
PWA
Analysis Services server, specifying, 549
default home page appearance, 603–604
Gantt taskbar styles and timescales, 601–602
grouping formats, 602–603
mail server information, setting up, 552–553
menus, establishing, 599
notifications and reminders, 604–605
Continued
Administrator (continued)

PWA (continued)

OLAP server information, entering, 555–556
operation modes, changing, 554–555
SharePoint portal server information, 553–554
tracking settings, 599–601
WSS server information, 549, 556–558
resource tables, updating, 615–616
SharePoint site accounts, managing and synchronizing, 619–620
tasks, order of, 561–562
users, adding or modifying, 578–581
Web-based project, creating, 634–636

ALAP (as late as possible), 51, 94
all open projects, consolidating, 451–452
allocations, changing, 315–318
analysis, portfolio
 Administrator account, creating, 524–526
Analysis Services Repository, migrating, 606–608
building, 605–606, 608–612
described, 664
trends and potential problems, identifying, 708–713
users, viewing cube, 612–615
“what if” question, answering, 713–723
Analysis Services Repository, 606–608
appearance
 Calendar view, 159, 271–272
changing, 245–246
consistency, importance of, 245
critical tasks, identifying, 300–301
drawings and objects
 copying, 273–278
creating, 281–284
inserting, 279–281
modifying, 284–285
using in schedules, 278–279
Gantt Chart Wizard, 247–250
network diagrams, 263–270
taskbars, 254–263
text, 251–254
applications
 CD, back-of-the-book
 Empire TIME, 876
 InfoSource, Inc., 882
 Innate Info, 877
 Innate Timesheets, 877
 Milestones Professional 2002, 878
 MPX Translator, 879
 PDF file of book, 876
 PERT Chart EXPERT, 878–879
 Project 2003 Bible Web page, 876
 Project KickStart, 879–880
 TimeSheet Professional, 880–881
 WBS Chart Pro, 881
 peripheral Project Server, installing, 518–528
requirements
 for client computers, 515
 for servers, 514
applications, writing task-specific
critical tasks filter, recording, 774–778
described, 757
keyboard shortcut, 770–772
menu command, 766–770
recording, 758–761
Rollup Formatting, 186–189
running, 761–762
toolbar button, 762–766
as late as possible (ALAP), 51, 94
ASAP (as soon as possible), 51
ASCII files, 828
as-done figures
 adjusting, 659
calculation options, 356–359
costs, 366–371
defined, 355
estimates versus, tracking, 336–337
progress, reviewing, 378–383
uncompleted work, rescheduling, 376–377
updating
 accelerating, 375–376
organizing, 355–356
tasks, 360–366
techniques and tips, 371–377
work done and remaining, 652
Asian conglomerate case study, 864–866
assigning
 fixed cost, 142–144
new commands to project menus, 754
assigning resources
 adding or deleting, 317–318
contouring over time, 328–331
displaying by task, 196–197
including in Excel export file, 817
new and changed, publishing to e-mail workgroup, 481–484
notifying, 643–645
project, modifying, 437
Project Resource manager
described, 137–139, 640–641
enterprise, adding, 641–642
generic, replacing with real, 642–643
notifying of assignments, 643–645
with PWA, 649–651
Resource Substitution Wizard, 645–649
removing or replacing, 139–140
republishing to e-mail workgroup, 484–486
viewing from Resource Center, 700, 701
Assistance pane, 75
authentication
logging off, 704
logon account, creating, 624–626
Project Server, 541, 626–628
PWA, 668–669
SQL Server, setting, 520–521
AutoFilters, 237–238
automating repeated tasks, 13
availability
assignment, contouring over time, 331
resources, 47, 126, 129, 135
B
back-of-the-book CD
project sample files, 882–883
software, 875–882
troubleshooting, 883
base calendar, 508
baseline
budget report, importance to, 394
clearing, 345
described, 17, 335, 338–339
displaying multiple, 164
interim plans, 18, 343–345
multiple, usefulness of, 352
progress, viewing against, 346–348, 381–383
reasons to maintain, 341
setting, 339–341
tasks, adding, 342–343
BCE Emergis case study, 869–870
BCWP (budgeted cost of work performed)
baseline, tracking against, 347
budget report, 394
calculating, 412–413
cash flow report, 393
BCWS (budgeted cost of work scheduled), 393, 394, 412
bids, gathering costs for, 120
Bluewater Project Management Services case study, 860–864
sample software, 879
booking type, 126–127
boot failure, registry editing and, 470
Boring, Neal (Project consultant), 855–856
bottlenecks, finding, 558
box styles, network node, 264–265
boxes, dialog
Cancel button, 798
ComboBox, 789–790
CommandButton, 791–793
creating, 784–785
described, 783
label, 787–789
OK button to change work, 795–798
resource name display, 793–795
size, adjusting, 785–786
sub procedure showing, 799–800
TextBox, 790–791
window, 781
broken hyperlinks, 497
browser, using Project with
described, 22, 501–503, 549–551
executive use
defined, 505
summary of all projects, 705–708
trends and potential problems,
identifying, 708–713
“what if” analysis, 713–723
Gantt taskbar styles and timescales, 601–602
grouping formats, 602–603
logging onto, 550–551
mail server information, setting up, 552–553
menus, establishing, 599
notifications and reminders, 604–605
OLAP server information, entering, 555–556
opening, 22
operation modes, changing, 554–555
Continued
browser, using Project with (continued)
   Outlook tasks, 680–688
   pages, displaying, 804
   resources, assigning, 649–651, 684
   server, specifying, 549
   SharePoint portal server information,
      modifying, 553–554
   tracking settings, 599–601
   user, logging on, 668–669
   WSS server information, entering, 556–558
budget planning, 16
Budget report, 394
budgeted cost of work performed. See BCWP
budgeted cost of work scheduled. See BCWS
button
   images, changing and editing, 749–751
   macro, assigning, 762–766
C
Cabbell, Sally (Project consultant), 857–858
calculating
   actuals, 356–359
   durations for task, 172
   earned value with percent complete
      method, 414–416
   weighted average for PERT analysis,
      175–176
calendar
   administrative projects, 597–598
   changes, accepting, 658–659
   creating new, 55–58
   Enterprise Global template, 587
   options, setting, 53–54
   Outlook, integrating with PWA
      assignments, 684
      described, 681–682
      options, 687–688
      setting up, 682–683
      updates, 684–687
   redefining, 319–320
   resource scheduling, 123, 130–132
   schedule options, setting, 54–55
   selecting, 51
   system design, 508–509
   task duration, entering in months, 84
timescale
   cost analysis, 427–431
   Gantt Chart, 29, 97–100
   graphic, attaching, 283
   PWA, 601–602
   saving, 198
   timing tasks, assigning, 88
   Working Days report, 390–391
calendar view
   described, 158–159
   formatting, 260, 271–272
Callos, John D. (Project consultant), 864–866
Cancel button, UserForm, 798
case studies
   Asian conglomerate, 864–866
   BCE Emergis, 869–870
   DEA Brown & Sharpe Limited, 851–855
   EDS, 866–868
   Fortune 100 company, 855–856
   Fortune 100 company, IT division, 868–869
   Longs Drug Stores, 856–858
   Nebraska Arts Council, 858–860
   Webcasting services company, 860–864
Cash Flow report, 391–393
categories
   double-checking settings, 575–578
   text formatting, applying to, 253–254
CD, back-of-the-book
   project sample files, 882–883
   software, 875–882
   troubleshooting, 883
cells, entering information, 35–36, 121
changes
   actuals
      accelerating, 375–376
      adjusting, 659
      calculation options, 356–359
      costs, 366–371
      defined, 355
      estimates versus, tracking, 336–337
      organizing, 355–356
      progress, reviewing, 378–383
      tasks, 360–366
      techniques and tips, 371–377
   uncompleted work, rescheduling,
      376–377
work done and remaining, 652
work or costs, tracking regularly, 372–375
assignments, publishing to e-mail workgroup, 481–484
chart
earned value, 421–427
flow
current task, viewing with predecessors and successors, 170, 295
described, 10
descriptive, 169–170
illustrated, 9
layout, changing, 268–270
node box styles, modifying, 264–265
node fields, formatting, 265–268
nodes, formatting, 263
views, 165–169, 260
Gantt Chart
dependencies, establishing, 111–113
described, 8
layout, changing, 258–262
taskbar styles and timescales, 601–602
timing tasks, 85, 97–100
viewing online, 22
Gantt Chart view
described, 28–30
details, 160
duration, assigning, 83–84
fixed cost, assigning, 142–143
sorting tasks, 217
with Task Form view, 192–193
PERT Chart EXPERT software, 878–879
chronological order, viewing tasks in, 195–196
client computers
hardware requirements, 516
software requirements, 515
Clipboard Viewer, 278
closing Project and saving files, 66
Code window, 781
codes, WBS (work breakdown structure)
assigning when copying tasks, 71
chart, illustrated, 9
creating, 220–223
Enterprise outline codes, customizing, 507
files, saving, 739
renumbering, 224–226
Coker, Ray (Project consultant), 855–856
Collaborate menu, 33
color
critical tasks, highlighting, 248
object, filling, 283, 284, 751
overallocation status codes, 718
columns
entering information, 35–36
Excel, widening, 436
Gantt table, adjusting view, 97
hiding and inserting, 205–206
macro, 760
printing, 201–202
viewing information in, 152
combination view, 213–216
combining toolbars, 742–746
ComboBox control, UserForm, 789–790
command
commonly-used, displaying, 744
deleting, 754–755
macro, assigning, 766–770
project menus, assigning, 754
UserForm button, 791–793
comma-separated value, 328
committed resources, 126–127
commonalities, progress report, 385–388
communicating
e-mail workgroup
information, publishing all, 479–481
managers’ commands, 478–479
new and changed assignments, publishing, 481–484
republishing assignments, 484–486
status update, requesting, 486–487
resource assignment, 124–126
company-wide resource pool
creating, 588–589
custom field values, assigning, 587
described, 22, 509, 587
editing, 589–592
comparing portfolio models, 723
Completed Tasks report, 398
computer system administrator
IIS, enabling, 521–523
mode, checking, 523–524
Project Server
connecting through PWA, 549–558
installing, 539–548
requirements, reviewing, 513–518
troubleshooting, 558
Continued
computer system administrator (continued)
PWA
Analysis Services server, specifying, 549
mail server information, setting up, 552–553
OLAP server information, entering, 555–556
operation modes, changing, 554–555
SharePoint portal server information, modifying, 553–554
WSS server information, entering, 549, 556–558
SQL Server and Analysis Services, 519–521
Windows (Microsoft) accounts
groups, adding new accounts to proper, 526–528
setting up, 524–526
WSS Administrator account, creating, 526
Windows SharePoint Services
described, 528–533
extending WSS site, 533–536
integrating with Project Server, 536–539
security issues, 529
concurrent tasks, 320–322
configuration strategy, 509–510
conflicts
constraint and dependency, 103–104
described, 309–310
displaying, 139, 178, 311–315
resolving
allocations, changing, 17, 315–318
calendar, redefining, 319–320
contouring assignment over time, 328–331
delaying tasks by leveling workloads, 323–328
overtime scheduling, 318–319
part-time work, 320–322
pooling, 332
start time, controlling, 322–323
connecting to Project Server
logging on, 626–628
logon account, creating, 624–626
consistency in appearance, importance, 245
consolidating projects
all open projects, 451–452
described, 441–442
inserting project into host file, 444–450
links, changing across projects, 455–456
objectives, 442–444
subprojects, moving within, 452–453
tasks, linking across projects, 453–455
using inserted projects and source files, 450–451
constraint
changing to resolve scheduling problem, 292–294
dependencies, interacting, 103–104
described, 93, 94, 95–96
indicators, 155
consultants
Boring, Neal, 855–856
Cabbell, Sally, 857–858
Callos, John D., 864–866
Coker, Ray, 855–856
Davis, Barbee, 858–860
finding, 504
questionnaires, 506
contouring assignment
availability, 331
described, 328–329
indicators, 156
pattern, setting, 329–331
copying
hyperlinks, 497
pictures, 273–278
Project data to Microsoft Word, 825–826
tables, 209
tasks to outline, 69–71
cost
assigning people with lower versus higher, 180–181
baseline, changing, 339
Budget report, 394
Cash Flow report, 391–393
earned value, analyzing, 393–394, 421–427
estimates, monitoring, 732–737
examining, 141
fixed, 141–144
indicators, 420–421
information, gathering, 119–120
Overbudget reports, 394–395
overriding resource valuations, 369–371
per use, setting, 123
PivotTable analysis, 431–436
planning, 16
progress reports, 391–395
project length and, 302
researching, 47
resource rate changes, accounting for, 144–147
resource table, 368–369
resources, 118, 366–367
salaried employees, extending workday, 319–320
Task Cost table, tracking, 349–350
task table, 367–368
timescaled information, analyzing, 427–431
tracking, 336, 372–375, 511
cost variance. *See CV*
CPI (Cost Performance Index), 413
critical path
described, 5–6, 298
identifying, 299–302
multiple, 305–308
shortening, 302–305
viewing across multiple projects, 459–462
critical task
filtering
key components, 780–781
macro, writing, 774–778
specified resources, showing, 778–779
testing code, 781–783
highlighting, 248
summary report, 390
crosstab, 406–407
.CSV (comma-separated value) files, 828
cube, OLAP (Online Analysis Processing)
Administrator account, creating, 524–526
Analysis Services Repository, migrating, 606–608
building, 605–606, 608–612
described, 664
trends and potential problems, identifying, 708–713
users, viewing cube, 612–615
“what if” question, answering, 713–723
current date line, 51
custom fields
Enterprise Global template, 583–587
system design, 507
CV (cost variance)
Cash Flow report, 393
Earned Value report, 394, 412
percentage, 413
D
daily tasks
Who Does What When Report, 400–401
workday, setting, 91
data entry
actualls
organizing, 355–356
tasks, 360–366
techniques and tips, 371–377
cells, entering information, 35–36
requirement, 12–13
working environment, customizing, 728–731
data fields, creating custom, 507
data gathering
costs, 119–120
dependencies, 48
detail tasks, 46–47
resources, identifying, 47
steps, 45–46
time limits, 47
database
Access (Microsoft), 820–825, 839–840
ingine, minimum, 514
multiple servers, 542
Project Server
configuring, 532–533, 540–542
importing projects, 593–597
managing, 505, 618
opening project from, 631–632
sample, 540
security templates, 569–570
views, 508, 572–575
resources, storing, 501
SQL, creating for OLAP cube, 605–608
storing Web-based project, 630–631
timphased data, expanding, 740
date
earned value, 416–417
format, setting, 261
scheduling project, 51
Tasks Starting Soon report, 397
Davis, Barbee (Project consultant), 858–860
Davis Consulting case study, 858–860
day of the week, start day, 54
days, working
  administrative projects, 597–598
  calendar, 509
  changes, notifying managers, 688–690
  contiguous, selecting, 131
  daily tasks, setting, 91
  partial, setting, 132
  standard calendar, 51
  summary reports, 390–391
DEA Brown & Sharpe Limited case study, 851–855
deadlines
  setting, 52
  tasks, 94–96
  trimming time from schedule, 47
default home page appearance, 603–604
Defense Department WBS (work breakdown structure) codes
  chart, illustrated, 9
  creating, 220–223
  Enterprise outline codes, customizing, 507
  files, saving, 739
  renumbering, 224–226
delays
  dependencies, allowing, 104–106
  displaying, 161–162
  leveling workloads, 323–328
delelgating tasks, 690–692
deleting
  commands and menus, 754–755
  dependencies, 115
  hyperlinks, 495
  old database information, 618
  resource assignments, 139–140, 317–318
  rows from Details section, 154
  toolbar tools, 746–747
deliverables, tracking, 336
demote, 67
Department of Defense WBS (work breakdown structure) codes
  chart, illustrated, 9
  creating, 220–223
  Enterprise outline codes, customizing, 507
  files, saving, 739
  renumbering, 224–226
dependency, task
  adjusting to resolve scheduling problems, 294–296
  consolidating projects, 442
  deleting, 115
  described, 11
  establishing
    constraints, interaction with, 103–104
    described, 102–103
    FF, 110–111
    FS, 108–109, 111–113
    overlaps and delays, 104–106
    SF, 109
    SS, 109–110
    types, 107–111
    information gathering, 48
    viewing, 114–115
Descriptive Network Diagram, 169–170
design
  Calendar view, formatting, 272
  Gantt Chart toolbars, 258–262
  network diagrams, 268–270
design approvers, identifying, 504
Detail Gantt view, 159–160
detail task
  dependencies, 111
  displaying, 72
  information gathering, 46–47
  moving in outline, 67
  new project, creating, 60–63
  rollup views, 183
Details section view, 154–155
diagrams
  drawing, 281–284
  project management, 8–10
dialog boxes, creating
  Cancel button, 798
  ComboBox, 789–790
  CommandButton, 791–793
  creating, 784–785
  described, 783
  label, 787–789
  OK button to change work, 795–798
  resource name display, 793–795
  size, adjusting, 785–786
  sub procedure showing, 799–800
  TextBox, 790–791
  window, 781
disc, back-of-the-book
  project sample files, 882–883
software, 875–882
troubleshooting, 883

displaying
filtered lists
  applying, 213, 234–235
  AutoFilters, 237–238
  creating WBS codes, 220–223
critical tasks, 7, 301–302, 304–305, 774–778
customizing, 236–237
database exports, 823
described, 230
grouping, 238–243
multiple, 542
outline numbers, defining, 226–230
PERT Chart and Network Diagram
  views, 166
renumbering WBS codes, 224–226
resources, 134, 180, 233–234, 313–315, 778–779
sorting, 216–219
tasks, 71–74, 231–233
views
  adding, 211–213
  changing, 37–38, 803
  combination, creating, 213–216
described, 151–152
Details section, changing, 154–155
double-checking settings, 571–575
indicators, 155–156
reasons to vary, 210
resource conflicts, spotting, 311–313
sharing among projects, 741–742
switching among, 23
system design, 508
table, changing, 152–154, 203–210
drawings
  copying, 273–278
  creating, 281–284
  inserting, 279–281
  modifying, 284–285
  using in schedules, 278–279
duplicating
  hyperlinks, 497
  pictures, 273–278
Project data to Microsoft Word, 825–826
tables, 209
tasks to outline, 69–71
duration
  adding time to tasks, 290
  baseline, tracking progress against, 346–347
critical path, shortening, 302–305
described, 6–7
effort-driven tasks and resources, 119
fixed-duration tasks, 7–8, 81, 321
fixed-work tasks, 82
Gantt Chart symbol, 10
grouping tasks by, 167
E
EAC (estimate at completion), 394, 412–413, 414
earned value
  calculating with percent complete
    method, 414–416
  charting, 421–427
date, setting, 416–417
described, 411–413
report, 393–394
tables, 417–421
earned value cost variance. See CV
edit menu, 32
editing
  Enterprise resource pool, 589–592
  hyperlinks, 495–496
  progress reports, 409
  registry to set up e-mail workgroup, 470–474
tables, 206–210
toolbar button images, 749–751
views, 211
EDS project case study, 866–868
effort-driven tasks
described, 82
duration, 119
EIF (Enterprise Information Framework), 505

employee hours
assigning people with lower versus higher, 180–181
availability, calculating, 135
done during time period, 652

overtime
information, viewing, 180
rate, setting, 123
resolving scheduling problems, 288–290
scheduling, 318–319

percentage, tracking, 178, 179
resources, modifying, 131–132
salaried employees, 319–320
setting, 54, 57
start time, controlling, 322–323
viewing with Tracking Gantt View, 350–351

employee work
automating adjustment
code, adding, 793–798
controls, adding, 789–793
creating, 784–785
described, 783
size, adjusting, 785–786
sub procedure showing, 799–800

completed, updating with actuals, 365–366
resources, time needed to finish task with baseline, 380–381
tracking regularly, 372–375

employee workload
delaying tasks by leveling workloads, 323–328

leveling
automatic, 323–327
manual, 327–328

Resource Usage report, 404
Task Usage report, 402–403

empty project, imported, 849
end time, setting, 54, 92
Enterprise Global template
calendars, 587
custom fields, 583–587
described, 503

Enterprise Information Framework, 505
Enterprise Project versions, managing, 581–582
enterprise projects, checking in, 616–617

E-mail address
company, setting, 553
looking up, 125
of resources, 124

e-mail messages
customizing, 507
sending to workgroup, 489–490
updates, sending along with, 676

e-mail server
configuring, 545, 552–553
notifications and reminders, 604–605

e-mail workgroup
building, 477–478
communicating, 478–487
customizing, 487–488
described, 469–470
future of, 126, 470
hyperlinks, 493–497
Internet interface, 492–493
management procedures, establishing, 489
notes, sending, 489–490
project file, routing, 490–491
setting up, 470–477

embedding
import or export failures, 848
Word document in Project, 843–846

Empire TIME software, 876

employee assignments
new and changed, publishing to e-mail workgroup, 481–484
Overallallocated Resources report, 401–402
part-time, 320–322
receiving online, 22
republishing to e-mail workgroup, 484–486
To Do List report, 401
Who Does What report, 399–400
Who Does What When report, 400–401
Enterprise Resource Pool
creating, 588–589
custom field values, assigning, 587
described, 22, 509
editing, 589–592
Enterprise Resources
adding, 641–642
checking in, 616–617
defining, 118
entries, formatting calendar, 271–272
Entry Sheet view, PERT analysis, 172
environment, work
fields
data entry, 728–731
described, 727–728
formulas, 732–737
interface
Organizer, 741–742
project menus, 751–755
Saving files, 739–740
toolbars, 742–751
Windows taskbar icons, 737–739
estimate at completion. See EAC
estimates
cost, monitoring, 732–737
durations, 84
tracking versus actuals, 336–337
Excel (Microsoft)
earned value, 421–427
exporting information, 816–820
importing information, 835–839
PivotTables, creating, 431–436, 816
timescaled earned value data, 427–431
Timesheet grid, 677–678
executives
defined, 505
summary, multi-project, 705–708
trends and potential problems, identifying, 708–713
“what if” analysis, 713–723
exempt employees, 319–320
expected durations. See PERT analysis
Expected Gantt view, 173–174
expenditures, tracking, 336
expense accounting system, 876
exporting information
to Access database, 820–825
described, 815–816
to Excel, 816–820
to graphic image, 826–828
to Office files, 816–826
to other project management software, 830
problems, 849
to text files, 828–830
troubleshooting, 847–849
for Web pages, 830–832
to Word, 825–826
as XML file, 832–834
eXtensible Markup Language file, 832–834
F
facility sample file, 883
FF (finish-to-finish) dependencies, 110–111
fields
customizing
data entry, 728–731
described, 727–728
formulas, 732–737
resource assignments, 127–128
defined, 121
earned value, 412–417
improper in imported information, 849
nodes, displaying, 167–169
File menu, 32
file, project
hyperlink to
described, 493–494
editing, 495–496
indicator, 156
inserting, 494–495
moving or copying, 497
repairing, 497
opening new, 48–50
protecting, 65–66
routing to e-mail workgroup, 490–491
saving
closing Project, 66
in custom working environment, 739–740
for first time, 63–64
as template, 65
as Web page, 830–832
fill handle
copying tasks, 70
Gantt Chart, 28
filter
  applying, 213, 234–235
  AutoFilters, 237–238
critical tasks, 7, 301–302, 304–305, 774–778
customizing, 236–237
database exports, 823
described, 230
grouping, 238–243
multiple, 542
PERT Chart and Network Diagram views, 166
resource
  conflicts, spotting, 313–315
  by groups, 180
  limiting, 134
  listed, 233–234
task, listed, 231–233
financial progress
costs, evaluating
  charts, 421–427
  PivotTable analysis, 431–436
timescaled information, 427–431
earned value, 411–421
project adjustments, 436–437
finish date
  actuals, updating with, 360–361
deadlines, 95
interim plan, 343
setting, 51, 52, 59
Finish No Earlier Than/Finish No Later Than
  constraint, 94
finish tasks, duration versus, 85
finish-to-finish dependencies, 110–111
finish-to-start dependencies, 108–109, 111–113
fiscal year, setting, 54
fixed consumption, 138
fixed cost, 141–144
fixed-duration tasks, 7–8, 81, 321
fixed-unit tasks, 80
fixed-work tasks, 82
flags
  described, 122
e-mail, sent, 480
multiple, viewing, 129
nodes, displaying, 167–169
views, 155–156
float
  adjusting to resolve scheduling problems, 290–292
described, 5–6
evaluating, 159–160
total, 305
floor
  adjusting to resolve scheduling problems, 290–292
described, 5–6
evaluating, 159–160
total, 305
flow chart
  current task, viewing with predecessors and successors, 170, 295
described, 10
descriptive, 169–170
illustrated, 9
layout, changing, 268–270
node box styles, modifying, 264–265
node fields, formatting, 265–268
nodes, formatting, 263
views, 165–169, 260
fonts
  caution, 254
  formatting, 251–252
footer
  graphics, inserting, 279–281
  printing, 200
format
  files, saving, 739–740
  graphics, 279
  PWA, 602–603
Format menu, 33
formatting
  Calendar view, 159, 271–272
critical tasks, identifying, 300–301
network diagram nodes, 263
node fields, 265–268
taskbars, 255–258
Formatting toolbar, 34, 742–744
forms
  creating
    Cancel button, 798
    ComboBox, 789–790
    CommandButton, 791–793
  creating, 784–785
described, 783
G
Gantt Chart
dependencies, establishing, 111–113
described, 8
layout, changing, 258–262
taskbar styles and timescales, 601–602
timing tasks, 85, 97–100
viewing online, 22
Gantt Chart view
described, 28–30
details, 160
duration, assigning, 83–84
fixed cost, assigning, 142–143
sorting tasks, 217
with Task Form view, 192–193
Gantt Chart Wizard, 247–250

gap
establishing, 105, 107
not using, 114
gathering information
costs, 119–120
dependencies, 48
detail tasks, 46–47
resources, identifying, 47
steps, 45–46
time limits, 47
generic resources
described, 118
replacing with real, 642–643
GIF image file, rendering, 827
Global template file, 760
goal area
adding to Tasks, 808–809
described, 801
HTML page, 804–806
goals
defined, 4
identifying, 14
graphics
in schedules, 278–279
toolbar button, changing and editing, 749–751
gridlines, 262–263
grouping
filtered views, 238–243
formats, PWA, 602–603
Network Diagram tasks, 167
resources by task, 196–197
groups
accounts, adding to Windows accounts, 526–528
double-checking settings, 570–571
resources, assigning, 122, 180–181
tasks, adjusting timing, 80
H
handle, fill
copying tasks, 70
Ganttt Chart, 28
hardware requirements
for client computers, 516
for servers, 515
headers
columns, wrapping, 210
graphics, inserting, 279–281
HTML page, 831
printing, 199–200
Help
Office Assistant, 74–75
online, 39, 76
resource selection, 134–137
system, 39, 75–76
hiding
consolidated project tasks, 448
Office Assistant, 75
outline tasks, 71–74
Project Guide, 27
table columns, 205–206
View Bar, 23
highlighting critical tasks, 248
Home Page
  appearance, default, 603–604
  reviewing, 669–670
host file, 444–450
hours
  assigning people with lower versus higher, 180–181
  availability, calculating, 135
  done during time period, 652
overtime
  information, viewing, 180
  rate, setting, 123
  resolving scheduling problems, 288–290
  scheduling, 318–319
percentage, tracking, 178, 179
resources, modifying, 131–132
salaried employees, 319–320
setting, 54, 57
start time, controlling, 322–323
  viewing with Tracking Gantt View, 350–351
HRIS (Human Resources Information and Payroll System) case study, 857–858
HTML (HyperText Markup Language) page
  custom task, 809–810, 813
  Project Guide, 802–806
  saving files as, 830–832
hyperlinks
  described, 493–494
  editing, 495–496
  indicator, 156
  inserting, 494–495
  moving or copying, 497
  repairing, 497
HyperText Markup Language. See HTML page
icons, Windows taskbar, 737–739
ID number, sorting tasks by, 217
IdeaBridge strategy and management consulting firm, 864–866
IIS (Internet Information Services)
  enabling, 521–523
  mode, checking, 523–524
  required, 518
  version, required, 514
images
  exporting information, 826–828, 831
  in schedules, 278–279
toolbar button, changing and editing, 749–751
implementation strategy, 509–510
importing
  Access database information, 839–840
  described, 815–816
  Excel workbook information, 835–839
  Microsoft Project Exchange files, 846–847
  Outlook task lists, 13, 840
  problems when, 847–849
  projects, 593–597, 835
text files, 847
Word document information, 840–846
indicators
  described, 122
  e-mail, sent, 480
  multiple, viewing, 129
  nodes, displaying, 167–169
  views, 155–156
information, entering
  actuals
    organizing, 355–356
    tasks, 360–366
    techniques and tips, 371–377
  cells, entering information, 35–36
  requirement, 12–13
  working environment, customizing, 728–731
information gathering
  costs, 119–120
  dependencies, 48
detail tasks, 46–47
  identifying, 47
  steps, 45–46
time limits, 47
InfoSource, Inc. (ISI) software, 882
initials, resource, 122
Innate Info software, 877
Innate Timesheets software, 877
input windows
  Cancel button, 798
  ComboBox, 789–790
  CommandButton, 791–793
  creating, 784–785
  described, 783
  label, 787–789
  OK button to change work, 795–798
  resource name display, 793–795
  size, adjusting, 785–786
sub procedure showing, 799–800
TextBox, 790–791
window, 781
Insert menu, 33
inserted project
consolidating, 450–451
described, 445, 835
into host file, 444–450
inserting
drawings and objects, 279–281
hyperlinks, 494–495
Table columns, 205–206
toolbars and menus with objects, 35
integrated
Outlook calendar with PWA, 681–688
Windows SharePoint Services with Project
Server, 536–539
interactions, task
adjusting to resolve scheduling problems,
294–296
consolidating projects, 442
deleting, 115
described, 11
establishing
constraints, interaction with, 103–104
described, 102–103
FF, 110–111
FS, 108–109, 111–113
overlaps and delays, 104–106
SF, 109
SS, 109–110
types, 107–111
information gathering, 48
viewing, 114–115
interface, customizing
Organizer, 741–742
project menus, 751–755
Saving files, 739–740
toolbars, 742–751
UserForm
ComboBox, 789–790
CommandButton, 791–793
creating, 784–785
described, 783
label, 787–789
OK button to change work, 795–798
resource name display, 793–795
size, adjusting, 785–786
sub procedure showing, 799–800
TextBox, 790–791
window, 781
Windows taskbar icons, 737–739
interim plans, 343–345
Internet
Web page
Gantt Chart, creating file for, 277–278
saving files as, 830–832
Web-based project, creating
administrative projects, 634–636
opening project from Project Server
database, 631–632
options, setting, 628–630
publishing project information, 634
storing in Project Server database,
630–631
to-do lists, 636–640
viewing pages in Project Professional,
632–633
Webcasting services company case study,
860–864
Internet Explorer (Microsoft)
client software requirement, 515
PWA
described, 22, 501–503, 549–551
effective use, 505, 705–708
Gantt taskbar styles and timescales,
601–602
grouping formats, 602–603
logging onto, 550–551
mail server information, setting up,
552–553
menus, establishing, 599
notifications and reminders, 604–605
OLAP server information, entering,
555–556
opening, 22
operation modes, changing, 554–555
Outlook tasks, 680–688
pages, displaying, 804
resources, assigning, 649–651, 684
server, specifying, 549
SharePoint portal server information,
modifying, 553–554
tracking settings, 599–601
trends and potential problems,
identifying, 708–713
Continued
Internet Explorer (Microsoft) (continued)
PWA (continued)
user, logging on, 668–669
“what if” analysis, 713–723
WSS server information, entering, 556–558
security configuration, 529
Internet Information Services. See IIS
Internet interface, 492–493
interviews, conducting, 506
invalid information, export/import flaw, 849
investment, return. See ROI, calculating
issues
creating, 702
tracking, 660–662, 663
IT administrator
IIS, enabling, 521–523
mode, checking, 523–524
Project Server
connecting through PWA, 549–558
installing, 539–548
requirements, reviewing, 513–518
troubleshooting, 558
PWA
Analysis Services server, specifying, 549
mail server information, setting up, 552–553
OLAP server information, entering, 555–556
operation modes, changing, 554–555
SharePoint portal server information, modifying, 553–554
WSS server information, entering, 549, 556–558
SQL Server and Analysis Services, 519–521
Windows (Microsoft) accounts
groups, adding new accounts to proper, 526–528
setting up, 524–526
WSS Administrator account, creating, 526
Windows SharePoint Services, installing and configuring
described, 528–533
extending WSS site, 533–536
integrating with Project Server, 536–539
security issues, 529
items
copying, 273–278
creating, 281–284
inserting, 279–281
modifying, 284–285
schedules, using visuals in, 278–279
K
key markers
described, 7
establishing, 46
Gantt Chart symbol, 10
summary reports, 390
timing tasks, 88–89
key task
filtering
key components, 780–781
macro, writing, 774–778
specified resources, showing, 778–779
testing code, 781–783
highlighting, 248
summary report, 390
keyboard shortcut, assigning macro, 759, 770–772
L
labels
resources, 122
UserForm object to adjust work, 787–789
lag time
establishing, 105, 107
not using, 114
LAN (Local Area Network), 503
laptop computer, 669
layout
Calendar view, formatting, 272
Gantt Chart toolbars, 258–262
network diagrams, 268–270
lead time
establishing, 105
not using, 114
legend, printing, 200
length of time
adding to tasks, 290
baseline, tracking progress against, 346–347
critical path, shortening, 302–305
described, 6–7
effort-driven tasks and resources, 119
drawn -duration tasks, 7–8, 81, 321
fixed-work tasks, 82
Gantt Chart symbol, 10
grouping tasks by, 167
leveling, resource
delay, showing, 161–162
described, 52
indicator, 156
with Resource Allocation, 176–177
workloads, 323–328
library, document
creating, 697–698
posting, 695–697
limitation
changing to resolve scheduling problem, 292–294
dependencies, interacting, 103–104
described, 93, 94, 95–96
indicators, 155
line thickness and color, 284
linking
inserted project to source file, 450–451
tasks across projects, 453–455
Word document in Project, 843–846
links
changing across projects, 455–456
objects won’t import or export, 848
list
project categories, displaying, 807
resources, creating, 120–123
listed views, 156–157
load-balancing, 558
Local Area Network, 503
logging off, 704
logging on
Project Server, 626–628
PWA, 668–669
logon account, creating, 624–626
long-range goals, 14
Longs Drug Stores project case study, 856–858
look and feel
Calendar view, 159, 271–272
changing, 245–246
consistency, importance of, 245
critical tasks, identifying, 300–301
drawings and objects
copying, 273–278
creating, 281–284
inserting, 279–281
modifying, 284–285
using in schedules, 278–279
Gantt Chart Wizard, 247–250
network diagrams, 263–270
taskbars, 254–263
text, 251–254
lunchtime, ignoring, 106
M
macro
critical tasks filter, recording, 774–778
described, 757
keyboard shortcut, 770–772
menu command, 766–770
recording, 758–761
Rollup Formatting, 186–189
running, 761–762
toolbar button, 762–766
main page
appearance, default, 603–604
reviewing, 669–670
management, project
critical path and slack, 5–6
dependencies, 11
described, 4–5
diagrams, 8–10
durations and milestones, 6–7
Project Server, uses for, 22
software
exporting information to non-Project, 830
Microsoft Project tools, 13–14
procedures, 11–12
samples, 876–882
user requirements, 12–13
tasks, 7–8
manager
e-mail workgroup commands, 478–479
multiple, supporting, 645
procedures, establishing for e-mail workgroup, 489
tasks import to, 47
workday changes, 688–690
“what if” analysis, 713–723
WSS server information, entering, 556–558
security configuration, 529
Microsoft Office files
exporting
  to Access database, 820–825
  to Excel, 816–820
  problems, 849
  to Word, 825–826
importing
  Access database information, 839–840
  Excel workbook information, 835–839
  Outlook task lists, 840
  Word document information, 840–846
online help, 76
sharing, 39
Microsoft Outlook
PWA integration
  integrating calendar with PWA, 681–688
  viewing information, 681
  task lists, importing, 13, 840
Microsoft Paint, 827–828
Microsoft PowerPoint, exporting Gantt Chart to, 273–276
Microsoft Project
  behavior of Project Guide, controlling, 811–812
  new features, 38–41
  setting up e-mail workgroup, 475–477
  tools, 13–14
Microsoft Project Exchange files, importing, 846–847
Microsoft Project Professional
  consolidating projects, 442
  Project Server, 502
  viewing pages in, 632–633
Microsoft SQL 2000, 514, 515
Microsoft Windows
  accounts, setting up, 524–526
  Active Directory, 135
  taskbar icons, customizing, 737–739
  version, checking before Project Server installation, 539
Microsoft Windows Server 2003, 514
Microsoft Word
  document information, importing, 840–846
  exporting information, 825–826
  Gantt Chart, copying to, 273–278
milestones
  described, 7
  establishing, 46
  Gantt Chart symbol, 10
  summary reports, 390
  timing tasks, 88–89
Milestones Professional 2002 software, 878
MIL-HDBK-881 (WBS codes, described), 220
mistakes, learning from, 18–19
mixed mode, SQL Server and Analysis Services, 520–521
mode, IIS (Internet Information Services), 523–524
module, 799
months, entering duration in, 84
moving
  hyperlinks, 497
  objects in drawings, 285
  subprojects within projects, 452–453
  tasks in outline, 66–67
.MPD format, exporting to, 830
.MPX file. See Microsoft Project Exchange files, importing
MPX Translator software, 879
Multiple Baselines Gantt view, 164
Must Finish On/Must Start On constraint, 94
N
name
  column header, wrapping, 210
  column width, adjusting to fit, 204
  resource, 122
Nebraska Arts Council case study, 858–860
network administrator
  IIS, enabling, 521–523
  mode, checking, 523–524
Project Server
  connecting through PWA, 549–558
  installing, 539–548
  requirements, reviewing, 513–518
  troubleshooting, 558
PWA
  Analysis Services server, specifying, 549
  mail server information, setting up, 552–553
  OLAP server information, entering, 555–556
Continued
network administrator (continued)
PWA (continued)
operation modes, changing, 554–555
SharePoint portal server information, modifying, 553–554
WSS server information, entering, 549, 556–558
SQL Server and Analysis Services, 519–521
Windows (Microsoft) accounts groups, adding new accounts to proper, 526–528
setting up, 524–526
WSS Administrator account, creating, 526
Windows SharePoint Services, installing and configuring
described, 528–533
extending WSS site, 533–536
integrating with Project Server, 536–539
security issues, 529
network diagram
current task, viewing with predecessors and successors, 170, 295
described, 10
descriptive, 169–170
illustrated, 9
layout, changing, 268–270
node box styles, modifying, 264–265
node fields, formatting, 265–268
nodes, formatting, 263
views, 165–169, 260
networking
with browser, PWA
default home page appearance, 603–604
described, 22, 501–503, 549–551
effective summary of all projects, 705–708
Gantt taskbar styles and timescales, 601–602
grouping formats, 602–603
logging onto, 550–551
mail server information, setting up, 552–553
menus, establishing, 599
notifications and reminders, 604–605
OLAP server information, entering, 555–556
opening, 22
operation modes, changing, 554–555
Outlook tasks, 680–688
pages, displaying, 804
resources, assigning, 649–651, 684
server, specifying, 549
SharePoint portal server information, modifying, 553–554
tracking settings, 599–601
trends and potential problems, identifying, 708–713
user, logging on, 668–669
“what if” analysis, 713–723
WSS server information, entering, 556–558
Project Server
calendar management, 56
connecting Project Resource manager, 624–628
consolidating projects, 442
database, 618
described, 22, 501–503
Enterprise Custom Fields, setting, 51
information, viewing in Project, 157
new features, listed, 40
peripheral software, installing, 518–528
pitfalls, avoiding, 510–512
planning, 504–510
prompt when opening project file, 48
requirements, reviewing, 513–518
troubleshooting, 558
Windows SharePoint Services, integrating, 536–539
requirements, 516
networks of tasks, 305–308
new assignments, publishing, 481–484
new project, creating
basic information, 50–53
calendars, 53–58
help, 74–76
information gathering, 45–48
opening file, 48–50
outline, 66–74
with Project Guide, 806–807
saving, 63–66
subtasks, 60–63
tasks, entering, 58–59
node
box styles, modifying, 264–265
details, enlarging, 165
fields, formatting, 265–268
network diagrams, formatting, 263
noncritical tasks
becoming critical, 298
with slack, 290–291
non-exempt employees
information, viewing, 180
rate, setting, 123
resolving scheduling problems, 288–290
scheduling, 318–319
notebook computer, 669
notes
e-mail workgroup, sending, 489–490
indicator, 156
resources, 129–130
tasks, 100–102, 676
notification
of assignments, 643–645
e-mail server setup, 552–553
PWA, 604–605
numbering
list of tasks to finish project, 220–221
WBS codes, 224–226

O
objectives, consolidating projects, 442–444
objects
copying, 273–278
creating, 281–284
inserting, 279–281
modifying, 284–285
schedules, using visuals in, 278–279
Office Assistant, 74–75
Office (Microsoft) files
exporting
to Access database, 820–825
to Excel, 816–820
problems, 849
to Word, 825–826
importing
Access database information, 839–840
Excel workbook information, 835–839
Outlook task lists, 840
Word document information, 840–846
online help, 76
sharing, 39
OK button, UserForm, 795–798
OLAP (Online Analysis Processing) cube
Administrator account, creating, 524–526
Analysis Services Repository, migrating,
building, 605–606, 608–612
described, 664
trends and potential problems, identifying,
708–713
users, viewing cube, 612–615
“What if” question, answering, 713–723
ongoing adjustments, tracking, 337–338
online
Web browser, using Project with
described, 22, 501–503, 549–551
executive use, 505
Gantt taskbar styles and timescales,
601–602
grouping formats, 602–603
logging onto, 550–551
mail server information, setting up,
552–553
menus, establishing, 599
notifications and reminders, 604–605
OLAP server information, entering,
555–556
opening, 22
operation modes, changing, 554–555
Outlook tasks, 680–688
pages, displaying, 804
resources, assigning, 649–651, 684
server, specifying, 549
SharePoint portal server information,
modifying, 553–554
summary of all projects, 705–708
tracking settings, 599–601
trends and potential problems,
identifying, 708–713
user, logging on, 668–669
“What if” analysis, 713–723
WSS server information, entering,
556–558
Web page
Gantt Chart, creating file for, 277–278
saving files as, 830–832
Web-based project, creating
administrative projects, 634–636
opening project from Project Server
database, 631–632

Continued
online (continued)
  Web-based project, creating (continued)
    options, setting, 628–630
    publishing project information, 634
    storing in Project Server database, 630–631
    to-do lists, 636–640
    viewing pages in Project Professional, 632–633
  Webcasting services company case study, 860–864
Online Analysis Processing. See OLAP cube
online help, 76
opening project
  from Project Server database, 631–632
  using resource sharing pool, 464
operating system, 539
optimistic durations. See PERT analysis
Optimistic Gantt view, 172–173
ordering task views
  columns, changing, 207
  outline numbers, defining, 226–230
  sorting, 216–219
  WBS codes, 220–226
organizational standards, establishing and enforcing, 507–509, 728
Organizer, customizing work environment, 741–742
outline
  adjusting tasks, 66–69
  copying tasks, 69–71
  displaying and hiding tasks, 71–74
  numbers, 226–230
outline codes
  files, saving, 739
  system design, 507
Outlook (Microsoft)
  PWA integration
    integrating calendar with PWA, 681–688
    viewing information, 681
  task lists, importing, 13, 840
Overallocated Resources report, 401–402
overallocation
  cause, 309
  finding, 181–182, 311–315
  Portfolio Analyzer, 711
  replacing assignment, 139
  resolving
    allocations, changing, 315–318
    calendar, redefining, 319–320
    contouring assignment over time, 328–331
    delaying tasks by leveling workloads, 323–328
    overtime scheduling, 318–319
    part-time work, assigning, 320–322
    pooling, 332
    start time, controlling, 322–323
    viewing, 310
    working hours, tracking, 178, 179
Overbudget reports, 394–395
overlaps
  critical tasks, 303
  dependencies, allowing, 104–106
overriding resource valuations, 369–371
overtime
  information, viewing, 180
  rate, setting, 123
  resolving scheduling problems, 288–290
  scheduling, 318–319
overutilization, 179
P
padding time estimates, 81
page breaks, printing manually set, 198
page numbers, printing, 199–200
Page Setup box, 201
Paint (Microsoft), 827–828
part-time work
  assigning, 320–322
  resource availability, setting, 132, 137
password
  file protection, 65–66
  MSProjectServerUser and MSProjectUser accounts, 542
  OLAP administrator, 526
  Project Server administrator, 548
  security guidelines, 671
  user, changing, 670–672
  WSS administrator, 526
pasting
  Microsoft Word data into Project, 841–843
  Project data to Microsoft Word, 825–826
path, critical
  described, 5–6, 298
  identifying, 299–302
  multiple, 305–308
  shortening, 302–305
  viewing across multiple projects, 459–462
pattern, contouring assignment over time, 329–331
payroll case study, 857–858
PDF file of book, 876
percent complete method
  earned value, 411, 413, 414–416
  setting, 364–365
  viewing, 389, 652
percentage rate increases, 145
peripheral software, installing, 518–528
permissions
  groups, 570–571, 581
  templates, double-checking, 568–570
  users, 579–580
PERT Chart EXPERT software, 878–879
PERT (Program Evaluation and Review Technique) analysis
  current task, viewing with predecessors and successors, 170, 295
  described, 10, 171
  descriptive, 169–170
  Entry Sheet view, 172
  executive, 713–723
  Expected Gantt view, 173–174
  filtering, 166
  illustrated, 9
  layout, changing, 268–270
  node box styles, modifying, 264–265
  node fields, formatting, 265–268
  nodes, formatting, 263
  Optimistic Gantt view, 172–173
  Pessimistic Gantt view, 174–175
  tables, viewing, 154
  views, 157, 165–169, 260
  weighted average, calculating, 175–176
pessimistic durations. See PERT analysis
Pessimistic Gantt view, 174–175
physical percent complete, 411, 413, 414–416
pictures
  in schedules, 278–279
  toolbar button, changing and editing, 749–751
pivotal tasks
  filtering
    key components, 780–781
    macro, writing, 774–778
    specified resources, showing, 778–779
    testing code, 781–783
  highlighting, 248
  summary report, 390
PivotTable
  costs, evaluating, 431–436
  Portfolio Analyzer, 709–710, 712, 713
  worksheets created, 816
planning
  project, 15–16
  Project Server installation, 504–509
playing macros, 761–762
pool
  opening project that uses, 464
  resource sharing, 463–464
  updating, 465–466
portfolio managers/analyzers
  Administrator account, creating, 524–526
  Analysis Services Repository, migrating, 606–608
  building, 605–606, 608–612
  described, 505, 664
  trends and potential problems, identifying, 708–713
  users, viewing cube, 612–615
  “what if” question, answering, 713–723
Portfolio Modeler, 649
posting documents, 695–697
pound signs (###), 400
PowerPoint (Microsoft), exporting Gantt Chart to, 273–276
predecessor task
  constraint, 103
  dependency, 107
  linking tasks, 453–454
  viewing with current task, 170, 295
prerequisites
  assessing
    design approvers, identifying, 504
    interviews, conducting, 506
    questionnaire, creating, 505–506
    ROI, calculating, 506
Continued
prerequisites (continued)
assessing (continued)
staff member to interview, identifying, 505
team, setting up, 504
network environment, 516
Project Server, reviewing, 513–518
previewing report before printing, 26, 386–387
printing
current view as a report, 26–27
images, 827
previewing, 26, 386–387
project, 197–202
report, 388
task notes along with schedule, 102
Timesheet grid, 677–678
priority
limiting number, 731
setting, 51, 323–324
problems
conflicts
constraint and dependency, 103–104
described, 309–310
displaying, 139, 178, 311–315
identifying potential, 708–713
overallocation
cause, 309
finding, 181–182, 311–315
Portfolio Analyzer, 711
overutilization, 179
resolving
allocations, changing, 17, 315–318
calendar, reddefining, 319–320
contouring assignment over time, 328–331
delaying tasks by leveling workloads, 323–328
overtime scheduling, 318–319
part-time work, 320–322
pooling, 332
replacing assignment, 139
start time, controlling, 322–323
underutilization, 179, 722
viewing, 310
working hours, tracking, 178, 179
Program Evaluation and Review Technique.
See PERT analysis
program, task-specific
critical tasks filter, recording, 774–778
described, 757
keyboard shortcut, 770–772
menu command, 766–770
recording, 758–761
Rollup Formatting, 186–189
running, 761–762
toolbar button, 762–766
progress
progress lines, 381–383
resources table, 380–381
tasks table, 379–380
Tracking Gantt view
described, 162–163, 378–379
interpreting, 346–348
Task Cost table, 349–350
Task Variance table, 348–349
Task Work table, 350–351
progress reports
commonalities, 385–388
costs, 391–395
customizing, 405–410
summary reports, 388–391
timing, 395–399
work assignments, 399–402
workloads, 402–404
Project Assistants case study, 868–869
project calendar, 508
Project Center
portfolio, reviewing by executive, 705–708
views, described, 698–701
Project Exchange (Microsoft) files, importing, 846–847
project file
hyperlink to
described, 493–494
editing, 495–496
indicator, 156
inserting, 494–495
moving or copying, 497
repairing, 497
opening new, 48–50
Project Resource manager
- connecting to Project Server, 624–628
- resources, assigning
  - assignment notification, 643–645
  - described, 640–641
  - enterprise, 641–642
  - generic, replacing with real, 642–643
  - with PWA, 649–651
- Resource Substitution Wizard, 645–649

tracking
- adjusting actual work, 659
- issues, 660–662, 663
- method, establishing, 652
- risks, 660, 662
- status reports, 652–656
- updates, receiving, 656–659
- versions, 663–664

version required, 623

Web-based project, creating
- administrative projects, 634–636
- opening project from Project Server database, 631–632
- options, setting, 628–630
- publishing project information, 634
- storing in Project Server database, 630–631
- to-do lists, 636–640
- viewing pages in Project Professional, 632–633

Project Server
- calendar management, 56
- connecting Project Resource manager, 624–628
- consolidating projects, 442
- database, 618
- described, 22, 501–503
- Enterprise Custom Fields, setting, 51
- information, viewing in Project, 157
- new features, listed, 40
- peripheral software, installing, 518–528
- pitfalls, avoiding, 510–512
- planning, 504–510
- prompt when opening project file, 48
- requirements, reviewing, 513–518
- troubleshooting, 558
- Windows SharePoint Services, integrating, 536–539

Project Guide
- behavior, controlling, 811–812
- defining, 806–810, 813
- described, 800–802
- new project, starting, 24–28
- online, organizing, 60
- tasks, entering, 58
- XML document elements, 802–806

Project KickStart software, 879–880

Project management
- critical path and slack, 5–6
- dependencies, 11
- described, 4–5
- diagrams, 8–10
- durations and milestones, 6–7
- Project Server, uses for, 22
- software
  - exporting information to non-Project, 830
  - Microsoft Project tools, 13–14
  - procedures, 11–12
  - samples, 876–882
  - user requirements, 12–13
- tasks, 7–8

Project menu
- adding, 752–753
- assigning new commands, 754
- deleting commands and menus, 754–755
- described, 33, 751

Project Partners
- finding, 504
- questionnaires, 506

Project Professional (Microsoft)
- consolidating projects, 442
- Project Server, 502
- viewing pages in, 632–633

protecting, 65–66
routing to e-mail workgroup, 490–491
saving
- closing Project, 66
- in custom working environment, 739–740
- for first time, 63–64
- as template, 65
- as Web page, 830–832
Project Server Support, Inc. consultants, 506
Project Summary report, 389
project templates
described, 13
Enterprise Global, 503, 583–587
files, saving as, 65
Global template file, 760
opening or starting projects, 48–49, 883
Project 2003 Bible Web page, 876
Project Web Access. See PWA
Project Workgroup Message handler, installing, 475
projections
cost, monitoring, 732–737
durations, 84
tracking versus actuals, 336–337
projects
adjustments, 436–437
coordinating multiple
all open projects, 451–452
critical path, viewing, 459–462
described, 441–442
inserted projects and source files, 450–451
inserting project into host file, 444–450
links, changing across projects, 455–456
objectives, 442–444
resources, sharing, 462–467
saving, 456–457
server design, 517–518
subprojects, moving within, 452–453
tasks, linking across projects, 453–455
viewing multiple, 458–459
enterprise, checking in, 616–617
information, publishing online, 634
inserting another, 835
progress of overall, 162–163
resource assignments, modifying, 437
schedule, changing, 437
projects, case studies
Asian conglomerate, 864–866
BCE Emergis, 869–870
DEA Brown & Sharpe Limited, 851–855
EDS, 866–868
Fortune 100 company, 855–856
Fortune 100 company, IT division, 868–869
Longs Drug Stores, 856–858
Nebraska Arts Council, 858–860
Webcasting services company, 860–864
promoting tasks in outline, 67, 68
Properties window, 780
proposed resources, 126–127
protecting files, 65–66
PSCom+ utility, 549
publication sample file, 883
publishing project information
documents, 695–697
e-mail, 479–481
online, 634
PWA (Project Web Access)
default home page appearance, 603–604
described, 22, 501–503, 549–551
executive use
defined, 505
summary of all projects, 705–708
trends and potential problems,
identifying, 708–713
“what if” analysis, 713–723
Gantt taskbar styles and timescales, 601–602
grouping formats, 602–603
logging onto, 550–551
mail server information, setting up, 552–553
menus, establishing, 599
notifications and reminders, 604–605
OLAP server information, entering, 555–556
opening, 22
operation modes, changing, 554–555
Outlook tasks, 680–688
pages, displaying, 804
resources, assigning, 649–651, 684
server, specifying, 549
SharePoint portal server information,
modifying, 553–554
tracking settings, 599–601
user, logging on, 668–669
WSS server information, entering, 556–558
Q
quality, planning, 16
questionnaire, requirements, 505–506
quitting resource sharing, 466–467
rate
  changes, accounting for, 144–147
  overtime, 123
  standard, 122
RBS (Resource Breakdown Structure), 642, 645
read-only files, creating, 65–66
recording
  macros, 758–761
  tracking, 352
recurring task, 90–92
registry editing, 470–474
Relationship Diagram view
  dependencies, reviewing, 295
  described, 170
relationships, task
  adjusting to resolve scheduling problems, 294–296
  consolidating projects, 442
  deleting, 115
  described, 11
  establishing
    constraints, interaction with, 103–104
    described, 102–103
    FF, 110–111
    FS, 108–109, 111–113
    overlaps and delays, allowing for, 104–106
    SF, 109
    SS, 109–110
    types, 107–111
  information gathering, 48
  viewing, 114–115
relocating
  hyperlinks, 497
  objects in drawings, 285
  subprojects within projects, 452–453
  tasks in outline, 66–67
remaining durations, updating, 362–364
reminder, 604–605
remote computer, 669
removing
  commands and menus, 754–755
  dependencies, 115
  hyperlinks, 495
  old database information, 618
resource assignments, 139–140, 317–318
  rows from Details section, 154
  toolbar tools, 746–747
renumbering WBS (work breakdown structure) codes, 224–226
replacing
  assignment, 139–140
  resources, 133, 645–649
report
  custom, generating in any format, 832–834
  process, assessing current, 511
  sharing among projects, 741–742
  Web publishing, 877
reports, listed
  Budget report, 394
  Cash Flow report, 391–393
  Completed Tasks report, 398
  Overallocated Resources report, 401–402
  Overbudget reports, 394–395
  Project Summary report, 389
  Resource report, 406
  Resource Usage report
    with Leveling Gantt Chart view, 176–177
    overallocation, finding, 181–182
    workloads, 404
  Should Have Started Tasks report, 398
  Slipping Tasks report, 399
  Task report, 405–406
  Task Usage, 402–403
  Tasks in Progress report, 397–398
  Tasks Starting Soon report, 397
  Top Level Tasks, summary report, 389
  Unstarted Tasks report, 396
  Who Does What report, 399–400
  Who Does What When report, 400–401
requirements
  assessing
    design approvers, identifying, 504
    interviews, conducting, 506
    questionnaire, creating, 505–506
    ROI, calculating, 506
    staff member to interview, identifying, 505
    team, setting up, 504
  network environment, 516
  Project Server, reviewing, 513–518
rescheduling
   summary report, 399
   uncompleted work, 376–377
resizing
drawings, 285
UserForm object, 785–786
resource
   allocation, 176–177, 309
   assigning
described, 137–139, 640–641
   enterprise, adding, 641–642
generic, replacing with real, 642–643
   notifying of assignments, 643–645
   with PWA, 649–651
   removing or replacing, 139–140
   Resource Substitution Wizard, 645–649
availability, 126, 135
calendars for, 53, 130–132, 509
changing, answering “what if” question, 713–723
committed or proposed booking type, 126–127
communication method, assigning, 124–126
costs, 119–120, 143–144, 366–369
custom fields, 127–128
described, 4, 117–118
enterprise
checking in, 616–617
   setting up and editing, 587–592
grouping by task, 196–197
help while selecting, 134–137
identifying, 47
list, creating, 120–123
macro to show specified, 778–779
maximum units available, 122
mechanics, 118–119
name, displaying on UserForm, 793–795
notes, adding, 129–130
overbudget report, 395
overriding valuations, 369–371
planning, 16
progress, reviewing Work table for, 380–381
rate changes, accounting for, 144–147
schedule and, 119
tables, 418–419, 615–616
tasks
   adding to, 132–133, 288
   driven by, 7–8
   fixed cost, assigning to, 143–144
   vacation time, blocking off, 132
   working hours, modifying, 131–132
resource assignment
   filter viewing
critical tasks macro, 774–778
   key components, 780–781
   specified resources macro, 778–779
testing code, 781–783
   project, modifying, 437
   by week, 401
   Who Does What Report, 399–400
   Who Does What When Report, 400–401
Resource Breakdown Structure. See RBS
resource conflict
described, 309–310
displaying, 139, 178, 311–315
resolving
   allocations, changing, 17, 315–318
calendar, redefining, 319–320
   contouring assignment over time, 328–331
delaying tasks by leveling workloads, 323–328
   overtime scheduling, 318–319
   part-time work, 320–322
   pooling, 332
   start time, controlling, 322–323
resource contouring
   availability, 331
described, 328–329
   indicators, 156
   pattern, setting, 329–331
Resource Form, 177
Resource Graph, 178–179
resource leveling
   delay, showing, 161–162
described, 52
   indicator, 156
   workloads, 323–328
resource manager, 505
Resource Name Form, 179–180
resource pool
  company-wide
    creating, 588–589
    custom field values, assigning, 587
    described, 22, 509
    editing, 589–592
    consolidating projects, 443
    creating, 463–464
  Resource report, 406
resource sharing
  consolidating projects, 443
  creating pool, 463–464
  opening project that uses pool, 464
  quitting, 466–467
  updating pool, 465–466
  Resource Sheet view, 180–181
  Resource Substitution Wizard, 133, 645–649
  Resource Usage report
    with Leveling Gantt Chart view, 176–177
    overallocation, finding, 181–182
    workloads, 404
  restricting data field entries, 730
  return on investment. See ROI, calculating
  reviewing progress, 378–383
  revising project, 17
  risk tracking, 660, 662
  ROI (return on investment), calculating, 506
Rollup view
  described, 183
  Gantt bars, setting, 261
  Rollup_Formatting macro, 186–189
  summary task bar, 184–186
  switching among, 189–191
  Rollup_Formatting macro, 186–189
routing project file to e-mail workgroup, 490–491
rows
  database export file, 824
  entering information, 35–36
  Excel export file, 819
  HTML export file, 831
  number displayed for each task, setting, 258, 259
  printing, 202
  removing from Details section, 154
  table height, changing, 203–205
  viewing information in, 152
running macros, 761–762

S
salaried employees, 319–320
saving
  baseline, 339–340
  consolidated projects, 456–457
  files as Web pages, 830–832
  interim plans, 344
  working environment, customizing, 739–740
schedule
  building from completion to start, 51
  calendar options, setting, 54–55
  project, changing, 437
  resources and, 119
  tables, earned value, 420–421
  visuals in, 278–279
schedule variance. See SV
scheduling
  calendar, redefining, 319–320
  overtime, 318–319
problems, resolving
  constraints, changing, 292–294
  dependencies, adjusting, 294–296
  multiple critical paths, 305–308
  overtime, 288–290
  resources, adding to tasks, 288
  shortening project with critical path, 298–305
  slack, adjusting, 290–292
  splitting task, 296–298
  time, adding to tasks, 290
  timing tasks options, 87
  uncompleted work, 376–377
scope, identifying, 15
screen, input
  Cancel button, 798
  ComboBox, 789–790
  CommandButton, 791–793
  creating, 784–785
  described, 783
  label, 787–789
  OK button to change work, 795–798
  resource name display, 793–795
  size, adjusting, 785–786
  sub procedure showing, 799–800
  TextBox, 790–791
window, 781
screening filter
applying, 213, 234–235
AutoFilters, 237–238
critical tasks, 7, 301–302, 304–305, 774–778
customizing, 236–237
database exports, 823
described, 230
grouping, 238–243
multiple, 542
PERT Chart and Network Diagram views, 166
resource
conflicts, spotting, 313–315
by groups, 180
limiting, 134
listed, 233–234
task, listed, 231–233
security issues
password guidelines, 671
protecting files, 65–66
SQL Server authentication, 520–521
templates, double-checking, 568–570
Windows SharePoint Services, installing and configuring, 529
sending
assignments via e-mail, 481–484
notes to workgroup, 489–490
republishing assignments, 484–486
separating toolbars, 742–746
servers
e-mail, 545, 552–553
hardware requirements, 515
multiple database, 542
number of, 516
software requirements, 514
SF (start-to-finish) dependencies, 109
shapes, adding to Gantt Chart. See Drawing toolbar
shaping assignment timeline
availability, 331
described, 328–329
indicators, 156
pattern, setting, 329–331
SharePoint sites, managing and synchronizing administrator accounts, 619–620
SharePoint Team Services
Administrator account, creating, 526
connection from Project Server, configuring, 545–546
downloading, 518
installing and configuring
described, 528–533
double-checking settings, 566–568
extending WSS site, 533–536
integrating with Project Server, 536–539
security issues, 529
issues and risks, tracking, 660–663
portal server information, modifying, 553–554
recommendation, 514
requirement, 506
sharing, resource
consolidating projects, 443
creating pool, 463–464
opening project that uses pool, 464
quitting, 466–467
updating pool, 465–466
shifting
hyperlinks, 497
objects in drawings, 285
subprojects within projects, 452–453
tasks in outline, 66–67
shortcut
macro, assigning, 759, 770–772
menu, adding to table, 207
shortening critical path, 302–305
Should Have Started Tasks report, 398
showing
filtered lists
applying, 213, 234–235
AutoFilters, 237–238
creating WBS codes, 220–223
critical tasks, 7, 301–302, 304–305, 774–778
customizing, 236–237
database exports, 823
described, 230
grouping, 238–243
multiple, 542
outline numbers, defining, 226–230
PERT Chart and Network Diagram views, 166
renumbering WBS codes, 224–226
resources, 134, 180, 233–234, 313–315, 778–779
sorting, 216–219
tasks, 71–74, 231–233
views
adding, 211–213
changing, 37–38, 803
combination, creating, 213–216
described, 151–152
Details section, changing, 154–155
double-checking settings, 571–575
indicators, 155–156
reasons to vary, 210
resource conflicts, spotting, 311–313
sharing among projects, 741–742
switching among, 23
system design, 508
table, changing, 152–154, 203–210
Sicun Management Group, Inc. case study, 856–858
sizing
drawings, 285
UserForm object, 785–786
slack
adjusting to resolve scheduling problems, 290–292
described, 5–6
evaluating, 159–160
total, 305
slippage, 159–160
Slipping Tasks report, 399
software
CD, back-of-the-book
    Empire TIME, 876
    InfoSource, Inc., 882
    Innate Info, 877
    Innate Timesheets, 877
    Milestones Professional 2002, 878
    MPX Translator, 879
    PDF file of book, 876
    PERT Chart EXPERT, 878–879
    Project 2003 Bible Web page, 876
    Project KickStart, 879–880
    TimeSheet Professional, 880–881
    WBS Chart Pro, 881
peripheral Project Server, installing, 518–528
requirements
    for client computers, 515
    for servers, 514
sorting tasks
    by duration, 305
    by priority, 324
    in view, 216–219
source files, 450–451
The Southern Project Group case study, 855–856, 868–869
special needs, 506–507
SPI (Special Performance Index), 413
split tasks, 296–298
spreadsheet work
    earned value, 421–427
    exporting information, 816–820
    importing information, 835–839
    PivotTables, creating, 431–436, 816
    Task Sheet view, 195–196
timescaled earned value data, 427–431
Timesheet grid, 677–678
SQL 2000 (Microsoft), 514, 515
SQL Server and Analysis Services
    Mixed mode, setting to operate in, 520–521
    version, checking, 519–520
SS (start-to-start) dependencies, 109–110
staff assignments
    new and changed, publishing to e-mail
workgroup, 481–484
Overallocated Resources report, 401–402
part-time, 320–322
receiving online, 22
republishing to e-mail workgroup, 484–486
To Do List report, 401
Who Does What report, 399–400
Who Does What When report, 400–401
staff hours
    assigning people with lower versus higher, 180–181
    availability, calculating, 135
done during time period, 652
overtime
    information, viewing, 180
rate, setting, 123
    resolving scheduling problems, 288–290
    scheduling, 318–319
percentage, tracking, 178, 179
Continued
staff hours (continued)
resources, modifying, 131–132
salaried employees, 319–320
setting, 54, 57
start time, controlling, 322–323
viewing with Tracking Gantt View, 350–351
staff member, interviewing, 505
staff work
automating adjustment
code, adding, 793–798
controls, adding, 789–793
creating, 784–785
described, 783
size, adjusting, 785–786
sub procedure showing, 799–800
completed, updating with actuals, 365–366
resources, time needed to finish task with baseline, 380–381
tracking regularly, 372–375
staff workload
delaying tasks by leveling workloads, 323–328
leveling
automatic, 323–327
manual, 327–328
Resource Usage report, 404
Task Usage report, 402–403
Standard toolbar
appearance, changing, 742–744
described, 34
Task Information button, 83
start date
calculating, 310
close, caution against rollup view, 189, 191
illogical, flagging, 292–293
interim plan, 343
setting, 51
updating with actuals, 360–361
Start No Earlier Than/Start No Later Than constraint, 94
Start tasks, duration versus, 85
start time, controlling, 54, 322–323
starting Project, 23–28
start-to-finish, 109
start-to-start, 109–110
statement, goal or scope, 15
status reports
actuals, adjusting to reflect, 659
baselines, 338–345
cost estimates, 511, 732–737
described, 18, 335–336
estimates versus actuals, 336–337
issues, 660–662, 663
method, establishing, 652
ongoing, 337–338, 372–375
progress, viewing with Tracking Gantt View, 345–351
Project Web Access settings, 599–601
receiving online, 22
risks, 660, 662
status reports, 652–656
strategies, 351–352
updates, receiving from team members, 656–659
user, day-to-day, 702–704
versions, 663–664
viewing and editing one task at a time, 191–192
status update, requesting, 486–487
steps, interdependent individual. See tasks
storing
customized HTML pages, scripts, and XML documents, 807
Web-based project in Project Server database, 630–631
studies, case
Asian conglomerate, 864–866
BCE Emergis, 869–870
DEA Brown & Sharpe Limited, 851–855
EDS, 866–868
Fortune 100 company, 855–856
Fortune 100 company, IT division, 868–869
Longs Drug Stores, 856–858
Nebraska Arts Council, 858–860
Webcasting services company, 860–864
style sheet, 811
subordinate task. See subtask
subproject
benefit of creating, 437
consolidating, 450–451
described, 445, 835
into host file, 444–450
moving within projects, 452–453
substituting
assignment, 139–140
resources, 133, 645–649
subtask
dependencies, 111
displaying, 72
information gathering, 46–47
moving in outline, 67
new project, creating, 60–63
rollup views, 183
successor task
dependency, displaying, 103, 107, 166
filtering, 166
viewing with current task, 170, 295
summary report
of all projects for executive, 705–708
choosing, 388
Critical Tasks, 390
Milestones, 390
Project Summary, 389
Top Level Tasks, 389
Working Days, 390–391
summary task
appearance, 60
highest level, reporting as of today, 389
moving without subtasks, 67
Rollup view, 184–186
timing, 89–90
SV (schedule variance)
cash flow report, 393, 394
earned value
  cost indicators and schedule, 420–421
  for resources, 418–419
  for tasks, 417–418
row height, changing, 203–205
sharing among projects, 741–742
shortcut menu, adding, 207
switching
  among Rollup view, 189–191
resources, 316–317
tables, 120, 206
  between tasks in views, 193, 194
views, 152
symbols, database conventions, 821
synchronizing SharePoint administrator
  accounts, 619–620
system design
  implementation and configuration
    strategy, 509–510
  organizational standards, establishing and
    enforcing, 507–509
  special needs, addressing, 506–507
  technology environment, assessing, 506
T
table
columns, hiding and inserting, 205–206
costs, 367–369
creating new or editing existing, 206–210
earned value
  cost indicators and schedule, 420–421
  for resources, 418–419
  for tasks, 417–418
row height, changing, 203–205
sharing among projects, 741–742
shortcut menu, adding, 207
switching, 120, 206
updating by Administrator, 615–616
views, changing, 152–154
Table of Contents, Help menu, 76
targets
defined, 4
identifying, 14
task
adding time to, 290
Administrator, order of, 561–562
baseline, adding, 342–343
changing, answering “what if” question,
  713–723
constraints
  changing to resolve scheduling
    problems, 292–294
  described, 93, 94, 95–96
copying to outline, 69–71
costs for, 142–144, 367–368
custom HTML page, 809–810, 813
deadline dates, 94–96
defined, 290
delaying by leveling workloads, 323–328
dependencies, establishing, 102–114
displaying and hiding on outline, 71–74
goals area, 808–809
information gathering, 46–47
linking across projects, 453–455
new project, entering, 58–59
notes, 100–102
ordering
  creating WBS codes, 220–223
  outline numbers, defining, 226–230
  renumber WBS codes, 224–226
  sorting, 216–219

Continued
task (continued)
  outline, adjusting, 66–69
  overbudget report, 395
  recurring, 90–92
  resource-driven and fixed-duration, 7–8
  resources, adding, 132–133, 288
  schedule, managing, 55
  splitting to resolve scheduling problems, 296–298
  tables, earned value, 417–418
  timing, 79–90, 97–100
  type indicators, 155
  updating with actuals
    durations, 361–362
    Percent Complete value, setting, 364–365
    remaining durations, 362–364
    start and finish dates, 360–361
    work completed, 365–366
  Work table for, reviewing, 379–380
  task assignments
    adding to resource, 317
    displaying resources, 181
    to resource by week, 401
    Who Does What Report, 399–400
    Who Does What When Report, 400–401
  task bar
    display, setting, 271
    timing tasks, 86
  task calendar, 509
  Task Cost table, 349–350
  Task Details form, 191–192
  Task Entry view, 192–193
  Task Form view
    described, 193–194
    with Gantt Chart view, 192–193
  task lists, Outlook (Microsoft), 840
  Task Name Form, 194–195
  Task report, 405–406
  Task Sheet view, 195–196

Task Usage
  form, 196–197
  report, 402–403
  Task Variance table, 348–349
  Task Work table, 350–351
  taskbars
    formatting, 255–258
    Gantt Chart layout, changing, 258–262
    gridlines, changing, 262–263
  Tasks in Progress report, 397–398
  tasks, series of. See critical path
  Tasks Starting Soon report, 397
  team
    member updates, receiving, 656–659
    requirements, assessing, 504
  team projects
    e-mail workgroup
      information, publishing all, 479–481
      managers’ commands, 478–479
      new and changed assignments, publishing, 481–484
      republishing assignments, 484–486
      status update, requesting, 486–487
      resource assignment, 124–126
    Technology Associates International case study, 851–855
  technology environment, assessing, 506
  template
    described, 13
    Enterprise Global, 503, 583–587
    files, saving as, 65
    Global template file, 760
    opening or starting projects, 48–49, 883
    Tenrox, Inc. business-optimization software developer, 866–868, 869–870
    testing VBA (Visual Basic for Applications) code, 781–783
  text boxes
    Gantt Chart, 281–284
    UserForm, 790–791
  text files
    exporting, 828–830
    importing, 847
  text formatting
    calendar project fields, 272
    categories, applying to, 253–254
    selected, 251–252
Index ✦ T

time
accounting system, 876
adding to tasks, 290
chronological order, viewing tasks in, 195–196
delaying tasks
  adjusting to resolve scheduling problems, 290–292
described, 5–6
evaluating, 159–160
total, 305
incorrect in data from Microsoft Excel, 848
limits, gathering, 47
period shown by formatted bar, 258
PERT Entry Sheet, 172
planning, 16
remaining, 362–364
scheduling options, setting, 87
shape of resource work assignment
  availability, 331
described, 328–329
indicators, 156
pattern, setting, 329–331
specific amount to accomplish task
  adding time to tasks, 290
  baseline, tracking progress against, 346–347
critical path, shortening, 302–305
described, 6–7
effort-driven tasks and resources, 119
fixed-duration tasks, 7–8, 81, 321
fixed-work tasks, 82
Gantt Chart symbol, 10
grouping tasks by, 167
specific, projects defined by, 4
Start and finish tasks versus, 85
tasks, entering, 59, 82–90, 675–678
total from all resources to finish task, 379–380
updating with actuals, 361–362
timescale
cost analysis, 427–431
Gantt Chart, 29, 97–100
graphic, attaching, 283
PWA, 601–602
saving, 198
TimeSheet Professional software, 880–881
timesheets, 601, 877, 880–881
timing. See also critical path
  progress reports on
  choosing, 395–396
  Completed Tasks report, 398
  Should Have Started Tasks report, 398
  Slipping Tasks report, 399
  Tasks in Progress report, 397–398
  Tasks Starting Soon report, 397
  Unstarted Tasks report, 396
resource allocation relative to, 176–177
tasks
calendar, assigning, 88
described, 79–80, 82–83
effort-driven, 82
fixed-duration, 81
fixed-unit, 80
fixed-work, 82
Gantt table, 85
milestones, 88–89
mouse and task bar, 86
padding, pros and cons, 81
scheduling options, 87
Start and finish versus duration, 85
summary tasks, 89–90
Task Information dialog box, 83–84
variance between baseline and actual, 348–349
viewing on Gantt Chart, 97–100
timing, tasks dependent on
  identifying, 299–302
multiple, 305–308
shortening, 302–305
viewing across multiple projects, 459–462
to-do lists
  executive, preparing, 705
  Web-based project, creating, 636–640
weekly, 401
toolbar
  adding and deleting tools, 746–747
  button
    images, changing and editing, 749–751
    macro, assigning, 762–766
  combining or separating, 742–746
custom, creating, 747–749
described, 34–35

Continued
toolbar (continued)  
Drawing, 281–284
Project Guide, 801
working environment, customizing, 742–751
Tools menu, 33
Top Level Tasks, summary report, 389
top-level view 
  described, 183
  Gantt bars, setting, 261
Rollup_Formatting macro, 186–189
  summary task bar, 184–186
  switching among, 189–191
total slack, 305
tracking  
  actuals, adjusting to reflect, 659
  baselines, 338–345
  cost estimates, 511, 732–737
  described, 18, 335–336
  estimates versus actuals, 336–337
  issues, 660–662, 663
  method, establishing, 652
  ongoing, 337–338, 372–375
  progress, viewing with Tracking Gantt View, 345–351
  PWA settings, 599–601
  risks, 660, 662
  status reports, 652–656
  strategies, 351–352
  updates, receiving from team members, 656–659
  versions, 663–664
  viewing and editing one task at a time, 191–192
Tracking Gantt view 
  described, 162–163
  interpreting, 346–348
  progress, reviewing, 378–379
  Task Cost table, 349–350
  Task Variance table, 348–349
  Task Work table, 350–351
trends, identifying, 708–713
troubleshooting  
  importing information, 847–849
  Project Server, 558
typeface  
  caution, 254
  formatting, 251–252

U  
uncompleted work, rescheduling, 376–377
underutilization, 179, 722
Uniform Resource Locator. See URL
Unstarted Resource Locator, 396
updates  
  actuals, techniques and tips, 371–377
  baseline, 341
  making online, 22
  process, organizing, 355–356
  receiving, 656–659
  requesting, 486–487
  resource pool information, 465–466, 615–616
  transferring to schedule, 481
URL (Uniform Resource Locator)  
  hyperlinks to 
    described, 493–494
    editing, 495–496
    indicator, 156
    inserting, 494–495
    moving or copying, 497
    repairing, 497
  Project Guide SDK, 802
  Project Server, logging onto, 624, 668
  PWA Home page, linking, 603–604
  Windows SharePoint links, 538, 557–558
U.S. defense WBS (work breakdown structure) codes. See WBS
chart, illustrated, 9
creating, 220–223
Enterprise outline codes, customizing, 507
files, saving, 739
renumbering, 224–226
U.S. Navy. See PERT (Program Evaluation and Review Technique) analysis
usage, resource  
  with Leveling Gantt Chart view, 176–177
  overallocation, finding, 181–182
  workloads, 404
user  
  adding or modifying, 578–581
documents  
  adding supporting to projects, 693
  library, creating, 697–698
  posting, 695–697
  viewing, 694–695
account, adding to Windows accounts, 526–528
double-checking settings, 570–571
resources, assigning, 122, 180–181
tasks, adjusting timing, 80
Home Page, reviewing, 669–670
logging off, 704
mapping to projects and views, 575–578
number, server design and, 517–518
OLAP cube, viewing, 612–615
password, changing, 670–672
PWA, logging on, 668–669
requirements for project management software, 12–13
status reports, 702–704
tasks
adding, 678–680
delegating, 690–692
PWA and Microsoft Outlook, 680–688
time, entering, 675–678
viewing, 673–675
workday changes, notifying managers, 688–690
version needed, 667
viewing information, 698–701
user authentication, 565–566
UserForm
Cancel button, 798
ComboBox, 789–790
CommandButton, 791–793
creating, 784–785
described, 783
label, 787–789
OK button to change work, 795–798
resource name display, 793–795
size, adjusting, 785–786
sub procedure showing, 799–800
TextBox, 790–791
window, 781

V
VAC (variance at completion), 394
vacation time
blocking off, 132
noting, 129
value, earned
calculating with percent complete method, 414–416
charting, 421–427
date, setting, 416–417
described, 411–413
report, 393–394
tables, 417–421
values, corrupted when exporting/importing, 849
variable consumption, 138
variance
cost
Cash Flow report, 393
Earned Value report, 394, 412
percentage, 413
schedule
cash flow report, 393, 394
earned value report, 394
percentage, 413
task, 348–349
variance at completion. See VAC
VBA (Visual Basic for Applications)
filter for critical tasks, macro recording, 774–778
key components, 780–781
menu macros, writing, 751–756
specified resources, edit macro to show only, 778–779
testing code, 781–783
uses, 773
version
Enterprise Project, managing, 581–582
file format, differing, 64, 830
needed by day-to-day user, 667
Project Resource required, 623
SQL Server and Analysis Services, checking, 519–520
Standard versus Professional, 21–22
tracking, 18, 663–664
View Bar
described, 37–38
hiding, 23
View menu, 32
viewing
critical path for multiple projects, 459–462
dependencies, 114–115
Continued
viewing (continued)
documents, 694–695
information by day-to-day user, 698–701
multiple projects, 458–459
OLAP cube, 612–615
Outlook information in PWA, 681
pages in Project Professional, 632–633
tasks by users, 673–675
timing tasks on Gantt Chart, 97–100
views
adding, 211–213
changing, 37–38, 803
combination, creating, 213–216
described, 151–152
Details section, changing, 154–155
double-checking settings, 571–575
filtering
applying, 234–235
AutoFilters, 237–238
customized, 236–237
described, 230
grouping, 238–243
types listed, 231–234
indicators, 155–156
reasons to vary, 210
resource conflicts, spotting, 311–313
sharing among projects, 741–742
switching among, 23
system design, 508
table, changing, 152–154, 203–210
tasks, ordering
creating WBS codes, 220–223
outline numbers, defining, 226–230
renumbering WBS codes, 224–226
sorting, 216–219
views, listed
Calendar, 158–159
Descriptive Network Diagram, 169–170
Detail Gantt, 159–160
Gantt Chart, 28–30, 160
Leveling Gantt, 161–162
Multiple Baselines Gantt, 164
Network Diagram, 165–169
PERT analysis, 171–176
Relationship Diagram, 170
Resource Allocation, 176–177
Resource Form, 177
Resource Graph, 178–179
Resource Name Form, 179–180
Resource Sheet, 180–181
Resource Usage, 181–182
Rollup, 183–191
table, 156–157
Task Details form, 191–192
Task Entry, 192–193
Task Form, 193–194
Task Name Form, 194–195
Task Sheet, 195–196
Task Usage form, 196–197
Tracking Gantt, 162–163
Visio, 273–276
Visual Basic for Applications. See VBA
visuals
images
exporting information, 826–828, 831
in schedules, 278–279
toolbar button, changing and editing, 749–751
indicators
described, 122
e-mail, sent, 480
multiple, viewing, 129
nodes, displaying, 167–169
views, 155–156
W
WAN (wide-area network), 503, 516
warnings, 293–294
WBS Chart Pro software, 881
WBS (work breakdown structure) codes
assigning when copying tasks, 71
chart, illustrated, 9
creating, 220–223
Enterprise outline codes, customizing, 507
files, saving, 739
renumbering, 224–226
Web browser, using Project with
described, 22, 501–503, 549–551
executive use
defined, 505
summary of all projects, 705–708
trends and potential problems,
identifying, 708–713
“what if” analysis, 713–723
Gantt bar styles and timescales, 601–602
  grouping formats, 602–603
logging onto, 550–551
mail server information, setting up, 552–553
menus, establishing, 599
notifications and reminders, 604–605
OLAP server information, entering, 555–556
opening, 22
operation modes, changing, 554–555
Outlook tasks, 680–688
pages, displaying, 804
resources, assigning, 649–651, 684
server, specifying, 549
SharePoint portal server information, modifying, 553–554
tracking settings, 599–601
user, logging on, 668–669
WSS server information, entering, 556–558
Web page
  Gantt Chart, creating file for, 277–278
saving files as, 830–832
Web-based project, creating
  administrative projects, 634–636
  opening project from Project Server database, 631–632
options, setting, 628–630
publishing project information, 634
storing in Project Server database,
  630–631
to-do lists, 636–640
viewing pages in Project Professional,
  632–633
Webcasting services company case study, 860–864
windows, input
  Cancel button, 798
  ComboBox, 789–790
  CommandButton, 791–793
creating, 784–785
described, 783
label, 787–789
OK button to change work, 795–798
resource name display, 793–795
size, adjusting, 785–786
sub procedure showing, 799–800
TextBox, 790–791
window, 781
Windows (Microsoft)
  accounts, setting up, 524–526
  Active Directory, 135
taskbar icons, customizing, 737–739
version, checking before Project Server installation, 539
Windows Server 2003 (Microsoft), 514
Windows SharePoint Services. See WSS
wizard, defined, 247
Word (Microsoft)
  document information, importing, 840–846
exporting information, 825–826
  Gantt Chart, copying to, 273–278
work
  automating adjustment
    code, adding, 793–798
    controls, adding, 789–793
    creating, 784–785
described, 783
  size, adjusting, 785–786
  sub procedure showing, 799–800
completed, updating with actuals, 365–366
resources, time needed to finish task with baseline, 380–381
tracking regularly, 372–375
work assignments
  new and changed, publishing to e-mail workgroup, 481–484
  Overallocated Resources report, 401–402
  part-time, 320–322
  receiving online, 22
  republishing to e-mail workgroup, 484–486
  To Do List report, 401
Who Does What report, 399–400
Who Does What When report, 400–401
wide-area network. See WAN
"what if" analysis. See PERT analysis
Who Does What report, 399–400
Who Does What When report, 400–401
work breakdown structure codes. See WBS codes
work hours
assigning people with lower versus higher, 180–181
availability, calculating, 135
done during time period, 652
overtime
information, viewing, 180
rate, setting, 123
resolving scheduling problems, 288–290
scheduling, 318–319
percentage, tracking, 178, 179
resources, modifying, 131–132
salaried employees, 319–320
setting, 54, 57
start time, controlling, 322–323
viewing with Tracking Gantt View, 350–351
Work table for tasks, 379–380
workday
administrative projects, 597–598
calendar, 509
changes, notifying managers, 688–690
contiguous, selecting, 131
daily tasks, setting, 91
partial, setting, 132
standard calendar, 51
summary reports, 390–391
workgroup
building, 477–478
communicating, 478–487
customizing, 487–488
described, 469–470
future of, 126, 470
hyperlinks, 493–497
indicators, 156
Internet interface, 492–493
management procedures, establishing, 489
notes, sending, 489–490
phasing out by Microsoft, 470
project file, routing, 490–491
setting up, 470–477
tracking, 14
working environment, customizing fields
data entry, 728–731
described, 727–728
formulas, 732–737
interface
Organizer, 741–742
project menus, 751–755
Saving files, 739–740
toolbars, 742–751
Windows taskbar icons, 737–739
workload
delaying tasks by leveling, 323–328
leveling
automatic, 323–327
manual, 327–328
Resource Usage report, 404
Task Usage report, 402–403
writing macros
critical tasks filter, recording, 774–778
described, 757
keyboard shortcut, 770–772
menu command, 766–770
recording, 758–761
Toolbar button, 762–766
WSS (Windows SharePoint Services)
Administrator account, creating, 526
connection from Project Server, configuring, 545–546
downloading, 518
installing and configuring
described, 528–533
double-checking settings, 566–568
extending WSS site, 533–536
integrating with Project Server, 536–539
security issues, 529
issues and risks, tracking, 660–663
portal server information, modifying, 553–554
recommendation, 514
requirement, 506
X
XML (eXtensible Markup Language) file
creating, 832–834
interchanging project data, 847
Project Guide, 802–806
Wiley Publishing, Inc.
End-User License Agreement

READ THIS. You should carefully read these terms and conditions before opening the software packet(s) included with this book “Book”. This is a license agreement “Agreement” between you and Wiley Publishing, Inc. “WPI”. By opening the accompanying software packet(s), you acknowledge that you have read and accept the following terms and conditions. If you do not agree and do not want to be bound by such terms and conditions, promptly return the Book and the unopened software packet(s) to the place you obtained them for a full refund.

1. License Grant. WPI grants to you (either an individual or entity) a nonexclusive license to use one copy of the enclosed software program(s) (collectively, the “Software”) solely for your own personal or business purposes on a single computer (whether a standard computer or a workstation component of a multi-user network). The Software is in use on a computer when it is loaded into temporary memory (RAM) or installed into permanent memory (hard disk, CD-ROM, or other storage device). WPI reserves all rights not expressly granted herein.

2. Ownership. WPI is the owner of all right, title, and interest, including copyright, in and to the compilation of the Software recorded on the disk(s) or CD-ROM “Software Media”. Copyright to the individual programs recorded on the Software Media is owned by the author or other authorized copyright owner of each program. Ownership of the Software and all proprietary rights relating thereto remain with WPI and its licensers.

3. Restrictions on Use and Transfer.
   (a) You may only (i) make one copy of the Software for backup or archival purposes, or (ii) transfer the Software to a single hard disk, provided that you keep the original for backup or archival purposes. You may not (i) rent or lease the Software, (ii) copy or reproduce the Software through a LAN or other network system or through any computer subscriber system or bulletin-board system, or (iii) modify, adapt, or create derivative works based on the Software.
   (b) You may not reverse engineer, decompile, or disassemble the Software. You may transfer the Software and user documentation on a permanent basis, provided that the transferee agrees to accept the terms and conditions of this Agreement and you retain no copies. If the Software is an update or has been updated, any transfer must include the most recent update and all prior versions.

4. Restrictions on Use of Individual Programs. You must follow the individual requirements and restrictions detailed for each individual program in the “What’s on the CD” appendix of this Book. These limitations are also contained in the individual license agreements recorded on the Software Media. These limitations may include a requirement that after using the program for a specified period of time, the user must pay a registration fee or discontinue use. By opening the Software packet(s), you will be agreeing to abide by the licenses and restrictions for these individual programs that are detailed in the “What’s on the CD” appendix and on the Software Media. None of the material on this Software Media or listed in this Book may ever be redistributed, in original or modified form, for commercial purposes.
5. **Limited Warranty.**

(a) WPI warrants that the Software and Software Media are free from defects in materials and workmanship under normal use for a period of sixty (60) days from the date of purchase of this Book. If WPI receives notification within the warranty period of defects in materials or workmanship, WPI will replace the defective Software Media.

(b) WPI AND THE AUTHOR OF THE BOOK DISCLAIM ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE, THE PROGRAMS, THE SOURCE CODE CONTAINED THEREIN, AND/OR THE TECHNIQUES DESCRIBED IN THIS BOOK. WPI DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE ERROR FREE.

(c) This limited warranty gives you specific legal rights, and you may have other rights that vary from jurisdiction to jurisdiction.

6. **Remedies.**

(a) WPI’s entire liability and your exclusive remedy for defects in materials and workmanship shall be limited to replacement of the Software Media, which may be returned to WPI with a copy of your receipt at the following address: Software Media Fulfillment Department, Attn.: *Microsoft Office Project 2003 Bible*, Wiley Publishing, Inc., 10475 Crosspoint Blvd., Indianapolis, IN 46256, or call 1-800-762-2974. Please allow four to six weeks for delivery. This Limited Warranty is void if failure of the Software Media has resulted from accident, abuse, or misapplication. Any replacement Software Media will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

(b) In no event shall WPI or the author be liable for any damages whatsoever (including without limitation damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising from the use of or inability to use the Book or the Software, even if WPI has been advised of the possibility of such damages.

(c) Because some jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation or exclusion may not apply to you.

7. **U.S. Government Restricted Rights.** Use, duplication, or disclosure of the Software for or on behalf of the United States of America, its agencies and/or instrumentalities “U.S. Government” is subject to restrictions as stated in paragraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause of DFARS 252.227-7013, or subparagraphs (c) (1) and (2) of the Commercial Computer Software - Restricted Rights clause at FAR 52.227-19, and in similar clauses in the NASA FAR supplement, as applicable.

8. **General.** This Agreement constitutes the entire understanding of the parties and revokes and supersedes all prior agreements, oral or written, between them and may not be modified or amended except in a writing signed by both parties hereto that specifically refers to this Agreement. This Agreement shall take precedence over any other documents that may be in conflict herewith. If any one or more provisions contained in this Agreement are held by any court or tribunal to be invalid, illegal, or otherwise unenforceable, each and every other provision shall remain in full force and effect.
Where can you find the best information on Microsoft Office 2003?